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Preface

Oracle MICROS Simphony is a cloud-based Point-of-Sale (POS) solution that provides
business management capabilities using a single tool with vast integration capabilities
to property management systems, paperless kitchen display systems, credit card
interfaces, and reporting applications.

Purpose

This Configuration Guide provides instructions to set up Simphony release 19.2.

Audience

This document is intended for system administrators of Oracle MICROS Simphony
release 19.2.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

• Product version and program/module name

• Functional and technical description of the problem (include business impact)

• Detailed step-by-step instructions to re-create

• Exact error message received and any associated log files

• Screen shots of each step you take

Documentation

Product documentation is available on the Oracle Help Center at https://
docs.oracle.com/en/industries/food-beverage/pos.html.

Simphony eLearning

The Simphony Learning Subscription provides additional product knowledge through
interactive training, guided video tours, and helpful knowledge checks. After exploring
the documentation library, use your Oracle Single Sign On to check out the Simphony
learning opportunities at Hospitality Learning Subscriptions.

Revision History

Date Description of Change

October 2020 Initial publication.
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Date Description of Change

November 2020 • Updated Surcharges in Taxes.
• Updated Follow Me in Guest Checks.
• Updated Configuring Employee

Privileges for Oracle Hospitality
Reporting and Analytics in Reporting.

December 2020 • Removed CAPS Supported Software
and Hardware from Check and Posting
Service (CAPS) as this information now
appears in the Oracle Food and
Beverage Compatibility Matrix.
Added a reference in Check and
Posting Service (CAPS) to the Oracle
Food and Beverage Compatibility
Matrix

• Added a new chapter called Remote
Support.

February 2021 • Updated Configuring Workstation
Translations in the Language Settings
and Translation chapter.

• Updated the following topics in the
Peripheral Devices chapter:
– Configuring a Barcode Reader

Using the Barcodes Module
Method.

– Removed Configuring a Barcode
Reader Using the Number Lookup
(NLU) Method.

• Updated Enabling Extension
Applications in the Extension
Applications chapter.

• Updated Enabling Log Archiving for
Workstations in the Log File
Management chapter.
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Date Description of Change

April 2021 Added and updated the following for
Simphony release 19.2.1:
• Updated Configuring the Room Charge

Tender and Configuring the Loadable
PMS Payment Module in the Payments
and Currency chapter.

• Updated Configuring Menu Item
Classes in the Menu Item Classes
chapter.

• Updated Assigning Condiments to
Parent Menu Item Classes and Using
Condiment Prefixes with Menu Item
Classes in the Condiments chapter.

• Updated Configuring Menu Item
Definitions in the Menu Item
Definitions chapter.

• Updated Allowing Assigned Receptacle
Access and Counts in the Enterprise
Cash Management chapter.

• Added Configuring a Rear Marketing
Display (RMD) to the Interfaces with
Simphony chapter.

• Added a new chapter called XProcessor
Gift Cards and Plug-ins.

• Updated the following topics in the
Properties chapter:
– Adding a Property
– Adding a Revenue Center

• Updated Enabling Events in the Events
chapter.

• Updated the Transaction Services
chapter home page.

• Updated Configuring Menu Item
Definitions, Family Groups, and
Condiment Group Names Consumer-
Facing Settings in the Transactions
Services chapter.

• Amended the following topics in the
Taxes chapter:
– Updated the Taxes chapter home

page, specifically the Inclusive
Taxes content

– Updated Configuring Order Types
– Added Configuring the Parent Item

Tax Class Override
• Added Configuring Active Main or Sub

Level Pricing for Current Round in the
Menu Levels chapter.

• Updated OPERA Self Pay in the
Payments and Currency chapter.
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Date Description of Change

May 2021 Updated Cloning Simphony Database
Configurations.
Updated Adding a Revenue Center in the
Properties chapter.
Updated Configuring a Serving Period in
the Taxes chapter.
Added the following topics to the Menu
Item Definitions chapter:
• Configuring Menu Tag Groups and

Tags
• Associating a Menu Item Definition

with a Tag
Added the following topics to the Check
and Posting Service (CAPS) chapter:
• Scheduling and Viewing Device

Information
• Device Information Needs Attention

State

June 2021 Added the following topics to the Menu
Item Definitions chapter:
• Configuring Menu Tag Groups and

Tags
• Associating a Menu Item Definition

with a Tag
Updated Assigning Default Condiments to
Parent Menu Items in the Condiments
chapter.
Updated Slip Printer in the Printers
chapter.
Added Configuring Open Checks on
Revenue Centers to Automatically Cancel to
the Guest Checks chapter.

July 2021 Added Configuring Time Card Chit Printing
to the Employees and Privileges chapter.
Updated the XProcessor Gift Cards and
Plug-ins chapter.
Updated Configuring Open Checks on
Revenue Centers to Automatically Cancel in
the Guest Checks chapter.

August 2021 Added Transaction Services Gen 2 URL and
OpenID Connect information to the
Transaction Services introductory topic.

September 2021 Updated Adding a Property in the
Properties chapter.
Updated Order Types in the Taxes chapter.
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the Reporting chapter.

November 2021 Updated Configuring Options for Australia
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Added CAPS Optimization for High Loads
in the Check and Posting Service (CAPS)
chapter.
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chapter.
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and Plug-ins chapter.
Updated the Logo Printing chapter.
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1
Introduction to Simphony

Oracle Hospitality Simphony is an Enterprise-class Point-of-Sale (POS) software product.
Simphony can be hosted in the Oracle Cloud Hosting Center, self hosted at multiple
properties or at a customer’s data center. Simphony can support multiple or single property
configurations.

Administrators can configure Simphony using the Enterprise Management Console (EMC)
tool. This application allows you to set up the Enterprise, properties, revenue centers, and
zones from a PC that has access to the central server.

Simphony interacts with the following devices and solutions:

• Peripheral Devices, such as cash drawers, magnetic stripe readers, and barcode readers

• Printers and Order Devices, such as a Kitchen Display System (KDS)

• Credit Card Drivers

• Loyalty and Gift Card Interfaces and Drivers

• Oracle Hospitality Reporting and Analytics

• Oracle Hospitality OPERA 5 Hotel Property Systems

EMC Basics
This section describes the basic functions in EMC. For information about accessing the EMC
after a fresh installation or upgrade, see the Oracle Hospitality Simphony Post-Installation or
Upgrade Guide, specifically the EMC Access Security chapter.

EMC Configuration Hierarchy

The Simphony EMC has three areas that allow you to choose where to define certain
definitions and records in the EMC’s hierarchy tree. In EMC, modules are configured (in order
from highest to lowest) on the enterprise, property, or revenue center levels. See Enterprise
for more information on EMC levels.

An employee’s assigned role determines whether users have full or partial access to specific
modules on certain levels. See Employees and Privileges for more information on employee
roles

EMC Home Page

When you log in, EMC defaults to the Home Page. The Home Page shows a navigation tree
in the Locations pane based on the EMC levels. Modules appear to the right of the Locations
pane and filters based on the location you select from the navigation tree.

You can use the filters below the Locations pane to easily search for properties, revenue
centers, and zones within a large enterprise.
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Figure 1-1    EMC Home Page Filters

• Filter: Enter the name of a property, revenue center or zone to filter the navigation
tree.

• Coll: Click to collapse the navigation tree. If the navigation tree is collapsed when
filtering, the search returns the top most level. For example, when you search for a
revenue center, the navigation tree shows the property to which it belongs.

• Exp: Click to expand the navigation tree.

• Show all zones: Select to shows zones in the navigation tree and to include
zones in your search.

• #: Select to show the object number in front of properties, revenue centers, and
zones in the navigation tree.

EMC remembers each users state at the time of exit. Therefore, the next time you log
in, the EMC Home Page defaults to the location that was last viewed by you when
EMC was closed.

Table View and Form View

Table view and form view are two views used to show information within modules.

Most modules open to table view, which is a grid view showing all records sorted by
object number. Typically, the first two columns are the object number and name of the
record. Table view is generally used when making bulk changes. When a record is
changed, table view highlights the record in yellow.

Form view shows the same content that is available in table view, but for a single
record. Depending on the data, sometimes form view shows more information than
table view. For example, the Employee Roles module, which contains only object
number and name in table view, contains several configurable tabs in form view. Form
view includes a navigation bar that shows the object number and name of each record
available, making record-to-record navigation easier. To navigate to a specific record,
simply select the record within the navigation bar and the corresponding form view
tabs populate with the selected record’s information.

Three methods are available for switching between table view and form view:

• Click the Toggle Table/Form View icon on the EMC toolbar.

• While in table view, double-click the Object Number column to open form view.

• While in form view, double-click the object number/name in the navigation bar to
open table view.

Chapter 1
EMC Basics
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Module Record Filters

By default, most modules in EMC show all of the available records when opened. You can
remove unwanted records from view using the filters available in table view. The filters
appear above the table and is set to Show All Records.

Figure 1-2    EMC Filter Section in Table View

When records are filtered,

• Form view shows only the records that appear in table view. While in form view, the
navigation buttons (next, previous, first, and last) change to only the records that appear
in table view.

• The Option Bit Comparison Dialog shows only the records that appear in table view.

The Menu Item Maintenance module provides additional filters for streamlining the records.
See Searching and Filtering Menu Items for more information.

Sorting Records

In EMC, you can sort records presented in tables by one of the columns. By default, records
are sorted by object number. To sort by another column, click the column header.

EMC Toolbar

EMC uses common controls that are familiar to most users. For example, the top of the
screen includes a menu bar with the standard File, Edit, and View options. Additionally, a
number of navigational icons are available on the toolbar.

The following table describes the icons on the EMC toolbar. You can also access the
functions performed by these icons within the menu bar.

Table 1-1    EMC Toolbar Icons

Toolbar
Icon

Name Function Available in
Table View?

Available in
Form View?

Refresh Performs a refresh of the data in the
current module.

Yes Yes

Close Closes the currently active module. Yes Yes

Close All Closes all open modules. Yes Yes

Location
Selector

Opens the current module in another
property or revenue center. This icon
is enabled only if you open a module
from the property or revenue center
level.

Yes Yes

Chapter 1
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Table 1-1    (Cont.) EMC Toolbar Icons

Toolbar
Icon

Name Function Available in
Table View?

Available in
Form View?

Language
Translation

Opens the EMC Record Translation
dialog. This icon is enabled only when
the current GUI control is a
translatable text field.

Yes Yes

Print Opens a dialog that allows you to print
records from table view.

Yes No

Save Saves changes to records in the
currently active module. This icon is
enabled only when changes have are
made to the current module.
When you insert a new record to a
module, Simphony automatically
saves that record. To invoke this icon,
you must make initial entries or
modify an existing record entry.

Yes Yes

Save All Saves changes to records in all open
modules. This icon is enabled only
when any open module has its records
change.

Yes Yes

Insert Adds a new record to the module. This
icon is enabled only when the current
module supports the Insert
functionality and only when the
logged-in user has Employee Role
permissions to add new records to the
module.

Yes Yes

Delete Deletes records. This icon is enabled
only when the current module
supports the Delete functionality, and
only when the logged-in user has
Employee Role permissions to delete
records from the module.

Yes Yes

Distribute Distributes records. This icon is
enabled only when the EMC user is
associated with an Enterprise Role
with the option Distribute enabled,
and only when the current module
supports distribution.

Yes Yes

Copy Record(s) Copies records while in table view. Yes No

Chapter 1
EMC Basics
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Table 1-1    (Cont.) EMC Toolbar Icons

Toolbar
Icon

Name Function Available in
Table View?

Available in
Form View?

Undo/Redo Performs the undo/reload function.
You cannot undo the addition or
deletion of a record. EMC uses a
record-level undo, where all changes
to a single record are undone. You
cannot undo a previous change
because the flow and layout of EMC
make this an impractical option. The
standard Ctrl+Z functionality does
exist to undo changes to a text field.
In Employee Maintenance and Menu
Item Maintenance, undo is available
through the right-click menu only.

Yes Yes

Paste Record(s) Pastes records while in table view. Yes No

Toggle Table/
Form View

Switches the current module between
table view and form view.

Yes Yes

First Record Navigates to the first record in the
module.

No Yes

Previous
Record

Navigates to the previous visible
record in the module.

No Yes

Next Record Navigate to the next record. No Yes

Last Record Navigates to the last record in the
module.

No Yes

Go To Opens a dialog that allows you to type
an object number and navigate to the
specified record.

Yes Yes

Find Opens a dialog that allow you to find a
record based on text comparison in
any column.

Yes No

Go To Previous In some modules, go to links are
provided to quickly open other
modules. For example, the Job Codes
module includes a go to link to open
the Employee Classes module. After
clicking a go to link, this icon is
enabled. When clicked, it closes the
module that you were navigated to
(for example, Employee Classes) and
returns you to the module from which
the link was pressed (for example, Job
Code).

N/A N/A

Navigation Bar Switches the visibility of the
navigation bar in form view.

No Yes

Chapter 1
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2
Getting Started

This chapter provides a high-level overview of Simphony configuration.

Table 2-1    Getting Started

I Want To Go To

Configure the business start of day Resetting Daily Totals

Add properties Adding a Property

Configure languages Adding a Language

Configure currencies Payment and Currency

Add revenue centers Adding a Revenue Center

Add employees Employees and Privileges

Add menu items Menu Items

Add condiments to menu items Condiments

Create combo meals Combo and Fixed Price Meals

Configure menu levels Menu Levels

Configure service charges Service Charges

Configure taxes Taxes

Configure discounts Discounts

Configure guest checks and receipts Guest Checks

Add workstations POS Workstations

Configure workstation touchscreens Workstation Touchscreen Pages

Configure Kitchen Display Systems Oracle Hospitality Simphony KDS Configuration
and User Guide

Configure printers Printers

Configure cash drawers, coin dispenses,
barcode scanners, and other peripheral
devices

Peripheral Devices
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3
Enterprise

The term Enterprise refers to the company’s business operations managed by Simphony.
Simphony supports multiple properties, and administrators can configure each property
individually. Simphony allows these properties to report centrally to a single database.

Configuration flexibility accommodates differences between properties and revenue centers.
In an Enterprise, the EMC configuration hierarchy is important to the administrator. Some
module components are configured at the Enterprise and are then used in various properties
and revenue centers.

The EMC level refers to the location where an EMC module is configured. In the EMC, you
can configure modules for the Enterprise, property, revenue center, and zone levels based on
the information you are configuring. For example, employee roles are set at the Enterprise
level because typically a company keeps privileges the same throughout the Enterprise (for
example, all bartenders have the same privileges). Tax rates are set at the property level
because a property in Chicago uses different tax rates than a property in Dallas. Order
devices are set at the revenue center level for a particular restaurant.

The following figure depicts the Enterprise with two properties. One property has two revenue
centers (they might be a restaurant and bar), while the other property has one revenue
center.

Figure 3-1    Enterprise Hierarchy Organization Levels

Related Topics

• Configuring Permissions for the EMC

Inheritance and Overrides
When configuration elements that are the same throughout an Enterprise, inheritance allows
you to configure the elements once and use them throughout the properties and revenue
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centers. When an operation differs at the property or revenue center levels, override
allows you to break away from the ancestry.

When you configure a module at the Enterprise level, the property and revenue center
levels inherit the module settings. If you want the property or revenue center to have a
different configuration than the Enterprise level, you can override the inheritance at the
property and revenue center levels. For example, you can configure menu items at the
Enterprise level, and override the menu items for a property by changing the
configuration at the property level.

Some EMC modules show the Zone/Location or Tab and Inheritance Type columns.
The Zone/Location column shows the zone or the location (Enterprise, property, or
revenue center) of each record. The Inheritance Type column indicates the type of
inheritance for each record:

• Defined Here, No Override: This status indicates the record is defined in the
location of the module that is open. The record does not override another record. It
is possible that another record overrides this record. (EMC is not aware of records
below the current location.)

• Inherited: This status indicates the record is defined in another location, and it is
inherited in the current module and location.

• Defined Here, Overriding: This status indicates the record is defined in the
location of the module that is open. The record overrides another record from a
higher location.

Additionally, in Menu Item Maintenance, the Override Indicator column shows visual
markers denoting the overriding level hierarchy (where an item is configured) for
definitions on the Enterprise:

• Up arrow (↑): Indicates that there is a definition above the current level in the
hierarchy.

• Down arrow (↓): Indicates that it is overridden below in the hierarchy.

• Plus sign (+): Indicates that there is a definition at another unit, which can be a
peer to the current level or a different zone, which is not above or below the
current unit in the hierarchy.

You need to change a record from the location in which it is inherited. If the change
only applies to a particular location (such as the Bar revenue center), you can override
the record. You cannot edit an inherited record from a child hierarchy. When overrides
exist for a record, the lowest record location applies.

The Override Indicator column is calculated only when the Map Menu Item Override
option is set on the search panel.

Related Topics

• Configuring Permissions for the EMC

Distribution
Distribution is an EMC function that enables you to copy records between properties
and revenue centers. You can configure records once within the EMC and distribute
the records throughout the enterprise to multiple properties and revenue centers
without having to create a record multiple times.

Chapter 3
Distribution

3-2



Remote Distribution

Remote distribution enables you to distribute data between two different Simphony systems.
Remote distribution is database independent; therefore, you can distribute from a Microsoft
SQL database into an Oracle Database and conversely, from an Oracle Database into a
Microsoft SQL database. Remote distribution is specifically designed for the following two
scenarios:

• Moving data from a testing system into a production system. This allows testing in a pre-
production environment before moving to production.

• Distributing a new revenue center into the production system.

The Importance of Object Numbers

When records are distributed from one location to another, the object number stays the same.
Therefore, it is important to configure properties and revenue centers consistently. For
example, if object number 11 is Room Charge in one property, it must be Room Charge in all
properties. Consider the following sample serving period configuration in revenue center 4:

• Object Number: 1

• Default Transaction Page: 41

When distributing this record to revenue center 8, it is created with the object number 1, and
there are two possibilities for the default transaction page:

• If transaction page object number 41 exists in revenue center 8, the serving period's
default screen is set to 41.

• If transaction page object number 41 does not exist in revenue center 8, the default
screen is set to 0. This is the standard functionality for all types of distributed records. If
the referencing object number does not exist, the value is set to 0.

Related Topics

• Configuring Distribution Privileges

• Distributing Properties and Revenue Centers

• Distributing Records

• Distribution Based on Source, Destination, and Selected Options

Configuring Distribution Privileges
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, click the Actions tab, and then select the appropriate
privileges:

Table 3-1    Distribution Privileges

Privilege Name Allows the Employee to ...

Distribute Use the EMC Distribute function.
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Table 3-1    (Cont.) Distribution Privileges

Privilege Name Allows the Employee to ...

Remote Distribute Out Move data from one revenue center to
another revenue center or from one
property to another property between two
different Simphony systems. Select this
option to allow employees associated with
this role to remote distribute from this
Simphony system out to another Simphony
system.
Employees need login credentials with
permissions on the receiving Simphony
system to Remote Distribute In.

Remote Distribute In Move data from one revenue center to
another revenue center or from one
property to another property between two
different Simphony systems. Select this
option to allow employees associated with
this role to remote distribute from another
Simphony system into this Simphony
system.
Employees need Remote Distribute Out
permissions on the other system to
distribute in.

3. Click Save.

Related Topics

• Distribution

• Distribution Based on Source, Destination, and Selected Options

Distributing Properties and Revenue Centers
1. To distribute a property:

a. Select the Enterprise, click Setup, and then click Properties.

b. Select the source property record.

2. To distribute a revenue center:

a. Select the property, click Setup, and then click RVC Configuration.

b. Select the source revenue center record.

3. To distribute within the same Simphony system, in the EMC toolbar, click Edit, and
then click Distribute.

4. To remotely distribute between Simphony systems:

a. In the EMC toolbar, click Edit, and then click Remote Distribute.

b. Enter or select the Server or the IP address of the destination Simphony
system.

c. Enter the user credentials for the destination system in the User and
Password fields respectively, and then click OK to log on to the system.

5. From the Destination pane, select the destination properties or revenue centers.
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6. From the Modules To Copy pane, select the modules to distribute.

7. Select the appropriate options:

The following table lists the distribution options and indicates whether the options are
applicable for property distribution or revenue center distribution. See Distribution Based
on Source, Destination, and Selected Options for more information on how Simphony
distributes records based on the source record, destination record, and the configuration
of options Distribute inherited records and If destination record is inherited, create
override.

Table 3-2    Property and Revenue Center Distribution Options

Option Description Property RVC

Create Clone Select this option to copy IP addresses of
workstations and KDS displays and to
distribute all revenue centers and create
new revenue centers.
Selecting this option also enables the
Distribute RVCs and Copy IP Addresses
options.

Yes No

Distribute RVCs Select this option to distribute revenue
centers, including all modules, in addition to
distributing the selected modules for the
property, if revenue centers exist in both
properties. Existing records are overwritten
and new records are created.
Selecting Create Clone automatically
enables this option.

Yes No

Create RVCs If remote distributing, select this option to
create revenue centers in the destination
properties, if they do not exist.
This option only becomes active when you
select Distribute RVC.

Yes No

Copy IP Addresses Select this option to copy IP addresses of the
source record to the destination record. This
option applies only to modules where the
records include an IP address (for example,
workstations and KDS displays).
Selecting Create Clone automatically
enables this option.

Yes No

Distribute
inherited records

Select to distribute all records (defined and
inherited) to the destination property.
Deselect to distribute only records defined
at the source property.

Yes Yes

If destination
record is
inherited, create
override

Select to override inherited definition
records in the destination property. Deselect
to keep inherited records unchanged.

Yes Yes

Distribute Data
Extension if they
Exist

Select to distribute any existing data
extension values. The source and
destination data extension property record
must match

Yes Yes

8. Click OK.
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Related Topics

• Distribution

• Distribution Based on Source, Destination, and Selected Options

Distributing Records
This procedure is applicable for most modules in the EMC. Some modules, such as
Menu Item Maintenance, contain module-specific distribution dialog boxes. See 
Distributing Menu Items for more information.

1. Navigate to the module that you want to distribute.

2. To distribute records within the same Simphony system, in the EMC toolbar, click
Edit, and then click Distribute.

3. To remotely distribute records between Simphony systems:

a. In the EMC toolbar, click Edit, and then click Remote Distribute.

b. Enter or select the Server or the IP address of the destination Simphony
system.

c. Enter the user credentials for the destination system in the User and
Password fields respectively, and then click OK to log on to the system.

4. From the Record Selection pane, select the records to distribute:

• All Records: Select to copy all records from the source to the destination.

• Selected Records: Select to distribute only the selected records.

• Specify Records: Select to enter a list or range of records to distribute, and
then enter the record numbers or ranges in the text box below separated by a
comma. For example, 3-7, 9-20, 21-30.

5. From the Options pane, select the appropriate options:

See Distribution Based on Source, Destination, and Selected Options for more
information on how Simphony distributes records based on the source record,
destination record, and the configuration of options Distribute inherited records
and If destination record is inherited, create override.

• Overwrite records if they exist: Select to overwrite existing records in the
destination location. If the destination record is inherited, it is not overwritten.

• Create records if they do not exist: Select to create new records in the
destination location.

• Distribute inherited records: Select to distribute all records (defined and
inherited) to the destination property. Deselect to distribute only records
defined at the source property. This option only appears if the module supports
inheritance and override.

• If destination record is inherited, create override: Select to override
inherited definition records in the destination property. Deselect to keep
inherited records unchanged. This option only appears if the module supports
inheritance and override.

• Distribute Data Extension if they Exist: Select to distribute any existing data
extension values. The source and destination data extension property record
must match.
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6. From the Destination pane, select one or more destinations for the records.

7. Click OK.

Once distribution completes, a Distribution Report appears showing all records that were
created, overwritten, and any errors encountered. You can save this report by clicking
Save to Disk.

Related Topics

• Distribution

• Distribution Based on Source, Destination, and Selected Options

Distribution Based on Source, Destination, and Selected Options
The following table describes how records are distributed based on the source record,
destination record, and the selected distribution options.

Table 3-3    Distribution Based on Source, Destination, And Selected Options

Record Source
Type

Record
Destination Type

Option Distribute
Inherited Records

Option If
Destination
Record is
Inherited, Create
Override

Destination
Record Created?

Inherited Inherited Selected Selected Yes

Inherited Inherited Selected Deselected No

Inherited Inherited Deselected Selected No

Inherited Inherited Deselected Deselected No

Inherited Defined Selected N/A Yes

Inherited Defined Deselected N/A No

Defined Inherited Selected Selected Yes

Defined Inherited Selected Deselected No

Defined Inherited Deselected Selected Yes

Defined Inherited Deselected Deselected No

Defined Defined Selected N/A Yes

Defined Defined Deselected N/A Yes

Related Topics

• Distribution

• Configuring Distribution Privileges

• Distributing Properties and Revenue Centers

• Distributing Records

Configuring Permissions for the EMC
You can set user permissions for the EMC modules. The privileges define the actions which
users linked to the role can perform throughout EMC.
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1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the record of the role for which to set user permissions (for example,
administrator, manager or server).

3. Click the EMC Modules tab.

4. Select the appropriate module permission options for the user role. You can grant
user permissions for the following module actions:

• View: Open and view a module. If you allow a user to Edit, Add, or Delete, you
must also grant View access (otherwise the user cannot open the module).

• Edit: Update fields or records within a module.

• Add: Add records to a module.

• Delete: Delete records from a module.

• Add Override: Override records within a module.

• Allow Duplicate Obj#: Add menu item records where existing records with
the same number exist elsewhere in the Enterprise.

• Allow Duplicate Name: Add records where existing records with the same
name exist elsewhere in the Enterprise.

To grant access for all module actions, select All Modules from the Global Access
section for each action. The All Modules option allows you to easily configure all
permissions for the user for every module without individually selecting each
option. Selecting All Modules also allows the user to access new modules that
become available in future Simphony versions. Oracle Hospitality recommends
granting All Modules permission for an administrator role.

5. Click the Actions tab.

6. Select the appropriate action permissions for the role.

To grant access to perform all actions, select All Actions from the Global Access
section. Selecting All Actions also allows the user to perform new actions that
become available in future Simphony versions. Oracle Hospitality recommends
granting All Actions permission for an administrator type of role.

7. Click Save.

Related Topics

• Enterprise

• Inheritance and Overrides
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4
Cloning Simphony Database Configurations

Starting with Simphony 18.2.2, you can clone an existing Simphony database configuration to
quickly set up a new database. Cloning a database configuration consists of extracting data
from a source environment and then uploading that data to the new target environment.
Roles are not deleted during the cloning process, preserving existing users, so they can
continue to log onto the system.

To clone a database configuration, you need the EMC logon credentials for both the source
and new target environments.

Note:

The Shell DB Clone tool only supports Oracle-to-Oracle Database solutions. The
tool is not supported for use with Microsoft SQL Server database installations.

How it Works

Data Extraction

• Data extraction from the source database only extracts configuration and definition
related data. It does not extract any Payment Card Industry (PCI) data (where cardholder
data includes any information that could be used to identify the individual) or transactional
data.

• Data extraction only partially occurs for employee related data. See the Post-Uploading
Cloned Data Instructions section for more information.

• A validation check is run against each extracted table for a row count of one million or
more. If the detected row count is greater than one million records, the extraction process
stops and users are prompted to confirm continuing with the data extraction. This is
meant as a safe-guard to ensure the data extraction is occurring from the correct
database.

• The Shell DB Clone tool is not designed to serve as a database backup strategy. Only a
limited amount of data/configuration items are extracted which does not fulfill an entire
database backup.

Uploading Data

• During the data upload process, the application first checks to ensure users are not
uploading data into an organization running live transactions.

• The Shell DB Clone tool detects any existing configuration related data and generates a
warning message to users which indicates the cloned data upload process deletes any
currently existing configuration records (as listed on the validation check window).
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Figure 4-1    Uploading Data Validation Check

Note:

You can proceed with uploading cloned data despite the warning
message by clicking the Erase Data & Proceed button, but be aware
the cloned data upload does not merge data, rather it only inserts cloned
data.

Extracting Data from the Source Environment

1. Log in to the source environment.

2. Click Clone Config on the toolbar.

3. Click Create Configuration Export File.

4. In the Extract and Download window, click Download Link to download the data
ZIP file.

5. Log out of the clone configuration tool.

Uploading Data to the Target Environment
1. Log in to the new target environment.

2. Click Clone Config on the toolbar.

3. Drag and drop the data ZIP file to the Import Configuration window or click the link
to upload the file. Do not unzip the data ZIP file first.

Chapter 4
Extracting Data from the Source Environment

4-2



4. Click Import Configuration File.

5. After the upload is complete, verify the configuration settings in the new environment.

If the upload fails, review the error messages returned by the clone tool, and then try the
upload again.

If configuration data exists in the target environment, the clone tool detects the data
during the upload. To overwrite the existing data with the data you are uploading, click
Erase Data & Proceed.

Post-Uploading Cloned Data Instructions
Once you have successfully uploaded cloned data, you need to access the EMC for the new
environment and perform the following:

Employee Configuration

Most personal information data contained in employee records is not cloned during the data
extraction process. Your new environment now contains only partial employee records which
can be used to log on to the EMC (for example, as the default user). Users need to configure
employee information such as their first and last name, password, email address, and enable
their access to generate Reporting and Analytics reports, and so on.

See the Oracle MICROS Simphony Configuration Guide, specifically the Employees and
Privileges chapter and the Configuring Employee Privileges for Oracle Hospitality
Reporting and Analytics topic in the Reporting chapter for more information.

Reporting and Analytics Integration

Reporting and Analytics configuration data is not cloned. Users need to map all associated
properties and revenue centers to the Reporting and Analytics environment.

See the Oracle MICROS Simphony Installation Guide, specifically the Post-Installation
Tasks chapter, and the Connecting Reporting and Analytics to Simphony topic for more
information.

Workstation Configuration

Existing workstations are erased during the cloning process. Workstations for the targeted
location need to be updated with their correct host names, subnet masks, and default
gateways.

See the Oracle MICROS Simphony Configuration Guide, specifically the POS Workstations
chapter for more information.

CAL Package Configuration

CAL packages are not cloned. As with standard operations, you need to assign CAL
packages to the workstations. After this is complete, workstations with updated CAL
packages can begin to process transactions.

See the Oracle MICROS Simphony Client Deployment Guide for more information.
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5
Log File Management

Built-in log archiving capabilities are included with Simphony version 2.8 and later. Rather
than deleting the oldest log file when a log reaches its maximum size, Simphony compresses
the oldest log file up to two percent of its original size and then stores it in an AutoArchive
folder, which is located in the same directory as the original logs. This reduces the disk space
consumed by the log files and allows you to keep the files for a longer period of time. For
example, if the maximum file size for a single log file is 1 MB and the total amount of disk
space (log size) that can be used by all log files is 10 MB or 10 logs, when the application
generates the eleventh log, it compresses the oldest log file and moves it to the AutoArchive
folder.

Simphony names the archived files after the log files and includes the date and time of
compression. You can easily search the log files for a particular date. For example, if the log
file is Log_PEPPER_172.txt, the archived file is
Log_Pepper_172.DateOfCreation_TimeOfCreation.zip.

Simphony purges archived log files only when one of the following configured thresholds is
met:

Table 5-1    Log Archive Purge Thresholds

Purge Threshold Description

LogArchiver.MinDiskUsedPercent This threshold defines the free disk space threshold.
When the free disk space falls below the configured
percentage, Simphony purges the archived files.
The minimum disk space is set to 10% by default.

LogArchiver.MaxDiskUsedMB This threshold defines the maximum size for the
archived files. When the total size of all the archives
exceeds the configured amount, Simphony purges the
archived files.
The size is set to 100 MB by default.

LogArchiver.DaysToKeeep This threshold defines the number of days to keep the
archived logs before purging.
The number of days to keep is set to 21 days by default.

The ArchiveHistory.txt file, which resides in the original log directory, tracks log archiving
operations. When this file reaches 20 KB, Simphony renames it to
ArchiveHistory.previous.txt. Simphony retains only one ArchiveHistory.previous.txt file at a
time.

Log archiving is active by default for application servers and services, while it is deactivated
by default for workstation services due to the constrained disk space of workstations.
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Modifying the Default Log Archive Purge Settings for
Application Services

To modify the default archive purge settings, you need to add entries to four
application service configuration files. The following table lists the configuration files for
the application services and their locations:

Table 5-2    Application Services Configuration Files

Application Service Configuration File Name Location

EGateway Service Web.config [Drive
Letter]:\MICROS\Simphony2\EGateway
Service

Data Transfer Service
(DTS)

DataTransfeService.exe.c
onfig

[Drive
Letter]:\MICROS\Simphony2\DataTran
sfeService

Direct Posting Service
(DPS)

DirectPostingService.exe.
config

[Drive
Letter]:\MICROS\Simphony2\DirectPos
tingService

Sequencer Service SequencerService.exe.co
nfig

[Drive
Letter]:\MICROS\Simphony2\Sequence
rService

1. Browse to the file location and open the configuration file.

2. Add the following entries:

• To turn off log archiving, add <add key="LogArchiver.Enabled"
value="false" />.

• To change the free disk space threshold, add <add
key="LogArchiver.MinDiskUsed-Percent"
value="MinDiskUsedPercent" />.

• To change the maximum size for the archived files, add <add
key="LogArchiver.MaxDiskUsedMB" value="MaxDiskUsedMB" />.

• To change the number of days to keep the archived logs, add <add
key="LogArchiver.DaysToKeep" value="DaystoKeep" />.

3. Repeat Steps 1 and 2 for each configuration file listed in the table.

Enabling Log Archiving for Workstations
Workstations keep 10 logs by default.  In some cases, it is necessary to retain the logs
for a longer period of time. This is accomplished by enabling the Log Archiving
settings on each workstation where needed.

Once enabled, an additional folder in the EGatewayLog folder named AutoArchive is
created. The logs that are rotated out of the EgatewayLog folder are then zipped and
placed in the AutoArchive folder.
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There are default values in place to ensure that the Workstations do not keep excess logs,
which can cause disk space issues. The available default values are:

• MinDiskUsedPercent: 10 — When only 10% free space remains on the workstation's
drive, the oldest logs are removed as each log is rotated.

• MaxDiskUsedMB: 100 — When only 100 MB of free space remains on the workstation's
drive, the oldest logs are removed as each log is rotated.

• DaysToKeep: 21 — Any archived logs older than 21 days are removed

To override the defaults, optional keys and values can be added as well. Care should be
taken when overriding the default values to ensure that the Workstation does not run out of
disk space.

To enable this functionality:

1. Browse to the [Drive Letter]:\MICROS\webserver\wwwroot\EGateway folder and open the
Web.config file.

2. Add the following entry to the Web.config file:

<add key="LogArchiver.Enabled" value="true" />
3. Add optional keys to override default values by adding the following entries:

• <add key="LogArchiver.MinDiskUsedPercent" value="MinDiskUsedPercent" />
• <add key="LogArchiver.MaxDiskUsedMB" value="MaxDiskUsedMB" />
• <add key="LogArchiver.DaysToKeep" value="DaystoKeep" />

4. Save the changes.
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6
Properties

A property is a place of business. A property can have one or more revenue centers within a
confined geographic location. For example, a hotel property can have three revenue centers
(restaurant, bar, and gift shop), and a shopping mall can have several restaurant revenue
centers. Both properties can belong to the same Simphony Enterprise, but each property has
separate sales figures, tax information, and other configuration specific to the location.

Adding a Property
1. Select the Enterprise level, click Setup, and then click Properties.

2. Click the Insert icon  on the toolbar.

3. In the Add Property dialog, enter the Property Number and Property Name.

4. To include this property in Reporting and Analytics, select Add Location To Simphony
Reporting.

5. Select the Time Zone for the property location.

6. (Optional) The content in the Simphony Reporting Location section is intended for users
of Simphony Transaction Services (STS) Gen 2. If you want customers to view your
property name and location information via STS Gen 2, complete this section.

See Transaction Services for more information about Transaction Services Gen 1 and
STS Gen 2.

7. If the property connects to Labor Management Cloud Service, enter the Simphony
Labor Logon username and Simphony Labor Password.

8. Select the appropriate options as applicable:

• Enable Inventory: Select to enable Inventory Management for the property.

• Enable Enterprise Labor Management: Select to enable Labor Management for the
property.

9. (Optional) To copy information from a property template, in the Source Property section,
select Copy from source property. The hierarchy panel and Modules To Copy fields
become active.

a. To add the property to the same locations as the template property, select Add to
Zones

b. In the hierarchy panel, select the property to use as the source property.

c. In the Modules to Copy section, select the modules you want to copy from the source
property. To automatically select all modules, click the Select All Modules link.

d. (Optional) To copy the Internet Protocol (IP) addresses of workstations and kitchen
display system (KDS) displays, and to create new revenue centers, select Create
Clone. Selecting this option essentially selects the next two options (described in
Steps 9d and 9e).
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e. (Optional) To create new revenue centers for the property based on the
existing revenue centers in the template property, select Create RVCs.

f. (Optional) To copy the IP addresses of workstations and KDS displays from
the source property to the destination property, select Copy IP Addresses.
Use this option when properties are segmented on their own networks and IP
address conflicts do not occur.

g. (Optional) To distribute all records (defined and inherited) from the source
property to the destination property, select Distribute inherited records.
Deselect this option to distribute only records defined at the source property to
the destination property.

h. (Optional) To create an override record in the destination property when an
inherited definition exists, select If destination record is inherited, create
override.

i. (Optional) To distribute data extension values, select Distribute Data
Extensions if they exist.

10. Click OK to copy the records from the source template property to the new
property.

11. Click Save.

12. In the Properties module table view, double-click the property you just added.

13. In the Oracle MICROS Reporting and Analytics section, select the location
configured in the reporting database from the Report Location drop-down list.
The Oracle MICROS Reporting and Analytics database determines the locations
that appear in the list.

a. To add a location, click New, and then enter the appropriate information. An
administrator must then add the information to the Reporting and Analytics
property list in order to run reports.

b. To change an existing location, click Edit, and then enter the appropriate
information.

If you change the report location for a live location, update the corresponding
Simphony Transaction Services API account in Oracle MICROS Reporting
and Analytics to use the same location.

14. Click Save.

Adding a Revenue Center
1. Select the property, click Setup, and then click RVC Configuration.

2. Insert a record.

3. From the Add Revenue Center dialog, enter the RVC Number and the RVC
Name.

4. (Optional) To copy information from an existing revenue center, select Copy from
source Revenue Center from the Source Revenue Center section. The hierarchy
panel and Modules To Copy fields become active.

a. From the hierarchy panel, select the revenue center to use as the source
revenue center.
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b. From the Modules to Copy section, select the modules you want to copy from the
source revenue center. To automatically select all modules, click the Select All
Modules link.

c. (Optional) Select Distribute inherited records to distribute all records (defined and
inherited) from the source revenue center to the new revenue center. Deselect this
option to distribute only records defined at the source revenue center to the new
revenue center.

d. (Optional) Select If destination record is inherited, create override to create an
override record in the new revenue center when an inherited definition exists.

e. (Optional) Select Distribute Data Extensions if they exist to distribute data
extension values if they exist.

5. Click OK to copy the records from the source template revenue center to the new
revenue center.

6. (Optional) Toggle to Form view. The content in the General section is meant for users of
Simphony Transaction Services (STS) Gen 2. If you want customers to view your
Revenue Center name and location information via STS Gen 2, complete this section.

See Transaction Services for more information about Transaction Services Gen 1 and
STS Gen 2.

7. Toggle to Table view and select the following options as applicable for the new revenue
center:

• LDS Active: Select this option if the revenue center uses a Liquor Dispensing
System (LDS), which is a third-party system used for pouring and tracking liquor and
beverages, as well as mixed drinks.

• KDS Controller: Select the KDS Controller to control the kitchen display system
(KDS) order devices in the revenue center.

8. Click Save.

After adding a new revenue center, restart the workstation to ensure changes are saved.

Revenue Center Groups
You can create a revenue center group for use when a property hosts an event that occurs in
multiple revenue centers. For example, a baseball game takes place in every revenue center
at a stadium. When you create the event, you can associate it with the revenue center group
rather than selecting each revenue center individually.

Revenue center groups are also useful when multiple revenue centers use the same kitchen
or bar to prepare menu items. You can set a Menu Item Availability record for a revenue
center group.

Configuring a Revenue Center Group
1. Select the property, click Setup, and then click Revenue Center Groups.

2. Insert a new record or select an existing record, and then double-click the record to open
it.

3. Select the revenue centers to include in the revenue center group.

4. Click Save.
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Deleting a Property
Administrators can remove a property from the Enterprise when it has stopped
operating. All property level data is removed, including revenue centers in the property.

Before deleting a property, close all modules in the EMC that are related to the
property, and close all open checks and transactions.

1. Select the Enterprise level, click Setup, and then click Properties.

2. Highlight the property to delete, and then click the Delete icon ( ) on the toolbar.

3. On the Properties: Delete dialog, click Yes to confirm.

A progress bar shows the status. Depending on the amount of data being deleted,
the deletion process may take several minutes.

If you click Cancel, the operation will finish deleting the current property, but will
not delete any properties remaining in the queue.
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7
Zones

Zones are custom hierarchies within the Enterprise. You can use zones to group similar
aspects of an Enterprise together to manage configuration tasks with minimum effort and to
eliminate duplicate configuration. For example, you can categorize:

• Taxes by country, state, county, and city

• Prices by region, tier, and property

• Menu item maintenance by item groups (food, beverage, retail), price tiers, and stores

Zones assist in managing definitions and records in a more streamlined manner. Simphony’s
Inheritance and Override feature enables you to configure definition records on the Enterprise
level, and they are inherited throughout the system. If there are unique circumstances where
a particular definition must be different from an inherited record, you can override that record
at the zone, property, or revenue center level. Inheritance and Override contains more
information.

For example, you can create a country zone for the Enterprise, create sub-zones (child
zones) for each country, and then create or override the records from the relevant level as
illustrated in the following figure. This figure shows a sample zone hierarchy for a single
record group, where the existence of records is denoted in blue and inheritance is denoted in
gray.
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Figure 7-1    Sample Zone Configuration

A single revenue center or property can belong to multiple zones, and a single zone
can contain an unlimited number of sub-zones. Zones with meaningful names provide
a clear overview of the structure. Configuring zones effectively:

• Allows privileged users to view and navigate the entire Enterprise from within the
EMC in a more logical manner

• Creates a big picture that shows which locations might be affected by potential
changes or updates

• Saves time with definition handling and updates throughout the system

• Controls definition distribution to POS clients

Record Priority within Multiple Zone Configurations

If a property or revenue center exists in multiple zones, Simphony uses the definition
record which is closest to the hierarchy when determining which record to use for a
specific object number. For example, in the following figure, the Enterprise depicted
has two separate zone hierarchies. The Country zone has two sub-zones: United
States and Canada. The second zone, Concepts, also has two sub-zones:
Restaurants and Retail. Both zone hierarchies have revenue centers in common.
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Imagine that a discount record is defined in the Enterprise, and the four sub-zones (United
States, Canada, Restaurants, and Retail) override this discount record, which is then
inherited by their properties and revenue centers respectively. The existence of the record is
denoted in blue and inheritance is denoted in gray.

Figure 7-2    Sample Configuration of a Single Record Definition
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Because the revenue centers are closer to the definition record in the Concepts zone
(RVC 1-1 is only one level away from Restaurants while it is two levels away from
United States), the Concepts zone record wins.

Consider the following sample configuration for multiple discount records:

Figure 7-3    Sample Configuration of Multiple Record Definitions

Given the configuration in the above image, Simphony uses the following discount
records for Property 1:

• Record 1 defined in Property 1

• Record 2 defined in the United States zone

• Record 3 defined in the Unites States zone

• Record 4 defined in the Enterprise

• Record 5 defined in Property 1

Record Collisions

Record collisions occur when a property or revenue center has two competing winning
records that are the same number of levels away from the hierarchy. For example, in
the following figure, RVC 4-2 is one level away from Property 4 and Retails, both of
which have overriding record definitions.
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Figure 7-4    Sample Zone Configuration with Record Collision

While EMC prevents you from manually creating a competing record, such situations can
arise when moving revenue centers and zones, or when using the Import/Export Service. In
such instances, EMC detects the error and prevents you from opening the module
corresponding to the definition record until the conflict is resolved.
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Example Configuration Scenarios

You can use zones to organize the Enterprise in multiple ways. Here are a few
examples:

• Example 1: Region zones are useful for many applications, from global
considerations such as alphanumeric keyboards and currencies to tax or labor
laws. These zones are usable repeatedly in multiple trees.

Figure 7-5    Sample Zone Configuration for Regions

• Example 2: Enterprises that have different concepts (Dine-In, Take-Out) between
properties or revenue centers can manage their differences through zones.
Similarly, zones are useful for configuring brands. Hotel chains that have certain
concessions in various or all properties can configure them as zones and place the
appropriate revenue centers into the Brand Zones to inherit the relevant records.
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Figure 7-6    Sample Zone Configuration for Brands

Reporting and Analytics Posting

Reporting and Analytics is zone independent. Transactions post to the actual location where
the transaction originated. For example, if a menu item definition record originated in the
Retail zone, it posts under the revenue center that inherited the record from the zone at the
time of the transaction. If you create an overriding record later in the same revenue center
and another transaction is posted for the same menu item, Reporting and Analytics shows as
if the price change was made for the same menu item.

Related Topics

• Creating Zones

Creating Zones
1. Select the Enterprise, click Setup, and then click Zone Configuration.

2. In the Zone Configuration pane on the left, right-click Enterprise, and then select the
appropriate option:

• Add Zone: Select to create only a single zone.

• Add Multiple Zones: Select to create more then one zone simultaneously.

3. In the Add Zones to Enterprise dialog, enter the Name and Object Number for each
zone, and then click OK.
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Enter a meaningful name, such as a description of what modules are defined in
the zone, to provide a clear overview of the structure.

4. To apply enforcement rules to the zone to prevent record collisions and unwanted
updates:

a. From the Zone Configuration pane, select a zone, and then click Edit
Selected Note.

b. Select the appropriate Zone Type:

• 0 - None: Select if the zone has no restrictions.

• 1 - Properties and RVCs: Select if the zone can only contain properties
and their revenue centers.

• 2 - RVCs Only: Select if the zone can only contain revenue centers.

c. Select the appropriate enforcement rules. The following table describes the
enforcement rule options and indicates the zone types for which each option is
available.

Table 7-1    Zone Enforcement Rule Options

Option Description Non
e

Properti
es and
RVCs

RVCs
Only

1 - Enforce Unique
Properties within
this Zone

Select to prevent properties
from existing more than once in
the zone and all child zones.

No Yes No

2 - Enforce Unique
RVCs within this
Zone

Select to prevent revenue
centers from existing more than
once in the zone and all child
zones.

No Yes Yes

3 - Modules Available
in this Zone are not
available in Child
Zones.

Select to prevent child zones
from inheriting the modules
from the zone.

Yes Yes Yes

4 - All RVCs must be
from the same
Property

Select to enforce all revenue
centers within the zone to
belong to the same property.

No No Yes

5 - Sort the selected
zone alphabetically

Select to sort a zone in
alphabetical order.

Yes Yes Yes

d. To make all EMC modules configurable in the zone, select All Modules.

e. To select the EMC modules that are configurable in the zone, deselect All
Modules, and then select the modules that are accessible from the EMC
module list.

Modules that are available in one location are also available in the children of
that location, unless you configure otherwise.

f. Click OK.

5. To add properties to a zone:

a. From the Zone Configuration pane, right-click the zone, and then click Add
Properties.

b. From the Add Property dialog, select the properties to add, and then click OK.
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6. To add revenue centers to a zone:

a. From the Zone Configuration pane, right-click the zone, and then click Add Revenue
Centers.

b. From the Add RVC dialog, select the property to which the revenue centers belongs,
and then select the revenue centers from the list.

c. Click OK.

7. To apply enforcement rules to the properties or revenue centers in the zone:

a. From the Zone Configuration pane, select a property or revenue center, and then
click Edit Selected Node.

b. Select the appropriate enforcement rules and configurable EMC modules. Refer to
the Zone Enforcement Rule Options table in Step 4 for more information on the
enforcement rules.

8. Click OK.

Related Topics

• Zones
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8
POS Workstations

A workstation is a device used by managers, servers, bartenders, hosts, and cashiers at a
property to perform various functions, such as creating guest checks, adding menu items,
applying discounts and service charges, and paying a check. Examples of POS workstations
include the Oracle MICROS Workstation 6 Series and the Workstation 5a.

Workstation Tasks
Adding a workstation consists of completing the following tasks:

• Adding a workstation

• Configuring workstation transaction settings

• Setting offline transaction posting time

• Configuring workstation security

• (Optional) Configuring an Android mobile device as a workstation

Related Topics

• Adding a Workstation

• Configuring Workstation Transaction Settings

• Setting Offline Transaction Posting Time

• Configuring Workstation Security

• Allowing Employees to Install and Authenticate POS Clients and Service Hosts

Related Topics

• Workaround for Android Lollipop 5.0.2 and 5.1

• Configuring the Android Device as a Workstation

• Configuring an Android Workstation

• Viewing and Editing Simphony Android Files

Adding a Workstation
1. Select the property, click Setup, and then click Workstations.

2. Insert a record for the workstation, enter the name, and then click OK.

Workstations cannot be named using solely numerical characters. Alpha characters must
be included in each workstations naming convention. A combination of alphanumeric
characters is supported.

3. Double-click the new workstation record.

4. On the General tab, enter information in the following fields:
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Table 8-1    General Workstation Settings

Field Description

Type Select the type of workstation from the drop-down list:
• 1 - Mobile MICROS: Mobile devices
• 2 - Workstation Client: Workstations, virtual

machines, and Android tablets
Select this option when configuring these devices:
– Oracle MICROS Workstation 6 Series
– Oracle MICROS Tablet 700 Series
– Oracle MICROS Compact Workstation 310

• 3 - POSAPI Client: Simphony Transaction Services
or Pay@Table

• 6 - MICROS Tablet Client: Oracle MICROS Tablet
E-Series
Select this option for the Oracle MICROS Tablet E-
Series 11-inch.

Language Select the default language of the workstation. This is
the language that appears on the workstation’s Sign
On screen. If an employee has a different default
language set, the employee sees their default language
after signing in to the workstation.

Resolution Cols Enter the number of Resolution Columns for the
workstation’s display. The default value is 0 (zero).

Resolution Rows Enter the number of Resolution Rows for the
workstation’s display. The default value is 0 (zero).

Log Verbosity Select the logging verbosity for the workstation. Select
0 (zero) for minimal logging. Higher log verbosity
provides more information in the log file, which may
be helpful in troubleshooting issues.

(Optional) Workstation
Class

Select a Workstation Class to allow similar
workstations to be grouped together and to share
certain page configuration settings.

Database Update Frequency Enter the number of seconds for the workstation to
receive changes. The default value is 1800 seconds (30
minutes).
The value in this field overrides the Property
Parameter’s Database Update Frequency setting.

Check Inactivity Timeout Enter the number of seconds before the workstation
shows the message (Do you need more time?),
prompting the workstation operator to cancel the
transaction. When you enter 0 (zero), the message
does not appear.
When you select Enable Follow Me from the RVC
Parameters module, the check is automatically
suspended rather than cancelled.

Check Inactivity Dialog
Timeout

Enter the number of seconds that the workstation
shows the Inactivity dialog before automatically
cancelling the transaction. This field is unavailable
when you set the Check Inactivity Timeout value to 0
(zero).
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Table 8-1    (Cont.) General Workstation Settings

Field Description

Report Timeout Enter the number of seconds the workstation waits for
a response before showing a communication failure
notice.

Address / Host Name Enter the IP address or host name of the Oracle
Hospitality Simphony Service Host where the
workstation application runs.

Subnet Mask Enter the subnet mask of the Service Host where the
workstation application runs.

Default Gateway Enter the default gateway of the Service Host where
the workstation application runs.

Is Connectionless Select this option to have the Service Host open and
close a new connection for each web service call. This
prevents the workstation from reaching the maximum
number of web connections allowed, although the
connection becomes slightly slower.

Is Windows Service Select this option to allow the Service Host to start as a
Windows service. The Service Host service starts on
Microsoft Windows startup with other Microsoft
Windows services. The POS client starts only when the
workstation operator signs on to the operating system.
If you select this option, you need to change the ports
of the services being run (for example, Check and
Posting Service (CAPS) and Oracle Hospitality
Simphony Kitchen Display System (KDS) Controller) in
addition to the POS client. Use the EMC modules to
change the ports.
If a non-POS client is required to run on the Service
Host, it must run on a different port than the
workstation port.
You can also set the Service Host to run as a Microsoft
Windows service from the Service Host module
(rather than from the Workstations module). If you set
this option in the Service Host module, you do not
need to change the ports of the services being run as
the device is not intended to run the POS client.

5. Click the Options tab, and then click the Display/Security subtab.

6. Select the appropriate Display Options:

Table 8-2    Workstation Display Options

Display Option Description

5 - Do Not Clear Screen After
Transaction

Select this option to have the last screen of a transaction
remain visible on the workstation display after the
transaction is complete.

6 - Enable Rear Display Select this option to enable output to a rear customer
display that is attached to the workstation.
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Table 8-2    (Cont.) Workstation Display Options

Display Option Description

33 - Show Cursor Select this option to show the mouse cursor for this
workstation when workstations are installed on PCs (such
as a host/hostess desk). This option is usually disabled for
Workstation 4 and other Oracle MICROS hardware
platforms.

39 - Floating Tablet Select this option for an Oracle tablet that is not docked to
a base station. When enabled, the tablet cannot configure
or use the majority of the hardware devices that
traditional workstations support.

42 - Display Discounts on
Customer Display

Select this option to show discount totals and amount due
on the second line of the customer display. Deselect this
option to show only the amount due.

43 - Auto-Pickup Next Check In a drive-through environment, select this option to allow
the Payment Window workstation to automatically pick up
the oldest open check (that has this workstation’s order
type) as soon as the current check is paid. When no checks
are open, the workstation prompts to check again or to exit
the Auto-Pickup functionality. This option is intended for
drive-through environments that have an Ordering
Window and a Payment Window.

44 - Use LCD Customer Display Select this option to use an LCD customer display. Deselect
this option to use a pole display. This option is dimmed
when 6 - Enable Rear Display is deselected.

52 - Do not display currency
symbol on rear/customer
display

Select this option to suppress the currency symbol
appearance on the rear customer display.

53 - Display non-rounded
amounts on rear/customer
display

Select this option to show a non-rounded value for the total
amount due on a rear customer display.
You must also select 4 - Round Currency in the Currency
Parameters module. Configuring Base Currency and Alternate
Currency contains more information.

54 - Display Change to
dispense in Bills in the Change
due dialog

Select this option to show the Change to Dispense in bills in
the Change Due dialog. This lets workstation operators
easily determine the change due in bills while the coin
dispenser dispenses the rest of the amount.

61 - Always Hide Frame Select this option to hide the POS Operations window
frame when the POS Operations UI is not in full-screen
mode.

62 - Prompt for Destination
Printer when docked

Select this option to have the workstation prompt for a
Destination Printer (if configured) when docked.

7. Click the Printers tab.

8. Click the Select link next to each printer type that you need to configure, select the
printer, and then click OK.

9. Click the Revenue Centers tab.

10. Select the revenue centers for the workstation. You must select at least one
revenue center.

11. Click Save.
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12. When adding or removing workstations, you need to edit the system’s license count using
the following steps:

a. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

b. Click the License Configuration tab.

c. Click Configure adjacent to Workstations Client License Count.

d. To add a license count (for the first time), select I would like to set the license
count to X, making the new license count X.

e. To append licenses to an existing license count, select I would like to add X to the
current license count, making the new license count Y.

f. Enter the number of client licenses purchased.

g. (Optional) Enter additional details regarding the purchased license in Enter
Reference Information for the License Count Change, and then click OK.

h. Repeat Steps 12-c through 12-g for Transaction Service Client License Count,
and KDS Client License Count.

i. Click Save, and then click Yes to agree to the license.

j. To perform a side by side comparison of the number of purchased licenses against
the number of configured clients, click View adjacent to the Properties, Revenue
Centers, Concessions Terminals, Workstation Client License Count, Transaction
Services Client License Count, or KDS Client License Count labels.

Related Topics

• Workstation Tasks

Configuring Workstation Transaction Settings
1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation record to open it.

3. Click the Transactions tab, and then enter information in the following fields:

Table 8-3    Workstation Transaction Settings

Field Description

Minimum Check Number Enter the minimum guest check number to use:
• When the workstation is in offline mode
• When the workstation is used in revenue centers

without the RVC Parameters option Use Revenue
Center Check Numbers. In these revenue centers,
each workstation determines its own check number
range.

Maximum Check Number Enter the maximum guest check number to use:
• When the workstation is in offline mode
• When the workstation is used in revenue centers

without the RVC Parameters option Use Revenue
Center Check Numbers. In these revenue centers,
each workstation determines its own check number
range.
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Table 8-3    (Cont.) Workstation Transaction Settings

Field Description

(Optional) Default Order Type Select the default active order type for the workstation
(for example, Dine In, Take Out, or Drive Thru).

Barcode Format Set Select the barcode format for the workstation to read
barcodes of various lengths.

Cashier Link Select the cashier record to link to the workstation. This
provides a link to tracking totals for Tender/Media
information.
This field is available only when you select 8 - On = Link
Cashier Totals to WS; OFF = Link to Operator from the
Workstations module (Optionstab, and then the Offline/
Misc subtab).

Merchant Group Select the merchant group for the workstation, or select
0 - Use RVC Setting to use the settings from the revenue
center in which the transaction occurs.
If multiple revenue centers exist, each revenue center
may route payment information to a different bank.
These banks can be grouped into merchant groups.

Thai Tax Rd Number If applicable, enter the number to print on Thai Tax
trailers.

4. Click Save.

Related Topics

• Workstation Tasks

Setting Offline Transaction Posting Time
When a property or its workstations are unable to communicate with the database for
an extended period of time, transactions do not post. You can determine whether
offline transactions post using the current time or the transaction time once
communication resumes.

1. Select the property, click Setup, and then click Property Parameters.

2. Click the Options tab.

3. To allow offline checks to post to the database (when communication with the
Check and Posting server is re-established) with the actual time of the transaction,
select 6 - Post Offline Transactions with Actual Transaction Time. Deselect
this option to allow offline checks to post with the time that the check is uploaded
into the database.

4. Click Save.

Related Topics

• Workstation Tasks

Configuring Workstation Security
1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation record to open it.
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3. Click the Options tab, and then click the Display/Security subtab.

4. Select the appropriate options:

Table 8-4    Workstation Security Options

Security Option Description

Mag Card Entry Required for
Employee ID

Select this option to require all employee
identification (ID) entries at the workstation to use
a magnetic employee identification card (for
example, to sign on and authorize privileged
operations). When you select this option, the
workstation does not accept an employee ID
number entered through the keyboard or
touchscreen. Deselect this option to allow
employee ID entery by either a magnetic card or
by the keyboard or touchscreen.

Disable Employee Auto Sign Out Select this option to if you do not want to use the
Automatic Operator Popup Interval set in the
RVC Parameters module. Deselect this option to
sign out workstation operators after the
Automatic Operator Popup Interval is reached.

Use Alternate ID for Sign-in Select this option to allow workstation operators to
sign on using a four-digit alternate ID number
rather than a ten-digit employee ID number.

Fingerprint Scan Required for
Employee ID

Select this option to require all employee ID
entries at the workstation to scan a fingerprint.
When you select this option, the workstation does
not accept an employee ID number entered
through the keyboard or touchscreen.

Employee ID or Fingerprint Scan
Required for Employee ID

Select this option to require all employee ID
entries at the workstation to scan a fingerprint or
enter an employee ID through the keyboard or
touchscreen. When you select this option, the
workstation only accepts an employee ID number
entered through the keyboard or touchscreen, or
fingerprint scan.

Employee ID and Fingerprint Scan
Required for Employee ID

Select this option to require all employee ID
entries at the workstation to scan a fingerprint and
enter an employee ID through the keyboard or
touchscreen. When you select this option, the
workstation only accepts an employee ID number
entered through the keyboard or touchscreen and
fingerprint scan.

Mag Card or Fingerprint Scan
Required for Employee ID

Select this option to require all employee ID
entries at the workstation to scan a fingerprint or
swipe a magnetic card. When you select this
option, the workstation only accepts either a
magnetic card swipe or fingerprint scan.

Mag Card and Fingerprint Scan
Required for Employee ID

Select this option to require all employee ID
entries at the workstation to scan a fingerprint and
swipe a magnetic card. When you select this
option, the workstation accepts only a magnetic
card swipe and fingerprint scan.

5. Click Save.
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Related Topics

• Workstation Tasks

Changing the Appearance of Workstations
1. Select the Enterprise, property, or zone, click Configuration, and then click

Theme Assignment.

2. Change the following settings:

• Default Theme: Select the default theme for the workstations.

• Default Palette: If you selected Edge as the Default Theme, select the color
palette for the theme.

3. Click Save.

Configuring the Magnetic Stripe Reader on the Oracle
MICROS Tablet 720

The Oracle MICROS Tablet 720 comes with a built-in OPOS Mag Stripe Reader
(MSR).

1. In EMC, select Property, Setup, Hardware/Interfaces, Workstations, and then
Devices.

2. In the Peripheral Device Configuration section, click Add.

3. For Select Peripheral Device Type, select OPOS Mag Stripe Reader.

4. For Configuration, enter IDTECH_SECUREMAG_USBHID.

5. Click OK, and then Save.

The Oracle MICROS Tablet 720 Setup Guide contains more information on setting up
and using the Tablet 720.

Configuring the Barcode Scanner on the Oracle MICROS
Tablet 720

The Oracle MICROS Tablet 720 comes with a built-in OPOS Barcode Scanner.

1. In EMC, select Property, Setup, Hardware/Interfaces, Workstations, and then
Devices.

2. In the Peripheral Device Configuration section, click Add.

3. For Select Peripheral Device Type, select OPOS Barcode Reader.

4. For Configuration, enter Honeywell.

5. Click OK, and then Save.

The Oracle MICROS Tablet 720 Setup Guide contains more information on setting up
and using the Tablet 720.
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Allowing Employees to Install and Authenticate POS Clients and
Service Hosts

In Simphony release 19.1, you must allow administrator employees to download software,
install, and authenticate clients and service hosts using CAL version 145. After granting this
privilege, employees can use their credentials to configure POS clients. In addition, the User
Security Credentials configured in the Property Parameters module become inactive.

1. Select the Enterprise, click Configuration, and then click Roles.

2. Double-click an employee role.

3. Click the Operations tab, click the Miscellaneous subtab, and then select 10065 -
Download Software, Install and Authenticate Clients and Service Hosts Using CAL.

4. Click Save.

Related Topics

• Workstation Tasks

Using the Simphony POS Client and Mobile Solution Application
on One Device

Your organization can run Mobile Solution 18.1 (used with Oracle Hospitality Inventory
Management and Oracle Hospitality Materials Control) on a Simphony tablet device. To share
applications on the device, you need to configure a button (using the Page Design module in
the EMC) that closes the Simphony POS client on the device. (Minimizing Simphony does not
release the scanner.)

After configuring the Close Application function button:

• When the device is powered on, the Simphony POS client starts automatically.

• The workstation operator must click the Close Application button to stop the Simphony
POS client.

• The workstation operator must manually start the Mobile Solution application.

• After using Mobile Solution, the workstation operator must stop it.

• The workstation operator must manually start the Simphony POS client.

Related Topics

• Configuring the Close Application Button

Configuring the Close Application Button
To configure a button that closes Simphony on the workstation:

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the page on which to place the close application button.

3. On the Edit tab, select the page area in which to define the button.
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4. Click Button to add a button.

5. From the Type drop-down list, select Function.

6. Click the black arrow beneath the Type drop-down list.

7. In the Name field, enter close, select Close Application in the Results section,
and then click OK.

8. On the General subtab, click the Generate Legend link.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Related Topics

• Using the Simphony POS Client and Mobile Solution Application on One Device

POS Clients Running Android Mobile Operating System
You can run Simphony release 2.7 and later on devices that have the Android mobile
operating system. The Simphony POS client operates in a similar way on an Android
mobile device and a Microsoft Windows device. You can configure the POS client
using the EMC.

Oracle recommends using one revenue center per Android device, and a maximum of
10,000 menu item definitions.

The UI is the same on all devices and workstations. Android devices have special
requirements to consider, including deployment method, configuration requirements,
and the procurement process.

The Oracle Food and Beverage Compatibility Matrix contains more information about
supported POS client operating systems.

Related Topics

• Workaround for Android Lollipop 5.0.2 and 5.1

• Configuring the Android Device as a Workstation

• Configuring an Android Workstation

• Viewing and Editing Simphony Android Files

Android Functionality Support
Note the following functionality limitations when using Simphony on an Android device:

• Simphony does not support remote access to the Android desktop for certified
support applications (for example, Bomgar, Remote Desktop Protocol (RDP), and
so on).

• Android devices only operate the Simphony POS client application and cannot
host shared services that other devices might access.

• Android devices do not support the Check and Posting Service (CAPS). Therefore,
the property must use at least one device with a Microsoft operating system in
addition to the Android device. Oracle Hospitality recommends that this device be
an Oracle MICROS Workstation 5a (POSReady) or Oracle MICROS PC
Workstation 2015.
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Related Topics

• Workaround for Android Lollipop 5.0.2 and 5.1

• Configuring the Android Device as a Workstation

• Configuring an Android Workstation

• Viewing and Editing Simphony Android Files

Android Network Requirements
Android devices are connected wirelessly to Simphony using an 802.11x network. Therefore,
it is vital that the property have a high quality wireless network. Spotty Wi-Fi coverage causes
application performance issues with check sharing and posting, as well as bouncing between
online and offline states with the services on property (for example, check and posting,
printing and kitchen display) and the Enterprise, which impacts the ability to receive database
updates.

You must configure the Android device to use a wireless local area network (WLAN) with
connectivity to the local area network (LAN) used by the Check and Posting Service and
other Simphony POS clients with which they might share checks. Simphony does not support
the use of a 3G or 4G connection through a telecommunications provider back to these local
devices.

Oracle Hospitality recommends that you configure Android devices to use a static Internet
Protocol (IP) address. Simphony does not support the use of Dynamic Host Configuration
Protocol (DHCP) assigned addresses unless you define a DHCP reservation.

Related Topics

• Workaround for Android Lollipop 5.0.2 and 5.1

• Configuring the Android Device as a Workstation

• Configuring an Android Workstation

• Viewing and Editing Simphony Android Files

Android Payments
The Android clients support credit card processing and other forms of electronic payments.

The following drivers are supported with the Android mobile operating system:

• OPI/SPI

The loadable Stored Value and Loyalty modules support Android clients, and are used with
Oracle Hospitality Gift and Loyalty and with FreedomPay. The Xprocessor Extension
Application, which is used for third party gift cards such as Givex, does not support Android
devices.

Related Topics

• Workaround for Android Lollipop 5.0.2 and 5.1

• Configuring the Android Device as a Workstation

• Configuring an Android Workstation

• Viewing and Editing Simphony Android Files
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Workaround for Android Lollipop 5.0.2 and 5.1
Devices running the Android version Lollipop (5.0.2 and 5.1) mobile operating system
do not render the WebView drop-down lists properly. To resolve this issue, update the
Android WebView Component.

1. Open the Play Store app on the Android device.

2. Search for, and then select the Android System WebView app by Google.

3. Tap Update.

Related Topics

• Workstation Tasks

• POS Clients Running Android Mobile Operating System

• Android Functionality Support

• Android Network Requirements

• Android Payments

Configuring the Android Device as a Workstation
Perform the following steps before installing Simphony software.

1. Configure the Android device to be a member of the POS network using a static
Internet Protocol (IP) address.

2. Install antivirus software on the device.

3. Turn off Trusted Sources on the device. See the manufacturer instructions for
details.

4. If you are using a Bluetooth printer, pair it with the device. See the manufacturer
instructions for details.

Related Topics

• Workstation Tasks

• POS Clients Running Android Mobile Operating System

• Android Functionality Support

• Android Network Requirements

• Android Payments

Configuring an Android Workstation
1. (Optional) If you are using a printer with the Android device, configure the printer

from the Printers module. Configuring a Printer contains more information about
setting up the printer.

2. Select the property, click Setup, and then click Workstations.

3. Insert a new workstation record.

4. Double-click the record to open it in form view.
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5. Enter information in the workstation configuration fields, and set the Type as 2 -
Workstation Client.

If you are configuring a Motorola MC40 device, set the Type as 1 - Mobile.

6. Enter the Internet Protocol (IP) address or host name of the Service Host where the
workstation application runs in the Address/Host Name field.

7. Click the Options tab, and then click the Display/Security subtab.

8. Select 39 - Floating Tablet.

9. (Optional) If you are using a printer, click the Printers tab, and then select the printer.

10. Click the Revenue Centers tab, and then assign the device to a revenue center.

11. Click Save.

12. To install the Simphony Service Host on an Android Device, see the Oracle MICROS
Simphony Client Deployment Guide, specifically the CAL on Workstations chapter.

Related Topics

• Workstation Tasks

• POS Clients Running Android Mobile Operating System

• Android Functionality Support

• Android Network Requirements

• Android Payments

Viewing and Editing Simphony Android Files
After installing Simphony on an Android device, you can use the Configuration Management
Tool to view and edit certain files.

1. Launch the Simphony application on the Android device.

2. After the application loads, perform the following task on the Android device: On event
(left swipe + right swipe + left swipe + tap + tap).

3. Enter the code based on the six-digit number shown at the top, and then tap Sign In. The
Management Tool Home screen appears.

4. The following table lists the options and actions you can perform.

Table 8-5    Simphony Android Files

Option Action

View web.config.txt Tap to view and edit the web.config.txt file

View config32.web Tap to view and edit the config32.web file

View Log Tap to view the EGateway Log

View LogZone Tap to view the LogZone_LoadHandlers.txt
file, which is not editable

Ping Server Tap to view the Server Name or IP Address

Delete DataStore Tap to delete the DataStore database file and
restart the application on the device
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Table 8-5    (Cont.) Simphony Android Files

Option Action

Copy DataStore Tap to copy the DataStore database file
within the device

Related Topics

• Workstation Tasks

• POS Clients Running Android Mobile Operating System

• Android Functionality Support

• Android Network Requirements

• Android Payments

Wireless Signal Strength Threshold
Wireless devices occasionally behave unpredictably or inconsistently due to weak
wireless signal strength or a flickering network, leaving the device in a state that is not
consistently online or offline. To handle unstable network environments, you can
configure the wireless network signal strength at which devices automatically go
offline. Configure the wireless signal strength threshold for workstations that use a
wireless network (tablet devices running the Microsoft Windows and Android mobile
operating systems). Some devices may have both cable and wireless network
connections; when docked, the device can use both network types. Disable this
wireless signal strength feature when docking a device with a cable (wired) network.

You can define the wireless threshold settings from the following EMC modules:

• Property Parameters: The values are set at the property.

• Workstations: The workstation inherits the values from the property, unless
overridden here.

Related Topics

• Configuring Wireless Signal Strength Control Permissions

• Configuring the Wireless Signal Strength Threshold for Tablet Devices

Configuring Wireless Signal Strength Control Permissions
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type record (for example, administrator, manager or server).

3. Click the Actions tab, and then click the Hardware subtab.

4. Select the Wireless Monitor option.

5. Click Save.

Related Topics

• Wireless Signal Strength Threshold
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Configuring the Wireless Signal Strength Threshold for Tablet
Devices

1. Perform one of the following, depending on which level you want to configure or override:

• To configure at the property level, select the property, click Setup, and then click
Property Parameters.

• To override at the workstation, select the property, click Setup, and then click
Workstations.

2. On the General tab, in the Wireless Signal Strength Control section, enter information in
the following fields:

• Offline Threshold: Enter a number between 0 and 99 to represent the signal
strength percentage at which devices go offline. Devices will go offline when the
signal strength is at or below this percentage value. For example, if the Offline
Threshold is set to 90 (90%), and the device’s current signal is 89%, the device will
go offline. When the signal is detected above 90%, the device reconnects online.

• Reconnect Threshold: Enter a number between 0 and 99 to represent the signal
strength percentage at which devices recover online after being in an offline state.
Devices will go online when the signal strength is at or above this percentage value.
For example, if the Reconnect Threshold is set to 80, and the device’s signal
strength is 85%, the device will go online.

These values appear in a status bar on the POS client workstation.

3. Click Save.

Related Topics

• Wireless Signal Strength Threshold

Configuring an Alpha-Numeric Keyboard
The following steps describe how to configure an Alpha-Numeric Keyboard in EMC:

1. In Enterprise Management Console, select the property, click the Setup tab, and then
click Alpha-Numeric Keyboard under the Custom Content section.

2. Insert a new record. Choose Regular Alpha-Numeric or Small Screen Alpha-Numeric
from the template record drop down menu.

3. Add a name for the record, and then click OK.

4. In the list view, set the desired language from the Language drop down menu.

5. Click the Options button, and then ensure that the Default keyboard for this language
option is enabled.

6. Double-click the record to enter page design view.

7. In page design, add the necessary buttons for the workstation. Ensure that the Popup
Alpha Numeric Keyboard button is added. In addition to this, add a Cancel button to be
able to exit in the workstation.

8. Click the Save icon to complete.
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9
Language Settings and Translation

Simphony allows you to translate the user interface to the local language and to maintain
translation files for the EMC. You can configure up to four languages to appear on
workstations, guest checks, and customer receipts. When a new language is configured for a
property, all POS workstation clients must receive the new database updates and must
restart prior to the changes becoming active. When the Translation CAL package is loaded,
the POS workstation clients, including the CAPS workstation, need to be restarted upon
receiving the language translation files.

Simphony upgrades earlier versions of translation files to later versions, and translates all
languages defined in the system. You cannot translate core translation files as they are
managed internally.

Configuring languages allows strings that have been translated to be presented to the user
based on their language setting. You must manually translate menu items, touchscreen
buttons, and user-defined strings in the EMC.

Adding Languages contains a list of all supported languages in Simphony.

Related Topics

• Configuring Translation Privileges

• Configuring Languages

• Configuring Workstation Translations

• Configuring the EMC Translation Files

• Translating Menu Item Records

• Translating Touchscreen Buttons

• Setting Languages for the Property

• Setting the Default Language for a Workstation

• Configuring Screen Language Buttons

• Copying Translations from One Language to Another

• Exporting a Translation File

Language Translation Configuration Tasks
Configuring language translation in Simphony consists of completing the following tasks:

Table 9-1    Overview of Configuring Languages

Task Go To

Set the Translation Privileges Configuring Translation Privileges

Create an Enterprise language entry Adding a Language
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Table 9-1    (Cont.) Overview of Configuring Languages

Task Go To

Load translation file • Loading Workstation Translations
• Setting Languages in the EMC

Translate definition data • Translating Menu Item Records
• Translating EMC Records
• Translating Touchscreen Buttons

Set languages for the property Setting Languages for the Property

Assign languages to employees Associating Languages to Employees

Set the default language for a workstation Setting the Default Language for a Workstation

(Optional) Configure Simphony to print a
secondary language on guest checks and
customer receipts

Multiple Languages on Guest Checks and
Customer Receipts

(Optional) Create touchscreen button to switch
between languages on workstations

Configuring Screen Language Buttons

Related Topics

• Configuring Translation Privileges

• Configuring Languages

• Configuring Workstation Translations

• Configuring the EMC Translation Files

• Translating Menu Item Records

• Translating Touchscreen Buttons

• Setting Languages for the Property

• Setting the Default Language for a Workstation

• Configuring Screen Language Buttons

• Copying Translations from One Language to Another

• Exporting a Translation File

Configuring Translation Privileges
To enable privileges so that users can modify, import, or configure translations,
perform the following steps:

1. Select the Enterprise, click Configuration, and then click Roles.

2. Double-click the role type, click the Actions tab, and then select the appropriate
privileges:
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Table 9-2    Translation Privilege Settings

Privilege Name Allows the Employee to... Recommended Roles

EMC Text Translations Import and modify the EMC
related text files

Property expert

Workstation Text
Translations

Import and modify
workstation related text files

Property expert

3. Click Save.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Configuring Languages
Configuring languages as described in this procedure changes the user interface message
language on workstations, and in the EMC for text labels, options, help text, and error
messages. You must manually change the language for EMC records, menu items, and
touchscreen buttons.

1. Select the Enterprise, click Setup, and then click Languages.

2. Insert a record and enter a name (for example, Spanish).

3. Double-click the record to open it.

4. On the General tab, select the language from the Keyboard Type drop-down list.

5. On the Printing tab, set the following options (if needed):

• Print Custom Numerals: Select this option to print numerals defined in the Custom
Numerals field on the General tab.

• Asian Characters: Select this option for languages such as Chinese, Japanese,
Thai, and Korean where characters are picture-based. When you select this option,
characters print double-wide to make them more readable. The order device printer
also prints the characters double-wide to maximize readability.

• Mapping Font: By default, this option is set to Amap (used for Arabic). Select Vmap
for Thai and Hebrew.

6. Click the Miscellaneous tab.

7. Select the language from the Locale String drop-down list. The following table lists all
supported languages in Simphony.

Table 9-3    Supported Language Settings

Language Locale String Local ID Language Culture

Arabic Arabic-SaudiArabia Arabic (Saudi Arabia) ar-SA

Chinese (Simplified) chinese-simplified Chinese (People's
Republic of China)

zh-CHS

Chinese (Traditional) chinese-traditional Chinese (Taiwan) zh-CHT
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Table 9-3    (Cont.) Supported Language Settings

Language Locale String Local ID Language Culture

Danish danish Danish (Denmark) da-DK

Dutch dutch Dutch (Netherlands) nl-NL

English english-us English (United
States)

en-US

Finnish finnish Finnish (Finland) fi-FI

French french France (France) fr-FR

German german German (Germany) de-DE

Hebrew hebrew Hebrew (Israel) he-IL

Italian italian Italian (Italy) it-IT

Japanese japanese Japanese (Japan) ja-JP

Korean korean Korean (Korea) ko-KR

Norwegian norwegian Norwegian (Norway) nb-NO

Portuguese (Brazil) portuguese Portuguese (Brazil) pt-BR

Portuguese (Portugal) portuguese Portuguese (Portugal) pt-PT

Russian russian Russian (Russia) ru-RU

Spanish spanish Spanish (Spain) es-ES

Swedish swedish Swedish (Sweden) sv-SE

Thai chinese Thai (Thailand) th-TH

Turkish turkish Turkish (Turkey) tr-TR

See http://msdn.microsoft.com/en-us/library/ee825488(v=cs.20) for a detailed list
of language codes.

8. Select the Local ID from the drop-down list, and then enter the Language Culture
corresponding to the language.

9. Click Save.

10. To configure translated text files for the workstation, see Configuring Workstation
Translation Files.

11. To configure translated text files for the EMC, see Configuring the EMC Translation
Files

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Configuring Workstation Translations
Configuring Translations for Required Files

The following file types require translation configuration:

• OPS Text
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• POS Core Text

• Payment Cash

To configure translated text files for required files:

1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the appropriate language record to open it.

3. Click the General tab, and apply the appropriate language abbreviation in the Text File
Name field. Refer to the table of standard language abbreviations below these steps as
an example.

Figure 9-1    General Tab

4. Click Save.

Note:

If you are using non-standard languages (that is, any language other than the
20 standard languages that are included with Simphony), proceed to the
following steps.

5. Click the Text Files tab.
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Figure 9-2    Text Files Tab

6. Click the Add link in the Text File Configurations section, and then select the file
type from the File Type drop-down list.

7. Click the Edit link, and then click the Import from a file link.

8. Browse to the [Drive
Letter]:\MICROS\Simphony2\Tools\Translations folder, and then select
the file corresponding to your language. Use the following sample German
translation text file names as an example:

a. For an OPS Text file, select OpsText_de.xml to translate to German.

b. For a POS Core Text file, select PosCoreText_de.xml to translate to
German.

c. For a MICROS Payment Cash file, select MicrosPaymentCash_de.xml to
translate to German.

9. Click Open, click OK, and then click Save.

Note:

Text files uploaded to EMC are available to use for all client types.

Table 9-4    Sample Translation Files and Used Abbreviations for Language
Settings

Language Sample OpsText Filename Abbreviation

English OpsText.xml No Abbreviation

German OpsText_de.xml de

Spanish OpsText_es.xml es

Italian OpsText_it.xml it

French OpsText_fr.xml fr

Danish OpsText_da.xml da

Dutch OpsText_nl.xml nl
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Table 9-4    (Cont.) Sample Translation Files and Used Abbreviations for
Language Settings

Language Sample OpsText Filename Abbreviation

Arabic OpsText_ar.xml ar

Portuguese OpsText_pt.xml pt

Finnish OpsText_fi.xml fi

Japanese OpsText_ja.xml ja

Korean OpsText_ko.xml ko

Norwegian OpsText_no.xml no

Portuguese (Brazil) OpsText_pt_BR.xml pt_BR

Russian OpsText_ru.xml ru

Swedish OpsText_sv.xml sv

Thai OpsText_th.xml th

Turkish OpsText_tr.xml tr

Chinese (Simplified) OpsText_zh_CN.xml zh_CN

Chinese (Traditional) OpsText_zh_TW.xml zh_TW

Configuring Translations for Custom Files

The following steps are required only for non-standard language users.

In addition to configuring the required translated files for POS client workstations and the
EMC, you can also configure the translated text for the following custom files:

• Micros.Payment.LoadableCreditCardModule

• Micros.Payment.LoadablePmsModule

• LoyaltyCommandModule.dll

• StoredValueCommandModule.dll

To configure translated text files for custom files:

1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the appropriate language record to open it.

3. Click the General tab and set the language abbreviation. Refer to Step 3 from the
previous section if you have not set your language abbreviation.

4. Click the Text Files tab.

5. Click the Add link in the Text File Configurations section, and then select 0 - Custom
from the File Type drop-down list.

6. Click the Edit link, and then click the Import from a file link. For standard language
users, Simphony's preset translation files are automatically sent through the Service Host
Download package.

7. Browse to the [Drive Letter]:\MICROS\Simphony2\Tools\Translation folder,
and then select the custom text file corresponding to your language.
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For example, if you are adding a translation text file for
StoredValueCommandModule.dll, browse to that folder in the Translations folder,
and select the desired language. Use the following sample German translation text
file name as an example:

• StoredValueCommandModule.dll_de.xml
8. Click Open, and then click OK.

9. Repeat Steps 3 through 5 for each custom file.

10. Click Save.

Configuring Translation Files for Non-Standard Languages

The following steps apply to users who need to create a translation file for a non-
standard language (that is, any language other than the 20 standard languages that
are included with Simphony).

1. Select the Enterprise, click Setup, and then click Languages.

2. Create a custom language record by clicking the Add icon on the toolbar. Click OK
to save the custom language record.

3. Click the General tab and set the language abbreviation in the Text File Name
field. Refer to this site and find the appropriate language abbreviation in the ISO
639–1 column.

4. Click the Translation tab and select the desired Text File Type.

5. In the Translated Text column of the Text Elements section, manually translate
each text element listed in the desired language. For example, if the non-standard
language is Czech, manually translate each text element to its Czech equivalent.

6. After translating each text element, click Export to a File in the Text File section.
The custom text file name is automatically generated from the text in the Text File
Name field of the General tab. For example, when setting up a translation file for
OPS Text in Czech, the file name displays as OpsText_cz.xml if the
abbreviation was set to cz.

7. Navigate to the appropriate text file type folder, click Save, and then click OK.

8. The non-standard language translation file is now available for use when adding
and importing in the Text Files tab.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Configuring the EMC Translation Files
When you add a new language or after the Simphony Cloud Service has been
upgraded, you need to import the translation files for each local language you want to
use or that you have configured.

To configure translated text files for the EMC:

1. Select the Enterprise, click Setup, and then click Languages.
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2. Double-click the language record to open it.

3. Click the Translation tab.

4. To access a standard translation file:

a. In the Type drop-down list, select EMC Text.

b. Click Import Standard Translation.

c. In the Select translation field, select the EMC Text file corresponding to the standard
language, and then click OK.

For example, select EMCText_de.xml for German.

If you do not import a standard translation file, the system will use the default English
(EMCText.xml). The default English text file does not appear in the list.

d. The Import Summary Report shows the number of fields that were successfully
imported from the application server. Click the Exit button.

The translated fields are listed in the Text Elements section of the Translation tab.

5. To manually import a translation file for each language used:

a. In the Type drop-down list, select EMC Text.

b. Click Import from a File.

c. Browse to the [Drive Letter]:\MICROS\Simphony2\EmcClient folder, select the
language translation text file, and then click Open.

d. Click Yes in the Translation dialog to proceed.

e. The Import Summary Report shows the number of fields that were successfully
imported from the application server. Click the Exit button.

The translated fields are listed in the Text Elements section of the Translation tab.

6. Click Save.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Translating Menu Item Records
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Maintenance.

2. Use the filters to search for the items to translate, and then click Search.

3. To translate menu item master records, enter the translated text in the relevant language
column on the Master Records tab.

For example, to translate master records to Spanish, enter the translated text in the
Name - Spanish column. Master records show a separate column for each language
configured in the Enterprise.

4. To translate menu item definitions, click the Definition Records tab, and then enter the
translated text in the relevant language column.
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Definition records show two extra columns per language, First - [Language
Name] and Second - [Language Name], to allow translations for the first name
and second name of each definition.

5. Click Save.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

EMC Record Translation
In the EMC, you can translate the name of any record into multiple languages using
the Text Translation dialog. This dialog is invoked by the Language Translation icon

( ) on the toolbar (or using the shortcut key F8). The Language Translation icon
only becomes active when a translatable text field or a translatable table view cell is
active in the module. This icon is dimmed if:

• Only one language exists in the Enterprise

• You do not have Edit access for the selected module

Translated text saves when the record itself is saved. Therefore, if you perform an
undo operation on a record, record translations are also reverted.

Related Topics

• Configuring Translation Privileges

• Configuring Languages

• Configuring Workstation Translations

• Configuring the EMC Translation Files

• Translating Menu Item Records

• Translating Touchscreen Buttons

• Setting Languages for the Property

• Setting the Default Language for a Workstation

• Configuring Screen Language Buttons

• Copying Translations from One Language to Another

• Exporting a Translation File

Translating Touchscreen Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page to translate, and then on the Edit tab, click the Translate current

item legend ( ) icon.
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3. In the Edit Content Area Translated Text dialog, enter the translation for each button in
the relevant language column.

The dialog shows a separate column for each language assigned to the current property
in Property Parameters. Each row in the grid represents a single touchscreen button.

4. Click Save.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Setting Languages for the Property
You can specify four languages that are available to be used in the property. Workstation
operators can then switch between the four different languages on the fly, independent from
the employee language settings. For example, if an employee has a different language
assigned that what is configured for the property, the workstation operator will be prompted to
select any of the available languages of the property upon first signing in to the workstation.

After configuring languages for a property, all POS workstation clients must receive the new
database updates and must be restarted prior to the changes becoming active.

To configure the screen languages for the property:

1. Select the property, click Setup, and then click Property Parameters.

2. On the General tab, select the default language from the Language 1 drop-down list.

3. (Optional) From the Language 2 through Language 4 drop-down lists, select the
secondary languages.

4. Click Save.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Setting the Default Language for Employees
You can configure the default language for employees, which appears on the following:

• POS Operations UI for the logged in workstation operator

• Workstation messages and prompts not configurable in the EMC

• PMC labels and ad hoc reports

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Employee Maintenance.

2. Double-click an employee record to open it, change the default Language of the
employee, and then click Save.

3. Repeat Step 2 for all employees.
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Setting the Default Language for a Workstation
You can configure the language that appears on the POS UI Sign-In page.

Employees with a different language configured see their default language after
signing in to the workstation.

The CAPS workstation requires the translation files, so the ad hoc reports for the
workstation operator who is signed in show the report in the his or her assigned
language.

1. Select the property, click Setup, and then click Workstations.

2. Double-click a workstation record to open it.

3. On the General tab, select the Language to appear on the workstation device,
and then click Save.

4. Repeat Steps 2 and 3 for all workstations.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Configuring Screen Language Buttons
If more than one language is configured, you can create touchscreen buttons to allow
workstation operators to switch between the languages.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the Front of House page on which to place the language buttons, and then
on the Edit tab, select the page area in which to define the buttons.

3. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

4. Click the black arrow directly beneath the Type drop-down list, and then select
Multi Language from the Type pane.

5. To allow workstation operators to select the preferred language from a list, select
Screen Language List, and then click OK.

6. To configure separate touchscreen buttons for each language configured for the
property, select Screen Language 1, and then click OK.

Screen Language 1 shows the descriptors for the default language.

7. Enter a Legend for the button, and then position and size the button on the page.

8. If you are creating separate buttons for each language, repeat Steps 3 through 7
and configure buttons for the following:

• Screen Language 2: Shows the descriptors for the second language defined
in the system.

Chapter 9
Setting the Default Language for a Workstation

9-12



• Screen Language 3: Shows the descriptors for the third language defined in the
system.

• Screen Language 4: Shows the descriptors for the fourth language defined in the
system.

9. Click Save.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation

Multiple Languages on Guest Checks and Customer Receipts
You can show guest check detail and print a customer receipt showing both primary and
secondary languages configured for the property. For example, English and Arabic can
appear on the guest check detail area of the POS client and print on the customer receipt.
When configured, all areas of the check show both languages, except the check number,
table number and employee name and number. These fields print in the primary language.

Multilingual printing with Simphony is supported through the internationalized domain name
(IDN) and ethernet interface. There is no need to change the default language setting for the
printer. Each property in Simphony can be set up to support four languages at one time for
multilingual printing.

Simphony version 2.7 and later supports printing custom numerals on a customer receipt (not
in the check detail area of the POS client). For example, Arabic digits can print on the
customer receipt rather than Latin digits.

Related Topics

• Printing a Secondary Language on Guest Checks and Customer Receipts

• Configuring Right to Left Reading Languages

• Creating a Print Language List Button

• Creating Print Language Buttons

Printing a Secondary Language on Guest Checks and Customer Receipts
To configure Simphony to print menu items in an alternate language beneath the default
language on guest checks and customer receipts:

1. Select the property, click Setup, and then click Property Parameters.

2. On the General tab, select a language from the Select Secondary Print Language
drop-down list. Select 0 - None to print only the default language.

3. Click Save.

4. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Format Parameters.

5. Click the Options tab.

6. Select 52 - Print Secondary Language on Guest Checks/Customer Receipt.

7. Click Save.
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Related Topics

• Multiple Languages on Guest Checks and Customer Receipts

Configuring Right to Left Reading Languages
To show guest check detail and print customer receipts and guest checks in the right
to left orientation configured for a language (for example, Arabic and Hebrew), set the
following:

• Enterprise Language

• Workstation Language

• Secondary Print Language

1. Select the Enterprise level, click Setup, and then click Languages.

2. Double-click the language record to open it.

3. To show the check detail area and customer receipt on the POS client and print in
right-to-left orientation, select Right-To-Left.

4. To print Hebrew characters in the correct order, select Reverse Word.

5. Click Save.

6. Select the property, click Setup, and then click Workstations.

7. From the Language drop-down list, select the language to appear on the
workstation.

You can override the default language on the workstation for specific employees
using the Employee Maintenance module. Employees with a different language
configured in Employee Maintenance see that language after signing on to the
workstation.

8. Click Save.

9. Select the property, click Setup, and then click Property Parameters.

10. From the Language 1 and Language 2 drop-down lists, select the primary and
secondary languages.

11. From the Select Secondary Print Language drop-down list, select the language.

To print only the default language, select 0 - None. When printing multiple
languages, the application prints item names in the order configured for the
property.

12. Click Save.

13. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Format Parameters.

14. Click the Options tab, and then select 52 - Print Secondary Language on Guest
Checks/Customer Receipt.

15. Click Save.

Related Topics

• Multiple Languages on Guest Checks and Customer Receipts
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Creating a Print Language List Button
When printing multiple languages, you can have each workstation operator select the
language from a list in the POS client using the Print Language List button.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Add a button to the appropriate screen with the function Print Language List.

3. Click Save.

Related Topics

• Multiple Languages on Guest Checks and Customer Receipts

• Workstation Touchscreen Pages

Creating Print Language Buttons
The Print Language function allows the workstation operator to select a specific language.
For example, if the secondary language is Arabic, the Print Language 2 button prints the
customer receipt in Arabic. Follow these steps to create one or more Print Language buttons.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Add a button to the appropriate screen with the function Print Language 2. Depending
on the number of languages, you can create other Print Language buttons (for example,
Print Language 3 and Print Language 4).

3. Click Save.

Related Topics

• Multiple Languages on Guest Checks and Customer Receipts

• Workstation Touchscreen Pages

Copying Translations from One Language to Another
1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the appropriate language record to open it, and then click the Translations
tab.

3. To copy all translations from another language, click Copy All Translations, select the
language from which to copy, and then click OK.

4. To copy the translations for selected elements:

a. From the Text Element section, select the relevant records, and then click Copy
Selected Translations.

b. Select the language from which to copy, and then click OK.

5. Click Save.

Related Topics

• Language Settings and Translation
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• Language Translation Configuration Tasks

• EMC Record Translation

Exporting a Translation File
After you modify a language file, you can export it and then import it into another
system.

1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the appropriate language record to open it, and then click the
Translations tab.

3. Click Export to a File, and then browse to the desired local directory and save the
file.

The default file name appends the language to the end. For example, if the
language is French, the exported default file name is OPSText_French.

Related Topics

• Language Settings and Translation

• Language Translation Configuration Tasks

• EMC Record Translation
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10
Privacy and Personal Data Management

Before entering and storing the personal information of an employee in the system, consent
must first be obtained. Consent can be denied, which stops you from entering a new
employee record. You can enable or disable the prompt of the consent message. The prompt
of the consent message applies for the Enterprise.

The consent notification message for an employee appears in the EMC at the Enterprise
level when creating a new employee. If consent is granted, the personal information is
entered in the Employee Maintenance module and stored in the application database.

The Audit Trail tracks and logs the user name of whomever is currently logged in (either in
the EMC or workstation), and responds to the consent request for employees. Audit Trail
contains more information.

Configuring Consent Messages
1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the Data Privacy tab.

3. Enter or paste the consent message for employees in the Capture Consent Message
text box, and then click Save.

The character limit for consent messages is unlimited. The default language is English
and you must first enter the consent message in English. You can then enter the
message in multiple languages (depending on the languages configured in the
Languages module). The language tabs that appear are those configured for the
Enterprise.

4. To enable the consent prompt, select Enable Consent Capture.

If Enable Consent Capture is enabled, when an administrator adds a new employee,
the configured consent message prompt appears in the administrator’s language. The
consent must be accepted to add a new employee. If consent is denied, the employee
record cannot be created nor saved.

5. To disable the consent prompt, select Disable Consent Capture. The Capture Consent
Message text box, and the No Of Days to keep Employee PII Data fields also become
inactive.

6. In the No Of Days to keep Employee PII Data field, enter the number of days after an
employee withdraws consent when the system de-identifies the employee’s PII data. De-
identifying deletes a person’s personal data from the system.

Removing Personal Data from Simphony contains more information about configuring de-
identification.

7. Click Save.

8. If prompted with a consent message for bulk updates for existing employees, click OK.

To deny the bulk updates for existing employees, click Cancel. The data is not saved.

9. To edit the consent message:
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a. Modify the message text, and then click Save.

If you modify the consent message, you are prompted with the option to trigger
re-capturing of consent from users.

b. To present the updated consent message to all employees and require
recapture of consent when employees log in to EMC, the workstation, the
Engagement Cloud Service, or the Simphony Web Portal, click OK.

c. On the Consent status updated successfully dialog, click OK.

The Employee Maintenance module shows all employee records and the Is
Consented option is unchecked for everyone. After an employee logs in and
agrees to the modified consent message, the Is Consented option becomes
checked.

Withdrawing Consent
Before withdrawing an employee’s consent, you must ensure that:

• Enable Consent Capture is selected in the Enterprise Parameters module. 
Configuring Consent Messages contains more information.

• The employee is in a deleted state. Deleting an Employee contains more
information.

If an employee has withdrawn consent, they can be reactivated if the employee
personal information has not been removed from Simphony. Consent must be asked
again upon reactivation. See Removing Personal Data from Simphony for more
information about de-identification.

1. Select the Enterprise, property, or revenue center, click Configuration, and then
click Employee Maintenance.

2. Select View Deleted Employees, and then click the Search button to locate the
employee record.

3. Right-click the employee record, and select Withdraw Consent.

4. In the Withdraw Consent confirmation dialog, click Yes. The employee’s consent
status is removed.

5. Click Save.

Removing Personal Data from Simphony
When you de-identify someone, their personal data is deleted from Simphony. The
employee who withdrew consent in the system will have their records de-identified
after a configured number of days. Simphony automatically runs a DTS job on a
periodic basis to check for records eligible for de-identification; the default is every 12
hours.

After an employee has been de-identified, the employee cannot be reactivated.

1. To configure automated de-identification:

a. Select the Enterprise level, click Setup, and then click Enterprise
Parameters.

b. Click the Miscellaneous tab.
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c. In the DTS Jobs section, enter the Interval for the Withdraw Employee Consent
job. This is the number of minutes between jobs. For example, if you enter 1, the
DTS job runs every minute.

d. Click Save.

2. To manually de-identify an employee without using the DTS job:

a. Select the Enterprise, property, or revenue center, click Configuration, and then click
Employee Maintenance.

b. Search for the employee record with the View Deleted Employees option selected in
the Search/Table View pane.

c. Right-click the employee record, and then select De-identify Now.

d. In the De-Identify Now confirmation dialog, click Yes. The employee’s PII data is de-
identified with a standard template.
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11
Employees and Privileges

If you are using Oracle Hospitality Labor Management, you need to add employees using
Labor Management. The Oracle Hospitality Labor Management Cloud Service Feature
Reference Manual, located at the Oracle Help Center, contains information about adding
employees in Labor Management. The initial employee information is sent from Labor
Management to Simphony. To change the role for an existing employee, use the Simphony
EMC.

In Simphony, privileges determine the activities an employee can perform, the EMC modules
available to the employee, and the types of transactions the employee can process. You can
configure privileges by the job role (for example, host, server, bartender, cashier, manager).

Creating Employee Roles
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Insert a record for the type of role (for example, host, bartender, server, manager, or
administrator), and then click OK.

3. Double-click the role type.

4. On the General tab, select the role security from the Level drop-down list.

Level 0 (zero) has greater privileges than level 9. The value in this field prevents EMC
users from creating employee records with greater privileges than the administrator is
granted. The following table describes typical levels for various types of roles. Gaps
appear to allow flexibility for other types of roles that are not listed.

Table 11-1    Role Security Levels

Level Type of Role

0 System Administrator

1 Enterprise Level Administrator

2

3

4 Property Level Administrator

5

6 Property Floor Manager

7

8 Bartender, Cashier, Server

9

5. Click the EMC Modules tab.

6. For each EMC module listed in the File column, select one or more of the following
privileges:
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• View: Selecting this option grants access to view a module. You must select
View so that employees in the role can open the module.

• Edit: Selecting this option allows employees in the role to update fields or
records within a module.

• Add: Selecting this option allows employees in the role to add records to a
module.

• Delete: Selecting this option allows employees in the role to delete records
from a module.

• Add Override: Selecting this option allows employees in the role to override
records in a module.

• Allow Duplicate Obj#: Selecting this option allows employees in the role to
add menu item records where existing records with the same number exist
elsewhere in the Enterprise.

• Allow Duplicate Name: Selecting this option allows employees in the role to
add records where existing records with the same name exist elsewhere in the
Enterprise.

• To easily configure a role to View, Edit, Add, Delete, or Add Override for every
module without individually selecting each option, right-click a column heading
and select Set All.

7. Click the Actions tab.

8. Select Enable for the appropriate EMC tasks listed in the Action column.

To activate a role for every module without individually selecting each option, right-
click the Enable heading, and then select Set All.

9. Click Save.

Creating Employee Classes
You can set collective options for a group of similar employee roles using an Employee
Class. Each employee must belong to an Employee Class to perform workstation
operations.

1. Select the property, click Configuration, and then click Employee Classes.

2. Insert a record for a group of employees (for example, server, bartender, or host),
and then double-click the record to open it.

3. On the General tab, set information for the fields as described in the following
table:

Table 11-2    Employee Class Settings

Field Description

#Hours/Day Before OT Enter the number of regular hours that
employees in the Employee Class can
work in a single day before being paid at
the overtime rate.
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Table 11-2    (Cont.) Employee Class Settings

Field Description

#Hours/Period Before OT Enter the number of regular hours that
employees in the Employee Class can
work in a single pay period before being
paid at the overtime rate.

ISL Options Select the ISL Employee Options to
allow employees in the Employee Class to
execute Interface Script Language (ISL)
scripts.
ISL is the Oracle Hospitality proprietary
interpreted language used to create small
programs called scripts. The ISL options
act like a transaction privilege level in an
ISL script. ISL scripts can be written to
include variables that check for the
presence of these privileges for the
employee who is running the script. If
the employee is not a member of an
Employee Class that has the necessary
ISL employee option set, the script does
not execute, and a privilege prompt
appears.

Default Trans TS Select the default touchscreen that
appears when members of the Employee
Class sign on to a workstation.

MMH Default Trans TS Select the default touchscreen that
appears when members of the Employee
Class sign on to a Mobile MICROS device.

Pickup/Add/Xfer SLU Style Select a touchscreen style that
workstation operators can use when
adding and transferring checks with the
Add/Transfer Check Screen Lookup
(SLU) function key.

View Screen/Style Names for RVC Select this option to view the screen
names and styles set in the revenue
centers.

4. Click the Operator Options tab.

5. For each revenue center listed, from the Operator Type drop-down list, select the guest
check printing method for workstation operators assigned to the Employee Class.

• By Round: Select this option to print a guest check at the end of each service round,
showing only the changes posted to the service round.

• On Demand: Select this option to print a buffered guest check after performing a
Service Total or tender set to print an on demand check.

• Temp On Demand: Select this option to print a guest check on demand (in a by
round manner).

• Special By Round: Select this option to print a guest check on demand for all rounds
except the first round of a check. The first round always prints. Subsequent service
rounds print if the Service Total is set to print an on demand check.

6. For each revenue center listed, select the appropriate Options for workstation operators
assigned to the Employee Class, and then click OK.
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Using a Server Employee Class as an example, you can require all servers in a
revenue center to enter the number of guests when beginning new checks and to
enter table numbers.

7. Click Save.

Menu Item Field Security
EMC Employee Role privileges have been added so access to all of the fields within
the Menu Item (MI) Master, MI Definition, MI Prices, Event Definitions, and Effectivity
Groups files can be controlled more precisely. All current EMC and POS client access
privilege controls remain enforced. However, all of the fields within these files now
have Editable, View Only, and Exclude privileges available for configuration. By
default, all of the new field access levels are set to Editable (full access privileges).

EMC Configuration

To configure the Role’s module Fields tab settings:

Access the EMC and select the Enterprise, Configuration tab, under Personnel,
Roles module.

Select the Fields tab. You can set the access levels under the Access column.

Select the drop-down list to view the settings. The levels you have available are:

• 0 - Editable

• 1 - View Only

• 2 - Exclude
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Figure 11-1    Roles Module ‘Fields’ Tab

From the same Roles module, when you select the EMC Modules tab, there is a column
named Field Level Security. This column shows an indicator (!) when viewed from Table
view if any of the access privileges located in the Fields tab have been set to the View Only
or Exclude access settings.

In the following example, the Manager role has been assigned View Only access privileges
for the Menu Item (MI) Masters and MI Definitions modules.
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Figure 11-2    Roles Module ‘EMC Modules’ Tab

If you restrict access to users using the View Only or Exclude Field settings, the
indicators (!) display on the tabs located in the MI Maintenance module while in Table
view. Additionally, if users attempt to filter a search using an excluded field, the Filter
becomes disabled.
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Figure 11-3    Menu Item Maintenance Module - Restriction Indicators for MI Records

If you are in Form view from within the Menu Item Definition module, restriction indicators
show on the record tabs as shown below.
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Figure 11-4    Menu Item Definition Module - Restriction Indicators from Form
View

When working with Event Definitions, if the Roles module Fields setting is assigned
to View Only or Exclude, the fields from within the module are grayed out and non-
configurable by the user.
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Figure 11-5    Roles Module ‘Fields’ Tab - Event Definitions

The grayed out fields shown here are non-configurable based on the previous Fields tab
configuration.
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Figure 11-6    Event Definitions Module Showing Grayed Out Fields

Figure 11-7    Event Definitions Module - Grayed Out ‘Areas’ Tab
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When working with Effectivity Groups, if the Roles module Fields setting is assigned to View
Only or Exclude, the fields from within the module are grayed out and non-configurable by the
user.

Figure 11-8    Roles Module ‘Fields’ Tab - Effectivity Groups

The grayed out fields shown here are non-configurable based on the previous Fields tab
configuration.

Figure 11-9    Effectivity Groups Module Showing Grayed Out Fields
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See Creating Employee Roles in the Employees and Privileges chapter for more
information.

Adding an Employee
You must have the Enterprise level permission Add Employees to add an employee
record from a template.

1. Select the Enterprise, property, or revenue center, click Configuration, and then
click Employee Maintenance.

2. Click the Insert Record icon from the toolbar. The Add Employees dialog appears.

3. From the Select a task to perform drop-down list, select Add Employee Record
from Template.

Using a template simplifies the process of adding employees.

4. Click the Select link next to the Employee To Copy field.

5. From the Select Employee dialog, select a template employee record, and then
click OK.

6. Enter employee information in the following fields, and then click OK.

• First and Last Name

• (Optional) Check Name: Enter the employee name to appear on guest checks
(for example, Sally S).

• (Optional) ID: Enter the employee identification number.

• Record Number: The next available record number appears by default.

• Property # and Name: The property where the employee works.

• RVC # and Name: The revenue center (RVC) where the employee works.

7. Click Yes in the Add Employee confirmation dialog.

8. If prompted with the employee consent message, click OK to accept consent and
save the new employee record.

Click Cancel to deny consent. The Warning Data Privacy Declined dialog appears.
If you click OK, the employee record is not created nor saved.

When employee consent capture is enabled, the consent must be accepted to add
a new employee.

9. To add another employee:

a. Click Yes on the Item Added Successfully dialog (prompt to add another
employee), and then repeat Steps 6 through 8

b. When you are finished adding employees, click No.

10. Click Save.

Deleting an Employee
You must have the Enterprise level permission called Delete Employees to remove an
employee record.
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1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Employee Maintenance.

2. Search for the employee record.

3. Right-click the employee record, and then select Delete.

4. From the Delete Employee Records dialog, click Yes to confirm.

5. To view a list of all deleted employees in the search area, select View Deleted
Employees, and then click Search.

6. To reactivate a deleted employee, right-click the employee record, select Reactivate, and
then click Yes to confirm.

After an employee has been de-identified, the employee cannot be reactivated because
the employee’s personally identifiable information has been deleted from Simphony and
cannot be reconstructed. Removing Personal Data from Simphony contains more
information about de-identification.

7. If you are an administrator and want to permanently delete an employee, right-click the
employee record, select Permanently Delete, and then click Yes on the prompts to
confirm.

You cannot permanently delete an employee who is not marked Is Deleted and who has
associated sales or timecard records in the Oracle Hospitality Reporting and Analytics
database. Employees are mapped between the Simphony and Reporting and Analytics
databases using the object number from the EMC. Consider the following example:

• Employee 12345, Ted Davis, has $500 in sales

• Employee 12345 is deleted from the database

• If the EMC allowed this employee to be permanently deleted, a new employee, Mary
Smith, could be added at employee record 12345 and the new employee would
essentially start with $500 in sales

Thus, the two-step employee deletion process preserves the object number between the
two databases. Because of this potential scenario, object numbers are not reusable. If
employee 12345 shows as Is Deleted in the database, you cannot create a new
employee record using number 12345.

8. Click Save.

9. To withdraw an employee’s consent, see Withdrawing Consent.

Changing Employee Information
You must have the Enterprise level permission Edit Employees to change an employee
record.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Employee Maintenance.

2. Search for the employee record using the Search Criteria fields to limit the results, and
then click Search. Depending on the hierarchy level at which you opened the Employee
Maintenance module (Enterprise, property, or revenue center), the resulting list of
employee records appears in one of the following tabs located near the lower area of the
screen:

• Employee Records – Enterprise level

• Property Employee Records – Property level
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• Operator Records – Revenue Center level

3. Make changes in either table view or form view. To make changes in form view,
double-click the object number of the employee record.

4. Change any of the information in the active fields. The following tables list the
types of information you can change for each hierarchy level.

Table 11-3    Employee Records Information

Subtab Type of Information

General Allows you to change basic information
about the employee, including name,
language, identification numbers, level,
group, email address, and EMC login
credentials.

Note:

The Employee Access Level is
not manageable from EMC
when Labor Management is in
use. When the Employee
Access Level is changed in
Labor Management, it is
subsequently updated in
Simphony.

Roles Allows you to change the employee’s
role.
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Table 11-3    (Cont.) Employee Records Information

Subtab Type of Information

Reporting In previous versions, this tab allowed
you to change an employee’s logon
credentials for Oracle Hospitality
Reporting and Analytics ( R&A).

Note:

Beginning with the Simphony
19.1.2 release, when integrated
with R&A version 20.1,
Reporting User creation is no
longer possible from the
Simphony EMC because the
Employee records Reporting
subtab has been disabled.
Moving forward, Reporting
Users are only able to be
created from the R&A version
20.1 application. It is still
possible to add Reporting Users
from Simphony when it is
associated with R&A version
9.1.

See the Enterprise Back Office 20.1
documentation, specifically the
Reporting and Analytics User Guide’s 
Adding Users section for more
information about adding users from
R&A.

References Shows the locations where the employee
is being referenced (excluding
workstations).

Table 11-4    Property Employee Records Information

Subtab Type of Information

General The General subtab allows you to change
basic information about the employee,
including name, employee class, revenue
center, check name, email address, and
clock-in options.

Job Codes The Job Codes subtab shows the job code
assigned to the employee in the property.
You can change the Regular and Overtime
Pay Rates for each job code.
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Table 11-4    (Cont.) Property Employee Records Information

Subtab Type of Information

Operators The Operators sub tab shows each revenue
center in the property where the employee
has an operator record. You can change the
Cash Drawer, Table Count, TMS Color, and
Server Efficiency. You can also select
whether to use the Employee Class options
or set options at the operator level.

Table 11-5    Operator Records Information

Subtab Type of Information

General The General subtab allows you to
change basic information about the
employee, including name, employee
class, revenue center, and clock-in
options.

Job Codes The Job Codes subtab shows the job code
assigned to the employee in the property.
You can change the Regular and
Overtime Pay Rates for each job code.

Operators The Operations subtab shows each
revenue center in the property where the
employee has an operator record. You
can change the Cash Drawer, Table
Count, TMS Color, and Server
Efficiency. You can also select whether to
use the Employee Class options or set
options at the operator level.

5. Click Save.

Configuring Employee Shifts
A shift is the period of time that an employee is scheduled to work. Employees can
volunteer or are scheduled to work more than one shift. Simphony provides the ability
to post employee or cashier totals to shifts to account for the multiple shifts worked
during a single business day.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Control Parameters.

2. Click the Options tab, and then select the appropriate shift options.
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Table 11-6    Shift Options

Option Description

49 - Enable Shift Tracking Select this option to activate shift reporting,
segregating employee, employee tip, and
cashier financial totals by shift. Deselect this
option to accumulate employee, employee
tip, and cashier totals in a single total set.
When you deselect this option, the
subsequent shift-related options are
dimmed.

50 - Increment Cashier Shift when Clocking
Out

Select this option to increment the shift for
the cashier associated with the employee
clocking out (except when clocking out on
break). Deselect this option to have the shift
for the cashier associated with the employee
remain the same.

51 - Increment Cashier Shift when Clocking
In

Select this option to increment the shift for
the cashier associated with the employee
clocking in (except when returning from
break). Deselect this option to have the shift
for the cashier associated with the employee
remain the same.

52 - Increment Cashier Shift when Changing
Job

Select this option to increment the shift for
the cashier associated with the employee
when they clock in with a different job. This
clock in occurs automatically when the
employee signs on to a workstation with a
different revenue center than the job in
which they are currently clocked in. Deselect
this option to have the shift for the cashier
associated with the employee remain the
same during this clock in cycle.

53 - Increment Cashier Shift when Changing
Revenue Center

Select this option to increment the shift for
the cashier associated with the employee
when signing on to a different revenue
center. Deselect this option to have the shift
for the cashier associated with the employee
remain the same when signing on to a
different revenue center.

54 - Prompt before incrementing Cashier
Shift

Select this option to prompt the employee to
increment the shift for the cashier
associated with the employee when the shift
is set to increment upon clocking in or out,
changing jobs, or changing revenue centers.
Deselect this option so that no prompting
occurs when the cashier shift is set to
increment through one of those methods.

55 - Prompt to Increment Cashier Shift after
Shift Report

Select this option to prompt the workstation
operator to increment the cashier shift when
a Cashier Shift Report is generated with a
shift scope. Deselect this option so that no
prompting occurs and the cashier shift does
not increment.
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Table 11-6    (Cont.) Shift Options

Option Description

56 - Increment Employee Shift when
Clocking Out

Select this option to increment the shift for
the employee upon clocking out (except on
break). Deselect this option to have the shift
for the employee remain the same.

57 – Increment Employee Shift when
Clocking In

Select this option to increment the shift for
the employee upon clocking in (except when
returning from break). Deselect this option
to have the shift for the employee remain
the same.

58 - Increment Employee Shift when
Changing Job

Select this option to increment the shift for
the employee when clocking in with a
different job. This clock in occurs
automatically when the employee signs on
to a workstation with a different revenue
center than the job in which they are
currently clocked in. Deselect this option to
have the shift for the employee remain the
same during this clock in cycle.

59 - Increment Employee Shift when
Changing Revenue Center

Select this option to increment the employee
shift when signing in to a different revenue
center. Deselect this option to have the
employee shift remain the same when
signing in to a different revenue center.

60 - Prompt to Increment Employee Shift
after Shift Report

Select this option to prompt the workstation
operator to increment the employee shift
when an Employee Shift Report is generated
with a shift scope. Deselect this option to set
no prompting and leave the employee shift
the same.

61 - Prompt before incrementing Employee
Shift

Select this option to prompt the workstation
operator to increment the employee shift
when the shift is set to increment upon
clocking in or out, changing jobs, or
changing revenue centers. Deselect this
option to set no prompting when the
employee shift is set to increment through
one of those methods.

3. Click Save.

4. Select the revenue center, click Setup, and then click RVC Parameters.

5. Click the Calendar tab.

6. From the Shift Incrementing Options section, select the following options if you do
not want Employee or Cashier Financial Shifts to reset with the start of business
day:

• Do not reset Employee Financial Shifts with the start of each business
day

• Do not reset Cashier Financial Shifts with the start of each business day

7. Click Save.
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Configuring Employee Breaks
A break is a rest period for hourly workers, such as a lunch break. Breaks can be either paid
or unpaid and you can set time limits for breaks. Some jurisdictions legislate break length
requirements for minor employees.

1. Select the property, click Setup, and then click Property Parameters.

2. Click the Timekeeping tab, and then enter values in the following fields:

• Minor Unpaid Break Minimum Length: If applicable, enter the minimum number of
minutes allowed for unpaid breaks taken by a minor employee.

• Minor Unpaid Break Maximum Length: If applicable, enter the maximum number of
minutes allowed for unpaid breaks taken by a minor employee.

• Minor Paid Break Minimum Length: If applicable, enter the minimum number of
minutes allowed for paid breaks taken by a minor employee.

• Minor Paid Break Maximum Length: If applicable, enter the maximum number of
minutes allowed for paid breaks taken by a minor employee.

• Regular Unpaid Break Minimum Length: Enter the minimum number of minutes
allowed for an unpaid break taken by a regular employee.

• Regular Unpaid Break Maximum Length: Enter the maximum number of minutes
allowed for an unpaid break taken by a regular employee.

• Regular Paid Break Minimum Length: Enter the minimum number of minutes
allowed for a paid break taken by a regular employee.

• Regular Paid Break Maximum Length: Enter the maximum number of minutes
allowed for a paid break taken by a regular employee.

3. Click Save.

Configuring Time Card Chit Printing
You can print time card chits for an employee with the total hours worked per shift. The time
card chit combines their regular hours with any overtime hours worked during a shift into a
single total. The total labor hours worked are labeled Labor Shift Hours on the printout.
The Labor Shift Hours label text cannot be translated.

The following figure shows an example of the printed time card chit with the Labor Shift
Hours indicated in red.
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Figure 11-10    Time Card Chit with Combined Labor Shift Hours

To configure printing for time card chits:

1. Select the property, click Setup, and then click Property Parameters.

2. Click the Timekeeping tab.

3. Select Print Accumulated Labor Shift Total in Clock In/Out Chits.

When enabled, the system prints single labor shift total hours worked by
employees on final clock-out chits for the shift.

4. Click Save.

Clock-In and Clock-Out Cycles
A clock-in cycle for a workstation operator includes one clock in and the subsequent
clock out. Clock-in cycles are sequentially numbered from the start of the current
payroll period to the current date on employee time cards and labor detail reports. If
breaks are not in use, a cycle is the equivalent of a work shift.

A clock-in cycle includes the day, date, and time of the entry and the Job Code under
which the employee clocks in.

Related Topics

• Setting Clock-In and Clock-Out Cycles

Setting Clock-In and Clock-Out Cycles
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Employee Maintenance.
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2. Search for the property employee record.

3. Select the Employee Records tab near the lower part of the screen, and then double-
click the object number of the appropriate record.

4. If the ID field is blank, enter the employee identification number.

5. Click the Search/Table View tab.

6. Click the Property Employee Records tab near the lower part of the screen, and then
double-click the object number of the appropriate record.

7. Click the Job Codes tab and add a job code for the role if it does not exist.

Employees who clock in require a job code. Employees without a job code assigned
typically do not need to clock in (such as tax exempt employees). If an employee has
more than one job code assigned (for example, bartender and server), the workstation
prompts the employee to select a job code when clocking in.

8. Click Save.

9. Select the Enterprise level, click Configuration, and then click Roles.

10. Select the role type, click the Operations tab, and then click the Timekeeping subtab.

11. From the Job Rate Options section, select the appropriate Clock in at Rate options for
employees associated with the role. Each rate number refers to a pay rate that is
assigned for the employee record.

12. Click Save.

Related Topics

• Clock-In and Clock-Out Cycles

Job Codes
A Job Code identifies a category of labor group (for example, Server, Bartender, Cashier,
Manager) for timekeeping. Job codes:

• Link hourly employees to specific pay rates upon clock in

• Group labor hours and costs into job categories on reports

Related Topics

• Configuring Job Codes

Configuring Job Codes
1. Select the property, click Configuration, and then click Job Codes.

2. Insert a new job code record with the appropriate name (for example, Server, Bartender,
or Manager), and then double-click it to open.

3. Select the Employee Role from the drop-down list to associate with the job code.

If you select 0 - None, the employee receives privileges based on the roles set in the
Employee Maintenance module.

This setting is ideal for an employee who has two job codes (for example, Server and
Bartender). The privileges associated with this employee role are active for the duration
of the clock-in cycle.
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4. Select the Employee Class from the drop-down list.

If you select 0 - None, the employee uses the Employee Class set in the
Employee Maintenance module.

The employee is assigned to this employee class for the duration of the clock-in
cycle.

5. Select the Revenue Center in which the job code is available.

To make the job code available in all revenue centers, select 0 - None.

6. Enter the Report Group for the job code.

The labor reports sort and calculate subtotals by the Report Group. If you set the
Report Group to 0 (zero), the job code does not appear on job code reports.

7. Select the appropriate options as described in the following table:

Table 11-7    Job Code Options

Option Description

1 - Prompt for Direct Tips before
Clocking Out

Select this option to prompt employees who
are clocked in under the job code to declare
the amount of direct tips received (tips given
directly from the customer to the employee)
when clocking out.

2 - Prompt for Indirect Tips before
Clocking Out

Select this option to prompt employees who
are clocked in under the job code to declare
the amount of indirect tips received (tips
given from one employee to another) when
clocking out.

3 - Cannot Clock Out with Open
Checks

Select this option to prevent employees
clocked in under the job code from clocking
out while they have open guest checks.
You can override this setting for employees
that have the Clock Out with Open Checks
privilege.

4 - Use Scheduled Time if Employee
Clocks in Early

Select this option to use the employee’s
scheduled clock-in time for labor
calculations if the employee clocks in earlier
than scheduled.

5 - Prompt for Clock In Revenue
Center

Select this option to allow employees to
select the revenue center when clocking in.

8. Click Save.

Related Topics

• Job Codes

Declaring Tips
Tip declaration is a generic term that applies to direct tips and indirect tips.

Tip Track is a Simphony feature that involves declaration of indirect tips. Servers can
use Tip Track to:

• Share tips with other employees
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• Edit tip-outs

• Claim tips from other employees

Managers can use Tip Track to:

• Grant tip-out privileges

• Generate tip-out transaction reports

Related Topics

• Configuring Tip Tracking and Reporting

• Configuring Tip Track Buttons

Configuring Tip Tracking and Reporting
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the type of role (for example, server or bartender).

3. Click the Operations tab, and then select the appropriate options as described in the
following table:

Table 11-8    Tip Tracking and Reporting Privileges

Option Number Privilege Name Allow the Employee
to...

Recommended Role

65 Authorize/Use the
[Direct Tips] and
[Indirect Tips] Keys

Use the Direct Tips
and Indirect Tips
function keys to
declare cash tips
received, and to
authorize others to
do so

Server

66 Authorize/Use the
[Direct Tips] and
[Indirect Tips] Keys
for Another
Employee

Use the Direct Tips
and Indirect Tips
keys to declare cash
tips received by
another employee,
and to authorize
others to do so

Manager

187 Authorize/Perform
the Pay Tip Out To
Others Keys

Give cash tips to
others, and to
authorize non-
privilege employees
to do so

Server

188 Claim Tips From
Other Employee

Receive a tip from
another employee

Server

189 Authorize/Perform
Edit Of Any Tip Outs

Edit cash tips given to
other employees, and
to authorize non-
privilege employees
to do so

Manager

195 Allow Edit of My Tip
Out

Edit tip outs Server
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Table 11-8    (Cont.) Tip Tracking and Reporting Privileges

Option Number Privilege Name Allow the Employee
to...

Recommended Role

303 Authorize/Perform a
zero Direct Tip

Enter a $0 direct tip
without requiring
authorization to do
so when clocking out

Manager

31010 Run Employee Tip
Report

Run the Employee
Tip Report

Manager

31045 Run Employee Tip
Track Report

Run the Employee
Tip Track Report

Manager

4. Click Save.

5. Select the revenue center, click Setup, and then click RVC Parameters.

6. Click the Options tab.

7. To print a validation receipt when a tip-out or tip edit operation occurs, select 7 -
Validate Employee Direct/Indirect Tips Declared Transactions.

8. Assign a validation printer at the property level:

a. Select the property, click Setup, and then click Workstations.

b. Click the Printers tab.

c. Select a Validation Printer, and then click OK.

d. Click Save.

Related Topics

• Declaring Tips

Configuring Tip Track Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page on which to place tip track buttons.

3. On the Edit tab, select the page area in which to define the tip track functions.

4. Click Button.

5. On the General subtab, enter the button name Tip Track Tip Out in the Legend
field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, select Tips from
the Type section, select Tip Track Tip Out from the Results section, and then click
OK.

8. Repeat Steps 3 through 7 to create the following buttons:

• Tip Track Edit My Tips

• Tip Track Edit

9. Click Save.
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Related Topics

• Declaring Tips
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12
Payments and Currency

Guests pay guest checks with various types of payments or tenders, ranging from paper to
plastic to digital.

Types of Payment
Payments reduce the balance of the guest check, and can include the types listed in the
following table:

Table 12-1    Payment Types

Payment Type More Information

Cash Configuring the Cash Tender

Credit Cards The Oracle Payment Interface (OPI)

The Simphony Payment Interface (SPI)

Gift Cards Stored Value Configuration Tasks

Pay at the Table Pay@Table

Hotel Room Charge Configuring the Room Tender

Configuring Currency
You can configure the types of currencies in circulation for exchange at workstations.

Oracle Food and Beverage recommends to use Currency ISO standard 4217 in the Currency
module’s Abbreviation field. For example:

• USD for the US Dollar

• CAD for the Canadian Dollar

• EUR for the Euro

• GBP for Pound Sterling

• MXN for the Mexican Peso

• JPY for the Japanese Yen

Note:

The currency Abbreviation field is where the currency type is pulled from by the
Simphony Transaction Services (STS) Gen2 API.

1. Select the Enterprise, property, or zone, click Setup, and then click Currency.
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2. Insert a record, enter the name (for example, US Dollars), and then click OK.

3. Double-click the record to open it.

4. Enter the Abbreviation for the currency (for example, USD).

5. Enter the Symbol for the currency record (for example, $).

6. Select the Number of Digits from the drop-down list.

This is the number of digits after the decimal point that the currency allows.

7. Enter the Smallest Bill Amount for the currency (for example, 1).

8. Select 1 - On = Print Symbol After Total; Off = Print Symbol Before Total to
print the currency’s symbol after the amount due on guest checks and customer
receipts. Deselect this option to print the currency’s symbol before the amount
due.

9. Select 5 - Use Thousands Separator Character to use the thousands separator
(comma as in the example 1,000) when numbers are printed.

10. Click Save.

11. Repeat Steps 2 through 10 for each currency payment allowed.

Configuring Base Currency and Alternate Currency
1. Select the Enterprise, property, or zone, click Setup, and then click Currency

Parameters.

2. Select the Base Currency from the drop-down list. This is the primary currency for
the location.

Oracle recommends setting the base currency once during initial configuration of a
property, prior to opening guest checks. When you change the base currency after
opening checks, the EMC prompts you for verification twice.

3. (Optional) Select the Alternate Currency from the drop-down list.

This is the other currency used at the location. For example, a property located
near Niagara Falls might set US Dollars as the base currency and accept
Canadian Dollars as the alternate currency.

4. To use rounding, select 4 - Round Currency. Selecting this option activates the
subsequent options. Select the appropriate options to round the amount due:

• 5 - ON = Round to Nearest 0; OFF = Round to Nearest 5: Select this option
to round currency amounts to the nearest 0 (for example, 163.336 rounds to
163.340). Deselect this option to round currency amounts to the nearest 5 (for
example, 163.336 rounds to 163.335).

• 6 - ON = Round to Second-Least Significant Digit; OFF = Round to Least
Significant Digit: Select this option to round currency amounts based on the
second least significant digit (for example, in 100.45, the second least
significant digit is 4). Deselect this option to round currency amounts based on
the least significant digit (for example, in 100.45, the least significant digit is 5).

5. Click Save.

6. Select the Enterprise, property or zone, click Setup, and then click Currency
Availability.
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7. If you selected the Enterprise level, for each record, select the non-base currency
(foreign or alternate currency) for conversion in the Currency field.

8. Select the appropriate alternate currency options:

• 2 - Issue Change In Other Currency: Select this option to issue change from a
currency conversion in the currency. Deselect this option to issue change only in the
base currency.

• 3 - Prompt For Issuing Change: Select this option to ask the workstation operator
with a Yes/No prompt whether change is required in the alternate currency. Deselect
this option to issue change only in the base currency without prompting.

• Select options 4, 5, and 6 as appropriate for the alternate currency. These options
are described in Step 4.

9. Click Save.

Configuring Currency Conversions
You can configure the manner in which one currency rate converts to another currency rate.
Typically, currency conversion rates are set at the Enterprise level, and each property
receives the same conversion. If one location has a slightly different conversion rate for the
same two currencies, you can set the currency conversion at the zone (for example, a Euro-
to-US Dollar conversion might be standard for the Enterprise level, while an airport property
has a different rate).

1. Select the Enterprise, property or zone, click Setup, and then click Currency
Conversions.

2. Insert a record. Each record contains two currencies: a Currency and a Conversion
Currency.

3. Click the ellipsis point (...) button from the Currency column, select the currency, and
then click OK.

This field, divided by the Rate, determines the number of Conversion Currency records.

4. Click the ellipsis point (...) button from the Conversion Currency column, select the
conversion currency, and then click OK. You must select a different currency than the
selection in the Currency field. That is, the Currency and Conversion Currency fields
cannot contain the same values.

This field, multiplied by the Rate, determines the number of Currency records.

5. Enter the conversion Rate.

The Rate determines how Simphony calculates the Currency and Conversion Currency.
The Conversion and Conversion Reverse fields calculate automatically to show additional
information about the record.

6. Click Save.

Configuring the Cash Tender
You must configure a cash tender to allow guests to pay the check with cash.

1. Select the Enterprise, property, or revenue center, click Setup, and then click Payments.

2. Insert a record, enter Cash as the name, and then click OK.

3. Double-click the record to open it.
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4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select
Micros.Payment.Cash.dll, and then click Open.

6. Click the Configuration tab, and then click the Module Configuration subtab.

7. Enter information in the following fields:

Table 12-2    Module Configuration Fields

Field Description

Module ID Enter MicrosCashPaymentModule.

Description Enter a description for the payment driver (for
example, MICROS Cash Payment Module).

Do Not Batch Select False.

Run As Service Select either True or False to indicate whether
to run the MICROS Cash Payment Module as a
Service Host service. Select False to run the
cash module directly on the POS client.

Show Change Due Dialog Select True to show the Change Due dialog on
the POS client.

8. Click Save.

9. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

10. Insert a record, name it Cash, and then click OK.

11. Double-click the Cash record to open it.

12. On the General tab, select 1 - Payment from the Key Type drop-down list.

13. Select the Print Class to associate with the cash tender.

Print Class Output contains more information.

14. Click the Options tab, and then click the Printing Options subtab.

15. Select 8 - Print Customer Receipt and 21 - Print Summary Totals.

16. Select the Ops Behavior subtab, and then select the appropriate options as
described in the following table:

Table 12-3    Amount Options

Option Description

2 - Amount Required Select this option to require an amount when
using the cash tender. If the workstation
operator presses the cash tender button at the
POS client without entering an amount, the POS
client prompts to enter the tender amount.
If you deselect option 2 and select option 3, the
tender is used for 0.00, unless the workstation
operator enters an amount before pressing the
tender key.
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Table 12-3    (Cont.) Amount Options

Option Description

3 - Assume Paid in Full Select this option to record the exact amount
due as the entry. You must also deselect option
2. If you deselect both options 2 and 3, the
system records 0.00 as the entry.

4 - Use with Currency Conversion Select this option to post payment amounts
entered through a currency key to the cash
payment key.

37 - Partial Tender Not Allowed Select this option to prevent the cash tender
from being used to partially tender a
transaction.

53 - Round Tender to Next Highest
Dollar

Select this option to round the cash tender up to
the next highest whole number dollar amount.
Options 53, 3, and 56 work together; to enable
option 53, you must also select options 3 and 56.
In addition, option 2 must be deselected. In this
scenario, the Change Due will always be 0.00
and the rounding value will show the
difference.
In Page Design, you must configure the
Payment Type as Cash:Cash and the Function
as Default in the Payment Configuration dialog
when configuring the Cash payment tender
button.
Partial tenders are allowed when Amount
Options 3, 53, and 56 are enabled, when the
Payment Type is Cash:Cash and the Function
is # (DollarUp) in the Payment Configuration
dialog when configuring the payment tender
button in Page Design. Partial Tenders are not
allowed when option 37 is enabled. (The
message “Tender must be made in full” will
appear when option 37 is enabled).
Adding Payment Keys to the Transaction Page
contains more information.

56 - Round Change Due Select this option to accept payments for the
exact amount and to round change due.
Selecting option 56 overrides option 87.

87 - Rounded Payments and
Change

Select this option to round change due resulting
from an overtender.

88 - Round Payments and Change
To the Nearest 0

Select this option to round the payment total or
change due to the nearest 0 or 10.
You must also select one of the following
options:
• 56
• 87
If you select option 88, the least significant
decimal digit is rounded to 0 or 10. Deselect
option 88 to round the least significant decimal
digit to 0 or 5.
Tender/Media Amount Options 53 and 88 are
mutually exclusive; you cannot select both.
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Table 12-3    (Cont.) Amount Options

Option Description

96 - Round To Second Least
Significant Digit

Select this option to round the payment total or
change due to the nearest .50 or 1.00.
You must also select one of the following
options:
• 56
• 87
If you select option 88, the payment total and
change due are rounded to the nearest 0. With
option 96 enabled, it is rounded to the
nearest .00.
If you deselect option 88, the payment total and
change due are rounded to the nearest 0 or 5.
With option 96 enabled, it is rounded to the
nearest .00 or .50.

97 - Round Change Due Down Select this option to round change due down
when the unrounded change is exactly half of
the rounding number. For example if the
payment given is .25 greater than the amount
due, and rounding is to the nearest .50, the
change due will be 0 instead of .50.
Select option 97 to round the change due down.
Deselect option 97 to round the change due up.

17. Click Save.

Adding Payment Keys to the Transaction Page
You can create payment keys for each type of payment tender (for example, Cash,
Auth, Auth and Pay, Final Authorization, and Split Tender).

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the Front of House page (typically the Transaction page) on which to place
the payment buttons.

3. On the Edit tab, select the page area in which to define the payment buttons.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. From the Type drop-down list, select Payment Tenders.

7. Click the black arrow beneath the Type drop-down list.

8. Select the tender payment type, and then click OK.

9. From the Payment Configuration dialog, select the Payment Type, and then click
OK.

10. Position and size the button on the page. Use the Style arrow to change the color.

11. Click Save.
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The Oracle Payment Interface (OPI)
The Oracle Payment Interface (OPI) simplifies credit card payment configuration by enabling
Simphony to communicate with payment service providers (PSPs) that provide credit card
processing using a single payment driver. In addition the OPI:

• Enhances security by not handling or storing card holder or sensitive authentication data
in Simphony or OPI. PSPs process card data and provide a token to Simphony.

• Eliminates credit card batch processing in Simphony by automating end-of-day
settlement for credit card transactions through the OPI.

Before performing an installation or upgrade, ensure that you install or upgrade to OPI
version 6.2, including the latest patch.

See My Oracle Support (MOS) at https://support.oracle.com/ to access the latest OPI
payment drivers.

Related Topics

• Configuring the OPI Driver

• Configuring the OPI Payment Module

• Configuring the Default Payment Tender for OPI

• Updating Credit Card Preambles for OPI

• Configuring the OPI and SPI to Settle Transactions Automatically

• Configuring the OPI and SPI to Settle Transactions Manually

• Credit Card Preambles for OPI and SPI

OPI Architecture
In the Simphony implementation, an OPI server is installed on-premise and processes
payment requests between the Simphony POS clients and the PSP. The PSP provides the
PIN Entry Devices (PEDs) that read and process credit card data, and then communicate
with the PSP Host on the Cloud. The PEDs can be connected directly to the POS clients
(usually via serial, USB, or Bluetooth connection) or they can be network devices.

OPI supports two modes:

• Terminal Mode

• Middleware Mode

In Terminal mode, the OPI Datastore database contains a table with a one-to-one mapping of
POS client to PED. A payment request from a POS client is directed to the correct PED. In
Middleware mode, the PSP provides an application, called middleware, that handles the
mapping of a POS client to a PED. The OPI server directs all payment requests to the
middleware application, which then routes the request to the appropriate PED. In either
mode, neither the OPI server nor Simphony come in contact with credit card data. Sensitive
data is handled strictly between the PED or middleware and the PSP Host. OPI receives and
stores tokens and voucher printing instructions from the PSP, and passes the voucher data to
Simphony, leaving Simphony and the OPI server out of PA-DSS scope.
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Figure 12-1    Terminal Mode Architecture
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Figure 12-2    Middleware Mode Architecture

Related Topics

• Configuring the OPI Driver

• Configuring the OPI Payment Module

• Configuring the Default Payment Tender for OPI

• Updating Credit Card Preambles for OPI

• Configuring the OPI and SPI to Settle Transactions Automatically

• Configuring the OPI and SPI to Settle Transactions Manually

• Credit Card Preambles for OPI and SPI
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Configuring the OPI Driver
If the property sends transactions to multiple Merchant IDs, create the OPI driver
record in the property with the Merchant ID that is used by a majority of the revenue
centers, and then override the driver records of the revenue centers that route
transactions to other Merchant IDs.

1. Select the Enterprise, property, or revenue center, click Setup, and then click
Payment Drivers.

2. Insert a new Payment Driver record named OPI, and then double-click the record
to open it.

3. On the General tab, select 3 - DLL or 26 - Secure DLL Configuration as the
Content Type, click Import from a file, browse to [Drive
Letter]:\MICROS\Simphony2\EgatewayService\handlers\OPIPaymen
t.dll, and then click Open.

4. On the Configurations subtab, enter information in the following fields:

• Display Name: Enter a display name for the driver (for example, OPI).

• Merchant Number: Enter the Merchant ID.

• Primary Host: Enter the URL for the OPI gateway.

• Host Timeout: Enter the timeout value in seconds. The default timeout value
is 180 seconds.

• Pass Phrase: Enter a passphrase for authentication.

5. Click Save.

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Credit Card Preambles for OPI and SPI

Configuring the OPI Payment Module
1. Select the Enterprise, property, revenue center, or zone, click Setup, and then

click Payments.

2. Insert a new record for the OPI, and then double-click to open it.

3. Click Import from a file, browse to [Drive letter]
\MICROS\Simphony2\EgatewayService\handlers\Micros.Payment.Lo
adableCreditCardModule.dll, and then click Open.

4. Select the OPI Driver from the drop-down list.

5. Select the Device from the drop-down list.

6. Select 3 - DLL from the Content Type drop-down list.

7. On the Configuration subtab, modify the settings as required. Obtain the
configuration information from the credit card processor.
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To enable Incremental Authorizations, select True. By default, Incremental
Authorizations is disabled (False). You must use the native Oracle Payment Interface
(OPI) payment drivers and the payment service provider must support Incremental
Authorizations.

8. Click Save.

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Credit Card Preambles for OPI and SPI

Configuring the Default Payment Tender for OPI
1. Create a credit card tender for the OPI. See Configuring a Credit Card Tender for

instructions.

Give the tender a general name such as OPIDefault.

2. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Tender Parameters.

3. On the Configuration tab, select the credit card tender that you created for the OPI as the
Payment Card Tender.

4. Click Save.

5. Create a button for the default OPI tender. See Creating Credit Card Payment Buttons for
instructions.

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Credit Card Preambles for OPI and SPI

Creating Credit Card Payment Buttons
Oracle recommends that you create payment card buttons on a page for the credit card
functions.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the page on which to place credit card buttons.

3. On the Edit tab, select the page area in which to define the credit card functions (typically
the payment area).

4. Click Payments.

5. On the General subtab, select Payment Tenders from the Type drop-down list.

6. Click the black arrow beneath the Type drop-down list.

7. From the Select Tender/Media Payment dialog, select the payment tender, and then click
OK.

Select None to use all types of credit cards.
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8. From the Payment Configuration dialog, select CreditDebit:Loadable from the
Payment Type drop-down list.

9. Select the appropriate function key from the Functions drop-down list:

• CreditAuthOnly: This function sends a request to the cardholder’s bank to
authorize available funds and place a hold on those funds for sale. The
account is not charged. This function is used in Table Service to obtain
authorization of payment.

• CreditAuthAndPay: This function authorizes funds available and completes
the sale. This function is used in Quick Service to apply payment and close a
check.

• InitialAuthorization: This function sends a request to the cardholder’s bank to
authorize available funds and place a hold on those funds for sale. The
account is not charged. This function is used in Table Service to obtain
authorization of payment for a large party or with bar tabs where additional
charges may be incurred. It is also used to name a bar tab after the patron
whose credit card was authorized.

• ManualAuthorization: When connection to the credit card processor is
unavailable, this function allows the workstation operator to manually enter the
authorization code (obtained by phoning the credit card processor).

10. To use the Initial Authorization process to update the check ID (check name) with
the card holder’s name from the authorized credit card:

a. In the Argument field, enter GuestCheckId.

b. Click OK.

The Initial Authorization performs an SPI authorization, and Simphony retrieves
the card holder name (if present) from the payment service provider (PSP) and
inserts it into the Guest Check ID field.

11. Position and size the button on the page. Use the Style arrow to change the color.

12. In the Legend field, enter the button name.

13. Repeat Steps 7 through 11 for each type of payment tender.

14. Click Save.

Updating Credit Card Preambles for OPI
1. Click the Enterprise or property, click Configuration, and then click Tender/

Media.

2. Double-click a credit card tender type to open it, click the Options tab, and then
click the Credit Card Options subtab.

3. In the Preambles section, if standard credit card preambles are defined, select the
preamble records, and then click Delete.

You must delete all preexisting standard credit card preambles.

4. Click Add, and then configure the Start preamble and the Length based on the
card payment type.

See Credit Card Preambles for OPI and SPI for a list of preambles for commonly
used card types.

5. Click Save.
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6. Repeat Steps 2 through 5 for other credit card payment types.

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Credit Card Preambles for OPI and SPI

Configuring the OPI and SPI to Settle Transactions
Automatically

You can configure the OPI or SPI settlement to run automatically at a recurring day and time.
The settlement occurs at the Coordinated Universal Time (UTC) standard. Here are a few
configuration examples:

Workstation Time Zone: Eastern

Recurrence Time: 15:00

Configuration 1 (There is no conversion to UTC in this case)

• Time Zone: 0 - Local Time Zone

• Time Settlement Occurs: 15:00

Any event with a Time Zone is converted to UTC. This is best illustrated with Configuration 2.

Configuration 2

• Time Zone: 35 - Eastern Time Zone (UTC - 5) (Daylight Savings Time is active)

• UTC Time Settlement Will Occur: 19:00

Configuration 3

• Time Zone: 260 - Brisbane (UTC + 10)

• UTC Time Settlement Will Occur: 05:00 Tomorrow

1. Select the Enterprise or property, click Configuration, and then click Task Schedules.

2. Insert a new record for the OPI or SPI EOD, and then double-click the record to open it.

3. On the General tab, in the Service Type drop-down list, select 8 - Check and Posting,
and then select 5 - EOD Settlement as the Task Type.

4. In the Schedule Type drop-down list, select 4 - Recurring - Daily, and then select
Enabled in the Duration section.

5. Select the Start date, and then click No end date.

6. Click the Recurrence tab.

7. To set the SOD settlement:

a. In the Daily Frequency section, select Occurs once at.

b. Schedule the EOD settlement to execute at the same time SOD runs on the property.

8. To set the EOD settlement:

a. In the Daily section, enter 1 in the Every xx day(s) field.
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b. In the Daily Frequency section, select Occurs every and schedule the EOD
batch settlement time to execute.

9. Click Save.

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Credit Card Preambles for OPI and SPI

Configuring the OPI and SPI to Settle Transactions Manually
If credit card settlement fails, you can enable workstation operators to manually
perform the EOD OPI or SPI settlement through the workstation.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Double-click the transaction page on which you want the button to appear on the
workstation, and insert a new button.

3. On the General tab, select Payment Tenders as the Type, click the right arrow
directly beneath the Type drop-down list, select the 0–None payment record, and
then click OK.

4. On the Payment Configuration dialog, select CreditDebit:Loadable from the
Payment Type drop-down list.

5. In the Argument drop-down list, select CreditDebit:Loadable
ManualEODSettlement, and then click OK.

6. Enter a Legend for the button (for example, OPI EOD or SPI EOD), and then click
Save.

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Credit Card Preambles for OPI and SPI

Credit Card Preambles for OPI and SPI
The preambles configured in EMC are different than the Issuer IDs used by SPI and
OPI, and these numbers are not a one-to-one match.

The following table lists the credit card preambles for OPI and SPI.

Table 12-4    Credit Card Preambles for OPI and SPI

Card Type Preamble Preamble Length Issuer ID

Visa 0* 1 01

Visa PIN Credit 12* 2

Visa Electron 17* 2 17

Visa Debit 18* 2 18
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Table 12-4    (Cont.) Credit Card Preambles for OPI and SPI

Card Type Preamble Preamble Length Issuer ID

VPAY 20* 2 20

MasterCard 1* 1 02

MasterC Debit 24* 2 24

MasterCard PIN Credit 13* 2

American Express 1* 1 03

Discover 26* 2 12

Diners 3* 1 04

JCB 4* 1 05

Stored Value Card (SVC) 7* 1 07

Maestro 19* 2 19

Gift Card 8* 1 07

Points 9* 1

CUP 10* 2 06

CUP Debit 14* 2 09

Debit 11* 2 00

Interac 15* 2 10

UKDM/Switch 16 1 16

VPAY 20* 2 20

Alliance 21* 2 21

ecChip 22* 2 22

GiroCard 23* 2 23

Bank Card 25* 2 11

PayPal 27* 2 13

RESERVE-1 28* 2 31

RESERVE-2 29* 2 32

RESERVE-3 30* 2 33

RESERVE-4 31* 2 34

RESERVE-5 32* 2 35

RESERVE-6 33* 2 36

RESERVE-7 34* 2 37

RESERVE-8 35* 2 38

RESERVE-9 36* 2 39

RESERVE-10 37* 2 40

RESERVE-11 38* 2 41

RESERVE-12 39* 2 42

RESERVE-13 40* 2 43

RESERVE-14 41* 2 44

RESERVE-15 42* 2 45
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Table 12-4    (Cont.) Credit Card Preambles for OPI and SPI

Card Type Preamble Preamble Length Issuer ID

AliPay 26

MIR 27

WeChat Pay 25

Related Topics

• The Oracle Payment Interface (OPI)

• OPI Architecture

• Configuring the OPI Driver

• Configuring the OPI Payment Module

• Configuring the Default Payment Tender for OPI

• Updating Credit Card Preambles for OPI

• Configuring the OPI and SPI to Settle Transactions Automatically

• Configuring the OPI and SPI to Settle Transactions Manually

The Simphony Payment Interface (SPI)
The SPI is a resilient version of the OPI. It is part of the Simphony client application
and formats the individual messages for the PSP (terminal or middleware) and
processes the responses for the client directly. This eliminates the need for the OPI
server and avoids traffic over the LAN on POS clients that have a PIN Entry Device
(PED) attached.

Related Topics

• Configuring the SPI Payment Driver

• Configuring Mail Order Telephone Order (MOTO)

SPI Architecture
With the exception of Pay@Table, there is no longer a need for the OPI server. The
business logic and communication layer that with the OPI are handled by the OPI
server are included in the SPI, which is a component of the Simphony client
application. If a POS client has a PED attached, it is possible to be completely
independent of the LAN for payment processing.

The SPI can be deployed using one of the following connection methods: Terminal
mode or Middleware mode. Talk to your PSP to identify the mode(s) which are
available and best suited to your environment.

Terminal Mode

POS Clients With Attached PEDs

In the ideal scenario, Simphony POS clients (typically Win32 or Win64) are each
attached to a PED. This setup eliminates the need for a LAN connection.

Chapter 12
The Simphony Payment Interface (SPI)

12-16



Figure 12-3    POS Clients With Attached PEDs

The process for a credit card transaction follows these steps (as illustrated in the following
figure):

Figure 12-4    Terminal Mode Architecture With Attached PED
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1. POS Operations sends a payment request to the PED, addressing it as
localhost:port.

2. The PED communicates with the PSP Host and returns the token and voucher
printing instructions to POS Operations.

3. The token and other transaction details are saved in the Datastore on the POS
client.

This scenario is independent of both the LAN and the OPI server.

POS Clients Without Attached PEDs

POS clients, such as tablets and Android devices, may not have PED devices directly
attached. However, PSPs offer network-capable PEDs that can be used.

Figure 12-5    POS Clients Without Attached PEDs

The process for a credit card transaction follows these steps (as illustrated in the
following figure):
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Figure 12-6    Terminal Mode Architecture Without Attached PED

1. POS Operations sends a payment request to the PED over the network, addressing it
with its IP address:port.

2. The PED communicates with the PSP Host and returns the token and voucher printing
instructions to POS Operations.

3. The token and other transaction details are saved in the Datastore on the POS client.

This scenario depends on a LAN connection and is vulnerable to network failure to the PED,
but does not require an OPI server.

Middleware Mode

POS Clients With or Without Attached PEDs

The PSP provides an application, called middleware, which handles the mapping of a POS
client to a PED.
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The process for a credit card transaction follows these steps (as illustrated in the
following figure):

Figure 12-7    Middleware Mode Architecture With or Without Attached PED

1. POS Operations sends a payment request to the IP address where the
middleware application is configured.

2. The middleware application passes the request to the appropriate PED.

3. The PED communicates with the PSP Host and returns the token and voucher
printing instructions to POS Operations.

4. The token and other transaction details are saved in the Datastore on the POS
client.

This scenario depends on a LAN connection and is vulnerable to network failure to the
PED, but does not require an OPI server.
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Related Topics

• Configuring the SPI Payment Driver

• Configuring Mail Order Telephone Order (MOTO)

Payment Driver vs. Workstation Settings
You must configure SPI as a payment driver. You can configure the SPI driver at the
Enterprise, zone, property, and revenue center levels in the Payment Drivers module, and
you can override the SPI configuration to set client specific values at the workstation level in
the Workstations module. Workstation settings override Payment Driver settings in case of
conflict. If workstation settings are present, but the driver is not SPI, workstation settings are
ignored.

One example where workstation device settings are required when a property or revenue
center has a mix of Windows clients that have PEDs directly attached, and Android clients
that are paired with network PEDs in Terminal mode:

• For the Windows clients, entering http://localhost:port in the Primary Host of the
Payment Driver module is sufficient as each PED communicates with the client on the
local host IP address.

• For the Android clients, it is necessary to enter each PED’s IP address individually. An
SPI device is added for each Android client, and the only setting entered is the paired
PED’s actual URL. When the Android client attempts to process a credit card transaction,
the device setting URL will override the Payment Driver setting, and it will communicate
with its own paired PED. If this environment is a middleware mode, this configuration is
not necessary. In that case, the URL in the Payment Driver points to the middleware host,
which in turn looks up the paired PED for the requesting client, and passes the request
on.

SPI supports TLS 1.2 with two-way authentication, where server and client exchange
certificates. The PSP is responsible for issuing certificates. Another scenario in which
workstation devices have to be used for each client is HTTPS with two-way authentication
when client certificates are to be issued for each client individually. In that case, the Payment
Driver settings reflect the security settings as HTTPS with Certificate Validation, and the
Server Certificate’s public key file will be loaded. For each client, a workstation SPI device is
created, and the client’s certificate with password is loaded.

Related Topics

• Configuring the SPI Payment Driver

• Configuring Mail Order Telephone Order (MOTO)

OPI Users
If you are currently using the Oracle Payment Interface (OPI), you will not experience
changes as the system can run SPI and OPI together at the same property. OPI transaction
data remains in the OPI database. If an Enterprise is currently using OPI, you can create an
override record at a property or revenue center to configure it to use SPI, while other
properties or revenue centers remain on OPI. Only a few settings that were configured on the
OPI server are now configured in EMC. If required, client-specific settings (such as the PED’s
IP address or client certificates) can be set at each workstation by configuring an SPI device.

The OPI and SPI use the same OPIPayment.dll file.
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Related Topics

• Configuring the SPI Payment Driver

• Configuring Mail Order Telephone Order (MOTO)

Pay@Table
Pay@Table is supported by both OPI and SPI. Pay@Table devices continue to
connect to the OPI server and use Transaction Services to close the check. The
architecture and configuration remains the same. These devices are supported with a
LAN connection, but not during LAN failure. If the LAN connection is not available,
Pay@Table devices are dependent on the OPI server.

Related Topics

• Configuring the SPI Payment Driver

• Configuring Mail Order Telephone Order (MOTO)

Check Sharing
The SPI supports check sharing if this feature is also supported by the primary service
provider.

Related Topics

• Configuring the SPI Payment Driver

• Configuring Mail Order Telephone Order (MOTO)

Configuring the SPI Payment Driver
To add the SPI driver for the first time, or to update an existing property, revenue
center, or zone from OPI to using SPI:

1. Select the Enterprise, property, or revenue center, click Setup, and then click
Payment Drivers.

If multiple properties exist and you are configuring one property or revenue center
to use SPI, select the property or revenue center that will use SPI.

2. Insert a new Payment Driver record named SPI, and then double-click the record
to open it.

3. On the General tab, select 26 - Secure DLL Configuration as the Content Type,
click Import from a file, browse to [Drive
Letter]:\MICROS\Simphony2\EgatewayService\handlers\OPIPayment.dll, and
then click Open.

4. On the Configuration subtab, enter information in the following fields:

Table 12-5    Configuration Fields

Field Description

Description Enter a description for the driver (for example,
SPI).
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Table 12-5    (Cont.) Configuration Fields

Field Description

Display Name Enter a display name for the driver (for example,
SPI).

Currency Code Enter or verify the existing ISO numeric three-digit
currency code for the country. (This value can only
be set when SPI Interface = True.)

Enable Quick Chip Set the value to True when using the quick chip
feature. (This value can only be set when SPI
Interface = True.)
Ensure that your PSP supports quick chip before
you enable this feature. Quick chip lets the guest
swipe or dip a credit card at the beginning of a fast
transaction while the workstation operator enters
the menu items.
The system must allow fast transactions by
enabling option 15 - Allow Fast Transactions in
the RVC Parameters module.

Merchant Number Enter the Merchant ID.

Host Timeout Enter the timeout value in seconds. This is the
amount of time that the host waits for a response
from the PSP. The default timeout value is 180
seconds.

Pass Phrase Leave this field blank for SPI.

Primary Host Enter the URL for the PSP endpoint.
For example, in Terminal Mode this is http://
PEDIPAddress:Port. In Middleware Mode, this is
http://MiddlewareIPAddress:Port. If the IP
address for each PED is different (network/wireless
PEDs in Terminal mode), you need to create
workstation devices to enter each POS client’s
PED’s IP address individually.
If the Security Settings use HTTPS, ensure that the
Primary Host field shows https. This is based on
the Security settings below.

SPI Interface Set the value to True when using the SPI driver.
This is helpful in preparation for an upgrade or
switch from OPI to SPI, when you have a property
with many POS clients that each require a
certificate. While the property is still operating on
OPI and the payment driver remains set to SPI
Interface = False, each client SPI device can be
created and certificates loaded. As long as the
payment driver is not set to SPI, the device record
is ignored. When the property is ready to switch to
SPI, you simply need to set the SPI Interface to
True.

Validate XML Message Against
Schema

To validate the format of existing messages that are
sent to the PSP against the schema, set the value to
True. (This value can only be set when SPI
Interface = True.)
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Table 12-5    (Cont.) Configuration Fields

Field Description

Security You can load the certificate into the payment driver
or the workstation device, depending on the
communication method and connection between
the POS client and the PED. The certificates are
installed on the POS clients as part of the DBSync
process.
• Security Settings: Select the appropriate

option:
– Use Http Only
– Use Https with No Certificate Validation
– Use Https with Certificate Validation

(one- or two-way authentication)
* For one-way authentication, the PSP

provides the private key for the server
certificates, which must be distributed
to all POS clients.

* For two-way authentication, the client
certificates with passwords are also
issued by the PSP for each Simphony
POS client.

• Load Server Certificate: Click the ellipsis
button, select the server certificate, and then
click Open.

• Load Client Certificate: Click the ellipsis
button, select the client certificate, enter the
password when prompted, and then click
Open.

• Delete Certificates: To delete a certificate,
select Do Not Delete, Delete All Certificates,
Delete Server Certificate, or Delete Client
Certificate. Confirm with Yes or No.

The Oracle Hospitality Simphony Security Guide
contains more information about the certificates.

5. Click Save.

Related Topics

• The Simphony Payment Interface (SPI)

• SPI Architecture

• Payment Driver vs. Workstation Settings

• OPI Users

• Pay@Table

• Check Sharing

Configuring Mail Order Telephone Order (MOTO)
You need to create the MOTO button on a page, allowing workstation operators to use
the MOTO feature with SPI.
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1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Double-click the transaction page on which you want the MOTO button to appear on the
workstation, and insert a new button.

3. On the General tab, select Payment Tenders as the Type, click the right arrow directly
beneath the Type drop-down list, select the 0 - None payment record, and then click OK.

4. On the Payment Configuration dialog, select CreditDebit:Loadable from the Payment
Type drop-down list.

5. In the Function drop-down list, select CreditAuthAndPay or CreditAuthOnly.

6. In the Argument field, enter MOTO, and then click OK.

7. Enter a Legend for the button (for example, MOTO Sale or MOTO Auth), and then click
Save.

Related Topics

• The Simphony Payment Interface (SPI)

• SPI Architecture

• Payment Driver vs. Workstation Settings

• OPI Users

• Pay@Table

• Check Sharing

Configuring Cash Back
Cash back is supported when the Simphony Payment Interface (SPI) is configured, and if the
Payment Service Processor (PSP) also supports cash back.

In addition to the steps explained in this section, you need to configure a cash drawer and
ensure that an employee is assigned to the cash drawer. Configuring a Cash Drawer contains
more information.

1. (Optional) Create a cash back pickup tender. This is used for reporting, if configured.

a. Select the Enterprise or property, click Configuration, and then click Tender/Media.

b. Insert a record, name it Cash back, and then click OK.

c. Double-click the cash back record to open it.

d. On the General tab, select 3 - Pickup from the Key Type drop-down list.

e. Select 9 - CASHBACK in the Report Group drop-down list.

f. Select 17 - Cash in the Print Class drop-down list.

g. Click the Options tab, and then click the Ops Behavior subtab.

h. Enable the following options:

• 1 - Open Cash Drawer

• 91 - Cash Management Transaction Item

• 92 - Affects Cash Pull Threshold

Tracking Tender Transaction Items contains more information about 91 and 92.
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i. Click Save.

2. Create a Cash Back non-revenue service charge.

a. Select the Enterprise, property, or zone, click Configuration, and then
click Service Charges.

b. Insert a Cash Back service charge record, and then double-click the record to
open it.

c. Select Cash back in the Pickup/Tender Media drop-down list.

d. Select Cash in the Print Class drop-down list.

e. Select CASHBACK in the Report Group drop-down list.

f. Select the following options:

• 1 - ON = Open; OFF = Preset

• 7 - Non-Revenue Service Charge (No Post to Sales)

• 28 - Cash Management Transaction Item

g. Click Save.

3. Associate the Cash Back non-revenue service charge with the tender:

a. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Tender Parameters.

b. On the Configuration tab, ensure that Default SPI is selected in the Payment
Card Tender drop-down list.

This must be set for SPI transactions to function.

c. Select an open amount, non-revenue service charge (Cashback) to apply for
cash back transactions in the Cashback Service Charge drop-down list.

d. Click Save.

4. Enable Cash Back at the workstation:

a. Select the property, click Setup, and then click Workstations.

b. Double-click the workstation that has a Pinpad attached.

c. Click the Options tab, and then click the Offline/Misc subtab.

d. In the Miscellaneous Options section, select 63 - Enable Cashback.

e. Click Save.

Allowing Employees to Authorize and Perform Cash Back
You must grant permission for employees to authorize and perform a cash back
transaction.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, and then click the Operations tab.

3. Click the Transactions sub-tab, and then in the Service Charge and Discount
Options section select 305 - Authorize/Perform Cashback.

4. Click Save.
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Configuring Activate, Issue, and Reload Gift Cards with SPI
You can create three different service charge records for Activate Gift Card, Issue Gift Card,
and Reload Gift Card, or you can create one service charge record for all three.

1. Select the Enterprise, property, or zone, click Configuration, and then click Service
Charges.

2. Insert the service charge record (for example, Activate Gift Card, Issue Gift Card, or
Reload Gift Card), and then double-click it.

Note the Object # of each service charge.

3. On the General Settings tab, select the following options:

• 1 - ON = Open; OFF = Preset

• 7 - Non-Revenue Service Charge (No Post to Sales)

• 28 - Cash Management Transaction Item

See Configuring Service Charges for a description of each option.

4. Repeat Steps 2 and 3 to configure the other service charge records.

5. Click Save.

6. Select the Enterprise or property, click Configuration, and then click Print Classes.

7. Insert a new record and enter the name of the gift card print class in the Name field (for
example, Gift Card).

8. Select the following options:

• 1 - Print on Customer Receipt

• 2 - Print on Journal

• 3 - Print on Guest Check

9. Click Save.

Configuring Default Gift Card Redemption and Cash Out Gift
Card with SPI

You can create two tender media records for Default Gift Card Redemption and Cash Out Gift
Card.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a record, name it Default Gift Card Redemption, and then click OK.

3. Double-click the Default Gift Card Redemption record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Select 3 - Gift Cards from the Report Group drop-down list.

6. Click the Options tab, and then click the Printing Options subtab.

7. Select 8 - Print Customer Receipt and 21 - Print Summary Totals.

8. Select the Ops Behavior subtab, and then select the following options:
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• 2 - Amount Required

• 91 - Cash Management Transaction Item

9. Repeat Steps 2 through 8 to configure the Cash Out Gift Card record.

10. Click Save.

11. Select the Enterprise or property, click Configuration, and then click Print
Classes.

12. Insert a new record and enter the name of the gift card print class in the Name
field (for example, Default Gift Card Redemption).

13. Select the following options:

• 1 - Print on Customer Receipt

• 2 - Print on Journal

• 3 - Print on Guest Check

14. Click Save.

Configuring Gift Card Providers for SPI
You can configure multiple gift card providers to use with SPI. The Gift Card Provider
lets you configure the transaction type.

1. Select the Enterprise, click Configuration, and then click Gift Card Provider.

2. Insert a new gift card provider record with a relevant name, and then double-click
the record to open it.

3. Enter the Provider Reference. This is the Provider ID, which is obtained from the
Payment Service Provider (PSP). You cannot enter duplicate Provider References.

Simphony reads the Provider ID that is returned from the PSP and uses this
configuration to obtain the specific gift card provider. If no Provider ID is returned
or if a Provider ID is returned that is not configured in this module, Simphony uses
the Tender Parameters module configuration.

4. Select the default transaction type value for the following fields:

• Activate Service Charge: Select the service charge to use to activate a gift
card for this provider. Only non-revenue service charges may be used.

• Issue Service Charge: Select the service charge to use to issue a gift card for
this provider. Only non-revenue service charges may be used.

• Reload Service Charge: Select the service charge to use to reload a gift card
for this provider. Only non-revenue service charges may be used.

• Redeem Tender Media: Select the tender to use to redeem a gift card for this
provider.

When performing a gift card redemption transaction, the preambles in the
Tender/Media module are not used if a Provider ID is returned in the PSP
response.

• Cash Out Pickup: Select the tender to use to cash out a gift card for this
provider. Only Pickup Tenders may be used.

5. Repeat steps 2 through 4 for all gift card providers.

6. Click Save.
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Configuring Gift Card Tender Parameters for SPI
You need to have the privileges to configure the Tender Parameters module for gift cards.

To configure the default transaction types for SPI gift cards:

1. Select the Enterprise, click Setup, and then click Tender Parameters.

2. On the Configuration tab, select the SPI default values for the following fields:

• Payment Card Tender: Select the payment tender to use as the default for SPI (for
example, 14 - Default SPI).

• Activate Gift Card Service Charge: Select the default service charge to activate a
gift card (for example, 7 - Activate Gift Card).

• Issue Gift Card Service Charge: Select the default service charge to issue a gift
card (for example, 8 - Issue Gift Card).

• Reload Gift Card Service Charge: Select the default service charge to reload a gift
card (for example, 9 - Reload Gift Card).

• Redeem Gift Card Tender: Select the default tender to redeem a gift card (for
example, 41 - Default Gift Card Redemption).

• Cash Out Gift Card Tender: Select the default tender to cash out a gift card (for
example, 42 - Default Cashout Gift Card).

The default Payment Card Tender must be configured for a Cash Out Gift Card
transaction to function.

• Cashback Service Charge: Select the default service charge to use for giving cash
back from the use of a gift card (for example, 37 - Cashback).

3. Click Save.

Creating SPI Gift Card Buttons
You can create buttons on a POS client page for the SPI gift card functions.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the page on which to place gift card buttons.

3. On the Edit tab, select the page area in which to define the gift card functions (typically
the payment or function area).

4. Click Button.

5. On the General subtab, select Payment Tenders from the Type drop-down list.

6. Click the black arrow beneath the Type drop-down list.

7. Select 0 - None, and then click OK.

8. In the Payment Configuration dialog, select CreditDebit:Loadable from the Payment
Type drop-down list.

9. Select Balance Inquiry from the Functions drop-down list, and then click OK.

10. Position and size the button on the page. Use the Style arrow to change the color.

11. In the Legend field, enter the button name (for example, Gift Card Balance Inquiry)
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12. Click Save.

13. Repeat steps 4 through 12 to create buttons for each gift card function listed in the
following table. Select the corresponding function shown below from the
Functions drop-down list in Step 9.

Table 12-6    Gift Card Buttons

Button Name Function

Issue Gift Card IssueGiftCard

Activate Gift Card ActivateGiftCard

Reload Gift Card ReloadGiftCard

Cash Out Gift Card CashoutGiftCard

OPERA Self Pay
This section describes the process in which a guest can pay a check using a tablet
device, and an overview for setting up OPERA Self Pay features for Simphony.

The OPERA Self Pay feature is currently supported for OPERA Property Management
System (PMS) version 5.6.8.0 or higher.

After a dining room guest or hotel guest places an order, a server or room service staff
member presents a tablet device containing the check to the guest, who can:

• View the check

• Add a tip or change the tip value

• Select a different language

• Charge entire check to a room account

• Enter a room number and guest last name

• Sign the check with electronic signature after authorization

• Enter a valid email address and receive a receipt electronically through email

When a guest charges payment to a room account, Simphony posts the total payment
to the OPERA property management system (PMS). The front desk manager can view
the payment and signature from OPERA Self Pay in:

• Oracle Hospitality Reporting and Analytics using the Check Query and Audit and
Analysis portlets

• Oracle Hospitality Simphony Reports

Check images, including captured electronic signatures, are available through the
Oracle Hospitality Reporting and Analytics Check Query and Audit and Analysis
portlets.

Complete the following tasks to set up the OPERA Self Pay feature.

• Configure the Tenders

• Configure the Payment Drivers

• Configure the Payment Modules

• Create buttons for the POS Client
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• Configure E-mail Receipts

• Configure Languages

Configuring a Credit Card Tender
1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a record and name it based on the credit card company (for example, Visa or
MasterCard).

3. Double-click the credit card record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Printing Options subtab.

6. Select 8 - Print Customer Receipt and 21 - Print Summary Totals.

7. Click the Ops Behavior subtab.

8. Select 3 - Assume Paid in Full.

9. Click Save.

Credit Card Preamble
A credit card preamble—sometimes called a credit card prefix, issuer identification number
(IIN), or bank identification number (BIN)—is a digit or series of digits at the beginning of a
credit card number that identifies the type of card or company that issued the card.

Adhere to the following rules for governing a valid credit card preamble:

• The Start and End preambles must end with an asterisk (*) (for example, 304*).

• The number of digits in the Start and End fields must be the same.

• The number of digits in the Start and End fields cannot exceed the Length defined.

• The value of the End field must be greater than the value of the Start field.

Related Topics

• Configuring Standard Credit Card Preambles

• List of Standard Credit Card Preambles for the U.S.

Configuring Standard Credit Card Preambles
1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Double-click a credit card tender to open it, click the Options tab, and then click the
Credit Card Options subtab.

3. In the Preambles section, click Add, and then enter the Start, End, and Length for the
preamble.

If the preamble record defines a range such as 3050 to 3090, the Start field represents
the begin range, which is 3050*, and the End field represents the end range, which is
3090*.

See List of Standard Preambles for the U.S for a list of standard credit card preamble
ranges for different card types.
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4. To add another preamble for the card, Repeat Step 3.

5. Click Save.

Related Topics

• Credit Card Preamble

• List of Standard Credit Card Preambles for the U.S.

List of Standard Credit Card Preambles for the U.S.
The values listed in the following table apply to all US sites. Additional types are
accepted in other countries. Contact the local processor for the specific list. Preambles
also change as card providers are bought out (for instance, Discover purchased
Diner’s Club) and should be updated regularly.

Table 12-7    List of Standard U.S. Credit Card Preambles

Card Type Start End Length

Visa 40000000* 49999999* 16

MasterCard 51000000*
222100*

55999999*
272099*

16
16

American Express 34000000*
37000000*

34999999*
37999999*

16
15

Diners Club 36000000*
38000000*
30000000*
30950000*

36999999*
39999999*
30599999*
30959999*

14
16
16
16

JCB 35280000* 35899999* 16

Discover 60110000*
60112000*
60117400*
60117700*
60118600*
64400000*

60110999*
60114999*
60117499*
60117999*
60119999*
65999999*

16
16
16
16
16
16

Discover (CUP) 62212600*
62400000*
62820000*

62292599*
62699999*
62889999*

16
16
16

Related Topics

• Credit Card Preamble

• Configuring Standard Credit Card Preambles
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Configuring Credit Card Authorization to Print Merchant
Vouchers and Customer Receipts

You can configure the printing of credit card vouchers when workstation operators press the
Credit Card Authorization function key on the POS client. Complete the steps below to
allow the following items to print:

• Merchant voucher (for cardholder signature)

• Customer receipt

Confirm the cardholder signature verification with your Payment Service Processor (PSP)
before configuring Quick Service Limits. Cardholder signature verification prompts are forced
by the PSP, and may appear for every transaction, even if the property is configured to not
print merchant vouchers below a certain amount. This could leave a property in a situation
where no signature is present, but the workstation operator is prompted to verify it.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Click the Printing Options tab, and then select the following options:

• 8 - Print Customer Receipt

• 54 - Print 2 Guest Checks/Receipts

3. Click Save.

4. Repeat Steps 1 through 3 for each credit card tender record.

If multiple properties exist and each property has different credit card tenders (not
inherited from the Enterprise), you will need to configure the printing options separately
for each property.

5. Select the revenue center, click Setup, and then click RVC Parameters.

6. Click the CA/EDC tab (Credit Card Authorization/Electronic Draft Capture), and then
select 7 - Print Two Credit Card Vouchers.

7. Click Save.

Configuring Credit Card Voucher Headers and Trailers
Credit card headers and trailers are leading and trailing lines that print on credit card
vouchers.

1. Select the Enterprise or revenue center, click Descriptors, and then click either Credit
Card Headers or Credit Card Trailers.

2. In the Text column, enter the text to appear on the header or trailer in the rows.

3. To insert a logo for the header or trailer, select a check box from the Use Logo column,
and then select a logo using the ellipsis point (...) button in the Logo column.

Logo Printing contains more information about setting a header or trailer line to print
logos rather than text.

4. Click Save.
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Configuring the Room Charge Tender
Configure a room charge tender for guests to charge meals to a hotel room using
Oracle Hospitality OPERA.

1. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

2. Insert a record and name it OPERA Room Charge.

3. Double-click the OPERA Room Charge record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Interface Options subtab.

6. Configure settings on the subtab as follows:

• Click the Interface Link drop-down and select 0 - None.

• Select 38 - Use ISL TMED Procedure Instead of PMS Interface.

• Select 39 - Reverse PMS Itemizers On VOID Postings.

7. Click Save.

8. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Tender Parameters.

9. On the Configuration tab, select 4 - PMS in the Room Charge Tender drop-down
list.

This is the Tender/Media record to use for room charges with the OPERA PMS
Interface.

10. Click Save.

Configuring the OPERA PMS Payment Driver
To configure the Oracle Hospitality OPERA 5 Hotel Property Systems payment driver:

1. Select the Enterprise, property, or revenue center, click Setup, and then click
Payment Drivers.

2. Insert a record, enter OPERA PMS Driver as the name, and then click OK.

3. Double-click the record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select
OperaWSPayment.dll, and then click Open.

6. Click the Configuration tab.

7. From the Assembly/Class section, enter information in the following fields:

Table 12-8    Assembly/Class Fields

Field Description

Description Enter a description for the payment driver (for
example, PMS posting driver for OPERA).
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Table 12-8    (Cont.) Assembly/Class Fields

Field Description

Display Name Enter the name of the PMS driver (for example,
OPERAPMS). This value appears in the Driver
drop-down list.

Driver ID Enter OPERAPMS.

8. From the Opera Interface Properties section, enter information in the following fields:

Table 12-9    Opera Interface Properties Fields

Field Description

Connection String For Opera Cloud, enter CLOUD.
For Opera version 5, enter the connection string
provided. It will look similar to jdbc / abcde.

Interface ID Enter the OPERA interface ID.

Opera Tender Number Enter the Tender/Media object number mapped for
the Room Charge.

Password Enter the password.

Posting Format Select one of the following:
• Encoded: Select to post to OPERA with encoded

format in the XML request. The Encoded
format is used for backward compatibility. Use
this format with OPERA version 5.0.04.

• Literal or Empty (by default): Select to post to
OPERA with plain text format. The room charge
will post to OPERA with Literal format in the
XML request. Use this format with OPERA
version 5.0.05.

Resort Enter the name of the property using OPERA.

UserName Enter the user name.

Web Service Enter the URL of the OPERA Web Service.

9. Click Save.

Configuring the Loadable PMS Payment Module
Configure a property management system (PMS) payment module for guests to charge
meals to a hotel room using Oracle Hospitality OPERA version 5.0.04.01 and later.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Payments.

2. Insert a record and name it LoadablePMS.

3. Double-click the LoadablePMS record to open it.

4. Click the Import from a file link.

5. Browse to [Drive
Letter]:\MICROS\Simphony2\EgatewayService\handlers\Micros.Payment.LoadablePmsM
odule.dll, and then click Open.
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6. Click Save.

7. If you are using Simphony version 19.2.1 or later, complete the following steps:

a. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Tender Parameters.

b. On the Configuration tab, select OPERA as the Payment Card Tender.

c. Click Save.

Configuring the OPERA Self Pay Button
OPERA Self Pay utilizes the Loadable PMS Payment Module to perform a room
charge from the Simphony POS client to the OPERA Property Management System.
To configure the OPERA Self Pay button:

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the OPERA Self Pay button.

3. On the Edit tab, select the page area in which to define the OPERA Self Pay
functions (typically the payment area).

4. Click Button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, and then select
OPERA Self Pay.

8. Highlight the OPERA Self Pay button.

9. Click the OPERA Self Pay Configuration button. The following steps are
optional:

a. Select Exit Opera Self Pay Without ID Prompt when OPERA Self Pay is
used on a guest-facing device (such as a kiosk). This allows for the guest to
exit to the order screen without employee intervention.

b. Select Hide Email Prompt Screen so that the UI does not ask for a guest’s e-
mail address. If this option is disabled, the option to enter an email address
appears for the guest.

c. Select Enable Tip Screen, and then enter the Default Tip Percent value
between 0–99. This tip percentage value is shown to the guest.

10. In the Select Payment Methods section, select Opera as the payment type from
theType drop-down list.

11. Click the Edit... link in the Command column.

12. From the Payment Configuration dialog window, select the appropriate payment
method from the Functions drop-down list.

13. Select the Loadable PMS Driver Payment command Other1:LoadablePms from
the Payment Type drop-down list, and then click OK.
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Table 12-10    OPERA Self Pay Payment Methods

Type Command

Opera Other1:LoadablePms: Loadable property
management system driver for room
charges

14. In the Style section, click the arrow to change the color of the button.

15. Position and size the button to the desired area and dimension on the page.

16. Click Save.

Configuring Email Receipts
1. Select the property, click Setup, and then click Property Parameters.

2. On the General tab, click the Primary SMTP Server subtab.

3. Enter information in the fields as described in the following table:

Table 12-11    Email Receipt Fields

Field Description

Server Enter the email server or service to use.
Click Select to choose from the SMTP Server
list of commonly used mail servers (for
example, Outlook, Gmail, or Yahoo).

Port Enter the port number for the SMTP email
server. A default port of 587 works for most
SMTP servers.

SSL Select this option to require secure Internet
communication.

User Name Enter the user name of the email address
that will send receipts.

Password, Confirm Password Enter the password associated with the
email user name.

Source Email Enter the full email address to appear as the
sender in the emailed receipt. Depending on
the SMTP server, this may not create a copy
of emails sent.

Name Enter the business name or sender name to
appear along with the email in the sender
field. Depending on the SMTP server, this
value may or may not appear in the sent
email (for example, Username = jsmith
Name = John could appear as:
John<jsmith@oracle.com>).

BCC List Enter the email addresses to receive a blind
carbon copy of the email receipt that is sent
to the guest. Oracle recommends that you
list the source email in the BCC field so you
can resend copies of email receipts later if
necessary.
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4. Click the Send Test Email button to send a test email receipt message to the
source email address. A confirmation appears after the email is successfully sent.

5. Click the Backup SMTP Server subtab.

6. Configure the Backup SMTP Server with the same settings as the Primary SMTP
Server or an alternate server from which to send emails in the event the primary
server becomes unavailable.

7. Click the Text Formatting subtab, and then enter information in the following
fields:

• Email Subject: Enter text in rich text format to appear as the subject line of
email receipts.

• Email Body: Enter text in rich text format to appear as the body of email
receipts. You must include @@Check in the body in order to send a copy of
the receipt.

8. Click the HTML Formatting subtab, and then enter information in the following
fields:

• Email Subject: Enter text in HTML format as the subject line of email receipts.

• Email Body: Enter text in HTML format as the body of email receipts. You
must include @@Check in the body in order to send a copy of the receipt.

9. Select the Send Html Email check box to dim the Text Formatting tab and send
only the HTML format. Deselect this option to dim the HTML Formatting tab and
send only the text formatted email.

10. Click Save.

Configuring a Tender with Charged Tips
A charged tip is a gratuity credited to a server by adding it to a charge slip, such as a
credit charge slip or room charge slip. Thus, like the meal, the tip is “charged” to a
credit card or room account. A charged tip is credited to the check operator.

1. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

2. Double-click a credit card tender record to open it (for example, Visa or OPERA
Room Charge).

3. Click the Ops Behavior subtab.

4. Select the following options:.

• 9 - Charged Tip Required

• 10 - Post to Gross Receipts on Tip Reports

Disabling 10 causes service charges to post to gross receipts as a negative
amount on tip reports.

• 11 - Post Amount to Charged Receipts on Tip Reports

5. Click Save.

6. Select the Enterprise, property, or zone, click Configuration, and then click
Service Charges.

7. Double-click a service charge record to open it
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8. In the Service Charge options section, select 3 - Post to Charged Tips Total on Tip
Reports.

Configuring Service Charges contains more information about option 3.

9. Click Save.

Autosequence Events
You can set up automatic event tasks, such as running Start of Day (SOD) and nightly credit
card batching, using the PC Autosequence feature. After you create an automatic event, you
can schedule it to run repeatedly at specific frequencies or time intervals.

To set up an automatic event, you must configure the Autosequence Event and the
Autosequence Event Schedule.

Related Topics

• Configuring Autosequence Events

• Configuring the Autosequence Event Schedule

Configuring Autosequence Events
1. Select the Enterprise level, click Configuration, and then click PC Autosequences.

2. Insert a record for the autosequence event (for example, Nightly Batch). If the
autosequence event record exists, skip this step.

3. Double-click the record to open it.

4. On the General tab, select each Property to include in the autosequence event run.

5. (Optional) Select the employee group that is allowed to run the autosequence event from
the Privilege Group drop-down list.

6. (Optional) To restrict execution of the autosequence event, click the Add link from the
Parameters section, and then add optional parameters.

7. Click the Steps tab.

8. Beneath the Steps section, click the Add link to add the first step of the autosequence
event.

9. From the Step Parameters section, select the Step Type from the drop-down list.

10. Repeat Steps 9 and 10 to add each step required to run the autosequence event.

11. Select the outcome for each step:

• Step on Success: Select the step number to occur next if a step succeeds. For
example, after Step 1 runs successfully, proceed to Step 2.

• Step on Failure: Select the step number to occur next if a step fails. For example, if
Step 1 fails, do no proceed with any steps.

12. Click Save.

Related Topics

• Autosequence Events
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Configuring the Autosequence Event Schedule
1. Select the Enterprise level, click Configuration, and then click PC Autosequence

Schedules.

2. Insert a record for the autosequence schedule (for example, Nightly Batch). If the
autosequence schedule record exists, skip this step.

3. Double-click the record to open it.

4. On the General tab, enter information in the following fields:

Table 12-12    General Settings Fields

Field Description

Autosequence Select the autosequence event from the
drop-down list.

Server Name Enter the name of the server located at
the Enterprise level or Hosting Center.

Time Zone Select the time zone of the Enterprise
level or Hosting Center.

Schedule Type Select the frequency for the
autosequence event.

Duration Select Enabled for the autosequence
event to run.
Select the Start and End dates for the
autosequence event.

5. Click the Recurrence tab.

6. From the Daily section, enter the number of days for the autosequence event to
reoccur. For example, to run the event daily, set this value to Every 1 day(s).

7. From the Daily Frequency section, set the time or times for the autosequence
event to run.

8. Click Save.

Related Topics

• Autosequence Events

Configuring Equal Payment Functionality
To configure the Equal Payment On/Off function in EMC:

1. Select the Enterprise or property level, click Configuration, and then click Page
Design.

2. In the Page Design module, select the Transaction page for editing.

3. In the Edit tab, add the new toggle button function Equal Payment On/Off. You
can also edit an existing button function and replace it with the Equal Payment
On/Off button.

4. Click Save.
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5. Select the Enterprise, zone, property, or revenue center, click Configuration, and then
click Format Parameters.

6. In the Options tab, select 62 - Print Equal Payment Receipts.

When enabled, the printed equal payment receipt shows all menu items, subtotal, tax,
total due, and equal partial payment amount including tips or change. The receipt prints
on the workstation guest check printer or customer receipt printer for fast transactions.

7. Click Save.

Removing Legacy Credit Card Drivers
The following steps describe how to remove legacy credit card drivers from EMC, in order to
allow for upgrading from older versions of Simphony. Oracle Food & Beverage provides an
Upgrade Eligibility tool for customers that need to remove legacy credit card drivers.

1. On the client system file explorer, navigate to the Handlers directory, and run the
UpgradeEligibilityCheck.exe utility.

2. After the utility finishes checking, it notifies you that there are configuration settings that
are preventing an upgrade. Navigate to the UpgradeEligibilityCheck.log in the
Handlers directory and open the file to view the list of detected settings.

3. Make note of the listed legacy payment drivers (and their property/enterprise locations in
EMC) in the log file that are preventing the upgrade.

4. In EMC, at the enterprise or property level, navigate to the Setup tab and then click
Payment Drivers.

5. Select the payment driver record(s) that need to be deleted, and then click the Delete
icon button.

6. Run the UpgradeEligibilityCheck.exe utility to verify that there are no additional
payment drivers to delete.
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13
Taxes

A tax is a sum of money imposed by a government, levied upon prepared food and
beverages sold in a restaurant. The following table explains the Simphony methods of
taxation:

Table 13-1    Tax Methods

Tax Method Description

Value Added Tax (VAT) A VAT is a form of sales tax used in some countries. VAT is an
inclusive tax, which means the tax is included in the menu
item price. The global tax type can be set as European or
United States. A VAT is calculated differently, depending on
the global setting. In Europe, only inclusive type tax is
calculated. In the United States, inclusive type tax and add-on
type tax can be used at the same time.
VAT inclusive taxes are broken out from sales totals on
financial related reports (for example, Revenue Center
Financial Report or System Financial Report), with the
inclusive tax reflected in the Tax Collected totals field.
If your property uses VAT, the following Reporting and
Analytics templates can be applied for the Open/Closed Check
reports:
• EAME_MMRevCtrOpenChecks_VAT
• EAME_MMRevCtrClosedChecks_VAT

U.S. Inclusive Tax U.S. inclusive tax uses the item price and a percent value to
calculate the tax amount. The tax is then included in the price
of each menu item added to the bill. For example, if the tax
rate is 5% and the item price is $5.00, the inclusive tax method
calculates by the formula: $5.00/(1+5%) = $4.76. The total cost
for the customer remains $5.00, but the net sales price is $4.76
and the tax is $0.24. If U.S. inclusive tax is used, only one
inclusive tax rate can be applied to a menu item.
U.S. inclusive taxes do not appear on the Open Check Report
in Reporting and Analytics, and do not print on Open/Closed
Check reports.
Additionally, inclusive taxes are broken out from net sales
totals on financial related reports (for example, Revenue
Center Financial Report or System Financial Report), with the
inclusive tax reflected in the Tax Collected totals field.

Add-on Tax Add-on tax uses the item price to calculate tax, which is then
added to the bill. For example, if the tax rate is 5% and the
item is $5.00, the application calculates 5% of $5.00,
posting $0.25 tax to the check and making the total due
of $5.25.

Breakpoint or Threshold Tax Breakpoints establish the points at which an increase of one
cent in sales increases tax by one cent. For example, a
breakpoint tax might be one percent for sales from zero to
twenty cents and then two percent from twenty-one to forty
cents. Twenty cents would be the breakpoint for this tax.
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Tax Rates and Tax Classes
Simphony uses tax rates and tax classes to assign taxes to menu items, discounts,
and service charges.

A tax rate is the percentage at which taxes are paid to a government. In some
jurisdictions, multiple tax rates apply. Usually these tax rates must be calculated
separately for accounting purposes (allowing each jurisdictional government to collect
the appropriate tax amount).

A tax class is a collection of tax rates. Tax classes determine the tax rates that apply to
menu items and service charges, and which tax rates can be reduced by discounts.
Consider the following example: 2% City Tax Rate + 4% State Tax Rate = 6%
Sales Tax (tax class which contains two tax rates). In this example, both the
city and state tax rates are active for the Sales tax class. The total sales tax is 6%. By
grouping multiple tax rates into a single tax class, you can view a record named Sales
Tax.

You can associate a tax class with the following types of records:

• Menu Item Class: All menu item definitions in the menu item class are taxed using
the tax class.

• Discount: When you assign a tax class to a discount, the taxes linked to the tax
class are recalculated when the discount is applied using the reduced taxable
sales value.

• Service Charge: Some types of service charges are taxed, such as banquet and
room service transactions.

For server convenience, bars often use inclusive taxes. In some properties with
multiple revenue centers, it is common that a bar revenue center uses inclusive taxes
while a restaurant revenue center uses add-on taxes, even though both revenue
centers serve the same items. In this scenario, the configuration of a Liquor tax class
might be:

• Inclusive tax rate – 5%

• Add-on tax rate – 5%

Using this scenario, you can set either order types or serving periods to have the
appropriate tax rates in the revenue centers. The following table shows an example
configuration using Order Types:

Table 13-2    Example of Inclusive Tax with Multiple Revenue Centers

Revenue Center Order Type Tax Configuration

Bar • Inclusive tax rate enabled
• Add-on tax rate disabled

Restaurant • Inclusive tax rate disabled
• Add-on tax rate enabled

Related Topics

• Configuring Tax Rates and Classes
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Configuring Tax Rates and Classes
1. Select the Enterprise, property, or zone, click Setup, and then click Tax Rates.

2. Locate the appropriate tax rate. There are 64 active tax rates.

3. Select the tax rate type from the Type drop-down list. The following table describes the
tax types:

Table 13-3    Tax Types

Type Description

0 - Disabled Tax Rate Select this option if the tax rate is not used.

1 - Add On, Breakpoint Select this option to calculate the add-on tax
using the Breakpoint method.

2 - Add On, Percentage Select this option to calculate the add-on tax
using the tax percentage rate.

3 - Included, Percentage Select this option to calculate the inclusive
tax using the tax percentage rate to
determine what portion of the sales price is
the tax. The inclusive tax applies differently
depending on the global VAT (European or
United States).
Because the tax is included in the price, the
tax is backed out of gross sales on reports.

4 - Surcharge Select this option to calculate surcharges for
items.

4. Click Save.

5. Select the Enterprise, property, or zone, click Setup, and then click Tax Classes.

6. Insert a tax class record with the appropriate name (for example, Soda Tax, Liquor Tax,
or Surcharge).

7. From the Taxes Enabled field, select the applicable tax rates, and then click OK. The tax
rates you select are active for the tax class.

8. Click Save.

Related Topics

• Tax Rates and Tax Classes

Tax Parameters
The Tax Parameters module enables you to configure options related to taxes. You can
configure the Tax Parameters module at the property, zone, or revenue center levels. 
Configuring Tax Parameters contains more information.

The following tables list all tax parameter options.
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Table 13-4    Tax Parameters International Options

International Options Description

1 - ON = Apply Tax as Add-On; OFF = Apply
Tax as VAT

Select this option to treat taxes as add-on.
Deselect this option to treat taxes as a value
added tax (VAT). If you enable VAT, all tax
rates in use must be type Included,
Percentage.

3 - Print Tax Itemizers Select this option to print tax itemizers on
guest checks and receipts. An itemizer is
considered a bucket that holds the sale
amount of all items taxed at a specific rate.
At the end of a transaction, the tax is
applied to the subtotal of all items in the
bucket. Menu Item Classes are linked to
Tax Classes, which in turn, are linked to
Tax Rates 1-64. When you link to a tax rate,
you are creating an itemizer bucket for
that item.
You must enable this option for Philippine
tax.

4 - Enable Canadian GST Select this option to enable Canadian Goods
and Services Tax (GST).

6 - Enable Thailand Tax Printing Select this option to enable Thai tax
options.
Starting with Simphony release 19.2.1, this
option is not in use.

13 - Truncate Inclusive Taxes This option applies to all inclusive tax
calculations. It determines whether the
inclusive tax amount that is calculated is
rounded or truncated. For example, if a
currency has two decimal places and the
tax calculated is 12.005, the rounded tax is
12.01, but the truncated tax is 12.00.

14 - Print Item Inclusive Tax Total If the check contains items with inclusive
taxes, this option enables the total inclusive
tax to print on the guest check. The line
prints according to Tax Parameters option
4 - Print Inclusive Tax Totals when 0.00.
The inclusive tax amount is the sum of the
inclusive taxes for each item on the check.
You must also select Tender/Media Printing
Options 21 - Print Summary Totals and 24
- Print Inclusive Tax or VAT Lines on
Check or Receipt for the inclusive tax
totals to print.
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Table 13-4    (Cont.) Tax Parameters International Options

International Options Description

15 - Print Check Inclusive Tax Total If the check contains items with inclusive
taxes, this option enables the total inclusive
tax to print on the guest check. The line
prints according to Tax Parameters option
4 - Print Inclusive Tax Totals when 0.00.
The inclusive tax amount is calculated on
the total sales for each tax rate. You must
also select Tender/Media Printing Options
21 - Print Summary Totals and 24 - Print
Inclusive Tax or VAT Lines on Check or
Receipt for the inclusive tax totals to print.

16 - Print Tax Rate per item Select to print the applied tax rates for each
menu item on guest checks, customer
receipts, and the journal.

17 - Enable Tax Labels Select to consolidate tax reporting
information based on the defined Tax
Labels configured under Tax Rates.

Table 13-5    Tax Parameters Options

Options Description

1 - Do Not Include Tax in Totals on Tip Reports Select this option to prevent a transaction's
calculated tax amount from posting to the
gross receipts and charged receipts totals on
tip reports.

2 - Require a Reference Entry with Tax
Exemptions

Select this option to require workstation
operators to enter a reference entry when
using an exempt tax function key.

3 - Print Inclusive Tax Lines Before Summary
Totals

Select this option to print inclusive tax total
before summary totals on guest checks and
customer receipts.

4 - Print Inclusive Tax Totals when 0.00 Select this option to print inclusive totals on
guest checks and customer receipts even if the
calculated tax due is 0.00.

5 - Print Consolidated VAT Line on Checks and
Customer Receipts

Select this option to print a consolidated VAT
line. If you use this option in conjunction with
individual VAT line printing, the consolidated
line prints last.

6 - Print VAT Net Totals on Guest Checks and
Customer Receipts

Select this option to print a VAT Net Totals line
on guest checks and customer receipts.

7 - Print Tax Exempt Voucher Select this option to print a voucher when any
tax is exempted. The voucher prints when a
tax exempt function key or a tender exempts
tax. The voucher prints at the validation
printer designated for the workstation.
Deselect this option to suppress printing of a
tax exempt voucher.
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Table 13-5    (Cont.) Tax Parameters Options

Options Description

8 - Post Taxable Sales When the Tax Rate is
Zero

Select this option to have taxable sales post to
the TAX_DAILY_TOTAL table in Reporting and
Analytics when the tax rate is set to 0.00%. The
taxable amounts can be used for reporting
even though there are no applied taxes.
Deselect this option so that taxable sales do
NOT post to Reporting and Analytics when the
tax rate is set to 0.00%.

Related Topics

• Configuring Tax Parameters

Configuring Tax Parameters
Tax Parameters contains a list of all tax parameter options.

1. Select the property, zone, or revenue center, click the Setup tab, and then click
Tax Parameters.

2. Click the International Options tab, enable the appropriate options, and then click
Save.

3. Click the Options tab, enable the appropriate options, and then click Save.

4. To set printing lines for the appropriate tax rates, select the VAT Options, and then
click Save.

Related Topics

• Tax Parameters

Tax Labels
Setting tax labels allows you to perform the following actions:

• Define up to two tax labels and associate each of them with a specific tax rate

• Associate multiple tax rates with the same tax labels

• Associate a blank tax label with tax exempt items (considered non-value-added
tax (VAT))

Related Topics

• Configuring Tax Labels

Configuring Tax Labels
1. Select the Enterprise, property, revenue center, or zone, click Setup, and then

click Tax Parameters.

2. Click the International Options tab.

3. Select 17 - Enable Tax Labels.
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4. Click the Options tab.

5. To post items with a 0% tax rate, select 8 - Post Taxable Sales when Tax Rate is Zero.

6. Click Save.

Related Topics

• Tax Labels

Serving Periods
A serving period is a time period during the business day in one revenue center. The
following examples illustrate serving periods:

• Breakfast (5:00 a.m. to 11:00 a.m.)

• Lunch (11:00 a.m. to 5:00 p.m.)

• Dinner (5:00 p.m. to 10:00 p.m.)

You can run sales reports for serving periods, include the active serving period in interface
posting messages, and use serving periods to determine the default transaction screen.

Related Topics

• Configuring a Serving Period

Configuring a Serving Period
1. Select the revenue center, click Configuration, and then click Serving Periods.

2. Insert a record and enter the serving period name.

The name is used in Serving Period Reports and is also available as an indicator on the
POS client.

3. Select the serving period Start Time and the End Time. If the serving period lasts all day,
use the same start and end times.

4. In the Table Count field, enter the number of tables available during the serving period.

5. Select the days of the week when the serving period is active.

6. (Optional) Select the Default Main Level to use when the serving period is active.

The values available in the Default Main Level and the Default Sub Level fields are set
in the RVC Parameters module. Setting the Default Menu Levels for a Revenue Center
contains more information.

Menu Levels contains more information about Menu Level Hierarchy.

7. Select the Default Sub Level to use when the serving period is active.

8. Click the Taxes tab.

9. Select the tax rates to use when the serving period is active.

10. Click Save.

Related Topics

• Serving Periods
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Order Types
An order type is a sales category, such as Dine In or Take Out. You can set up to eight
order types for each location. Order types control active tax rates for a transaction and
help to reduce theft in fast transaction environments. You can specify order types at
three different levels of a transaction, as described in the following table: Transaction,
Check, and Menu Item.

Table 13-6    Order Types

Order Type Description

Transaction Order Type This is the order type of the current round. If the
workstation operator changes the transaction order type,
the order type of all menu items in the current round
changes to the selected order type while the order type of
the check remains unaffected. A reference entry with the
name of the changed order type appears at the top of the
menu items.

Check Order Type The active check order type appears in the check detail
header.
When option 16 - Post to Check Order Type is enabled (in
the RVC Parameters module Posting options), and the
menu item order type is different from the active check
order type, menu item sales post to the check order type
on financial reports, even if the Menu Item Order Type
function is used and will result in a different order type.
When option 16 - Post to Check Order Type is disabled,
and the menu item order type is different from the active
check order type, menu item sales post to the menu item
order type on financial reports.
For example, a Dine In guest wants to take a dessert home,
so the server changes the dessert item’s order type to Take
Out. Doing so may have tax rate implications, as well as
notifying the prep station to package the dessert for carry
out. In this instance, if option 16 is disabled, the dessert
posts to the Take Out order type totals on the financial
reports.

Menu Item Order Type This is the order type of the menu item and also affects the
condiments of the menu item. The workstation operator
can change the order type of an entire combo meal or
selected items in a combo meal. A reference entry appears
with the name of the order type beneath the menu item to
which the change was made. If the workstation operator
consolidates menu items, changing the menu item order
type affects all consolidated items. When the workstation
operator changes a condiment order type, it applies to the
parent menu item.
Review the Check Order Type information (in the row
directly above) for information about how Posting option
16 - Post to Check Order Type in the RVC Parameters
module affects order types and their reporting totals.
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Order Type Subtotal Security Option

In a fast transaction environment, you can increase security and reduce theft by restricting
the workstation operators’ ability to perform voids and cancel transactions, while still allowing
operators to perform legitimate error corrections. Simphony allows you to suppress the check
total on the workstation until the workstation operator presses an order type key that
functions as a subtotal. The following table describes the type of theft that can be prevented
using the subtotal security.

Table 13-7    Subtotal Restriction Scenarios

No Order Type Subtotal Keys Using Order Type Subtotal Keys

• Workstation operator begins transaction.
• Customer orders hamburger and soda.
• Workstation operator sees the total

as $4.78 and requests the payment amount
from the customer.

• The customer gives $4.78 in cash.
• Workstation operator pockets the cash and

voids the items or cancels the transaction.

• Workstation operator begins transaction.
• Customer orders hamburger and soda.
• Workstation operator does not see the

total amount due, and must press one of
the Order Type function keys to view the
subtotal.

• The customer gives $4.78 in cash.
• Workstation operator cannot void items or

cancel the transaction after pressing the
Order Type key. After pressing the Order
Type key, the items ordered are
considered previous-round items for
voiding purposes. Typically, only
managers can perform previous-round
voids.
If the workstation operator adds another
menu item after pressing the Order Type
key, the Summary Totals are hidden until
an Order Type is declared again. The
workstation operator can perform error
corrections on items that were ordered
since the Order Type key was pressed, but
cannot perform error corrections on items
before the Order Type declaration.

Related Topics

• Configuring Order Types

• Configuring Order Types as Subtotal Keys

• Configuring Touchscreen Buttons for Order Types

Configuring Order Types
1. Select the Enterprise, property, or zone, click Descriptors, and then click Order Types.

2. In the Text field, enter an order type for each record (for example, Dine In, Take Out,
Drive Thru).

3. Click Save.

4. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Order Type Parameters.
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5. For each order type record, select the appropriate options as described in the
following table:

Table 13-8    Order Type Options

Option Description

1 - Print on Customer Receipt and
Guest Check

Select this option to print the order type name
on customer receipts and guest checks.

2 - Print on Order Printer Select this option to print the order type name
on order printers.

4 - Do Not Post Transactions to Tip
Report Totals

Select this option to exclude sales for the order
type from Tip Report Totals.

5 - Perform Auto Combo
Recognition

Select this option to have workstations
automatically perform auto combo recognition
when the workstation operator changes the
workstation to the order type.

6 - Transaction Cancel Default Select this option when starting orders without
an order type.
When a workstation operator begins a
transaction and cancels it before selecting an
order type, the POS client requires the
workstation operator to associate the check
with an order type for posting purposes. The
POS client finds the first order type that has this
option selected and uses it.
Deselect this option to have the POS client use
the first order type record in the list to associate
with the check.

8 - Enable Routing Order by Order
Type

Select this option to control order routing by the
order type.

9 - KDS Allow Item Print on Item
All Prep Done

See Printing Runner Chits by Order Type in the
Oracle Hospitality Simphony KDS Configuration
and User Guide for more information.

10 - Suppress Dining Course See Suppressing Dining Courses from Orders in
the Oracle Hospitality Simphony KDS
Configuration and User Guide for more
information.

11 - Exempt Inclusive Tax Select this option to exempt the inclusive tax for
take away order types.

6. Click the ellipsis point (...) button in the Tax Mask column, select the tax rates for
the order type, and then click OK.

If you are creating an order type for Uber Eats or Deliveroo, do not select any tax
rates in the Tax Mask column.

7. Select Active for each order type that you want to activate.

8. Click Save.

9. Select the revenue center, click Setup, and then click RVC Parameters.

10. (Optional) Select the Default Order Type from the drop-down list. This is the order
type that is active when a workstation operator begins a check.

11. Click Save.
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12. To override the default order type setting for a workstation:
a. Select the property, click Setup, and then click Workstations.

b. Click the Transactions tab.

c. Select the Default Order Type from the drop-down list.

d. Click Save.

Related Topics

• Order Types

Configuring Order Types as Subtotal Keys
You can allow the Order Type keys in the revenue center to act as Subtotal keys. After
pressing the Order Type key, the items ordered are considered previous-round items for
voiding purposes. This is a security option to prevent fast transaction operators from voiding
items after viewing the check subtotal.

1. Select the Enterprise, property, or revenue center, click Setup, and then click Control
Parameters.

2. Click the Options tab.

3. If you do not want summary totals (subtotal, tax, amount due, and change due) to appear
on the workstation until the workstation operator presses an Order Type key, select 8 -
Display Summary Totals Only After Order Type Declared.

4. Click Save.

Related Topics

• Order Types

Configuring Touchscreen Buttons for Order Types
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page on which to place the order type buttons, and then on the Edit tab, select
the page area in which to define the buttons.

3. Click Button.

4. To configure a menu item order type button:
a. On the General subtab, select Menu Item Order Type from the Type drop-down list

b. Click the black arrow directly beneath the Type drop-down list, select an order type
from the list, and then click OK.

5. To configure a transaction order type button:
a. On the General subtab, select Transaction Order Type from the Type drop-down list

b. Click the black arrow directly beneath the Type drop-down list, select an order type
from the list, and then click OK.

6. To configure a check order type button:
a. On the General subtab, select Order Type from the Type drop-down list

b. Click the black arrow directly beneath the Type drop-down list, select an order type
from the list, and then click OK.
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7. Enter a Legend for the button, and then position and size the button on the page.

8. Click Save.

9. Repeat Steps 3 through 8 to configure more order type buttons.

Related Topics

• Order Types

Printing Tax Rate Per Item
You can configure a menu item’s tax rate to print on guest checks and customer
receipts, and in the journal. The following diagram illustrates a sample customer
receipt printed with the tax rates for each menu item, workstation number and
transaction number.

Figure 13-1    Sample Guest Check with Tax Rates

Related Topics

• Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and
Journal

• Configuring Workstation Number and Transaction Number to Print on Guest
Check, Customer Receipt, and Journal

Configuring Tax Rates Per Item to Print on Guest Check,
Customer Receipt and Journal

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Tax Parameters.

2. Click the International Options tab.

3. Select 16 - Print Tax Rate per item to print tax rates associated with the menu
item class on the guest checks and customer receipts. Deselect this option if you
do not want the tax rates to print on the guest check, customer receipt, or journal.
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For example, the line item for a Grilled Cheese Sandwich on the printed check appears
as follows:

1 Grilled Cheese 5.99  T2  T4

The guest check and customer receipt indicate the tax rate applied to each item. The T2
and T4 shown after the item’s price indicate that tax rates 2 and 4 were applied to a
Grilled Cheese.

4. Click Save.

Related Topics

• Printing Tax Rate Per Item

Configuring Workstation Number and Transaction Number to
Print on Guest Check, Customer Receipt, and Journal

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Format Parameters.

2. Click the Options tab.

3. Select the appropriate workstation and transaction options.

• 54 - Print Workstation Number: Select this option to print the workstation number
on the header of guest checks and customer receipts, and in the journal.

• 55 - Print Transaction Number: Select this option to print the transaction number on
the header of guest checks and customer receipts, and in the journal. The journal
header does not contain the legacy transaction number (labeled TRN).

4. Click Save.

Related Topics

• Printing Tax Rate Per Item

Surcharges
A surcharge is a preset tax amount that is applied to a menu item. For example, some cities
charge a sugar tax for beverages that contain added sugar, such as carbonated soft drinks,
sports drinks, and energy drinks.

Related Topics

• Configuring Surcharges

Configuring Surcharges
1. Create a surcharge tax rate:

a. Select the Enterprise, property, or zone, click Setup, and then click Tax Rates.

b. Insert a record and name it for the surcharge.

c. Select the 4 - Surcharge tax rate type from the Type drop-down list.

d. Click Save.

2. Create a surcharge tax class:
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a. Select the Enterprise, property, or zone, click Setup, and then click Tax
Classes.

b. Insert a tax class record and name it for the surcharge.

c. From the Taxes Enabled field, select the surcharge tax rate, and then click
OK.

d. Click Save.

3. Configure the Tax Mask:

a. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Order Type Parameters.

b. Click the ellipsis point (...) button in the Tax Mask column, select the
surcharge tax rate for the order type, and then click OK.

c. Ensure that Active is enabled for the order type with the surcharge tax rate.

d. Click Save.

4. Configure the serving period for the tax rate:

a. Select the revenue center, click Configuration, and then click Serving
Periods.

b. Insert a record and enter the serving period name, or select an existing
serving period.

c. On the Taxes tab, select the surcharge tax rate

d. Click Save.

5. Change the Menu Item Class to the surcharge tax class:

a. Select the Enterprise, property, revenue center, or zone, click Configuration,
and then click Menu Item Classes.

b. Double-click the menu item class.

c. On the General tab, select the surcharge tax class from the Tax Class drop-
down list.

d. Click Save.

6. Configure the surcharge for the Menu Item Definition record:

a. Select the Enterprise, property, revenue center, or zone, click Configuration,
and then click Menu Item Maintenance.

b. Double-click the menu item master record corresponding to the definition to
open it.

c. Click the General tab, and then enter the surcharge for the menu item in the
Surcharge field.

d. Click Save.

Related Topics

• Surcharges

Configuring the Menu Item Tax Class Override
1. Select the Enterprise, property, or zone, click Configuration, and then click Menu

Item Groups.
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2. Insert a record and name it for the tax class override.

3. Double-click the record to open it.

4. Select 2 - Tax Override from the Group Type drop-down list in the Group Type
Configuration section.

5. Enter the Threshold Quantity.

• The base tax class setting is applied if the quantity of an ordered menu item is below
the designated threshold value.

• You can use the Menu Item Definition Quantity field to contribute (or add to) to the
Menu Item Group module’s Threshold Quantity value. Once the Threshold Quantity
setting has been reached or exceeded, the previous base tax class setting is
overridden by the tax class assigned to the Menu Item Group record. See 
Configuring Menu Item Definitions for more information.

• For Add-on taxes, the overall price of an item changes when the threshold is met or
exceeded.

• For Inclusive taxes, only the tax rate changes when the threshold is met or
exceeded.

6. From the Tax Class Override drop-down list, select the desired tax class override.

You can use the lookup function for tax class override, which opens the Tax Classes
module.

Tax Rates and Tax Classes contains more information.

7. You must add all menu items to a specific Menu Item Group to which you want to apply a
tax class override. In the Include section, click Add to assign menu items (or range of
items) that you want to be able to apply to this particular tax class override.

8. Select information for the fields described in the following table:

Table 13-9    Include Fields

Field Description

Type Select 4 - By Menu Item.
This the only option that is applicable as an
included item for tax class override. An
error message appears if you select family
group or major group.

Start # Click in this field, and then enter the start
item.

End # Do not enter anything in this field.

See Items and Select Click the link, select the item or item range
in the See Items and Select dialog, and then
click OK.

Range Items selected in See Items and Select
appear in this field.

9. If a menu item or menu item range was entered in error or is no longer needed, select the
row, and then click Delete.

10. Repeat Steps 7 through 9 as needed.

11. Click Save.
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Configuring the Parent Item Tax Class Override
There are some locations where food is taxed differently based upon its
preparation. For example, a whole bagel is not taxed. However, a bagel that is sliced
in two, or warmed up is taxed. In both cases, the bagel's status changes from non-
prepared to prepared - resulting in a tax change.

The configuration described here is only meant for condiment menu items. A
condiment item can be configured to override a parent item’s tax class on all menu
items associated with the condiment. The condiment only applies to the item to which
it is added; the condiment does not change the taxes for the entire check, nor for items
not associated with the parent item.

Preparation instructions, such as sliced and warmed, can be configured as condiment
items in the EMC, and then workstation operators can add them to the parent item on
the POS workstation.

To configure condiment items with a parent item tax class override:

1. Select the Enterprise, property, revenue center, or zone, click Configuration, click
Menu Item Maintenance, and then search for and select a Menu Item Definition
record.

2. Double-click the Menu Item Definition record to open it.

3. Click the Prices sub-tab.

4. Under the Parent Tax Class Override column, select the tax class to apply to the
parent item if this condiment changes how that item is taxed.

Note:

Since this configuration is meant for only condiment menu items, the
Parent Tax Class Override column is grayed out for regular menu item
records, and is not configurable.

When the Parent Tax Class Override column is set to a valid tax class, there are
two available options to drive the behavior of the parent tax class if there is a
conflict with an existing menu item tax class override. To access these options,
remain on the Prices sub-tab.

5. Click the ellipsis (...) under the Options column to configure the following options:

• 3 - Use Menu Item Group Tax Class Override instead of parent Tax Class
Override - Select if this condiment causes the parent item to use the Menu
Item Group Tax Class Override instead of the parent item Tax Class Override.

• 4 - Exclude parent from Tax Override Threshold Quantity - Select if this
condiment causes the parent item to not count toward the Tax Override
Threshold Quantity in Menu Item Groups.

6. Click Save.
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Configuring Options for Australia GST Requirements
The following options must be configured in EMC in accordance with the Australia Goods and
Services Tax requirements:

• 1 - On = Apply Tax as Add-On; Off = Apply Tax as VAT

• 78 - Forgive Inclusive Tax

• 11 - Exempt Inclusive Tax

• 61 - Show Asterisk

1. To configure the Tax Parameter option 1:

a. Select the Enterprise, property, or revenue center, click Setup, and then click Tax
Parameters.

b. Click the International Options tab.

c. Enable option 1 - On = Apply Tax as Add-On; Off = Apply Tax as VAT.

d. Click Save.

2. To configure Menu Item Classes option 78:

a. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

b. Double-click the record to open it.

c. On the General tab, select a previously configured tax class from the Tax Class
drop-down list.

d. Click the Options tab, and then select option 78 - Forgive Inclusive Tax.

e. Click Save.

3. To configure Order Type option 11:

a. Select the Enterprise, property, or revenue center, click Setup, and then click Order
Type Parameters.

b. Locate the Take Away order type record, click the ellipsis point (...) button in the
Options column, select 11 - Exempt Inclusive Tax, and then click OK.

c. Click Save.

4. To configure the Print Outputs and option 61:

a. Select the Enterprise, property, or revenue center, click Setup, and then click Format
Parameters.

b. Click the Configuration tab.

c. In the Print Output section, enter the Print Tax Invoice after Sales Threshold and
the Print Customer Information after Sales Threshold.

d. Enter the customer name and/or business number in the Customer/Trade Identity
Label field.

Per Australia GST requirements, this label must be present on a bill after the
maximum threshold is met. This information is never stored, and the label can be
changed.

e. Click the Options tab.
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f. Select 61 - Show Asterisk ( * ) indicator for Menu Item where Inclusive
Tax was forgiven on screen.

g. Click Save.
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14
Discounts

You can activate a discount using the methods described in the following table:

Table 14-1    Discount Methods

Discount Method Description

Manual A workstation operator manually applies a discount to a
check by pressing a discount key. This is a traditional
discount method.

Automatic Simphony applies an automatic discount when a
transaction meets certain criteria. As a workstation
operator adds menu items to the guest check, Simphony
detects items that trigger a discount, and then applies
the discount to the check.

Coupon A coupon is an automatic discount with one difference:
the workstation operator must first apply the discount
(coupon) to the guest check.
Coupon discounts do not require trigger menu items on
the transaction when entering the coupon. The coupon
discounts the check if trigger menu items are added
before or after the coupon is entered. The coupon is
applied only when the menu items are ordered and it is
not excluded by the presence of a better deal.

Combination Pricing A combination pricing discount charges a single price
for multiple items when they appear on a check at the
same time. Restaurants use this type of discount in
combo meal scenarios such as Burger, Fries, and Soda
are $3.25. Configuring a Combination Pricing Discount
contains instructions to set up combination pricing
discounts.

Manual Discounts
Workstation operators can manually apply a discount to a transaction. You can configure
manual discounts as:

• Subtotal discounts

• Item discounts

Subtotal Discounts

All discounts are subtotal discounts by default. That is, the discount applies to all items on a
check that belongs to a menu item group or itemizer group affected by the discount. Subtotal
discounts are item discounts that apply to multiple items. The amount of a subtotal discount is
allotted to all items to which the discount applies. For example, a $3.00 discount that applies
to two items will discount each item by $1.50. Workstation operators can add a subtotal
discount any time during the transaction, and the subtotal discount is applied to all trigger
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items that are already on the check. New items added after applying the discount are
not discounted.

Item Discounts

An item discount applies to only one item. Item discounts apply to any menu item that
belongs to a Menu Item Class with option 7 - Item Discounts May Be Applied to
these Menu Items set. Discount Itemizers and Menu Item Groups are not applicable
for item discounts. Workstation operators must add an item discount immediately after
adding the menu item to discount.

Automatic Discounts
The workstation automatically applies discounts to a guest check based on conditions
within the transaction and without workstation operator interaction. For example, a
property may run a promotional sale: buy one DVD and receive one CD for free. In this
situation, whenever both a CD and a DVD appear on a single transaction, a 100%
discount applies to the CD. There are several automatic discount types. This scenario
is just one example of an automatic discount configuration.

Automatic discounts and coupon discounts use the following Menu Item Groups to
determine which items receive a discount:

• Trigger Menu Item Group: Trigger menu items are the menu items that trigger a
discount award. A Trigger Menu Item Group contains at least one item that
initiates a discount. For example, in a Buy a DVD, get a CD example, the DVD is
in the Trigger Menu Item Group. When a workstation operator adds the minimum
quantity of items (1) from this menu item group (DVD), items from the Award Menu
Item Group are discounted based on the award configuration for the discount.

• Award Menu Item Group: The Award Menu Item Group is the Menu Item Group to
be used as the award group. An Award Menu Item Group contains at least one
item to receive a discount. For example, in the Buy a DVD, get a CD example, the
CD is in the Award Menu Item Group. When a workstation operator adds the
minimum quantity of items from the Trigger Menu Item Group, items from this
Award Menu Item Group are discounted based on the award configuration for the
discount. As another example, in a Buy-One-Get-One scenario, such as Buy one
DVD and get one CD for 50% off, set the Award Menu Item Group to CDs and the
Percent Off to 50.

A menu item can be in both the trigger and award groups.

Simphony uses several other factors to determine the automatic discount amount:

• Automatic Discount Rules

• Awarding Algorithms

• Discount Award Types

• Discount Exclusivity

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button
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Related Topics

• Configuring Decimal Quantity Menu Items

• Configuring an Item Price Substitution Discount

• Configuring a Quantity Threshold Discount

• Configuring a Total Price Threshold Discount

• Configuring a Combination Pricing Discount

• Configuring a Sales Price Discount

Automatic Discount Rules
Various algorithms (known as Automatic Discount Rules) determine how Simphony calculates
a discount. The following table explains the Automatic Discount Rules:

Table 14-2    Automatic Discount Rules

Automatic Discount Rule Description

Item Price Substitution The discount is applied when the Minimum Quantity
has been satisfied. If the Minimum Quantity is not met,
the normal item price applies. When the Minimum
Quantity is set to 1, the Max Count is equal to the
number of items awarded. When the Minimum
Quantity is set to a value greater than 1, the Max Count
field applies to groups of awarded menu items. When
set, the Max Count field affects which items get the
reward. A value of 0 indicates that the discount applies
to an unlimited number of items.
This discount rule is used in scenarios such as:
• All Beverages are half-price on Tuesday
• If you order three or more hamburgers, they are

20% off
• Candy bars are 10% off
• Candy bars are 50 cents off
• Candy bars are $1 each
The Item Price Substitution discount rule is more
complex than the Sales Price rule.

Quantity Threshold Use a Quantity Threshold discount when the number of
items added triggers a discount, and the awarded items
are different than the trigger items. The discount is
applied when the Minimum Quantity has been
satisfied. When the workstation operator adds the
configured number of items from the Trigger Menu
Item Group, the discount award is applied. For
example, to configure a scenario where every three
shirts purchased awards a free tie, set the Minimum
Quantity value to 3, the Trigger Menu Item Group as
the Shirt group, the Award Menu Item Group as the Tie
group, and the Award Count to 1.
This discount rule can be used for Buy-One-Get-One
scenarios, such as Buy one DVD and get one CD for 50%
off, or Buy two entrees and a dessert is free.
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Table 14-2    (Cont.) Automatic Discount Rules

Automatic Discount Rule Description

Total Price Threshold Use a Total Price Threshold discount when the total
price of items triggers a discount. This discount is
similar in operation to Quantity Threshold, except that
Total Price Threshold looks at the total price of the
trigger items rather than the quantity of items on the
transaction.
This discount rule is used for scenarios such as 15% off
all purchases of $200 or more.

Combination Pricing Use a Combination Pricing discount to include each
combo item to apply the discount. Workstation
operators must add at least two of an item before a
discount can be applied.
This discount rule is used for combination meals, such
as when a hamburger, fries, and soda are applied on
one check, charge $4.00.

Sales Price This discount rule is similar to Item Price Substitution,
but it is easier to configure. Sales Price discounts have
no Minimum Quantity or Max Count associated,
always apply before another discount, and cannot be
replaced by a better deal.
Use this discount rule for All hamburgers are $2.00 on
Wednesdays, without configuring Minimum Quantity
of trigger items or Max Count per check.

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button

Awarding Algorithms
The better deal always wins with automatic discounts. For example, if you set both
Buy One DVD Get One CD For Free and Buy One DVD Get One Car For Free, the
application discounts the price of the car to $0.00 because this is a better deal than
receiving a CD for $0.00.

When using automatic discounts, Simphony detects the presence of discountable
menu items on a transaction, and then performs algorithms to determine which
discounts are applied and which items receive a discount. The following two types of
algorithms determine the discount:
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Table 14-3    Awarding Algorithms

Awarding Algorithm Description

Best Deal for Customer If two discounts can be applied to a check and one yields
a higher discounted amount, that discount is said to give
the best deal. If two discounts can be applied to a check,
and the order in which they are applied yields a
different amount, the ordering which gives the customer
the highest discount is said to give the best deal.
Each automatic discount type provides the best deal for
the customer, which means that the workstation scans
all menu items and determines the largest discount to
apply. In this example, a common best deal scenario is
described as follows:
• A combo discount is configured so any Pants-and-

Shirt purchase is $30.
• If a customer orders a $25 pair of pants and a $20

shirt, the discount is $15:
– $25 for a pair of pants, $20 for a shirt = $45
– The combination price is $30, so the discount

is $15.
• If the customer then orders a $25 shirt, the discount

recalculates:
– $25 for a pair of pants, $25 for a shirt = $50
– The combination price is $30, so the discount

is $20.
In this example, the higher-priced shirt is discounted, so
the customer receives a total discount of $20 instead of
just $15. This is the calculation for all automatic
discounts and you cannot configure it (except for
Quantity Threshold Discounts). By default, the POS client
considers all menu items on the check and all discounts
that can apply, and creates the largest discount possible
for the customer.

Best Deal for Merchant You can configure Quantity Threshold Discounts to
provide the best deal for the merchant, which means
that the customer receives the lowest possible discount.
Some jurisdictions require this configuration.

Chapter 14
Awarding Algorithms

14-5



Figure 14-1    Examples of Best Deals for Merchant and Customer

Consider this discount: Buy one entree and get a second (of equal or lesser value) for
50% off. The examples show the different calculations of the discount based on the
best deal configuration.

• In Example 1, the Filet is the most expensive item, so it is the trigger. The Chicken
Dinner is more expensive than the Spaghetti, so it is discounted by 50%. The total
discount is $7.50.

• In Example 2, the Filet is the most expensive item, so it is the trigger. The
Spaghetti is the least expensive entree, so it is discounted by 50%. The total
discount is $5.00.

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button

Discount Award Types
An award type identifies the discount that customers receive. The following table
describes the three discount award types in Simphony.
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Table 14-4    Award Types

Award Type Description

Percent Off This award type is used when all menu items in the
Trigger Menu Item Group (Item Price Substitution
discounts) or in the Award Menu Item Group (Threshold
discounts) are to receive a percent discount. You can use
the Percent Off award type for discounts such as All
sodas are 50% off on Tuesdays or Get 15% off all shirts
for purchases of $80 or more.
Simphony calculates this type of award as a percent of
the sales total. For example, if the item is $10.00 and the
discount is 20%, the discount amount is $2.00. The
amount owed is reduced to $8.00.

Amount Off This award type is used when all items in the Trigger
Menu Item Group (Item Price Substitution discounts) or
in the Award Menu Item Group (Threshold discounts)
are to receive a flat amount discount. You can use the
Amount Off award type for discounts such as All sodas
are $1.00 off on Tuesdays or Save $25 on shirts for
purchases of $150 or more on pants.
Simphony calculates this type of award as a fraction of
the sales total. The discount awarded cannot be greater
than the Amount Off value. The Amount Off is
subtracted from the item’s price. For example, if the
item is $10.00 and the Amount Off is $3.00, the discount
amount is $3.00. The amount owed is $7.00. Items are
not discounted below 0.00; if an item’s price is $5.00 and
the Amount Off is set to $9.00, the amount owed is $0.00.
Amount Off Examples contains more complex examples
of the Amount Off award type.

Amount Substitution This award type is used when all items in the Trigger
Menu Item Group (Item Price Substitution discounts) or
in the Award Menu Item Group (Threshold discounts)
are to be charged a fixed amount. You can use the
Amount Substitution award for discounts such as All
sodas are $2.00 on Tuesdays or Buy $80 of shirts and
receive up to 3 pairs of pants for $15.00 each.
The amount is substituted for the original price of the
item. For example, if the item is $10.00 and the amount
substitution is $5.99, the discounted item’s price is $5.99.
Calculations do not change with whole numbers. For
decimal values, Simphony calculates what percent of the
parent item the original substitution price was, and
applies that percent discount to the new decimal
quantity.
Amount Substitution contains more complex examples of
the Amount Substitution award type.

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button
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Discount Exclusivity
Exclusivity stops all discounts from applying to a check at once. Discount exclusivity
controls how multiple discounts interact with each other. You can configure discounts
to be exclusive to the following:

• Per transaction

• Per menu item

• Based on workstation operator-defined groups

In short, discount exclusivity stops discounts from applying multiple times to the same
items.

Discount exclusivity applies in these situations:

• A senior citizen discount coupon cannot be used at the same time as a 25% off all
items discount.

• A Buy One Get One Free discount cannot be applied to a transaction that also has
a Buy $100, Get 25% Off Discount.

• The customer's 10% coupon cannot be applied to items that receive the Happy
Hour discount.

You can configure two types of discount exclusivity: simple exclusivity and group
exclusivity. Simple exclusivity is easier to use and configure. Group exclusivity yields
greater flexibility, but at the price of complexity. Simple Exclusivity and Group
Exclusivity contain more information about these types of discount exclusivity.

Automatic discounts always recalculate after the workstation operator adds or
removes an item from a guest check. Because of this, automatic discounts are always
applied after manual discounts. Consider the following example:

• The revenue center is configured with automatic discounts enabled in the RVC
Parameters module.

• One automatic discount is active: all food is 10% off.

• A manual discount is configured, and it allows the 10% off all food discount to be
on the check at the same time as the manual discount.

• The operator orders $20 of food.

• The automatic discount applies on the check for $2.

If the workstation operator then adds a manual discount for $5.00 off, the discount
changes:

• All automatic discounts are removed (this occurs internally on the workstation but
is listed here to explain the logic)

• The check's total is $15.00 ($20.00 minus the $5.00 manual discount)

• The 10% automatic discount is applied for $1.50, taking the check's total to $13.50

Because of the scenario described here, it is not possible to get a better deal when
combining automatic and manual discounts. Either the discounts can both be on the
check (as in this example) or the manual discount is not allowed (if the automatic
discount is exclusive to the manual discount). Thus, to use manual discounts and
automatic discounts in the same environment, configure the discounts that would
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normally be manual as automatic coupon discounts, which follow the best deal rules of the
Discount Engine. See Understanding Awarding Algorithms for more information.

Configuring Discounts contains more information about setting the Simple Item Exclusivity
and Simple Transaction Exclusivity options.

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button

Simple Exclusivity
The following three discount options apply to simple exclusivity in the Discounts module:

Table 14-5    Simple Exclusivity Options

Option Description

9 - Simple Item Exclusivity When you select this option, only this discount can be applied
to a menu item. This prevents individual items from being
discounted more than once. Deselecting this option causes the
Exclusivity Group settings to determine how this discount
interacts with other discounts. If other discounts that are
better deals can apply to the item or transaction, the better
deal discounts apply.

23 - Simple Transaction
Exclusivity

When you select this option, only this discount can be applied
to a single check. This prevents the check from being
discounted more than once. Deselecting this option causes the
Exclusivity Group settings to determine how this discount
interacts with other discounts. If other discounts that are
better deals can apply to the item or transaction, the better
deal discounts apply.

24 - Discount is Final When you select this option, no additional discounts can be
applied to the transaction after this discount posts. (This
option works in automatic discount transactions only.)

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button

Group Exclusivity
Group exclusivity lets you configure the manner in which discounts interact. When two
discounts are exclusive to each other, it means that only one discount applies. This
exclusiveness can apply either per transaction or per menu item:

• If two discounts are transaction exclusive to each other, only one can be applied to the
same transaction. The discount that provides the best deal is applied to the check.

• If two discounts are item exclusive to each other, only one can be applied to a specific
menu item. Two discounts that are item exclusive can both be present on a transaction,
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but only applied to different menu items. Again, the discount that provides the best
deal is applied to the item.

Table 14-6    Transaction Exclusivity

Discount In Exclusivity Group 1 In Exclusivity Group 2

A Yes Yes

B Yes No

C No Yes

D No No

Given the configuration shown in the Transaction Exclusivity table, the following
occurs:

• Discounts A and B cannot appear on the same transaction because they both
belong to the first group.

• Discounts A and C cannot appear on the same transaction because they both
belong to the second group.

• Discounts B and C can appear on the same transaction because they do not
belong to the same groups.

• Discount D can appear on any transaction with A, B, and C because it does not
belong to any group.

The Transaction Exclusivity example shows a configuration with only two groups. The
combinations become more complex (yet more flexible) when using all 32 groups in
the property.

Table 14-7    Item Exclusivity

Discount In Exclusivity Group 1 Menu Items Affected by
Discount

A Yes x, y

B Yes x

C No y

Given the configuration shown in the Item Exclusivity table, the following occurs:

• Menu Item x is discounted by A or B, but not both. Discounts A and B are
exclusive to each other.

• Menu Item y is discounted by A and C. These discounts are not exclusive to each
other, so they may both discount the same items.

Related Topics

• Configuring Discount Privileges

• Configuring Discounts

• Creating the Discount Button
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Menu Item Groups
Each record in a menu item group specifies the menu items it represents. Within the Menu
Item Group module, you can assign menu items based on major groups, family groups, or by
menu item object number or range. Each menu item group can have a combination of major
groups, family groups, and so on. You can configure menu item groups to include and
exclude major groups, family groups, and so on.

Examples of menu item groups are:

• All menu items in major group Liquor

• All menu items in major group Liquor, but not Bottles of Wine in family group 6

• All menu items in family groups Cold Appetizers, Warm Appetizers, and Soups

• All menu items with object numbers in the range 4000-4999, 14000-14999, and major
group Non-liquor

• All menu items with object numbers in the range 5000-10000, except those in 6500-6600

Related Topics

• Configuring Menu Item Groups

Related Topics

• Configuring Major Groups

Related Topics

• Configuring Family Groups

Configuring Menu Item Groups
1. Select the Enterprise, property, or zone, click Configuration, and then click Menu Item

Groups.

2. Insert a menu item group record, and then double-click it to open.

3. Click Add near one of the following areas:

• Include: You can add the menu item groups to include in the discount here

• Exclude: You can add the menu item groups to exclude from the discount here

4. Select information for the fields described in the following table:

Table 14-8    Include and Exclude Fields

Field Description

Type Select the grouping to include or exclude:
• 0 - None
• 1 - All
• 2 - By Major Group
• 3 - By Family Group
• 4 - By Menu Item

Start # Click in this field, and then select the start item.

End # Do not enter anything in this field.
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Table 14-8    (Cont.) Include and Exclude Fields

Field Description

See Items and Select Click the link and then select the menu items to be the
trigger. This item appears in the End # field.

Range The items you selected in the See Items and Select dialog
appear in this field.

Override Price Amount/
Percentage (Include only)

If you want a discount to apply to menu items differently,
use this field. For example, you can set discounts for Sweet
Potato Fries to 15% and Pub Fries to 20%.
To use this field with automatic discounts, you must select
the Use Price in MI Group Detail option from the
Discounts module Auto subtab. You can set amount off,
percent off, or amount substitution, based on the discount
configuration. For example, enter 10.00 to indicate 10% off
(not 0.10). The Use Price in MI Group Detail option does
not function with combination pricing discounts.

5. Click Save.

Related Topics

• Menu Item Groups

• Categorizing Menu Items into Groups

Configuring Discount Privileges
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Voids/Returns
subtab.

3. Select the following options to allow employees to void discounts in a previous
round and on closed checks:

• 27 - Authorize/Perform Void of Discounts from a Previous Round

• 70 - Authorize/Perform Void of Discounts on Closed Checks

4. Click the Transactions subtab.

5. Select the options that apply to discounts:

• 20 - Post Discounts to Checks Belonging to Another Operator

• 52 - Authorize/Perform Posting of Discounts in Priv Group 1

• 53 - Authorize/Perform Posting of Discounts in Priv Group 2

• 54 - Authorize/Perform Posting of Discounts in Priv Group 3

• 98 - Authorize/Perform Employee Meal Discount Override for Non-
Scheduled Employees

• 282 - Authorize/Perform Minimum Amount Threshold Override

6. Click Save.

Related Topics

• Automatic Discounts
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• Automatic Discount Rules

• Awarding Algorithms

• Discount Award Types

• Discount Exclusivity

• Simple Exclusivity

• Group Exclusivity

Configuring Discounts
1. Select the Enterprise, property, or zone, click Configuration, and then click Discounts.

2. Insert a record for a discount or double-click a record to select it.

3. On the General tab, select the type of discount from the Activation Type drop-down list:

• 0 - Manual (Manually entered and applied)

• 1 - Automatic (Automatically applied, operator cannot enter)

• 2 - Coupon (Automatically applied, operator must enter)

4. (Optional) Enter the minimum menu item subtotal required on a check to apply the
discount in the Min Amount field.

5. To configure a manual discount, enter the following information. Otherwise, skip this step.

a. To use a percent discount, enter the percentage in the Percent field.

b. If configuring an open-priced discount, enter the maximum amount allowed for the
discount in the Max Amount field.

c. If configuring a preset amount discount, enter the amount of the discount in the
Amount field.

This field works with options 7 - Limit Discount to Value in Amount Field and 8 - If
No Amount is Entered, Use the Full Discountable Amount.

d. From the Trigger MI Group drop-down list, select the menu item group that triggers
the discount.

This is an alternative and preferred method to using discount itemizers. The discount
applies to only those qualifying menu items based on the selected Trigger MI Group,
Trigger Condiment Group, and other discount configurations.

6. To make the discount available to the workstation operator, select Enabled.

You can turn off temporary discounts by deselecting Enabled.

7. Select the Tax Class to use for the discount.

8. Select a Privilege Group to restrict the discount to only employees who are linked to the
same privilege group. Set the Privilege Group to 0 to allow all employees to use the
discount.

9. Select the method to determine how condiment menu items are discounted from the
Condiment Discountability drop-down list.

If you select 0 - Use MI Class Option, the discounts only apply to parent items unless
you enable the Menu Item Class option 55 - Discounts Apply to Priced Condiments.

10. Select the Report Group to associate with the discount.
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Report groups are subcategories that allow reports to show similar discounts
grouped together. You can set report groups from the Report Groups module, in
the Reporting section of the Property tab.

11. Select the Print Class to associate with the discount.

Print Class Output contains more information.

12. Select the appropriate options for the discount. The following table describes the
options and indicates the Activation Types (Manual, Automatic, Coupon) that are
available for each option.

Table 14-9    Discount Options

Option Description Manual Automatic Coupon

1 - ON = Open;
OFF = Preset

Select this option to make the
discount open. The workstation
prompts the workstation operator
to enter the amount or
percentage.
Deselect this option to use a
preset amount or preset
percentage for the discount.

Yes No Yes

2 - ON =
Amount; OFF =
Percentage

Select this option to make the
discount an amount. Deselect this
option to make the discount a
percentage.

Yes No No

3 - This is an
Item Discount

Select this option to calculate the
discount based on the price of the
last menu item entered. Deselect
this option to calculate the
discount based on the
discountable transaction subtotal.
For automatic discounts, this
option controls the discount
sorting and consolidation on a
check. When set, each item in the
Menu Item Award Group shows
the discounted amount on
customer receipts and on the POS
client. When deselected, all items
in the Menu Item Award Group
show a combined discounted
amount as one entry.

Yes Yes Yes

4 - Employee
Meal

Select this option to set the
discount as an Employee
Discount. The POS client prompts
the workstation operator to enter
the employee number or ID of the
employee receiving the discount.

Yes No Yes

5 - Reference
Entry Required

Select this option to require the
workstation operator to enter a
name or number when using the
discount.

Yes No Yes

6 - Validation
Required

Select this option to print a
validation chit when the discount
is applied.

Yes No Yes
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Table 14-9    (Cont.) Discount Options

Option Description Manual Automatic Coupon

7 - Limit
Discount to
Value in
Amount Field

Select this option to limit the
amount of a discount. Enter an
amount in the Max Amount field,
which represents the highest
discount possible when setting
this option.

Yes No Yes

8 - If No
Amount is
Entered, Use
the Full
Discountable
Amount

Select this option to control the
open amount discount calculation
if the workstation operator does
not enter an amount before
pressing the Discount button. In
short, this option allows you to set
a discount as:
• A 100% discount (if the

workstation operator does
not enter an amount before
selecting the Discount button)

• An open amount discount (if
the workstation operator
enters an amount before
selecting the Discount button)

You must select option 2 - ON =
Amount; OFF = Percentage to
activate this option.

Yes No No

9 - Simple Item
Exclusivity

Select this option to apply the
discount to only one menu item.
This setting imposes a limit of one
discount per item and prevents
individual items from receiving a
discount more than once.
Deselect this option to have the
Exclusivity tab settings determine
how the discount interacts with
other discounts.

Yes Yes Yes

10 - Tender
Required (Only
for Subtotal
Discounts)

Select this option to require
workstation operators to tender
the transaction after applying a
subtotal discount. You must also
deselect option 3 - This is an Item
Discount.

Yes No No

11 - Affects
Auto Service
Charge (Only
Subtotal
Discounts)

Select this option to apply the
discount to Menu Item Itemizers
that allow Auto Service Charges.
This results in an adjusted Auto
Service Charge value based on the
Itemizers discounted. Deselect to
keep the Auto Service Charge
unchanged.

Yes No No

14 - Do Not
Allow Subtotal
Discount While
Seat Filter is
Active

Select this option to disallow
subtotal discounts while seat
filtering is active. Deselect for
item discounts or when not using
seat handling.

Yes No No
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Table 14-9    (Cont.) Discount Options

Option Description Manual Automatic Coupon

23 - Simple
Transaction
Exclusivity

Select this option to have the
discount apply to a single
transaction. This setting prevents
the transaction from receiving a
discount more than once.

Yes Yes Yes

24 - Discount is
Final

Select this option to prevent
workstation operators from
applying additional discounts to
the transaction after the discount
is posted.

No Yes No

25 - Discount
Combo Meal
Group Items

Select this option to discount
combo group menu items when
the Allow Discounts option is set
for the combo group.

Yes Yes No

28 - Apply to
Returned or
Direct-Voided
Menu Items

Select this option to allow the
discount to be applied to returned
and voided items.

No Yes Yes

29 - Menu item
to use check
open time

Select this option to have a menu
item use the check’s open time
(instead of using the current time)
to determine effectivity of the
discount.

Yes Yes Yes

30 - Selected
menu item to
include parent
menu item in
discount

Select this option to include a
parent menu item in the discount
when the workstation operator
selects a child menu item for the
discount.

Yes Yes Yes

31 - Net
Automatic
Service Charge
Itemizer

Select this option to post the net
value of the menu item to the
Automatic Service Charge
Itemizer, reducing the Automatic
Service Charge after the discount
is applied.
This option is available when you
set option 3 - This is an Item
Discount (above) and option 12 -
Add to Automatic Service
Charge Itemizer from the Menu
Item Classes module.

No Yes Yes

32 - Limit
Discount value
to value of
Discountable
Item

Select this option to limit the
discountable amount to the item
or award when the Amount Off
exceeds the item or award. For
example, if the Amount Off
is $5.00 and the item or award
is $4.00, the discount is limited
to $4.00.

Yes Yes No

33 - Cash
Management
Transaction
Item

Select this option to include the
discount in Enterprise Cash
Management (ECM) tracking and
reports.

Yes No Yes
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13. Click the RVC Type tab.

14. Select the revenue centers that can have the discount available.

15. Click the Menu Levels tab.

16. In the Menu Level Configuration section, select the Active On Main Levels and Active
On Sub Levels on which the discount is active.

17. In the Main Level Popup and Sub Level Popup sections, select Transaction Default to
return the transaction to the default Main Level or Sub Level after the discount is pressed,
select 0 - Stay Down to keep the current transaction levels, or select one of the levels
1-8 to become active. Deselect Transaction Default to make the other levels active for
selection.

18. (Optional) If you are using NLUs or SLUs, click the NLU/SLU tab.

19. (Optional) Enter the unique NLU number for the discount (0 to 255).

20. (Optional) Select a screen lookup key for the discount from the SLU drop-down list.

The SLU is configured by selecting the Enterprise or property, clicking Descriptors, and
then clicking Discounts.

21. (Optional) From the MMH SLU drop-down list, select a Mobile MICROS screen lookup
key for the discount.

22. (Optional) From the Icon drop-down list, select an icon to assign to the discount key.

23. Click the Effectivity tab.

24. Select the dates, days, and times for the discount to be in effect.

25. To configure manual discount printing output, click the Output tab, and then select the
order devices that will show the discount. Otherwise, skip this step.

Automatic Discounts and Coupons are excluded from Order Device output.

26. Click the Effectivity Groups tab.

Effectivity groups allow you to configure and package promotions so that the menu items
and their discounts are only available for a fixed period of time. If effectivity groups do not
exist, you must create one or more in the Effectivity Groups module. Configuring
Effectivity Groups contains more information.

27. Click the Add Effectivity Record link.

28. Click the Select link adjacent to Effectivity Group, select the effectivity group, and then
click OK twice. The new effectivity record shows the discount name, Effectivity Status (for
example, Active or Future), Date Start, and Date End.

29. Click Save.

30. To set an automatic discount to apply to a revenue center:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Click the Options tab.

c. Select 48 - Enable Automatic Discounts by Default. If you do not select this option,
workstation operators must activate automatic discounts per transaction using one of
the following function keys:

• 655 - Auto Discount Toggle: Switch the automatic discounts for the transaction

• 656 - Auto Discount Apply: Apply all discounts possible

• 657 - Auto Discount Remove: Remove all discounts from the transaction
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Examples of the types of discounts that are available with this option include:

• All appetizers are 25% off

• All domestic beers are $3.00 during Happy Hour

• Buy an appetizer, get another one for 50% off

• Buy an entrée, get $2.00 off a dessert

d. Click Save.

31. To configure an Item Price Substitution Discount, see Configuring an Item Price
Substitution Discount.

32. To configure a Quantity Threshold Discount, see Configuring a Quantity Threshold
Discount.

33. To configure a Total Price Threshold Discount, see Configuring a Total Price
Threshold Discount.

34. To configure a Combination Pricing Discount, see Configuring a Combination
Pricing Discount.

35. To configure a Sales Price Discount, see Configuring a Sales Price Discount.

Related Topics

• Automatic Discounts

• Automatic Discount Rules

• Awarding Algorithms

• Discount Award Types

• Discount Exclusivity

• Simple Exclusivity

• Group Exclusivity

Configuring Effectivity Groups
You can assign discounts, menu item prices, and reservation periods to an effectivity
group. Effectivity groups let you configure and package promotions and reservation
times. For example, you can make menu items or discounts available for a fixed period
of time.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Effectivity Groups.

2. Insert a record for the effectivity group, enter a descriptive name, and then click
OK.

3. Double-click the record to open it.

4. Click the Add link, and then select the Start Time and the End Time from the
calendar.

5. Click Save.

6. After creating the Effectivity Group, you need to associate the Effectivity Group
with one of the following types of records to make it active:

• Tender/Media
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• Menu Item Price

• Discount

• Combo Group Detail Price

• Service Charge

• Tax

• Page Content Area

You can make the association in the record type. For example, to associate a Tender/
Media record with the Effectivity Group, click the Tender/Media module, and then click
the Effectivity tab.

Note:

Valid Property effectivity date settings take precedence over enterprise
effectivity date settings. If no valid effectivity dates are configured for a property,
then valid enterprise effectivity dates are then used by the system.

Automatic Discounts with Decimal Quantity Menu Items
Simphony ignores decimal quantity menu items with automatic discounts and applies the
discount for the closest whole number. For example:

• 1 Cherry Pie = $20.00

• 1.5 Cherry Pies = $30.00

• If you add a menu item to the check with a quantity less than 1, Simphony does not apply
the automatic discount.

• If you add a menu item to the check with a discount and then split the check, the discount
no longer applies to either check.

The following automatic discount rules ignore decimal quantities when ordering:

• Quantity Threshold

• Combination Pricing

The discount engine ignores menu items added with a quantity less than 1 (for example .5
cup of yogurt). Understanding Automatic Discount Rules contains more information about
Quantity Threshold and Combination Pricing.

Amount Off Examples contains examples of the Amount Off award type.

Amount Substitution contains examples of the Amount Substitution award type.

Related Topics

• Configuring Decimal Quantity Menu Items

• Configuring an Item Price Substitution Discount

• Configuring a Quantity Threshold Discount

• Configuring a Total Price Threshold Discount

• Configuring a Combination Pricing Discount
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• Configuring a Sales Price Discount

Amount Off Examples
This section provides examples of the Amount Off discount award type.

Example 1: Whole Number Quantity Item

• 1 Salad: $10.00

• Amount Off: $2.00

• Award Percent = Amount Off ($2.00) / Item Base Price ($10.00) = .20

• Discount = Discountable Total ($10.00) x Award Percent (.20) = $2.00

Because the Discountable Total is greater than or equal to the base price, the
customer receives the Amount Off.

Example 2: Decimal Number Quantity Item

• .5 Salad: $5.00

• Amount Off: $2.00

• Award Percent = Amount Off ($2.00) / Item Base Price ($10.00) = .20

• Discount = Discountable Total ($5.00) x Award Percent (.20) = $1.00

When the Discountable Total is less than the base price, the customer receives the
discount based on the Award Percent calculation.

Example 3: Decimal Number Quantity Item with Condiment

• .5 Salad: $5.00

• 1 Chicken: $5.00

• Discountable Total = $10.00

• Discount = Discountable Total ($10.00) x Award Percent (.20) = $2.00

Because the Discountable Total is greater than or equal to the base price, the
customer receives the Amount Off.

Related Topics

• Configuring Decimal Quantity Menu Items

• Configuring an Item Price Substitution Discount

• Configuring a Quantity Threshold Discount

• Configuring a Total Price Threshold Discount

• Configuring a Combination Pricing Discount

• Configuring a Sales Price Discount

Amount Substitution Examples
This section provides examples of the Amount Substitution discount award type.
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Example 4: Whole Number Quantity Item

• 1 Salad: $10.00

• Amount Substitution: $9.00 (discounted $1.00)

• Award Percent = Amount Substitution ($9.00) / Item Base Price ($10.00) = .90

• Discount = ($10.00) - Amount Substitution ($9.00) = $1.00

When dealing with whole number quantity menu items, the customer always pays the
Amount Substitution. If the customer orders items totaling $100, they pay only $9.00.

Example 5: Decimal Number Quantity Item

• .5 Salad: $5.00

• Amount Substitution: $9.00 (discounted $1.00 from parent item base price)

• Award Percent = Amount Substitution ($9.00) / Item Base Price ($10.00) = .90

• Discount = (Current Sales Total – (Current Sales x Award Percent) = $5.00 – ($5.00
x .90) = $5.00 – $4.50 = $.50

Example 6: Decimal Number Quantity Item, More Condiments Than Parent Items

• The Award Percent for Amount Substitution is based on the parent item base price, not
the total price of each item plus condiments.

• The Discount Calculation only applies when the menu item plus condiments are less than
the base price amount of the parent item.

Order
Number

Items Price Award
Percent

Discount
Calculation

Discount
Amount

Customer
Pays

1 1 Salad $10.00 ($9.00) /
($10.00)
= .90

($25.00
– $9.00)

$16.00 $9.00

1 Chicken $5.00

1 Steak $5.00

1 Steak
(This extra
condiment
is added to
the first
menu item.)

$5.00

2 1 Salad $10.00 ($9.00) /
($10.00)
= .90

($25.00
– $9.00)

$11.00 $9.00

1 Chicken $5.00

1 Steak $5.00

3 1 Salad $10.00 ($9.00) /
($10.00)
= .90

($17.50
– $9.00)

$8.50 $9.00

1 Chicken $2.50

1 Steak $5.00

4 .5 Salad $5.00 ($9.00) /
($10.00)
= .90

($10.00
– $9.00)

$1.00 $9.00

1 Steak $5.00

Related Topics

• Configuring Decimal Quantity Menu Items
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• Configuring an Item Price Substitution Discount

• Configuring a Quantity Threshold Discount

• Configuring a Total Price Threshold Discount

• Configuring a Combination Pricing Discount

• Configuring a Sales Price Discount

Configuring Decimal Quantity Menu Items
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Menu Item Classes.

2. Double-click the menu item class record to open it.

3. (Optional) On the General tab, select 2 - Decimal/fraction allowed, round sales
count up from the Count Entry drop-down list.

4. Click Save.

Related Topics

• Automatic Discounts

• Automatic Discounts with Decimal Quantity Menu Items

• Amount Off Examples

• Amount Substitution Examples

Configuring an Item Price Substitution Discount
1. Select the Enterprise, property, or zone, click Configuration, and then click

Discounts.

2. Double-click an automatic discount record to open it.

3. On the Auto tab, select 1 - Item Price Substitution from the Automatic
(Automatically applied, operator cannot enter) drop-down list.

4. (Optional) Enter a Priority for the discount.

Priority determines the order in which discounts are calculated. By default, this
field is blank (0) for all discounts, meaning that discounts are calculated at the
same time. If you enter a priority, the workstation calculates all discounts in priority
1, then in priority 2, and so on. Priority zero (0) discounts are calculated last. The
priority field allows Simphony to calculate discounts more efficiently.

5. In the Trigger section, configure a trigger to invoke the discount:

• Trigger MI Group: Select the menu item groups that will trigger the discount
award.

• Trigger Condiment Group: Select the condiment menu item groups to use as
the trigger for the discount, if any. For example, If customers can get a bagel
for $0.50 when they add cream cheese to any bagel, cream cheese is the
trigger condiment and bagel is the trigger menu item for the $0.50 discount.

• Minimum Quantity: Enter the number of items that customers must order
from the corresponding trigger menu group before applying the discount
award.
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6. In the Awards section, configure the discount amount:

• Percentage Off: If this is a percent discount, enter the percentage to discount from
each item in the Trigger MI Group.

• Amount Off: If this is an amount discount, enter the amount to discount from each
item in the Trigger MI Group.

• Amount Substitution: If this is an amount substitution discount, enter the price to
charge for each item in the Trigger MI Group.

• Max Count: Enter the maximum number of discounts that can be applied to a single
check when option 23 - Simple Transaction Exclusivity is enabled for this discount.
If set to zero (0), the maximum count is unlimited.

For example, if the discount is $5.00 off every appetizer with a limit of 3 appetizers
per check, set this field to 3. Then, if seven appetizers are ordered, the three most
expensive appetizers are discounted while the other four appetizers are charged the
regular price.

7. If you configured a Percent Off discount, click the General tab, and then enter the
maximum amount allowed for the discount in the Max Amount field.

8. Click Save.

Related Topics

• Automatic Discounts

• Automatic Discounts with Decimal Quantity Menu Items

• Amount Off Examples

• Amount Substitution Examples

Configuring a Quantity Threshold Discount
1. Select the Enterprise, property, or zone, click Configuration, and then click Discounts.

2. Double-click an automatic discount record to open it.

3. Click the Auto tab, and then select 2 - Quantity Threshold from the Automatic
(Automatically applied, operator cannot enter) drop-down list.

4. Select the appropriate Awarding Algorithm:

• 1 - Best Deal for Customer: Select to apply the best possible deal (highest discount
amount) to the check. Oracle recommends using this setting unless specific business
needs are required at the property.

• 2 - Best Deal for Merchant: Select to apply the smallest discount amount to the
check. This option is intended for properties with specific needs and configurations.

5. (Optional) Enter a Priority for the discount.

Priority determines the order in which discounts are calculated. By default, this field is
blank (0) for all discounts, meaning that discounts are calculated at the same time. If you
enter a priority, the workstation calculates all discounts in priority 1, then in priority 2, and
so on. Priority zero (0) discounts are calculated last. The priority field allows Simphony to
calculate discounts more efficiently.

6. Enter the maximum number of times the coupon discount can be entered on a check in
the Max Count Per Check field.
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7. To use promotion prices that appear in the Menu Item Groups module for the
discounted menu item, select Use Price in MI Group Detail.

8. In the Trigger section, configure up to eight unique triggers to invoke the discount.
You must configure the triggers in sequential order.

• Trigger MI Group: Select the menu item groups that will trigger the discount
award.

• Trigger Condiment Group: Select the condiment menu item groups to use as
the trigger for the discount, if any. For example, If customers can get a bagel
for $0.50 when they add cream cheese to any bagel, cream cheese is the
trigger condiment and bagel is the trigger menu item for the $0.50 discount.

• Quantity: Enter the number of items that customers must order from the
corresponding trigger menu group before applying the discount award.

• Minimum Quantity: Enter the number of items that customers must order
from the corresponding trigger menu group before applying the discount
award.

9. In the Awards section, configure up to eight rewards for the discount:

• Award MI Group: Select the menu item groups to use as the award group
when the minimum quantity of items from the Trigger MI Group is ordered.

• Award Type: Select the discount type.

• Percentage Off: If this is a percent discount, enter the percentage to discount
from each item in the Award MI Group.

• Amount Off: If this is an amount discount, enter the amount to discount from
each item in the Award MI Group.

• Amount Substitution: If this is an amount substitution discount, enter the
price to charge for each item in the Award MI Group.

• Award Count: Enter the number of award items that are allowed once the
Trigger MI Group's Minimum quantity is reached. For example, if this is a Buy
Three Coffees and Get Two Donuts at 50% off discount, set this field to 2.

• Max Count: Enter the maximum number of award items that can be
discounted on a single check. If set to zero (0), the maximum count is
unlimited.

• Allow award of higher priced item: Select to allow a discount to be applied
when the trigger item price is lower than the award item price.

10. If you configured a Percent Off discount, click the General tab, and then enter the
maximum amount allowed for the discount in the Max Amount field.

11. Click Save.

Related Topics

• Automatic Discounts

• Automatic Discounts with Decimal Quantity Menu Items

• Amount Off Examples

• Amount Substitution Examples
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Configuring a Total Price Threshold Discount
1. Select the Enterprise, property, or zone, click Configuration, and then click Discounts.

2. Double-click an automatic discount record to open it.

3. Click the Auto tab, and then select 3 - Total Price Threshold from the Automatic
(Automatically applied, operator cannot enter) drop-down list.

4. (Optional) Enter a Priority for the discount.

Priority determines the order in which discounts are calculated. By default, this field is
blank (0) for all discounts, meaning that discounts are calculated at the same time. If you
enter a priority, the workstation calculates all discounts in priority 1, then in priority 2, and
so on. Priority zero (0) discounts are calculated last. The priority field allows Simphony to
calculate discounts more efficiently.

5. To use promotion prices that appear in the Menu Item Groups module for the discounted
menu item, select Use Price in MI Group Detail.

6. In the Trigger section, configure up to eight unique triggers to invoke the discount. You
must configure the triggers in sequential order.

• Trigger MI Group: Select the menu item groups that will trigger the discount award.
When the total amount of all items on a check exceeds the amount configured for the
trigger group, the discount will be applied to all items in the Award Menu Item Group.

• Trigger Condiment Group: Select the condiment menu item groups to use as the
trigger for the discount, if any. For example, If customers can get a bagel for $0.50
when they add cream cheese to any bagel, cream cheese is the trigger condiment
and bagel is the trigger menu item for the $0.50 discount.

• Total: Enter the total amount of corresponding trigger menu item group items
customers must order before applying the discount (that is, to activate the Award
Menu Item Group). For example, if you are giving 15% off all shirts for a purchase
of $80 or more, enter 80.00 in this field.

7. In the Awards section, configure up to eight rewards for the discount:

• Award MI Group: Select the menu item groups to use as the award group when the
total amount of all items on a check exceeds the Total configured for the Trigger MI
Group.

• Award Type: Select the discount type.

• Percentage Off: If this is a percent discount, enter the percentage to discount from
each item in the Award MI Group.

• Amount Off: If this is an amount discount, enter the amount to discount from each
item in the Award MI Group.

• Amount Substitution: If this is an amount substitution discount, enter the price to
charge for each item in the Award MI Group.

• Max Count: Enter the maximum number of award items that can be discounted on a
single check. If set to zero (0), the maximum count is unlimited.

8. If you configured a Percent Off discount, click the General tab, and then enter the
maximum amount allowed for the discount in the Max Amount field.

9. Click Save.
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Related Topics

• Automatic Discounts

• Automatic Discounts with Decimal Quantity Menu Items

• Amount Off Examples

• Amount Substitution Examples

Configuring a Combination Pricing Discount
1. Select the Enterprise, property, or zone, click Configuration, and then click

Discounts.

2. Double-click an automatic discount record to open it.

3. On the Auto tab, select 4 - Combination Pricing from the Automatic
(Automatically applied, operator cannot enter) drop-down list.

4. (Optional) Enter a Priority for the discount.

Priority determines the order in which discounts are calculated. By default, this
field is blank (0) for all discounts, meaning that discounts are calculated at the
same time. If you enter a priority, the workstation calculates all discounts in priority
1, then in priority 2, and so on. Priority zero (0) discounts are calculated last. The
priority field allows Simphony to calculate discounts more efficiently.

5. If you are configuring an automatic coupon discount with combination pricing,
enter the maximum number of times the coupon discount can be entered on a
check in the Max Count Per Check field. Enter a value of 0 to allow the discount
to be added an unlimited amount of times to the same check.

This field is active only for automatic discounts with the Activation Type of 2 -
Coupon (Automatically applied, operator must enter).

6. In the Trigger section, select up to eight unique Trigger MI Groups that invoke the
discount. You must configure the triggers in sequential order.

7. Enter the price to charge for this combo meal in the Amount Substitution field.

8. Enter the maximum number of combo meals that customers can order per check
in the Max Count field.

In general, the Max Count field is set to 0 to allow an unlimited amount of combo
meals on a single check

9. Click Save.

Related Topics

• Automatic Discounts

• Automatic Discounts with Decimal Quantity Menu Items

• Amount Off Examples

• Amount Substitution Examples

Configuring a Sales Price Discount
1. Select the Enterprise, property, or zone, click Configuration, and then click

Discounts.
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2. Double-click an automatic discount record to open it.

3. On the Auto tab, select 5- Sales Price from the Automatic (Automatically applied,
operator cannot enter) drop-down list.

4. Select the menu item groups that will trigger the discount from the Trigger MI Group
drop-down list, and then select the condiment menu item groups to use as the trigger for
the discount, if any from the Trigger Condiment Group drop-down list.

For example, if customers can get a bagel for $0.50 when they add cream cheese to any
bagel, cream cheese is the trigger condiment and bagel is the trigger menu item for
the $0.50 discount.

5. Select discount type, and then enter the discount amount:

• Percentage Off: If this is a percent discount, enter the percentage to discount from
each item in the menu group.

• Amount Off: If this is an amount discount, enter the amount to discount from each
item in the menu group.

• Amount Substitution: If this is an amount substitution discount, enter the price to
charge for each item in the menu group.

6. If you configured a Percent Off discount, click the General tab, and then enter the
maximum amount allowed for the discount in the Max Amount field.

7. Click Save.

Related Topics

• Automatic Discounts

• Automatic Discounts with Decimal Quantity Menu Items

• Amount Off Examples

• Amount Substitution Examples

Discounts With Condiments
You can apply manual, automatic, and coupon discounts to a check when a condiment item is
present on the check. A workstation operator can manually apply a discount by selecting the
condiment item. For example, configure a bagel to be a parent menu item and configure the
condiment, such as cream cheese, to trigger a 5% discount. As a result, when the
workstation operator enters the customer order for a bagel with cream cheese, the system
applies the discount after the workstation operator selects cream cheese.

Place condiments in trigger menu item groups to have Simphony apply automatic and
coupon discounts.

Complete the following tasks to apply discounts when condiments are present:

• Specify the condiment to be the trigger

• Set the discount to apply to the parent menu item, condiment, or both

• Set up the discount for a condiment

• Create a discount button to appear on the workstation page

Related Topics

• Configuring Condiments as Discount Triggers
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• Configuring Discounts for Parent Menu Items in a Menu Item Class

• Configuring a Condiment as the Discount Award

• Creating the Discount Button

Configuring Condiments as Discount Triggers
1. Select the Enterprise, property, or zone, click Configuration, and then click Menu

Item Groups.

2. Create a menu item group record and then double-click it to open.

3. Click Add near the Include area.

4. Select information for the fields described in the following table:

Table 14-10    Include Fields

Field Description

Type Select 4 - By Menu Item.

Start # Click in this field, and select the start number.

End # Click in this field, but do not enter a value.

See Items and Select Click the link and then select the condiment to
act as the discount trigger. This condiment
appears in the End # field.

5. Click Save.

Related Topics

• Discounts With Condiments

Configuring Discounts for Parent Menu Items in a Menu
Item Class

1. Select the Enterprise, property, or zone, click Configuration, and then click Menu
Item Classes.

2. Double-click a menu item class record.

3. Click the Options tab.

4. To allow both parent and condiment items to receive the discount, select 55 -
Discounts Apply to Priced Condiments (parent items only). Deselect option 55
to have only the parent item receive the discount.

5. Click Save.

Related Topics

• Discounts With Condiments
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Configuring a Condiment as the Discount Award
1. Select the Enterprise, property, or zone, click Configuration, and then click Discounts.

2. Create the discount record and then double-click it.

3. On the General tab, enter the fields as described in the following table:

Table 14-11    Discount Fields

Field Description

Activation Type Select the type of discount:
• 0 - Manual (Manually entered and applied)
• 1 - Automatic (Automatically applied, operator

cannot enter)
• 2 - Coupon (Automatically applied, operator must

enter)

Percent Enter the discount percentage to use a percent discount.

Max Amount Enter the maximum amount allowed for the discount to
use an amount discount.

Enabled Select this option to make the discount available to the
workstation operator. (If you configure a temporary
discount, you can quickly turn it off.)

Condiment Discountability Select the discount method for condiment menu items:
• 0 - Use MI Class Option: You must also select Menu

Item Class option 55 - Discounts Apply to Priced
Condiments (parent items only).

• 1 - Parent Items Only: Selecting this option applies the
discount only to the parent menu item.

• 2 - Condiment Items Only: Selecting this option
applies the discount to the trigger condiment and to all
condiments associated with the check.

• 3 - Parent and Highlighted Condiment Items: This
option is available only for manual discounts.

• 4 - Parent and All Condiment Items: Selecting this
option applies the discount to the parent menu item
and to all condiments associated with the check.

Trigger MI Group Select the menu item group to trigger the discount award.
When a workstation operator adds the minimum quantity
of items from this menu item group, the items are
discounted based on the award configuration for this
discount.
When you select 0 - Use Discount Itemizers, the only
options available for the Trigger Condiment Group are 0 -
None and all available condiment groups previously
created.
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Table 14-11    (Cont.) Discount Fields

Field Description

Trigger Condiment Group Select the Condiment Menu Item Group to use as the
trigger for the discount.
This field is dimmed when the Trigger MI Group is set to 0 -
Use Discount Itemizers.
This is an alternative method to using discount itemizers.
The discount applies to only qualifying menu items based
on the selected Trigger Menu Item Group, Trigger
Condiment Group, and other discount configuration.

Options Select 25 - Discount Combo Meal Group Items to discount
combo group menu items. You must also select option 1 -
Allow Discounts from the Combo Meal Groups module.

4. On the Effectivity tab, select the days on which the application applies the
discount.

5. On the RVC Type tab, select the revenue centers that can use this discount.

6. On the Menu Levels tab, in the Menu Level Configuration section, select all
options for Active On Main Levels and Active On Sub Levels.

7. On the Output tab, select the following options:

• Print on Customer Receipt

• Print on Journal

• Print on Guest Check

8. Click Save.

Related Topics

• Discounts With Condiments

Creating the Discount Button
1. Select the Enterprise, property, or zone, click Configuration, and then click Page

Design.

2. Open the page on which to place the discount button.

3. Click the Edit tab, and then select the page area in which to define the button.

4. Click Button, and then on the General subtab, select Discount from the Type
drop-down list.

5. Click the black arrow directly beneath the Type drop-down list, select the discount,
and then click OK.

6. Enter a Legend for the button, position and size the button on the page, and then
click Save.

Related Topics

• Automatic Discounts

• Automatic Discount Rules

• Awarding Algorithms
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• Discount Award Types

• Discount Exclusivity

• Simple Exclusivity

• Group Exclusivity

Related Topics

• Discounts With Condiments
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15
Service Charges

A service charge is the amount added to a sales transaction for a service rendered and is
posted to one of the following parties:

• The person or people providing the service (for example, a server or bartender, or a team
of servers)

• The House or the establishment providing the service

You can configure the following types of service charges:

• Service changes that report as Tips on employee tip reports

• Service changes that report as Service Charges on employee tip reports

• Service changes that are paid to the House

• Non-revenue service charges

• Gift certificates sold

Related Topics

• Configuring Service Charges

• Creating Service Charge Buttons

Related Topics

• Configuring Menu Item Fees

Configuring Service Charges
1. Select the Enterprise, property, or zone, click Configuration, and then click Service

Charges.

2. Insert the service charge record, and then double-click it.

3. On the General tab, enter information in the General Settings section as described in the
following table:

Table 15-1    General Settings Fields

Field Description

Percent Enter the service charge percentage. This field becomes
available only when you deselect option 2 - ON =
Amount; OFF = Percentage.

Amount Enter the service charge amount. This field becomes
available only when you select option 2 - ON =
Amount; OFF = Percentage.
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Table 15-1    (Cont.) General Settings Fields

Field Description

Tips Paid Tender/Media To link the service charge to a Tips Paid Tender/Media,
select the Pickup configured as Tips Paid from the
drop-down list.
When a service charge linked to a Tips Paid Tender/
Media is added to a check, it automatically posts to Tips
Paid.
Automatically posted Tips Paid occur as a part of a sales
transaction and therefore are not included in non-sales
transaction reports.

Pickup Tender/Media To link a pickup tender to the service charge, select the
Tender/Media from the drop-down list.
Only the tenders that have 3 - Pickup set in the Key
Type field of the Tender/Media module appear.

HALO Enter the High Amount Lock Out (HALO) value for the
service charge. This setting limits the amount
workstation operators can enter for the service charge.
To exceed this limit, the workstation operator must
have the Authorize/Perform Over HALO Amounts on
Service Charge Keys option set for the employee role.
When you set the value to 0, there is no HALO for the
service charge.
This field does not apply to automatic service charges.

Print Class Select the Print Class for the service charge.
Print Class Output contains more information.

Tax Class To apply a tax class to the service charge, select a Tax
Class from the drop-down list.

Privilege Group Select a Privilege Group to restrict use of this service
charge to employees who are linked to the same
privilege group. You can set the field to 0 to allow all
employees to use the service charge.

Percent to Tips Paid Enter the percentage of a charged tip that posts to the
Tips Paid Tender/Media.

Report Group Select the report group to which this service charge
record belongs.
Report groups are subcategories that allow reports to
show similar service charges grouped and subtotaled
together. You can configure report groups from the
Report Groups module, in the Reporting section of the
Property tab.

4. Select the Service Charge options as described in the following table:

Table 15-2    Service Charge Options

Option Description

1 - ON = Open; OFF = Preset Select this option to make the service charge an
open service charge, prompting the workstation
operator for the amount or percentage. Deselect
this option to use a preset amount or preset
percentage for the service charge.
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Table 15-2    (Cont.) Service Charge Options

Option Description

2 - ON = Amount; OFF =
Percentage

Select this option to make the service charge an
amount service charge. Deselect this option to
make the service charge a percentage service
charge.

3 - Post to Charged Tips Total
on Tip Reports

Select this option to post the service charge to the
Direct Charged Tips total. This option records
charged tips that employees receive directly from
customers. If you select this option, workstation
operators who use it must also enter a charge
payment using a tender with Tender/Media option
Post to Charged Receipts on Tip Reports set.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 11 - Do Not Post to Gross Receipts, but
not both.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 4 - Post to Service Charges Total on
Tip Reports, but not both.
Configuring a Tender with Charged Tips contains
more information about charged tips.

4 - Post to Service Charges Total
on Tip Reports

Select this option to post the service charge to the
Service Charges total, but not the Total Tips or the
Gross F&B Receipts total. Deselect this option to
post the service charge to the Gross Food and
Beverage Receipts, but not to the Service Charges
total. The Service Charges total on tip reports meets
the reporting requirements of United States IRS
Form 8027, which states that this total should equal
all tips that are paid to the employee as wages, and
are less than 10% of the transaction total.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 4 - Post to Service Charges Total on
Tip Reports, but not both.

5 - Reference Entry Required Select this option to require the workstation
operator to enter an alphanumeric reference entry
when using the service charge.

6 - Validation Required Select this option to print a validation chit when
the workstation operator uses the service charge.
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Table 15-2    (Cont.) Service Charge Options

Option Description

7 - Non-Revenue Service
Charge (No Post to Sales)

Select this option to create a service charge that
does not post to Simphony sales totals (for
example, cash back through the SPI). (A tracking
group total can track this amount if necessary.)
This option is used to create a service charge for
gift card/certificate sales as the customer can pay
for the gift certificate with a credit card. If you are
using gift cards through the SPI, you need to create
non-revenue service charges for:
• Activate Gift Card
• Issue Gift Card
• Reload Gift Card
You must also enable options 1 and 28.
When you select this option, you must configure
the service charge as an amount service charge. A
non-revenue service charge cannot post to a check
that contains menu items. If a cashier link is
required for tendering, a cashier link is also
required for posting a non-revenue service charge.
When using this option, deselect options 3 and 4.

8 - Taiwanese Paid Out Select this option to create a service charge that is
used to record the repayment of cash from a
Taiwanese paid out.

9 - Reset Itemizer(s) Select this option to reset service charge itemizers.
When set, service charges can only apply once to
menu items that post to the same service charge
itemizers. Deselecting this option allows multiple
service charges to apply to the same service charge
itemizers.

10 - Service Charge Adds to
Guest Count

Select this option to increment the transaction’s
guest count by one every time the service charge
applies to the transaction. This option is often used
for non-revenue service charges that apply as
cover charges. Selecting the RVC Parameter option
8 - Use Number of Seats for Guest Count
overrides the setting of this option. When the
workstation operator presses the Number of
Guests key during a transaction, the guest count
no longer increments when the service charge
applies to the transaction. The workstation
operator must maintain the guest count manually
from that point.

11 - Do Not Post to Gross
Receipts

Select this option to prevent checks with this
service charge from posting to gross F&B receipts
on tip reports. This is intended for service charges
that meet the United States Internal Revenue
Service’s definition of non-allocable receipts (as
defined in the IRS Instructions for Form 8027).
Deselecting this option allows the service charge to
post to gross F&B receipts on the tip reports.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 11 - Do Not Post to Gross Receipts, but
not both.
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Table 15-2    (Cont.) Service Charge Options

Option Description

12 - Item is Shareable Select this option to share the item between two or
more seats or two or more checks when using
TouchEdit or TouchSplit.

13 - Cash Tips Select this option to add the Direct Cash Tips total
on the tip reports. Selecting option 3 - Post to
Charged Tips Total on Tip Reports or 4 - Post to
Service Charges Total on Tip Reports overrides
this option. This option is used in a cashier
environment where the guest leaves the table and
pays the check directly with a cashier. When
paying the bill, the guest indicates to the cashier to
give the change to the server. After receiving
payment, the cashier can post a value to a Cash Tip
Service Charge. This Cash Tip Service Charge posts
to the employee’s Direct Cash Tips total on the
Employee Tip Report.

14 - Service Charge Used For
Stored Value Transactions

Select this option if the service charge is used for
stored value transactions.

17 - Use Floor Amount
(Automatic Service Charges
Only)

Select this option to require a minimum value for
the automatic service charge. Then enter the
minimum floor amount in the Amount field, which
is only active for percentage service charges when
you select option 17. This option only applies to the
service charge in revenue centers where it is used
as an automatic service charge.

18 - Gift Certificate Sold Select this option to create a service charge that
can be paid without posting to sales totals. (A
tracking group total can track the amount if
necessary.) This option is similar to 7 - Non-
Revenue Service Charge, except that menu items
can be present on the check in addition to the
service charge. When you select this option, you
must configure the service charge as an amount. If
a tender requires a cashier link, posting a non-
revenue service charge also requires a cashier link.
Selecting this option dims option 7.

22 - Add to Checks Begun/Paid
Count if Non-Revenue

This option applies to the service charge if it is
configured as non-revenue (option 7 is set).
Selecting this option increases the checks begun or
paid count on reports when the non-revenue
service charge applies to a transaction. Deselecting
this option results in no change to the checks
begun or paid count.

23 - Rental Deposit Select this option to use the service charge as a
rental deposit. Rental deposits work with the
deposit handling feature and are necessary to
apply a deposit to a check. Service charges with
this option set may be non-revenue service
charges. However, unlike traditional non-revenue
service charges, a check may contain more than
one rental deposit service charge.

Chapter 15
Configuring Service Charges

15-5



Table 15-2    (Cont.) Service Charge Options

Option Description

26 - Configure as Banquet Tip Select this option to include the amount of the
service charge transaction in the Tip Summary
Total of the banquet check.

27 - Configure as Banquet Fee Select this option to include the amount of the
service charge transaction in the Fees Summary
Total based upon the selected service charge on the
banquet check.

28 - Cash Management
Transaction Item

Select this option to include the service charge in
Cash Management tracking and reporting.

30 - Prorate Service Charges to
Menu Items

Select this option to prorate the service charge
based on the value of the menu items. This
overrides the requirement for the minimum guest
count for a memo check, if the minimum guest
count requirement is met for the entire check.

5. Click Save.

Related Topics

• Service Charges

Creating Service Charge Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page (typically the Transaction page) on which to place the Service
Charge buttons.

3. On the Edit tab, select the page area in which to define the Service Charge
buttons.

4. Click Button to add a button, and then on the General subtab, select Service
Charge from the Type drop-down list.

5. Click the black arrow directly beneath the Type drop-down list, select the service
charge, and then click OK.

6. Enter a Legend for the button.

7. Position and size the button on the page. Use the Style arrow to change the color.

8. Click Save.

Related Topics

• Service Charges

Menu Item Fees
You can apply one or more menu item service charge fees (for example, a bottle
deposit and a recycling fee), which are combined as a service charge group, to a
menu item. When the workstation operator adds a menu item (for example, bottled
soda) that is associated with a service charge group, Simphony adds the menu item
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fees to the guest check under the service charge group. Auditors can track the revenue from
specific menu item fees, such as a recycling fee.

Related Topics

• Configuring Menu Item Fees

Configuring Menu Item Fees
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Service Charge Groups.

2. Insert a new service charge group or double-click the existing service charge group
record.

3. Add or remove service charges to be included with this service charge group using the
Add and Delete links.

4. Click Save.

5. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Classes.

6. Double-click the menu item class record.

7. On the General tab, select the Service Charge Group from the drop-down list to apply
to the menu item class record.

8. Click Save.

9. Select the Enterprise level, click Configuration, and then click Roles.

10. Select the role, click the Operations tab, and then click the Voids/Returns subtab.

11. Select Authorize/Perform Void of Fees.

12. Click Save.

13. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

14. Add the Display/Hide Menu Item Fees function key.

Workstation operators use the Display/Hide Menu Item Fees function key to show or
hide menu item fees on the workstation.

15. Click Save.

Related Topics

• Service Charges

• Menu Item Fees
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16
Menu Items

A menu item is the foundation of transactions. Anything ordered is a menu item. In
restaurants, food and drinks are menu items. In retail stores, shirts and hats are also
considered menu items. Therefore, any item being sold is a menu item.

Oracle recommends configuring menu items in the following order:

Figure 16-1    Sequence for Configuring Menu Items

Configuring Menu Items
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Double-click a menu item class.

3. To allow the main level of the transaction to change to another level when a workstation
operator orders a menu item from this class, select a new Main Level Popup.

4. To allow the sub level of the transaction to change to another level when a workstation
operator orders a menu item from this class, select a new Sub Level Popup.

5. To allow the transaction to return to the default main level after a workstation operator
orders a menu item from this class, select Main Level Default.

6. To allow the transaction to return to the default sub level after a workstation operator
orders a menu item from this class, select Sub Level Default.

7. Click the Options tab, and then select the appropriate options:
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Table 16-1    Menu Item Options

Option Description

10 - ON = Use Sub Level Pricing; OFF =
Use Main Level Pricing

Select this option for an item with
multiple price definitions, to have the
workstation use sub level pricing for the
menu item class.

26 - Keep Main Level With Repeat
Rounds

Select this option to have the items in the
class use the same main menu level that
was in effect during the most recent
service round when ordered using the
Repeat Round touchscreen button.

27 - Keep Sub Level With Repeat Rounds Select this option to have the items in the
class use the same sub menu level that
was in effect during the most recent
service round when ordered using the
Repeat Round touchscreen button.

28 - Print Main Level Prefix and Suffix Select this option to show the main menu
level prefixes or suffixes on the check
detail area and print on guest checks and
order receipts.

29 - Print Sub Level Prefix and Suffix Select this option to show the sub menu
level prefixes or suffixes on the check
detail area and print on guest checks and
customer receipts.
Prefixes and suffixes are often used to
show the size of a menu item (for
example, small or large soda). It is
recommended to enable this option so
customers understand why different
charges are applied to the same menu
item. For example, a Large Soda is $2.50,
and a Small Soda is $1.50. When this
option is deselected, the guest check or
order receipt shows two entries for Soda:
one Soda for $2.50 and another Soda
for $1.50. If prefixes are printing, the
customer understands that the Lrg Soda
is $2.50 and the Sm Soda is $1.50.

52 - Prompt to begin another item if this
item is incomplete

Select this option to prompt workstation
operators to move to the next item
before completing a menu item order. To
use option 52, you must deselect option
51 - Item must be complete before
beginning another item. Option 52 is
not used with required condiments.

69 - Prompt to lookup menu item
definition based on current menu levels
(Repeat Rounds)

Select this option to prompt workstation
operators to run a menu item definition
lookup based on the current active menu
levels when a repeatable menu item is
unavailable.
You must also select options 26 - Keep
Main Level With Repeat Rounds and 27
- Keep Sub Level With Repeat Rounds.

8. Click Save.
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Related Topics

• Menu Levels

Adding and Disabling Menu Items
Adding a menu item is a different process than adding records in other EMC modules. You
can add master records, definition records, and price records at the same time for the
Enterprise from the Menu Item Maintenance module. These instructions explain how to add
menu item master records with definition and price records. For information about adding
masters, definitions, and prices individually, see the appropriate section:

• Configuring Master Records for Menu Items

• Configuring Menu Item Definitions

• Configuring Menu Item Prices

1. To add menu items from the EMC, select the Enterprise, property, revenue center, or
zone, click Configuration, and then click Menu Item Maintenance.

2. Insert a record.

3. If you opened Menu Item Maintenance at the revenue center level, from the Select a
task to perform drop-down list, select Add Master Record from Template.

4. Click Select adjacent to the Master to Copy field, and then select a template record.

5. Enter the Name of the new menu item.

6. Enter the Record Number of the item. By default, this field shows the next available
record number after the selected record to copy.

7. If you selected Add Master Record from Template, select Copy Menu Item Names to
copy all existing primary and foreign names, including Long Descriptors, from the original
menu item to the new menu item.

8. If the menu item is priced the same for the entire Enterprise or property, select Use the
same price for all records, and then enter the price in the text box next to the option.

9. If the menu item has more than one definition and price, select Configure Prices
Individually, enter the price for the first definition in the Price column, and then click OK
to add the menu item.

10. To add another menu item, click Yes when prompted, and repeat Steps 4 through 9.

11. When you have finished adding items, click No.

12. Click Save.

13. To disable a menu item, select the Enterprise, property, revenue center, or zone, click
Configuration, and then click Menu Item Maintenance.

14. Double-click the menu item to disable.

15. Click the General tab, and then deselect all main and sub levels from the Menu Level
Availability section.

16. Click Save.
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Configuring Employee Privileges to Edit Menu Item
Definitions and Prices

In the EMC, you must grant employees permission to edit menu item definitions and
prices. The permissions enable workstation operators to change menu item definitions
and prices at the property level from the workstation using the Edit Menu Item function
key. The Oracle Hospitality Simphony Manager User Guide contains more information
on Adjusting Menu Item Definitions.

Users cannot edit a menu item that is defined at the Enterprise or zone levels; users
with the appropriate privileges can edit a menu item that is defined at the property
level.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the PMC Procedures
sub-tab.

3. Select options 30020 - View Menu Items to enable employees to access menu
items from the workstation, 30021 - Edit Menu Item Definitions to enable
employees to edit menu item definitions from the workstation, and 30022 - Edit
Menu Item Prices to enable employees to edit menu item prices from the
workstation.

4. Click the PMC General/Reports sub-tab.

5. Select 30001 - Run PMC to allow employees associated with the role to launch
the PMC on the workstation using Function Key 300, Launch PMC.

6. Click Save.

Configuring Employee Privileges for Menu Item Availability
Adjustments

In the EMC, you must grant employees permission to adjust the availability of menu
items. The permission enables workstation operators to change menu item availability
at the workstation using the Menu Item Availability function key. The Oracle Hospitality
Simphony Manager User Guide contains more information on Adjusting Menu Item
Availability.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the PMC Procedures
sub-tab.

3. Select options 30020 - View Menu Items to enable employees to access menu
items from the workstation, and 30023 - Change Menu Item Availability to
enable employees associated with the role to adjust the availability of menu items
from the workstation.

4. Click the PMC General/Reports sub-tab.

5. Select 30001 - Run PMC to allow employees associated with the role to launch
the PMC on the workstation using Function Key 300, Launch PMC.

6. Click Save.
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Configuring Menu Item Availability for Multiple Definitions at the
Workstation

By default, the Menu Item Availability function key only allows workstation operators to
adjust the availability of the first menu item definition. To allow workstation operators to edit
all definitions of an item from the workstation:

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Options tab, and then select 66 - Manage Menu Item Availability/Out of Item
for each Menu Item Definition.

3. Click Save.

Adding the Menu Item Availability Key to the Transaction Page
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page (typically the Transaction page) on which to place the menu item
availability function key.

3. On the Edit tab, select the page area in which to define the menu item availability
function key.

4. Click Button.

5. On the General subtab, enter the key name in the Legend field.

6. From the Type drop-down list, select Function.

7. Click the black arrow beneath the Type drop-down list.

8. Select Menu Item in the Filter list, select Menu Item Availability in the Results list, and
then click OK.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Adding Menu Item Keys to the Transaction Page
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page (typically the Transaction page) on which to place the menu item buttons.

3. On the Edit tab, select the page area in which to define the menu item buttons.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. From the Type drop-down list, select Menu Item.

7. Click the black arrow beneath the Type drop-down list.

8. Select the menu item, and then click OK.

9. From the Menu Item Display Name drop-down list, select the appearance for the menu
item name.
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10. Position and size the button on the page. Use the Style arrow to change the color.

11. Click Save.

12. Repeat Steps 4 through 11 to create keys for each menu item.

Adding the Edit Menu Item Key to the Transaction Page
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page (typically the Transaction page) on which to place the menu item
buttons.

3. On the Edit tab, select the page area in which to define the menu item buttons.

4. Click Button.

5. On the General subtab, enter the button name in the Legend field.

6. From the Type drop-down list, select Menu Item.

7. Click the black arrow beneath the Type drop-down list.

8. Select Menu Item in the Filter list, select Edit Menu Item in the Results list, and
then click OK.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Repeatable Menu Items
Repeat Round allows workstation operators to order several items (typically beverages
or fixed price meal items) from the previous round of a guest check to the current
round using a single button. Repeat Round is used when customers re-order the same
menu items for another round. For example, a group of 10 people at the bar ordered
10 beverages. After drinking the beverages, they ordered another round. Rather than
entering all 10 drinks again, the bartender presses the Repeat Round function key to
quickly re-enter the beverage order.

If a menu item is set to check for availability, the Repeat Round function inquires and
updates this status. If the availability of an item is exceeded, the entire Repeat Round
process stops.

The following menu item types are not repeatable:

• Weighed menu items

• Combo meals

• Voided and returned menu items

• Menu items that are programmed to allow a decimal amount entry

Related Topics

• Configuring Menu Items to be Repeatable

• Configuring a Repeat Round Button
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Configuring Menu Items to be Repeatable
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Double-click a menu item class record to open it.

3. Click the Options tab, and then configure the following settings: .

• 25 - Use with Repeat Round Key: Select if menu items in this class can be reposted
on guest checks using the Repeat Round key. For an item to be repeatable, you must
make all associated condiments repeatable. Else, the parent menu item does not
repeat when the Repeat Round key is used.

• 26 - Keep Main Level With Repeat Rounds: Select for items in this class to use the
same Main Menu Level that was in effect during the most recent service round when
ordered using the Repeat Round key. Deselect to use current menu levels. For
example, you can use a Main Level with Happy Hour prices, where Happy Hour ends
at 7:00 pm. In this example, if you keep the Main Level, you will have an Extended
Happy Hour.

• 27 - Keep Sub Level with Repeat Round: Select for items in this class to use the
same Sub Menu Level that was in effect during the most recent service round when
ordered using the Repeat Round key. Deselect to use current menu levels. You can
use a Sub Level for menu item sizing. If a pitcher of draft beer is ordered and service
totaled, the Repeat Round key repeats the pitcher if this option is selected, but
repeats only a pint of draft beer if deselected.

• 69 - Prompt to lookup menu item definition based on current menu levels
(Repeat Rounds): Select to prompt the workstation operator to look up a menu item
definition based on the current menu levels when a repeatable menu item is
unavailable. You must also select options 26 - Keep Main Level With Repeat
Rounds and 27 - Keep Sub Level With Repeat Rounds.

4. Click Save.

Related Topics

• Repeatable Menu Items

Configuring a Repeat Round Button
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page on which to place the Repeat Round button.

3. Click the Edit tab, and then select the page area in which to define the button.

4. Click Button, and then on the General subtab, select Function from the Type drop-
down list.

5. Click the black arrow directly beneath the Type drop-down list, select Transaction from
the Type pane, and then select Repeat Round.

6. Enter a Legend for the button (for example, Repeat Round), position and size the
button on the page, and then click Save.
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Related Topics

• Repeatable Menu Items

Menu Item Distribution
Menu Item Distribution is the method of distributing menu item records in the Menu
Item Maintenance module. Because the Menu Item Maintenance module allows the
configuration of multiple record types (Menu Item Masters, Menu Item Definitions, and
Menu Item Prices), the Menu Item Distribution dialog differs from the dialogs that
appear in other modules.

Related Topics

• Distributing Menu Items

• Searching and Filtering Menu Items

Distributing Menu Items
1. Select the Enterprise, property, revenue center, or zone, click the Configuration

tab, and then click Menu Item Maintenance.

2. To distribute a specific set of records, use the filters to search for the items to
distribute, and then select the records.

3. Click Edit on the EMC toolbar, and then select Distribute.

4. From the Destination pane, select the locations to which to distribute.

5. From the Record Type pane, select the attributes to distribute:

• Masters: Select to distribute menu item masters.

• Definitions: Select to distribute menu item definitions.

• Prices: Select to distribute menu item prices.

6. From the Record Selection pane, select the records to distribute:

• All Records: Select to copy all records from the source to the destination
revenue center or property.

• Selected Records: Select to distribute only the selected records. When
distributing definitions and prices, all records for the object number are
distributed. For example, if you choose to distribute definition number 1000,
sequence #3, all definitions for number 1000 are distributed, not only
sequence #3.

• Specify Records: Select to enter a list or range of records to distribute, and
then enter the record numbers in the text box below.

7. From the Options pane, select the appropriate options:

• Overwrite records if they exist: Select to overwrite existing records in the
destination location. If the destination record is inherited, it is not overwritten.

• Create records if they do not exist: Select to create new records in the
destination location.

• Distribute inherited records: Select to distribute all records (defined and
inherited) to the destination property. Deselect to distribute only records
defined at the source property.
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• If destination record is inherited, create override: Select to override inherited
definition records in the destination property. Deselect to keep inherited records
unchanged.

• Distribute Data Extensions if they exist: Select to distribute data extension values,
if existing. The source and destination data extension property records must match.
Deselect to prevent data extension values from distributing

• Create Masters for Definitions: Select to create new Menu Item Master records for
distributed Menu Item Definition records in the destination location, if they do not
currently exist. This option is only available when Definitions are being distributed
without Master records. It is recommended to select this option if distributing menu
items between revenue centers in different properties.

8. Click OK.

Once distribution completes, a Distribution Report appears showing all records that were
created, overwritten, and any errors encountered. You can save this report by clicking
Save to Disk.

Related Topics

• Menu Item Distribution

Searching and Filtering Menu Items
The Menu Item Maintenance module allows you to search for menu items. Typically several
thousand menu item records are likely to exist. Searching and filtering allows you to work with
only the desired menu item records. By default, no items appear in table view.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

2. To view all records, click Search without entering search criteria.

Depending on the number of menu items, this step may take several minutes.

3. To view specific menu item records, enter information in the relevant search fields, and
then click Search:

• Record Type: Select the type of record to find (Menu Item Master, Menu Item
Definition, or Menu Item Price). When both a Menu Item Master and a revenue
center are selected, Simphony returns only master records with definitions in the
selected revenue center.

• Name Search: Enter the menu item name (partial or full) to search. Only records
containing the text in the name field for the specified language are returned. Menu
Item Definition and Price searches will look for the text in either the Name 1 or Name
2 fields. Entering Shrimp Cocktail returns the specific record; a family group search
on Appetizers returns results more quickly.

• Major Group: Enter a major group number or a range of major group numbers to
include in the search.

• Family Group: Enter a family group number or a range of family group numbers to
include in the search.

• Master Group: Enter a menu item master group number or a range of master group
numbers to include in the search.

• Object Number or Range: Enter an object number or range of object numbers to
include in the search.
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• Show Master w/Defs Only: Select to show only menu item master records
that contain one or more definitions for this zone or property. Deselect to show
all menu item master records for this level or above.

• Map Menu Item Overrides: Select to show the Menu Item Override indicator,
which allows you to see other locations in the Enterprise where the item is
configured. Deselect to exclude the Menu Item Override indicator. As the
system needs to check the entire enterprise for the menu item, the search
results will take longer to generate. Therefore, set this option only when there
is a specific need to see this information.

• Class: Enter a menu item class or range of menu item classes to include in
the search when querying menu item definitions or menu item prices.

• SLU: Enter a SLU or range of SLUs to include in the search when querying
menu item definitions or menu item prices.

• Sales Itemizer: Enter a sales itemizer or range of sales itemizers to include in
the search when querying menu item definitions or menu item prices.

Related Topics

• Menu Item Distribution
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17
Categorizing Menu Items into Groups

Both major groups and family groups categorize menu items and sales. Every menu item
belongs to a major group and to a family group.

A major group is a basic category of a menu item, such as Food or Liquor. For example, you
can configure major groups to represent revenue centers so that an accountant can see
sales figures for a tenant.

A family group is a category of menu items.

Related Topics

• Configuring Menu Item Groups

Related Topics

• Configuring Major Groups

Related Topics

• Configuring Family Groups

Configuring Major Groups
1. Select the Enterprise, property, or zone, click Configuration, and then click Major

Groups.

2. Insert a new record, and then enter a name for the major group (for example, Food).

3. Enter a number other than 0 (zero) in the Report Group field.

For example, you can enter 1 for the Food major group and enter 2 for the Liquor major
group. When you enter 0 (zero), the menu item does not appear on the Menu Item
Report.

4. Click Save.

Related Topics

• Categorizing Menu Items into Groups

• Menu Item Groups

Configuring Family Groups
1. Select the Enterprise, property, or zone, click Configuration, and then click Family

Groups.

2. Insert a new record, and then enter a name for the family group (for example,
Appetizers).

3. Enter a number other than 0 (zero) in the Report Group field.
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For example, you can enter 1 for all family groups associated with Food and enter
2 for all family groups associated with Liquor. When you enter 0 (zero), the menu
item does not appear on the Menu Item Report.

4. (Optional) Select the Parent Major Group to which the new family group belongs.

Note:

Assigning a Parent Major Group to a Family Group provides a filtering of
choices when assigning a family group to a Menu Item Master record,
where only the family groups belonging to the assigned Major Group
appear in the drop-down list. This is useful when there are a large
number of family groups configured, or to prevent assigning a family
group which is not associated with a major group.

5. Click Save.

Related Topics

• Categorizing Menu Items into Groups

• Menu Item Groups
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18
Menu Item Master Records

A menu item master record is configured at the Enterprise level and is inherited by all
properties. This record resides at the top of the menu item hierarchy, and its primary purpose
is to appear in reports. A menu item master:

• Does not appear on workstation touchscreens

• Does not have a price

A menu item can have only one menu item master per property (for example, one Shrimp
Cocktail master record exists).

Related Topics

• Configuring Master Records for Menu Items

Configuring Master Records for Menu Items
You can add master records for menu items, along with menu item definitions and prices,
using a template record. If you are creating a new property and there are no template records
to use, at first you can add only a menu item master record, and then add menu item
definition and price records later.

If a menu item name includes the special characters, $#$, they are replaced with the object
number of the record being created. For example, if the name is My Record $#$ and is being
inserted into object number 4, the new record is created as My Record 4.

1. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.

2. Click Insert on the toolbar.

3. To add a master record using a template:

a. From the Select a task to perform drop-down list, select Add Master Record from
Template, and then select the menu item to use as the template from Master to
Copy.

b. Enter the Name of the new menu item, select the Report Master, and then enter the
Record Number for the menu item master record.

c. To copy all menu item names from the original menu item template, select Copy
Menu Item Name.

d. To modify the prices of each menu item definition, select Configure Prices
Individually, and then enter the price for each definition in the table.

This is the default setting. This option is used for menu items that do not use the
same price in every revenue center. That is, multiple price records exist in a single
revenue center for a single definition. If the Price Level field in the table is blank, the
record has no price (it is probably a condiment), and no price will be created.

e. To define a single price for all menu item definitions, select Use same price for all
records, and then enter the price in the adjacent field.
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This option is used for menu items that are priced the same system-wide. It
creates a menu item with the same price for every definition and price record.
If the Price Level field in the table is blank, the record has no price (it is
probably a condiment), and no price will be created. You can modify the price
of a definition at any time.

4. To add a master record without a template:

a. From the Select a task to perform drop-down list, select Add Master Record
Without a Template, and then enter the Name of the new menu item.

b. Select a Major Group and a Family Group for the menu item.

c. Enter a Report Group number between 1 and 99 for the menu item.

Menu Item Reports sort and list subtotals by Report Group. When the Report
Group number is 0 (zero), the menu item does not show on Menu Item
Reports.

d. Select the appropriate value for the object number:

• To insert the menu item in the next available position, select Next
Available Position.

• To define the record number or range for the new menu item record or
records, select Record Number Or Range, and then enter the record
numbers or ranges.

• To insert the menu item at the next available record number after the
currently selected record, select After currently selected record. For
example, if you have record #50 selected and records 51 through 53 also
exist, the new men item is created in record #54.

5. Click OK.

6. (Optional) Select the Master Group for the Menu Item Master record.

A Menu Item Master Group is a collection of Menu Item Masters. The group is
used for conversational ordering to allow the menu item master to be switched
based on levels or other conditions.

7. Double-click the new master record to open it.

8. Click the Production Item tab, click Add and then, configure the following
settings:

• Production Item Name: Select the name of the production item. You can add
more than one distinct production item.

• Production Item Count: Enter the number of portions required to complete
the menu item. The count must be between 1000.00 and 0.00. For example, a
hamburger would require a single hamburger patty, while a double-
cheeseburger would required 2 patties. You can enter half, quarter, and so on.

9. Click Save.

Related Topics

• Menu Item Master Records

Chapter 18
Configuring Master Records for Menu Items
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19
Menu Item Search and Report

To prevent the addition of unnecessary menu item records, privileged users can run the
Module Reference Report to search and review the system for existing menu item names or
record numbers (or range of record numbers). This report shows the location of items and
overrides throughout the Enterprise. The report appears in two views: tree view and text view.

Generating the Module Reference Report
1. Select the Enterprise level, click the Tasks tab, and then click Module Reference

Report.

2. Select the appropriate Report Type:

• By Name: Select to search for menu items by name.

• By Number: Select to search for menu items by record number.

3. Click Select Items for Report, select the menu item names or numbers to include in the
search, and then click OK.

Select multiple menu items by pressing the CTRL or SHIFT key while selecting an item.
You can select a maximum of 50 items at a time.

4. Click Run Report by Name or Run Report by Number to generate the report.

5. To print the report, click the Text View tab, and then click Print.

6. To save the report as a text file, click the Text View tab, click Save as Text File, and then
enter the file name and browse to the location to save the file.
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20
Menu Item Classes

A menu item class consists of a set of options that apply to similar menu items in a revenue
center. A menu item class specifies information, including:

• The tax class associated with the menu items

• The two types of menu items: Regular and Condiments

• Active menu levels after ordering an item from the class

• The order devices to which the items output

You can configure similar menu items into a class rather than individually setting each menu
item’s order device output or condiment settings. For example, the menu items Cola, Diet
Cola, and Root Beer all share the following characteristics:

• Receive the same tax rates

• Do not require condiments

• Output to the same order device

Therefore, you can create one menu item class called Soda and make all soda menu items a
part of this class.

Related Topics

• Configuring Menu Item Classes

Related Topics

• Configuring Menu Item Classes

Configuring Menu Item Classes
For information about configuring menu item classes for condiments and fixed price meals,
see Creating Menu Item Classes for Condiment Groups.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Classes.

2. Insert a new record, and then enter a name for the new menu item class.

3. Double-click the new menu item class.

4. On the General tab, configure the appropriate settings:
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Table 20-1    General Menu Item Class Fields

Field Description

Tax Class Select the tax class to apply to the menu
item class. To leave the tax class blank,
select 0 - None.
Tax Rates and Tax Classes contains more
information about tax classes.

Main Level Popup Select the Main Level of the transaction
that becomes active after ordering a
menu item from the menu item class.

Sub Level Popup Select the Sub Level of the transaction
that becomes active after ordering a
menu item from the menu item class.

Privilege Group Select a Privilege Group number to
restrict the use of menu items in the
menu item class to employees who are
linked to the same Privilege Group.
To enable all employees to order items in
the menu item class, select 0 (zero).

Sales Itemizer Select the Sales Itemizer that is
associated with this Menu Item Class.
The Sales Itemizer is often used for
interface (Property Management System)
purposes, or to replace the Subtotal on
printed guest checks and customer
receipts. You can either see the Subtotal,
or Food, Liquor, Beer, and Wine.

Discount Itemizer Select the discount itemizer to determine
which discounts can apply to specific
menu items.

Srv Chrg Itemizer Select the Service Charge Itemizer that is
associated with this Menu item Class. The
Service Charge Itemizer is used to
determine which Service Charges can be
applied to specific menu items. Note that
the automatic service charge is
unaffected by this setting; only Menu
Item Class Option 12 - Add to Automatic
Service Charge Itemizer affects the
Automatic Service Charge posting.

Chapter 20
Configuring Menu Item Classes
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Table 20-1    (Cont.) General Menu Item Class Fields

Field Description

HALO Enter the High Amount Lock Out (HALO)
value for menu items in this Menu Item
Class. This field represents the total
dollar amount of the items that are being
ordered, and it is often used for Open
Priced menu items. For example, if this
field is set to 50, the operator is prompted
to confirm items in this class if they
exceed 50.00. Note that the entered value
must contain all zeroes except for the
first digit. Valid values are: 2, 20, 200,
2000. Invalid values are 45, 450, 405.
HALO is also often used for preset priced
menu items to safeguard against
erroneous entry. For example, the price
of Coffee is $1.00. A workstation operator
could post 1 Coffee, 5 Coffees or 10
Coffees if someone is getting coffee for
their entire office. It is unlikely that
someone would order 100 Coffees ($100).
It is likely that someone ordering 10
Coffees inadvertently presses an extra 0
when entering the quantity.

Pricing Calculation Select the calculation method to use for
pricing menu items in the class.
• To base the price on the amount

entered, select 0 - Based on entered
count

• To base the price on the rounded up
count, select 1 - Based on sales
count when sales rounded up.

Count Display Select the manner in which the amount
appears for a decimal item on the
workstation and printers.
• 0 - Show entered amount
• 1 - Show sales count amount with

entered count as reference
The count for an item can be entered
as a decimal. There are two counts
kept for an item; the entered
amount, and the sales count. The
sales count is always the entered
amount if the entered amount is a
whole number. If the entered
amount is not a whole number then
the sales count is the entered
amount, only rounded up. For
example, if a user enters 1.5, then
the entered amount is 1.5 and the
sales count is 2. This field determines
whether the entered amount or the
sales count appears on workstations
and printers.

Chapter 20
Configuring Menu Item Classes
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Table 20-1    (Cont.) General Menu Item Class Fields

Field Description

Count Entry Select the manner in which workstation
operators can enter the sales count of an
item in the class.

Print Group Enter the Print Group (1-99). The sorting
mechanism uses this value for receipt
printing, check detail, and order output
devices. When the items are set to use
groups for sorting, the items appear from
lowest group number to highest.

Print Class Select the print class for the menu item
class.
If the Condiment Prefix Type is set to
anything except 0 - Not a Prefix, prefix
condiments follow the same print class
setting chosen for the condiment with
which they are associated.

KDS Highlight Scheme Select the KDS Highlight Scheme color to
display menu items on the KDS.

Condiment Prefix Type Select the prefix type associated with the
condiment type.

Condiment Handling with Parent Item
Switching

Select from the following condiment
behaviors to use for default and other
Condiments, when the parent item is
switched in Conversational Ordering:
• 0 - Condiments Remain

Unchanged: Condiment
modifications will be unchanged.

• 1 - Reset Default Condiments Only:
Only default condiments for a menu
item reset.

• 2 - Reset All Condiments: All
condiment types reset.

All options are applicable when
Condiment Prefixes are used.

Chapter 20
Configuring Menu Item Classes

20-4



Table 20-1    (Cont.) General Menu Item Class Fields

Field Description

Next Page/Panel Select a Page or Panel that the order
screen switches to after a menu item
associated with this class is ordered.
• Page: From the drop-down list, select

the next screen to which the
workstation user is directed.

• Panel: If you select a tabbed
template, this area specifies which
tab to navigate to after pressing the
button.

To use the Next Page functionality in the
Menu Item Classes module, Oracle
recommends that you configure a Sales
SLU screen in the Page Design module,
and then select this newly created SLU
page from the Page drop-down list and
Save.
Ensure that menu items are assigned the
proper SLU from the Menu Item
Definition record; this allows
workstation operators to add the menu
item from the SLU page.
To enable a hard-coded menu item key to
navigate to another page, configure the
Next Page/Panel fields for the actual
menu item key in the Page Design
module.

Maximum Refill Count Enter the maximum number of refills
allowed (up to 99).

Refill Descriptor Enter the optional label to identify refill
items when printed on order chits (up to
12 characters).

Service Charge Group Select the Service Charge Group to apply
to this Menu Item Class. Select 0 - None
for no service charge.

Pre-Production Chit Print Class Select a Print Class to print pre-
production chits to remote printers for
the menu items assigned to this Menu
Item Class. Remote pre-production chit
printers are assigned in the Print Classes
module.
See Configuring Pre-Production Chits to
Output to Remote Printers for more setup
information.

5. Click the Options tab, and then select the appropriate options.

Chapter 20
Configuring Menu Item Classes
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Table 20-2    Menu Item Class Options

Option Description

1 - ON = Open-Priced Menu Items; OFF =
Preset Menu Items

Select this option to require workstation
operators to enter a price when adding a
menu item in the class. Deselect this
option if you are using preset prices.

3 - Negative Priced Menu Items Select this option to have menu items in
this class post a negative price. This
option causes a minus sign (-) to appear
before the price.

4 - Increment Seat Number With Sale of
these Menu Items

Select this option to increase the seat
number each time a workstation
operator adds a menu item in the class.
This feature is not available when seat
filtering is active.

5 - Reference Entry Required Select this option to require workstation
operators to enter a reference entry
when adding menu items in the class.
The text that is entered outputs to order
devices, checks, receipts, and journals.

6 - Validation Required Select this option to print a validation
chit at the validation printer designated
in the Workstation module.

7 - Item Discounts May Be Applied to
these Menu Items

Select this option to allow menu items in
the class to be discounted with an item
discount (manual discount only).

8 - Allow Menu Items in this Class to be
Non-Priced

Select this option to allow menu items in
the class to be non-priced. When
selected, priced menu items in this class
post a sales and count total when
ordered, and appear on reports; non-
priced items do not post a sales count
and do not appear on reports.
Priced menu items do not require an
entry on the Menu Item Price form.

10 - ON = Use Sub Level Pricing; OFF =
Use Main Level Pricing

Select this option to apply Sub Level
pricing to menu items assigned to the
menu item class.

11 - Add to Guest Count Select this option to increase the guest
count each time a workstation operator
adds menu items that are assigned to the
class. When this option is selected and
the Guest Count field is set to 0,
Simphony increments the guest count in
the transaction by one.
If a workstation operator uses the
Number of Guests function key during a
transaction, the guest count no longer
increments when menu items in the class
are added to the check.
Revenue Center Parameters option 8 -
Use Number of Seats for Guest Count
overrides this option.

Chapter 20
Configuring Menu Item Classes
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Table 20-2    (Cont.) Menu Item Class Options

Option Description

12 - Add to Automatic Service Charge
Itemizer

Select this option to add sales of the
menu items in this class to the Automatic
Service Charge itemizer. Automatic
service charges apply to all menu items
associated with Menu Item Classes where
this option is enabled.

13 - Print Price on Order Chit Select this option to print the menu item
price on order devices. This option is
typically used with open-priced menu
items. Order Devices option Wrap
Condiments overrides this option.

14 - Do Not Put in Transaction Detail Select this option to prevent zero-priced
or non-priced menu items in the class
from printing, appearing, or posting.

17 - Print Name 1 and Name 2 on Checks Select this option to print the First Name
and the Second Name (from the Menu
Item's Definition record) of all menu
items associated with the class on guest
checks. For example, with wine menu
items, the First Name shows the name of
the wine, while the Second Name shows
the Bin Number and the type of wine.

18 - Print Name 2 on Order Output
instead of Name 1

Select this option to print the Second
Name, if defined, of menu items
associated with this class on order
devices. If a Second Name is not defined,
the First Name is used.
Order Devices option 11 - Print Both
Menu Item Names overrides this option.

19 - Use Name 2 on Touchscreens instead
of Name 1

Select this option to show the Second
Name, if defined, of menu items in this
class on touchscreen keys. If a Second
Name is not defined, the First Name is
used. This applies to names shown on
Menu Item and Condiment SLU’s, but not
to Direct Access keys.

24 - LDS Items (International LDS Only) Select this option if all menu items in this
class can be ordered using an
International Liquor Dispensing System
(ILDS). Deselect if using a North
American Dispensing System (NALDS).

35 - Fixed Price Meal Select this option to indicate all menu
items in the class are the priced (parent)
portion of a fixed price meal.

38 - Item is Shareable Select this option to allow menu items in
the class to be shared between two or
more seats, or two or more checks.

39 - Retail Item Select this option to designate all menu
items in this class as retail items. Retail
items do not post to Gross Food and
Beverage receipts.

Chapter 20
Configuring Menu Item Classes
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Table 20-2    (Cont.) Menu Item Class Options

Option Description

41 - Consolidate Menu Items with
Condiments on Order Output

Select this option to consolidate parent
menu items on Order Device Output, and
then to print each condiment with its
seat number to which the condiment
applies. (The Order Device option, Print
Seat Numbers with Individual Items
must be enabled). For example, if this
option is enabled, and an operator orders
Chicken Wings with condiments ‘Extra’
and ‘Sauce’ on Seat 1, and Chicken Wings
with condiments ‘Without’ and ‘Bleu
Cheese’ on Seat 2, then the Order Device
Output shows the following:
Seat 1,2: Chicken Wings
S1 Extra
S1 Sauce
S2 Without
S2 Bleu Cheese

43 - Include in CRM/TMS Check Detail
Status Update

Select this option to indicate whether a
menu item associated with this class is
sent to TMS with the check detail status
message.

45 - Use KDS/Dining Course Number Select this option to use KDS/Dining
Coursing with the menu item class.

62 - Count Menu Item Select this option to allow the menu item
count to appear on the KDS or at the
bottom of the requisition chit from a
local or remote printer. To use the Count
menu item feature with a KDS, assign a
KDS Chit Layout Style containing a menu
item count element (for example, #301 -
Chit-Std-DOM ). You must also select the
Order Devices KDS option 11 - Display
Menu Item Count for the order device.
To be counted, you must send a menu
item to at least one KDS Display.
This feature informs the expediter or
bagger of how many items go into the
bag for carry-out or quick service orders.

65 - Support Enhanced Prefix Mode
(Parent Only)

Select this option to use enhanced prefix
support for non-condiment menu items
in the Menu Item Class. Enhanced prefix
support uses condiment prefix items to
describe condiments such as “Extra” or
“No”.
Existing condiment threshold levels are
supported for condiment prefixes.
See Assigning Condiments to Parent Menu
Item Classes and Using Condiment Prefixes
with Menu Item Classes for more
information.

Chapter 20
Configuring Menu Item Classes
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Table 20-2    (Cont.) Menu Item Class Options

Option Description

66 - Print Name 3 on Order Output
instead of Name 1

Select this option to print the menu item
definition’s Third Name, if defined, on
order devices for all menu items in this
class. If a Third Name is not defined, the
First Name is used.
Menu Item Classes option 18 - Print
Name 2 on Order Output instead of
Name 1 and Order Devices option 11 -
Print Both Menu Item Names overrides
this option.

68 - Print Name 3 on Checks Select this option to print the menu item
definition’s Third Name, if defined, on
guest checks for menu items in this class.
17 - Print Name 1 and Name 2 on
Checks overrides this option.

70 - Use Name 2 on OCB instead of Name
1

Select this option to show the menu item
definition's Second Name, if defined, on
an Order Confirmation Board (OCB). If a
Second Name is not defined, the First
Name is used.

74 - Prevent Menu Items from Being Held Select this option to prevent menu items
belonging to this menu item class from
being held.

75 - KDS Sort Priority Above Normal See Prioritizing Menu Item Classes on
KDS Displays in the Oracle MICROS
Simphony KDS Configuration and User
Guide for more information.

76 - Post Sales Count To KDS Reports Select this option to add the menu item
count to the Menu Item Count totals on
KDS reports.

77 - Only allow condiments with an
active price record

Select this option to have condiment
items with an active effectivity price
record appear in SLUs. When the
effectivity record is expired or has a
future date, the condiments are not
available in SLUs.
You must also disable option 8 - Allow
Menu Items in this Class to be Non-
Priced.

78 - Forgive Inclusive Tax Select this option to forgive the inclusive
tax for the Menu Item Class.

Chapter 20
Configuring Menu Item Classes
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Table 20-2    (Cont.) Menu Item Class Options

Option Description

79 - Do not print unpriced condiments on
Guest Checks

Select this option to prevent unpriced
condiments from printing on guest
checks and customer receipts.
Option 79 applies to the menu item
condiments. For example, if there is no
charge for lettuce on a sandwich, you can
configure this condiment to not print. If
there is a charge for avocado on a
sandwich, you can configure this
condiment to print.
You must also select 65 - Support
Enhanced Prefix Mode (Parent Only)
for the main menu item (such as a
hamburger or chicken sandwich) that
can be modified with condiments. Using
Condiment Prefixes with Menu Item Classes
contains more information about option
65.

80 - Override do not print unpriced
condiments on Guest Checks

Select this option to have condiments
with the condiment prefix always print
on guest checks and customer receipts.
Option 80 is the override of option 79 for
the unpriced condiments. If you are
using condiment prefixes (for example,
extra mayo), apply this option to the
condiment prefix menu item class.

82 - Contains Alcohol Select this option to identify menu items
containing alcohol. This setting can then
be used by integrators (via Simphony
Transaction Services Gen2) to show users
which menu items contain alcohol.

6. Click Save.

Related Topics

• Menu Item Classes

Related Topics

• Menu Item Classes

• Condiments

Print Groups
Print groups are user-defined values used to sort menu items. Print groups control
sorting on various types of print jobs including order chits, guest checks, and customer
receipts. However, it is most commonly used for order device output. You can use print
groups to:

• Sort by preparation time (items that take longer are sorted first)

• Sort by meal course (appetizers before entrees)

• Sort specific condiments last

Chapter 20
Print Groups
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• Change the print group of parent menu items

Print groups are configured for a menu item class; new menu item class records are created
with a default value of 1.

Related Topics

• Configuring Print Groups for Menu Item Classes

Configuring Print Groups for Menu Item Classes
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Double-click a menu item class to open it.

3. On the General tab, select a Print Group for the class.

When the items are set to use print groups for sorting, the items appear from lowest
group number to highest.

4. Click Save.

Related Topics

• Print Groups

Chapter 20
Configuring Print Groups for Menu Item Classes
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21
Menu Item Definitions

Menu item definitions define the menu items available within the revenue center, including:

• Screen look up (SLU) on which the menu item appears

• Menu item class to which it belongs

• Menu levels where the item is active

• Name of the item that appears on guest checks, customer receipts, order receipts, and
journals

Menu item definitions are the records that customers can order. Menu item definitions appear
on touchscreens and print on order chits, guest checks, and customer receipts. A menu item
can have up to 64 menu item definitions in a revenue center for a single menu item master.
The following figure shows the relationship between the menu item master and menu item
definitions.

When customers order menu items (configured as menu item definitions), the sale count of
the menu item master increases. This is the purpose of the menu item master record. Only
one instance of the item needs to exist in a property, but multiple menu item definitions allow
this master record to behave differently.

You can create new definitions based on an existing menu item or without using an item. You
can add menu item definitions to existing menu item master records from both table and form
view.

Related Topics

• Adding Menu Item Definition Records to Multiple Menu Item Masters

• Adding Menu Item Definition Records to a Single Menu Item Master

• Configuring Menu Item Definitions

• Allowing Users to Override Restricted Menu Item Ranges
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Adding Menu Item Definition Records to Multiple Menu Item
Masters

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Menu Item Maintenance.

2. Click Insert.

3. From the Select a task to perform drop-down list, select Add Definition to
Masters.

The drop-down list shows valid choices based on your location within the
application and your privilege levels.

4. To add definitions to a menu item master record, select the menu item master
record from the master record list.

5. To add definitions to multiple menu item master records, select one of the following
from the Range Type drop-down list:

a. Record Number or Range: Select this option if the menu item master records
to receive the definitions are not in sequential order, and then enter individual
record numbers or ranges (for example, 3, 5, 6-12).

b. Select Range: Select this option if the menu item master records to receive
the definitions are in sequential order, and then select the begin and end
items.

6. Select one of the following methods to create the new definitions:

• Use Template: Select this option to use an existing definition record as a
template for creating the new definitions, and then select the menu item
definition record to use as the template from the Template Definition field.

• Menu Item Class: Select the menu item class, and then click OK to create
new definitions from scratch (without a template).

7. Select the definitions to create for the master records from the Definitions to Add
list.

Up to 64 definitions can exist for one master record in one zone. Simphony
ignores requests to create a definition sequence for a master, if it already exists.

8. If you are using a template and you want the new definitions to inherit price
records, from the Insert Price Records drop-down list, select Inherit Prices from
Template.

9. To add new price records for the new menu item definitions:

a. From the Insert Price Records drop-down list, select Specify Prices.

b. Select the Number of Price Records to create for the definitions.

c. Enter the Price for the definitions.

Typically, you use Specify Prices when the new definitions each have only one
price record.

10. Click OK to confirm.

11. Configure the definitions. See Configuring Menu Item Definitions for instructions.

Chapter 21
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Related Topics

• Menu Item Definitions

Adding Menu Item Definition Records to a Single Menu Item
Master

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

2. Double-click a master record to open it.

3. Click the Insert icon on the toolbar.

4. From the Select a task to perform drop-down list, select Add Definition Records to
this Master.

The Master field shows the Menu Item Master to receive the new definition records.

5. From the Definitions to Add list, select the number of definitions to create for the
master.

Up to 64 definitions can exist for one master record. Simphony ignores requests to create
definitions greater than sequence number 64.

6. If the master record already has definitions configured, select an existing menu item
definition to use as a template for the new definition record from the Use Template drop-
down list.

7. (Optional) To add price records when creating the definition:

a. Select Insert Price Records.

b. If you are not using a definition template, select the Number of Price Records to
create for the definition, and then enter the default Price for the new price records.

If using a definition template, Simphony copies the price records from the template
record.

8. Click OK to confirm.

9. Configure the definitions. See Configuring Menu Item Definitions for instructions.

Related Topics

• Menu Item Definitions

Configuring Menu Item Definitions
The Major and Family Groups assigned to the corresponding Master are shown here for
reference and are generally used for filtering purposes.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

2. Double-click the menu item master record corresponding to the definition to open it.

3. Click the General tab, and then configure information for the fields described in the
following table:

Chapter 21
Adding Menu Item Definition Records to a Single Menu Item Master
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Table 21-1    Menu Item Definition Fields

Field Description

Def Sequence # If more than one definition exists for this item,
select the Menu Item (MI) Definition number to
change to another definition of this item.
For example, a Vodka menu item can have two
definitions: one appears on a SLU and prompts
for a modifier; and another as the item that is
prompted for, for instance, if a Martini requires
the type of Vodka. The definition sequence
number is the number of the definition in the
revenue center for the master record. Up to 64
definitions can exist in one revenue center for a
single Menu Item Master record.

(Optional) First Name Enter the name for the MI Definition, which
appears on the workstation, KDS Displays,
guest checks, customer receipts, and order
device output.

(Optional) Second Name Enter an alternate second name for the menu
item to use on touchscreen keys or order device
output depending on Menu Item Classes
options 18 - Print Name 2 on Order Output
instead of Name 1 and 19 - Use Name 2 on
Touchscreens instead of Name 1. Leave this
field blank to use the First Name by default.
The output to order device printers appears
double wide, showing fewer characters than
single wide output. Oracle recommends
enabling option 18 - Print Name 2 on Order
Output instead of Name 1, because only 12
characters print to order devices, but 16 are
allowed as the Definition Name.
Second Name is sometimes used when the
kitchen staff does not use the native language.
This field is also used when Order Devices
option 11 - Print Both Menu Item Names is set
for a wine order device. This allows the First
Name of the wine, while the Second Name
represents the Bin number and type of wine.

(Optional) Third Name Enter the third name for a definition to use for
search operations with the Order Menu Item
By Name 3 function key.

(Optional) Long Descriptor Enter the descriptor to print on guest checks
and receipts, below the menu item and price.

Menu Item Class Select the Menu Item Class to assign to this
definition.

Print Class Override Select the Print Class for the menu item
definition to override its menu item class
setting. Select option 0 to use the menu item
class setting.

Chapter 21
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Table 21-1    (Cont.) Menu Item Definition Fields

Field Description

KDS Prep Time Minutes Seconds
Negative

Enter the time it takes to prepare the menu
item, in Minutes or Seconds.
If the item has a negative prep time (for
example, a condiment that changer the item’s
prep time), select the Negative check box.

SLU through SLU 8 Select the relevant SLU numbers.

SLU Sort Priority If you are using SLUs, enter a SLU sort priority
number (between 1-99) for the menu item.
Use this field when Touchscreen Style
option Sort Screen Using Menu Item Sort
Priorities is set. When configured, menu items
with Sort Priority 1 appear on the screen first,
followed by menu items with Sort priority 2,
and so on up to Sort Priority 99, and then
finally Sort Priority 0 items.

(Optional) NLU Group Select the number of the NLU Group to assign
to this menu item.

(Optional) NLU Number Enter the NLU number for the menu item. Up to
12 digits are allowed.

Main Level Select the Main Levels on which the definition
is active (for example, you can use this field for
menu item sizes, such as Small, Medium and
Large, or for serving periods, such as Happy
Hour).
Click All to make the definition active on all
Main Levels. Click None to deselect all Main
Levels.

Sub Level Select the Sub Levels on which the definition is
active.
Click All to make the definition active on all
Sub Levels. Click None to deselect all Sub
Levels.

Prefix Level Override Select to allow the condiment prefix to override
the price level of the item it modifies. You must
select 65 - Support Enhanced Prefix Mode
(Parent Only) in the Menu Item Class module.

(Optional) Surcharge Enter the surcharge for the menu item, if 4 -
Surcharge is enabled in the Tax Rates module.

Tare Weight Enter the weight of the empty package for an
item that is sold by weight (for example, the
weight of the salad container at a salad bar,
where salad is sold by weight).
The Tare Weight should not be more accurate
than your scale can measure so that the
application does not round. For kilograms this
is to the thousandth 0.000, for pounds the
hundredth 0.00, and for ounces the tenth 0.0.
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Table 21-1    (Cont.) Menu Item Definition Fields

Field Description

Guest Count Enter the guest count for the menu item to
increment the check guest count when added.
For example, if a catering order consists of 2
Catering Appetizer Platters, each representing
10 guests as defined here, the guest count on
the check will be 20. You must select 11 - Add to
Guest Count in the Menu Item Class module.
This value does not affect the guest count when
8 - Use Number of Seats for Guest Count is set
in the Revenue Center Parameters module. If
the workstation operator presses the Number
of Guests key during a transaction, the guest
count no longer increments when menu items
are added to the check.

(Optional) Quantity For some menu items, you might want to assign
a quantity (greater than one) to a single MI
Definition record. For example, you could have
one MI Definition record for ½ Dozen Donuts
(whose assigned Quantity setting is 6). The
default value of the Quantity field is one (1).
The Quantity field is accessible from a MI
Definition record and then switching to Table
view. The MI Definition Quantity field also links
to and enhances the Menu Item Tax Class
Override feature. Configuring the Menu Item Tax
Class Override contains more information about
menu item tax class overriding.

(Optional) Consumer Advisory
Description

This field is meant for Simphony Transaction
Services (STS) Gen 2 users who want to provide
dietetic information to customers.
Allergen, Nutrition and Consumer Advisory
Information contains more information about
configuring these fields.

4. Click Save.

Related Topics

• Menu Item Definitions

Allowing Users to Override Restricted Menu Item Ranges
You can allow users to add, edit, and delete menu item master records, definitions,
and prices for menu item object numbers that are set as restricted in the Properties
module.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click an employee role.

3. Click the EMC Modules tab.

4. From the Menu Items section, select the Edit privilege option for Menu Item
Master Restriction.
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5. Click Save.

Related Topics

• Menu Item Definitions

Configuring Menu Tag Groups and Tags
A delivery service provider menu is a collection of Simphony menu items. Use a menu tag to
associate a Simphony menu item with the delivery provider menu. Each provider must have a
unique menu tag in Simphony. Only the menu items with these tags are visible in the delivery
provider application.

You need to have the role privilege to view, edit, add, or delete tags. Creating Employee
Roles contains more information about setting these privileges for tags in the Roles module,
EMC Modules tab.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To add a tag group:

a. Select the Enterprise level, click Descriptors, and then click Tag Groups.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag group record with the appropriate name, and then click OK.

d. Click Save.

2. To add a tag:

a. Select the Enterprise level, click Descriptors, and then click Tags.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Select the Tag Group.

e. Click Save.

3. To edit a tag:

a. Select the Enterprise level, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.

c. Click Save.

4. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise level, click Descriptors, and then click Tags.
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b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

5. To associate a tag with a menu item definition, see Associating a Menu Item
Definition with a Tag for detailed instructions.

Associating a Menu Item Definition with a Tag
Menu tags need to be added in the Tags module before associating them with a menu
item definition. Configuring Menu Tag Groups and Tags contains more information
about adding tags.

Simphony Transaction Services Gen 2 uses tags to filter and to group menu item
definitions. A menu item definition record can be associated with more than one tag.
The menu item master record must have at least one menu item definition to enable
the Tags tab in the Menu Item Maintenance module.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Menu Item Maintenance.

2. Double-click the menu item master record corresponding to the definition to open
it.

3. Click the Tags tab.

4. Click the Add link.

By default, the first tag from the Tags module appears.

5. To change the tag, click the ellipsis (…), select the new tag from the list, and then
click OK.

6. To change the tag name, click inside the Tags column and edit the text.

7. If the menu item master record has more than one menu item definition, click the
Next Def Seq link, and then click the Add link again for another tag.

8. Click Save.

Allergen, Nutrition and Consumer Advisory Information
Starting with Simphony release 19.2, administrators can configure allergen, consumer
advisory, and nutrition related menu item content in the EMC. This information can be
used in Oracle API interfaces to meet legal requirements where necessary. The
allergen, nutrition, and consumer advisory details are supported in the Simphony
Transaction Services (STS) Gen2 configuration service responses, such as self-
service kiosks or Enterprise online ordering.

The allergen, nutrition, and consumer advisory content is configured for individual
menu item definitions. Each menu item definition can have multiple allergens and
multiple nutrition entries configured. One consumer advisory description is allowed per
menu item definition.

The allergen, nutrition, and consumer advisory content is translatable. You can also
change the nutritional content unit of measure for each language translation.
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Simphony does not support the % of Daily Value or Serving Size.

Allergen

Simphony contains a fixed list of allergens (for example, eggs, fish, peanuts, and milk) in the
Allergens module at the Enterprise level. Administrators can create an allergen class using
the Allergen Classes module, and then associate allergens to an allergen class. Then the
allergen class can link to a menu item class. You can override the allergen class at the menu
item definition level.

Nutrition

Administrators can configure nutritional values (for example, calories, total fat, saturated fat,
and sodium) for each menu item definition. The nutrition information is typically found on a
packaged goods label.

The Nutrition Names module provides a pre-defined list of nutrients available at the
Enterprise level. This is a reference list used for entering nutritional details and cannot be
modified.

You can use the Nutrient Sets module, available at the Enterprise level, to create a set of
nutritional details that can be associated with a menu item definition. For example, you can
add nutritional content for a Chicken entrée to a Chicken nutrient set, with details of calories,
dietary fiber, carbohydrates, total fat and protein, and link this nutrient set to the menu item
definition for the Chicken entrée.

The Menu Item Definition module has a Nutrition tab that is used to add nutritional details
based on the defined nutrient sets. You can use the Nutrition tab to link Nutrient Sets to the
menu item definition.

Consumer Advisory

Typically, the consumer advisory description contains food safety warnings specific to
allergens. An example of a consumer advisory description is: Consuming raw or under-
cooked meats, poultry, seafood, shellfish, or eggs may increase your risk of foodborne illness.
The Consumer Advisory Description field is available in the Menu Item Definition module.

Creating Allergen Classes

1. Select the Enterprise level, click Descriptors, and then click Allergen Names.
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Figure 21-1    EMC Enterprise Descriptors Tab - Allergen Names

• The module has several pre-configured allergen names/codes.
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Figure 21-2    EMC Allergen Names Module

• The existing allergen names and codes cannot be edited or deleted; however the text
can be translated.

2. To insert new allergen names:
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a. Click the insert icon

on the toolbar.

b. After adding a record, click OK, and then click Save.

The system does not allow duplicate allergen names.

Figure 21-3    Inserting Allergen Names

3. Select the Enterprise level, click Configuration, and then click Allergen Classes.
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Figure 21-4    EMC Configuration Tab - Allergen Classes

4. Insert a new record and enter a name for the allergen class.

You can configure the Allergen Classes module from either table or form view. In table
view, if more than one allergen is selected, allergens are listed and comma separated.

Figure 21-5    Allergen Classes - Table View

5. Based on the allergy class’ name, select the allergen you want to include in the class.

You can select more than one allergen. Switch to form view by using the toggle icon on
the toolbar

, or double-click the record.

This is an example of an allergen class named Seafood. Each allergen selected here is
seafood related.
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Figure 21-6    Allergen Classes - Form View

6. Create as many allergen classes as needed, and then click Save.

7. Select the Enterprise, property, or revenue center level, click Configuration, and
then click Menu Item Classes.

8. On the General tab, assign an allergen class from the drop-down list in the
Allergen Class field, and then click Save.
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Figure 21-7    Menu Item Classes - Allergen Class Field

9. Select the Enterprise, property, or revenue center level, click Configuration, and then
click Menu Item Maintenance.

10. Search Menu Item Definition records for items you wish to assign an allergen class.

11. On the record’s General tab, select the allergen class from the drop-down list that you
want to assign to the menu item class from the Allergen Class Override field, click OK,
and then click Save.
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Figure 21-8    Menu Item Definition - Allergen Class Override Field

Configuring Nutrition Settings
To configure nutritional information for menu items:

Note:

Even though the EMC shows a pre-configured list of nutrient records, you
can only specify calorie information for Uber Eats.

1. Select the Enterprise level, click Descriptors, and then click Nutrition Names.

Figure 21-9    EMC Enterprise Descriptors Tab - Nutrition Names
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The EMC shows pre-configured nutrient records. No new nutrient records can be added
at this time. These existing nutrient names cannot be edited or deleted, but you can
translate the nutrient names in the Text column.

Figure 21-10    EMC Nutrition Names Module

2. Select the Enterprise level, click Configuration, and then click Nutrient Sets.
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Figure 21-11    EMC Configuration Tab - Nutrient Sets

3. To insert new nutrient set records, click the insert icon

on the toolbar.

Figure 21-12    Nutrient Sets - Table View

4. Enter the nutrient set name in the Name field.

5. Switch to form view by clicking the toggle icon on the toolbar

, or double-click the record. In the Nutrients section, click Add to insert and
configure nutritional information.
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Figure 21-13    Nutrient Sets - Adding Nutrients

6. In the Nutrient column, click the ellipsis (…), select the nutrient type from the drop-down
list, and then click OK. Repeat this step for each nutrient you add to the record.

Figure 21-14    Adding Items to Nutrient Sets

7. In the Unit of Measure column, select the appropriate measurable for each nutrient. The
available units are:

• Calories

• Kilojoules

• Grams

• Milligrams
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Figure 21-15    Nutrient Sets - Unit Of Measure Column

8. In the Quantity column, enter the numerical value associated with each unit of
measure type, and then click Save.

9. Select the Enterprise, Property, or Revenue Center level, click Configuration, and
then click Menu Item Maintenance.

10. Search Menu Item Definition records for items you wish to assign nutrition sets.

11. (Optional) Open a menu item definition record and enter text in the Consumer
Advisory Description text box.

The text shown in the following image contains the disclosure in the Consumer
Advisory Description field. There is a character limit of 1,024 for this field.

Figure 21-16    Menu Item Definition Record - Form View

12. Open a menu item definition record, and then select the Nutrition tab.

13. In the Nutrients section, click the Add link.
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Figure 21-17    Menu Item Definition Record - Nutrition Tab

14. In the Nutrient Set column, click the ellipsis (…), select the nutrient set from the drop-
down list, and then click OK.

Figure 21-18    Adding Nutrient Sets to a Menu Item Definition Record

15. You can add more than one nutrient set to a menu item definition record. Repeat these
steps for each menu item definition record for which you want to add nutrient sets.

Adding Nutrient Sets to menu item definition records cannot be performed from table
view. You need to manually add each Nutrient Set to each individual menu item definition
record.

16. Click Save.

Adding Dietary Labels to Menu Item Masters
To configure and add dietary labels to menu item masters:

1. Select the Enterprise or property level, click Configuration, and then click Roles.

2. Double-click the employee record, and then click the EMC Modules tab.

3. In the bulk operations list, scroll to the Dietary Labels row, and ensure the necessary
operations are selected.
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4. Click Save.

5. Select the Enterprise level, click Descriptors, and then click Dietary Labels.

6. Add dietary label records as needed. If you delete a dietary labels record, this will
in turn delete all dietary labels associated with a menu item.

The Use Template function is not supported in the Dietary Labels module.

7. Click Save.

8. Select the Enterprise level, click Configuration, and then click Menu Item
Maintenance.

9. Search for and then double-click the menu item master record, and then click the
Dietary Labels tab.

10. In the Dietary Labels section, click Add, and then click the ... button.

11. Select the dietary label for the menu item, and then click OK.

12. Repeat Steps 10 and 11 to add more dietary labels.

13. Click Save.
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22
Menu Item Prices

A menu item price is the amount charged for the sale of a menu item. In Simphony, menu
item prices are configured per menu item definition. Typically a menu item definition has one
price. However, in some cases a definition has multiple prices (for example, separate prices
for a small, medium, and large soda), or no price (common for condiments).

When multiple prices are active for the current Main or Sub Level, the workstation searches
the prices assigned to the definition starting with price sequence number 1, then price
sequence number 2, and so on. The workstation adds the first price that meets the active
level to the check. For example, based on the configuration described in the following table,
the item price is $8.00 when ordered on menu level 7, and $4.00 when ordered at any other
level. The workstation’s logic is:

• The current level of the transaction is level 5.

• Price number 1 for the item is active on level 7. Continue to the next price.

• Price number 2 for the item is active on level 0. This represents any level. The item
is $4.00.

Table 22-1    Correct Menu Prices and Levels

Price Sequence Number Price Level

1 8.00 7 - Double

2 4.00 0 - All Levels

When configuring multiple prices, you must always configure the 0 - All Levels price level as
the last price sequence number for the definition. For example, in the following table, the
configurations in the previous table are reversed.

Table 22-2    Incorrect Menu Prices and Levels

Price Sequence Number Price Level

1 4.00 0 - All Levels

2 8.00 7 - Double

The workstation’s logic is:

• The current level of the transaction is level 7.

• Price number 1 for the item is active on level 0; this includes all levels. The item is $4.00.

The item price $8.00 never becomes active because the 0 - All Levels price level is set as the
first price sequence for the definition.

Related Topics

• Configuring Menu Item Prices

• Configuring Menu Item Prices for Multiple Definitions
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Configuring Menu Item Prices
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Item Maintenance.

2. Click Search to show all menu items, and then double-click a menu item master
record.

3. Click Prices, and then click the Insert button on the toolbar.

4. From the Prices to Add field, select Price Sequence #1, enter the Default Price
for the menu item, and then click OK.

5. Configure the price record. The following table describes the price record fields:

Table 22-3    Price Record Configuration Fields

Field Description

Price Enter the menu item price amount.

(Optional) Prep Cost Enter the menu item prep cost.
This field is grayed out for properties
that have Inventory Management
enabled.

Tax Class Override To allow the menu item price to use a
different tax class than the tax class
configured for the menu item definition,
select a new tax class from the list.
If you select 0 - None, the price uses the
tax class configured for the menu item
class associated with the menu item
definition.

Service Charge Group If the price includes a service charge,
select a service charge group from the
list.

Active on Level Select the main or sub menu level in
which this price becomes active.
Select 0 - All Levels to make the price
active for all menu levels.

Effectivity Group To make the price active at a specific date
and time, select the corresponding
effectivity group from the list.

6. Click Save.

7. Repeat Steps 3 through 6 to add price definitions for the menu item.

Related Topics

• Menu Item Prices

Configuring Menu Item Prices for Multiple Definitions
You can define price records for multiple menu item definitions simultaneously.
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1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

2. (Optional) In table view, click the Definition Records tab, and then select the definitions
for which to add the new price records.

This is the most common method of adding prices to definitions.

3. Click Insert on the toolbar.

4. From the Select a task to perform drop-down list, select Add Prices to Definitions.

5. To insert the new price records to the definitions you selected in Step 2, select Selected
Records from the Range Type drop-down list.

This is the default setting if Menu Item Definitions are active in table view and you
selected at least one menu item definition before accessing the Add Menu Items dialog.
The selected records show beneath the Range Type drop-down list.

6. To insert the new price records into a range of menu item definitions:

a. Select Select Range from the Range Type drop-down list.

b. Select the first and last definition records to receive the new prices from the Begin
Range and the End Range fields respectively.

7. From the Prices to Add list, select the price sequences to add for each menu item
definition selected, and then enter the Price.

Simphony ignores requests to create the same price sequence for a definition multiple
times and requests to create prices greater than sequence number 8. For example, if a
definition already has six prices and you choose to add three prices, Simphony does not
create price 9.

8. Select the Menu Level in which the new price records become active, and then click OK.

Prices are active on either the sub level or the main level, as dictated by the Menu Item
Definition's class.

Related Topics

• Menu Item Prices
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23
Menu Levels

Simphony uses menu levels to:

• Determine which sales items (Menu Items, Discounts, Service Charges, Tender/Medias)
are available in a transaction.

• Allow different prices for one menu item.

A main menu level and a sub menu level are always active. You can determine which levels
are active by default (using the menu level hierarchy) and allow workstation operators to
change the levels during a transaction using a function key or menu level pop-ups. You can
also configure the status bar in the upper or lower area of the workstation to show main and
sub level names that are active.

Auto Menu Level

You can set the main menu level, sub menu level, or both to change automatically at a
specific time of day. This configuration is called auto menu level, and controls the availability
of sales detail items. For example, a revenue center can offer an Early Bird Special (Burgers
are $5.00) every weekday from 3:00 p.m. to 6:00 p.m. For the Early Bird Special to
automatically occur, you can set an auto menu level from 3:00 p.m. to 6:00 p.m. Monday
through Friday. Set menu item definitions with multiple prices accordingly (one price for the
Early Bird level and another general price).

If you configure auto menu levels to overlap, menu levels become active based on the order
in which you set the auto menu levels. After the workstation determines that one level is
active, it does not look at the other auto menu levels. Therefore, you must pay special
attention when configuring multiple auto menu levels that occur on the same days at the
same times.

According to the configuration in the following table, at 3:00 p.m. the main level become 2 -
Early Bird, and at 4:00 p.m. the main level becomes 3 - Free Drinks. This occurs because the
Free Drinks level is set at auto level 1, and starts after Early Bird, which is set at auto level 2.

Table 23-1    Example of Correct Auto Menu Levels

Numb
er

Main Level Start Time End Time Days Active

1 3 - Free Drinks 16:00 17:00 Monday–Friday

2 2 - Early Bird 15:00 18:00 Monday–Friday

The workstation’s logic for these two menu levels is explained in the following table.

Table 23-2    Workstation Logic

Time Logic

15:00 Is auto level 1 active? No
Is auto level 2 active? Yes. Active main level is 2 - Early Bird
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Table 23-2    (Cont.) Workstation Logic

Time Logic

16:00 Is auto level 1 active? Yes. Active level is 3 - Free Drinks

17:00 Is auto level 1 active? No
Is auto level 2 active? Yes. Active main level is 2 - Early Bird

18:00 Is auto level 1 active? No
Is auto level 2 active? No
The main level is 1 - Regular, which is the default menu level
for the revenue center

Menu Level Hierarchy

The following menu level hierarchy determines which setting controls the default
transaction menu levels:

Table 23-3    Menu Level Hierarchy

Num
ber

Enterprise Management Console (EMC)
Configuration

Description

1 Serving Periods If the active serving period has a main
or sub level that is not 0, that is the
active main or sub level.

2 Auto Menu Levels table If the time of day falls during an active
auto menu level, the main or sub level
that is specified for that auto menu
level is the active level.

3 Transaction Menu Level Defaults If the main or sub level set in the RVC
Parameters module is not 0, that is the
active main or sub level.

4 Main 1 and sub 1 are always defaults If the other hierarchy rules have not
been met, the workstation defaults to
main level 1 and sub level 1.

Menu Level Configuration Tasks

Setting up menu levels consists of completing the following tasks:

• Set up main, sub, and custom menu levels

• Configure the default main and sub levels for serving periods

• Configure auto menu levels

• Configure the default menu levels for a revenue center

• Configure the active menu levels for menu item definitions, prices, discounts,
service charges, and Tender/Media

• Configure the functionality of menu items at the workstation

Related Topics

• Setting Main, Sub, and Custom Menu Levels

• Setting the Default Main and Sub Levels for Serving Periods
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• Configuring Auto Menu Levels

• Setting the Default Menu Levels for a Revenue Center

• Configuring Active Menu Levels for Menu Item Definitions and Prices

• Configuring Menu Items

Setting Main, Sub, and Custom Menu Levels
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Level Sets.

The Type column specifies whether the Menu Level Set refers to the Main Levels, the
Sub Levels, or to the levels defined within the record. Main Levels and Sub Levels are
not configured in this module. However, you can create an entry for the entire Main Level
Set and Sub Level Set in this module; this allows you to configure the Options and
Default Master Group fields for Main and Sub levels.

2. To create a custom menu level, insert a new record, and then enter a custom level set
name.

3. To define main menu levels, double-click Main.

4. To define sub menu levels, double-click Sub.

5. To define menu levels for a custom level set, double-click the new custom level that you
created in Step 2.

6. Select the appropriate options:

a. To change the menu level to the default level when the workstation operator presses
a touchscreen button corresponding to any menu level in this menu level set again,
select 1 - Pressing level key again reverts to default level.

b. If the menu level set is bound to a Default Master Group and you want the POS client
to switch the active parent menu item when the active menu level changes, select 2 -
Bound to parent.

7. (Optional) Select the Default Master Group for the menu level set.

This field is used for conversational ordering. If a Default Master Group is assigned, when
a Menu Level in this group is pressed, Simphony determines which item from the
selected Menu Item Group (if any) to apply to the check.

8. In the Menu Level Entries section, define the menu levels.

You can use Menu Levels to specify menu item sizes, such as Small, Medium, and
Large, and serving periods, such as Happy Hour.

9. (Optional) Enter the Prefix or Suffix for each menu level to show on the check detail
area and print on guest checks and customer receipts.

10. To define a menu level as the default level for the menu level set:

a. In the Options column, click the ellipsis point (...) button adjacent to the default menu
level.

b. Select 1 - Default, and then click OK.

11. To define a menu level as an anonymous level for the menu level set:

a. In the Options column, click the ellipsis point (...) button adjacent to the anonymous
menu level.
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b. Select 2 - Anonymous, and then click OK.

The Default and Anonymous menu levels are generic, and are typically used
with $0.00 priced menu item definitions that have names such as [SIZE] Hot Drink
or [TEMP] Drink.

12. Click Save.

Related Topics

• Menu Levels

Setting the Default Main and Sub Levels for Serving Periods
1. Select the revenue center, click Configuration, and then click Serving Periods.

2. Double-click a serving period record.

3. On the General tab, select the Default Main Level, and then select the Default
Sub Level.

4. Click Save.

Related Topics

• Menu Levels

Configuring Auto Menu Levels
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Auto Menu Levels.

2. In the Start column, enter the time at which the menu level becomes active.

3. In the End column, enter the time at which the menu level becomes inactive.

4. Select the Main Level, and then select the Sub Level.

5. Click the ellipsis point (...) button from the Options column.

6. Select 1 - This Entry is Active, and then select one or more of the following
options that correspond with the days that the menu level becomes active:

• 2 - Active On Sunday

• 3 - Active On Monday

• 4 - Active On Tuesday

• 5 - Active On Wednesday

• 6 - Active On Thursday

• 7 - Active On Friday

• 8 - Active On Saturday

7. Click Save.

Related Topics

• Menu Levels
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Setting the Default Menu Levels for a Revenue Center
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. On the General tab, select the Default Main Level, and then select the Default Sub
Level.

The values configured in the Default Main Level and the Default Sub Level fields are
available in the Serving Periods module. Configuring a Serving Period contains more
information.

3. Click the Options tab, and then set the main and sub menu levels as follows:

• To set the workstation to remain at the current main menu level after completing a
transaction, select 23 - Retain Current Main Level after a Transaction.

• To set the workstation to remain at the current sub menu level after completing a
transaction, select 24 - Retain Current Sub Level after a Transaction.

4. Click Save.

Related Topics

• Menu Levels

Configuring Active Menu Levels for Menu Item Definitions and
Prices

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

2. Search for and then double-click a menu item master record.

3. If the menu item has multiple definitions, select a definition, and then click the General
tab.

4. From the Menu Level Availability section, select the active main and sub levels for the
item.

5. To set the menu item definition as active on all menu levels, click All.

6. To set the menu item definition as active on a custom menu level:

a. Click Menu Levels Tab, select a Menu Level Set, and then select the menu levels.

b. To set the definition as active on all custom levels, select Active on All Levels.

7. If the menu item has multiple price records click Prices, and then select the Active Menu
Level for each price definition.

When menu items are assigned to a class which uses sub level pricing (Menu Item Class
option 10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing is set),
Simphony lists sub levels.

8. Click Save.

Related Topics

• Menu Levels

Chapter 23
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Configuring Active Main or Sub Level Pricing for Current Round
When using the Change Price Level feature, you can also change the active main or
sub level pricing for the current round (transaction) only. This allows the active menu
(price) main or sub level to be maintained for the current round so that further menu
items are priced at the same price level.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Options tab, and then select the following:

• 71 - Change Price Main Level sets active Main Level: Select this option to
set the active Main Level for the current round after using Change Price Main
Level.

• 72 - Change Price Sub Level sets active Sub Level: Select this option to set
the active Sub Level for the current round after using Change Price Sub Level.

3. Click Save.
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24
Sales Itemizers

Sales itemizers are used with PMS postings and other third-party interfaces. When the
workstation operator adds items to a check, Simphony maintains various subtotals, known as
itemizers, in the background. An itemizer is a bucket where totals accumulate. Simphony
uses sales itemizers to separate menu item sales into categories such as food, beverage,
and merchandise. You can configure up to 16 sales itemizers, which can output in the
Summary Totals section of a guest check or customer receipt in lieu of the Subtotal.

Configuring Sales Itemizers
1. Select the Enterprise level, click Descriptors, and then click Sales Itemizers.

2. In the Text column, enter the names for each descriptor.

3. Click Save.
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25
Screen Look Up (SLU)

A screen look up (SLU) is used to organize items, making it easier for workstation operators
to find specific items on the workstation. A SLU is a system-generated screen that is created
when a workstation operator selects a SLU button.

The following figure shows an example of a menu item touchscreen without SLUs.

Figure 25-1    Menu Item Touchscreen Without SLUs

The next figure shows an example of a menu item touchscreen with SLUs. After selecting
Apps, only the menu items associated with appetizers appear on the screen.
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Figure 25-2    Menu Item Touchscreen With Appetizer SLUs

The third example shows a menu item touchscreen with Soup and Salad SLUs. After
selecting Soup and Salad, only the menu items associated with soup or salad appear
on the screen.

Chapter 25
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Figure 25-3    Menu Item Touchscreen With Soup and Salad SLUs

Typically menu item buttons are not added directly to a touchscreen, but instead menu items
are usually linked to SLUs.

SLUs are efficient; after setup, there is no need to go to the Page Design module to link new
items as all linking is done at the item level. SLUs also manage screen paging automatically;
if the SLU items exceed the space allotted on a touchscreen display, up and down navigation
keys automatically appear. You can define the sort method (alphabetical or by object number,
or an optional sort priority can advance an item to the top of the list), background and font
color, font size, and grid layout (number of columns and rows).

You can configure screen look ups for the following:

• Menu Items

• Discounts

• Service Charges

• Family Groups

• Major Groups

• Custom Reports

• Open Checks

Chapter 25

25-3



Creating Screen Look Ups for Menu Items
You can assign each menu item definition to a maximum of eight different SLUs in
table view of the Menu Item Maintenance module. Assigning multiple SLUs to a menu
item allows flexibility in building POS client pages that are customized to use dine in,
carry out, and curbside to go, and shows the menu items supported by the order type.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and
then click Menu Item.

2. Insert a new record, enter a name for the menu item screen look up (for example,
DinnerCarryOut) in the Record Name field, and then click OK.

3. Repeat step 2 to add more SLUs, and then click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Menu Item Maintenance.

5. To assign a SLU, click the ellipsis point (...) button adjacent to the menu item First
Name, select the SLU, and then click OK.

To assign another SLU to the menu item, select the SLU from the SLU 2 column.
You can assign up to eight SLUs per menu item. Duplicate SLUs do not appear on
the same workstation page.

6. (Optional) To assign a SLU sort priority:

a. Double-click a menu item, and then click General.

b. Select the relevant SLU from the Touchscreen Properties section.

Use the SLU 2, SLU 3, and so on for multiple SLUs.

c. Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Page Design Layout option, Use Sort Priority, is enabled
from the Screen Lookup settings.

When SLU Sort Priority is used, menu items with Sort Priority 1 appear on
the screen first, followed by menu items with Sort priority 2, and so on up to
Sort Priority 99, and then finally Sort Priority 0 items. (Priority 0 means “Do not
sort”; items with 0 appear at the end of the list.) Typically the most popular
menu items have Sort Priority 1 for easy access. Items in the same SLU can
belong to the same Sort Priority.

Chapter 25
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Figure 25-4    Page Design Screen Lookup (SLU) Layout Settings

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Menu Item from the Type drop-down list, select SLU as the Property, and then
select the menu item screen lookup as the Value.

11. Select the Menu Item Display Name, and then click Save.

12. If the revenue center uses hand held POS client devices:

a. Select Dynamic SLU as the Property, and then select a menu item screen look up
group as the SLU Value.

b. Enter a non-zero value for the Visual State(s).

Chapter 25
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The application uses the Visual State value to link menu item screen look ups
with their corresponding Visual State buttons, which workstation operators use
to change the menu items that appear in the Dynamic SLU.

c. To add more screen look ups to the Dynamic SLU, click Add.

d. Select the Menu Item Display Name, and then click Save.

e. Insert buttons for each screen look up that you added to the Dynamic SLU.

For example, if you added five screen look up groups to the Dynamic SLU,
insert five buttons.

f. Select Function from the Type drop-down list, and then select Visual State
from the Function list.

g. In the Arguments field, enter the Visual State value that you assigned to a
screen look up group in Step 12-b.

h. Click Save.

Configuring Screen Look Ups for Discounts
1. Select the Enterprise, property, or zone, click Descriptors, and then click

Discount.

2. Enter names for discount screen look up groups in the Text column, and then click
Save.

3. Select the Enterprise property, or zone, click Configuration, and then click
Discounts.

4. Double-click a record, and then click NLU/SLU.

5. Select the relevant SLU for the discount, and then click Save.

6. Repeat Steps 3 through 5 for all discounts to appear in screen lookups.

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear
on the workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Discount from the Type drop-down list, and then select the discount
screen lookup from the Value drop-down list.

11. Click Save.

Configuring Screen Look Ups for Service Charges
1. Select the Enterprise property, or zone, click Descriptors, and then click Service

Charge.

2. Enter names for service charge screen look ups in the Text column.

3. Click Save.

4. Select the Enterprise property, or zone, click Configuration, and then click
Service Charges.

5. Double-click a record, and then click NLU/SLU.
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6. Select the relevant SLU for the service charge.

7. Click Save.

8. Repeat Steps 4 through 7 for all service charges to appear in screen lookups.

9. Select the Enterprise, property, revenue center, or zone, click Configuration and, and
then click Page Design.

10. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

11. Click Other in the Page Design toolbar, and then click Sales SLU.

12. Select Service Charge from the Type drop-down list, and then select the service charge
screen lookup as the Value.

13. Click Save.

Configuring Menu Item Screen Look Ups by Family Group
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

3. Click Other in the Page Design toolbar, and then click Sales SLU.

4. Select Menu Item from the Type drop-down list, select Family Group as the Property,
and then select the family group to show in the screen look up as the Value.

5. Select the Menu Item Display Name.

6. Click Save.

Configuring Menu Item Screen Look Ups by Major Group
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

3. Click Other in the Page Design toolbar, and then click Sales SLU.

4. Select Menu Item from the Type drop-down list, select Major Group as the Property,
and then select the major group to show in the screen look up as the Value.

5. Select the Menu Item Display Name.

6. Click Save.

Configuring Menu Item Screen Look Ups by Menu Item Master
Group

You can assign a Menu Item Master Group to a SLU, which is applied to a workstation page.
This feature is useful with conversational ordering as it enables easy addition to the page
without hard coding individual menu items on the page. The system automatically generates
the Master Group SLU button on the page.
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1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and
then click Menu Item Master Group SLU Names.

2. Enter names for menu item master group screen look ups in the Text column.

3. Click Save.

4. Select the Enterprise, property, or zone, click Configuration, and then click Menu
Item Master Groups.

5. Select the SLU assignment for each Menu Item Master Group.

You can assign a maximum of 32 Menu Item Master Group SLUs.

6. Click Save.

7. Select the Enterprise, property, revenue center, or zone, click Configuration and,
and then click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear
on the workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Master Group from the Type drop-down list, select SLU as the Property,
and then select the menu item master group to show in the screen look up as the
Value.

The Value drop-down list shows the menu item master group screen look up
names that you created in Step 2.

11. Select the Menu Item Display Name.

12. Click Save.

Related Topics

• Conversational Ordering

Configuring Screen Look Ups for Custom Reports
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Double-click the transaction page on which you want the screen look up to appear
on the workstation.

3. Click Other in the Page Design toolbar, and then click Sales SLU.

4. Select Custom Report from the Type drop-down list.

5. Click Save.

Configuring Screen Look Ups for Open Checks
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Double-click the transaction page on which you want the screen look up to appear
on the workstation.

3. Click Other in the Page Design toolbar, and then click Check SLU.

4. In the Show Checks For drop-down list, select one of the following:
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• All Employees: Select this option to set the SLU to show open checks belonging to
all employees.

• Currently Signed In Employee: Select this option to set the SLU to show open
checks belonging to only the employee who is signed in.

5. Select the type of open checks to appear on the SLU:

Table 25-1    Open Check Options

Open Check SLU Option Description

All Checks Select this option to show all open checks.

Autofire Checks Only Select this option to show only open checks
that are configured to send to order devices
at a preset time.

All Except Autofire Checks Select this option to hide open checks that
are configured to send to order devices at a
preset time.

Checks with Held Items Only Select this option to show only open checks
with items on hold.

All Except Checks with Held Items Select this option to hide checks with items
on hold.

All Except Autofire and Checks with Held
Items

Select this option to hide open checks with
items on hold and checks that are configured
to send to order devices at a preset time.

Autofire Checks with Held Items Only Select this option to show only open checks
that are configured to send to order devices
at a predefined time and have items on hold.

6. In the Sort Order drop-down list, select the primary sort criteria for the SLU. Selecting a
Sort Order option in the Page Design module simplifies SLU sorting configuration in the
EMC.

Table 25-2    Open Check Sort Order Options

Open Check SLU Sort Order Option Description

Check Open Time Select this option to show open checks in the
order in which they are created (opened) in
the check SLU. The earliest time is shown
first. This option is the default sort order.

Table Name Select this option to sort open checks started
with a table name or number in
alphanumeric order in the check SLU.
Checks without table names or numbers
appear first before table name/number
checks.
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Table 25-2    (Cont.) Open Check Sort Order Options

Open Check SLU Sort Order Option Description

Service Total Time Select this option to sort open checks in the
order in which they are service totaled. The
earliest service total time is shown first.
This is useful for drive thru operations
where checks are ordered in the same
sequence as cars entering the drive thru.
Workstation operators are able to pick up
checks quickly and service guests efficiently
with their drive thru orders.

Sort Order Overrides:

When options 65 - Sort Check SLU by Table Name (in the RVC Parameters
module) or 23 - Sort Check SLU by Table Name (in the Employee Classes
module or the Employee Maintenance module (Operator Records tab)) are
enabled, these options override the check SLU Sort Order set here in the Page
Design module (described in the preceding table). When options 65 or 23 are
enabled, the Page Design setting is the secondary sort order when no table name/
number is used.

Sort Order Exceptions:

• When Table Name sort order is enabled, checks using a Check Name (ID),
where the name or ID is a customer reference, are shown first in the Check
SLU in alphabetical order so they can be easily identified.

• Autofire (future) checks are listed at the end of the check SLU, irrespective of
the sort order setting, and follow regular checks chronologically sorted by
scheduled fire date/time.

7. To show only open checks that belong to specific order types (for example, Dine-in
or Take Out), select one or more Order Types, and then click Add.

8. Click Save.
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26
Number Look Up (NLU)

A number look up (NLU) is a touchscreen button that allows workstation operators to access
a numbered list of items. The workstation operator can select one of the following items or
enter the relevant NLU number to apply the item to the transaction:

• Discounts

• Main Levels

• Menu Items

• Service Charges

• Sub Levels

• Tender/Media

Note:

Payment tenders are not supported for use with NLUs.

To show an item in NLU, you must configure a valid NLU number greater than zero (0) for the
item. You can intentionally assign duplicate NLU numbers. If this occurs, the workstation
applies the lowest numbered record (by object number) to the check.

When showing discounts, service charges, and tender/media records, the workstation takes
the active menu level of the transaction into consideration. For example, Chardonnay has 3
definitions used: 4-ounce pour (small), 6-ounce pour (medium), and carafe (large). All three
definitions are configured with NLU 23. The workstation operator selects the Small, Medium,
or Large Menu Level and the 23 menu item NLU to get the desired Chardonnay.

Configuring Number Look Ups for Discounts
1. Select the Enterprise or property, click Configuration, and then click Discounts.

2. Double-click a record, and then click NLU/SLU.

3. Enter a unique NLU number for the discount.

You can enter a value between 1 and 255.

4. Click Save.

5. Repeat Steps 2 through 4 for all discounts to appear in the number look up.

6. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

7. Double-click the transaction page on which you want the number look up to appear on
the workstation.

8. Insert a new button, select Function from the Type drop-down list, select Discount NLU
from the Function list, and then click OK.
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9. Click Save.

Configuring Number Look Ups for Service Charges
1. Select the Enterprise or property, click Configuration, and then click Service

Charges.

2. Double-click a record, and then click NLU/SLU.

3. Enter a unique NLU number for the service charge.

You can enter a value between 1 and 255.

4. Click Save.

5. Repeat Steps 2 through 4 for all service charges to appear in the number look up.

6. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

7. Double-click the transaction page on which you want the number look up to
appear on the workstation.

8. Insert a new button, select Function from the Type drop-down list, select Service
Charge NLU from the Function list, and then click OK.

9. Click Save.

Configuring Number Look Ups for Tender/Media Records
Simphony does not support the use of payment tenders through NLU in POS
Operations. If a workstation operator attempts to use the Tender/Media NLU function
key as a payment tender with a NLU value set, a “Tender/Media not found” error
appears in POS Operations. Workstation operators can use the same payment tender
without error if it is configured as an individual payment tender button via the Page
Design module; administrators must assign a special type of payment button in the
Page Design module in order to configure the payment configuration arguments.

1. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

2. Double-click a record.

3. Enter a unique NLU number for the tender/media record.

You can enter a value between 1 and 255.

4. Click Save.

5. Repeat Steps 2 through 4 for all tender/media records to appear in the number
look up.

6. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

7. Double-click the transaction page on which you want the number look up to
appear on the workstation.

8. Insert a new button, select Function from the Type drop-down list, select Tender/
Media NLU from the Function list, and then click OK.

9. Click Save.
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Configuring Number Look Ups for Main and Sub Levels
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Double-click the transaction page on which you want the number look up to appear on
the workstation.

3. Insert a new button, select Function from the Type drop-down list, select either Main
Level NLU or Sub Level NLU from the Function list, and then click OK.

4. Click Save.

Configuring Number Lookups for Menu Items
You can create NLUs for retail menu items (for example, bottled wine, t-shirts, and hats).

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

2. Double-click a menu item, and then click the General tab.

3. Select the relevant NLU Group from the Number Lookup Properties section.

4. Enter a unique NLU Number for the menu item. Up to 12 digits are allowed

5. Click Save.

6. Repeat Steps 2 through 5 for all menu items to appear in the number look up.

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the number look up to appear on
the workstation.

9. Insert a new button, select Function from the Type drop-down list, select Menu Item
NLU from the Function list, and then click OK.

10. Click Save.

Configuring NLU Groups
An NLU Group contains menu items that workstation operators can scan with a barcode
scanner to look up items.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
NLU Names.

2. In the Text field, enter the NLU Group name (for example, Barcode Items).

You can configure up to 32 NLU Groups.

3. Click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

5. Select a menu item record (for example, potato chips).

6. Select the NLU Group to associate with the menu item.
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7. Enter the NLU number or barcode value in the NLU Number field.

8. Repeat Steps 5 through 7 for each menu item that associates with an NLU Group.

9. Click Save.
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27
Weighed Menu Items

A weighed menu item is measured in ounces, pounds, or kilograms and is priced per unit of
measurement (for example, lobster is sold by the pound). You can measure the weight
manually or automatically. The workstation calculates the price regardless of the weight entry
method.

• Manual: The workstation operator is prompted to enter the weight of the item if the scale
is not connected.

• Automatic: A scale attached to a workstation can automatically calculate the weight of the
item.

Tare weight is the weight of a container or wrapper that is deducted from the gross weight to
obtain the net weight. For example, in a restaurant with a salad bar where salad is sold by
weight, the customer should not be charged for the weight of the container. To prevent this, a
tare weight is configured for the salad menu item, and the weight of the salad’s container is
automatically subtracted from the weight of the salad.

The weight and tare weight (if set) appear for a weighed menu item on guest checks and
customer receipts. The weight formatting meets the United States Department of Agriculture
Weights and Measures requirements for scale certification. The weight is determined by the
Unit of Measure (UOM) as follows:

• Kilograms: 0.000

• Pounds: 0.00

• Ounces: 0.0

The UOM must match in the Enterprise Management Console (EMC) configuration and on
the scale setting. For example, the scale must measure in ounces and EMC must be set to
use ounces.

Related Topics

• Setting the Tare Weight for a Menu Item

• Configuring a Weighed Menu Item

• Configuring a Scale

Configuring a Weighed Menu Item
There are two methods of configuring a weighed menu item. You can use one of the
following:

1. Assign the menu item to a menu item class that has option 15 - Weighed Items set.

2. Configure a Tare Weight for the menu item definition. See Setting the Tare Weight for a
Menu Item for more information.

Related Topics

• Weighed Menu Items
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Setting the Tare Weight for a Menu Item
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Item Maintenance.

2. Click Search to show all menu items, and then double-click a menu item master
record.

3. Click the Definition Records tab in the lower area of the screen.

4. In the Tare Weight field, enter the weight of the empty package for an item that is
sold by weight (for example, the weight of the salad container at a salad bar,
where salad is sold by weight).

The Tare Weight should not be more accurate than your scale can measure so
that the application does not round. For kilograms this is to the thousandth 0.000,
for pounds the hundredth 0.00, and for ounces the tenth 0.0.

5. Click Save.

6. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Control Parameters.

7. Click the Options tab, and then select 13 - Convert Weight to System Unit of
Measure.

You must set this option in the United States to comply with the Department of
Agriculture Weights and Measure requirements. Setting this option allows the POS
client to convert the item weight to the property’s UOM if the UOM received from a
scale does not correspond to the UOM set from the Property Parameters module.

8. Click Save.

Related Topics

• Weighed Menu Items
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28
Menu Item Waste

Menu Item Waste describes menu items that are not sold to customers due to reasons such
as spillage, spoilage and quality standards. Menu Item Waste also includes menu items that
are donated (for example, to soup kitchens, employee parties, or used for photo shoots).
There are three main characteristics of a menu item waste check:

• Does not post to sales

• Deplete inventory

• Service Total and Print functions close a waste check

When menu item waste occurs, authorized workstation operators can begin a menu item
waste check and then enter menu items to waste or donate. Managers can generate waste
reports by revenue center, menu item, employee, and waste reason. Depending on the
reasons for waste, managers can take action to reduce inventory loss. You can differentiate
waste checks from other checks in the Employee Journal Report and the Check Journal
Report by the Waste Check banner on the check header.

The following table lists the functional differences between menu item waste checks and
guest checks.

Table 28-1    Differences Between Waste Checks and Guest Checks

Function Menu Item Waste Checks Guest Checks

Kitchen Display Systems (KDS)
or screen lookups display the
check

No Yes

Reopen a closed check No Yes

Apply discounts No Yes

Apply taxes No Yes

Apply service charges No Yes

Apply guest count No Yes

Return item No Yes

Edit seat No Yes

Split check No Yes

Gift card or credit card
operations

No Yes

Send and Stay No Yes

Hold and Fire No Yes

Transaction void No Yes

Transaction return No Yes

Menu item availability No Yes

Complete the following tasks to configure the Menu Item Waste feature:
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• Configure employee privileges to begin waste checks and run waste check reports

• Define reasons for menu items declared as waste

• Configure waste receipt headers and trailers

• (Optional) Hide price details on waste checks

• Add a Declare Waste button to the touchscreen page

Allowing Employees to Begin Waste Checks and Run Waste
Reports

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, and then click the Operations tab.

3. To allow employees associated with this role to begin waste checks and to
authorize other employees to begin waste checks, select 263 - Authorize/Begin
Menu Item Waste Check.

4. Select the appropriate report privileges as described in the following table:

Table 28-2    Menu Item Waste Report Privileges

Privilege Name Allows the Employee to ...

31062 - Run Employee Waste Report Run the Employee Waste Report from the
workstation.

31063 - Run Menu Item Waste Report Run the Menu Item Waste Report from
the workstation.

31064 - Run Waste Summary Report Run the Waste Summary Report from the
workstation.

31065 - Run Waste Detail Report Run the Waste Detail Report from the
workstation.

5. Click Save.

Configuring Waste Reasons
1. Select the Enterprise level, click Descriptors, and then click Void/Return/Waste

Reasons.

2. To add a new waste reason, enter a waste reason in an empty row of the Text
column, and then select 2 - Use for Waste in the Options column.

3. To use an existing void or return reason as a waste reason, select 2 - Use for
Waste in the Options column adjacent to the void or return reason.

The options work independently of each other; you can set one, both, or none.

4. Click Save.

Configuring Waste Receipt Headers and Trailers
When you post a waste check, the guest check printer assigned to the workstation
prints a waste receipt.
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1. Select the Enterprise level, and then click Descriptors.

2. Select one of the following options, depending on whether you want to configure receipt
headers or trailers:

• Waste Receipt Headers

• Waste Receipt Trailers

3. Perform one of the following actions:

• Enter text for the header or trailer in the rows of the Text column.

• Select a check box in the Use Logo column, and then select a logo using the ellipsis
point (...) button in the Logo column.

4. Click Save.

Hiding Price Details on Waste Checks
A waste check measures the cost of wasted inventory as opposed to a guest check that
posts the prices of menu items to the sales totals.

Complete these steps if you do not want to show prices of waste menu items in the check
detail area of the workstation screen or print prices on waste receipts.

1. Select the Enterprise level, click Setup, and then click Format Parameters.

2. Click the Options tab, and then select 56 - Do not display/print price for Waste.

3. Click Save.

Creating the Declare Waste Button
To declare waste, you need to add the Declare Waste function key to a page.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Open the Front of House page on which to place the Declare Waste button.

3. On the Edit tab, select the page area in which to define the Declare Waste button.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, and then select Declare
Waste.

8. Highlight the Declare Waste button.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.
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29
Menu Item Refills

Refills is a function that provides workstation operators the ability to reorder menu items from
the previous round of a check to the current round, free of charge. It is ideal for occasions
such as an all-you-can-eat buffet where customers can reorder menu items for free until the
refill limit of the menu item is reached.

When a menu item with a condiment is refilled, the condiment retains its cost for the
restaurant, while the sales price of the parent menu item shows a zero amount.

To control costs, only one refill is enabld for each parent menu item per service round.

Related Topics

• Allowing Employees to Refill Menu Items

• Making Menu Items Refillable and Configuring the Refill Limit

• Adding Refill Buttons

Allowing Employees to Refill Menu Items
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type record (for example, administrator, manager or server).

3. Click the Operations tab, click the Transactions subtab, and then select 186 - Perform
Menu Item Refills.

4. Click Save.

Related Topics

• Menu Item Refills

Making Menu Items Refillable and Configuring the Refill Limit
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Double-click a menu item class to open it.

3. Click the Options tab, and then select 72 - Enable Refill.

4. Click the General tab, and then enter maximum number of refills customers can order in
the Maximum Refill Count field. The maximum refill count is 99.

5. Enter a label (for example, Refill) to identify refill items on printed order chits in the
Refill Descriptor field. Up to 12 characters are allowed.

6. Click Save.

7. Repeat Steps 2 through 6 for all menu item classes that are refillable.

Related Topics

• Menu Item Refills
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Adding Refill Buttons
In order for workstation operators to initiate refills for customers, you must configure
touchscreen buttons for the refill function. There are two types of refill functions.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the refill buttons.

3. On the Edit tab, select the page area in which to define the buttons.

4. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

5. Click the black arrow directly beneath the Type drop-down list, and then select
Transaction from the Type pane.

6. Select one of the following function keys, and then click OK:

• Refill Auto: Shows a list of refillable items on the check for selection.

• Refill Interactive: Refills only the parent menu item and allows the
workstation operator to select required and allowed condiments as necessary.
Only one menu item is refillable at a time using this function.

7. Enter a Legend for the button (for example, Refill), and then position and size
the button on the page.

8. Repeat Steps 4 through 7 and create a button for the remaining Refill function.

9. Click Save.

Related Topics

• Menu Item Refills
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30
Condiments

Condiments typically provide details to the cook preparing the menu item, such as a rare
steak and salad dressing. Other examples of condiments include tomatoes, onions, and
pickles. In Simphony, enhanced condiment prefixes include the words extra, add, substitute,
and without.

Setting up condiments consists of completing the tasks listed in the following table:

Table 30-1    Condiment Configuration Tasks

Task More Information

Create condiment groups Configuring Condiment Groups

Create menu item classes for the condiment
groups

Creating Menu Item Classes for Condiment Groups

Create menu item master records for
condiments and assign to condiment classes

Creating Menu Item Master Records for
Condiments

Create condiment sets and assign condiments Configuring Condiment Sets

Assign condiments to parent menu item
classes

Assigning Condiments to Parent Menu Item
Classes

Assign default condiments to parent menu
items

Assigning Default Condiments to Parent Menu
Items

Create condiment prefixes Configuring Condiment Prefixes

Configure additional settings for condiment
appearance on workstations, guest checks,
and customer receipts

Setting Condiment Appearance

Related Topics

• Configuring Menu Item Classes

Condiment Groups and Condiment Sets
A condiment set defines the condiments that accompany the parent menu item. For example,
a condiment set for a bacon cheeseburger includes the following condiments:

• Bacon

• Cheddar Cheese

• Mayonnaise

• Lettuce

• Ketchup

A condiment group defines the category to which a condiment set belongs and dictates its
behavior.
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Related Topics

• Configuring Condiment Groups

• Creating Menu Item Classes for Condiment Groups

• Creating Menu Item Master Records for Condiments

• Configuring Condiment Sets

• Assigning Condiments to Parent Menu Item Classes

• Assigning Default Condiments to Parent Menu Items

• Setting Condiment Appearance

Configuring Condiment Groups
1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and

then click Condiment Group Names.

2. Enter condiment group names (for example, Meat Group or Cheese Group) in the
Text field.

3. Click Save.

Related Topics

• Condiment Groups and Condiment Sets

Creating Menu Item Classes for Condiment Groups
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Item Classes

2. Insert a new record, enter the class name, and double-click the new record.

3. On the General tab, select the Condiment Order Type from the drop-down list.

This setting describes how the condiment is added to a check when it is ordered:

• 0 - Add: Select to create a new item on the check even if it already exists for
that parent.

• 1 - Increment: Select to add the item if it does not exist for the parent or
increments an existing one.

• 2 - Replace In Condiment Group: Select to remove any items that exist in
the item’s member condiment group before adding it (this simulates a radio
button effect).

• 3 - Replace In Master Group: Select to remove any items that exist in the
item’s master group are before adding it.

• 4 - Toggle: Select to toggle the item on and off.

4. Click the Options tab, and then select 2 - ON = Condiment Menu Items; OFF =
Regular Menu Items.

When you select this option, Simphony updates the Type column in table view to
Condiment for this menu item class. For a menu item to be a condiment, it must
belong to a class where at least one Member Condiment Group is enabled.
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5. To set no charge for the condiments in this class, select 8 - Allow Menu Items in this
Class to be Non-Priced.

To prevent a condiment from printing on the guest check and customer receipt if it does
not have an associated price, see Configuring Menu Item Classes, specifically option 79 -
Do not print unpriced condiments on Guest Checks.

6. To set each condiment in this class to print to a specific order device, select 22 - ON =
Use Own Output Link; OFF = Use Parent's (Condiments Only).

By default, the ideal setup of a condiment group class is to keep this option deselected
and to select all order devices as the output. This ensures that the condiment always
follows the parent item to its order devices. This option does not apply to Condiment
Prefixes.

7. To override order device programming of the parent menu item, select 58 - Condiment
order device programming overrides that of parent.

When this option is selected, order devices configured for the condiments class override
the order devices defined for parent menu items. Use this option in a situation where a
menu item is sent to a different order device when a specific condiment is added. For
example, a Muffin served at room temperature outputs to the Pantry Order Device. Warm
is set to output to the Hot Order Device. When the Condiment Warm with this option set
is added to the Menu Item Muffin, the Muffin will use the Order Device output of the
Warm Condiment and go to the Hot Order Device instead of the usual Pantry. This option
does not function if the menu item is a Condiment Prefix.

8. Click the Condiment Groups tab, and then select the Member Condiment Groups for
the class.

For example, if the condiment class is Deli Meat Class, select Meat Group from the
Member Condiment Groups list.

9. Click Save.

10. Repeat Steps 2 through 9 to create menu item classes for all condiment groups.

Related Topics

• Condiment Groups and Condiment Sets

Creating Menu Item Master Records for Condiments
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Maintenance.

2. Insert a new record, and then enter the condiment name (for example, Ham).

3. Search for and then double-click the new record

4. Insert a definition record, and then click the General subtab.

5. From the Name and Class section, select the Menu Item Class for the condiment.

6. To set a priced condiment:

a. Click the Prices subtab, insert a price definition, and then enter the Price for the
condiment.

b. To set the price to become active at a specific menu level, select Active On Level,
and then select the level.

7. Click Save.
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8. Repeat Steps 2 through 6 to create menu item master records for all condiments.

Related Topics

• Condiment Groups and Condiment Sets

Configuring Condiment Sets
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Condiment Sets.

2. Insert a new record, enter a name for the condiment group, and then double-click
the new record.

3. Click Add from the Condiments section.

4. From the Menu Item column, click the ellipsis point (...) button, select a condiment
from the list, and then click OK.

5. Enter the number of condiments that accompany the condiment group in the
Default Count field.

For example, if the condiment is a slice of cheddar cheese and you enter number
2 as the default count, 2 slices of cheddar cheese accompany the condiment.

6. In the Sort Order field, enter the order in which the workstation shows the
condiment on screen.

7. If you want the condiment to remain in the order when the workstation operator
changes a menu item to plain (for example, when a workstation operator changes
the order to a plain bacon cheeseburger, the bacon and the cheese are not
removed), click the ellipsis point (...) button from the Options column, select 1 -
Persist On Plain, and then click OK.

8. Enter the Menu Item Definition Sequence number that coincides with this
condiment.

The Menu Item Definition Sequence number helps workstation operators switch
between condiments. For example, the cheeseburger has two menu item
definitions. If the customer orders definition 1, the cheeseburger should have
cheddar cheese and if the customer orders definition 2, the cheeseburger should
have mozzarella cheese. When configuring the condiment group for the
cheeseburger, you must enter 1 as the Menu Item Definition Sequence for the
condiment cheddar cheese and 2 as the Menu Item Definition Sequence for the
condiment mozzarella cheese.

9. Repeat Steps 3 through 8 to add more condiments to the condiment group.

10. Click Save.

Related Topics

• Condiment Groups and Condiment Sets

Assigning Condiments to Parent Menu Item Classes
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Item Classes.

2. Double-click a parent menu item class.
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3. Click the Condiment Groups tab, and then select the appropriate Required Condiment
Groups and Allowed Condiment Groups for the class.

For example, if the parent menu item class is Sandwich Class, the required and allowed
condiment groups are listed in the following table:

Table 30-2    Examples of Required and Allowed Condiment Groups

Condiment Group Examples

Required Condiment Meat Group, Bread Group
Each Required Condiment Group that you select
appears on the Forced Condiments tab. From there you
can enter the Minimum and Maximum amounts for
each item.

Allowed Condiment Meat Group, Bread Group, Cheese Group, Sauce Group,
and Veggie Group

4. (Optional) Click the Forced Condiments tab.

5. For each required condiment group, enter the Minimum and Maximum condiment count
required to complete the order.

For example, if you set the minimum condiment count for Veggie Group as 2, the
workstation operator must add two types of vegetables to complete the order.

6. To limit the number of selections that workstation operators can add from a condiment
group at a certain menu level, enter the Threshold 1 and Threshold 2 for each required
condiment group.

• To configure the menu levels that are used for the condiment price, enter numerical
values in the Threshold 1 Level and Threshold 2 Level fields corresponding to the
price sequence record in the Menu Item Maintenance module for each menu level.
For example, if you enter 2 and 3 in Threshold 1 and 2 Levels, Menu Item
Maintenance price sequences 2 and 3 are used for condiment pricing when
Threshold 1 and Threshold 2 quantities are exceeded.

Starting with Simphony release 19.2.1, threshold configuration is supported with option
65 - Support Enhanced Prefix Mode (Parent Only) in the Menu Item Classes module.
The Threshold 1 Level and Threshold 2 Level pricing is recalculated based on the
value selected in the Condiment Handling with Parent Item Switching drop-down list
(located in the Menu Item Classes module on the General tab): option 1 - Reset Default
Condiments Only or 2 - Reset All Condiments. On the Menu Item Classes module
Forced Condiments tab, do not enter zero in the Threshold 1 Level and Threshold 2
Level fields for Condiment Groups when Threshold 1 and Threshold 2 quantities are
used.

See Using Condiment Prefixes with Menu Item Classes and Configuring Menu Item
Classes for more information about option 65 and enhanced prefix support.

7. Click the Options tab, and then select the appropriate options as described in the
following table:
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Table 30-3    Condiment Menu Item Class Options

Option Description

9 - Condiment Changes Print Group of
Parent Menu Item

Select this option to have the menu items
in this class use the print group of the
condiment.
This is used to modify the parent menu
item's Order Device Sorting. For example,
you can use the condiment As Entree to
modify an appetizer, forcing it to print
and sort with other entrée menu items.
If a parent menu item has several
condiments with this option set, the last
condiment for which this option is
enabled determines the parent’s print
group. The menu item cannot be a
Condiment Prefix.

21 - Require Number of Condiments to
Match Number of Parent Items

Select this option to match the number of
the required condiments belonging to the
menu item class to the number of parent
menu items ordered.
For example, if selected, when a
workstation operator orders 3 Steak
Dinner, the operator is prompted for the
Meat Temperature condiment group
three times. If this option is deselected
and a workstation operator orders 3
Steak Dinner, the operator is prompted
for the Meat Temperature condiment
only once, and the cook assumes that all
three steaks are to be prepared at the
same temperature.

23 - Add Condiment Price to the Parent
Item's Price on Check Only

Select this option to have guest checks
and customer receipts show the price of
condiment added to the price of the
menu item it is modifying.
For example, a Salad is $5.00, and Blue
Cheese dressing is $0.25. With option 23
set, the guest check and receipt show the
price as $5.25.
This option does not apply to Condiments
Prefixes.
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Table 30-3    (Cont.) Condiment Menu Item Class Options

Option Description

30 - Sort Condiments by Print Group Select this option to sort condiments
according to their print group. Deselect
to print condiments in the order in
which they were ordered.
For example, Prime Rib requires three
condiments: meat temperature, potato
type, and salad dressing. In addition to
these required condiments, which must
be entered first, other condiments such
as End Cut are ordered for this item. By
configuring menu item class print groups
to anticipate this situation, the meat
temperature items are assigned to Print
Group 1, the potato type and salad
dressing items are assigned to Print
Group 4, and the End Cut item is assigned
to Print Group 2. When the item is added,
the cook sees the condiments print in this
order: meat temperature, End Cut, potato
type, and then salad dressing. Therefore,
Simphony sorted the End Cut item
immediately after the meat temperature,
making the order receipt more logical to
read.
This option does not apply to Condiment
Prefixes.

41 - Consolidate Menu Items with
Condiments on Order Output

Select this option to have order devices
consolidate items with condiments and
print each condiment with the seat
number to which the condiment applies.
You must also select 6 - Print Seat
Numbers with Individual Items from
the Order Devices module at the revenue
center level.

42 - Consolidate Parents with Matching
Condiments on Order Output

Select this option to have order devices
consolidate parent menu items with
identical condiments.
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Table 30-3    (Cont.) Condiment Menu Item Class Options

Option Description

54 - Condiment entry/display relational
to Parent Item's quantity

Select to show the number of condiments
for each parent menu item. Deselect to
add each condiment individually or by
quantity without relation to the parent
item’s quantity. Use this option based on
the ordering process and flow of
operations.
For example, if set and there are 3
Burgers, when a workstation operator
enters 2 Cheese, each Burger will get 2
cheese for a total of 6 Cheese. Because
the condiments are relational to the
parent item’s quantity, it only shows how
many Cheese each Burger will get—in
this example 2 for each Burger. If
deselected, to order 2 Cheese for each
Burger, workstation operators must
enter 6 Cheese.

8. Click Save.

9. Repeat Steps 2 through 8 for all parent menu item classes.

Related Topics

• Condiment Groups and Condiment Sets

Assigning Default Condiments to Parent Menu Items
Default condiments are used for the following purposes:

1. The default building of a menu item (for example, a hamburger comes with tomato,
onion, and pickle)

2. Breaking down a menu item to the ingredient level for inventory system integration
(for example, the default number of pickles that accompany a hamburger)

Default condiments are not supported with Transaction Services. If you are using
Transaction Services, workstation operators need to add default condiments
separately.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Menu Item Maintenance.

2. Search for and double-click a parent menu item record.

3. Click the Default Condiments subtab, and then click Add.

4. Click the ellipsis point (...) button from the Condiment Set column, select the
condiment set, and then click OK.

5. (Optional) Enter the sort group number for the condiment set in the Sort Group
column.

All condiment sets appear in the workstation according to the Sort Group.
Condiment sets in Sort Group 0 appear first, followed by 1, 2, and so on. Items
that have the same Sort Group number appear as they are listed in the EMC.
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6. To show the default condiments, click the ellipsis point (...) button from the Options
column, and then select 1 - Display when in default state.

7. To always charge guests for the condiment count, select 2 - Charge for entire sales
count, and then click OK.

For example, if a burger comes with 2 slices of cheese by default, the guest is charged
regardless of whether they order 1 or 2 slices of cheese on the burger. If you do not
select this option, guests are only charged when the condiment count exceeds the default
count.

8. Click Save.

Related Topics

• Condiment Groups and Condiment Sets

Condiment Prefixes
Many restaurants allow workstation operators to modify menu items, such as adding,
removing, increasing and decreasing the number of condiments on the item. Workstation
operators can add prefixes (for example, No, Add, Extra) before the condiment on the guest
check, order devices, and customer receipts. This provides helpful preparation instructions to
the kitchen staff and eliminates order confusion.

Condiment prefixes follow the same print class settings configured for the condiment to which
they are associated.

Complete the following tasks to set up condiment prefixes:

• Create condiment prefix menu items

• Create menu item classes for the prefixes

• Activate and deactivate condiment prefixes

• Configure separate touchscreen buttons for condiment prefixes

Related Topics

• Creating Condiment Prefix Menu Items

• Creating Menu Item Classes for Prefixes

• Using Condiment Prefixes with Menu Item Classes

• Disabling Condiment Prefixes

• Configuring Touchscreen Buttons for Condiment Prefixes

Creating Condiment Prefix Menu Items
1. Select the Enterprise, click Configuration, and then click Menu Item Maintenance.

2. Insert a new record and name it Prefixes.

3. Select the Prefixes header record and insert a new record. Enter the prefix (for example,
ADD) as the name for the new menu item record.

4. Double-click the record you created in Step 3, and then click Menu Levels Tab.

5. Select Active on All Levels.

6. Click Prices and insert a $0 priced record.
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7. Click Save.

8. Repeat Steps 3 through 7 to create records for the remaining prefixes.

Related Topics

• Condiment Prefixes

Creating Menu Item Classes for Prefixes
1. Select the Enterprise level, click Descriptors, and then click Condiment Group

Names.

2. In the Text field, enter a group name to appear in the POS client for the condiment
prefixes.

3. Click Save.

4. Select the Enterprise level, click Configuration, and then click Menu Item
Classes.

5. Insert a new record and name it after a prefix (for example, Add).

6. Double-click the new record.

7. On the General tab, select the Condiment Prefix Type that corresponds to the
prefix menu item class that you created in Step 5:

• 1 - Description Prefix: Indicates that the prefix describes the condiment it
modifies more clearly (for example, Lite Mayo).

• 2 - No Prefix: Indicates the removal of the default condiment (for example, No
Cheddar).

• 3 - Add Prefix: Indicates the addition of a non-default condiment (for example,
Add American).

• 4 - Sub Prefix: Identifies the item as replacing a default condiment with a
similar condiment (for example, No American, Sub Cheddar).

• 5 - Plain Prefix: Works like a function key. When selected, all condiments are
removed from the check detail. If an item is re-added after being set to Plain,
the workstation shows the items in the check detail, including default items
that are placed back on the menu item. Switching the Plain key is the same as
selecting the Reset key.

• 6 - Reset Prefix: Resets the menu item to its original ordered state with no
non-default condiments ordered and all of the default condiments
automatically ordered.

8. Click the Options tab, and then select 2 - ON = Condiment Menu Items; OFF =
Regular Menu Items and 8 - Allow Menu Items in this Class to be Non-Priced.

9. Click the Condiments Group tab.

10. From the Member Condiment Groups section, select the condiment group that you
created in Step 2.

11. Click Save.

12. Repeat Steps 5 through 11 to configure menu item classes for the remaining
prefixes.
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Related Topics

• Condiment Prefixes

Using Condiment Prefixes with Menu Item Classes
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Click the Options tab.

3. For all regular menu item classes, select 65 - Support Enhanced Prefix Mode (Parent
Only), and then click OK.

If you are not using condiment prefixes, do not select 65 - Support Enhanced Prefix
Mode (Parent Only).

See Configuring Menu Item Classes and Assigning Condiments to Parent Menu Item
Classes for more information.

4. Click Save.

Related Topics

• Condiment Prefixes

Disabling Condiment Prefixes
You can disable condiment prefixes to prevent them from appearing in the Combo/Condiment
Orderer.

1. Select the Enterprise level, click Configuration, and then click Menu Item Classes.

2. Double-click a regular menu item class with condiments.

3. Click the Condiments Group tab, and then change all Allowed Condiment Groups to
Required Condiment Groups.

4. From the Allowed Condiment Groups section, select the condiment group you created in
the section Creating Menu Items Classes for Prefixes.

5. Click the Forced Condiments tab, and then set the Minimum value for the previously
enabled condiment groups to 0 (zero).

6. Repeat Steps 2 through 5 for all regular menu items with condiments.

7. Click Save.

Related Topics

• Condiment Prefixes

Configuring Touchscreen Buttons for Condiment Prefixes
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Locate the Combo/Condiment Orderer and deselect Allowed.

3. Click Save.
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4. Insert a new button on the transaction screen, select Menu Item as the button
type, and then select a prefix as the menu item (for example, ADD).

5. Enter or generate a legend for the button, and then click Save.

6. Repeat Steps 4 and 5 to configure touchscreen buttons for the remaining
condiment prefixes.

Related Topics

• Condiment Prefixes

Setting Condiment Appearance
1. Select the Enterprise, property, or revenue center, click Setup, and then click

Format Parameters.

2. Click the Options tab, and then select the appropriate options:

• To show as many condiments as possible printed together on each line of
guest checks and customer receipts, select 4 - Wrap Condiments on Guest
Checks.

• To hide previous round condiments and show only the parent menu item when
a workstation operator picks up a check, select 35 - Hide Previous Round
Condiments on Display.

• To set the check detail area to actively sort condiments while they are added,
select 45 - Sort Current Round Condiments on Screen. Condiment sorting
occurs only when items are in different print groups and the parent allows
condiment sorting.

3. Click Save.

4. Select the Enterprise, property, or revenue center, click Setup, and then click
Control Parameters.

5. Click the Options tab, and then select the appropriate options:

• To show only condiments that workstation operators are allowed to add with
the parent menu item, select 37 - Enable Condiment Masking.

• To allow workstation operators to add condiments out of order (conversational
ordering), select 44 - Permit Required Condiments To Be Entered Out Of
Order.

6. Click Save.

7. Select the revenue center, click Setup, and then click Order Devices.

8. Double-click a printer record, and then click the Options tab.

9. To print condiments in red font, select 10 - Print Condiments in Red (Overrides
Print Class Settings).

10. Click Save.

Related Topics

• Condiment Groups and Condiment Sets
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Popup Condiment Orderer
The Popup Condiment Orderer provides a screen workflow that automatically advances the
workstation operator through required condiments when adding menu items.

The Popup Condiment Orderer resides in a template. The system creates a page (based on
the template) that pops up for required condiments. When adding a menu item (for example,
Steak) that requires condiment selection to a transaction, the page with the template appears
as a popup where the workstation operator can select the required condiment groups (for
example, meat temperature and sauce).

The workstation operator can also recall a Popup Condiment Orderer to modify the required
condiments of a previously ordered menu item. The workstation operator can select the
parent item or condiment in the check detail or select the Recall Popup Condiment Orderer
function key (depending on configuration).

Unlike the regular Condiment Orderer, the Popup Condiment Orderer automatically pops up
and closes.

Complete the following tasks to set up the Popup Condiment Orderer:

• Configure a Popup Condiment Orderer page

• Configure a revenue center to use the Popup Condiment Orderer

• Configure a menu item class to use the Popup Condiment Orderer

Related Topics

• Configuring a Popup Condiment Orderer Page

• Configuring a Revenue Center to Use the Popup Condiment Orderer

• Configuring Menu Items Linked to Classes to Use the Popup Condiment Orderer

Configuring a Popup Condiment Orderer Page
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Insert a record for Popup Condiment Orderer if it does not exist.

3. Double-click the record to open it.

4. Select Specify Template, and then select Popup Condiment Orderer from the Internal
Templates list.

The template is preset with a Condiment Orderer control and a Done button. You cannot
delete these elements from the template, nor can you copy elements to this template.
The Popup Condiment Orderer template supports two key functions: Void and
Transaction Cancel.

5. From the Popup Type drop-down list, select the location for the Popup Condiment
Orderer on the page. (The Popup Types do not apply to POS clients running the Android
mobile operating system.)

• Full Screen

• Centered

• Next to Check Detail Area
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• In Dynamic Content Area

6. Select Allow selection in check detail area to allow workstation operators to
select the current menu item and its condiments in the check detail area while the
Popup Condiment Orderer is open.

7. Select Manually dismiss Condiment Orderer to have the Popup Condiment
Orderer remain open after the workstation operator selects all required
condiments. The workstation operator must use the Done button to close the
Popup Condiment Orderer.

If you configure required condiment groups with a zero minimum count, select
Manually dismiss Condiment Orderer. Otherwise the Popup Condiment Orderer
automatically closes because the application meets the minimum required count
(zero) before the workstation operator orders a condiment in the group.

8. (Optional) Change the page settings, such as layout and button styles. You cannot
modify the dimmed settings.

9. (Optional) Repeat Steps 2 through 8 to create additional Popup Condiment
Orderer pages. The POS client requires one page for initial condiment selection
and subsequent editing, although you can configure two pages.

When you designate Next Page/Panel for menu items (in menu item classes and
on menu item buttons), the POS client goes to the designated page or panel after
the Popup Condiment Orderer closes (either manually or automatically).

10. Click Save.

Related Topics

• Popup Condiment Orderer

Configuring a Revenue Center to Use the Popup Condiment
Orderer

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. From the Default Condiment Ordering Popup drop-down list, select the default
Popup Condiment Orderer Page to appear when the workstation operator adds a
menu item with required condiments for the revenue center.

3. From the Default Condiment Editing Popup drop-down list, select the default
Popup Condiment Orderer Page to appear when the workstation operator selects
a menu item with required condiments in the check detail area for the revenue
center.

4. Click Save.

Related Topics

• Popup Condiment Orderer

Configuring Menu Items Linked to Classes to Use the Popup
Condiment Orderer

The Popup Condiment Orderer configuration in the Menu Item Classes module
overrides the revenue center configuration in the RVC Parameters module.
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If you do not configure a revenue center or menu item class to use the Popup Condiment
Orderer, the feature is turned off. You can use a mix of the settings. For example, you can set
the revenue center to use the Popup Condiment Orderer, and set specific menu items to use
the revenue center parameter, other menu items to use a different Popup Condiment Orderer,
and some menu items with no popup.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Classes.

2. Double-click the menu item class record.

3. From the Condiment Order Popup drop-down list, select the Popup Condiment Orderer
Page to automatically appear when the workstation operator orders a menu item with
required condiments:

If you want the menu item class to use the Default Condiment Ordering Popup assigned
to the revenue center, select 0 - Use Revenue Center Parameter.

4. From the Condiment Edit Popup drop-down list, select the Popup Condiment Orderer
Page to automatically appear when the workstation operator selects a menu item with
required condiments in the check detail area:

If you want the menu item class to use the Default Condiment Editing Popup assigned to
the revenue center, select 0 - Use Revenue Center Parameter.

To use gestures on transaction pages, set the Condiment Edit Popup to No Popup for
the menu item classes, and use the Recall Popup Condiment Orderer function key to
modify previously ordered required condiments.

5. Click Save.

Related Topics

• Popup Condiment Orderer
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31
Combo and Fixed Price Meals

A combo meal consists of two or more menu items grouped together in combo meal groups
and sold to the customer for a single price. Quick service restaurants typically sell combo
meals to increase business by packaging the most frequently requested menu combinations
(for example, hamburger, fries, and a drink) and offering them for a lower price than à la carte
items.

A combo meal group allows you to configure the menu items within a group so that the POS
client knows which items to combine. Two typical combo meal groups are combo sides and
combo drinks. For example, you can configure a meal named Combo 1 with a primary menu
item called Combo Sandwiches and additional Combo Groups (such as Combo Drinks and
Combo Side Items).

A fixed price meal (FPM) is a complete meal offered at a fixed price. For example, during
special occasions or holidays, restaurants sometimes serve multi-course meals with only a
few menu item choices for each course, and charge a fixed total price.

There is no restriction on the number of FPMs or courses. The workstation operator can
order multiple meals on the same seat. The sides can default to a placeholder menu item that
the workstation operator replaces in a later round. Placeholder menu items can be shown or
hidden in the check detail area.

You can configure FPMs like combo meals. Creating Combo Meal Groups contains more
information about assembling required items for a FPM, and assigning alternate groups to
allow guests to substitute items.

Combo Meal Group Pricing
You can use many pricing scenarios for combo meal groups, as described in the following
examples.

Pricing Combo Meal Groups Based on Side Items

You can price side items on the combo meal’s side items level instead of the pricing at the
combo meal groups items level. In some cases, this simplifies combo meal price
configuration. If you set prices in both places, the pricing on the combo meal groups item
level takes precedence. Consider the following examples:

• (Traditional Pricing) Combo Meal #1 Drink price $0.99

• (Traditional Pricing) Combo Meal #2 Drink price $1.09

• (Side Item Pricing) Milk (drink choice) price $1.50 (upcharge)

1 Combo Meal #1: Root Beer $0.99

1 Combo Meal #1: Milk $1.50

1 Combo Meal #2: Root Beer $1.09
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Pricing Combo Meal Groups Based on Size

The following figure illustrates the configuration of a basic combo meal group using
different sizes and associated prices. A combo meal group called Combo Drinks
contains the menu items Small Cola, Medium Cola and Large Cola. The Medium Cola
is the default drink for all applicable Order Types. The workstation operator does not
need to make a selection when adding the combo meal item using the workstation.
The application automatically adds the Medium Cola as the default selection. (A
workstation operator can modify this choice using the sizing or substitute function
keys.) You can apply the prices of $1.00 for the Medium Cola and $2.00 for the Large
Cola. To use combo meal sizing, set the Small Cola as the Size 1 Item, the Medium
Cola as the Size 2 Item and the Large Cola as the Size 3 Item. You must set Size 1-4
Item settings for all sizable combo group items listed. To enable workstation operators
to add or change combo meal item sizes, add buttons to the combo transaction page
using the Page Design module.

Figure 31-1    Example of Pricing Based on Item Size

Pricing Combo Meal Groups Based on Menu Item Definition

The following figure shows another optional pricing convention. You can price any
combo meal menu item (for example, a Hamburger Combo to include all combo side
and drink items). Set the combo’s price in the menu item definition record (in the Menu
Item Maintenance module), and deselect option 4 - Add Side Prices To Meal Price in
the Combo Meals module.
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Figure 31-2    Example of Pricing Based on Menu Item Definition

Another method is to lower the combo meal menu item price and then roll the price of the
combo sides and combo drink items into the price of the primary combo meal menu item.

Related Topics

• Creating Combo Meal Groups

• Creating Combo Meals

• Configuring Additional Combo Meal Settings

• Creating Combo Meal Pages

• Configuring a Smart Key to Show Menu Level Buttons

• Combo Meal Function Keys

Placeholder Menu Items in Combo Meals
When ordering a combo meal, the guest might not know what they want for dessert when
placing the initial appetizer and entrée for a combo meal. The workstation operator can post a
placeholder menu item to complete the combo meal, substituting it with the guest’s dessert
choice (made after the entrée is cleared and they are ready to order dessert). Placeholder
items stand in for unknown items until the workstation operator substitutes the placeholder
item with the actual menu item in a subsequent service round.

You need to configure a placeholder as a menu item (MI), including inserting a MI master, MI
definition and a $0.00 price record. Additionally, assign a MI class to its MI definition file using
the placeholder options. Then add the placeholder menu item to each desired combo meal
group (for example, combo sides) so that Simphony shows the placeholder item on the Child
Orderer area of the page. When the workstation operator selects the placeholder item, it
occupies a place in the check to enable service total.

The workstation operator can substitute the placeholder menu item at any time prior to
closing the check. After substituting it with a valid item (as shown in the following figure), the
workstation operator cannot change the item back to a placeholder item. However, the
workstation operator can substitute with another valid item.

Chapter 31
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Related Topics

• Creating Combo Meal Groups

• Creating Combo Meals

• Configuring Additional Combo Meal Settings

• Creating Combo Meal Pages

• Configuring a Smart Key to Show Menu Level Buttons

• Combo Meal Function Keys

Creating Combo Meal Groups
You need to configure the menu items that comprise a combo meal group. Then you
can configure combo meals using two EMC modules: Combo Meal Groups and
Combo Meals. Configure the Combo Meal Groups module first and then configure the
Combo Meals module.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Combo Meal Groups.

2. Insert a record for a new combo meal group with the appropriate name, or double-
click an existing record.

3. Select the appropriate combo group configuration options:

• 1 - Allow Discounts: Select this option to apply discounts to items in the
group. The discount being applied must have option 25 - Discount Combo
Meal Group Items set from the Discounts module.

• 2 - Substitution Group items use this sides price: Select this option to set
the menu item price to the side’s combo meal price specified on the combo
meal form. The price setting occurs when the workstation operator substitutes
a combo meal side with a menu item from an alternate group. Deselect this
option to set the menu item price in the alternate group.

4. (Optional) To enable substitution side items, add Alternate Groups using the Add
link.

• When Alternate Groups are present, workstation operators can substitute
combo side items with other combo meal groups. For example, the guest
might want to have an onion rings side item that is generally available in
Combo Meal #2 with a Combo Meal #4. You can add a Combo Onion Rings
alternate group that enables menu item substitution with a Combo Fries group.
Configuring alternate side groups enables the application to substitute these
side menu items. You must configure an Alternate Side button (using the Page
Design module) to substitute items in the POS client.

• If you are using Simphony version 2.7 MR3 or later, configure FPMs in the
Alternate Groups field. For example, guests often substitute an appetizer or
salad for the entrée portion of an FPM and this field accommodates these
substitutions.

5. Click the Items tab to configure all menu items within a combo meal group.

• To have all of the combo meal side items sent to the order device of the parent
item, select 11 - Send to Combo Parent Order Devices. This enables an
entrée that comes with two sides to print to the same order device.

Chapter 31
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For example, if you have a steak with mashed potatoes and broccoli, you can send
the steak, potatoes, and broccoli to the grill order device. Deselect option 11 to send
the steak and potatoes to the grill order device and the broccoli to the pantry order
device.

6. Click the Add and Delete links to add or remove menu items from the combo meal
group.

7. Enter or select information in the following fields for each item:

Table 31-1    Combo Meal Group Fields

Field or Option Description

Primary Menu Item Select a menu item to be the primary item in
the combo meal group.
This field shows all menu item master
records that contain a definition in the
revenue center.

Quantity Enter the number of times the menu item is
needed in the combo group (for example, a
combo meal has one hamburger).

1 - Default when no Order Type declared Select this option to make the selected item
the default item for the combo group
without an Order Type.

2 - 9 Default for Order Types 1-8 Select these options to make the selected
item the default item when Order Type 1
(through 8) is active. Deselect these options
to have the workstation operator select an
item to fulfill the combo meal requirements.

10 - Autofill Select this option to change the quantity of
the side item ordered to the number of
remaining items to complete the side
requirements when the workstation
operator orders one of the combo meals and
more than one remaining item is required.

Size 1-4 Items Select a menu item that substitutes for the
Primary Menu Item when using the Combo
Size 1 through Size 4 function keys (set in
Page Design under Type).
This list shows all menu items assigned to
the combo group after saving the items. You
cannot copy or paste combo meal groups in
the EMC. The Size 1-4 Items field populates
only after you save items. For example, if
you create a new combo group and add the
items Soda and Large Soda, you must save
these items before selecting either item in
this field.

Size 1-4 Menu Levels Select a menu level that can affect the price
of the substituted Size 1-4 Items.

8. To set specific side items with a different price (upcharge), click the Prices subtab.

For example, Fries are priced at $0.00, but there is an extra charge of $1.25 when the
guest orders Onion Rings.
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9. Click the Add and Delete links to add or remove prices for each item. You can
configure up to 8 prices for a single item.

Set the following fields when adding a price:

• Price: Enter the price to charge for the item.

• Prep Cost: Enter the à la carte price of the combo group item.

• Active On Level: Select the menu level on which the price is active.

• (Optional) Effectivity Group: Select the effectivity group for this price.

• (Optional) Date Start and Date End: Enter start and end dates.

10. Click Save.

Related Topics

• Combo Meal Group Pricing

• Placeholder Menu Items in Combo Meals

• Combo Meal Function Keys

Creating Combo Meals
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Combo Meals.

2. Insert a record for a new combo meal, or double-click an existing record.

3. Click the Select link next to the Menu Item Master field, select the menu item that
represents the combo meal, and then click OK.

4. Click the ellipsis point button, select the Primary Combo Group, and then click
OK.

This is the combo meal group of the primary item for the combo meal. For
example, if you have a Burger Combo, you might select a Burgers Combo Meal
Group.

5. In the Priority field, enter the combo meal priority when workstation operators
press the Auto Combo function key.

6. From the Auto Combo Algorithm drop-down list, select the setting for the
application to use when the workstation operator creates a combo meal from
menu items already listed on a check. When the workstation operator presses the
Auto Combo function key, the application uses one of the following options to
combine the combo meal items:

• 0 - First Deal Found: Select this option to have the application use and
combine the first items found.

• 1 - Best Deal for Customer: Select this option to combine the most expensive
items as a combo meal.

• 2 - Best Deal for Merchant: Select this option to combine the least expensive
items as a combo meal.

7. Select the appropriate options as described in the following table:
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Table 31-2    Combo Meal Options

Option Description

1 - Disable Auto-Combo Recognition Select this option to prevent the combo meal
from being considered when the
workstation operator presses the Auto
Combo function key.

2 - Allow Auto-Combo in Previous Round Select this option to allow the combo meal to
consider previous-round items when the
workstation operator presses the Auto
Combo function key.

3 - Is Sized Combo Meal Select this option to allow the combo meal to
use Combo Size Size 1-4 function keys,
changing the size of the items ordered.

4 - Add Side Prices To Meal Price Select this option to add the prices of the
meal’s side items to the price of the meal on
the Kitchen Display System (KDS) display
and the customer receipt.

5 - Only Print Priced Sides On Guest Check Select this option to prevent the meal’s side
items from printing on the customer receipt
when they have no price, or when their
price rolls into the price of the meal.

6 - No Charge For Condiments Select this option when added condiments
(to the meal) are non-priced.

7 - No Bulk Order With Quantity Order Select this option to prompt the workstation
operator for each non-default side item per
meal. This option is used when a
workstation operator adds more than one
combo meal.
Deselect this option to allow the workstation
operator to specify a count when ordering
non-default side items. When you deselect
this option, the application does not
continue to the next side item until all of the
combo meals satisfy the side items
requirement.

8 - Allow Resizing of Individual Sides Select this option to allow the workstation
operator to change the size of one selected
combo meal side item. Deselect this option to
allow the workstation operator to resize the
entire combo meal.

9 - Do Not Show With Combo Meal Choices If workstation operators can create multiple
combo meals from the existing menu items
listed on a check and you select this option, a
system-generated list of available choices
does not include the combo meal. This
combo meal only appears in the list when no
combo meals are found.

10 - Keep Last Item Selected after Ordering a
New Meal

Select this option if you expect modifications
to the combo meal after adding the last side,
keeping the combo meal selected. This is
particularly useful if the last side is often
modified.
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Table 31-2    (Cont.) Combo Meal Options

Option Description

11 - Is Defined Combo Meal Select this option to allow the application to
incorporate the meal items in the combo as
individual menu items in the Auto Combo
On The Fly process.
For example, you can configure a Donut 6
combo meal and set option 11. When a guest
orders a Donut 6 combo and then adds one
more donut, the option allows the
application to handle the Donut 6 combo as
six individual donuts. The auto combo
procedure creates an auto combo meal from
the menu items added to the check in the
current round and initiates a Donut 7 combo
instead of adding a seventh donut at full
price. This results in a lower price for the
customer.

8. To add a combo group:

a. Cick the Add link in the Combo Groups section.

b. Enter the Side Count.

c. Click the ellipsis pint button in the Side Item Group column, select the side
items for the combo meal, and then click OK.

For example, if the combo meal is a Burger, Fries, and Soda, the side items
include two Combo Meal Groups: Fries and Soda.

d. To include only the menu items that are active at the menu level in the combo
meal group SLU list, select the default size for a combo meal side item using
the Default Menu Level drop-down arrow.

The menu item’s active menu level needs to be configured in order to select
the Default Menu Level. Configuring Active Menu Levels for Menu Item
Definitions and Prices contains more information.

The menu level availability is configured for each individual item in the Menu
Item Maintenance module. The Main Level Link must be selected in the
Menu Item Maintenance module. Configuring Menu Item Definitions contains
more information.

A workstation operator can select the menu items that appear on the page by
switching between menu levels on the POS client. If the workstation operator
uses a main or sub level button while this side item is active, the Menu Level
Change dialog appears after adding the side item to the guest check.

Using the example shown in the following table, you can have the SLU show
only medium sized beverages by setting the side item’s Default Menu Level
to 3 in the Combo Meals module. Workstation operators can use the Menu
Level buttons to switch to the small and large size beverages. To have the
SLU show all sizes of beverages in this example, set the Default Menu Level
to 1.
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Table 31-3    Example of Menu Levels Used for Combo SLU Sizes

Number Default Menu Level

1 Small Beverage
Medium Beverage
Large Beverage

2 Large Beverage

3 Medium Beverage

4 Small Beverage

e. To configure the SLU menu item sizes that appear on a workstation page, select the
Menu Level.

Selecting the Menu Level reduces the number of items shown in a SLU, making it
easier for workstation operators to locate the right combination of menu items and
sizes for a combo meal without scrolling through many lists. The list of items in the
SLU changes based on the Menu Level. If there are no Menu Levels configured, all
SLU items appear on the workstation.

9. Do not price items within the combo meal’s Combo Group Price field for combo size
meals as this could cause issues with the Size 1-4 Items fields in the Combo Meal
Groups module. See Creating Combo Meal Groups for more information.

10. Click Save.

Related Topics

• Combo Meal Group Pricing

• Placeholder Menu Items in Combo Meals

• Combo Meal Function Keys

Configuring Additional Combo Meal Settings
You can configure additional combo meal options in various EMC modules.

1. To prevent tendering with incomplete combo meals:

a. Select the Enterprise, property, or zone, click Configuration, and then click Tender/
Media.

b. Double-click the tender media record.

c. Click the Options tab, and then click the Printing Options subtab.

d. To prevent the tender from being enabled when a meal is missing a side item, select
85 - Not Allowed With Incomplete Meals.

e. Click Save.

2. To enable workstation operators to add incomplete combo meals and placeholder items:

a. Select the Enterprise level, click Configuration, and then click Roles.

b. Double-click the role record.

c. Click the Operations tab, and then click the Transactions subtab.

d. To enable workstation operators to add a parent item without a required condiment,
select 161 - Allow Incomplete Item.
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The parent menu item must have 59 - Allow Item Incomplete Based on Role
set from the Menu Item Classes module.

e. To enable workstation operators to authorize or perform a service total or
tender on a transaction with a placeholder item, select 164 - Authorize/
Perform Service Total/Payment with Placeholder item.

You must also set option 85 - Not Allowed With Incomplete Meals in the
Tender/Media module. Placeholder Menu Items in Combo Meals contains
more information.

f. Click Save.

3. To configure revenue center parameters for combo meals:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Click the Options tab.

c. To enable the combo key to function with Auto Combo Meal recognition, select
51 - Allow Auto Combo Meal Recognition with the "Combo" key.

d. To enable the Auto Combo Meal recognition to create combo meals from
menu items that were ordered in previous rounds, select 52 - Allow Creation
of Combo Meals from Previous Round Menu Items.

e. To show a list of combo meal choices when the workstation operator attempts
to create meals from menu items already on the check, select 55 - Show
Combo Meal Choices.

f. To have the application create combo meals from the menu items added to the
check in the current round, select 58 - Auto Combo Items On The Fly.

g. Click Save.

4. To configure menu item class options:

a. Select the Enterprise, property, revenue center, or zone, click Configuration,
and then click Menu Item Classes.

b. Double-click the menu item class record.

c. Click the Options tab.

d. To indicate that all menu items in the class are the priced (parent) portion of a
Fixed Price Meal, select 35 - Fixed Price Meal.

If this option is not selected, the class is treated as a child (non-priced)
component of a Fixed Price Meal. The system relies on the setting of the
Course Mask options to determine whether a menu item class is associated
with a fixed price meal.

e. To enable the workstation operator to add a menu item without satisfying the
required condiment’s conditions, select 59 - Allow Item Incomplete Based
On Role.

The role privilege 161 - Allow Incomplete Item must be set for the
workstation operator ordering a parent item with this menu item class.

f. If the menu item is a placeholder in a combo meal, select 60 - Placeholder.

g. To hide placeholder items from the check detail area, select 61 - No
Placeholder Display.

h. Click Save.
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Related Topics

• Combo Meal Group Pricing

• Placeholder Menu Items in Combo Meals

• Combo Meal Function Keys

Creating Combo Meal Pages
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page (typically the Transaction page) on which to place the combo meal keys
and functions.

3. Click Button, and then create combo meal menu item keys on the Transaction page.

4. Click Other..., and then add a Condiment/Combo Orderer.

Add the Condiment/Combo Orderer to the same Transaction page as the combo menu
items and function keys to view the combo meals and substitute side items easier.

5. Select the Condiment/Combo Orderer, click the Data tab, and then select Display Title
Bar.

The Display Title Bar on the POS client indicates when required combo meal sides or
condiments are not ordered.

6. Select Combo Meal Side to have the application generate and show combo meal side
items.

7. (Optional) Create combo meal size keys (if needed). These keys enable switching
between sizes of combo meal items. You can name the combo size keys for an actual
size such as small, medium, or large, or Combo Size 1, Combo Size 2, and so on.

Figure 31-3    Combo Meal Size Key

8. Add the appropriate function keys to the Combo Meal Transaction page (for example
Combo, Un-Combo, Auto Combo and Combo Multi-Selection).

Combo Meal Function Keys contains more information about each combo meal function
key.

9. Configure keys for all individual menu items available (in particular combo groups).

10. Click Save.
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Related Topics

• Combo Meal Group Pricing

• Placeholder Menu Items in Combo Meals

• Combo Meal Function Keys

Configuring a Smart Key to Show Menu Level Buttons
You can configure a smart key that workstation operators use to change menu levels.
Define a smart key on the page containing the Condiment/Combo Orderer and set the
main and sub level buttons for only small, medium, and large levels to appear when a
combo side item with a default menu level is active. The buttons disappear from the
page when the combo meal moves to the next side item or is complete. The smart key
is only active while adding a combo meal side with a default menu level.

Follow these steps to implement the smart key.

1. Select the Enterprise, zone, property, or revenue center, click Configuration, and
then click Page Design.

2. Select the page that has the Condiment/Combo Orderer. This is typically the
Transaction page that also has the combo menu items and function keys.

Creating Combo Meal Pages contains information about configuring the
Condiment/Combo Orderer

3. On the Edit tab, click Button.

4. Enter information in the Page Design fields.

Table 31-4    Page Design Edit Fields

Field Entry

Legend Enter the name of the button (for
example, Smart Key).

Type Select Function from the drop-down list.

Sub Type Click the black arrow, and then select
Smart Key.

Auto Active Select this option to make the button
automatically active.

5. Click the Edit Smart Keys button.

6. Click Add.

7. Enter information in the fields as described in the following table for the Main Level
smart key.

Table 31-5    Smart Key 1 Fields

Field Smart Key Entry

Condition Select Combo Side Default Level Active
from the drop-down list.

Value Enter 1.
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Table 31-5    (Cont.) Smart Key 1 Fields

Field Smart Key Entry

Legend Enter the name of the button (for
example, Small, Medium, or Large).

Type Select Main Menu Level from the drop-
down list.

8. Click Add.

9. (Optional) Enter information in the fields as described in the following table for the Sub
Level smart key.

Table 31-6    Smart Key 2 Fields

Field Smart Key Entry

Condition Select Combo Side Default Level Active
from the drop-down list.

Value Enter 2.

Legend Enter the name of the button.

Type Select Sub Menu Level from the drop-down
list.

10. Click Close.

11. Click Save.

Related Topics

• Combo Meal Group Pricing

• Placeholder Menu Items in Combo Meals

• Combo Meal Function Keys

Combo Meal Function Keys
Workstation operators can use the following function keys (if configured) with combo meals:

Table 31-7    Combo Meal Function Keys

Function Key Description

Auto Combo This key allows the workstation operator to create one or
more combo meals from existing menu items.

Combo This key changes the selected item or the last item on the
check to a combo meal. The item must be a primary combo
item. For example, if the combo meal is a burger with fries
and a drink, the burger item must be the highlighted item
or the last item ordered before pressing this key.

Combo Alternate Side This key allows the workstation operator to substitute a
combo meal side with a selection from another combo
meal group (for example, when a customer orders an
appetizer instead of an entree in a combo meal).
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Table 31-7    (Cont.) Combo Meal Function Keys

Function Key Description

Combo Bulk Order This key allows the workstation operator to order multiple
combo meals at a time. The workstation operator must
meet each combo’s side item requirements before moving
on to order the next combo’s side items.

Combo Multi Selection This key allows the workstation operator to select existing
menu items to combine into a combo meal. This function
shows the check detail in a window, which allows the
workstation operator to select individual items to make up
the combo meal. This gives the workstation operator
greater control in determining what is included in the
combo meal.

Un-Combo This key separates an existing combo meal into individual à
la carte items (non-combo pricing takes effect).

Type - Combo Order Size This key changes the order size before ordering the combo
meal.

Type - Combo Size 1-4 These keys change the combo size after ordering the combo
meal. Using these keys causes the workstation to resize the
selected combo meal or combo meal side item to selected
sizes 1 through 4. If the workstation operator does not
select an item, the last item on the check is resized.

Related Topics

• Combo Meal Group Pricing

• Placeholder Menu Items in Combo Meals

• Creating Combo Meal Groups

• Creating Combo Meals

• Configuring Additional Combo Meal Settings

• Creating Combo Meal Pages

• Configuring a Smart Key to Show Menu Level Buttons
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32
Guest Checks

A guest check contains a record of all sales on the check, from the guest’s initial menu item
to final payment.

Configuring Guest Check Numbers
The guest check number can be between 1 and 99999999 (an eight-digit number). Generally
check numbers are created in sequential order. If a workstation operator begins check
number 10000007, the next check number for the revenue center is 10000008. Check
numbers are maintained at the revenue center.

If the property has multiple revenue centers and wants to keep unique check numbers for
each revenue center, you can assign an exclusive range or check numbers per revenue
center. For example, Revenue Center 1 could have checks from 1000 to 1999 and Revenue
Center 2 could have checks from 2000 to 2999.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. To set guest check numbers to generate automatically, enter the Min Guest Check # and
the Max Guest Check # on the General tab.

When Simphony generates check numbers automatically, after reaching the Max Guest
Check # value, the next check number is the Min Guest Check # value.

3. To enable workstation operators to manually assign guest check numbers, click the
Options tab, and then select 1 - Operator Assigns Check Numbers.

This option is used at properties that have guest checks with pre-printed numbers.

4. Click Save.

Configuring Guest Check Headers and Trailers
Guest check headers and trailers are leading and trailing lines that print on guest checks.
Typically, the header lines include the name of the property or revenue center and address.
The trailer lines generally show gratitude or promotional information about upcoming events.
At hotels, guest check trailers are often configured to show room charge information for the
customer to complete. You can also set a header or trailer line to print logos rather than text.

Headers print automatically on guest checks. You must set trailers to print per tender/media
record.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
either Guest Check Headers or Guest Check Trailers.

2. For each row, enter information in the following fields:

• Text: Enter the text to appear on the header or trailer.

• (Optional) Use Logo: Select this option to print a logo rather than text on the guest
check header or trailer.

• (Optional) Logo: If you selected Use Logo, select an image.
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3. Click Save.

4. To configure trailers to print for each tender media record, select the Enterprise,
property or zone, click Configuration, and then click Tender/Media.

5. Double-click the tender record.

6. Click the Options tab, and then click the Printing Options subtab.

7. Set the appropriate options as described in the following table:

Table 32-1    Trailer Printing Options for a Tender Record

Option Description

20 - Print Sales Itemizers Select this option to print the sales
itemizer lines on guest checks, customer
receipts, and memo checks when
workstation operators use the tender
record. Deselect this option to suppress
printing of the sales itemizers.

21 - Print Summary Totals Select this option to print the summary
totals (subtotal, tax, amount due, and
change due) on guest checks, customer
receipts, and memo checks when
workstation operators press the key.
Deselect this option to suppress printing
of the summary totals.

22 - Print Check Trailer Select this option to print the guest check
trailer lines at the end of the guest check.

28 - Print Guest Check Trailer on Fast
Transaction Customer Receipt

Select this option to print the guest check
trailer on the customer receipt when
workstation operators use the tender to
close a fast transaction. Deselect this
option to prevent the trailer from
printing on customer receipts.

8. Click Save.

Creating a Service Total to End the Current Service Round
of Checks

You can configure the following two types of service totals. Both types are used to end
the current service round of guest checks:

• Service totals that send menu items to order devices, end the current service
round, and post totals

• Service totals that send menu items to order devices, end the current service
round, post totals, and print to order devices

1. To have the service total send menu items to order devices:

a. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

b. Insert a new record, enter a name for the new tender record (for example,
Send), and then double-click the new tender record.
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c. From the Key Type drop-down list, select Service Total.

d. Click Menu Levels, and then select the Main and Sub Levels on which the service
total is active.

e. Click Save.

2. To have the service total send menu items to order devices and print the guest check:

a. Select the Enterprise or property, click Configuration and Tender/Media.

b. Insert a new record, enter a name for the new tender record (for example, Print), and
double-click the new tender record.

c. From the Key Type drop-down list, select Service Total.

d. Click Options and then click Printing Options.

e. Select 23 - Print Check on Demand.

f. Click Menu Levels and select the Main and Sub Levels on which the service total is
active.

g. Click Save.

Adding a Service Total Key to the Transaction Page
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page (typically the Transaction page) on which to place the Service Total
function key.

3. On the Edit tab, select the page area in which to define the Service Total key.

4. Click Button.

5. On the General subtab, enter the function key name (for example, Service Total or Send
and Stay (if you are using Send and Stay functionality)) in the Legend field.

6. From the Type drop-down list, select Tender/Media.

7. Click the black arrow beneath the Type drop-down list.

8. Select the Service Total tender, and then click OK.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Configuring Pickup Next Check by Check Open Time
You can configure a function key to pick up the next check by open time. This function allows
a workstation operator to pick up the next check based on the time the check was opened.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.
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2. Double-click the transaction page on which you want the pickup next check by
check open time function key to appear on the workstation.

3. On the Edit tab, select the page area in which to define the Pickup Next Check
by Check Open Time key.

4. Click Button.

5. On the General subtab, enter the button name in the Legend field (for example,
Pickup Next Check by Check Open Time).

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list.

8. Enter pick in the Name field, select Pickup Next Check by Check Open Time in
the Results list, and then click OK.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Configuring Pickup Next Check by Service Total Time
You can configure a function key to pick up the next check by service total time. This
function allows a workstation operator to pick up the next check based on the service
total time, and is typically used in a drive-through environment.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Double-click the transaction page on which you want the pickup next check by
service total time function key to appear on the workstation.

3. On the Edit tab, select the page area in which to define the Pickup Next Check
by Service Total Time key.

4. Click Button.

5. On the General subtab, enter the button name in the Legend field (for example,
Pickup Next Check by Service Total Time).

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list.

8. Enter pick in the Name field, select Pickup Next Check by Service Total Time in
the Results list, and then click OK.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Configuring Open Checks on Revenue Centers to
Automatically Cancel

You can configure a revenue center (RVC) to automatically cancel any open checks
which have not already been cancelled (voided) or tendered by configuring the Purge
Order Threshold (in Minutes) field. Some customers wish to have all currently open
checks cancelled prior to running their Start of Day (SOD) daily system reset. This
setting is disabled by default with a zero setting. The minimum number of minutes for
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this field is 30. By default, point-of-sales (POS) Operations scans for all open checks every 5
minutes.

Essentially, enabling this functionality means no carried-over totals are generated on financial
reports for these RVC’s upon the completion of the daily start-of-day autosequence.

All automatically cancelled checks are posted on the Employee Closed Check Report from
the workstation or the Closed Checks report from Reporting and Analytics.

All EMC configurations for this functionality are tracked by the Audit Trail module.

To enable access privileges to configure this functionality, you must be assigned View and
Edit employee privileges (using the Roles module) for accessing the RVC Parameters
module.

See the Employees and Privileges chapter for more information about configuring
employee roles and EMC access privileges.

To configure the Purge Order Threshold (in Minutes) setting in EMC:

1. Access the EMC, select the revenue center, click Setup, and then click RVC
Parameters.

2. From the General tab, enter a time value in the Purge Order Threshold (in Minutes)
field and Save.

Fast Transactions
A Fast Transaction is a transaction that is started by selecting a menu item or scanning a
barcode to post a menu item rather than selecting a Begin Check function key. Workstation
operators can quickly start transactions by pressing a menu item key or scanning an item.
Fast transactions are used in quick service, concessions, bars, or retail environments where
a workstation operator begins transactions repeatedly, and rarely assigns customers to a
specific table or check number. A fast transaction is completed in a single service round, and
generates a customer receipt.

Related Topics

• Configuring Fast Transactions

Configuring Fast Transactions
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Options tab, and then select 15 - Allow Fast Transactions.

3. To prevent customer receipts from automatically printing after each fast transaction,
select 9 - On Demand Customer Receipts.

4. Click Save.

5. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Format Parameters.

6. Click the Options tab.

7. To print the check number at the bottom of the customer receipt to be used as an order
number, select 21 - Print order number at bottom of Receipts.

8. Click Save.
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9. Select the Enterprise, property, or zone, click Configuration, and then click
Tender/Media.

10. Double-click the tender record.

11. Click the Options tab, and then click the Printing Options subtab.

12. To print the guest check trailer on the customer receipt when a workstation
operator uses the tender to close a fast transaction, select 28 - Print Guest
Check Trailer on Fast Transaction Customer Receipt.

13. Click Save.

Related Topics

• Fast Transactions

Full Seat Checks
A full seat check shows each seat’s menu items with the subtotal separated by the
seat header. Unlike a seat check, each full seat check includes a check header, a
check trailer, and a paper cut.

Figure 32-1    Example of Full Seat Check

Related Topics

• Configuring a Print Full Seat Check Service Total

• Creating a Full Seat Check Button

Configuring a Print Full Seat Check Service Total
1. Select the Enterprise or property, click Configuration, and then click Tender/

Media.
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2. Add a new record, and then double-click it to open in form view.

3. Select 2 - Service Total from the Key Type drop-down list.

4. Click the Options tab, and then click the Printing Options subtab.

5. Select 16 - Print Full Seat Check.

If you also select 14 - Print Seat Check, option 16 overrides option 14.

6. Select 21 - Print Summary Totals.

7. Click the Menu Levels tab, and then select the Main and Sub Level on which the Print
Full Seat Check Service Total is available.

8. Click Save.

9. Add a touchscreen button for the tender/media record that you created in Step 2. 
Creating a Full Seat Check Button contains more information about configuring the
touchscreen button.

Related Topics

• Full Seat Checks

Creating a Full Seat Check Button
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page on which to place the Full Seat Check button.

3. On the Edit tab, select the page area in which to define the Full Seat Check button.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Tender/Media from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, and then select Full Seat
Check.

8. Highlight the Full Seat Check button.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Related Topics

• Full Seat Checks

Splitting Off an Item
A Split Off Item is a function key that enables workstation operators to separate (split) one or
more items from a multiple quantity menu item entry so that it can be modified independently
from the original item.

For example, a guest orders 3 burgers with 2 pieces of cheese and bacon. The guest then
later requests to add ketchup to one burger. The workstation operator uses Split Off Item to
separate one of the burgers and adds ketchup to it.
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Figure 32-2    Example of a Check Before and After Splitting an Item

When a workstation operator splits a multiple quantity menu item with condiments
(required or non-required condiments) the following results appear on the check:

• The condiments of the original item and their quantities are carried over to each
split item.

• The quantity of the original parent menu item is reduced by the number of items
split.

For example, if the workstation operator originally adds 3 burgers, after splitting one
item, the original item entry shows as 2 burgers while the new split entry shows as 1
burger.

Related Topics

• Configuring a Split Off Item Button

Configuring a Split Off Item Button
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page on which to place the Split Off Item button.

3. On the Edit tab, select the page area in which to define the Split Off Item button.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, and then select
Menu Item.
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8. Highlight the Split Off Item button.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Related Topics

• Splitting Off an Item

Adding the Assign Opera Account Button
After beginning a check, workstation operators can use the Assign Opera Account function to
validate a guest’s room number and last name. Upon validation, the confirmed OPERA
account detail is stored in a way that it can be recalled for payment at a later time.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the page on which to place the Assign Opera Account button.

3. On the Edit tab, select the page area on which to add the Assign Opera Account
function.

4. Click Button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, select Assign Opera
Account, and then click OK.

8. In the Style section, click the arrow to change the color of the button.

9. Position and size the button to the desired area and dimension on the page.

10. Click Save.

Conversational Ordering
Conversational ordering allows workstation operators to add specially configured menu items
for guests who order these items in no particular sequence. For example, in a coffee shop,
the workstation operator requires the following items:

• Drink Type (Espresso, Latte, Mocha, Tea)

• Drink Size (Small, Medium, Large)

• Drink Temperature (Hot, Iced)

• Condiments or Modifiers (Whipped Cream, Cinnamon, Skim Milk)

When using conversational ordering, the workstation operator adds the order as a guest
states items (for example, an iced mocha, medium size, with whipped cream), improving
Speed of Service (SOS), ease of ordering for guests, and overall order accuracy.

Setting up conversational ordering consists of completing the following tasks:

• Creating Menu Item Master Groups

• Configuring Menu Level Sets

• Configuring Menu Item Classes
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• Setting Menu Items

• Creating Front of House Buttons

Related Topics

• Creating Menu Item Master Groups for Conversational Ordering

• Configuring Menu Level Sets for Conversational Ordering

• Configuring Menu Item Classes for Conversational Ordering

• Configuring Menu Items for Conversational Ordering

• Configuring Menu Item Screen Look Ups by Menu Item Master Group

• Creating Buttons for Conversational Ordering

Creating Menu Item Master Groups for Conversational
Ordering

1. Select the Enterprise, property, or zone, click Configuration, and then click Menu
Item Master Groups.

2. Insert a new Menu Item Master Group.

In the coffee shop example, you could create the following groups: Espresso,
Latte, Mocha, and Americano.

3. Click Save.

Related Topics

• Conversational Ordering

Configuring Menu Level Sets for Conversational Ordering
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Level Sets.

2. Insert a new Menu Level Set.

In the coffee shop example, you could create Size and Temperature Menu Level
Sets.

3. Select the Default Master Group for each Menu Level Set.

In the coffee shop example, you could select Drinks as the Default Master Group.
When a workstation operators selects a Menu Level in this group, Simphony
determines which item of the selected Menu Item Group to apply to the check.

4. Double-click a Menu Level Set to open it in form view.

5. From the General section, select 2 - Bound to parent to bind the Menu Item
Master Group (for example, Drinks) to the custom Menu Levels (for example, Size
and Temperature).

When a guest initially orders a drink by either Size or Temperature, those menu
items link to the Menu Item Master Group, which also link to Anonymous Menu
Level Entry Options. This enables the workstation operator to add items in the
exact order that the guest states or orders them.

6. From the Menu Level Entries section, click Add.
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7. Enter menu level names for the Menu Level Set (for example, you could add Small,
Medium, and Large Menu Level Entries to the Size Menu Level Set).

8. For each Menu Level Entry, select the Default and Anonymous options.

Selecting these options enable the menu level sets to serve as temporary $0.00
placeholders for menu items when guests order them out of sequence.

9. Click Save.

Related Topics

• Conversational Ordering

Configuring Menu Item Classes for Conversational Ordering
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Insert a new Menu Item Class record.

• For each menu item that a guest can order through Conversational Ordering, create
at least two Menu Item Classes to accommodate the guest in ordering the same
menu item in different ways. In the coffee shop example, each coffee type might have
two classes: Latte Anonymous and Latte Defined. Create the Anonymous class first.

• Create a generic Menu Item Class to assign only to Menu Item Definitions that
are $0.00 priced menu items. In the coffee shop example, the Menu Item Class Drink
Anonymous can be used for Menu Item Definitions such as {SIZE} Large Drink or
{TEMP} Hot Drink. This Menu Item Class is assigned to the Default Master Group
named Drinks.

3. Double-click a Menu Item Class to open it in form view.

4. From the General tab, select 2 - Replace in Condiment Group from the Condiment
Order Type drop-down list.

Setting this option replaces the previously selected condiment with the latest condiment
choice when the workstation operator selects condiments. If you set the Increment
option, a priced condiment can be added to a transaction, such as a shot of espresso.

5. (Optional) Select the default parent to order from the Default Master Group drop-down
list.

In conversational ordering you can assign a default parent item to a condiment so that
when the condiment is ordered without an existing parent, Simphony orders the
condiment's default parent. For example, the condiment American Cheese has Burger as
its default parent. If the workstation operator orders American Cheese and there is no
current parent, Simphony orders the Burger automatically and the American Cheese
appears as a condiment on the burger.

Set this field only for condiments; it is meaningless for parent items.

6. Click the Options tab.

7. For each Menu Item Class with Anonymous in the name, select the following options:

• 8 - Allow Menu Items in this Class to be Non-Priced

• 49 - Participates in Menu Item Master Switching

• 50 - Anonymous Menu Item

8. For each Menu Item Class with Defined in the name, select the following options:
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• 8 - Allow Menu Items in this Class to be Non-Priced

• 49 - Participates in Menu Item Master Switching

9. For the generic Menu Item Class, select the following options:

• 8 - Allow Menu Items in this Class to be Non-Priced

• 49 - Participates in Menu Item Master Switching

• 50 - Anonymous Menu Item

10. Click the Condiment Groups tab.

11. For each Menu Item Class, select the appropriate condiment groups:

• Required Condiment Groups: These condiment groups must be entered
when a workstation operator adds menu items in this class.

• Allowed Condiment Groups: These condiment groups are allowed to be
entered as condiments for menu items in this class.

• Member Condiment Groups: These condiment groups consist of menu items
in this class.

12. Click Save.

Related Topics

• Conversational Ordering

Configuring Menu Items for Conversational Ordering
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Item Maintenance.

2. Insert a menu item master record for each menu item (including condiments) that
can be ordered using conversational ordering. You need to account for all potential
ordering combinations a guest might use. Use braces {} to surround the generic
variables such as {SIZE} and {TEMP}.

In the coffee shop example shown in the following figure, you might have records
for {SIZE} {TEMP} Drink, {SIZE} Hot Drink, and so on.
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Figure 32-3    Menu Item Master Records for Conversationally Ordered Items

3. Select the Major Group, the Family Group, and the Master Group.

4. Click the Definition Records tab in the lower area of the page.

5. Set the following for each record:

• Menu Item Class

• Menu Item Price

• Menu Level Availability

• Default Condiments

6. Click Save.

Related Topics

• Conversational Ordering

Creating Buttons for Conversational Ordering
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.
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2. Open the page on which to place menu item master buttons.

3. On the Edit tab, select the page area in which to define the menu items (including
condiments) (typically the transaction area).

4. Click Button to add a button.

5. On the General subtab, select the appropriate function from the Type drop-down
list.

6. Click the black arrow beneath the Type drop-down list.

7. Position and size the button on the page. Use the Style arrow to change the color.

8. In the Legend field, enter the button name.

9. Click Save.

10. Repeat these steps to create buttons for each of the menu item master names.

Related Topics

• Conversational Ordering

Configuring Employee Privileges for Automatic Check Firing
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click an employee role, click the Operations tab, and then click the Guest
Checks subtab.

3. Select the appropriate privileges. The following table describes the privileges
corresponding to automatic check firing.

Table 32-2    Employee Guest Check Privileges for Automatic Check Firing

Privilege Description

183 - Begin Autofire Check using [Begin
Autofire Check] Key

Select this option to allow employees in
this role to create checks with orders that
automatically fire at a preset time using
the Begin Autofire Check function key.

184 - Authorize/Perform Pickup of
Autofire Check Belonging to Another
Operator

Select this option to allow employees in
this role to pick up and edit checks with
orders that fire at a preset time from
other employees.

185 - Authorize/Perform Edit of Autofire
Date/Time

Select this option to allow employees in
this role to modify the date and time that
orders are set to automatically fire.

4. To allow employees in this role to generate the Autofire Open Check Report from
the workstation, click the Ad Hoc Reports subtab, and then select 31030 - Run
Autofire Open Check Report.

5. Click Save.

Configuring Automatic Check Firing (Autofire)
1. Select the revenue center, click Setup, and then click RVC Parameters.
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2. Click the Autofire tab, and then configure the fields as described in the following table:

Table 32-3    Automatic Check Firing Fields

Fields and Options Description

(Optional) Autofire Employee To allow a specific employee to become the
owner of all checks, including those placed
using Transaction Services after the orders
fire, select a workstation operator, and then
click OK.
• If you select an Autofire Employee, all

sales totals post to the designated
workstation operator and the checks
appear under the Autofire Employee in
the Open Check Report.

• If you do not select an Autofire
Employee, the check operator remains
the owner of the check after the order
fires.

Autofire Workstation Select the workstation from which the
orders fire and print. The application uses
this value to determine the order output
devices and workstation printers to use
when an order fires.

Default Autofire Tender/Media Select a service total that workstation
operators can use with Autofire.
You can assign any service total. Oracle
recommends configuring a separate service
total for automatic order firing to allow
workstation operators to identify the
designated touchscreen button. Creating a
Service Total to End the Current Round of
Checks contains information about
configuring a service total.

Backup Autofire Delay (Mins) Enter the amount of time (in minutes) that
the autofire workstation must try to fire the
orders.
After the Backup Autofire Delay time
elapses, if the autofire workstation is
unsuccessful at firing the order, the
workstation at which the check was
originally created tries to fire the order. If
both workstations fail, a memo chit prints
and a workstation operator must manually
fire the order.

(Optional) Maximum Days Enter the maximum number of days for
which workstation operators can schedule
orders to fire automatically.

(Optional) 1 - Print Autofire Memo at Time of
Entry

Select this option if you want a memo chit to
print when workstation operators create
orders that fire automatically.
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Table 32-3    (Cont.) Automatic Check Firing Fields

Fields and Options Description

(Optional) 2 - Print Guest Check at Time of
Autofire

Select this option if you want a guest check
to print when an order automatically fires to
order devices.
If you select this option, guest checks print at
the guest check printer assigned to the
autofire workstation.

3 - Enable Autofire in this Revenue Center Select this option to allow the revenue
center to create orders that fire
automatically.
If you are using DOM, do not enable Autofire
or hold and fire.

3. Click Save.

4. Select the Enterprise, property, revenue center, or zone, click Descriptors, and
then click Autofire Check Offline Header.

5. From the Text column, enter the header lines to print on memo chits when orders
fail to fire automatically.

6. To add a logo to the header, select Use Logo, click the ellipsis point (...) button
from the Logo column, select the logo from the list, and then click OK.

7. Click Save.

8. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

9. Insert a new button on the transaction page, select Function from the Type drop-
down list, and then select Begin Autofire Check from the Function list.

10. Click Save.

Configuring Employee Privileges for Check Re-firing
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click an employee role, click the Operations tab, and then click the
Transaction subtab.

3. To allow employees in this role to re-fire items in a previous round, select 293 -
Authorize/perform re-fire Menu item.

4. Click Save.

Configuring the Check Re-fire Button
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the transaction page on which to place the Re-fire button.

3. On the Edit tab, select the page area in which to define the Re-fire button.

4. Click Button.
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5. On the General subtab, enter the button name (for example, Re-fire Pending Checks) in
the Legend field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, select Re-fire, and then
click OK.

8. Position and size the button on the page. Use the Style arrow to change the color.

9. Click Save.

Suspend and Resume
With the Suspend and Resume feature, workstation operators can:

• Suspend a check started by another employee, and sign on to the workstation.

• Suspend a check when the workstation automatically signs off an employee.

• Suspend a check using a Service Total key.

When suspended, the check is stored in the memory until a workstation operator resumes it
by signing on to a workstation.

Related Topics

• Configuring Suspend and Resume

• Creating a Suspend and Resume Button

• Setting the Employee Auto Sign Out Period

Configuring Suspend and Resume
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Options tab, and then select 60 - Enable Suspend/Resume.

3. Click Save.

4. Select the Enterprise, property, or zone, click Configuration, and then click Tender/
Media.

5. Insert a record with the tender name.

6. Double-click the tender record.

7. On the General tab, select 2 - Service Total from the Key Type drop-down list.

8. Click the Options tab, and then click the Ops Behavior subtab.

9. Select 74 - Suspend Order.

10. Click Save.

11. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Tender Parameters.

12. Click the Configuration tab.

13. To configure a default Suspend Order tender, in the Default Suspend Order Tender
drop-down list, select the suspend order tender.

A default Suspend Order tender is needed for certain suspend scenarios, such as when a
workstation operator is auto-signed out or when another operator signs in.
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14. Click Save.

Related Topics

• Suspend and Resume

Creating a Suspend and Resume Button
To allow workstation operators to manually suspend a check, you need to add a button
assigned to the service total tender record.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the Suspend/Resume button.

3. On the Edit tab, select the page area in which to define the Suspend/Resume
button.

4. Click Button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Tender/Media from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, select the tender
you created for the suspend and resume service total, and then click OK.

8. Position and size the button on the page. Use the Style arrow to change the color.

9. Click Save.

Related Topics

• Suspend and Resume

Setting the Employee Auto Sign Out Period
To automatically suspend a check and sign out an employee, you need to define the
automatic operator popup interval.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Control Parameters.

2. Click the Configuration tab.

3. In the Automatic Operator "Popup" Interval (min:sec) field, enter the amount of
time (in minutes and seconds) that the workstation waits before signing out an
inactive popup workstation operator.

4. Click Save.

Related Topics

• Suspend and Resume

Follow Me
Follow Me extends the functionality of the suspend and resume feature in Simphony.
Follow Me allows workstation operators to use suspended checks across workstations
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in the same revenue center. This feature increases speed of service in a pub or fast casual
restaurant environment.

For example, a pub may have three workstations and up to twelve bartenders working
simultaneously. Each bartender can sign on and sign off at any workstation. A bartender can
begin a check on workstation 1, prepare a drink, suspend the check (via idle timeout, manual
suspend, or other employee sign on), and then sign on to workstation 2 to resume the check.
The check is automatically resumed on workstation 2. Any menu items, discounts, and
service charges that were added on workstation 1 appear on workstation 2. A check can be
open on only one workstation at a time.

The journal logs the suspend and resume history of each check and lists the workstation on
which the suspend and resume transaction was performed.

Related Topics

• Configuring Follow Me Checks

Configuring Follow Me Checks
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Options tab, and then select 68 - Enable Follow Me.

When you set Follow Me, option 60 - Enable Suspend/Resume dims, and vice versa.
You cannot select both Follow Me and Suspend/Resume; they are mutually exclusive.
When you set Follow Me, each workstation in the revenue center participates in the
Follow Me operation.

3. Select the property, click Setup, and then click Workstations.

4. On the General tab, enter information in the fields as described in the following table:

Table 32-4    Workstation Timeout Settings

Timeout Setting Description

Check Inactivity Timeout Enter the number of seconds that the
workstation waits before prompting the
workstation operator to cancel a transaction.
If you set this value to 0 (zero), the Cancel
dialog does not appear.
If you select 68 - Enable Follow Me from the
RVC Parameters module, the guest check is
automatically suspended rather than
cancelled.

Check Inactivity Dialog Timeout Enter the number of seconds that the
workstation shows the Do you need more
time? Inactivity dialog before automatically
cancelling the transaction. If you set this
value to 0 (zero), the Cancel dialog does not
appear.

5. Click Save.

Related Topics

• Follow Me
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Order Handling on Open Checks
This section describes how to configure the following Simphony features:

• Send and Stay: Send orders to order devices (such as remote printers or a
Kitchen Display System (KDS)) when performing a Service Total while the guest
check remains open

• Timed Fire: Manually or automatically send items on a guest check to order
devices in groups over a period of time at preset times

Related Topics

• Configuring Send and Stay

• Adding a Service Total Key to the Transaction Page

• Setting the Hold and Fire Option

• Setting the Hold and Fire Tender Notification

• Setting a Reminder for Items on Hold

• Configuring Checks with Items on Hold to End Current Service Round

• Configuring Check Handling For Closing Checks With Held Items

• Configuring Item Hold Buttons

Holding and Sending Items to Order Devices
The following table describes how to configure the workstation to hold and send menu
items on open guest checks to order devices.

Table 32-5    Configure Workstations to Hold Items on Guest Checks

Task More Information

Enable option to hold items on guest
checks and add touchscreen buttons

Setting the Hold and Fire Option

Enable workstation notifications for held
menu items when tendering

Setting the Hold and Fire Tender Notification

Configure workstations to remind
workstation operators of checks with
items on hold after signing into the
workstation

Setting a Reminder for Items on Hold

Configure guest checks with items on hold
to end current service round and add
touchscreen buttons

Setting Checks with Items on Hold to End
Current Service Round

Configure how to handle items on hold
when closing checks

Setting Check Handling with Items on Hold
when Closing Checks

(Optional) Configure Check Screen Look
Up (SLU) to display checks with only held
items

Configuring Check Screen Lookup (SLU) to
Show Checks with only Held Items

Related Topics

• Configuring Send and Stay
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• Adding a Service Total Key to the Transaction Page

• Setting the Hold and Fire Option

• Setting the Hold and Fire Tender Notification

• Setting a Reminder for Items on Hold

• Configuring Checks with Items on Hold to End Current Service Round

• Configuring Check Handling For Closing Checks With Held Items

• Configuring Item Hold Buttons

Configuring Send and Stay
Follow these instructions to configure the Service Total to send items to be prepared while the
check remains open.

1. Select the property, click Configuration, and then click Tender/Media.

2. Insert a Service Total record if it does not exist.

3. Double-click the record to open it.

4. On the General tab, select 2 - Service Total from the Key Type drop-down list.

5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 95 - Send Order.

7. Click Save.

8. Add a touchscreen button for the tender/media record that you created in Step 2. Adding
a Service Total Key to the Transaction Page contains more information about configuring
a service total touchscreen button.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Setting the Hold and Fire Option
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Options tab, and then select 70 - Enable Hold and Fire.

Do not enable hold and fire if you are using DOM.

3. Click Save.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Setting the Hold and Fire Tender Notification
1. Select the revenue center, click Setup, and then click Control Parameters.
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2. Click the Options tab, and then select 66 - Enable Hold and Fire Final Tender
Notification.

This notification indicates that unfired menu items are on a check during the final
tender process.

3. Click Save.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Setting a Reminder for Items on Hold
1. Select the Enterprise level, click Setup, and then click Control Parameters.

2. Click the Configuration tab.

3. In the Confirm Threshold Period for Items on Hold (minutes) field, enter the
time that elapses before notifying workstation operators of checks with items on
hold.

If you set the Confirm Threshold Period for Items on Hold (minutes) to 0, the
workstation shows a reminder each time a workstation operator signs on to the
workstation.

4. Click Save.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Configuring Checks with Items on Hold to End Current
Service Round

1. Select the property, click Configuration, and then click Tender/Media.

2. Insert a new record and name it Hold Order.

3. Double-click the new tender to open it.

4. On the General tab, select 2 - Service Total from the Key Type drop-down list.

5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 2- Hold Order from the Hold Type drop-down list. The Hold Type is used
with Hold and Fire to establish the order device output instructions for menu items
on the guest check. The following options are available.

• 0 - Fire Order: Sends all menu items, including items on hold, to order
devices. Items that you configure to send at a preset time are exempt from this
service total type.

• 1- Keep Held Status: Sends all items to the order device except those on
hold.

• 2- Hold Order: Holds the entire guest check.

7. Click Save.
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8. Repeat Steps 2 through 7 and configure service totals for Fire Order and Keep Held
Status.

9. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

10. Open the Front of House touchscreen page (typically the Transaction page) on which to
place the service total buttons.

11. On the Edit tab, select the page area in which to define buttons, and then click Button.

12. On the General subtab, select Tender/Media from the Type drop-down list.

13. Click the black arrow directly beneath the Type drop-down list, select Hold Order, and
then click OK.

14. Position and size the button on the page, and then click Save.

15. Repeat Steps 11 through 14 and add touchscreen buttons for the Fire Order and Keep
Held Status service total keys.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Configuring Check Handling For Closing Checks With Held
Items

1. Select the property, click Configuration, and then click Tender/Media.

2. Double-click a Service Total tender record to open it.

3. Click the Options tab, and then click the Ops Behavior subtab.

4. In the Tender Media Hold Types section, select a Hold Type for each type of Service
Total tender used when making a payment and closing a guest check. The following table
describes the Hold Types and their affect on the workstation messages.

Table 32-6    Hold Types and Workstation Messages

Hold Type Workstation Message When Closing a Check with Items
on Hold

0 - Fire Order Select this option to send all items on hold to the order
devices. This is the default Hold Type.

1 - Keep Held Status Select this option to show a message asking the
workstation operator whether to send the items on hold
to the order devices or to close the check without
sending the items.

2 - Hold Order Select this option to show a message asking the
workstation operator whether to send the items on hold
to the order devices or to close the check without
sending the items.

5. Click Save.

Related Topics

• Order Handling on Open Checks
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• Holding and Sending Items to Order Devices

Configuring Item Hold Buttons
To allow workstation operators to hold items on a check without sending to order
devices, you need to add buttons to the touchscreen page.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the buttons, and then on the Edit tab, select the
page area in which to define the buttons.

3. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

4. Click the black arrow directly beneath the Type drop-down list, select Transaction
from the Type pane, and then select one of the following functions:

• Hold: Holds the menu items selected in the check detail area.

• Hold Transaction: Holds every successive menu item added to the check
during the current round.

• Timed Fire Menu Item: Holds selected items or an entire check until a
predefined time.

• View Fire Times: Shows the time each menu item is configured to send to
order devices

5. Click OK, enter a Legend for the button, and then position and size the button on
the page.

6. Repeat Steps 3 through 5 and configure buttons for the remaining hold functions in
Step 4, and then click Save.

Related Topics

• Order Handling on Open Checks

• Holding and Sending Items to Order Devices

Configuring the Fire Now Button
To allow workstation operators to fire items on a check from the current service round
to order devices, you need to add a Fire Now button to the touchscreen page.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the button, and then on the Edit tab, select the
page area in which to define the button (for example, a menu item selection page).

3. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

4. Click the black arrow directly beneath the Type drop-down list, select Fire Now
from the Type pane, and then select the Service Total configured as the Fire Now
Service Total.
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5. Click OK, enter a Legend for the button (for example, Fire Now), and then position and
size the button on the page. The selected Tender Media’s number appears in the
Arguments field for the Fire Now function.

6. Click Save.

Team Service
Team Service allows assignment of more than one service personnel to a check. A team of
service personnel can work together when there is a large party requiring more than one
server. In some environments (usually high-end fine dining establishments), Team Service is
used exclusively, regardless of the party size.

Tip and receipt totals are divided equally on the Employee Tip Report among all team
members when a team check is closed. This allows resulting pay out of tips or service
charges to be paid equally among the team members. As the Employee Tip Report is used
for income reporting purposes for tax authorities, tax liabilities are shared equally among
team members. See Reports and Totals Posting for Team Checks for more information.

Team members can access checks where they are assigned as part of the team, even if they
are not the check owner. This is independent of Role option 18 - Authorize/Perform Pickup
of a Check Belonging to Another Operator.

Related Topics

• Enabling Team Service

• Configuring Team Service Privileges

• Configuring Revenue Centers to Delete Service Teams at the Start of Day

• Adding Team Service Buttons

Reports and Totals Posting for Team Checks
Team Service only affects Employee Tip Report totals. The Employee Financial Report is not
impacted. When a team check is closed, all totals post as usual to the Employee Financial
Report of the check operator. Totals posted to the Employee Tip Report are distributed
equally among all members of the team.

The following table shows an example result from totals posting of a team check with three
team members. Totals post only to the Employee Financial Report of the check owner
(Employee 1) while totals are distributed equally among all team members on the Employee
Tip Report.

Table 32-7    Sample Totals Posting for Team Checks

Report Name Total Employee 1 Employee 2 Employee 3

Employee
Financial

Net Sales $ 3000.00 $ 0 $ 0

Employee
Financial

Charge Tips $ 300.00 $ 0 $ 0

Employee Tip
Report

Gross Receipts $ 1000.00 $ 1000.00 $ 1000.00

Employee Tip
Report

Charge Tips $ 100.00 $ 100.00 $ 100.00
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Totals posted to the Employee Tip Report outside of a team check, such as those from
regular guest checks or employee tip declarations, are posted in the normal manner.

This reporting is visible in both Ad Hoc Reports available at the workstation and in
Reporting and Analytics Reports.

Related Topics

• Enabling Team Service

• Configuring Team Service Privileges

• Configuring Revenue Centers to Delete Service Teams at the Start of Day

• Adding Team Service Buttons

Enabling Team Service
1. Select the Enterprise, property, revenue center, or zone, click Setup, and then

click Format Parameters.

2. Click the Options tab, and then select 29 - Enable Team Service.

3. To print the names of all team members on guest checks, select 41 - Print Team
Member Names on Guest Check.

4. Click Save.

Related Topics

• Team Service

• Reports and Totals Posting for Team Checks

Configuring Team Service Privileges
1. Select the Enterprise, click Configuration, and then click Roles.

2. Double-click the role type, click the Operations tab, and then click the
Miscellaneous subtab.

3. Select the appropriate privileges. The following table summarizes the privileges
associated with Team Service and the recommended roles to have the privilege
set:

Table 32-8    Team Service Privileges

Option Number Privilege Name Allows the Employee to ...

190 Authorize/Create Team Create a team and add
initial team members to it,
and to authorize others to
do so.

191 Authorize/Add or Delete
Team Member to a Team

Add or delete members to
an existing team, and to
authorize others to do so.

192 Authorize/Delete a Team Delete an existing team,
and to authorize others to
do so.
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Table 32-8    (Cont.) Team Service Privileges

Option Number Privilege Name Allows the Employee to ...

193
7

Print a list of Teams
Validate Employee Direct/
Indirect Tips Declared
Transaction

Print a team list showing
the name of the team and
all assigned members, and
to authorize others to do
so.
To actually print a team
member list, you are also
required to enable a
revenue center level
option. Access the EMC,
select the Revenue Center
where the team members
were assigned, click the
RVC Configuration tab,
under the General
Options section, enable
option 7–Validate
Employee Direct/Indirect
Tips Declared
Transaction, and then
Save. Repeat this step for
each revenue center as
needed.

196 Available as Team Service
Team Member

Appear in selection lists
when assigning team
member.

4. Click Save.

Related Topics

• Team Service

• Reports and Totals Posting for Team Checks

Configuring Revenue Centers to Delete Service Teams at the
Start of Day

You can configure Simphony to automatically remove all teams on a daily basis for locations
that use Team Service as a standard of operation. As team members usually change each
day based on employee scheduling and availability, this allows managers to create new
teams each day without having to edit or delete previous teams.

1. Select the Enterprise or property, click Configuration, and then click Task Schedules.

2. Insert a new record, and then double-click the record to open it.

3. On the General tab, select 7 - Workstation as the Service Type, and then select 3 -
Reset Team Service as the Task Type.

4. Select 4 - Recurring - Daily as the Schedule Type, select Enabled, and then select the
Start Date.

5. Click the Recurrence tab.

6. In the Daily Frequency section, set the time at which to run the task, and then click Save.
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7. Repeat Steps 2 through 6 to create another task, but change the Service Type to
8 - Check and Posting.

Related Topics

• Team Service

• Reports and Totals Posting for Team Checks

Adding Team Service Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page on which to place the Team Service buttons, and then on the Edit
tab, select the page area in which to define the buttons.

3. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

4. Click the black arrow directly beneath the Type drop-down list, and then select
Check Begin Pickup from the Type pane.

5. Select Begin Team Check, and then click OK.

The Begin Team Check key allows workstation operators to start a team check. If
the workstation operator is a member of multiple teams, the workstation shows a
list of teams.

6. Enter a Legend for the button (for example, Begin Team Check), and then
position and size the button on the page.

7. Click Save.

8. Repeat Steps 3 through 7 and add buttons for the following functions:

• Create Team Members or Add Team to Check: Creates, edits, or deletes a
team; adds a team to a check; and prints a team list.

• Edit Team: Shows team information and allows member editing.

• Remove Team from Check: Removes the team from a check.

Related Topics

• Team Service

• Reports and Totals Posting for Team Checks

Allowing Employees to Edit Guest Check ID on Open Check
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, click the Operations tab, and then click the Guest
Checks subtab.

3. To set permission to edit the check ID, select 81 - Authorize/Perform Edit of
Guest Check ID In an Open Check.

4. Click Save.

Chapter 32
Adding Team Service Buttons

32-28



Closed Guest Check Operations
After a check is closed, you can allow workstation operators to perform these operations:

• Adjust Closed Check: Change or add a tip, tender, or guest count to a closed check
without reopening it.

• Reopen Closed Check: Reopen the check and use as a regular guest check. All menu
items from the check are considered previous-round items.

• Reprint Closed Check: Reprint checks for a closed transaction in the current or previous
business dates.

• Reprint Previous Closed Check: Reprint a receipt for the last closed check.

Note:

If users are allowed to reopen, adjust, or void closed checks, be aware of the
following RVC Parameters options settings and their effect on the Check Count
value on reports:

• Whether RVC Parameters option 73 - Keep The Same Check Number When
a Closed Check is Voided is enabled or not, it has no impact on the Check
Count value on reports.

• When RVC Parameters Posting option 5 - Zero or Negative Transactions Do
Not Add to Guest or Guest Check Counts is enabled, and you close a check
with a 0.00 or negative amount, the Check Count value does not increment and
remains the same value on reports.

• When RVC Parameters Posting option 5 - Zero or Negative Transactions Do
Not Add to Guest or Guest Check Counts is enabled, when you perform the
Reopen Closed Check or Void Closed Check functions on a closed check, the
Check Count value remains the same value on reports.

• When you initially close a check with a positive amount, the Check Count value
has already been incremented to 1, so when you perform the Void Closed
Check function on the same check, the Check Count value remains the same
on reports.

Related Topics

• Configuring Closed Check Settings

• Allowing Employees to Adjust Closed Checks

• Allowing Employees to Reopen and Edit a Closed Check

• Allowing Employees to Reprint Closed Checks

• Allowing Employees to Manually Replay Checks Through the Workstation

Configuring Closed Check Settings
1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click

Control Parameters.
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2. Click the Configuration tab, and then enter information in the following fields:

• Number of Days to Adjust Closed Checks: Enter the number of days (0-14)
a privileged employee can adjust closed checks. Enter 0 to allow the
adjustment for the current business day only.

• Number of Days to Reopen/Reprint Closed Check from Previous
Business Day: Enter the number of days (0-14) a privileged employee can
reopen or reprint closed checks. Enter 0 to allow checks from the current
business day only to be reopened or reprinted.

3. To allow privileged operators to service total reopened checks, click the Options
tab, and then select 31 - Allow Service Total of Closed Checks.

4. Click Save.

5. To retain the original guest check number when reopening a closed check and
voiding menu items:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Click the Options tab, and then select 73 - Keep The Same Check Number
When a Closed Check is Voided.

If deselected, Simphony assigns a new guest check number to the closed
check when reopened and voided.

c. Click Save.

6. To configure reprinting of closed checks:

a. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

b. Insert a Service Total tender record if it does not exist.

c. Double-click the Service Total record to open it.

d. On the General tab, select 2 - Service Total as the Key Type.

e. Click the Options tab, and then click the Printing Options subtab.

f. Select 19 - Reprint Check.

Setting option 19 does not print an exact copy of the receipt unless the printing
options are the same as the original tender.

You can enable other options to include elements of the check, such as 21 -
Print Summary Totals or 22 - Print Check Trailer, but selecting these
options is not required.

g. Click Save.

h. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Tender Parameters.

i. Click the Configuration tab, and then in the Default Reprint Check Tender/
Media drop-down list, select the Service Total tender from step 6-b.

j. Click Save.

Related Topics

• Closed Guest Check Operations
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Allowing Employees to Adjust Closed Checks
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, click the Operations tab, click the Guest Checks subtab, and
then select the appropriate options:

• 67 - Authorize/Perform Adjust Closed Check: Select to allow employees with this
role to use the Adjust Closed Check function key, and to authorize others to do so. A
closed check adjustment allows the user (if privileged to void Tender/Media from a
previous round) to adjust the tender/media, charge tip, or the number of guests on a
closed check.

• 133 - Auth/Perform Adjust Closed Check from Previous Business Days: Select
to allow employees with this role to adjust closed checks from previous business
days.

3. Click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

5. Open the page on which to place the Adjust Closed Check buttons.

6. On the Edit tab, select the page area in which to define the buttons.

7. Click Button, and then on the General subtab, select Function from the Type drop-down
list.

8. Click the black arrow directly beneath the Type drop-down list, and then select Check
Begin Pickup from the Type pane.

9. Select the appropriate function key, and then click OK.

• Adjust Closed Check: Prompts for the check number of the closed check to adjust.

• Adjust Closed Check From List: Prompts to select a closed check to adjust from a
list of checks for the current business day.

When adjusting a check using either function key, workstation operators can edit tenders,
charge tips, and the number of guests on the check, but the check itself is not reopened.

10. Enter a Legend for the button, and then position and size the button on the page.

11. (Optional) Repeat Steps 7 through 10 and configure a button for the remaining Adjust
Closed Check function in Step 9, and then click Save.

Related Topics

• Closed Guest Check Operations

Allowing Employees to Reopen and Edit a Closed Check
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, click the Operations tab, click the Guest Checks subtab, and
then select the appropriate options:

• 68 - Authorize/Perform Reopen Closed Check: Select to allow employees with this
role to use the Reopen Closed Check key, and to authorize others to do so.
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• 134 - Auth/Perform Reopen Closed Check from Previous Business Days:
Select to allow employees with this role to reopen closed checks from previous
business days.

3. Click the Voids/Returns subtab, and then select the appropriate options:

• 69 - Authorize/Perform Void of Menu Items on Closed Checks: Select to
allow employees with this role to void menu items from closed checks after
they have been reopened, and to authorize others to do so. You must also
select Roles option 25 - Authorize/Perform Void of Menu Items from a
Previous Round.

• 70 - Authorize/Perform Void of Discounts on Closed Checks: Select to
allow employees with this role to void discounts from closed checks after they
have been reopened, and to authorize others to do so. You must also select
Roles option 27 - Authorize/Perform Void of Discounts from a Previous
Round.

• 71 - Authorize/Perform Void of Service Charges on Closed Checks: Select
to allow employees with this role to void service charges from closed checks
after they have been reopened, and to authorize others to do so. You must
also select Roles option 28 - Authorize/Perform Void of Service Charges
from a Previous Round.

4. Click Save.

5. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

6. Open the page on which to place the Reopen Closed Check buttons.

7. On the Edit tab, select the page area in which to define the buttons.

8. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

9. Click the black arrow directly beneath the Type drop-down list, and then select
Check Begin Pickup from the Type pane.

10. Select the appropriate function key, and then click OK.

• Reopen Closed Check: Prompts for the check number of the closed check to
reopen.

• Reopen Closed Check From List: Reopens the closed checks selected from
a list of closed checks available on the current workstation.

11. Enter a Legend for the button, and then position and size the button on the page.

12. Repeat Steps 8 through 11 to create a button for the remaining Reopen Closed
Check function in Step 10, and then click Save.

Related Topics

• Closed Guest Check Operations

Allowing Employees to Reprint Closed Checks
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, click the Operations tab, click the Printing subtab, and
then select the appropriate options:
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Table 32-9    Check Reprinting Options

Option Description

23 - Authorize/Perform Unlimited
Reprinting/Printing of a Check

Select to allow employees associated with
this role to perform two functions:

a. Allow On-Demand operators to print
more guest checks than the maximum
number allowed.

b. Allow By-Round operators to use the
Reprint Closed Check key.

Selecting this option also allows employees
to grant authorization to others for these
functions.

24 - Authorize/Perform Reprinting of Closed
Checks

Select to allow employees with this role to
reprint a closed guest checks and to
authorize others to do so.

3. Click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

5. Open the Front of House page on which to place the Reprint Closed Check buttons.

6. On the Edit tab, select the page area in which to define button.

7. Click Button, and then on the General subtab, select Function from the Type drop-down
list.

8. Click the black arrow directly beneath the Type drop-down list, and then select Print from
the Type pane.

9. Select Reprint Closed Check, and then click OK.

When this function key is used, the Default Reprint Check Tender assigned in Tender
Parameters is used to print the check.

10. Enter a Legend for the button, and then position and size the button on the page.

11. Repeat steps 7 through 10 to create a Reprint Previous Closed Check button.

This function key is used to reprint a receipt for the last closed check.

12. Click Save.

Related Topics

• Closed Guest Check Operations

Allowing Employees to Manually Replay Checks Through the
Workstation

Beginning with Simphony version 2.9.2, you must grant employees permission to manually
replay offline checks through the Property Management Console (PMC), if an offline POS
workstation fails to automatically replay its checks before reconnecting online.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type record (for example, administrator or manager).

Chapter 32
Allowing Employees to Manually Replay Checks Through the Workstation

32-33



3. Click the Operations tab, and then click the PMC General/Reports subtab.

4. Select 30001 - Run PMC to allow employees associated with this role to launch
the PMC on workstations using the Launch PMC function key.

5. Click the PMC Procedures subtab, and then select 30069 - Replay Checks from
the Other Procedure Options section.

6. Click Save.

Related Topics

• Closed Guest Check Operations

Check Add/Transfer
Transferring checks is a procedure that changes ownership of a guest check.
Simphony enables privileged workstation operators to transfer checks from another
server to themselves by employee number or by employee ID number. Guest checks
may also be transferred across Revenue Centers. The Transfer Checks function only
transfers the ownership of the guest check; it does not transfer the check’s sales totals
for reporting purposes.

Add Check means to combine two checks together while in a transaction.

Related Topics

• Allowing Employees to Add or Transfer Checks

• Configuring the Add/Transfer Revenue Centers

• Configuring Add/Transfer Buttons

Allowing Employees to Add or Transfer Checks
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type record (for example, administrator, manager or server).

3. Click the Operations tab, and then click the Guest Checks subtab.

4. Select the appropriate permission options for the user role:

• 45 - Authorize Transfer of Checks in the Same Revenue Center: Select to
allow employees with this role to transfer checks from another operator within
the same revenue center, and to authorize others to do so.

• 46 - Authorize Transfer of Checks Between Revenue Centers: Select to
allow employees with this role to transfer checks from another revenue center,
and to authorize others to do so.

• 47 - Authorize Adding of Checks in the Same Revenue Center: Select to
allow employees with this role to add checks (to be in a check, and add
another check to it) within a revenue center, and to authorize others to do so.

• 48 - Authorize Adding of Checks Between Revenue Centers: Select to
allow employees with this role to add checks (to be in a check, and add
another check to it) from another revenue center, and to authorize others to do
so.

5. Click Save.
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Related Topics

• Check Add/Transfer

Configuring the Add/Transfer Revenue Centers
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. On the General tab, scroll down to the Add/Transfer Revenue Center section, and then
select up to eight revenue centers from which checks can be transferred into this revenue
center.

3. Click Save.

4. Repeat Steps 1 through 3 for all revenue centers in the property.

Related Topics

• Check Add/Transfer

Configuring Add/Transfer Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Page Design.

2. Open the page on which to place the Add/Transfer buttons.

3. Click the Edit tab, and then select the page area in which to define the buttons.

4. Click Button, and then on the General subtab, select Function from the Type drop-
down list.

5. Click the black arrow directly beneath the Type drop-down list, select Check Add from
the Type pane.

6. Select one of the following function keys, and then click OK:

• Add/Transfer by Number: Adds or transfers a check within the same revenue center
using the check number entered.

• Add/Transfer Check by Number RVC Index: Adds or transfers a check (using the
check number) from the revenue center specified in the Index field. The Index field
points to one of the eight revenue centers configured in the Add/Transfer section of
the RVC Parameters module.

• Add/Transfer Check by Number Prompt RVC: Adds or transfers a check (using the
check number) from one of the eight add/transfer revenue centers configured in the
RVC Parameters module.

• Add/Transfer Check by Table: Adds or transfers a check within a revenue center.
The workstation client prompts for the table number or table ID of the check to be
added or transferred.

• Add/Transfer Check by Table RVC Index: Adds or transfers a check (using the
table number or table ID) from the revenue center specified in the Index field. The
Index field points to one of the eight revenue centers configured in the add/transfer
section of the RVC Parameters module.

• Add/Transfer Check by Table Prompt RVC: Adds or transfers a check (using the
table number or table ID) from one of the eight add/transfer revenue centers
configured in the RVC Parameters module.
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• Add/Transfer Check From List Prompt RVC: Prompts users for the revenue
center, and then shows all open checks that can be added or transferred from
others within the specified revenue center.

• Add/Transfer Check From List RVC Index: Shows all open checks in the
revenue center (specified by the Index field) that can be added or transferred
from others. The Index field points to one of the eight revenue centers
configured in the Add/Transfer section of the RVC Parameters module.

• Add/Transfer Check SLU: Shows a list of checks that can be added or
transferred from other workstation operators on the Open Check SLU.

7. Enter a Legend for the button, and then position and size the button on the page.

8. Repeat Steps 4 through 7 to create buttons as needed for the remaining Add/
Transfer functions in Step 6.

9. Click Save.

Related Topics

• Check Add/Transfer

Seat Filtering and Memo Checks
You can configure check filtering by one or more seat numbers, allow workstation
operators to apply a tender only for the detail and summary totals associated with the
seat, and if required, allow workstation operators to create a check for the filtered
seats. This enables workstation operators to:

• Review check detail posting to facilitate the delivery of meals to the proper guest

• Print checks for one or more seats, or for groups of seats in a large party without
creating separate checks

For example, a party of four arrives at the restaurant. A workstation operator begins a
check for the table, assigning a seat number to each order. When the party has
completed the dining experience, guests at seats 1 and 2 want to pay and leave
before the guests at seats 3 and 4. The workstation operator can:

1. Filter the check by seats 1 and 2.

2. Apply a tender and close the check for the filtered seats.

3. If configured, print a memo check.

4. Close the check by tendering the remaining seats.

After applying a tender to a filtered check, items belonging to the filtered seat or seats
are removed from the primary guest check.

The check for the filtered seats is referred to as a memo check. After closing a memo
check, depending on the configuration, the active seat in the filter increments to the
next seat number, and menu items associated with that seat appear in the check detail
area. A memo tendered check contains the same information as the primary check
when closed, such as service team details, event details, and suite owner details.

Workstation operators can identify memo checks on the Check Journal Report by the
MEMO CHECK banner on the check header and in ad-hoc reports, as well as on the
printed check.
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Figure 32-4    Sample Check Filtered by Seats

Figure 32-5    Sample Printed Memo Check

If a workstation operator prints a memo check before applying a tender to the filtered seats,
the memo check prints with the check number of the primary check. If a workstation operator
prints a memo check after applying a tender and closing the check, a new check number is
assigned to the check that is closed. This check numbering continues until the last items on
the check are tendered, which closes the primary check and retains the number.

Applying Discounts on Memo Checks

Workstation operators can apply manual discounts to a memo check.
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• If one seat is in the active seat filter, the manual discount is applied to the seat that
is filtered, and the indicator next to the discount shows the seat number in the
check detail.

• If multiple seats are in the active seat filter, the manual discount is applied to all
seats that are in the seat filter, but not on the remaining items on the primary
check. The indicator next to the discount shows the letter F in the check detail as
the discount is applied to multiple seats.

• If there is no active seat filter, the manual discount is applied to the entire check.
There is no indicator next to the discount in the check detail.

If an automatic or coupon discount is applied to the primary check, Simphony
recalculates the discount when the check is filtered by seats. That is, Simphony
applies the automatic or coupon discount to the memo check only if the menu items for
the filtered seats are eligible for the discount.

Performing Operations on a Memo Check

The following conditions apply when performing operations on a memo check:

• When the check is filtered by multiple seats, new menu items, discounts, and
service charges are added to the lowest seat number.

• Workstation operators cannot perform the following functions when a seat filter is
active:

– Fire Now

– Next #/Next Seat

– Touch Split

– Begin Check

– Pick Up Check

– Transfer Check

• Simphony supports assigning up to 65 seats to a check.

Performing Memo Tenders When Using a Kitchen Display System (KDS)

The following conditions apply to the KDS when performing a memo tender:

• KDS Reports and report drill downs do not account for memo tendered or split
checks in check counts, timings, and check detail.

• Check modifications such as adding new menu items to a check, adding or editing
condiments, and the voiding of existing menu items are not allowed when the
following Dynamic Order Mode (DOM) types are enabled:

– Fire on Fly

– Fire on Next

– Fire on Tender

Related Topics

• Configuring Memo Check Printing

• Configuring Service Charges for Seat Filtering

• Configuring Seat Filter Management Buttons
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Configuring Memo Check Printing
1. Select the Enterprise or property, click Configuration, and then click Tender/ Media.

2. Insert a new record, name it Print Memo Check, and then click OK.

3. Double-click the Print Memo Check record to open it.

4. From the Key Type drop-down list, select 2 - Service Total.

5. Click the Options tab, click the Printing Options subtab, and then select the following
options:

• 13 - Print Memo Check: Select to allow this key to print memo checks.

• (Optional) 15 - Increment Active Seat # after Memo Check Print: Select to
increment the active seat number on the seat filter or active memo check number to
the next number each time this key is used to print. This allows workstation operators
to, in succession, generate Memo Checks or to apply Memo Tenders. When this
option is selected, pop-up operators remain signed in when the seat filter is reset.
Deselect to reset the seat filter when this key is used to print.

Select 13 and (optionally) 15 for all tender medias that can be used for Memo Tendering.

6. Click Save.

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Open the page on which to place the memo check button.

9. On the Edit tab, select the page area in which to define the buttons.

10. Click Button, and then on the General subtab, select Tender/Media from the Type drop-
down list.

11. Click the black arrow beneath the Type drop-down list, select Print Memo Check from
the list and then click OK.

12. Enter a Legend for the button (for example, Print Memo Check), and then position and
size the button on the page.

13. Click Save.

14. (Optional) To prompt for the guest count for memo checks:

a. Select the Enterprise, property, revenue center, or zone, click the Setup tab, and
then click Control Parameters.

b. Click the Options tab, and then select 9 - Prompt for Guest Count when Split
Check.

Related Topics

• Seat Filtering and Memo Checks

Configuring Service Charges for Seat Filtering
When a check is filtered by seats, automatic service charges prorate based on the active
menu items. Manual service charges do not prorate when seat filtering is active. Instead, the
manual service charge is added to the last memo check that is closed for the table. To set
manual service charges to prorate based on the filtered seats:
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1. Select the Enterprise, property, or zone, click Configuration, and then click
Service Charges.

2. Insert a record for either an automatic or a manual amount service charge with
prorate option, or double-click an existing automatic or manual service charge
record to open it.

3. On the General tab, select option 2 - On = Amount; Off = Percentage, and then
enter the service charge value in the Amount field under General Settings.

4. If required for your country, select the Tax Class from the drop-down list.

5. Select option 30 - Prorate Service Charges to Menu Items.

When selected, the service charge prorates based on the value of the menu items
in the filtered seats. This overrides the requirement for the minimum number of
guest count for a memo check, if the minimum guest count requirement is met for
the entire check.

6. If you are configuring a manual amount service charge with prorate option,
complete the following substeps to prorate to all menu items with corresponding
service charge itemizers:

a. Click the Itemizers tab, and then select all service charge itemizers.

b. Click the Menu Levels tab, and then select the appropriate Main and Sub
Levels.

7. Click the Output tab, and then select Print on Customer Receipt, Print on
Journal, and Print on Guest Check.

8. Click Save.

Related Topics

• Seat Filtering and Memo Checks

Configuring Seat Filter Management Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page on which to place the memo check button.

3. On the Edit tab, select the page area in which to define the buttons.

4. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

5. Click the black arrow beneath the Type drop-down list, and then select Guest
Seat from the Type pane.

6. Select one of the following function keys, and then click OK:

• Manage Seat Filter: A pop-up screen appears showing all available seats on
the guest check, and lets you add or remove seats interactively from the seat
filter.

• Add to Seat Filter: Prompts you for a seat number that is to be filtered (if no
seat filter is active), or adds the seat number to an active seat filter.

• Remove From Seat Filter: Prompts you for the seat number that you want to
remove from the current seat filter.

• Clear Seat Filter: Removes all seats from the current seat filter.
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• Edit Seat: Allows you to change the seat number of previously ordered menu items.

7. Enter a Legend for the button, and then position and size the button on the page.

8. Repeat Steps 3 through 6 and create buttons for the remaining functions in Step 6.

9. Click Save.

Related Topics

• Seat Filtering and Memo Checks
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33
Workstation Touchscreen Pages

A touchscreen page is a defined layout of functions and buttons that you configure in the
EMC. The touchscreen page appears on the workstation, allowing workstation operators to
perform operations and transactions on the POS client.

Page templates allow you to customize a workstation touchscreen page in various ways.
Page templates are categorized into the following types:

• Classic templates: These templates are similar to Simphony First Edition touchscreen
templates

• Blank templates: These templates are used for customized pages or a Sign On page

• Tabbed templates: These templates are used for Sign On and Transaction pages

Tabbed templates allow the greatest functionality. With a tabbed template, you can configure
multiple tabs on the page. Approximately 50 tabs and subtabs can appear on a page, and
each tab and subtab contain up to 50 buttons. Having a large number of buttons on a single
page allows you to configure a small number of pages for a revenue center. A tab is used for
navigation. Navigation on a page is consistent from page to page (navigation bar and
subtabs).

Pages can contain buttons and more sophisticated content, such as dining tables, Screen
Lookups (SLUs), numeric entry areas, and background panels for highlighted groups of
controls. All buttons performs a function.

The content appearing on a page can be dynamic based on the menu levels, serving period,
employee class, or other criteria. For example, you can show a Manager Functions tab only if
the manager is assigned to one of three manager employee classes.

When editing pages from the Page Design module, what-you-see-is-what-you-get.

Page Design
A touchscreen page is a defined layout of functions and buttons that you configure in the
EMC. The touchscreen page appears on the workstation, allowing workstation operators to
perform operations and transactions on the POS client.

Page templates allow you to customize a workstation touchscreen page in various ways.
Page templates are categorized into the following types:

• Classic templates: These templates are similar to Simphony First Edition touchscreen
templates

• Blank templates: These templates are used for customized pages or a Sign On page

• Tabbed templates: These templates are used for Sign On and Transaction pages

Tabbed templates allow the greatest functionality. With a tabbed template, you can configure
multiple tabs on the page. Approximately 50 tabs and subtabs can appear on a page, and
each tab and subtab contain up to 50 buttons. Having a large number of buttons on a single
page allows you to configure a small number of pages for a revenue center. A tab is used for

33-1



navigation. Navigation on a page is consistent from page to page (navigation bar and
subtabs).

Pages can contain buttons and more sophisticated content, such as dining tables,
Screen Lookups (SLUs), numeric entry areas, and background panels for highlighted
groups of controls. All buttons performs a function.

The content appearing on a page can be dynamic based on the menu levels, serving
period, employee class, or other criteria. For example, you can show a Manager
Functions tab only if the manager is assigned to one of three manager employee
classes.

When editing pages from the Page Design module, what-you-see-is-what-you-get.

Related Topics

• Configuring Function Keys

• Configuring Macros

Assigning Default Touchscreen Pages
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Assignment.

2. Click the Configuration tab, and then configure the following settings:

• Default Sign In Page: Select the page to show when workstation operators
are not signed on to a workstation.

• Default Transaction Page: Select the page to show for workstation operators
who sign on to this location when a transaction page is not defined (through
operator, Employee Class, and so on).

• Default Training Page: Select the page to show for workstation operators in
training mode. If you select 0 - None, employees in training mode see the
default touchscreen based on the touchscreen hierarchy.

3. Click Save.

Configuring Function Keys
Function keys allow workstation operators to perform a variety of tasks, such as
beginning a guest check, opening a cash drawer, authorizing a credit card, transferring
checks, printing customer receipts, and many other operations.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place a function key.

3. On the Edit tab, select the page area in which to define the function key.

4. Click Button.

5. On the General subtab, enter the key name in the Legend field.

6. From the Type drop-down list, select Function.

7. Click the black arrow beneath the Type drop-down list.

8. Select the appropriate function, and then click OK.
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9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

Related Topics

• Page Design

Configuring Macros
A macro is a button that, when pressed, executes a series of commands. Macros save time
when workstation operators frequently enter certain sequences or keystrokes. You can set
macros to include menu items, service charges, discounts, tenders, function keys,
alphanumeric keys, or a link to another macro.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the page on which to place the macro button.

3. On the Edit tab, select the page area in which to define the macro button.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. From the Type drop-down list, select Function.

7. Click the black arrow directly beneath the Type drop-down list, select the Macro function,
and then click OK.

8. Click the Edit Macro Keys button, and then add the appropriate steps in the proper
sequence.

9. Highlight the macro button.

10. Position and size the button on the page. Use the Style arrow to change the color.

11. Click Save.

Related Topics

• Page Design
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34
Rental Deposits

Rental deposits are used in Simphony to record advance payments on scheduled events,
such as banquets, parties, room rentals, or as a security deposit on loaned items, such as
bowling shoes. The Rental Deposits feature allows workstation operators to accept, apply,
record, report, and refund rental deposits taken at the POS client.

A rental deposit can be a menu item or a non-revenue service charge. Unlike traditional non-
revenue service charges, a check can contain more than one rental deposit.

Automatic discounts are not applied to rental menu items as the discount amount can change
when other items are added to the check.

Related Topics

• Configuring Deposits as a Menu Item

• Configuring Deposits as a Service Charge

• Configuring Rental Deposit Buttons

Configuring Deposits as a Menu Item
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then

click Menu Item Classes.

2. Insert a new record for the rental item (for example, Bike Rental or Bowling Shoes).

3. Double-click the new record to open it, and then click the Options tab.

4. Select 64 - Rental Deposit, and then click Save.

Enabling this option makes all menu items assigned to this class Rental Deposits. You
can use this option with the Deposit Handling feature to apply a deposit to a check.

5. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

6. Insert a new record and name it the same as the rental item.

7. Double-click the new record to open it, insert a definition record, and then click the
General tab.

8. From Menu Item Class, select the class that you created in Step 2, and then click Save.

9. Select the revenue center, click Setup, and then click RVC Parameters.

10. On the General tab, select the rental item that you created in Step 6 from the Deposit
Forfeit Return Item (Menu Item) drop-down list, and then click Save.

11. Add a button for the rental item to the workstation Transaction page. See Adding Menu
Item Keys to the Transaction Page for instructions.

Related Topics

• Rental Deposits
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Configuring Deposits as a Service Charge
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Menu Item Classes.

2. Insert a new record for the rental service charge (for example, Banquet Service
Charge or Conference Room Rental Service Charge).

3. Double-click the new record to open it, and then click the Options tab.

4. Select 64 - Rental Deposit, and then click Save.

5. Select the Enterprise or property, click Configuration, and then click Service
Charges.

6. Insert a new record and name it the same as the rental service charge.

7. Double-click the new record to open it.

8. On the General tab, select 23 - Rental Deposit, and then configure the following
settings:

• 1 - On = Open; Off = Preset: Select to make the rental deposit service charge
an open service charge, prompting workstation operators for the amount or
percentage. Deselect to use a preset amount or preset percentage for the
rental deposit service charge.

• 2 - On = Amount; Off = Percentage: Select to make the rental deposit
service charge an amount service charge. Deselect to make the rental deposit
service charge a percentage service charge.

9. Click Save.

10. Select the revenue center, click Setup, and then click RVC Parameters.

11. Click the Options tab, and then select 67 - Use Service Charge as Deposit
Forfeit Return Item.

12. Click the General tab, and then select the service charge that you created in Step
6 from the Deposit Forfeit Return Item (Service Charge) drop-down list.

13. Click Save.

Related Topics

• Rental Deposits

Configuring Rental Deposit Buttons
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Page Design.

2. Open the page on which to place the Rental Deposit buttons.

3. Click the Edit tab, and then select the page area in which to define the buttons.

4. Click Button, and then on the General subtab, select Function from the Type
drop-down list.

5. Click the black arrow directly beneath the Type drop-down list, select Transaction
from the Type pane.

6. Select one of the following function keys, and then click OK:
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• Apply Deposit: Applies a deposit to an active guest check containing a rental
deposit.

• Edit Deposit: Modifies information for the current or future rounds for a deposit in the
check detail area.

• Show Deposit: Refunds a deposit on a closed check, or prints a rental deposit report
for all deposits or a selected deposit.

Note:

When a Partial Refund is applied, references to the deposit no longer
appear on the Rental Apply Deposit screen. Refunds can only be applied
once.

7. Enter a Legend for the button, and then position and size the button on the page.

8. Repeat Steps 4 through 7 and create buttons for the remaining Rental Deposit functions
in Step 6.

9. Click Save.

10. If you configured a deposit as a service charge, add a button for the Deposits service
charge to the transaction page. Creating Service Charge Buttons contains instructions.

Related Topics

• Rental Deposits
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35
Resetting Daily Totals

A business day refers to the beginning and end times of a day of business. A business day
can have any begin time, but typically a business day starts in the early morning hours during
a slow or closed period of operations (for example, 3:00 a.m. or 4:00 a.m.). A calendar day
always begins at 12:00 a.m.

To reset daily check and employee totals, a property or revenue center must start a new
business day.

Start of Day
Start of Day (SOD) is the process that begins a new business day at a property. The SOD
can be set to run automatically or manually.

When the time of day occurs that a new business day is automatically configured to start (for
example, at 4:00 a.m. each day), the following actions occur in the order listed:

• Simphony increases the Business Day and updates the status of checks and employees.

• The PC Autosequence runs, and typically performs the following actions:

– Batches and settles credit cards

– Runs custom applications for a property

• After the SOD Asequence completes, Simphony checks to see whether it is time to run
other autosequences (such as Start of Week Autosequence, Start of Pay Period
Autosequence, and so on).

Many properties like to start a new business day manually at their own time (after a night
auditor balances reports). Often these properties stop their Simphony and property
management systems at the same time, roll to a new business day, and then bring the
systems back up. An administrator can manually run SOD in Simphony using an interaction
called PC Autosequence (from the EMC) or by pressing a button on the workstation. When
SOD begins manually, Simphony performs the same actions as if it were run automatically.
The only difference is the method by which SOD begins.

Related Topics

• Configuring Start of Day

Start of Day Business Rules
Simphony has business rules to determine how and when a business day can begin, and
which business day is beginning. The rules exist for both automatic and manual SOD.

When starting a new business day, the following rules apply:

• SOD cannot be run twice in 8 hours.

• SOD cannot be run twice between midnight and noon.

• SOD cannot be run twice between noon and midnight.
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• When a business day is scheduled to run automatically, it is not possible to start
the business day manually with a PC Autosequence.

A business day is calculated based on noon (12:00 p.m.) to noon times.

• If SOD is run before noon, Simphony assumes the business day completed is for
the previous calendar day. (If SOD runs at 3:05 a.m. on the 17th, the 16th is the
business day that is closing, and the 17th is the business day being started.)

• If SOD is run after noon, Simphony assumes the business day completed is for the
current calendar day. (If SOD is run at 11:52 p.m. on the 17th, the 17th is the
business day that is closing, and the 18th is the business day being started.)

Related Topics

• Configuring Start of Day

Start of Day with Offline Workstations or Server
Workstations are aware of the business date configuration so that offline reports show
relevant information. Consider the following scenario:

• Every business day begins at 3:00 p.m.

• On Tuesday at approximately 11:00 a.m., a property loses communication with the
database (the property is in Yellow Mode).

• The site is offline until Friday afternoon.

In this situation, workstations run reports as if SOD occurred. For example, a report
taken for today on Wednesday at 4:00 p.m, shows data from Wednesday at 3:00 a.m.
(the time SOD would have occurred) to the current second when the report was taken.
In addition, if days are configured for manual SOD, workstation reports assume that
the business day begins 24 hours after the previous SOD occurred. In this situation, a
dialog box appears on workstations informing the manager that a new business day
has begun.

Catch-Up mode increases the business day after the Simphony server goes offline
during an automatically scheduled SOD time period. Consider the following scenario:

• SOD is set to run automatically at 4:00 a.m.

• At 2:00 a.m., the Simphony server experiences a power failure.

• At 6:00 a.m., the Simphony server is online again.

In Catch-Up mode, the SOD Autosequence does not start. With Catch-Up mode, the
business day still starts at 4:00 a.m. When Simphony comes online at 6:00 a.m., the
PERIOD_INSTANCE table is populated with rows to indicate that the business day
started. The rows do not show a 6:00 a.m. run time, however. Catch-Up mode knows
that the application was supposed to have started at 4:00 a.m., so the rows are
created with 4:00 a.m. as the start time. Simphony can catch-up from up to two missed
automatic start of days and make the appropriate PERIOD_INSTANCE entries.

Related Topics

• Configuring Start of Day

Configuring Start of Day
1. Select the Enterprise level, click Configuration, and then click Roles.
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2. Select the role type (such as manager), click the Operations tab, and then click the PMC
Procedures subtab.

3. Select the appropriate start of day role privileges:

• 30058 - Run Start of Day from OPS: Select this option to allow all employees with
the role to increment the business date from the property’s Check and Posting
Service (CAPS) workstation.

• 30059 - Prevent Running SOD from OPS with Open Checks: Select this option so
that Start of Day (SOD) cannot run when open checks exist.

4. Click Save.

5. To allow a manager or administrator to manually run SOD from a workstation, select the
Enterprise, property, or revenue center, click Configuration , and then click Page
Design. Otherwise, skip to Step 14.

6. Select the page on which to place the Start of Day button.

The Start of Day button allows a manager or administrator to manually run the Start of
Day on a workstation.

7. Add a Start of Day button:

a. In the Legend field, enter Run Start of Day.

b. From the Type drop-down list, select Function.

c. Click the arrow beneath the Type drop-down list, and then select Start of Day.

d. Position and size the new button on the page.

8. Click Save.

9. Select the property, click Setup, and then click Property Parameters.

10. Click the Options tab.

11. To allow a manager or administrator to manually run SOD from a workstation, select 48 -
Run Start of Day from OPS.

12. Click the Calendar tab.

13. Select Run Manually for each day of the week.

14. In the Manual SOD Safety catch time field, set the time when the application
automatically increments the business date if someone forgets to manually run SOD.

The application checks to see whether SOD occurred within a 24-hour period for the
selected property. This time is based on the time zone of the property.

15. Click Save.

16. Select the Enterprise level, click Configuration, and then click PC Autosequences.

17. Insert a PC Autosequence record and name it Increment Business Day.

18. Open the record, and then select the Allowed Properties to view the autosequence.

19. (Optional) Add Parameters as appropriate. For example, you can enter a property
number and exclude a revenue center number.

20. On the Steps tab, add a step, and then from the Step Type drop-down list, select 3 -
Increment Business Date.

21. Click Save.
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Related Topics

• Start of Day

• Start of Day Business Rules

• Start of Day with Offline Workstations or Server
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36
Updating POS Client Configuration

You can establish the frequency with which database synchronization jobs run on the
workstations. By default, the workstations and Kitchen Display System (KDS) Controllers wait
30 minutes to retrieve the latest updates from the database.

The Database Update Frequency setting exists in three EMC modules:

• Property Parameters

• Workstations

• KDS Controller

The Workstations module setting or KDS Controller module setting takes precedence over
the Property Parameters setting. If the workstation’s Database Update Frequency setting is
greater than the Property Parameters setting, the highest configured value within the entire
Workstations module for the property is used for the purge jobs event scheduling calculation.

Setting the Database Update Frequency
1. Select the property, click Setup, and then click Property Parameters.

2. Click the Workstations tab.

3. In the Database Update Frequency field, enter the number of seconds that workstations
and KDS Controllers wait to retrieve the latest updates from the database.

4. Click Save.

5. To override this setting for the workstation, select the property, click Setup, and then click
Workstations.

6. Double-click the workstation.

7. On the General tab, set the Database Update Frequency timeout value.

8. Click Save.

9. To override this setting for the KDS, select the property, click Setup, and then click KDS
Controllers.

10. Double-click the KDS record.

11. On the General tab, set the Database Update Frequency timeout value.

12. Click Save.
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37
Clearing Totals

If you have the appropriate privileges, you can purge unwanted transaction totals
accumulated during testing and training periods prior to going live. Clearing totals
immediately purges the totals for all of the designated property’s revenue centers from the
Enterprise. You cannot clear totals for individual revenue centers.

The Clear Totals operation performs the following tasks:

• Immediately purges the property’s transaction totals and check related data on and prior
to the selected business date from the Enterprise

• Initiates a request to run a purge job for the reporting database (Oracle Hospitality
Reporting and Analytics Advanced) totals

• Purges the MRequest Queues data

• Purges the Journal log file data

• (Optional) Purges Cash Management data

After the Clear Totals operation begins, two data purging events are scheduled to run for the
following purge jobs:

• Check and Posting Service (CAPS) Database: This event runs first based on the
Database Update Frequency setting, plus an additional 30 minutes. When the scheduled
time is reached, the application purges the designated property’s CAPS database.

• Workstation DataStore Data: This event runs second based on the Database Update
Frequency setting, plus an additional 45 minutes. When the scheduled time is reached,
the application purges the DataStore data from the designated property’s workstations.

Running the Clear Totals Operation
Before clearing totals, you must batch and settle all credit card transactions dated prior to the
specified business date. You cannot clear totals when unbatched credit cards exist. Oracle
recommends that you generate and save all credit card related reports from either the EMC
or Oracle Hospitality Reporting and Analytics for historical reference.

Time Zone synchronization between the Simphony application server and workstations is
important for the Clear Totals operation to work correctly. The CAL keeps the time settings on
Simphony clients in sync with the Simphony application server. Some devices do not use
CAL for configuration, and these devices can become out of sync with the Simphony
application server. Therefore, before running the Clear Totals operation, ensure that the time
settings on non-CAL devices are set to match the Simphony application server’s time settings
as closely as possible.

1. Select the property, click Tasks, and then click Clear Totals.

2. Select the Business Date from the drop-down list.

3. Click Clear Totals. The Result window shows the status of each purged job.

4. Select the property, click Setup, and then click Workstations.
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5. Look at the column named Totals Cleared Through, and verify that the date and
time appear in the column for each workstation at the property.

6. Double-click the Check and Posting Service (CAPS) workstation, and then click
the Service Host tab.

7. Verify that the date and time appear in the Totals Cleared Through column for
the CAPS workstation.

EGateway log files show the date and time a Clear Totals operation was performed.

Chapter 37
Running the Clear Totals Operation

37-2



38
Check and Posting Service (CAPS)

The Check and Posting Service (CAPS) is a required service that runs on-premises at the
property. CAPS acts as the bridge between the Enterprise and the property, providing
resiliency and increasing system performance. As workstation operators perform transactions
and other operations on POS clients, CAPS stores the information and then posts in real-time
to the Enterprise. Each property must have CAPS configured because without it, information
occurring on the POS clients does not post to the Enterprise.

In the event of a WAN outage, POS clients are largely unaffected as they continue to post
transactions to the on-premises CAPS. During a WAN outage, the Enterprise is inaccessible
to the property; changes made in EMC are not reflected on POS clients, and Reporting and
Analytics reports do not include the live transactions. Other systems and functions that rely
on Enterprise connectivity are similarly impacted. When the WAN connection is restored,
CAPS posts the information to the Enterprise.

CAPS also serves as the arbitrator of check sharing by maintaining a record of check
ownership. This minimizes the likelihood of multiple POS clients having conflicting versions of
a check.

Some properties perform a large volume of transactions that overwhelm the POS client
workload. For these environments, it may be necessary to run CAPS on a PC with
significantly more computing resources and disk space. The information in this chapter
explains the variety of configuration methods for CAPS.

The Oracle Food and Beverage Compatibility Matrix contains a list of software and hardware
supported with CAPS.

CAPS Configuration Methods
Beginning with Simphony version 2.9, you can run the CAPS web application on Microsoft
Internet Information Services (IIS) and also have the CAPS database reside on an Oracle
database.

Running CAPS as a web service is an alternative method to running CAPS as a Windows
service and a workstation-based service. In Simphony versions earlier than 2.9, CAPS runs
only on a Microsoft SQL Server database and the embedded Simphony Service Host Webkit
web server.

CAPS needs to be on-property regardless of which configuration fits the business
architecture. CAPS holds state information of checks and hence, the CAPS service must be
on sticky sessions. The CAPS service cannot reside behind a load balancer.

You can run CAPS using one of the following types of configuration methods:

• CAPS Running on a POS Client Workstation (along with the POS client)

• CAPS Running on a POS Client Workstation (without the POS client)

• CAPS Running as a Windows Service with Oracle database

• CAPS Running as a Windows Service with Microsoft SQL Server database
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• CAPS Running as a Web Service on Microsoft Internet Information Services (IIS)
with Oracle database

• CAPS Running as a Web Service on Microsoft IIS with Microsoft SQL Server
database

Table 38-1    CAPS Configuration Methods

CAPS Configuration
Details

CAPS on a POS
Client Workstation CAPS as a Windows

Service

CAPS as a Web
Service on Microsoft

IIS

CAPS Database Microsoft SQL
Express

Oracle Database
Microsoft SQL
Server

Oracle Database
Microsoft SQL
Server

CAPS Service Host POS client CAPS Only CAPS Only

Hardware All supported Oracle
MICROS
workstations

All supported
Microsoft Windows
Servers

All supported
Microsoft Windows
Servers

CAPS Configuration Tool
To facilitate CAPS configuration, you can use the CAPS Configuration Tool. The CAPS
Configuration Tool is packaged with the Simphony 18.1 release during an installation
or upgrade, deploys on the Simphony server to the [Drive
letter]:\MICROS\Simphony2\Tools folder, and is named CAPSConfigurator.

If privileged to do so, when you click CAPSConfigurator, use your EMC logon
credentials to sign on to the tool. The tool provides an option to upgrade CAPS to
future versions of Simphony, create the CAPS database schema on either an Oracle
or Microsoft SQL Server database. The tool can also assist you in configuring the
service on IIS, and finally, it can authenticate CAPS on existing Services Hosts running
instances of CAPS on IIS.

Figure 38-1    CAPS Configurator Tool
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Configuring CAPS Access contains important information about enabling the privileges to
access the CAPS Configuration Tool.

Prerequisite Products for CAPS
The following prerequisite products are required when using CAPS as a web service on
Microsoft Internet Information Services (IIS), unless otherwise noted.

• Simphony Release 2.9 or Later

• Database Platform (one of the following):

– Oracle Database 12c Server

– Oracle Database 12c Standard Edition

• Operating System Components:

– Microsoft IIS

– Microsoft .NET Framework 4.6.1

Tasks to Set Up CAPS as a Web Service on Microsoft Internet Information
Services (IIS)

Setting up CAPS as a web service consists of completing the following tasks:

• Allowing access to the CAPS Configuration Tool

• Enabling users to install and authenticate workstations

• Configuring the Service Host for CAPS in the EMC

• Installing CAPS database software

• Configuring the CAPS database

• Configuring the Service on Microsoft IIS

Configuring CAPS on Microsoft IIS with Oracle Database on
Enterprise Server

The option to run CAPS on an Enterprise server is only available for licensed Simphony
customers. The Simphony cloud services do not support this feature.

Configuring CAPS Access contains important information about enabling the privileges to
access the CAPS Configuration Tool.

Configuring CAPS Access
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.

3. Select the following Miscellaneous options:

• 10061 - Allow Access to the IIS CAPS Configurator Tool
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• 10065 - Download Software, Install and Authenticate Clients and Service
Hosts Using CAL

4. Click Save.

Note:

Before you perform an upgrade to Simphony 18.1 from Simphony
versions 2.9.x or 2.10, you need to ensure that the options described
above are enabled before running the post-upgrade CAPS Configuration
Tool. Specifically, if option 10065 is disabled prior to the upgrade, after
the upgrade, an error message appears during your login to the CAPS
Configuration Tool . If you click OK on the error message window, you
can log onto the CAPS Configuration Tool, but you cannot utilize the
Authenticate CAPS button (added to the CAPS Configuration Tool for
the Simphony 18.1 release).

Configuring the Service Host for CAPS in EMC
Follow these steps to configure the Service Host for a hosted Enterprise with
Simphony Premium Cloud Service users:

1. Select the Enterprise level, click Setup, and then click Service Hosts.

2. Insert a new Service Host record, and then double-click it to open in form view.

3. In the Host Name field, enter the host name of the Simphony application server
where Microsoft IIS is running.

4. Enter the Subnet Mask and the Default Gateway of the Enterprise server.

5. Click Save.

6. Select the property, click Setup, and then click Property Parameters.

7. Click the Workstations tab.

8. From the Service Hosts section, select the CAPS Service Host created in Step 1,
and then enter the Port number for CAPS configuration. For example, port number
8050.

This port is the unused port number and is different from the EGateway service
port.

9. Click Save.

Configuring CAPS with an Oracle Database
1. Run the ODP.NET_12CR2.bat under the current directory with administrator

privileges from a command prompt.

2. Navigate to the directory containing the CAPSConfigurator folder.

Depending on your configuration method, the path is one of the following:

• [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
• [Drive

Letter]:\MICROS\Simphony\CAPSonIIS\Tools\CAPSConfigurator
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3. Double-click CAPSConfigurator, enter the server and port number of the EGateway, and
sign in using your EMC credentials. A list of Service Hosts appears.

4. Click the Service Host to configure.

5. Click CAPS Schema.

6. Enter the appropriate information in the CAPS Schema dialog, and then click Next.

• Database: Select the Oracle database type.

• Server: Enter the server name.

• Port: Enter the port number.

• Service name: Enter the service name.

• Admin User: Enter the administrative user name used to sign onto the Oracle
database server, for example, the system user name. This user name cannot be a
DBA user.

• Password: Enter the current user’s password to sign onto the Oracle database
server.

7. In the next CAPS Schema dialog, enter the User Name, Password, and Confirm
Password to create a new database user for the CAPS database, and then click Next.

8. Click OK to confirm. A message indicates success.

The CAPS Schema dbsettings.xml is configured at one of the following directories
(depending on your configuration):

• [Drive Letter]:\MICROS\Simphony2\IISCAPSServiceHost
• [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost
Configuring CAPS Access contains important information about enabling the privileges to
access the CAPS Configuration Tool.

Configuring CAPS on Microsoft IIS
In the CAPS Configurator Tool, click Configure CAPS.

The CAPS Configurator Tool detects and configures the new Service Host. Upon successful
configuration, the configured check box in the UI is automatically selected for the configured
Service Host. A browser opens with the configured CAPS URL.

CAPS is configured at [Drive
Letter]:\MICROS\Simphony2\EgatewayService\IISCAPSServiceHost.

Configuring CAPS Access contains important information about enabling the privileges to
access the CAPS Configuration Tool.

Configuring CAPS on Microsoft IIS with Oracle Database on
Remote Service Host

The CAPS service must run on the same server where the Oracle database is installed.

Configuring CAPS Access
1. Select the Enterprise level, click Configuration, and then click Roles.
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2. Select the role type, click the Operations tab, and then click the Miscellaneous
subtab.

3. Select the following Miscellaneous options:

• 10061 - Allow Access to the IIS CAPS Configurator Tool

• 10065 - Download Software, Install and Authenticate Clients and Service
Hosts Using CAL

4. Click Save.

Note:

Before you perform an upgrade to Simphony 18.1 from Simphony
versions 2.9.x or 2.10, you need to ensure that the options described
above are enabled before running the post-upgrade CAPS Configuration
Tool. Specifically, if option 10065 is disabled prior to the upgrade, after
the upgrade, an error message appears during your login to the CAPS
Configuration Tool . If you click OK on the error message window, you
can log onto the CAPS Configuration Tool, but you cannot utilize the
Authenticate CAPS button (added to the CAPS Configuration Tool for
the Simphony 18.1 release).

Configuring the Service Host for CAPS in EMC
1. To configure the Service Host for a hosted Enterprise with Simphony Standard

Cloud Service users:

a. Select the property level, click Setup, and then click Workstations.

b. Insert a new workstation record, and then double-click it to open in form view.

c. On the General tab, enter the host name of the remote server where CAPS
will be configured in the Address/Host Name field.

d. Enter the Subnet Mask and the Default Gateway of the remote server where
CAPS will be configured.

e. If you are configuring CAPS as a Windows Service, select Is Windows
Service. Otherwise, skip this step.

f. Click Save.

g. Click the Remove OPS From Service Host link, and then click Yes to
confirm.

2. To configure the Service Host for a hosted Enterprise with Simphony Premium
Cloud Service users:

a. Select the Enterprise level, click Setup, and then click Service Hosts.

b. Insert a new Service Host record, and then double-click it to open in form view.

c. In the Host Name field, enter the host name of the remote server where CAPS
will be configured.

d. Enter the Subnet Mask and the Default Gateway of the remote server.

e. If you are configuring CAPS as a Windows Service, select Is Windows
Service. Otherwise, skip this step.
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f. Click Save.

3. Select the property, click Setup, and then click Property Parameters.

4. Click the Workstations tab.

5. From the Service Hosts section, select the CAPS Service Host created in Step 1 or 2,
and then enter the Port number for CAPS configuration.

This Port is the unused port number and is different from the Egateway service port.

6. Click Save.

Preparing the Server to Configure CAPS
1. Ensure that the Server has the latest Microsoft Windows patches.

2. Turn on the Microsoft Windows features:

• Microsoft .NET Framework 3.5

• Microsoft IIS

3. Install Microsoft .NET Framework 4.6.1.

4. Install the Oracle Database 12c Server database.

a. Deselect the pluggable database option.

b. Select the database admin user system account or equivalent.

5. In the EMC, configure the CAPSOnIIS CAL package for deployment to the Remote
Service Host.

6. Install the CAL client on the Remote Service Host.

7. In the EMC, deploy the CAPSOnIIS CAL Package to the configured Service Host.

After completion, this package is available in the [Drive
Letter]:\Micros\Simphony\CAPSonIIS folder.

8. If you are using Oracle Database 12c Release 2 for the CAPS database, complete the
following steps:

a. Navigate to [Drive
Letter]:\Micros\Simphony\CAPSOnIIS\Tools\ODP.NET_12CR2, and then
follow the instructions in the Readme.

b. Run the ODP.NET_12CR2.bat under the current directory with administrator
privileges from a command prompt.

During batch file execution, the status appears in the Command Prompt window.

c. After successful execution of the batch file, close the Command Prompt window.

Scheduling and Viewing Device Information
To communicate workstation information, a core CAL package called Device Information runs
at each workstation and on CAPS running on a POS client workstation without the POS
client. The Device Information CAL package is not needed for Simphony release 19.1.2 as it
is deployed automatically with the Service Host. However, the Device Information CAL
package must be deployed for clients that still run on an earlier Simphony release (prior to
19.1.2), so the device information and metrics can be sent to the enterprise for the older
clients. The resulting device information status is propagated to the Service Host and to the
property.
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The Device Information module lets you schedule and view workstation metrics in the
EMC at the Enterprise level. The device information allows administrators to detect
possible issues that could prevent a client from upgrading successfully. Device
Information Needs Attention State contains a list and description of the needs attention
workstation state.

The detailed status of workstations and other CAL-enabled devices appears in the
Device Information module. After the CAL client is installed, the Device Information
module shows data if the following conditions are met:

• The CAL client is updated to Simphony release 19.1.2.

• The Device Information CAL package is deployed to the workstation, which shows
the status upon deployment.

1. To schedule the device information task:

a. Select the Enterprise level, click Configuration, and then click Task
Schedules.

b. Double-click the task schedule to open it in table view.

c. Select 8 - Device Information from the Task Type drop-down list.

By default, the Device Information task is scheduled to run daily at 5:00 a.m.
local time. You can change this by clicking the Recurrence tab and changing
the Daily Frequency occurrence options.

d. Ensure that the Task Data field shows DEVICE_INFORMATION_STATUS.

e. Click Save.

2. To view the workstation information after the device information task runs:

a. Select the Enterprise level, click Tasks, and then click Device Information.

The left pane shows a list of properties under Locations. If a property does not
have the Service Host, the middle and right panes are blank.

The middle pane shows a list of Service Hosts.

The right pane shows all device information, including CAL, Workstation
Hardware, Security, and Simphony Software Information.

There are two statuses icons to indicate the device information status:

Table 38-2    Device Information Status Icons

Icon Icon Name Icon Status Description

No Issues The device information
meets the requirements
and there are no issues
detected.

Needs Attention The device information
does not meet the
requirements. For
example, the workstation
device might need to be
restarted for operating
system updates.
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b. To limit the Service Hosts shown in the middle pane, select the filters for Status (All,
No Issues, Need Attention), Name, Software Version, and CAL Version.

c. Click a Service Host to change the view in the right pane.

d. To expand and collapse the views in the right pane, click the individual green triangle
icons, or click the Expand/Collapse All link in the upper right corner.

Device Information Needs Attention State
The Device Information module checks the following settings for each workstation. The status
is available at the Enterprise level, and listed by property. The following table describes what
causes the Needs Attention state.

Table 38-3    Device Information Workstations That Need Attention

Device Information Values Needs Attention State Description

CAL Enabled? Yes/No No If CAL is not enabled,
the workstation does
not query the
Simphony enterprise
and does not receive
scheduled CAL
packages.

TLS Connection OK? Yes No Verifies whether the
connection string to
the enterprise uses
https.

Auth Key Present/
Connect?

Yes/No No Verifies whether the
authentication key is
present and can
connect through TLS
to the Simphony
enterprise.

Password Policy Ok? Yes/No No Verifies that the
password policy does
not prevent successful
updating of the
database password.

DBA Login Ok? Yes/No No Verifies that the
database
administrator can log
in to the local client
database.
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Table 38-3    (Cont.) Device Information Workstations That Need Attention

Device Information Values Needs Attention State Description

Database Max. Login
Ok?

Yes/No No Verifies whether the
maximum log in
failure meets the
requirements, which
is minimum 8 for
normal clients.
If Database Max. Login
Ok? needs attention,
check the security
account lockout
threshold policy
through the Local
Security Policy in
Windows.
Security
Considerations in the
Oracle MICROS
Simphony Client
Deployment Guide
contains more
information.

DB Pending
credentials changes

Yes/No Yes Verifies whether
database credential
changes are pending,
which require a
restart.

Sufficient Disk Space? Yes/No No Verifies whether the
disk space falls below
the minimum of 1.5
GB free space.

OS pending reboot Yes/No Yes Test whether a restart
is pending because of
a Windows update
(Win32 devices only).

Directory Security Ok/No/NA No Test whether one of
the following
directories are not
accessible:
• %AppRoot%: Ok
• %ALLUSERSPROFI

LE%: Ok
Security
Considerations in the
Oracle MICROS
Simphony Client
Deployment Guide
contains more
information.
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Configuring CAPS with an Oracle Database
1. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges

from a command prompt.

2. Navigate to the directory containing the CAPSConfigurator folder.

Depending on your configuration method, the path is one of the following:

• [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
• [Drive

Letter]:\MICROS\Simphony\CAPSonIIS\Tools\CAPSConfigurator
3. Double-click CAPSConfigurator, enter the server and port number of the EGateway, and

sign in using your EMC credentials. A list of Service Hosts appears.

4. Click the Service Host to configure.

5. Click CAPS Schema.

6. Enter the appropriate information in the CAPS Schema dialog, and then click Next.

• Database: Select the Oracle database type.

• Server: Enter the server name.

• Port: Enter the port number.

• Service name: Enter the service name.

• Admin User: Enter the administrative user name used to sign onto the Oracle
database server, for example, the system user name. This user name cannot be a
DBA user.

• Password: Enter the current user’s password to sign onto the Oracle database
server.

7. In the next CAPS Schema dialog, enter the User Name, Password, and Confirm
Password to create a new database user for the CAPS database, and then click Next.

8. Click OK to confirm. A message indicates success.

The CAPS Schema dbsettings.xml is configured at one of the following directories
(depending on your configuration):

• [Drive Letter]:\MICROS\Simphony2\IISCAPSServiceHost
• [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost
Configuring CAPS Access contains important information about enabling the privileges to
access the CAPS Configuration Tool.

Configuring CAPS on Microsoft IIS
In the CAPS Configurator Tool, click Configure CAPS.

The CAPS Configurator Tool detects and configures the new Service Host. Upon successful
configuration, the configured check box in the UI is automatically selected for the configured
Service Host. A browser opens with the configured CAPS URL.

CAPS is configured at [Drive
Letter]:\MICROS\Simphony2\EgatewayService\IISCAPSServiceHost.
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Configuring CAPS Access contains important information about enabling the privileges
to access the CAPS Configuration Tool.

Upgrading Microsoft IIS CAPS

Upgrading Microsoft IIS CAPS on Enterprise Server
1. Upgrade Simphony on the Enterprise server.

2. Browse to [Drive
Letter]:\Micros\Simphony\Tools\CAPSConfigurator.

3. Double-click CAPSConfigurator, enter the server and port number of the
EGateway, and sign in using your EMC credentials. A list of Service Hosts
appears.

4. Select the Service Host configured on this server that needs to be upgraded.

5. Click Upgrade CAPS.

The CAPS Configurator Tool detects and configures the Service Host. Upon
successful configuration, the configured check box in the UI is automatically
selected for the configured Service Host. A browser opens with the configured
CAPS URL.

Configuring CAPS Access contains important information about enabling the
privileges to access the CAPS Configuration Tool.

Upgrading Microsoft IIS CAPS on Remote Service Host
1. Upgrade Simphony on the Enterprise server.

2. In the EMC, deploy the CAPSOnIIS CAL package to the configured Service Host.

3. Browse to [Drive
letter]:\Micros\Simphony2\CAPSOnIIS\Tools\CAPSConfigurator on
the remote server.

4. Double-click CAPSConfigurator, enter the server and port number of the
EGateway, and sign in using your EMC credentials. A list of Service Hosts
appears.

5. Select the Service Host configured on this server that needs to be upgraded.

6. Click Upgrade CAPS.

The CAPS Configurator Tool detects and configures the Service Host. Upon
successful configuration, the configured check box in the UI is automatically
selected for the configured Service Host. A browser opens with the configured
CAPS URL.

Configuring CAPS Access contains important information about enabling the
privileges to access the CAPS Configuration Tool.
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Configuring CAPS as a Windows Service with an Oracle
Database

CAPS must run on the same server where the Oracle database is installed. You can set up
CAPS as a Windows service only on remote servers—not on the Enterprise server—for both
Simphony Premium Cloud Service and Simphony Standard Cloud Service users.

Configuring CAPS Access
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.

3. Select the following Miscellaneous options:

• 10061 - Allow Access to the IIS CAPS Configurator Tool

• 10065 - Download Software, Install and Authenticate Clients and Service Hosts
Using CAL

4. Click Save.

Note:

Before you perform an upgrade to Simphony 18.1 from Simphony versions
2.9.x or 2.10, you need to ensure that the options described above are enabled
before running the post-upgrade CAPS Configuration Tool. Specifically, if option
10065 is disabled prior to the upgrade, after the upgrade, an error message
appears during your login to the CAPS Configuration Tool . If you click OK on
the error message window, you can log onto the CAPS Configuration Tool, but
you cannot utilize the Authenticate CAPS button (added to the CAPS
Configuration Tool for the Simphony 18.1 release).

Configuring the Service Host for CAPS in EMC
1. To configure the Service Host for a hosted Enterprise with Simphony Standard Cloud

Service users:

a. Select the property level, click Setup, and then click Workstations.

b. Insert a new workstation record, and then double-click it to open in form view.

c. On the General tab, enter the host name of the remote server where CAPS will be
configured in the Address/Host Name field.

d. Enter the Subnet Mask and the Default Gateway of the remote server where CAPS
will be configured.

e. If you are configuring CAPS as a Windows Service, select Is Windows Service.
Otherwise, skip this step.

f. Click Save.

g. Click the Remove OPS From Service Host link, and then click Yes to confirm.
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2. To configure the Service Host for a hosted Enterprise with Simphony Premium
Cloud Service users:

a. Select the Enterprise level, click Setup, and then click Service Hosts.

b. Insert a new Service Host record, and then double-click it to open in form view.

c. In the Host Name field, enter the host name of the remote server where CAPS
will be configured.

d. Enter the Subnet Mask and the Default Gateway of the remote server.

e. If you are configuring CAPS as a Windows Service, select Is Windows
Service. Otherwise, skip this step.

f. Click Save.

3. Select the property, click Setup, and then click Property Parameters.

4. Click the Workstations tab.

5. From the Service Hosts section, select the CAPS Service Host created in Step 1
or 2, and then enter the Port number for CAPS configuration.

This Port is the unused port number and is different from the Egateway service
port.

6. Click Save.

Preparing the Server to Configure CAPS
1. Ensure that the Server has the latest Microsoft Windows updates.

2. Turn on the Microsoft Windows features:

• Microsoft .NET Framework 3.5

• Microsoft IIS

3. Install Microsoft .NET Framework 4.6.1.

4. Install the Oracle 12c 32-bit client.

5. Install the Oracle Database 12c Server.

a. Deselect the pluggable database option.

b. Select the database admin user system account or equivalent.

6. From the EMC, configure the CAPSOnIIS CAL package for deployment to the
Remote Service Host.

7. Set up the Service Host prerequisites for deployment to the Remote Service Host.

8. Set up the Service Host for deployment to the Remote Service Host.

9. Install the CAL client on the Remote Service Host.

10. From the EMC, deploy the CAPSOnIIS CAL Package to the configured Service
Host.

11. If you are using Oracle Database 12c Release 2 for the CAPS database, complete
the following steps:

a. Navigate to [Drive
Letter]:\Micros\Simphony\CAPSOnIIS\Tools\ODP.NET_12CR2, and then follow
the instructions in the Readme.
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b. Run the ODP.NET_12CR2.bat under the current directory with administrator
privileges from a command prompt.

During batch file execution, the status appears in the Command Prompt window.

c. After successful execution of the batch file, close the Command Prompt window.

12. Deploy the Service Host prerequisites CAL Package.

13. Deploy the Service Host CAL Package.

14. Stop the CAPS Service.

Scheduling and Viewing Device Information
To communicate workstation information, a core CAL package called Device Information runs
at each workstation and on CAPS running on a POS client workstation without the POS
client. The Device Information CAL package is not needed for Simphony release 19.1.2 as it
is deployed automatically with the Service Host. However, the Device Information CAL
package must be deployed for clients that still run on an earlier Simphony release (prior to
19.1.2), so the device information and metrics can be sent to the enterprise for the older
clients. The resulting device information status is propagated to the Service Host and to the
property.

The Device Information module lets you schedule and view workstation metrics in the EMC at
the Enterprise level. The device information allows administrators to detect possible issues
that could prevent a client from upgrading successfully. Device Information Needs Attention
State contains a list and description of the needs attention workstation state.

The detailed status of workstations and other CAL-enabled devices appears in the Device
Information module. After the CAL client is installed, the Device Information module shows
data if the following conditions are met:

• The CAL client is updated to Simphony release 19.1.2.

• The Device Information CAL package is deployed to the workstation, which shows the
status upon deployment.

1. To schedule the device information task:

a. Select the Enterprise level, click Configuration, and then click Task Schedules.

b. Double-click the task schedule to open it in table view.

c. Select 8 - Device Information from the Task Type drop-down list.

By default, the Device Information task is scheduled to run daily at 5:00 a.m. local
time. You can change this by clicking the Recurrence tab and changing the Daily
Frequency occurrence options.

d. Ensure that the Task Data field shows DEVICE_INFORMATION_STATUS.

e. Click Save.

2. To view the workstation information after the device information task runs:

a. Select the Enterprise level, click Tasks, and then click Device Information.

The left pane shows a list of properties under Locations. If a property does not have
the Service Host, the middle and right panes are blank.

The middle pane shows a list of Service Hosts.

The right pane shows all device information, including CAL, Workstation Hardware,
Security, and Simphony Software Information.
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There are two statuses icons to indicate the device information status:

Table 38-4    Device Information Status Icons

Icon Icon Name Icon Status Description

No Issues The device information
meets the requirements
and there are no issues
detected.

Needs Attention The device information
does not meet the
requirements. For
example, the workstation
device might need to be
restarted for operating
system updates.

b. To limit the Service Hosts shown in the middle pane, select the filters for
Status (All, No Issues, Need Attention), Name, Software Version, and CAL
Version.

c. Click a Service Host to change the view in the right pane.

d. To expand and collapse the views in the right pane, click the individual green
triangle icons, or click the Expand/Collapse All link in the upper right corner.

Device Information Needs Attention State
The Device Information module checks the following settings for each workstation. The
status is available at the Enterprise level, and listed by property. The following table
describes what causes the Needs Attention state.

Table 38-5    Device Information Workstations That Need Attention

Device Information Values Needs Attention
State

Description

CAL Enabled? Yes/No No If CAL is not
enabled, the
workstation does not
query the Simphony
enterprise and does
not receive
scheduled CAL
packages.

TLS Connection OK? Yes No Verifies whether the
connection string to
the enterprise uses
https.

Auth Key Present/
Connect?

Yes/No No Verifies whether the
authentication key is
present and can
connect through TLS
to the Simphony
enterprise.
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Table 38-5    (Cont.) Device Information Workstations That Need Attention

Device Information Values Needs Attention
State

Description

Password Policy Ok? Yes/No No Verifies that the
password policy
does not prevent
successful updating
of the database
password.

DBA Login Ok? Yes/No No Verifies that the
database
administrator can
log in to the local
client database.

Database Max. Login
Ok?

Yes/No No Verifies whether the
maximum log in
failure meets the
requirements, which
is minimum 8 for
normal clients.
If Database Max.
Login Ok? needs
attention, check the
security account
lockout threshold
policy through the
Local Security Policy
in Windows.
Security
Considerations in
the Oracle MICROS
Simphony Client
Deployment Guide
contains more
information.

DB Pending
credentials changes

Yes/No Yes Verifies whether
database credential
changes are pending,
which require a
restart.

Sufficient Disk
Space?

Yes/No No Verifies whether the
disk space falls
below the minimum
of 1.5 GB free space.

OS pending reboot Yes/No Yes Test whether a
restart is pending
because of a
Windows update
(Win32 devices
only).
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Table 38-5    (Cont.) Device Information Workstations That Need Attention

Device Information Values Needs Attention
State

Description

Directory Security Ok/No/NA No Test whether one of
the following
directories are not
accessible:
• %AppRoot%: Ok
• %ALLUSERSPRO

FILE%: Ok
Security
Considerations in
the Oracle MICROS
Simphony Client
Deployment Guide
contains more
information.

Configuring CAPS with an Oracle Database
1. Run the ODP.NET_12CR2.bat under the current directory with administrator

privileges from a command prompt.

2. Navigate to the directory containing the CAPSConfigurator folder.

Depending on your configuration method, the path is one of the following:

• [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
• [Drive

Letter]:\MICROS\Simphony\CAPSonIIS\Tools\CAPSConfigurator
3. Double-click CAPSConfigurator, enter the server and port number of the

EGateway, and sign in using your EMC credentials. A list of Service Hosts
appears.

4. Click the Service Host to configure.

5. Click CAPS Schema.

6. Enter the appropriate information in the CAPS Schema dialog, and then click
Next.

• Database: Select the Oracle database type.

• Server: Enter the server name.

• Port: Enter the port number.

• Service name: Enter the service name.

• Admin User: Enter the administrative user name used to sign onto the Oracle
database server, for example, the system user name. This user name cannot
be a DBA user.

• Password: Enter the current user’s password to sign onto the Oracle
database server.
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7. In the next CAPS Schema dialog, enter the User Name, Password, and Confirm
Password to create a new database user for the CAPS database, and then click Next.

8. Click OK to confirm. A message indicates success.

The CAPS Schema dbsettings.xml is configured at one of the following directories
(depending on your configuration):

• [Drive Letter]:\MICROS\Simphony2\IISCAPSServiceHost
• [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost
Configuring CAPS Access contains important information about enabling the privileges to
access the CAPS Configuration Tool.

Copying the Database Settings
Copy and replace the dbsettings.xml file from the CAPS_DIRECTORY_PATH (for example,
copy from [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost to the [Drive
Letter]:\Micros\Simphony2\WebServer\wwwroot\EGateway folder).

Starting the CAPS Service
After the CAL process is complete, CAPS starts automatically. It may take several seconds to
create all tables and to synchronize data the first time.

Optional CAPS Configuration Tasks

CAPS Optimization for High Loads
To handle high transaction CAPS environments, system administrators can enable threaded
posting.

• To enable threaded posting on CAPS running Simphony’s native webserver in
ServiceHost, modify the web.config.txt file located on the CAPS machine.

• To enable threaded posting on CAPSonIIS, modify the web.config file located on the
CAPSonIIS machine. (Note that this is a different file than the one mentioned in the
previous point.)

For Simphony 19.x users, the following key needs to be manually entered in the appSettings
section:

<add key="MaxMrequestPlaybackThreads" value="x" />
In the syntax provided in the example above, x represents the number of threads.

The number of threads used depends on the volume of Mrequest messages. Also, the
number of connections is derived from the number of threads. Under enough load, the value
sets the upper limit of threads. There is a point when adding connections decreases
performance. As such, if you have a posting backlog on CAPS, it is suggested to use 1
thread for every 25 workstations.
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CAL Installation Prerequisites for a Workstation without the POS
Interface (CAPS Only Workstation)

Before installing CAL on a CAPS-only workstation, perform the following functions:

• Configure a service host for CAPS. See Configuring the Service Host for CAPS in
EMC for instructions.

• Assign the employee privilege to download software, install and authenticate
clients and Service Hosts using CAL.

Beginning with Simphony version 2.9.1 (which includes CAL version 139), users
must have the employee privilege assigned to the appropriate role to successfully
authenticate workstations, Android devices, and Kitchen Display Systems (KDS).
After installing or upgrading to Simphony version 2.9.1 or later, you must assign
the privilege to a user’s role. When the Role option is set, employees can use their
EMC logon credentials when CAL’ing devices. See Allowing Employees to Install
and Authenticate POS Clients and Service Hosts for instructions to assign the
privilege.

• Set the CAL deployment schedule. See Configuring the Deployment Schedule to
Install CAL on a POS Client Workstation without Ops for instructions.

Configuring the Deployment Schedule to Install CAL on a Workstation without
the POS Interface

1. Select the Enterprise, click Setup, and then click CAL Packages.

2. For Simphony version 2.9 and Simphony version 2.9.1:

a. If the CAPS workstation is running Microsoft Windows Embedded POSReady
2009, select Service Host Prereqs from the left pane.

b. If the CAPS workstation is running Microsoft Windows 7 or later, select
Service Host Prereqs (SQL 2012) from the left pane.

3. For Simphony version 2.9.2, select Service Host Prereqs from the left pane for all
POS clients.

4. Click the Deployment Schedule tab, and then click Add Deployment.

5. From the Deployment Type column, select 2 - Specific Service Host.

6. In the Service Host column, click the ellipsis (...) point button, select the CAPS
workstation, and then click OK.

7. In the Action To Take column, select 0 - Install, and then click Save.

8. Select Service Host from the left pane, and then repeat Steps 4 through 7.

Installing CAL on a Workstation without the POS Interface
1. On the workstation, press Start, select All Programs, select Micros Client

Application Loader, and then select McrsCAL Config.

2. Decipher and enter the correct access code, and then press the Configure CAL
button.
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3. Enter the correct code based on the six-digit number shown at the top, and then press
Next.

4. In the Enter CAL Server dialog, select MICROS Simphony as the POS Type.

MICROS Simphony is used for both Simphony Standard and Premium Cloud Service
environments.

5. Set the following values, and then press Next:

• Server Name: Leave this field blank.

• Server IP/URL: Leave this field blank.

• CAL Enabled: Select this option if it is not automatically set by default.

• Secure Connection: Select this option to use the Translation Layer Security (TLS)
1.2 Encryption protocol. (If you are installing CAL version 139 or later, this option is
set by default.)

• Server: Enter the CAPS server name.

• Port: Enter 443.

• Update: Click the Update button to automatically fill the Server Name and Server
IP/URL fields after the application server name is resolved and recognized. You are
now required to use an HTTPS secure connection in your Server URL.

6. If you are using Simphony version 2.9 (CAL version 138), skip to Step 8.

7. Beginning with Simphony version 2.9.1 and later, if you are installed on a Simphony
Standard or Premium Cloud Service environment, CAL prompts you to enter your
Simphony EMC logon credentials. Enter your User name and Password in the CAL
Authentication dialog, and then press the Login button.

8. If the Enterprise has multiple properties, select the property from the Property Search and
Select dialog, and then press Next.

If the property does not appear in the list, enter the property name in the Property Name
field, and then press Search.

You do not see a property list if only one property is configured or if there are multiple
properties, but only one property is using workstations.

9. In the Select WS Identity dialog, select the Show Service Hosts option, select the
appropriate service host from the available workstation list, and then press Save. Make
sure the Service Host ID and Workstation ID populate. The workstation automatically
restarts several times when installing the CAL package.
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Figure 38-2    Select Workstation Dialog

10. If you are using Simphony version 2.9 or Simphony version 2.9.2, after the CAL
process completes:

a. Browse to [Drive letter]:\MICROS\Simphony\webserver, and then
click AuthenticationServer.

b. For Simphony version 2.9, enter the following details in the Authentication
Server application:

• Client Service ID: Enter the Service ID for Check and Posting. You can
find the Service ID in the Workstations tab of the Property Parameters
module.

• Installer Username: Enter the Install User Security Username
configured in the Security tab of the Property Parameters module. Contact
your system administrator for assistance.

• Installer Password: Enter the Install User Security Password
configured in the Security tab of the Property Parameters module. Contact
your system administrator for assistance.
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Figure 38-3    Authentication Server Application for Simphony 2.9

c. For Simphony version 2.9.2 and later, enter the following details in the Authentication
Server application:

• Service Host ID: The service host ID. This value is automatically populated.

• EMC Username: Enter your EMC user name.

• EMC Password: Enter your EMC password.
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Figure 38-4    Authentication Server Application for Simphony 2.9.2

d. Click Authenticate.

e. Restart the workstation.

Configuring the Show Database Provider Button
The following steps are optional:

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Double-click the page on which you want the Show Database Provider button to
appear (typically the Sign In page).

3. Insert a new button.

4. On the General tab, select Function from the Type drop-down list, and then click
the right arrow beneath the Type field.

5. On the left pane, in the Name field, enter Show Database Provider.

6. On the right pane, select Show Database Provider as the result, and then click
OK.

7. Click Generate Legend to set Show Database Provider as the button name.

8. Click Save.

Encrypting Database Credentials
The following steps are optional:

1. Browse to [Drive Letter]:\MICROS\Simphony2\Tools\Crypt folder.

2. Run Crypt.exe.
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3. Enter or copy the complete [CAPS HOSTED DIRECTORY]\DbSettings.xml path (for
example, [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost).

4. Click Read DB Settings.

5. Select CPServiceDB from the drop-down list.

6. Enter the password, and then click Encrypt Password.

Verifying CAPS Installation
The following steps are optional:

1. Log in as the CAPS user on the Oracle database to verify the tables.

2. Verify the log files on the CAPS EGateway log and the workstation EGateway log folders.

3. Configure a new POS client workstation that points to CAPS from the Property
Parameters module (Workstations tab).

See Adding a Workstation for more information.

4. Click the Show Database Provider button, and then verify that CAPS DB: as Oracle
appears.

5. Verify that the CAPS status is online.

6. Add a few test transactions from the workstation.

7. Verify that the transaction details post to the CHECKS table on the workstation datastore
database, the CAPS database, and the Simphony transaction database.

Configuring IIS Application Pool Settings

Configuring Recycle Settings for the IIS Application Pool
For instructions on configuring an application pool to recycle at a scheduled time, refer to the
Microsoft TechNet Library at https://technet.microsoft.com/en-us/. Ensure that the times you
set do not coincide with the Start of Day (SOD) or periods of peak sales activity. If you
configure the application pool to recycle at a scheduled time using the IIS Manager, consider
the following recycle settings for the IIS Application Pools.

• Set the Memory Based Maximums to less than half of the available server memory.

• Set the .NET Integration mode to Classic for the CAPS Application Pool.

• Set the Disable Overlapped Recycle setting to True for the CAPS Application Pool.

• Leave the Application Pool’s Pipeline mode settings on the default settings.

Restarting Microsoft IIS CAPS
The following steps are optional:

1. From Microsoft IIS Manager, recycle the CAPS application pool.

2. Click the configured IIS CAPS application under the website, and switch to Content View.

3. Right-click EGateway.asmx and select Browse. The new CAPS Egateway.asmx URL
opens in the default internet browser.
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39
Printers

Printers and order devices are critical types of hardware that allow communication between
the various areas of a restaurant, such as the kitchen and dining room or bar.

Print Controller
A Print Controller is a service that sends print jobs to a printer. Each POS client process has
a built-in Print Controller. A workstation typically acts as a Print Controller. When a
workstation operator performs an action that causes a guest check, order receipt, or other
printing type to print, the POS client process does not communicate directly with the printer
receiving the print job. Instead, the POS client process sends a message to the Print
Controller (usually a workstation) that controls the printer. This Print Controller then receives
notification that the print job succeeded or failed, and routes the success or failure
information back to the workstation that sent the print job.

Ensure that employees in a revenue center know which workstations act as Print Controllers
for remote printers. This knowledge helps in troubleshooting printing problems.

Oracle Hospitality recommends that you have both a primary printer and a backup printer,
and that primary and backup printers reside on two different Print Controllers. This
configuration prevents a single point of failure from causing multiple remote printers to stop
printing.

A single Print Controller can control multiple printers. For example, one workstation can
control the following printers:

• Local printer that is physically attached to the workstation (used for guest checks and
customer receipts)

• Hot food printer that is a remote Ethernet kitchen printer (used for order receipts)

In this configuration, if the workstation loses power or network connectivity, other workstations
cannot print to either of these printers. This is generally not a problem because the print jobs
print to the backup printer as appropriate.

In another example, one workstation can control the following printers:

• Local printer that is physically attached to the workstation

• Hot food printer that is a remote Ethernet kitchen printer

• Cold food printer that is a remote Ethernet kitchen printer and backs up the hot food
printer

Oracle Hospitality does not recommend this configuration. In this example, if the workstation
loses power or network connectivity, other workstations cannot print to any of these printers.
In this scenario, no order receipts print to the hot or cold printers in the kitchen. Kitchen
operations would likely be severely impacted.

Related Topics

• Configuring a Printer
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Roll Printer
A roll printer uses a roll of paper as its source media. Thermal printers and impact
printers are two types of roll printers that you can use with Simphony.

Thermal Printer

A thermal printer does not use ink. Special thermal paper is provided for these printers
to burn the text onto the paper. Thermal printers are primarily used as guest check and
customer receipt printers. They are used infrequently in kitchens due to the heat
reaction. Thermal printers are ideal in public areas as the printing operation is quiet.

Impact Printer

An impact printer is something of a retronym. All printers were impact printers prior to
the invention of the thermal printer. An impact printer is primarily used in kitchens to
print order receipts. Impact printers can print in black and red, and they can be used
with two-ply paper.

Related Topics

• Configuring a Printer

Slip Printer
A slip printer does not contain paper. The workstation operator must add a piece (or
slip) of paper per print job. Properties who use custom stationery (often containing a
company logo or other similar artwork) generally use slip printers for guest checks and
customer receipts. Slip printers are also used for check endorsement printing. The
slips that are used by these printers are often called hard checks because they are
usually made of card stock.

Slip printers are not supported when using Transaction Services Gen 1 and Simphony
Transaction Services (STS) Gen 2.

Related Topics

• Configuring a Printer

Internet Protocol (IP) Printer
An IP printer communicates with the Print Controller through a computer network that
uses the IP address for communication.

Related Topics

• Configuring a Printer

Bluetooth Printer
Bluetooth printing refers to printing from an Oracle MICROS Tablet E-Series to a
wireless printer through the Bluetooth protocol.

There is a one-to-one relationship between a tablet and a Bluetooth printer. After you
identify and configure a Bluetooth printer and manually pair it with a specific Oracle
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MICROS Tablet E-Series as the Print Controller Service Host, you cannot assign another
Oracle MICROS Tablet E-Series to the same Bluetooth printer.

Related Topics

• Configuring a Printer

Printer Groups
If the property is large and has many printers disbursed over a wide area, you may find it
useful to configure a limited list of printers that are selectable by workstation operators. The
workstation operator can select a printer that is nearby from the list at the POS client (usually
a mobile tablet device), and optionally set this printer as the default printer for future print
jobs. When a workstation operator selects a default destination printer, the selection
automatically resets at Start of Day.

A default printer group named All Destination Printers exists in the Printer Groups module.
You cannot change this default printer group. If you do not create printer groups, all printers
with the option Destination Printer (set in the Printers module) belong to the All Destination
Printers printer group. The All Destination Printers default printer group is useful for
properties that need only one group of destination printers.

Related Topics

• Creating, Editing, and Removing Printer Groups

Configuring a Printer
1. Select the property, click Setup, and then click Printers.

2. Insert a printer record, name the printer, and then click OK.

3. Double-click the printer record to open it.

4. Select the Workstation from the drop-down list.

5. Select the Printer Type from the drop-down list.

Select Epson Bluetooth Printer for all Bluetooth printers.

6. If the property supports printing more than one language, select Multi-lingual-card is
installed in the Printer Options section.

7. If the roll printer is a thermal printer, select Thermal printer.

8. Enter the number of lines to advance the guest check or customer receipt after printing
the trailer text in the Trailing Line Feeds field.

The value in this field defaults to the recommended trailing line feeds for the printer
communication type, as listed in the following table. You can change the default value.

Table 39-1    Trailing Line Feeds per Printer Communication Type

Printer Communication Type Trailing Number of Lines

Bluetooth 1

Ethernet 1

Integrated Device Network (IDN) 1

Serial 6
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Table 39-1    (Cont.) Trailing Line Feeds per Printer Communication Type

Printer Communication Type Trailing Number of Lines

OPOS 6

9. (Optional) To set the printer to print logos, select Enable Logo Printing. Up until
the Simphony 18.2.3 and 19.2 releases, logo printing on printers with multi-
language cards was not supported.

When configuring Epson TM-P60 and TM-T88 Ethernet Thermal printers,
configure the logo to print in the center of the guest check or customer receipt by
selecting the paper size of the printer from the Center Logo Using drop-down list.

• Epson TM-P60 Ethernet Thermal printers: Set the paper size to 2 1/4"
(58mm) Paper.

• Epson TM-T88 Ethernet Thermal printers: Set the paper size to 3 1/8" (80mm)
Paper.

See Logo Printing for more information about enabling logo printing on guest
checks and customer receipts.

10. To allow the printer to be selectable by workstation operators (typically used with
mobile POS client devices), select Destination Printer.

Bluetooth printers are not selectable.

11. Configure the appropriate values for the printer type. Specific fields become active
based on the printer type you selected.

The following table lists the printer types and indicates information for each
applicable field. Enter or select information for the fields based on the printer you
are configuring. Fields denoted as Not applicable are not needed for the printer
type.

Table 39-2    Printer Configuration by Printer Type

Field Roll Printer Slip Printer IP Printer Bluetooth
Printer

COM Port Select the
communication
s port for the
printer.
Select COM7
for the Oracle
MICROS Mini-
Printer.*

Select the
communication
s port for the
printer.

Not applicable Not applicable

Baud Rate Select the baud
rate for the
printer.
Select 19200 for
the Oracle
MICROS Mini-
Printer.

Select the baud
rate for the
printer.

Not applicable Not applicable
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Table 39-2    (Cont.) Printer Configuration by Printer Type

Field Roll Printer Slip Printer IP Printer Bluetooth
Printer

Parity Select the
parity for the
printer.
Select None for
the Oracle
MICROS Mini-
Printer.

Select the
parity for the
printer.

Not applicable Not applicable

Data Bits Select the data
bits for the
printer.
Select 8 for the
Oracle MICROS
Mini-Printer.

Select the data
bits for the
printer.

Not applicable Not applicable

Stop Bits Select the stop
bits for the
printer.
Select 2 for the
Oracle MICROS
Mini-Printer.

Select the stop
bits for the
printer.

Not applicable Not applicable

PIN Not applicable Not applicable Not applicable Set the four-
digit passkey
that must be
entered into
the device
before printing.

ID Not applicable Not applicable Not applicable Enter the
Bluetooth ID of
the printer.

Number of
Columns

Not applicable Not applicable Not applicable This setting
determines the
report width so
that guest
checks and
reports print
with center
alignment. By
default, the
width is set to
32 columns.
Select 40 for
Bixolon SPP-
R300, SPP-R310,
and R310iK
Bluetooth
printers.
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Table 39-2    (Cont.) Printer Configuration by Printer Type

Field Roll Printer Slip Printer IP Printer Bluetooth
Printer

Address Not applicable Not applicable Enter the IP
address or
hostname of
the printer. If
you are using
the printer for
banquet
checks, enter
the hostname.

Not applicable

Port Not applicable Not applicable Enter the port
number for the
IP printer.

Not applicable

*For Oracle MICROS Workstation Series 6, the COM port voltage must be
manually set to 12 volts within BIOS setup in order for it to use the Mini-Printer. To
configure this, click the F2 button on the keyboard as the workstation boots,
navigate to the Advanced Tab, and then select the Special Configuration option.
Then, set the COM Port Voltage to 12 volts, and click the F10 button to save and
exit the BIOS screen.

12. Click Save.

13. Select the property, click Setup, and then click Workstations.

14. Double-click the workstation to open it.

15. Click the Printers tab.

16. Click the Select link to set the appropriate Printer for each type of print job. Click
the Set for All Destination Printers link to set the same printer for each type of
print job.

The printer defined here (primary or backup) always appears in the Destination
Printers list on the POS client, even if you do not add it to the Destination Printer
Group. Creating, Editing, and Removing Printer Groups contains more
information.

Oracle Hospitality recommends that you assign the same printer model and format
for the backup printer to ensure that checks format properly on other printers.

17. Click the Select link and assign each printer type to a Destination Printer Group.
Click the Set for All Destination Printers link to set the same printer type for all
destination printer groups.

Selecting a Destination Printer Group overrides the printer selected for the
printer type.

Printers with the option Selectable as Destination Printer set belong to a default
Destination Printer Group called All Destination Printers.

If you define a Destination Printer Group for the Backup Printer, the workstation
operator is prompted at the time of printing for both the primary printer (if it has a
group defined) and the Backup Printer.

18. Click the Options tab.
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19. To automatically disable the Destination Printers prompt (if configured) when a dockable
workstation (tablet device) is attached to the stand and has access to an attached printer,
leave the option 60 - Prompt for Destination Printer when docked deselected. Select
option 60 to have the POS client prompt to select a printer when a workstation is docked.

20. Click Save.

21. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Format Parameters.

22. Click the Configuration tab, and then enter the appropriate information in the following
fields:

Table 39-3    Print Output Configuration

Field Description

Lines on First Page Enter the maximum number of lines to print
on the first page of the guest check before
prompting for a new check to begin a new
order receipt.

Lines on Other Pages Enter the maximum number of lines to print
on successive pages of the guest check
before prompting for a new check to begin a
new order receipt.

Line Feeds Before First Page Enter the number of lines to advance before
printing the guest check header. You can add
extra space for the check so it appears
properly in custom check presentation
binders.

Line Feeds Before Other Pages Enter the number of lines to advance before
printing begins on the next successive page.
The line feeds set here are included in the
number configured for the Lines on Other
Pages field. For example, if you set this field
to 5 and set Lines on Other Pages to 30, the
pages have 25 lines of text.

Minimum Lines Per Roll Check/Receipt Enter the minimum number of lines to print
on guest checks and customer receipts.
Blank lines are added after printing to
achieve the minimum.
Use this field if you want guest checks and
customer receipts that are printed on a roll
printer to have a minimum length in order
to fit into guest check covers.

Number of Guest Check Information Lines Enter the number of detail lines (0 through
30) that can be entered in a System Interface
Module (SIM) dialog box.

Print Tax Invoice after Sales Threshold Enter the sales threshold needed to pass for
a tax invoice to be printed for a customer.

Print Customer Information after Sales
Threshold

Enter the sales threshold needed to pass for
customer information to be printed for a
customer.

Chapter 39
Configuring a Printer

39-7



Table 39-3    (Cont.) Print Output Configuration

Field Description

Customer/Trade Identity Label Enter the label information to be presented
on the top of a bill after a maximum sales
threshold is met. This label is either a
customer’s name (written in the field as
Customer Name) or a Trade Identity Label.
In the case of Australia Goods & Services Tax
requirements, the trade identity label for
Australia is ABN. This information must be
present on a bill after the maximum
threshold is met. The information is never
stored, and the label can be changed.

23. Click the Options tab.

24. Select the appropriate printing options:

• 57 - Do Not Print Change/Payment Due in Double Wide: Select this option
if you do not want double-wide formatting on the Change Due line of a receipt
or the Total Due line of a check.

• 58 - Do Not Consolidate Current Round Items in Printed Guest Check:
Select this option if you do not want to combine identical items which are
ordered in multiples in the current round when printing a receipt.

• 61 - Show Asterisk (*) indicator for Menu Item where Inclusive Tax was
forgiven on screen: Select this option if you want to display an asterisk on
the receipt to indicate that the inclusive tax was forgiven for a menu item.

25. Click Save.

Related Topics

• Print Controller

• Roll Printer

• Slip Printer

• Internet Protocol (IP) Printer

• Bluetooth Printer

Creating, Editing, and Removing Printer Groups
1. Select the property, click Setup, and then click Printer Groups.

2. Insert a printer group record, name the printer group, and then click OK.

3. Double-click the printer group record to open it.

4. To add a printer to the printer group, click the Add link, click the ellipsis button, and
then select the printer.

You can add any printer to any printer group, regardless of the Destination
Printer option setting. You can add one printer to multiple printer groups.

5. Repeat Steps 1 through 4 for to create more printer groups and to add printers to
the groups.
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6. To delete a printer from a printer group, select the printer, and then click the Delete link.

7. Click Save.

8. To edit a printer group, highlight the record, change the values, and then click Save.

9. To remove a printer group, highlight the record, and then click Delete on the toolbar.

Related Topics

• Printer Groups

Configuring the Change Default Printer Destination Button
You need to create a button which allows workstation operators to set and reset the default
printer selection.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the Front of House page on which to place the Change Default Printer Destination
button,

3. On the Edit tab, select the page area in which to define the button.

4. Click Button.

5. On the General subtab, enter the button name in the Legend field.

6. From the Type drop-down list, select Function.

7. Click the black arrow beneath the Type drop-down list, select Change Default Printer
Destination, and then click OK.

8. Position and size the button on the page. Use the Style arrow to change the color.

9. Click Save.

Configuring a Printer Order Device
You can configure order chits to send to a printer at the kitchen when checks are service
totalled on a workstation.

1. Select the revenue center, click Setup, and then click Order Devices.

2. Insert an order device record for the printer (for example, Kitchen Hot Printer), and then
double-click the record to open it.

3. On the General tab, select 1 - Remote from the Device Type drop-down list, select 0 -
Printer from the Primary Device Type drop-down list, and then select the appropriate
printer record from the Device drop-down list.

4. If you have a backup printer, select the Backup Device from the drop-down list.

5. From the Order Device Redirect drop-down list, select the printer order device that you
created in Step 2.

6. From the Menu Item Printing drop-down list, select the items to route to this KDS:

• 0 - All Items: Select to route all menu items.

• 1 - Only Items with Condiments: Select to route only menu items with condiments.

• 2 - Only Items without Condiments: Select to route only menu items without
condiments.
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7. From the Condiment Sort Type drop-down list, select how to sort the condiments
on the order chits. Condiment sorting only works if you have set Menu Item
Classes option 30 - Sort Condiments by Print Group for the parent menu items.

• No condiment sorting: Select to list condiments in the order in which they are
entered on the check by the workstation operator. Allowed condiments sort in
the order assigned in Condiment Sets, if configured.

• Sort allowed condiments: Select to sort only allowed condiments based on
the print group. The sort order configured for allowed condiments in
Condiment Sets is discarded. If required condiments are ordered in between
allowed condiments, the required condiments remain in the same position in
which order they were ordered.

• Sort all condiments: Select to sort all condiments based on the print group,
regardless of condiment type.

8. Configure the following Print Settings:

Table 39-4    Order Devices Printer Settings

Field Description

Max # Lines per Chit Enter the maximum number of lines (0
to 99) to print on each page of an order
chit. Oracle MICROS roll printers print 6
lines per inch.

Sort/Consolidation Method Select the parent menu item sort and
consolidation method for this order
device.

Language Select the primary language for the order
device. This field only shows the
languages that are assigned to the
property in the Property Parameters
module.

Language 2 To print the output in a second language,
select the secondary language.

Language 3 To print the output in a third language,
select the third language.

Line Feeds Before Order Enter the number of lines to advance
before printing the order on order chits.

Line Feeds After Order Enter the number of lines to advance
after printing the order on order chits.

9. Click the Options tab, and then select the appropriate printer options as described
in the following table:

Table 39-5    Order Devices Printer Options

Option Description

1 - On = Print Trans Emp Name and #; Off
= Print Chk Emp Name and #

Select this option to print the employee
name and number of the transaction
operator on the order chit. Deselect to
print the employee name and number of
the check operator.
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Table 39-5    (Cont.) Order Devices Printer Options

Option Description

3 - Print Dopplebon Select this option to print a separate
order chit for each menu item in the
current service round (dopplebon style).
Deselect to print one order chit for all
menu items in the current service round
(the default printing style).

4 - Print Dopplebon Summary Select this option to print an order
summary chit before printing an order's
dopplebon order chits. Deselect to
suppress dopplebon summary chit
printing

6 - Print Seat Numbers with Individual
Items

Select this option to print seat numbers
with each individual menu item.
If the order device is set to consolidate
(Sort/Consolidate Method on the General
tab), the seats print as a Seat Header
above the detail item.

7 - Print Revenue Center Name on Orders Select this option to print the revenue
center name with each order sent to this
order device. The name prints in double-
wide characters. Deselect to suppress
printing the revenue center name.

9 - On = Print void marker before Void;
Off = Print Void in Red

Select this option to print a VV VOID VV
line, in red or inverse, in front of voided
menu items. Deselect to print voided
items in red, without the VV Void VV
line.

10 - Print Condiments in Red (Overrides
Print Class Settings)

Select this option to print condiments in
red ink or in inverse. Deselect to print
condiments in red/inverse or in black,
depending on the Print Class Red/Black
option setting.

11 - Print Both Menu Item Names Select this option to print both names
entered for a Menu Item Definition on
the order chit. Deselect to print only one
name.
When this option is deselected, the name
that prints is determined by the Menu
Item Definition's Menu Item Class option
Print Name 2 on Order Output Instead
of Name 1.

13 - Print Guest Check Info Lines Before
Header on Order Device

Select this option to print guest check
information lines before the order device
header.

14 - Print Guest Check Info Lines After
Header on Order Device

Select this option to print guest check
information lines after the order device
header.

15 - Print Guest Check Info Lines After
Trailer on Order Device

Select this option to print guest check
information lines after the order device
trailer.
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Table 39-5    (Cont.) Order Devices Printer Options

Option Description

16 - Print Secondary Items See Secondary Printing for more
information.

21 - Exclude Voids Select this option if you do not want
voids of previous round items to be sent
to the kitchen.

22 - Intersperse Different Languages If you are printing in more than one
language, select this option to print the
menu item in each language before
printing any condiments. For example,
the output will be menu item name in
language 1, menu item name in language
2, 1st condiment in language 1, 1st
condiment in language 2.

23 - Identify Combo Meals Select this option to print a flag to denote
menu items that are part of a combo
meal. If printing Asian characters, the
information is printed on the preceding
line due to space limitations.

24 - Print Dining Course Header Select this option to print a dining course
header and to group the menu items by
dining course.

25 - Format Prefix On Separate Line Select this option to print the prefix on a
separate line above the condiment.
Deselect to print the prefix on the same
line as the condiment that it modifies.

26 - Print Single Wide Select this option to print orders in
single-width characters.
This supports longer menu item names,
but has the drawback of not being as
readable from a distance.

10. Click Save.

11. Select the property, click Setup, and then click Workstations.

12. Double-click the workstation record for which to assign the printer order device,
and then click the Order Devices tab.

13. Select the printer order device from the Order Device Output list, and then click
Save.

Print Class Output
You can use a Print Class to configure the output for Discounts, Service Charges, and
Tender Media. This enables multiple records with a single Print Class, meaning you
can define the output settings once rather than separately for each record.

A Print Class is automatically created once, only after upgrading from a previous
version of Simphony. The Print Class field automatically defaults to the Print Class
created for these records on the General tab in the Discounts, Service Charges, and
Tender/Media modules. After upgrading, new records must be manually created or
chosen in the Enterprise Management Console.
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There are four basic print class output destinations:

1. Receipts

Receipts print at the workstation at the end of a fast transaction. They are typically used
in a quick service restaurant (QSR) environment where ordering menu items and
tendering the check is performed in the same service round.

2. Guest Checks

Guest checks print at the workstation. They are typically used in a table service
restaurant (TSR) environment. Checks usually include a table number or guest name and
are service totalled several times before final tender.

3. Order Devices

Order devices are remote kitchen or bar printers, or KDS devices. These devices deliver
the order to the production area from the workstation.

4. Journal

The journal is not a physical device, but an electronic file journal that provides audit
capabilities in the application.

Secondary Printing
Secondary printing enables workstation operators to print menu items to additional printers as
secondary items. A secondary item is one that is part of the same order, but prepared at
another Prep Station. This allows the prep cook to know what other items accompany the
dish. For example, a house salad is a primary item on the cold line, but a secondary item on
the hot line. When secondary printing is enabled, the cook reading the chit from the hot
printer sees the items necessary for preparation at the hot line and also any items being
prepared by other cooks that were added to the check at the same time. This feature allows
the kitchen to synchronize orders for delivery. For example, pizza and chicken wings are set
to print to the hot printer, and house salad is set to print to the cold printer. If the cook who
prepares the salad does not know that the chicken wings and pizza go with the salad order,
the cook might prepare the salad immediately. This can cause the salad to get warm or wilt,
possibly having to be remade.

Secondary items print in a smaller font at the bottom of the order chit.
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Figure 39-1    Example Order Chit with Secondary Items

Related Topics

• Configuring Secondary Printing

Configuring Secondary Printing
1. Select the revenue center, click Setup, and then click Order Devices.

2. Double-click a printer order device record, and then click the Options tab.

3. Select the appropriate options that apply to secondary printing, and then click
Save:

• 16 - Print Secondary Items: Select this option to allow this order device to
print items sent from other printers as secondary items.

• 17 - Broadcast Secondary Print Jobs to All Printers: Select this option to
send all items programmed to print at this order device to other printers to print
as secondary items. Items print only at other printers that have 16 - Print
Secondary Items enabled.

• 18 - Print Secondary Printer Header: Select this option to print the name of
the printer from which the secondary items are being broadcasted.

• 19 - Print Secondary Items in Red: Select this option to print secondary
items in red.

• 20 - Suppress Blank Lines Between Secondary Items: Select this option to
remove extra line spacing between secondary items on order chits.
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Related Topics

• Secondary Printing

Printer DIP and Memory Switch Settings
The following links explain the setup and configuration of DIP and memory switch settings:

Epson Printer Setup for IDN Module
Setup the module DIP switches as follows:

Table 39-6    Printer ID

DEVICE # DS1 DS2 DS3 DS4

01 - - - ON*

02 - - ON -

03 - - ON ON

04 - ON - -

05 - ON - ON

06 - ON ON -

07 - ON ON ON

08 ON - - -

09 ON - - ON

10 ON - ON -

11 ON - ON ON

12 ON ON - -

13 ON ON - ON

14 ON ON ON -

15 ON ON ON ON

Table 39-7    Baud Rate

BAUD RATE DS5 DS6

9600 -* -*

19200 ON -

38400 - ON

*Factory Default
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Figure 39-2    Back of Printer and Module Faceplate

Set the annunciator to OFF by doing the following:

1. Make sure the printer is off.

2. Set the switches to the necessary parameters.

3. Turn the printer on. The Status sheet should subsequently print.

4. Turn the printer off. Set IDN switches back to their default setting.

Printer DIP Switch/Memory Switch Setting when using UB-IDN
(IDN02) Interface

Table 39-8    TM-U200, TM-U220, TM-U2300

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
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Table 39-8    (Cont.) TM-U200, TM-U220, TM-U2300

DIP SW 1 DIP SW 2

x x OFF OFF OFF OFF OFF x ON* x x x x x x x

Table 39-9    TM-T88 Series

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x OFF OFF OFF OFF ON OFF x x x x x x x x

Table 39-10    TM-T90, TM-L90 (Non-Peeler & Peeler)

DIP SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x ON OFF OFF OFF OFF ON OFF

Table 39-11    TM-T70

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x OFF OFF OFF OFF ON OFF x x x x x x x x

Table 39-12    TM-T70II

No DIP SW or Memory SW change is necessary.
Use GS (E command (Fn=11)) to set Serial Port Communication Parameters.

Table 39-13    Legend

OFF ON = Mandatory Setting
OFF* ON* = Recommended Setting
x = Don’t Care

Printer DIP Switch/Memory Switch Setting when using UB-IDML
(IDNML02) Interface

Table 39-14    TM-U200A

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x ON x x x x x ON ON x x x x x x ON
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Table 39-15    TM-U200B/D

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x ON x x x x x ON ON x x ON x x x x

Table 39-16    TM-U220 A/B/D (STD)

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x ON x x x x x ON ON x x x x x x ON

Table 39-17    TM-U220 B/D (STD US), TM-U230

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x ON x x x x x ON ON x x ON x x x x

Table 39-18    TM-U230 with firmware x.xx RV-EMC

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x x ON x x x x

Table 39-19    TM-T88III/IV/V

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x ON x x x x x x ON

Table 39-20    TM-T90, TM-L90 (Peeler & Non-Peeler) — DIP Switch

DIP SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x x x x x x

Table 39-21    TM-T90, TM-L90 (Peeler & Non-Peeler) — Memory Switch

Mem SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x ON x x x x ON
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Table 39-22    TM-T70

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x ON x x x x x x ON

Table 39-23    TM-T70II

No DIP SW or Memory SW change is necessary.

Table 39-24    Legend

OFF ON = Mandatory Setting
OFF* ON* = Recommended Setting

x = Don’t Care

Printer DIP Switch/Memory Switch Setting when using UB-E02 (E03)
Interface

Table 39-25    TM-U200A

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x x x x x x x x ON

Table 39-26    TM-U200B/D

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x x x x ON x x x x

Table 39-27    TM-U220 A/B/D (STD)

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x x x x x x x x ON

Table 39-28    TM-U220 B/D (STD US), TM-U230

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x x x x ON x x x x
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Table 39-29    TM-T88III/IV/V

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x x x x x x x x ON

Table 39-30    TM-T90, TM-L90 (Peeler & Non-Peeler) — DIP Switch

DIP SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x x x x x x

Table 39-31    TM-T90, TML90 (Peeler & Non-Peeler) — Memory Switch

Mem SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x x x x x ON

Table 39-32    TM-T70

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
x x x x x x x x x x x x x x x ON

Table 39-33    TM-T70II

No DIP SW or Memory SW change is necessary.

Table 39-34    Legend

OFF ON = Mandatory Setting
OFF* ON* = Recommended Setting

x = Don’t Care

Printer DIP Switch/Memory Switch Setting when using UB-EML
Interface

Table 39-35    TM-U200A

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x OFF x ON OFF OFF ON
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Table 39-36    TM-U200B/D

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x OFF ON OFF OFF OFF x

Table 39-37    TM-U220 A/B/D (STD)

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x x OFF x OFF OFF ON

Table 39-38    TM-U220 B/D (STD US)

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x OFF ON x OFF x OFF

Table 39-39    TM-U230

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x OFF ON OFF OFF OFF x

Table 39-40    TM-T88III/IV/V

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF x x x x x x x ON OFF x x x OFF OFF ON

Table 39-41    TM-T90 — DIP Switch

DIP SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x x x x x x

Table 39-42    TM-T90 — Memory Switch 1

Mem SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x OFF x OFF OFF ON
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Table 39-43    Memory Switch 2

Mem SW 2

2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
ON x x x x x x x

Table 39-44    Memory Switch 8

Mem SW 8

8–1 8–2 8–3 8–4 8–5 8–6 8–7 8–8
x x OFF x x x OFF OFF

Table 39-45    Legend

OFF ON = Mandatory Setting
OFF* ON* = Recommended Setting

x = Don’t Care

Printer DIP Switch/Memory Switch Setting when using UB-EML02
Interface

Table 39-46    TM-U220 A/B/D (STD)

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x x OFF x OFF OFF ON

Table 39-47    TM-U220 B/D (STD US)

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF ON x x x x x ON ON x OFF ON x OFF x OFF

Table 39-48    TM-T88IV/T88V

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF x x x x x x x ON OFF x x x OFF OFF ON

Table 39-49    TM-T90/L90 — DIP Switch 1

DIP SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x x x x x x
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Table 39-50    TM-T90/L90 — Memory Switch 1

Mem SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x x OFF x OFF OFF ON

Table 39-51    TM-T90/L90 — Memory Switch 2

Mem SW 2

2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
ON x x x x x x x

Table 39-52    TM-T90/L90 — Memory Switch 8

Mem SW 8

8–1 8–2 8–3 8–4 8–5 8–6 8–7 8–8
x x OFF x x x OFF OFF

Table 39-53    TM-T70

DIP SW 1 DIP SW 2

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8 2–1 2–2 2–3 2–4 2–5 2–6 2–7 2–8
OFF x x x x x x x ON OFF x x x OFF OFF ON

Table 39-54    TM-T70II — DIP Switch

No DIP Switch.

Table 39-55    TM-T70II — Memory Switch

Mem SW 1

1–1 1–2 1–3 1–4 1–5 1–6 1–7 1–8
x x ON x OFF x x x

Table 39-56    Legend

OFF ON = Mandatory Setting
OFF* ON* = Recommended Setting

x = Don’t Care

DIP Switch Definitions
TM-U200A

1. RS-232 serial interface model
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Table 39-57    DIP Switch 1

Switch No. Function ON OFF Default
Settings

1 Data reception error Ignored Prints “?” Off

2 Receive buffer
capacity 40 bytes

ANK model:
1000 bytes

Multilingual
model: 512

bytes

Off

3 Handshaking XON/XOFF DTR/DSR Off

4 Word length 7 bit 8 bit Off

5 Parity check Yes No Off

6 Parity selection Even Odd Off

7 Baud rate selection 4800 bps 9600 bps Off

8 BUSY condition Receive
buffer-full

Off-line
Receive

buffer-full
Off

Table 39-58    DIP Switch 2

Switch No. Function ON OFF Default
Settings

1

Selects number of
characters per line
(cpl) 7x9 font / 9x9

font

42 cpl / 35 cpl 40 cpl / 33 cpl Off

2 For internal use only
(*1) (Autocutter) Enabled Disabled On

3 For internal use only
(*1) (Autocutter)

Asynchronou
s

Synchronous
with clock Off

4 Undefined – – Off

5
For internal use only

(*1) (Semi-
autoloading)

For type A For type B/D On

6
For internal use only
(*1) (Flash memory

rewriting)
Enabled Disabled Off

7 Pin 6 reset signal Used Not used Off

8 Pin 25 reset signal Used Not used Off

2. Parallel interface model

Table 39-59    DIP Switch 1

Switch No. Function ON OFF Default
Settings

1 Auto line feed Enabled Disabled Off
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Table 39-59    (Cont.) DIP Switch 1

Switch No. Function ON OFF Default
Settings

2 Receive buffer 40 bytes – Off

3–7 Undefined – – Off

8 Busy condition Receive
buffer-full

Off-line
Receive
buffer-full

Off

Table 39-60    DIP Switch 2

Switch No. Function ON OFF Default
Settings

1 Selects number of
characters per line (cpl)
7x9 font / 9x9 font

42 cpl / 35 cpl 40 cpl / 33 cpl Off

2 For internal use only
(*1) (Autocutter)

Enabled Disabled On

3 For internal use only
(*1) (Interface
synchronization)

Asynchronous Synchronous
with clock

Off

4 Undefined – – Off

5 For internal use only
(*1) (semi-autoloading)

For Type A For type B/D On

6 For internal use only
(*1) (Flash memory
rewriting)

Enabled Disabled Off

7 Undefined – – Off

8 Pin 31 reset signal Used Not Used On

TM-U200B/D

1. RS-232 serial interface model

Table 39-61    DIP Switch 1

Switch No. Function ON OFF Default B Default D

1 Data reception error Ignored Prints “?” Off Off

2 Receive buffer
capacity 40 bytes

ANK model:
1000 bytes
Multilingual
model: 512
bytes

Off Off

3 Handshaking XON/XOFF DTR/DSR Off Off

4 Word length 7 bit 8 bit Off Off

5 Parity check Yes No Off Off

6 Parity selection Even Odd Off Off

7 Baud rate selection 4800 bps 9600 bps Off Off
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Table 39-61    (Cont.) DIP Switch 1

Switch No. Function ON OFF Default B Default D

8 BUSY condition Receive
buffer-full

Off-line
Receive
buffer-full

Off Off

Table 39-62    DIP Switch 2

Switch No. Function ON OFF Default B Default D

1 Selects number of
characters per line
(cpl) 7x9 font / 9x9
font

42 cpl / 35
cpl

40 cpl / 33
cpl

Off Off

2 For internal use
only (*1)
(Autocutter)

Enabled Disabled On Off

3 Pin 6 reset signal Used Not used Off Off

4 Pin 25 reset signal Used Not used Off Off

5 For internal use
only (*1) (Semi-
autoloading)

For type A For type
B/D

Off Off

6 For internal use
only (*1) (Flash
memory
rewriting)

Enabled Disabled Off Off

7 For internal use
only (*1) (Interface
synchronization)

Asynchron
ous

Synchrono
us with
clock

Off Off

8 Undefined – – Off Off

*1: Do not change the settings of DIP switches 2–2, 2–5, 2–6, and 2–7.

2. Parallel interface model

Table 39-63    DIP Switch 1

Switch No. Function ON OFF Default B Default D

1 Auto line feed Enabled Disabled Off Off

2 Receive buffer 40 bytes ANK
Model:
1000 bytes
Multilingua
l mode: 512
bytes

Off Off

3–7 Undefined – – Off Off

8 Busy condition Receive
buffer-full

Off-line
Receive
buffer-full

Off Off
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Table 39-64    DIP Switch 2

Switch No. Function ON OFF Default B Default D

1 Selects number of
characters per line
(cpl) 7 x 9 / 9 x 9 font

42 cpl / 35
cpl

40 cpl / 33
cpl

Off Off

2 For internal use only
(*1) (Autocutter)

Enabled Disabled On Off

3 Undefined – – Off Off

4 Pin 31 reset signal Used Not used On On

5 For internal use only
(*1) (semi-
autoloading)

For type A For type B/D Off Off

6 For internal use only
(*1) (Flash memory
rewriting)

Enabled Disabled Off Off

7 For internal use only
(*1) (Interface
synchronization)

Asynchrono
us

Synchronou
s with clock

Off Off

8 Undefined – – Off Off

*1: Do not change the settings of DIP switches 2–2, 2–5, 2–6, and 2–7.

TM-U220A/B/D (STD)

1. Serial interface model

Table 39-65    DIP Switch 1

Switch
No.

Function ON OFF Default A Default B Default D

1 Data reception
error

Ignored Print “?” Off Off Off

2 Receive buffer
capacity

40 bytes 4 KB Off Off Off

3 Handshaking XON/XOFF DTR/DSR Off Off Off

4 Word length 7 bits 8 bits Off Off Off

5 Parity check Yes No Off Off Off

6 Parity selection Even Odd Off Off Off

7 Transmission
speed selection

4800 bps 9600 bps Off Off Off

8 BUSY condition Receive
buffer-full

Offline
Receive
buffer-full

Off Off Off
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Table 39-66    DIP Switch 2

Switch
No.

Function ON OFF Default A Default B Default D

1 Selects number
of characters

per line (cpl) (*)

42 cpl / 35
cpl

40 cpl / 33
cpl

Off Off Off

2 Reserved
(Autocutter)

Enabled Disabled On On Off

3 Undefined — – Off Off Off

4 Serial
communication

set selection

By
memory
switch

By DIP
switch

Off Off Off

5 Undefined – — Off Off Off

6 Reserved (Flash
memory

rewriting)

Enabled Disabled Off Off Off

7 Pin 6 reset
signal

Used Not used Off Off Off

8 Pin 25 reset
signal

Used Not used Off Off Off

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots

The number of characters per line in the Table indicates for the 76 mm-width
paper.

2. Parallel interface model

Table 39-67    DIP Switch 1

Switch
No.

Function ON OFF Default A Default B Default D

1 Auto line feed Enabled Disabled Off Off Off

2 Receive buffer 40 bytes 4KB Off Off Off

3 Undefined – – Off Off Off

4 Undefined – – Off Off Off

5 Undefined – – Off Off Off

6 Undefined – – Off Off Off

7 Undefined – – Off Off Off

8 BUSY condition Receive
buffer-
full

Offline
Receive
buffer-
full

Off Off Off
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Table 39-68    DIP Switch 2

Switch No. Function ON OFF Default A Default B Default D

1 Selects number of
characters per
line (cpl) (*)

42 cpl / 35
cpl

40 cpl / 33
cpl

Off Off Off

2 Reserved
(Autocutter)

Enabled Disabled On On Off

3 Undefined – – Off Off Off

4 Undefined – – Off Off Off

5 Undefined – – Off Off Off

6 Reserved (Flash
memory
rewriting)

Enabled Disabled Off Off Off

7 Undefined – – Off Off Off

8 Pin 31 reset signal Used Not used On On On

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots.

The number of characters per line in the Table indicates for the 76 mm-width paper.

TM-U220B/D (US STD)

1. Serial interface model

Table 39-69    DIP Switch 1

Switch No. Function ON OFF Default B Default D

1 Printing mode Right side up
printing
mode

Normal
printing
mode

Off Off

2 Receive buffer
capacity

40 bytes 4KB Off Off

3 Handshaking XON/XOFF DTR/DSR Off Off

4 Word length 7 bits 8 bits Off Off

5 Parity check Yes No Off Off

6 Parity selection Even Odd Off Off

7 Transmission speed
selection

4800 bps 9600 bps Off Off

8 BUSY condition Receive
buffer-full

Offline
Receive
buffer-full

Off Off

Table 39-70    DIP Switch 2

Switch No. Function ON OFF Default B Default D

1 Selects number of
characters per line

(cpl) (*)

42 cpl / 35
cpl

40 cpl / 33
cpl

Off Off
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Table 39-70    (Cont.) DIP Switch 2

Switch No. Function ON OFF Default B Default D

2 Reserved
(Autocutter)

Enabled Disabled On Off

3 Pin 6 reset signal Used Not used Off Off

4 Pin 25 reset signal Used Not used Off Off

5 Undefined – – Off Off

6 Reserved (Flash
memory rewriting)

Enabled Disabled Off Off

7 Undefined – – Off Off

8 Serial
communication set

selection

By memory
switch

By DIP
switch

Off Off

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots.

The number of characters per line in the Table indicates for the 76 mm-width
paper.

2. Parallel interface model

Table 39-71    DIP Switch 1

Switch No. Function ON OFF Default B Default D

1 Printing mode Right side
up printing
mode

Normal
printing
mode

Off Off

2 Receive buffer 40 bytes 4KB Off Off

3 Undefined – – Off Off

4 Undefined – – Off Off

5 Undefined – – Off Off

6 Undefined – – Off Off

7 Undefined – – Off Off

8 BUSY condition Receive
buffer-full

Offline
Receive
buffer-full

Off Off

Table 39-72    DIP Switch 2

Switch No. Function ON OFF Default B Default D

1 Selects number of
characters per line

(cpl) (*)

42 cpl / 35
cpl

40 cpl / 33
cpl

Off Off

2 Reserved
(Autocutter)

Enabled Disabled On Off

3 Undefined – – Off Off

4 Pin 31 reset signal Used Not used On On

Chapter 39
Printer DIP and Memory Switch Settings

39-30



Table 39-72    (Cont.) DIP Switch 2

Switch No. Function ON OFF Default B Default D

5 Undefined – – Off Off

6 Reserved (Flash
memory rewriting)

Enabled Disabled Off Off

7 Undefined – – Off Off

8 Undefined – – Off Off

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots.

The number of characters per line in the Table indicates for the 76 mm-width paper.

TM-T88III/IV/V and TM-T70

1. Serial interface specification

Table 39-73    DIP Switch 1

SW 1 Function ON OFF Factory Setting

1 Data reception
error

Ignored Prints “?” OFF

2 Receive buffer
capacity

45 bytes 4 KB OFF

3 Handshaking XON/XOFF DTR/DSR OFF

4 Word length 7 bits 8 bits OFF

5 Parity check Yes No OFF

6 Selection of parity Even Odd OFF

7 Selection of
transmission
speed

See Table 18 See Table 18 ON

8 Selection of
transmission
speed

See Table 18 See Table 18 OFF

Table 39-74    Transmission Speed

Transmission speed (bps) SW 1–7 SW 1–8

(*1) ON ON

4800 OFF ON

9600 ON OFF

19200 OFF OFF

bps: bits per second
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Table 39-75    DIP Switch 2

SW 2 Function ON OFF Factory
Setting

1 Handshaking (Condition
or BUSY)

Receive buffer
full

Offline
Receive buffer-
full

OFF

2 Reserved (Do not
change settings)

Fixed to OFF Fixed to OFF OFF

3 Selects print density See Table 20 See Table 20 OFF

4 Selects print density See Table 20 See Table 20 OFF

5 Setting the conditions
that cancel the receive
buffer BUSY state (This
function is effective
when the receive buffer
capacity is set to 4 KB.)

Cancels the BUSY
state when the
remaining
capacity of the
receive buffer
reaches 138
bytes.

Cancels the BUSY
state when the
remaining
capacity of the
receive buffer
reaches 256
bytes.

OFF

6 Reserved (Do not
change settings)

Fixed to OFF Fixed to OFF OFF

7 I/F pin 6 reset signal Enabled Disabled OFF

8 I/F pin 25 reset signal Enabled Disabled OFF

Table 39-76    DIP Switch 2–3 and 2–4

Switch No. 3 Switch No. 4 Function

OFF OFF Print density (Standard)

ON OFF Print density (Medium)

OFF ON Print density (Dark)

ON ON Prohibited

2. Parallel interface specification

Table 39-77    DIP Switch 1

SW Function ON OFF Factory
Setting

1 Auto line feed Always
enabled

Always
disabled

OFF

2 Receive buffer capacity 45 bytes 4 KB OFF

3 Selects paper sensors to
output paper-end signals
(default value of ESC c 3)

Disabled Roll paper end
sensor
enabled; roll
paper near-
end sensor
enabled

OFF

4 Sets error signal Disabled Enabled OFF

5–8 Undefined – – OFF
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Table 39-78    DIP Switch 2

SW Function ON OFF Factory
Setting

1 Handshaking (Condition
for BUSY)

Receive buffer full Offline
Receive buffer
full

OFF

2 Reserved (Do not change
settings)

Fixed to OFF Fixed to OFF OFF

3 Selects print density See Table 23 See Table 23 OFF

4 Selects print density See Table 23 See Table 23 OFF

5 Setting the conditions that
cancel the receive buffer
BUSY state (this function
is effective when the
capacity of the receive
buffer is set to 4 KB).

Cancels the BUSY
state when the
remaining capacity
of the receive buffer
reaches 138 bytes.

Cancels the BUSY
state when the
remaining
capacity of the
receive buffer
reaches 256
bytes.

OFF

6 Reserved (Do not change
settings)

Fixed to OFF Fixed to OFF OFF

7 Reserved (Do not change
settings)

Fixed to OFF Fixed to OFF OFF

8 Interface pin 31 reset
signal (Do not change
settings)

Fixed to ON Fixed to ON ON

Table 39-79    DIP Switch 2–3 and 2–4

3 4 Function

OFF OFF Print density (Standard)

ON OFF Print density (Medium)

OFF ON Print density (Dark)

ON ON Prohibited

TM-T70II

Table 39-80    Memory Switch 1

Memory Switch Function Setting Value — 48
(OFF)

Setting Value — 49
(ON)

Defaults

1–1 (Reserved) – – 48 (OFF)

1–2 Receive buffer
capacity

4 KB 45 bytes 48 (OFF)

1–3 Condition for BUSY Receive buffer full
or offline

Receive buffer full 48 (OFF)

1–4 Data processing for
receiving error

Replaced with “?” Ignored 48 (OFF)

1–5 Automatic line feed Always disabled Always enabled 48 (OFF)

1–6 (Reserved) – – 48 (OFF)
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Table 39-80    (Cont.) Memory Switch 1

Memory Switch Function Setting Value — 48
(OFF)

Setting Value — 49
(ON)

Defaults

1–7 (Reserved) – – 48 (OFF)

1–8 (Reserved) – – 48 (OFF)

Table 39-81    Memory Switch 2

Memory
Switch

Function Setting Value —
48 (OFF)

Setting Value — 49
(ON)

Defaults

2–1 to 2–8 (Reserved) – – 48 (OFF)

Table 39-82    Memory Switch 3

Memory
Switch

Function Setting Value —
48 (OFF)

Setting Value — 49
(ON)

Defaults

3–1 to 3–8 (Reserved) – – 48 (OFF)

Table 39-83    Memory Switch 4

Memory
Switch

Function Setting Value —
48 (OFF)

Setting Value — 49
(ON)

Defaults

4–1 to 4–8 (Reserved) – – 48 (OFF)

Table 39-84    Memory Switch 5

Memory
Switch

Function Setting Value —
48 (OFF)

Setting Value — 49
(ON)

Defaults

5–1 Sets USB power-
saving function *1

Enabled Disabled 48 (OFF)

5–2 Sets recovery
conditions from
receive buffer
BUSY (Enabled
when the receive
buffer capacity is
set to 4 KB)

Recovers when the
remaining receive
buffer capacity
becomes 256 bytes

Recovers when the
remaining receive
buffer capacity
becomes 138 bytes

48 (OFF)

5–3 Selects paper
sensors to output
paper-end signals
(default value of
ESC c 3)

Roll paper end
sensor enabled;
roll paper near-
end sensor
enabled

Disabled 48 (OFF)

5–4 Sets error signal Enabled Disabled 48 (OFF)

5–5 (Reserved) – – 48 (OFF)

5–6 (Reserved) – – 48 (OFF)

5–7 (Reserved) – – 48 (OFF)
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Table 39-84    (Cont.) Memory Switch 5

Memory
Switch

Function Setting Value —
48 (OFF)

Setting Value — 49
(ON)

Defaults

5–8 (Reserved) – – 48 (OFF)

*1: Valid only when the USB interface communication condition is set to the vendor-defined
class and the system configuration is set so that the USB driver can support the USB power-
saving function.

Function 11

Function 11 — Descriptions

• Sets the configuration item for the serial interface specified by a to the values specified
by d.

a Configuration Item

1 Transmission speed

2 Parity

3 Handshaking

4 Bit length

• Transmission speed settings (a = 1)

d1...dk Transmission Speed

“2400” 2400 bps

“4800” 4800 bps

“9600” 9600 bps

“19200” 19200 bps

“38400” 38400 bps

“57600” 57600 bps

“115200” 115200 bps

• Parity settings (a =2)
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d1 Parity

48 None

49 Odd

50 Even

• Handshaking settings (a = 3)

d1 Handshaking

48 DTR/DSR control

49 XON/XOFF control

• Bit length settings (a = 4)

d1 Bit Length

55 7 bits

56 8 bits
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40
Logo Printing

You can print the logo of your Enterprise, property, or revenue center on guest checks,
customer receipts, and credit card vouchers. Simphony only supports monochrome bitmap
image files. Use Microsoft Paint to convert an image to a monochrome bitmap. Adhere to the
following rules governing the size of your logo:

• The image area must not exceed 98,304 pixels. (Keep in mind that a logo that is 512 x
384 pixels exceeds 98,304 pixels.)

• The image width must not exceed 512 pixels.

• The image height must not exceed 384 pixels.

• The bitmap file must not exceed 8 kilobytes in size.

You can configure print tasks to print more than one logo (on either the Header or Trailer
sections, or both). The printer loads one image at a time when printing a check, receipt, or
credit card voucher. The time it takes to print depends on the number of images the printer
has to load.

Beginning with the Simphony 19.2 release, logo printing is now also supported on:

• OPOS printers with multi-language cards installed

– Configuring logo printing for OPOS printers is no different from other printers in the
Simphony EMC.

– For specific third-party printer installation instructions, access the vendor’s website.

Complete the following tasks to set up logo printing:

• Upload a logo to Simphony

• Assign a logo to guest checks, customer receipts, and credit card vouchers

• Set the printer to print the logo

• Ensure the DIP settings for the printer's buffer are set to the higher value to
accommodate the logo's additional data

Printer DIP and Memory Switch Settings contains more information on DIP settings.

Uploading a Logo to Simphony
1. Select the Enterprise level, click Configuration, and then click Print Logos.

2. Insert a new record, and then double-click it to open in form view.

3. Click Load Image.

4. Select the image, and then click Open to upload it to Simphony. After the logo uploads,
an image preview appears.

5. Alternately, you can copy the image to your clipboard, and then click Paste Image to
upload it to Simphony.

6. Click Save.
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Assigning a Logo to Guest Checks and Customer Receipts
1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and

then click Guest Check Headers.

2. Select a check box in the Use Logo column.

If you select Use Logo for an existing record that has content in the Text column,
that text no longer appears on printed guest checks and customer receipts.

3. Click the ellipsis point (...) button in the Logo column, select the image you
uploaded, and then click OK.

4. Click Save.

5. To assign the logo to customer receipts and guest check trailers, repeat these
steps, selecting the Guest Check Trailers and Customer Receipt Headers
modules in Step 1.

You must also select 28 - Print Guest Check Trailer on Fast Transaction
Customer Receipt for tender records from the Tender/Media options. If you do not
set this option, trailers do not print on customer receipts when the tender is used to
close a fast transaction.

6. Click Save.
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41
Banquet Guest Check Printing

This chapter discusses the configuration and usage of the Banquet Guest Check Printing
feature.

A Banquet Guest Check is used to present a specially formatted guest check for customers.
Even though it can be used anywhere, the banquet guest check is intended for use in a
banquet environment. In this environment, there are additional components of information
which can be reflected on a guest check. Information such as the event name, address,
contact information, name of the function room the event was held, names of the maitre’d and
catering sales manager, and the event’s serving period.

One format of the Banquet Guest Check is available, utilizing an 8.5 x 11 page output and
prints on a custom page printer.
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Figure 41-1    Example of a Printed Banquet Guest Check

Configuring Employee Privileges for Banquet Guest Check
Printing

Operators must be assigned Role privileges to be allowed to configure and utilize
Banquet Guest Check printing functionality. To assign privileges to employees for this
feature:
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To Configure the Role Option to Begin a Banquet Check By Prompt

Prerequisite: The operator already has access to a Begin Check By Prompt function
touchscreen button.

1. Access the EMC and select the enterprise level, click the Configuration tab, and then
click Roles.

2. Select or create an employee role and toggle to Form view.

3. Click the Operations tab, and then click the Guest Checks tab.

4. From the Add/Transfer/Pickup Options section, enable the 199 - Begin Check by
Prompt option and Save.

5. Access and sign onto a point-of-sale (POS) workstation.

6. Press the Begin Check by Prompt button.

To Configure the Role Option to Edit a Banquet Check By Prompt

Prerequisite: The operator already has access to a Begin Check By Prompt function
touchscreen button.

1. Access the EMC and select the enterprise level, click the Configuration tab, and then
click Roles.

2. Select or create an employee role and toggle to Form view.

3. Click the Operations tab, and then click the Guest Checks tab.

4. From the Check Editing Options section, enable the 200 - Edit Check by Prompt option
and Save.

5. Access and sign onto a point-of-sale (POS) workstation.

6. Open a banquet check from the check listing.

7. Select a header and press the Edit Prompt button.

To Configure the Prompt for Authorization to Create a Banquet Check

Prerequisite: The operator already has access to a Begin Check By Prompt function
touchscreen button.

If you want to require only privileged users to authorize beginning and printing banquet
checks:

1. Access the EMC and select the enterprise level, click the Configuration tab, and then
click Roles.

2. From the Add/Transfer/Pickup Options section, disable the 199 - Begin Check by
Prompt option for all non-privileged users roles and Save.

3. Access and sign onto a point-of-sale (POS) workstation.

4. Press the Begin Check by Prompt button.

5. Have a privileged user enter their authorization code to begin the check.

To Configure the Prompt for Authorization to Edit a Banquet Check

Prerequisite: The operator already has access to a Begin Check By Prompt function
touchscreen button.
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If you want to require only privileged users to authorize editing and printing banquet
checks:

1. Access the EMC and select the enterprise level, click the Configuration tab, and
then click Roles.

2. From the Check Editing Options section, disable the 200 - Edit Check by Prompt
option for all non-privileged users roles and Save.

3. Access and sign onto a point-of-sale (POS) workstation.

4. Open a banquet check from the check listing.

5. Select a header and press Edit Prompt.

6. Have a privileged user enter their authorization code to edit the check.

Configuring Banquet Guest Check Buttons and Prompts
To configure the Begin Banquet Guest Check for point-of-sale (POS) workstation
touchscreens:

1. Access the EMC and select the Enterprise, Property, Revenue Center, or Zone,
click the Configuration tab, and then select Page Design.

2. You can configure an existing touchscreen or add a new one. Add a new button.

Figure 41-2    Page Design – Add Button

3. From the Type drop-down list, select Function, select the Begin Check By
Prompt function, and then click OK.
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Figure 41-3    Page Design – Begin Check By Prompt Function

4. Click the Configure Prompt Details button.

Figure 41-4    Page Design – Configure Prompt Details

Option 1 – Clicking the ‘No’ Button

1. Click No when prompted.
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Figure 41-5    Configure Prompt Details ‘No’ Response

2. From the Prompt Details section, configure the following:

a. From the Prompt Type field, select Configurable.

b. From the Dialog Type field, select a type from the drop-down list.

c. From the Prompt Category field, select BanquetPrompt.

d. From the Prompt Title field, select a title category from the drop-down list.

e. From the Prompt Text field, enter the appropriate text based on the Prompt
Title setting.

f. From the Content Name field, enter a name for your banquet content.

g. Click the Add button, and then click Ok.

Figure 41-6    Configure Prompt Content Window - Prompt Details

Option 2 – Clicking the ‘Yes’ Button

1. A prompt asks you to choose the existing configuration prompt to set, or select the
prompt content.
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Figure 41-7    Configure Prompt Details ‘Yes’ Response

• Selecting Yes displays a list of all the existing configuration file names in the Content
table.

Figure 41-8    Select Existing Content Prompt

• As mentioned previously, selecting No allows you to set the prompts and save details
in the Content table. Specify the name of the content.

2. As shown in Figure 5 above, configure the Prompt Type, Dialog Type, Prompt Category,
Prompt Title, Prompt Text, Default Value, and then enter a Content Name. Click Add and
Ok.

Note:

The Optional check-box allows the prompt to bypass the next screen and
allows the user to click OK.

• There are a number of options when configuring prompt content. Prompt Types can be
Configurable or Non-Configurable. Dialog Types include AlphaNumeric, Numeric, List,
and by Date. Users must select from the following list of configurable prompt items that
can be used for a Banquet Check:

– name="lblOrganization" >Organization

– name="lblAcct" >Acct

Chapter 41
Configuring Banquet Guest Check Buttons and Prompts

41-7



– name="lblCustName" >Name

– name="lblCustAddress1" >Address Line 1

– name="lblCustAddress2" >Address Line 2

– name="lblCustCity" >City

– name="lblState" >State

– name="lblZip" >Zip

– name="lblDate" >Date

– name="lblTime" >Time

– name="lblEvent" >Event

– name="lblSalesperson" >Sales Person

– name="lblMaitred" >Maitre D'

– name="lblGuarantee" >Guarantee

Configurable Prompt Type

The example below illustrates a Configurable Prompt Type. When this type is
configured, users are prompted to enter the requested information at the POS
workstation — in this case, a selection of function rooms.

Figure 41-9    Configure Prompt Content Window - Configurable Type

Non-Configurable Prompt Type

Non-Configurable prompts are not sent to users when beginning a Banquet Check.
Regardless of the assigned Dialog Type (e.g., Alphanumeric, Numeric, List , or Date),
users are not prompted to enter information.
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Figure 41-10    Configure Prompt Content Window - Non-Configurable Type

When configuring a Non-Configurable prompt, and a Default Value is entered, the value is
printed on the Banquet Check by default, without any prompts being sent to the user. The
following example illustrates a List Dialog Type to provide a list of items — in this case, a
selection of cities.

Figure 41-11    Non-Configurable Type - List Dialog Type
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When configuring a Non-Configurable prompt and the user does not enter a Default
Value (leaves the setting blank), nothing is printed on the Banquet Check.

Figure 41-12    Non-Configurable Type - Blank Default Value Setting

Users may configure Non-Configurable prompts when certain data does not change
and remains static in a Banquet Check. For example, if the organization holding the
banquet is always the same, then it can be defined as a Non-Configurable prompt.

1. The details and content name added or selected is added as Arguments in the
button properties panel.
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Figure 41-13    Page Design - Button Properties Panel

2. The configuration data for Banquet Check prompts is saved in the Content module as a
String in the Content Type field, and is shown using XML format below.
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Figure 41-14    Property Level Content Module

Configuring a Banquet Check Add/Transfer by Number

The following steps illustrate how to transfer one Banquet Check to another.

1. Access the EMC, select a Revenue Center, click the Configuration tab, and then
click Page Design.

2. Choose the touchscreen page to be edited and add a new button.

3. Select Function as the Type, select Add/Transfer by Number, click OK, and
then Save.

Figure 41-15    Page Design – Add/Transfer by Number Function

4. Access and sign onto a point-of-sale (POS) workstation.
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5. Begin a Banquet Check and ring up menu items. Note the check number and service
total.

6. Begin a second Banquet Check and ring menu items. Note the check number and
service total.

7. Pickup the first Banquet Check from the workstation Pick Up check list.

8. Press the Add/Transfer by Number button.

9. Enter the second Banquet Check number mentioned in step 6. The first check’s prompt
data overwrites the second check’s prompt data when the checks are merged.

10. Press OK from the ‘Add Check’ screen. The second Banquet Check is transferred to the
first one.

Configuring a Banquet Split Check

The following steps illustrate how to split a Banquet Check.

1. Access the EMC, select a Revenue Center, click the Configuration tab, and then click
Page Design.

2. Choose the touchscreen page to be edited and add a new button.

3. Select Function as the Type, select Touch Split, click OK, and then Save.

Figure 41-16    Page Design – Touch Split Function

4. Access and sign onto a point-of-sale (POS) workstation.
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5. Begin a Banquet Check, ring up some menu items, and then service total.

6. Pickup the first Banquet Check from the workstation Pick Up check list, and then
press the Touch Split button.

7. Add a check, move some menu items from one check to another, and then press
Save.

8. Press Yes in response to the ‘Exit and save changes?’ prompt.

9. Press Yes in response to the ‘Print split checks?’ prompt. The Banquet Check is
split and the individual checks can be viewed in the open checks list. The first
check’s prompt data is copied to the second check when the checks are split.

Configuring RVC Table Names as Room Names

1. Access the EMC, select a Property, click the Configuration tab, click Employee
Classes, and then select the Operator Options tab.

2. Enable the 1- Table Number Entry Required to Begin/Pickup Checks and 2-
Number of Guest Entry Required for New Checks options, click OK, and then
Save.
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Figure 41-17    Employee Classes - Operator Options

3. Access the EMC, select a Revenue Center, click the Setup tab, and then select the
Tables module (under the RVC Configuration header).

4. Insert or click an available record, enter a room name, for example, Board Room, assign
a Dining Table Class in the Class field, and then Save.
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Figure 41-18    Revenue Center Configuration - Tables Module

Adding a Banquet Guest Check Printer and Various Print
Settings

Configuring a Custom Page Printer

1. A Printer driver must be installed on the workstation.

2. Enter the hostname of the printer.

Figure 41-19    Add a Printer on the Workstation
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3. Access the EMC, select a Property, click the Setup tab, select the Printers module
(under the Hardware/Interfaces header).

4. Configure a network banquet printer. For the Printer Type field, select Custom Page
Printer from the drop-down list.

Figure 41-20    EMC Printers Module

5. Enter the network printer name in the Name field and Save.

Note:

The Name field entry must be the physical printer’s name as seen on the
network and the Printer Host's IP address in the Printer Configuration section’s
Address field.

Figure 41-21    EMC Printers Module (continued)
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6. Access the EMC, select a Property, click the Setup tab, select the Workstations
module (under the Hardware/Interfaces header).

7. Choose the banquet printing workstation record and click the Printers tab.

8. Click Select, and from the drop-down list, choose the output printer in the
Banquet Check Printer field (should be the Custom Page Printer type), click OK,
and then Save.

Figure 41-22    Workstation Module - Assigning the Banquet Check Printer

Configuring a Tender Media Deposit

Users can post a Deposit Payment amount on a Banquet Check. If configured, the
deposit tender amount prints in a special location on the Banquet Check.

1. Access the EMC, select the Enterprise level, click the Configuration tab, select
the Report Groups module (under the Reporting and Data header).

2. Insert a new record, name it, and then from the Type field, select Tender/Media
from the drop-down list.
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Figure 41-23    Report Groups Module

3. A Deposit Payment Tender is linked to a Report Group by enabling the 5 - Deposit Type
of Tender Media option. From the Options field, click the ellipsis (…) to open the Report
Group Tender Media Options screen. Select option 5, click OK, and then Save.

4. Users can add an advance deposit payment against the Banquet Check by configuring a
new payment tender.

Figure 41-24    Tender/Media - Advance Deposit Payment

Configuring Tender/Media Printing on Banquet Checks

To print a Banquet Check prior to finalizing the transaction, you can create a Tender/Media
record configured as a Service Total type. You can also use a Payment type to print a
Banquet Check when the transaction is tendered or finalized.
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Figure 41-25    Tender/Media - Print Banquet Check Service Total

1. Before printing a Banquet Check, access the EMC, select the enterprise or
property level, click the Configuration tab, select the Tender/Media module
(under the Sales header).

2. Select the Printing Options tab, enable the 90 - Print Banquet Check option,
and then Save.

Configuring Page Margins for Banquet Check Printing

1. Access the EMC, select a Property, click the Setup tab, select the Printers
module (under the Hardware/Interfaces header).

2. Select the Banquet Check printer record.

3. Enter the values for the top, bottom, and left margins, and then Save.
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Figure 41-26    Formatting Banquet Check Page Margins

Creating and Printing Banquet Guest Checks From a POS
Workstation

Beginning a Banquet Check

Once EMC configuration is complete, you can now begin to generate banquet guest checks
from a point-of-sales (POS) workstation.

1. After configuring a Begin Check By Prompt button in the EMC’s Page Design module,
access a workstation and press the Begin Check By Prompt button.
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Figure 41-27    Begin Check By Prompt

Note:

If a user cancels any one of the sequential Banquet Check prompts, the
entire check/transaction is cancelled.

2. Add the Banquet Check’s header detail through prompts.
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Figure 41-28    Banquet Check - Enter Name Window

3. Select the Room name. This step uses the EMC Tables module data to show a list of
room names.

4. Select the Serving Period.

Figure 41-29    Banquet Check - Select Serving Period
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5. The workstation’s Check Detail area displays the selected serving period.

Figure 41-30    Banquet Check - Shows Selected Serving Period

6. Select the header content in the Name field to edit. Press OK when finished.

Figure 41-31    Banquet Check - Edit the Header Content
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7. The Check Detail area displays the newly entered header text.

Figure 41-32    Banquet Check - Edited Header Content

Utilizing Banquet Checks With Serving Periods

1. Log onto a POS workstation and press the Begin Check By Prompt button.

Figure 41-33    Banquet Check - Begin Check By Prompt
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2. Enter the header prompt details and press OK to continue.

Figure 41-34    Banquet Check - Editing Header Prompt Details

3. Enter a table number and press Ok.
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Figure 41-35    Begin Check - Enter Table Number

4. Enter the number of guests and press Ok.

Figure 41-36    Begin Check - Enter Guest Count

5. Select a serving period and press Ok.
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Figure 41-37    Banquet Check - Select Serving Period

Configuring Check Printing Privileges

Printing of all checks, including Banquet Checks, requires privileges to be assigned to
employees Roles. Other EMC options also need to be enabled. To assign guest check
printing privileges:

1. Access the EMC and the select the Enterprise level, click the Configuration tab,
and then select Roles. Select the Role to be edited and toggle to Form view.

2. Click the Operations tab, click the Printing tab and enable the 23 - Authorize/
Perform Unlimited Reprinting/Printing of a Check option.

3. To control how many checks may be printed by employees before requiring
authorization, access the EMC and select the Property or Revenue Center level.
Click the Setup tab, and then click the Control Parameters module (under the
Parameters heading). Click the Configuration tab and from the Number of
Checks Printed Before Authorization field, enter a digit (from 0–99) to allow
staff to print Banquet Checks until the threshold limit is exceeded.
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Figure 41-38    EMC Control Parameters - Number of Checks to Print Before
Authorization Setting

4. Access the EMC, select a Property, click the Configuration tab, and then click Tender/
Media (under the Sales header).

5. Click the Options tab, click the Printing Options tab, and then enable the 23 - Print
Check on Demand option and Save.
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Figure 41-39    EMC Tender/Media Printing Options

6. Finally, each employee allowed to immediately print guest checks, needs to have
another privilege assigned to them. This setting can be accessed from the EMC by
selecting a Property, click the Configuration tab, click the Employee Classes
module, and then click the Operator Options tab. From the Operator Type field,
select 1 - On Demand from the drop-down list and Save.
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42
Configuring Pre-Production Chits to Output to
Remote Printers

Kitchen or bar staff can preview orders and begin preparing items that require more prep or
cooking time to assist in delivering orders more quickly. Pre-production printing allows servers
to send certain menu items to remote printers prior to finalizing the current round.

Operationally, as workstation operators add menu items, they can select a Pre-Production
Chit (Tender/Media Service Total) button to send the pre-production items to remote printers.
For easier recognition, pre-production chits are formatted differently than the output of
conventional order chits.

After an item is fired through pre-production chit printing, if the workstation operator adds a
second item and then selects pre-production chit printing again, the system only fires the
second item. The first item does not trigger the re-fire of a pre-production chit.

Configuring Print Classes for Pre-Production Chits
To configure and assign printers to a pre-production Print Class:

1. Select the Enterprise or property, click Configuration, and then click Print Classes.

2. Insert a new record and enter the name of the pre-production print class in the Name
field (for example, Print Pre-Production Chit).

3. Configure settings within the Options section as needed.

4. Select the Routing Group from the drop-down list in the Output section.

Typically, enabling the 0 - Use Order Devices routing group suffices for most pre-
production chit printing tasks.

5. Enable the order devices that are to serve as a pre-production remote printers.

6. Click Save.

Configuring Tender/Media - Service Total Records for Pre-
Production Chits

To configure Tender/Media - Service Total records for pre-production chit printing:

1. Select the Enterprise or property, click Configuration, and then click Tender Media.

2. Insert a new record, and enter the name of the pre-production service total record (for
example, Print Pre-Production Chit).

3. In the General Settings section, assign a Privilege Group that allows users to use this
service total.

4. In the Key Type field, select 2 - Service Total from the drop-down list.

5. Configure the remainder of the General tab settings, and then click the Options tab.
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6. Click the Printing Options tab, and then enable the 98 - Print Pre-Production
Chit option.

7. Click the Ops Behavior tab, and then select 2 - Hold Order as the Tender Media
Hold Type from the drop-down list.

8. Configure the remainder of this service total record’s settings.

9. Click Save.

Configuring Menu Item Classes for Pre-Production Chits
You need to determine which menu items to apply pre-production chit printing,
navigate to each of these items’ assigned Menu Item Class, and assign the pre-
production chit print class. To configure Menu Item Classes to generate pre-production
chits:

1. Select the Enterprise, property, or revenue center, click Configuration, and then
click Menu Item Classes.

2. On the General tab, select the pre-production print class from the Pre-Production
Chit Print Class drop-down list.
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Figure 42-1    Menu Item Classes - Pre-Production Chit Print Class Setting

3. Click Save.

Configuring a Page Design Button for Pre-Production Chits
To configure a workstation button to generate pre-production chit printing:

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. On the order entry pages of your choice, add a new button and configure the following
fields:

a. Legend: Enter the button name.

b. Type: Select Tender/Media, and then select the Print Pre-Production Chit, Tender/
Media - Service Total record.
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Figure 42-2    Page Design - Workstation Button for Pre-Production Chit
Printing

3. Configure the remainder of the button’s settings.

4. Click Save.

Example of a Pre-Production Chit
Pre-Production chits are formatted differently than conventional order output to remote
printers. The text * TO BE PREPARED * prints by default on each chit (with the Order
Type showing directly beneath it), prior to the Dining Course name (if enabled), and
then the quantity ordered is printed adjacent to each ordered Menu Item.

If enabled, the Dining Course Name prints and also adheres to the Print Classes
settings, whereby if the 4 - On = Red, Off = Black option is enabled, the Dining
Course name prints in red, and prints in black if disabled.

Here is an example of a Pre-Production Chit:
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Figure 42-3    Example of a Pre-Production Chit
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43
Peripheral Devices

Peripheral devices connect with and relay information to or from Simphony. For example,
common POS peripheral devices include magnetic card readers, cash drawers, coin
dispensers, printers, pole displays, and scales.

Cash Drawer Assignment and Unassignment
You can assign a cash drawer in the following ways:

• By workstation

• By workstation operator

Giving multiple employees access to a single cash drawer is less secure than requiring
employees to be assigned to a cash drawer.

When you set the option Assign Cash Drawer By User Workstation from the Workstations
module, workstation operators can assign themselves to a cash drawer using the one of the
following function keys:

• 848 - Assign Cash Drawer

• 839 - Assign Cash Drawer 1

• 840 - Assign Cash Drawer 2

The following table compares these function keys:

Table 43-1    Assign Cash Drawer Function Key Comparison

848 - Assign Cash Drawer 839 - Assign Cash Drawer 1 and 840 - Assign
Cash Drawer 2

Assigns the drawer to the workstation
operator who is signed in.

Assigns the drawer to the workstation
operator who is signed in.

If two drawers are used with the workstation,
Simphony assigns drawer 1 if both are
unassigned. If drawer 1 is assigned, Simphony
assigns drawer 2, and vice-versa.

If two drawers are used with the workstation,
these keys allow the workstation operator to
select the drawer he or she wants to assign. (To
offer a choice, you must configure both keys
on the touchscreen.)

Using this key opens the cash drawer. Using this key does not open the cash drawer.

If the cash drawer is unassigned, using this key
prompts the workstation operator to assign the
cash drawer number.

If the cash drawer is unassigned, using this key
prompts the workstation operator to assign the
cash drawer number, while the top of the
screen shows INACTIVE (no one is assigned).
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Table 43-1    (Cont.) Assign Cash Drawer Function Key Comparison

848 - Assign Cash Drawer 839 - Assign Cash Drawer 1 and 840 - Assign
Cash Drawer 2

If a workstation operator attempts to assign
the drawer when another workstation
operator is already assigned, the following
error message appears: All Cash Drawers
Currently Assigned.

If the workstation operator attempts to assign
the drawer when another workstation
operator is already assigned, no error message
appears. The top of the screen show NAME (of
the person assigned to the drawer). Thus, one
person may assign the drawer and override
the workstation operator who is already
assigned.

All workstation operators can use this function
key.

All workstation operators cannot use this
function key.

At the end of a shift, the workstation operator
or a privileged manager needs to unassign the
drawer to allow another workstation operator
to use the drawer.

At the end of a shift, it is not necessary to
unassign the drawer because another
workstation operator may override the
assigned workstation operator.

The 849 - Unassign Cash Drawer function key unassigns the drawer from the
workstation operator, regardless of whether the workstation operator assigned the
drawer using function 848 or 839/840. All workstation operators can always unassign
themselves from a drawer. You can prevent this by removing the Unassign Cash
Drawer function key from the touchscreen or restrict its access using a lockout macro.

Related Topics

• Configuring a Cash Drawer

Configuring a Cash Drawer
1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation to be used with the cash drawer.

3. Click the Transactions tab.

4. Select the number of Cash Drawers (0, 1, or 2) that are physically installed at the
workstation.

5. In the Cash Drawer Beep Timeout field, enter the number of seconds the cash
drawer can be open before the workstation begins beeping. If you set this value to
0 (zero), beeping does not occur.

6. In the Cash Drawer Notify Timeout field, enter the number of seconds the cash
drawer can be open before the workstation posts a message to the journal log file.
If you set this value to 0 (zero), the message does not post to the journal log.

7. Click the Options tab, and then click the Hardware/Cash Drawer subtab.

8. Select the appropriate cash drawer options.
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Table 43-2    Cash Drawer Workstation Options

Option Description

Require Cash Drawer to be Closed Before
New Transaction

Select this option to require the workstation
operator to close the cash drawer before
beginning a new transaction. Deselect this
option to allow transactions to begin while a
cash drawer is open.

Assign Cash Drawer By User Workstation Select this option to allow workstation
operators to assign themselves to the cash
drawer using the one of the function keys
(848 - Assign Cash Drawer, 839 - Assign
Cash Drawer 1, or 840 - Assign Cash
Drawer 2). Only the workstation operator
assigned to the drawer can open it.

Use Other Cash Drawer for Other Currency Select this option if two cash drawers are in
use for the workstation and one is dedicated
to foreign currency.

Require Cash Drawer Assignment to Begin
Transaction

Select this option to require a workstation
operator to have a cash drawer assigned
prior to beginning a transaction at the
workstation.

9. Click Save.

10. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Control Parameters.

11. Click the Options tab.

12. Select the appropriate cash drawer options.

Table 43-3    Cash Drawer Control Options

Option Description

23 - Open Drawer Only if Balance Due is 0.00 Select this option to prevent a tender/media
key from opening the cash drawer unless the
balance due is $0.00. Deselect this option to
allow a tender/media key to open the cash
drawer even if there is a balance due on the
transaction.
If the transaction’s subtotal is $0.00 and you
set 36 - Do Not Open Cash Drawer if
Subtotal is 0.00, the setting of option 23 is
irrelevant.
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Table 43-3    (Cont.) Cash Drawer Control Options

Option Description

33 - Employee ID Required With [No Sale]
Key

Select this option to prompt for the signed-on
workstation operator’s employee ID after
pressing the No Sale key. Deselect this option
to allow workstation operators to use the No
Sale key any time a privileged employee is
signed on.
This feature is used by staydown operators
(such as bartenders or sales clerks) who
typically walk away from the workstation,
and by prompting for employee ID,
mischievous persons cannot open the
drawer.

36 - Do Not Open Drawer if Subtotal is 0.00 Select this option to prevent the cash drawer
from opening for transactions in which the
subtotal is $0.00. Deselect this option to allow
the cash drawer to open whenever a
workstation operator uses a tender/media
key that is configured to open the drawer.

42 - Always Open Cash Drawer if Change
Due

Select this option to allow the cash drawer to
open when there are no tenders on the check
that should usually open the drawer. The
transaction must have change due, and the
current tender must not be configured to
open the drawer.
This option is typically used for Tender/
Media records such as gift certificates, where
change is issued only if the gift certificate
exceeds the value of the transaction (thus,
the drawer should be opened to issue
change), but the drawer remains closed
when the gift certificate does not exceed the
transaction’s total.

65 - Allow open of Cash Drawer on Service
Charge

Select this option to allow the cash drawer to
open for transactions where the service
charge has a value greater than $0.00, but
the subtotal is $0.00.
If you selected 36 - Do Not Open if Subtotal
is $0.00, you must also select this option to
allow the cash drawer to open for service
charge only guest checks.

The cash drawer will always open when using the OpsCheckCashDrawerEvent
Extensibility function. When the Extensibility function OpsCheckCashDrawerEvent
requests to open a cash drawer, the following cash drawer options are overridden:

• 23 - Open Drawer Only if Balance Due is 0.00

• 36 - Do Not Open Drawer if Subtotal is 0.00

• 42 - Always Open Cash Drawer if Change Due

• 65 - Allow open of Cash Drawer on Service Charge

13. Click Save.

14. Select the Enterprise, click Configuration, and then click Roles.
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15. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.

16. Select the appropriate options for cash drawer privileges.

Table 43-4    Cash Drawer Privilege Options

Option Description

17 - Authorize/Perform unassignment of
cash drawer from others

Select this option to allow employees in the
employee class to use the Unassign Cash
Drawer function key to unassign cash
drawers from other workstation operators.
Do not select this option for every employee;
set it only for management employee classes.
Setting this option allows workstation
operators in the employee class to use
function keys 839 - Assign Cash Drawer 1
and 840 - Assign Cash Drawer 2.

34 - Authorize Open Cash Drawer Using the
[No Sale] Key

Select this option to allow employees
associated with the role to open the cash
drawer outside of a transaction using the No
Sale key, and to authorize non-privileged
employees to do so.

88 - Authorize Cash Drawer Reconnection Select this option to allow employees
associated with the role to authorize a cash
drawer cable reconnection on a workstation.

17. Click Save.

Related Topics

• Cash Drawer Assignment and Unassignment

Coin Dispenser
A coin dispenser (sometimes called a coin changer) is a device attached to a workstation that
holds coins. A coin dispenser is not assigned to a workstation or server. When connected to a
workstation and configured, a cash tender sends commands to the coin dispenser to
dispense coins. The coin dispenser controls only the coin portion of a cash transaction. If the
customer presents $20.00 to pay a $16.45 guest check, the coin dispenser automatically
dispenses $0.55, but the workstation operator must give the remaining $3.00 to the customer.

The coin dispenser hardware varies the coins that are dispensed to avoid depleting a single
type of coin. For example, if the device dispenses $0.55 three times in a row, it is probable
that both of the following combinations dispense at least once:

• 1 Quarter and 3 Dimes

• 2 Quarters and 1 Nickel

Related Topics

• Configuring a Coin Dispenser

Configuring a Coin Dispenser
1. Select the property, click Setup, and then click Workstations.
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2. Double-click the workstation to open it in form view.

3. Click the Devices tab.

4. From the Peripheral Device Configuration section, click Add.

5. From the Select Peripheral Device Type drop-down list, select Coin Dispenser.

6. Enter the COM Port, and then click OK.

7. Click Save.

8. On the workstation, allow the configuration change to download to the POS client.

9. Connect the coin dispenser’s serial cable to the appropriate COM port.

10. Restart the workstation.

11. If the workstation is a Win32 client, modify the device settings for the COM port to
match the COM Port you set in Step 6.

Ensure that a workstation with an attached coin dispenser does not have a printer
or other device configured for the same COM port as the coin dispenser. Having
another device connected but not in use can cause problems with coin dispenser
operations.

12. Restart the workstation.

13. Verify that the coin dispenser is connected and ready for operation:

a. Sign on to the workstation as an employee with PMC privileges.

b. Launch PMC, and then click the Functions tab.

c. Click Device Diagnostics.

d. Click Dispense Change. The coin dispenser dispenses a penny when
successfully connected.

Related Topics

• Coin Dispenser

Magnetic Stripe Reader
Workstation operators scan magnetic stripe cards using a magnetic stripe reader
(MSR) attached to a workstation. Magnetic cards are commonly used as:

• Credit Cards

• Gift Cards

• Employee Identification Cards

Related Topics

• Configuring a Magnetic Stripe Reader

Installing the MSR Sleeve for Oracle MICROS Tablet E-
Series 8-Inch and 11-Inch Devices

The MSR sleeve for Oracle MICROS Tablet E-Series 8-inch and 11-inch devices
supports Transaction Vault Second Generation (TV2G) and data encryption.
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Before installing the MSR sleeve driver for Oracle MICROS Tablet E-Series devices, ensure
that the device has the following prerequisite requirements:

• Microsoft Windows 8.1 operating system

• Microsoft .NET Framework 4.0 or later

Contact Oracle Support to obtain the VeriFone E23x card reader driver before you begin the
following steps.

1. If a previous version of the driver exists, uninstall the old driver components before
installing the new driver.

a. From the Control Panel, select Programs and Features.

b. Uninstall the following components:

• E23x Driver Installer versions

• E23x OPOS DLL

• Microsoft POS for .NET 1.12

• OPOS Common Control Objects 1.13.001

2. Run the E23xDriverInstaller_1.2.0.exe file, and click Yes each time you are prompted.

3. Run the E23x_OPOS_DLL_Install_1.5.2.0.exe file, and click Yes each time you are
prompted.

The driver and OPOS DLL installation configures a default OPOS device name for the
magnetic stripe reader (MSR). Configure Simphony to use the exact name with the MSR.

Related Topics

• Configuring a Magnetic Stripe Reader

• Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices

Configuring a Magnetic Stripe Reader
1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation to be used with the MSR.

3. Click the Options tab, and then click the Display/Security subtab.

4. Select the appropriate MSR options.

Table 43-5    MSR Workstation Options

Option Description

12 - Mag Card Entry Required for Employee
ID

Select this option to allow all employee ID
entries at the workstation to be made by
swiping a magnetic employee ID card. The
workstation does not accept an employee ID
number entered through the keyboard or
touchscreen.

50 - Mag Card or Fingerprint Scan Required
for Employee ID

Select this option to allow all employee ID
entries at the workstation to be made using a
fingerprint scan or by swiping a magnetic
card. That is, employees must swipe a card or
scan a fingerprint.
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Table 43-5    (Cont.) MSR Workstation Options

Option Description

51 - Mag Card and Fingerprint Scan
Required for Employee ID

Select this option to allow all employee ID
entries at the workstation to be made using a
fingerprint scan and by swiping a magnetic
card. That is, employees must both swipe a
card and scan a fingerprint.

5. If you are using an encrypted MSR (for example, the MSR sleeve for Oracle
MICROS Tablet E-Series 8-inch and 11-inch devices with Transaction Vault
Second Generation (TV2G)), complete the following steps:

a. Click the Hardware/Cash Drawer subtab.

b. Select 55 - Enable Encrypted Magnetic Stripe Reader Support.

After you select this option, you cannot turn it off. Before setting this option,
ensure that the credit card processor or gateway supports encryption
functionality.

6. Click the Devices tab.

7. Click Add, and then select a magnetic stripe reader from the Select Peripheral
Device Type drop-down list.

8. Select the COM Port Settings (if necessary), and then click OK.

9. Click Save.

Related Topics

• Magnetic Stripe Reader

• Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8 and 11 Inch
Devices

Testing the MSR Sleeve for Oracle MICROS Tablet E-Series
8-Inch and 11-Inch Devices

You can test the MSR swiper functionality after you install the driver and configure the
MSR.

1. Copy the e23xservice.exe and e23xD.dll files to the [Drive Letter]:\Program
Files\Verifone\E23xOPOS folder.

2. Close the ServiceHost application.

3. Run e23xservice.exe.

4. In the OPOS MSR section of the dialog box, select the following options:

• Open

• Claim

• Enable

• D. Ev (Data Events)

After each successful swipe attempt, the D. Ev option is deselected.
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5. Swipe the magnetic card. If the card swipe was successful, a message appears with the
card data.

Related Topics

• Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch
Devices

• Configuring a Magnetic Stripe Reader

Barcode Reader Setup
A barcode is an optical machine-readable representation of data. Barcodes are used to
quickly order items. Workstation operators scan barcodes using barcode scanners attached
to workstations. When a barcode is scanned, the workstation software processes the data
and matches it with a menu item configured in the Simphony database.

The Barcodes module in the EMC lets you configure barcode menu item ordering. The
Barcodes module allows you to:

• Associate many different barcodes with the same menu item (for example, pricing
chewing gum items the same).

• Associate two different prices of one definition with different barcodes (for example, small
or large coffee).

• Use a maximum of 14-digit barcode.

Related Topics

• Configuring a Barcode Reader

Configuring a Barcode Reader
1. Select the Enterprise, property, or revenue center click Configuration, and then click

Barcodes.

2. Insert a barcode record.

3. In the Barcode column, enter the numeric value that the barcode represents.

4. Click the ellipsis point (...) button in the Master column, select the master menu item to
be ordered when the barcode is entered, and then click OK.

5. In the Definition column, select the Menu Item Definition (belonging to the selected
Menu Item Master) to be ordered when the barcode is entered. If you select 0 - All
Definitions, the workstation determines which definition to order at the time the barcode
is entered, based on active Menu Levels and other criteria.

This column is only active when you set the Menu Item Master column to a value other
than 0 - None.

6. In the Price # column, select the Menu Item Price (belonging to the selected Menu Item
Definition) to be ordered when the barcode is entered. If you select 0 - All Prices, the
workstation determines which price to order at the time the barcode is entered, based on
active Menu Levels and other criteria.

This column is only active when you set the Menu Item Definition column to a value other
than 0 - All Definitions.

7. In the Alternate Price column, enter the price to charge for the item when the barcode is
entered.
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This value is used only when you set a value greater than 0.00; if the value is 0.00,
the price from the Menu Item Price record is used.

8. In the Alternate Prep Cost column, enter the prep cost to use for the item when it
is ordered by the barcode.

This value is used only when you set a value greater than 0.00; if the value is 0.00,
the prep cost from the Menu Item Price record is used.

9. Click Save.

10. Select the Enterprise or property, click Setup, and then click Barcode Format
Sets.

11. Insert a barcode format set record, and then double-click it.

12. Click Add.

13. In the Input Length field, enter the number of digits in the scanned barcodes.

14. In the Returned Start field, enter the first digit to use in the numeric value to
return.

15. In the Returned Length field, enter the number of digits to read as the numeric
value to return.

16. Click Save.

17. Select the property, click Setup, and then click Workstations.

18. Double-click the workstation to be used with the barcode reader.

19. Click the Transactions tab.

20. Select the Barcode Format Set for the workstation to use.

The Barcode Format Set determines how the workstation reads barcodes of
various lengths.

21. Click the Devices tab.

22. Click Add, and then select the barcode reader from the Select Peripheral Device
Type drop-down list.

23. Select the COM Port Settings (if necessary), and then click OK.

24. Click Save.

Related Topics

• Barcode Reader Setup

Configuring the 1D/2D Imager Scanner
You can configure the 1D/2D Imager Scanner for use with the Oracle MICROS
Workstation 6 Series and Oracle MICROS Compact Workstation 310.

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation record to open it.

3. Click the Devices tab.

4. Click Add in the Peripheral Device Configuration section.

5. From the Select Peripheral Device Type drop-down list, select Generic Barcode
Reader.
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6. Under COM Port Settings, select the COM PORT.

The default COM Port setting is COM14.

To find the appropriate COM number, navigate to the workstation device manager and
locate the COM number associated with the workstation.

7. Click Save.

8. After configuration in EMC, update the workstation.

9. Following the update, shut down the workstation, and then connect the scanner.

The workstation should always be turned off when connecting or disconnecting a
scanner.

10. Restart the workstation.

11. Verify that the scanner is successfully initialized with the workstation.

Fingerprint Scanning
This section describes fingerprint scanning. Fingerprint scanning provides greater security by
verifying an employee’s identify. You can use an external USB fingerprint reader with the
following devices to scan fingerprints:

• Oracle MICROS Tablet E-Series

• Oracle MICROS Workstation 6 Series

• Oracle MICROS Workstation 5a

• Oracle MICROS PC Workstation 2015

• A PC running a Simphony client that is attached to the PC with a USB connection

You can require employees to scan fingerprints when performing the following operations:

• Signing in to a workstation

• Clocking in and out

• Authorizing privileged operations

Privileged employees can perform the following actions:

• Enroll themselves and other employees’ fingerprints in Simphony

• Register up to ten different fingers (in the event that employee digits become
incapacitated (cut, removed, or bandaged))

At registration, the employee places a finger on the fingerprint reader. The reader scans the
fingerprint and captures its characteristics (an array of pixels) as Fingerprint Image Data
(FID). The reader then extracts fingerprint features as Fingerprint Minutiae Data (FMD) and
creates a data record that is stored in database tables in the cloud and in the POS clients
where the employee signs in. At sign-in, the reader captures fingerprint data and then uses
FMD records to search the local database for a match. If a match is found, the action is
performed (such as sign-in). The system does not store pictures, photographs, or images of
the fingerprint. There is no way to reconstruct the fingerprint using the stored data.

Auditors can determine whether an employee performed an authorization using a fingerprint
reader, manual entry, or magnetic card swipe.

Simphony does not store the fingerprint image. Simphony uses only a mathematical
identification of the image. The data stored is similar to a hash of the fingerprint and cannot
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be used to reconstruct the fingerprint. Collecting or enrolling employee fingerprints is a
privileged operation, typically requiring manager authorization. The data is protected at
rest and in transit within the Simphony application using the same approaches that all
sensitive data is protected. When an employee is deleted from the system, the stored
fingerprint data for that employee is also deleted. This applies to all storage at the
enterprise and on premise. In current versions, the timing of when an employee is
deleted from the system is determined by when a privileged user manually deletes the
employee record in EMC.

Biometric data is stored in the Employee table for the Enterprise database, CAPS
database, and Datastore database. The following queries can be used to demonstrate
that no fingerprint data is present:

• To show the count of employees with any biometric data:

SELECT 
    count(*) AS "EMPLOYEES WITH BIOMETRIC DATA" 
FROM 
    EMPLOYEE 
WHERE 
    fingerprinttemplate1 IS NOT NULL or fingerprinttemplate2 IS NOT 
NULL or fingerprinttemplate3 IS NOT NULL or 
    fingerprintnewtemplate1 IS NOT NULL or fingerprintnewtemplate2 
IS NOT NULL or fingerprintnewtemplate3 IS NOT NULL;

• To show employee and fingerprint columns:

select FIRSTNAME, LASTNAME, FINGERPRINTTEMPLATE1, 
FINGERPRINTTEMPLATE2, FINGERPRINTTEMPLATE3, 
FINGERPRINTNEWTEMPLATE1, FINGERPRINTNEWTEMPLATE2, 
FINGERPRINTNEWTEMPLATE3 from EMPLOYEE;

Note:

– Neurotec templates are stored in FINGERPRINTTEMPLATE1,
FINGERPRINTTEMPLATE2, FINGERPRINTTEMPLATE3

– UrU templates are stored in FINGERPRINTNEWTEMPLATE1,
FINGERPRINTNEWTEMPLATE2, FINGERPRINTNEWTEMPLATE3

Related Topics

• Configuring Employee Privileges for the Fingerprint Reader

• Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal
Identification Number (PIN)

• Configuring the Workstation Employee Fingerprint Sign In Options

• Scanning a Fingerprint

Configuring Employee Privileges for the Fingerprint Reader
1. Select the Enterprise level, click Configuration, and then click Roles.
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2. Select the role type, click the Operations tab, and then click the PMC General/Reports
subtab.

3. To allow employees associated with the role to open the Property Management Console
(PMC) using function key 300, select 30001 - Run PMC.

4. Click the PMC Procedures subtab.

5. Select 30055 - Assign Employee Fingerprint Scan and 30052 - Assign Employee
PIN.

6. Click Save.

Related Topics

• Fingerprint Scanning

Configuring the Touchscreen Home or Sign In Page to Assign
Employee Personal Identification Number (PIN)

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the Home or Sign In page.

3. On the Edit tab, click Button.

4. On the General subtab, enter Assign PIN in the Legend field.

5. Select Function from the Type drop-down list.

6. Click the black arrow directly beneath the Type drop-down list, and then select Assign
Employee PIN.

7. Position and size the button on the page. Use the Style arrow to change the color.

8. Click Save.

Related Topics

• Fingerprint Scanning

Configuring the Workstation Employee Fingerprint Sign In
Options

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation to use with a fingerprint reader.

3. Click the Options tab.

4. Select the appropriate security options as described in the following table.

Table 43-6    Employee Security Options

Option Selecting This Option Requires That All
Employees …

47 - Fingerprint Scan Required for Employee
ID

Scan a fingerprint.
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Table 43-6    (Cont.) Employee Security Options

Option Selecting This Option Requires That All
Employees …

48 - Employee ID or Fingerprint Scan
Required for Employee ID

Scan a fingerprint or enter the employee ID
number.

49 - Employee ID and Fingerprint Scan
Required for Employee ID

Scan a fingerprint and enter the employee
ID number.

50 - Mag Card or Fingerprint Scan Required
for Employee ID

Scan a fingerprint or swipe an employee ID
card.

51 - Mag Card and Fingerprint Scan
Required for Employee ID

Scan a fingerprint and swipe an employee ID
card.

5. Click Save.

Related Topics

• Fingerprint Scanning

Scanning a Fingerprint
You can scan (also called enroll) a fingerprint using a workstation or from the EMC.

If you upgrade Simphony to version 2.9.1 or later, you must deploy the Biometrics 5.0
CAL package, and then re-enroll fingers with an Oracle MICROS or DigitalPersona
fingerprint reader. To re-enroll, attach an Oracle MICROS or DigitalPersona fingerprint
reader to the workstation, scan an already enrolled finger to sign on to the workstation,
and then click OK at the prompt to re-enroll.

Note:

Starting with the Simphony 19.2 release, a Delete Enrollment button has
been added and made available during the fingerprint enrollment procedure.
Prior to Simphony 19.2, the employee fingerprint data could only be removed
when an employees record was deleted from the EMC.

1. To scan (initially enroll) a fingerprint using a workstation:

a. Sign on to the workstation as an employee with the proper role privileges,
using an employee ID.

b. Click the PMC button, and then click the Functions tab.

c. Click the Edit Employee PIN function.

d. Select the employee whose fingerprints need to be scanned.

e. Click the Enroll Fingerprint button.

f. Follow the prompts to enroll up to three fingers for one employee. Click Yes at
the prompt to scan the same finger four times, or click No to return to the
Select Employee dialog.

g. Place the finger to scan on the fingerprint reader, and then remove it when the
scan is complete. Each finger is scanned four times. The scanner flashes
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while scanning and remains lit after the scan is complete. Repeat this step for each
finger.

2. To scan (initially enroll) a fingerprint using the EMC:

a. Select the Enterprise, property, or revenue center, click Configuration, and then click
Employee Maintenance.

b. Search for and select the employee record.

c. On the General subtab, click the Fingerprint Enrollment button.

d. Follow the prompts to enroll one or more fingerprints.

Related Topics

• Fingerprint Scanning

Configuring a Scale
A scale connects to the workstation and is used for menu items that are priced by weight (for
example, salad bar). You can configure Simphony to calculate weight in ounces, pounds, or
kilograms.

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation to open it in form view.

3. Click the Devices tab.

4. From the Peripheral Device Configuration section, click Add.

5. From the Select Peripheral Device Type drop-down list, select Scale (Serial).

6. Enter the COM Port to which the scale connects.

7. Select the following settings, and then click OK:

• Baud Rate: 9600

• Parity: E

• Data Bits: 7

• Stop Bits: 1

8. (Optional) If you are using an Oracle MICROS Tablet E-Series, click the Display/
Security subtab, and then deselect 39 - Floating tablet.

9. Click Save.

10. On the workstation, allow the configuration change to download to the POS client.

11. Connect the scale’s serial cable to the workstation’s serial COM port.

12. Connect the scale’s power cord to the outlet.

13. Restart the workstation.

14. Verify that the scale is connected and ready for operation:

a. Sign on to the workstation as an employee with PMC privileges.

b. Launch PMC, and then click the Functions tab.

c. Click Device Diagnostics.

d. Click Get Scale Weight.
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e. Place a weighed menu item on the scale and add the menu item to a guest
check.

Related Topics

• Weighed Menu Items

• Configuring a Weighed Menu Item

• Setting the Tare Weight for a Menu Item

Sales Recording Module (SRM)
An SRM is a microcomputer designed to be connected to a cash register or POS
system. It records transaction information such as sales and tax data in a secure
memory. After data transmission begins, the SRM device sends the necessary
information to a printer which prints a customer receipt with a barcode and information
about the restaurant. The SRM is used to produce reports such as a Periodic Sales
Summary Report which contains information on sales and transactions carried out
over a given period.

Restaurant owners who are also a Quebec Sales Tax (QST) registrant must produce
customer receipts using an SRM device and submit a receipt to the customer upon
sale of a meal.

Related Topics

• Enabling SRM for a Property

• Configuring SRM Payment Types for Tenders

• Enabling SRM for Printers

• Configuring the Quebec SRM Control Button

• Allowing Employees to Enable and Disable SRM from the Workstation

Enabling SRM for a Property
1. Select the property, click Setup, and then click Property Parameters.

2. On the Options tab, select 38 - Enable Sales Recording Module, and then click
Save.

Related Topics

• Sales Recording Module (SRM)

Configuring SRM Payment Types for Tenders
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and

then click Tender/Media.

2. Double-click a Tender Media record to open it.

3. On the General tab, select the appropriate SRM Payment Type for the tender.

The SRM payment types are:

• 1 - ARG: Select this option for cash payments.

• 2 - CRE: Select this option for credit card payments.
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• 3 - DEB: Select this option for Canadian debit card payments.

• 4 - AUT: Select this option for other payment types such as gift cards.

• 5 - PKG: Select this option for full payments where the check value posts to a third
party system.

4. If you selected SRM payment type 5 - PKG, click the Options tab, click the Taxing
Options subtab, and then click Select All to exempt all taxes from the tender.

If you do not exempt all taxes, they will post both to the SRM as well the third-party
application, resulting in duplicate tax entries.

5. Click the Options tab, click the Printing Options subtab, and then select the following
options:

• 8 - Print Customer Receipt

• 21 - Print Summary Totals

• 22 - Print Check Trailer

• 23 - Print Check on Demand

• 28 - Print Guest Check Trailer on Fast Transaction Customer Receipt

6. To have the tender print a special/duplicate receipt for the merchant, click the
Miscellaneous Options subtab, and then select 84 - Quebec SRM Duplicate.

The printed receipt does not include a barcode. This option is used with the Quebec SRM
Printer type.

When option 84 is enabled for the assigned Default Reprint Check Tender/Media, the
system does not print barcodes on receipts for split checks.

7. Click Save.

8. Repeat Steps 2 through 7 for all tenders that you have configured.

Related Topics

• Sales Recording Module (SRM)

Enabling SRM for Printers
1. Select the property, click Setup, and then click Printers.

2. Double-click the record for a printer that has an SRM device attached, select Quebec
SRM Device, and then click Save.

3. Repeat Step 2 for all printers that have an SRM device.

Related Topics

• Sales Recording Module (SRM)

Configuring the Quebec SRM Control Button
You can configure a touchscreen button to allow workstation operators to enable and disable
the SRM device locally through the POS client.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Double-click the page on which you want the button to appear on the workstation.
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3. Insert a new button.

4. On the General tab, select Function as the Type, and then click the right arrow
directly beneath the Type drop-down menu.

5. Select Fiscal from the Type pane, select Quebec SRM Control from the Results
pane, and then click OK.

6. Enter a Legend, and click Save.

Related Topics

• Sales Recording Module (SRM)

Allowing Employees to Enable and Disable SRM from the
Workstation

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type record (for example, administrator, manager or server).

3. Click the Operations tab, click the Miscellaneous sub-tab, scroll down to
Miscellaneous Options , and then select 162 - Authorize/Use Quebec SRM
Control Function.

4. Click Save.

Related Topics

• Sales Recording Module (SRM)
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44
Reporting

Various Simphony reports are accessible from Oracle Hospitality Reporting and Analytics,
and at the workstation. Reporting and Analytics reports provide access to Enterprise,
property, zone, and revenue center information. Workstation reports provide access to
property and revenue center totals. You can assign privileges to allow employees to run
reports.

Allowing Employees to Run Reports
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the PMC General/Reports
sub-tab.

3. Select 30001 - Run PMC to allow employees associated with the role to launch the
Property Management Console (PMC) on the workstation using Function Key 300,
Launch PMC.

4. Click the Ad Hoc Reports tab.

5. From the Report Options section, select the reports you want employees to run.

6. Click Save.

Related Topics

• List of Workstation PMC Reports

List of Workstation PMC Reports
Authorized employees can run the following Property Management Console (PMC) reports
when the workstation is in online mode:

Table 44-1    PMC Reports in Online Mode

Report Description

Financial Report Provides financial reporting for a property,
revenue center, or employee.
The Employee Financial Report is based on all
sales-related entries, such as checks opened,
menu items ordered, and the number and
amount of service charges, discounts, and
tenders applied. You can use this report to
balance the server’s bank, and to track
individual performance.

Employee Open Check Report Provides a list of all open checks belonging to
an employee at the time the report is taken.
Checks appear in the following order:
employee, property or revenue center, and
event.
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Table 44-1    (Cont.) PMC Reports in Online Mode

Report Description

Employee Closed Check Report Provides a list of all checks that have been
closed by an employee, including reopened
checks that were closed again and checks
closed as memo checks. In addition, special
symbols on the report indicate whether the
check was transferred, re-opened, split, or
added. Checks appear in the following order:
employee, property or revenue center, and
event.
Closed Check Report Codes contains more
information on the status indicator codes for
Closed Check Reports.

Employee Tip Report Provides a list of tippable sales in the form of
gross receipts from Food and Beverage, charge
tips, service charges, tips paid, direct and
indirect tip declaration, and percent of tips to
sales.

Employee Labor Detail Report Provides an account of work performed by
each employee. The report includes the dates,
times, and job rates of each clock-in and clock-
out, the total hours of regular and overtime
worked at each job code, and the gross pay
earned.

Employee Labor Summary Report Provides a summary of the regular and
overtime hours worked by each employee at
each of their assigned pay rates.

Cashier Financial Report Provides financial information for each
cashier, including tenders and tips paid.

Major Group Sales Report Provides sales totals for each major group.

Family Group Sales Report Provides sales totals for each family group.

Menu Item Summary Report Provides a list of all menu items.

Menu Item Sales Report Provides sales totals for each menu item.

Time Period Detail Report Shows each time period as a full report, with a
similar format to a system financial report
(sales, check profiles, tracking group).

Time Period Summary Report Lists each time period with sales information.

Serving Period Financial Report Provides financial reporting by serving period.

Table Sales Report Provides sales totals for each table.

Clock-in Status Report Provides a list of employees who are currently
clocked in or on a break.

Labor Availability Report Provides a count of all employees clocked in or
on break as of the time the report is taken.

Job Code Report Summarizes all employee labor totals by job
code.
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Table 44-1    (Cont.) PMC Reports in Online Mode

Report Description

Employee Autofire Open Check Report Provides a list of all checks that are scheduled
for autofire at the time the report is run.
Checks appear by employee, property or
revenue center, and event, and sorted by
scheduled date and time.

Employee Journal Report Provides a journal of all sales transactions by a
specific employee shown in a check detail
area.

Check Journal Report Provides a journal of all sales transactions in a
check detail area.

Tax Summary Report Provides a list of tax rates.

Authorized employees can run the following Property Management Console (PMC) reports
when the workstation is in offline mode:

Table 44-2    PMC Reports in Offline Mode

Report Description

Offline Revenue Center Financial Report
Offline Employee Financial Report

Provides financial reporting for a revenue
center or employee.
The Employee Financial Report is based on all
sales-related entries, such as checks opened,
menu items ordered, and the number and
amount of service charges, discounts, and
tenders applied. You can use this report to
balance the server’s bank, and to track
individual performance.

Offline Cashier Financial Report Provides financial information for each
cashier, including tenders and tips paid.

Offline Employee Open Check Report Provides a list of all open checks belonging to
an employee at the time the report is taken.
Checks appear in the following order:
employee, revenue center, and event.
Unlike the online version of this report, the
offline version functions only for a revenue
center; it is not possible to take a report for the
property.

Related Topics

• Allowing Employees to Run Reports

• Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics

• Configuring the Log Files for Oracle Hospitality Reporting and Analytics
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Closed Check Report Codes
The Status Indicator field prints to the left of the check number and indicates how the
check was closed. Several entries can apply to the same check, and they are printed
in a string. The following table lists and describes the Status Indicators for Closed
Check Report Codes.

Table 44-3    Status Indicator Codes for Closed Check Report

Code Name Description

A Add The detail from this check
was added to another check.

a Add The detail from this check
was received from another
check.

C Canceled The check was re-opened
and immediately closed,
using the Transaction
Cancel key.

f Fast Transaction The check was created
during a fast transaction.

j Adjusted The check was re-opened
with the Adjust Closed
Check key, and the tender
or tip was adjusted.

R Re-opened This is the original check
that was re-opened with the
Reopen Closed Check key.

r Re-opened This is the check that was
created when re-opening a
check.

S Split This is the original check
before it was split.

s Split This is the check that was
created when splitting a
check.

T Training This check was opened and
closed by a workstation
operator who was in
training mode.

X Transferred from check The detail from this check
was added to another check,
which is in a different
revenue center. This symbol
appears only if the transfer
was between revenue
centers.

x Transferred to check The detail from this check
was received from another
check in a different revenue
center.
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Table 44-3    (Cont.) Status Indicator Codes for Closed Check Report

Code Name Description

! Open on system This check was accessed
while it was open on the
system.

O Offline This check was created
offline.

B Batched This check was batched.

Configuring Employee Privileges for Oracle Hospitality
Reporting and Analytics

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Employee Maintenance.

2. Search for the employee record.

3. Click the Employee Records tab near the lower area of the screen, and then double-
click the object number of the appropriate record.

4. Click the Reporting tab to configure an employee’s settings as they pertain to logging in
to Reporting and Analytics.

Note:

If you install or upgrade to Enterprise Back Office version 20.1 (which includes
Reporting and Analytics and MyLabor) in conjunction with installing or
upgrading Simphony to either 19.1.2 or 19.2, the Simphony EMC's Employee
Maintenance, Reporting tab is now disabled (or has been removed). Going
forward, new reporting users need to be added and configured in R&A.
Reporting access passwords are no longer synchronized between Simphony
and R&A.
If you still utilize Enterprise Back Office version 9.1, the Simphony EMC's
Employee Maintenance, Reporting tab is still accessible and configurable as
usual.

5. To grant the employee an active account in the Reporting and Analytics database, select
Active.

6. To make the employee a default user for all Reporting and Analytics employee records
associated with the same role, select Default User. This allows new employees in
Reporting and Analytics who share the same role to use the same settings as this
employee.

7. From the Role drop-down list, select Workstation Report.

8. Click Save.

For users of R&A prior to the 20.1 release, the Oracle Hospitality Reporting and Analytics
User Guide, located at https://docs.oracle.com/cd/E80526_01/doc.91/e82050/toc.htm,
contains information about enabling reports in Reporting and Analytics.

Chapter 44
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For users of R&A version 20.1, see the Enterprise Back Office 20.1 documentation,
specifically the Add users content contained there, for more information about adding
user portals to R&A.

Related Topics

• List of Workstation PMC Reports

Configuring the Log Files for Oracle Hospitality Reporting
and Analytics

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the mymicros.net tab, and then enter the appropriate information. The
following table describes the fields.

Table 44-4    Reporting and Analytics Settings

Field Description

Logs to Keep Enter the number of Data Transfer
Service (DTS) logs to retain.

Error Files to Keep (days Enter the number of days the application
retains error file logs.

Verbosity Select the Verbosity level for DTS logging.
You should typically set this value to
Normal. Set verbose logging to
Extended or Super for troubleshooting
as these elevated levels create large log
files and slow performance.

mymicros.net Machine Name Enter the name of the Reporting and
Analytics server computer using the
format http://
[YourReportingAndAnalyticsUrl].

Enterprise mylabor URL If DTS uses a different Internet Protocol
(IP) address to connect to Oracle
Hospitality Labor Management, enter the
URL. Use the format http://[Name or IP
address of the Reporting and Analytics
portal server].
If you leave this field blank, DTS uses the
Reporting and Analytics machine name
to post Labor Management. Workstations
do not use this URL.

Organization ID Do not change this value unless
instructed by your Oracle representative.
This field represents the Enterprise
organization ID used for reporting to
Oracle Hospitality Reporting and
Analytics.
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Table 44-4    (Cont.) Reporting and Analytics Settings

Field Description

17 - Send selected translations to
Simphony Reports

Select this option to send definition
translations to Simphony reports. You
must also select the Send Translations
for this Language to Simphony Reports
option from the Language module for
each language to be sent to Simphony
reports.

3. Click Save.

The Oracle Hospitality Reporting and Analytics User Guide, located at http://
docs.oracle.com/en/industries/hospitality/, contains information about enabling reports in
Reporting and Analytics.

Related Topics

• List of Workstation PMC Reports

Viewing Move History Logs
Database administrators can use the EMC to verify Reporting and Analytics Daily
Aggregation and to review the Move History logs of the database. The self-service access to
information in EMC eliminates the need to consult the Oracle Hospitality Simphony Data
Transfer Service (DTS) log on the application server. Daily Aggregation is logged for each
property and each business date.

This feature is compatible with Reporting and Analytics version 9.0 Patch 8 and later.

1. Select the Enterprise level, click Configuration, and then click PC Autosequences.

2. Double-click the Reporting and Analytics Daily Aggregation record to open it.

3. Click the Execution History tab, and then click Get History. The list of all Move History
Logs appears.

The Move History logs of the database are listed by date, along with details such as ID,
Insert Date, Start Date, Finish Date, Property, and Complete Code (status). If the
Complete Code shows Failed, the Reprocess button becomes active for a specific
property and business date. You can click the Reprocess button to set a flag for the DTS
to update the Reporting and Analytics Aggregation Service to process the record again.

4. To limit the information shown, select the Property, and the Date Range, and then click
the Filter button.

The maximum date range is 7 days. If you do not select a date at the beginning (default
state), the system shows only yesterday and today’s dates.

5. Highlight a record in the Execution History section, and then click Show Details. The
Execution Detail section shows the date and time that the autosequence started and
stopped and additional messages, such as property, location, and status (success or
error).

6. Click Save.
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Configuring Data Retention Limits
Database administrators can set the length of time data (for example, ECM and
Reporting and Analytics aggregation) remains present in the database at the
Enterprise and property levels.

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the Miscellaneous tab.

3. To set data retention limits, in the Purging section, enter the Days To Keep for the
Purge Type.

This is the number of days from the time a transaction is reported to the enterprise
that the application retains it for use in reporting and auditing (for example, from 1
day to 999 days). After the number of days to keep expires, a scheduled event
purges the data. By default, the purging jobs purge 1000 records per batch.

• To set ECM data retention, enter the number of days for ECM Transaction
Detail.

• To change the PC Autosequences data retention, enter the number of days for
the Pcasequence Log.

Oracle recommends that you leave the default value set at 90 days, and that a
subject matter expert change this setting if necessary. The Pcasequence Log
Purge Type is available in Simphony version 2.10 and later and is compatible
with Reporting and Analytics version 9.0 Patch 8 and later.

4. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels
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45
Auditing

You can use the Audit Trail module to view additions, changes, and deletions made through
the EMC and through PMC Procedures. In addition, the Audit Trail reports on successful and
failed logins to EMC, PMC Report takers, Key Manager activity, and Audit Trail purges.

In almost every module, you can audit an individual record or a group of similar records. The
results usually show the record or records at a specific position. For example, consider the
following actions:

1. Add a Tender Media record at Object Number 1234.

2. Change the record’s name to Cash.

3. Delete the record.

4. Add a new record at Object Number 1234.

5. Change the record’s name to MasterCard.

After performing these steps, the Audit This Record results show all five of the changes (not
just the changes for steps 4 and 5). Although the first Tender Media record was deleted, it is
considered “this record” for functional purposes. In short, all records at the same object
number are treated as “this record” and are included in the results.

Related Topics

• Using the Audit Trail

• Using Audit This Record

Using the Audit Trail
You must have the privilege to access the audit trial at the Enterprise or property level. When
an Audit Trail report is taken, the activity is logged to the Audit Trail. All Audit Trail Reports
taken are logged as an Enterprise level activity. You can use the Audit Trail two different
ways: to view the history of a specific record or to perform a general search throughout the
entire system.

1. Select the Enterprise or property, click Tasks, and then click Audit Trail.

2. To perform a quick search on the Search tab:

a. Select the timeframe from the All Changes In drop-down list.

b. Click the Run Quick Search button.

When you perform a quick search, the application ignores the values in the standard
search fields.

3. To perform a standard search, enter or select information in the following fields, and then
click the Search button.
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Table 45-1    Audit Trail Standard Search Fields

Field Description

Application Select an application from the drop-
down list.
Depending on your selection, the Module
drop-down list is active or dimmed. For
example, when you select EMC, the
Module drop-down list shows a list of
EMC modules.

Module Select a module from the drop-down list.
This field is active only when the
Application selection allows a choice of
modules.
Depending on your selection, the Object
Numbers field is active or dimmed. For
example, when you select EMC from the
Application drop-down list and
Discounts from the Module drop-down
list, the Object Numbers field becomes
active.

(Optional) Object Numbers Enter an object number or range to
retrieve results based on specific records
only. Leave this field blank to have the
Audit Trail find all object numbers.

Operation Select an operation from the drop-down
list.
This field is active based on a
combination of the Application and
Module selections.

Zone/Location Select a zone or location.
When you open the Audit Trail from the
Enterprise level, this field allows a
selection of any property, zone, or
revenue centers. When you open the
Audit Trail from the property level, this
field allows a selection of revenue
centers within the property.

Employee Click the Select link, select an employee,
and then click OK. When you select a
specific employee, only changes made by
that employee are included in the results.
Click the Me link to include only the
logged-in employee.

Date Range Select the date range to use to query the
Audit Trail.
Select User-Defined to activate the Start
and End fields.

(Optional) Start and End To narrow your query to a specific date
or date range, select the start and end
dates and times.
Select All Dates to include all dates in
the query.
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Table 45-1    (Cont.) Audit Trail Standard Search Fields

Field Description

(Optional) Old/New Values Enter text for use in the query. This can
be useful in finding a specific change to a
record, such as when a Hamburger item
was renamed to Cheeseburger.

Preserve Previous Results Select this option to merge the search
results with the previous search results,
instead of overwriting them. Deselect
this option to see only the results of the
most recent search.

4. If the number of results that will be returned exceeds the pre-set thresholds for Audit Trail
results (for example, 10,000 records or more), the application prompts you to confirm the
action.

5. To view the search results for a quick search or a standard search, click the Results tab.

a. To save the results, click the Save to Disk button, select the directory, and then click
the Save button.

b. To copy the results into another application (such as Notepad or email) without
storing the information, click the Formatted Results button, and then click the Copy
button.

6. To manually remove old records from the Audit Trail table in the database, click the
Purge tab.

The Purge tab is visible only at the Enterprise level, and you must have the Purge Audit
Trail privilege.

7. Select the date before which the records will be purged, and then click the Purge button.
For example, if you select 9/1/2016, the application deletes all records from September 1,
2016 and earlier.

Records are deleted based on the UTC date of the Audit Trail record.

In addition to this manually initiated purge, the Data Transfer Service (DTS) purges Audit
Trail records automatically.

Related Topics

• Auditing

Using Audit This Record
1. Select the Enterprise or property, and then open a module that contains at least one

record.

2. Highlight one or more records, right-click inside the first column, and then select either
Audit This Record (single record) or Audit Selected Records (multiple records). The
Audit Record tab shows the information for the selected records.

Alternatively, from the EMC toolbar, click Edit, and then select Audit This Record.

3. To run specific queries on the selected record or records, click the Show Advanced
Options link.

4. Use the same search parameters that are available in the Audit Trail module. See Using
the Audit Trail for more information.
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Related Topics

• Auditing
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46
Importing and Exporting Data

The Simphony Import/Export Service allows you to:

• Import and export Simphony application data in a comma-separated values (CSV)
format, to or from spreadsheet applications

• Import configuration data into the Simphony application database that can be called by
external systems, such as a web service application programming interface (API)

• Export configuration data from Simphony that can be called by external systems, such as
an on premise inventory management application

The main benefits of this service are:

• Allows you to load configuration data in bulk (for example, making a large number of
price changes for menu items, which reduces the amount of time it takes to configure
systems)

• Allows third parties to integrate with customer databases (either self-hosted or hosted
within an Oracle facility), without providing direct access to the application file server or
database

• Allows third parties to build custom interfaces

See the MICROS Simphony Manager User Guide for more information about importing and
exporting data.

Configuring the Import/Export Service Privileges
You need to configure privileges to allow the appropriate employees to view and access the
Simphony Import/Export service from the Simphony Web Portal (SWP).

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role, and then click the EMC Modules tab.

3. Scroll down to the Import/Export setting located within the File column under the
Enterprise Modules section. The View setting controls the visibility of the Import/Export
service on the SWP toolbar for staff assigned this role.

4. To enable visibility of the Import/Export service from the SWP, select the View checkbox
and Save.

5. To hide the Import/Export service from the SWP, leave the View checkbox unselected.
This is the default setting.
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Figure 46-1    Role Configuration for Import/Export Access

Related Topics

• Import/Export Service Components

Configuring the Import/Export Service
Before configuring the Import/Export Service, you must have the appropriate EMC
Enterprise privileges assigned to you.

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the Import/Export tab.

3. Enter the appropriate values in the fields. The following table describes the
settings that you can configure for the Import/Export service.

Table 46-1    Import/Export Service Settings

Field Description

Root Path for Export/Import
File Operations

If you are using Simphony version 2.9.1 or later,
this field is disabled. Do not enter information in
this field.

Max No. of Records to Commit
Per Batch

Enter the maximum number of records to commit
per batch when importing. You can enter a value
from 1000 through 20000.
If you change the default value, restart the Oracle
Hospitality Simphony Data Request Processing
Service for the changes to take effect.

Import/Export API URL If you are using an API, enter the IP address of the
import/export API.

Simphony APP URL Enter the IP address for the Simphony Web Portal:
https://[ServerName]/SimphonyApp.

Default Date Time Format Select the date and time format to use when
processing import and export requests.

4. Click Save.
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Related Topics

• Import/Export Service Components

Configuring Task Schedules for Export Reliability
When upgrading Simphony, the Dbupgrade automatically creates two tasks for Export
Reliability: one for Workstation (WS) and one for Check and Posting (C&P), but only if these
tasks have never existed. The tasks are called ‘Daily WS Export Reliability with recurrence’
and ‘Daily C&P Export Reliability with recurrence’. Default values are used for these tasks.

New organizations created after the upgrade require task schedules to be created manually.
Schedules of an existing organization can be used as a template.

1. Select the Enterprise level, click Configuration, and then click Task Schedules.

2. Insert a new record for one of the following data export reliability tasks:

• Daily WS Export Reliability with recurrence

• Daily C&P Export Reliability with recurrence

3. Double-click the record to open it.

4. On the General tab, in the Service Type drop-down list, select one of the following,
depending on the export reliability task created in Step 2:

• 7 - Workstation: Select this option for Daily WS Export Reliability with recurrence.

• 8 - Check and Posting: Select this option for Daily C&P Export Reliability with
recurrence.

5. Select 7 - Export Reliability as the Task Type.

6. The Task Data field must be blank. Changing important details of the scheduler (such as
Task Data), results in the scheduler not running.

7. In the Duration (seconds) field, enter 120 seconds. This is the amount of time needed
for the task to run.

8. Click the Select link adjacent to the Time Zone field. Select the correct time zone from
the list, and then click OK.

9. In the Schedule Type drop-down list, select the frequency to run the export reliability
tasks as 4 - Recurring - Daily:

10. In the Duration section, click the Enabled check box, select a Start date of 1/1/2000 and
select No end date.

11. Click the Recurrence tab.

12. In the Daily Frequency section, select Occurs every, and enter:

• 45 minutes starting at 00:05 and ending at 23:10 for the Workstation task.

• 60 minutes starting at 00:15 and ending at 23:20 for the Check and Posting task.

13. Click Save.

14. Repeat Steps 1 through 13 to create the other Data Export Reliability task schedule.
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Increasing the Import File Size
Complete these steps if the Enterprise requires you to import files larger than the
default 4MB size.

1. Browse to [Drive Letter]:\MICROS\Simphony2\SimphonyImportExport\WebApp\
and open the Web.config file.

2. Add the following line within a comment:

<httpRuntime targetFramework="4.5" />
3. Uncomment the following line:

<httpRuntime targetFramework="4.5" executionTimeout="240"
maxRequestLength="10243"/>

4. Enter the maximum import file size for the maxRequestLength parameter in
Kilobits. By default, this value is set to 10 MB.

5. Save the changes.

Related Topics

• Import/Export Service Components

Import/Export Service Components
The Simphony Import/Export Service is comprised of four components, plus a
Microsoft Windows service. The following table lists the components and their
capabilities.

Table 46-2    Simphony Data Import/Export Service Components

Component Functionality

EGateway URL Provides access to the Simphony configuration
for self-hosted and Enterprise hosting center
environments.

Web Service (REST API) Assists developers with programmatic
integration and the development of third-party
application programming interfaces (API).

Web Service (SOAP API) The SOAP API has the same functionality as the
REST API, except this web service is constructed
using the SOAP format rather than the REST
format.
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Table 46-2    (Cont.) Simphony Data Import/Export Service Components

Component Functionality

Simphony Web Portal (SWP) This web application enables you to:
• Import and export data manually
• Download and store data securely in a

database
• Export data automatically using the

scheduler
• Review the status of completed import and

export jobs
• Access a Help page that provides additional

database and API details
The SWP is available for all users with Simphony
EMC logon credentials.

Oracle Hospitality Simphony Data
Request Processing Service (Microsoft
Windows Service)

This Microsoft Windows service runs as part of
throttling and scheduling processes (rather than
on demand servicing requests).

Related Topics

• Configuring the Import/Export Service Privileges

• Configuring the Import/Export Service

• Increasing the Import File Size
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47
Loyalty and Gift Card Interfaces and Drivers

Oracle Hospitality Gift and Loyalty is a customer relationship management (CRM) application
that allows properties to manage point-based loyalty card programs and stored value cards
(SVC) (also known as gift cards). Gift and Loyalty tracks customer activities (such as
frequency of visits, spending, and loyalty account balance) and reports the information
through Simphony’s enterprise reporting module. Simphony then sends this information to
Gift and Loyalty.

The following table lists common types of loyalty programs:

Table 47-1    Types of Loyalty Programs

Loyalty Program Description

Points earned per transaction or per
visit

An award given for X number of visits. The award could
be a discount, coupon for future visit, or stored value
added to the loyalty account for later redemption.

Points earned per dollar spent An award given for X dollars spent. The award could be
a discount, coupon for future visit, or stored value
added to the loyalty account for later redemption.

Discount card Each time the workstation operator swipes a card, the
check receives an automatic discount. Restaurants
typically use discount cards to control employee meal
discounts.

Category club card The customer earns points when ordering a specific
type of menu item (for example, burgers).

A stored value program allows a guest to establish a prepaid account to use for purchases at
a property. The prepaid payment vehicle is a stored value card with an associated monetary
value. A gift card is an example of a stored value card containing a prepaid amount.

The Valutec command module plug-in is a custom loyalty and gift card host adapter that
communicates between Simphony and the Valutec host. This command module incorporates
the web service API provided by Valutec.

The Valutec command module plug-in is available starting with Simphony release 19.2.1.
Valutec loyalty is not supported with devices running the Android mobile operating system.

Loyalty and Stored Value Configuration Prerequisites
Simphony supports the Gift and Loyalty drivers only on Microsoft Windows CE and Microsoft
Windows 32-bit operating systems.

Complete the following tasks before configuring the Loyalty and Stored Value Interfaces and
Drivers:

1. Install the latest Simphony release at the property.

2. Obtain access to the EMC within Simphony.
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3. Configure unique Tender/Media and Discount records for loyalty transactions. Take
note of the record number and type as you need the values to post transactions for
Oracle Hospitality Reporting and Analytics and third-party loyalty applications.

Reporting and Analytics and third-party loyalty applications use the configured
Simphony Tender/Media and Discount records to post loyalty transactions to the
guest check.

4. (Optional) If the property is using the XProcessor Extension Application for Gift
and Loyalty, configure the Gift and Loyalty interface and XProcessor Extension
Application at the Enterprise level. Deploy each interface only to the correct
locations and clients. After you upgrade the appropriate clients to the latest
Simphony release, see XProcessor Extension Application Migration for
instructions.

a. Leave the XProcessor installed at the Enterprise level until all clients have
been upgraded to the latest Simphony release and are using the Gift and
Loyalty interface.

b. Retrieve the data extension overrides for each property (such as URL, userid,
user_password, and timeout_seconds). Take note of these settings as you
need this information to create the integrated Gift and Loyalty interface.

c. Take note of the current functions the site uses through XProcessor. You need
this information to create buttons for the Gift and Loyalty interface.

5. (Optional) If a third party developed a driver, use the driver configuration settings
provided by the third party. Third-party drivers may have unique fields.

Related Topics

• Loyalty Configuration Tasks

Configuring Valutec Installation Files
1. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers\Text.

2. Edit VTLoyaltyCommandModule.dll.config and
VTStoredValueCommandModule.dll.config using a source code editor (for
example, Notepad++).

3. Change the <value> tag to the URL of the live Valutec production web service.

The following figure shows an example of the URL that you need to update.

Figure 47-1    Editing Valutec .config Files

4. Save your changes and close the VTLoyaltyCommandModule.dll.config and
VTStoredValueCommandModule.dll.config files.
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Loyalty Configuration Tasks
Complete the following tasks to set up the loyalty interface:

• Complete the configuration prerequisites

• Configure loyalty privileges

• Set loyalty options

• Configure the Loyalty driver

• Configure the Loyalty module

• Create Front of House loyalty buttons

• Allow workstation operators to void loyalty points issued on re-opened checks

• (If applicable) Migrate the XProcessor Extension Application

Related Topics

• Loyalty and Stored Value Configuration Prerequisites

• Configuring Loyalty and Stored Value Privileges

• Setting Loyalty Options

• Configuring the Loyalty Driver

• Configuring the Loyalty Module

• Creating Loyalty and Stored Value Buttons

• Voiding Points on a Re-opened Check

• XProcessor Extension Application Migration

Configuring Loyalty and Stored Value Privileges
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Stored Value Cards
subtab.

3. Select the appropriate options for the privileges. The following table summarizes the
privileges associated with Loyalty and Stored Value functionality.

Table 47-2    Loyalty and Stored Value Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Issue Functions 104 Authorize/Perform Issue
Stored Value Function

Issue a stored value card

Issue Functions 105 Authorize/Perform Void
Issue Stored Value Entry

Void an issued card

Issue Functions 106 Authorize/Perform Issue
Stored Value Batch
Function

Issue a batch of stored
value cards
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Table 47-2    (Cont.) Loyalty and Stored Value Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Issue Functions 107 Authorize/Perform Void
Issue Stored Value Batch
Entry

Void a batch of stored
value cards

Issue Functions 108 Authorize/Perform
Activate Stored Value
Function

Activate a stored value
card

Issue Functions 109 Authorize/Perform Void
Activate Stored Value
Entry

Void the activation of a
stored value card

Issue Functions 110 Authorize/Perform
Activate Stored Value
Batch Function

Activate a batch of
stored value cards

Issue Functions 111 Authorize/Perform Void
Activate Stored Value
Batch Entry

Void the activation of a
batch of stored value
cards

Reload and
Redeem Functions

112 Authorize/Perform
Reload Stored Value
Function

Reload (add credit) a
dollar amount to an
existing stored value
card

Reload and
Redeem Functions

113 Authorize/Perform Void
Reload Stored Value
Entry

Void a reload transaction

Reload and
Redeem Functions

114 Authorize/Perform
Redeem Authorization
Stored Value Function

Perform a redemption
authorization

Reload and
Redeem Functions

115 Authorize/Perform Void
Redeem Authorization
Stored Value Entry

Void a redemption
authorization

Reload and
Redeem Functions

116 Authorize/Perform
Redeem Stored Value
Function

Perform a redemption
transaction (a customer
makes a purchase using
a stored value card, and
the application deducts a
dollar amount from the
customer’s account)

Reload and
Redeem Functions

117 Authorize/Perform Void
Redeem Stored Value
Entry

Void a redemption
transaction

Reload and
Redeem Functions

118 Authorize/Perform
Manual Redemption
Stored Value Function

Perform a manual
redemption

Reload and
Redeem Functions

119 Authorize/Perform Void
Manual Redemption
Stored Value Entry

Void a manual
redemption transaction

Point Functions 120 Authorize/Perform Issue
Stored Value Points
Function

Issue points to a stored
value card
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Table 47-2    (Cont.) Loyalty and Stored Value Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Point Functions 121 Authorize/Perform Void
Issue Stored Value
Points Entry

Void the issued points on
a stored value card

Point Functions 122 Authorize/Perform
Redeem Stored Value
Points Function

Perform a points
redemption transaction

Point Functions 123 Authorize/Perform Void
Redeem Stored Value
Points Entry

Void a points
redemption transaction

Other Stored Value
Card Options

103 Authorize/Perform
Manual Entry of Stored
Value Card Number

Manually enter the
stored value card
account number

Other Stored Value
Card Options

124 Authorize/Perform
Stored Value Cash Out
Function

Debit some or all of the
remaining balance on a
stored value card

Other Stored Value
Card Options

179 Authorize/Perform Void
Stored Value Cash Out
Function

Void a cash out
transaction

Other Stored Value
Card Options

125 Authorize/Perform
Stored Value Balance
Inquiry Function

Check a stored value
card balance

Other Stored Value
Card Options

126 Authorize/Perform
Stored Value Balance
Transfer Function

Transfer the balance
from one stored value
card to another

Other Stored Value
Card Options

127 Authorize/Perform
Stored Value Point
Inquiry Function

Check a stored value
card point balance

Other Stored Value
Card Options

128 Authorize/Perform
Stored Value Report
Generation Function

Generate stored value
card reports

Loyalty Options 166 Authorize/Perform
Loyalty Coupon Inquiry

Request a list of coupons
that are available for a
loyalty account

Loyalty Options 167 Authorize/Perform
Accept Loyalty Coupon
Function

Redeem a coupon
associated with a loyalty
account

Loyalty Operations 168 Authorize/Perform Void
Accept Loyalty Coupon
Entry

Void the coupon
redemption

Loyalty Operations 169 Authorize/Perform Issue
Loyalty Coupon
Function

Issue a coupon to a
loyalty account

Loyalty Operations 170 Authorize/Perform Issue
Loyalty Points Function

Issue points to a loyalty
account

Loyalty Operations 171 Authorize/Perform Void
Issue Loyalty Points
Entry

Void the point issuance
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Table 47-2    (Cont.) Loyalty and Stored Value Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Loyalty Operations 172 Authorize/Perform
Redeem Loyalty Points
Function

Accept or redeem points
to apply towards the
balance of a check

Loyalty Operations 173 Authorize/Perform Void
Redeem Loyalty Points
Entry

Void the points
redemption

Loyalty Operations 174 Authorize/Perform
Redeem and Issue
Loyalty Points Function

Redeem points and issue
additional points to a
loyalty account

Loyalty Operations 175 Authorize/Perform Void
Redeem and Issue
Loyalty Points Entry

Void the points
redemption and
issuance

Loyalty Operations 176 Authorize/Perform
Loyalty Balance Inquiry
Function

Request a points balance
for a loyalty account

Loyalty Operations 177 Authorize/Perform
Loyalty Unique Item
Inquiry Function

Request a list of unique
menu items that were
ordered on a program
associated with a loyalty
account

Loyalty Operations 178 Authorize/Perform
Loyalty Balance
Transfer Function

Transfer the points
balance associated with
one loyalty account
number to another
loyalty account

Loyalty Operations 180 Authorize/Perform
Apply Loyalty Card to
Check

Use the Oracle
Hospitality Gift and
Loyalty operation that
applies a card account
against the guest check.
Depending on the
configuration in Gift and
Loyalty, setting this
privilege could trigger
one or more operations,
such as redeem points,
apply coupons, redeem a
gift card, and issue
points.

4. Click Save.

Related Topics

• Loyalty Configuration Tasks

Related Topics

• Stored Value Configuration Tasks
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Setting Loyalty Options
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Loyalty.

2. Insert a record, enter Loyalty as the name, and then click OK.

3. Double-click the record to open it.

4. Select the appropriate Loyalty Options as described in the following table.

Table 47-3    Loyalty Options

Option Description

1 - Support Offline Transactions Disable this option as loyalty transactions are not
supported in offline mode.

2 - Always Print Loyalty Results Enable this option to automatically print a chit after
each successful loyalty operation. When enabled,
upon finalizing a transaction, the message along with
any POS Print Text configured for the transaction type
automatically prints.

3 - Never Display Loyalty Results Enable this option to require the workstation
operator to touch the workstation in order to show
loyalty results. When enabled, no message is
generated. If the 2 - Always Print Loyalty Results
option is enabled, the loyalty results are printed.

5 - Remove Loyalty Results Print
Button

Enable this option to hide the Print button from the
loyalty results screen. When enabled, the generated
message does not include the Would you like to
print? Yes or No prompt. Enable this option in
conjunction with the 2 - Always Print Loyalty
Results option.

6 - Remove Guest Name Lookup
Button

Enable this option to hide the Guest Name Lookup
button from the account number entry screen. This
option deactivates the Guest Name Lookup function.

7 - Remove Phone Number Lookup
Button

Enable this option to hide the Phone Number Lookup
button from the account number entry screen. This
option deactivates the Phone Number Lookup
function.

5. Click Save.

Related Topics

• Loyalty Configuration Tasks

Configuring the Loyalty Driver
1. Select the Enterprise, property, or revenue center, click Setup, and then click Loyalty

Driver.

2. Insert a record and enter an appropriate gift and loyalty driver name.

If you are using Valutec, you can name the driver record VTLoyaltyDriver.

3. Double-click the record to open it.
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4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select
LoyaltyCommandModule.dll, and then click Open.

If you are using Valuetec, select VTLoyaltyCommandModule.dll, and then click
Open.

6. Click the Configuration tab.

7. From the Assembly/Class section, enter information in the following fields:

Table 47-4    Assembly/Class Fields

Field Description

Module ID Enter the module identification (for example,
LoyaltyDriver or VTLoyaltyDriver).

Display Name Enter a name for the module (for example, Loyalty
Driver or VTLoyaltyDriver).

Description Enter a description for the module (for example,
Loyalty Driver or VTLoyaltyDriver). Do not leave this
field blank.

8. From the iCareDriver Properties section, enter information in the following fields:

If you are using Valutec, skip to Step 9.

Table 47-5    iCareDriver Properties Fields

Field Description

Account Length Enter the number of digits for the loyalty account
number.

Account Prefix Enter the prefix for the account number.
For example, if the card rule dictates that all account
numbers start with 01013 and the Account Length
is always 16, the following configuration allows you
to enter the last digits (starting with the first non-
zero digit), and the account number is concatenated
as Prefix + padding zeroes + user input = where the
number of padding zeroes ensures that the account
length is correct.

Certificate File If the property implemented a unique certificate file,
specify the location of the certificate file on the local
machine.
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Table 47-5    (Cont.) iCareDriver Properties Fields

Field Description

Communications Offline
Retry Count

This value is the number of transactions that
workstation operators can complete offline before
attempting an online transaction. You cannot change
the value in this field as it is based on the Tender
Media or Service Charge records configured for
offline use.

Communications Timeout
Seconds

You cannot change the value in this field as it is
based on the Tender Media or Service Charge
records configured for offline use.

Log iCare Client Debug Data If the client is using Gift and Loyalty, indicate
whether the application includes debug information
in the log file.

Log iCare Client Message Data If the client is using Gift and Loyalty, indicate
whether the application includes client messages in
the log file.

Login Leave this field blank at the Enterprise level. This
value is set at the property level.

Password Leave this field blank at the Enterprise level. This
value is set at the property level.

Web Address Enter the path to Gift and Loyalty, including location,
port number and service path. Use the following
format: https://[GiftLoyaltyLocation]:
[GiftLoyaltyPortNumber]/ws/services/
StoredValueService.
If the property is using a third-party payment
provider application (rather than Gift and Loyalty),
enter the path to the third-party payment provider
application. This can be a Web address or a local
path.

9. (Valutec only) In the Valutec Driver Properties section, enter information in the following
fields:

Table 47-6    Valutec Driver Properties Fields

Field Description

Client Key This value is provided by Valutec, and is used by the
Valutec web service to identify the client.

Terminal ID This value is provided by Valutec, and is used to
identify each terminal initiating a transaction.

Merchant ID This value is provided by Valutec, and is used to
identify each merchant uniquely at the Valutec side.
This number is used as an alternate number instead
of the account number for loyalty operations.

10. Click Save.

Related Topics

• Loyalty Configuration Tasks
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Configuring the Loyalty Module
1. Select the Enterprise, property, or revenue center, click Setup, and then click

Loyalty Module.

2. Insert a record, enter LoyaltyModule as the name, and then click OK.

If you are using Valutec, you can name the module record VTLoyaltyModule.

3. Double-click the record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select
LoyaltyCommandModule.dll, and then click Open.

If you are using Valuetec, select VTLoyaltyCommandModule.dll, and then click
Open.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter information in the following fields:

• Module ID: Enter a value that identifies the module. For Valutec, enter
VTLoyaltyModule.

• Display Name: Enter a name for the module (for example, Loyalty or
VTLoyalty).

• Description: Enter a description of the loyalty module. Do not leave this field
blank.

8. In the Common Properties section, enter information in the following fields:

• Currency ISO Code: Enter the code (three alpha characters) that represents
the currency being used (for example, USD).

See http://www.currency-iso.org/en/home/tables/table-a1.html for a list of
Currency ISO 4217 codes.

• Language ISO Code: Enter the code (two alpha characters) that represents
the language being used (for example, EN).

See http://www.loc.gov/standards/iso639-2/php/code_list.php for a list of
Language ISO 639-1 codes.

If the currency or language is different at the property, override these values at the
property level.

9. In the Loyalty Module Properties section, enter information in the following fields:

• Account Number Maximum Length: Enter the maximum length of a loyalty
account number (up to 24 digits).

• Account Number Minimum Length: Enter the minimum length of a loyalty
account number (down to 7 digits).

• Cash Module Name: Enter the name of the cash module to use for
redemptions (for example, Cash:Cash).

10. Click Save.

11. Select the property, click Setup, and then click Loyalty Driver.

12. Double-click the gift and loyalty driver record to open it.
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13. Click the Override This Record link, and then click Yes to confirm.

14. Click the Configuration tab.

15. From the iCare Driver Properties section, enter information in the following fields:

• Login: Enter the login for the property ID or the login for the provider.

• Password: Enter the password for the property ID or the provider.

16. Click Save.

Related Topics

• Loyalty Configuration Tasks

Stored Value Configuration Tasks
Complete the following tasks to set up the stored value interface:

• Carry out the configuration prerequisites

• Configure stored value privileges

• (Valutec only) Configure Valutec Gift Card Tender/Media Records

• (Valutec only) Configure Valutec Gift Card Service Charge Records

• Set stored value options

• Configure the Stored Value driver

• Configure the Stored Value module

• Create Front of House stored value buttons

• Allow workstation operators to void loyalty points issued on re-opened checks

• (If applicable) Migrate the XProcessor Extension Application

Related Topics

• Configuring Loyalty and Stored Value Privileges

• Setting Stored Value Options

• Configuring the Stored Value Driver

• Configuring the Stored Value Module

• Creating Loyalty and Stored Value Buttons

• XProcessor Extension Application Migration

Setting Stored Value Options
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Stored Value.

2. Insert a record, enter Stored Value as the name, and then click OK.

3. Double-click the record to open it.

4. Select the appropriate Stored Value Options. The following table describes the options.
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Table 47-7    Stored Value Options

Option Description

1 - Support Offline Transactions For sites using Simphony Premium Cloud
Service, enable this option to allow
offline stored value transactions.
Stored value transactions are supported
in offline mode only for Simphony
Premium Cloud Service.

2 - Always Print Stored Value Results Enable this option to automatically print
a chit after each successful stored value
operation. When enabled, upon
finalizing a transaction, the message
along with any POS Print Text configured
for the transaction type automatically
prints.

3 - Never Display Stored Value Results Enable this option to require the
workstation operator to tap the
workstation to show loyalty results.
When enabled, no message is generated.
If the 2 - Always Print Stored Value
Results option is enabled, the loyalty
results are printed.

5 - Remove Stored Value Results Print
Button

Enable this option to hide the Print
button from the stored value results
screen. When enabled, the generated
message does not include the Would
you like to print? Yes or No
prompt. Enable this option in
conjunction with the 2 - Always Print
Stored Value Results option.

6 - Remove Guest Name Lookup Button Enable this option to hide the Guest
Name Lookup button from the account
number entry screen. This option
deactivates the Guest Name Lookup
function.

7 - Remove Phone Number Lookup
Button

Enable this option to hide the Phone
Number Lookup button from the
account number entry screen. This
option deactivates the Phone Number
Lookup function.

5. Click Save.

Related Topics

• Stored Value Configuration Tasks

Configuring the Stored Value Driver
1. Select the Enterprise, property, or revenue center, click Setup, and then click

Stored Value Driver.

2. Insert a record, enter an appropriate stored value card driver name, and then click
OK.

If you are using Valutec, you can name the driver record VTStoredValueDriver.
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3. Double-click the record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select
StoredValueCommandModule.dll, and then click Open.

If you are using Valuetec, select VTStoredValueCommandModule.dll, and then click
Open.

6. Click the Configuration tab.

7. From the Assembly/Class section, enter information in the following fields:

Table 47-8    Assembly/Class Fields

Field Description

Module ID Enter a value that identifies the module (for example,
SVCDriver).

Display Name Enter a name for the module (for example,
SVCDriver or VTStoredValueDriver).

Description Enter a description of the module (for example, SVC
Driver). Do not leave this field blank.

8. In the iCareDriver Properties section, enter information in the following fields:

If you are using Valutec, skip to Step 9.

Table 47-9    iCareDriver Properties Fields

Field Description

Account Length Enter the number of digits for the loyalty account
number.

Account Prefix Enter the prefix for the account number.
For example, if the card rule dictates that all account
numbers start with 01013 and the Account Length is
always 16, the following configuration allows you to
enter the last digits (starting with the first non-zero
digit), and the account number is concatenated as
Prefix + padding zeroes + user input = where the
number of padding zeroes ensures that the account
length is correct.

Certificate File If the property implemented a unique certificate file,
enter the location of the certificate file on the local
machine.
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Table 47-9    (Cont.) iCareDriver Properties Fields

Field Description

Communications Offline Retry
Count

This value is the number of transactions that
workstation operators can complete offline before
attempting an online transaction. You cannot change
the value in this field as it is based on the Tender
Media or Service Charge records configured for
offline use.

Communications Timeout Seconds You cannot change the value in this field as it is based
on the Tender Media or Service Charge records
configured for offline use.

Log iCare Client Debug Data If the client is using Gift and Loyalty, indicate
whether the application includes debug information
in the log file.

Log iCare Client Message Data If the client is using Gift and Loyalty, indicate
whether the application includes client messages in
the log file.

Login Leave this field blank at the Enterprise level. This
value is set at the property level.

Password Leave this field blank at the Enterprise level. This
value is set at the property level.

Web Address Enter the path to Gift and Loyalty, including location,
port number and service path. Use the following
format: https:// [GiftLoyaltyLocation]:
[GiftLoyaltyPortNumber]/ws/services/
StoredValueService.
If the property is using a third-party payment
provider application (rather than Gift and Loyalty),
enter the path to the third-party payment provider
application. This can be a Web address or a local
path.

9. (Valutec only) In the Valutec Driver Properties section, enter information in the
following fields:

Table 47-10    Valutec Driver Properties Fields

Field Description

Client Key This value is provided by Valutec, and is used by
the Valutec web service to identify the client.

Terminal ID This value is provided by Valutec, and is used to
identify each terminal initiating a transaction.

Merchant ID This value is provided by Valutec, and is used to
identify each merchant uniquely at the Valutec
side.
This number is used as an alternate number
instead of the account number for stored value
operations.

10. (Valutec only) In the Valutec Stored Value Card Properties section, enter
information in the following fields:
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You need to configure tenders and service charges first to get the object numbers needed
for entry in the following fields.

Table 47-11    Valutec Stored Value Card Properties Fields

Field Description

Activate Tender Enter the object number of either a service charge or
a menu item number used for the activate tender
operation.

Cashout Tender Enter the object number of the cashout tender used
for the pickup tender or loan tender operation.

Offline Redeem Tender Enter the object number of the offline redeem tender
used for redemption in offline mode only.

Offline Redeem Tender Limit Enter the offline redemption tender limit amount.
This is the maximum amount on the check that is
allowed while the POS client is in offline mode.

Redeem Tender Enter the object number of the tender used for the
redeem operation.

Reload Tender Enter the object number of the tender used for either
a service charge or menu item used for the reload
operation.

11. Click Save.

Related Topics

• Stored Value Configuration Tasks

Configuring the Stored Value Module
1. Select the Enterprise, property, or revenue center, click Setup, and then click Stored

Value Module.

2. Insert a record, enter SVCModule as the name, and then click OK.

If you are using Valutec, you can name the module record VTStoredValueModule.

3. Double-click the record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select
StoredValueCommandModule.dll, and then click Open.

If you are using Valuetec, select VTStoredValueCommandModule.dll, and then click
Open.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter information in the following fields:

• Module ID: Enter the module identification. For Valutec, enter VTStoredValueModule.

• Display Name: Enter a name for the module (for example, Stored Value or
VTStoredValue).

• Description: Enter a description of the stored value module. Do not leave this field
blank.
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8. In the Common Properties section, enter information in the following fields:

• Currency ISO Code: Enter the code (three alpha characters) that represents
the currency being used (for example, USD).

See www.currency-iso.org/en/home/tables/table-a1.html for a list of Currency
ISO 4217 codes.

• Language ISO Code: Enter the code (two alpha characters) that represents
the language being used (for example, EN).

See www.loc.gov/standards/iso639-2/php/code_list.php for a list of Language
ISO 639–1 codes.

If the currency or language is different at the property, override these values at the
property level.

9. In the Stored Value Module Properties section, enter information in the following
fields:

• Account Number Maximum Length: Enter the maximum length of a stored
value account number (up to 24 digits).

• Account Number Minimum Length: Enter the minimum length of a stored
value account number (down to 7 digits).

• Cash Module Name: Enter the name of the cash module to use for
redemptions (for example, Cash:Cash).

• Max Card Activation Quantity: Enter the maximum number of stored value
cards that can be activated with the Activate Multiple card operation.

• Max Card Issue Quantity

: Enter the maximum number of stored value cards that can be issued with the
Activate Multiple card operation.

10. Click Save.

11. Select the property, click Setup, and then click Stored Value Driver.

12. Double-click the stored value card driver record to open it.

13. Click the Override This Record link, and then click Yes to confirm.

14. Click the Configuration tab.

15. From the iCare Driver Properties section, enter information in the following fields:

• Login: Enter the login for the property ID or the login for the provider.

• Password: Enter the password for the property ID or the provider.

16. Click Save.

Related Topics

• Stored Value Configuration Tasks

Creating Loyalty and Stored Value Buttons
You can create buttons for use on a POS Operations page for the loyalty and stored
value functions.

1. Select the Enterprise, property, or revenue center, click Configuration, and then
click Page Design.
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2. Open the page on which to place loyalty and stored value buttons.

3. On the Edit tab, select the page area in which to define the loyalty and stored value
functions (typically the payment or function area).

4. Click Button.

5. On the General subtab, select the appropriate function from the Type drop-down list.

• Loyalty Function

• Stored Value Function

6. Click the black arrow beneath the Type drop-down list.

7. Select one of the following, and then click OK.

• iCare Loyalty: Select for Oracle MICROS Simphony loyalty.

• iCare Stored Value: Select for Oracle MICROS Simphony gift cards.

• Loyalty: Select for Valutec loyalty.

• Stored Value: Select for Valutec gift cards.

8. From the Loyalty or Stored Value Operation Selection dialog, select the appropriate
Module Type and Functions, and then click OK.

• iCareLoyaltyModule: Select for Oracle MICROS Simphony loyalty.

• iCareSVCModule: Select for Oracle MICROS Simphony gift cards.

• VTLoyaltyModule: Select for Valutec loyalty.

• VTStoredValueModule: Select for Valutec gift cards.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. In the Legend field, enter the button name, and then click Save. The following tables list
the loyalty and stored value button names and functions.

Buttons marked with an asterisk (*) are only available with Gift and Loyalty; these
functions are not available with third-party payment providers.

Table 47-12    Loyalty Buttons

Button Name Function

Balance Inquiry Request a points balance for a loyalty account.

Unique Items Inquiry* Request a list of unique menu items that have been ordered
on a program associated with a loyalty account.

Issue Points Issue points to a loyalty account.

Coupon Inquiry Request a list of coupons that are available for a loyalty
account.

Redeem Coupon Redeem a coupon to apply towards the balance of a guest
check.

Issue Coupon Issue an ad hoc coupon from Gift and Loyalty to a guest
loyalty account.

Transfer Loyalty Account Transfer the points balance and customer personal
information associated with one loyalty account number to
another loyalty account.
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Table 47-12    (Cont.) Loyalty Buttons

Button Name Function

Apply Card to Check* The Apply Card to Check function sends an Apply request to
Gift and Loyalty for the account number. Based on Gift and
Loyalty configuration, the workstation operator can select
the following actions:
• Apply Coupon
• Redeem Points
• Redeem Stored Value Card (SVC)
• Apply Coupon and Redeem SVC
• Issue Points
The Apply Card to Check function requires a special
configuration to share data between the Loyalty and Stored
Value modules. To configure the Apply Card to Check button
on the General tab, in the Text field, enter the SVCModule
Name and Record Number. Use the format
SVCModuleName:RecordNumber to process SVC actions
associated with this function. You can find the Record
Number and Module Name in EMC by highlighting the
Enterprise, selecting Setup, and then clicking Stored Value
Module.
A property can load more than one type of loyalty module,
although Oracle does not recommend doing so. If the
property uses multiple loyalty modules, manually enter the
module name in the Arguments field for the second module.

Table 47-13    Stored Value Buttons

Button Name Function

Balance Inquiry Request the current monetary value for a stored value
account or gift card.

Issue SVC Issue one stored value account number for a dollar
value that is determined at the time of purchase.

Issue Multiple SVCs* Issue multiple stored value account numbers for a dollar
value that is determined at the time of purchase.

Activate SVC Activate one stored value account. The application
prompts the workstation operator to enter the pre-
defined dollar value for validation.

Activate Multiple SVCs* Activate multiple stored value account numbers for a
dollar value that is determined at the time of purchase.
The application prompts the workstation operator to
enter the pre-defined dollar value for validation.

Reload Add funds to an existing stored value account.

Transfer Transfer the funds and customer personal information
(if applicable) associated with one stored value account
to another stored value account.

Authorize Authorize a gift card for use as payment on a guest
check.

Redeem Pay a guest check balance using a gift card.

Cash Out Obtain a cash payment for any remaining balance on a
stored value account.
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Table 47-13    (Cont.) Stored Value Buttons

Button Name Function

Redeem SVC/Issue Points* The Redeem SVC/Issue Points function combines the
Redeem SVC and Loyalty Issue Points functions. The
application prompts the workstation operator to redeem
a gift card, and then automatically issues points.
The Redeem SVC/Issue Points function requires a special
configuration to share data between the Loyalty and
Stored Value modules. To configure the Redeem SVC/
Issue Points button on the General tab, in the Text
field, enter the LoyaltyModule Name and Record
Number. Use the format
LoyaltyModuleName:RecordNumber to process loyalty
actions associated with this function. You can find the
Record Number and Module Name in EMC by
highlighting the Enterprise level, clicking Setup, and
then clicking Loyalty Module.
For SVC transactions, you can suppress a prompt for
entry of the Total Amount Due by enabling Tender/
Media option 3 - Assume Paid in Full, and by setting the
Text field of the Redeem button in the Page Design
module to: RedeemAmountIsTotalDue.
A property can load more than one type of stored value
module, although Oracle does not recommend doing so.
If the property uses multiple stored value modules,
manually enter the module name in the Arguments field
for the second module.

11. Repeat the preceding steps to create buttons for each of the loyalty and stored value
functions listed in the tables.

Related Topics

• Loyalty Configuration Tasks

Related Topics

• Stored Value Configuration Tasks

Voiding Points on a Re-opened Check
To allow workstation operators to void loyalty points issued on re-opened guest checks, the
check number must remain the same after reopening a check. By default, a guest check
number increments each time a workstation operator re-opens the check, preventing the
voiding of points due to check numbering mismatch.

1. Select the revenue center, click RVC Parameters, and then click Options.

2. Select 37 - Keep The Same Check Number When a Check is Reopened.

This allows a re-opened guest check to retain its original guest check number. When you
deselect this option, Simphony assigns a re-opened guest check to a new check number.

3. Click Save.

Related Topics

• Loyalty Configuration Tasks
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XProcessor Extension Application Migration
You can install the Loyalty driver for Gift and Loyalty Advanced at the property (in
place of the XProcessor Extension Application). Upgrade the POS clients to the latest
Simphony release before completing the steps in this section.

1. Browse to the CAL server’s Microsoft Windows 32-bit or Microsoft Windows CE
subdirectory for Gift and Loyalty Advanced:

• CAL\Win32\ICareProcessor2.0 directory

• CAL\WinCE\ICareProcessor2.0 directory

2. Delete the ICareProcessor2.0 directory.

3. From the EMC, select the Enterprise level, click Setup, and then click CAL
Packages.

4. Delete the CAL Client package that was used to deploy the ICareProcessor2.0
directory to the workstations.

5. Delete the following files from the disk:

• Micros.XProcessor.dll

• Micros.XProcessor.SVC.dll

• Micros.XProcessor.SVC.ICare.dll

6. Select the Enterprise, property, or revenue center, click Setup, and then click
Extension Application.

7. Delete the Extension Application for XProcessor.

8. Select the Enterprise, property, or revenue center, click Setup, and then click
Payments.

9. Delete the XProcessor Payment driver.

10. Select the Enterprise or property, click Configuration, and then click Tender/
Media.

11. Delete XProcessor Close Check.

12. Delete the iCareSvcProcessor.icare.xml file.

13. Select the Enterprise level, click Configuration, and then click Data Extensions.

14. Delete the data extensions for each property.

15. Select the Enterprise, property, or revenue center, click Configuration, and then
click Page Design.

16. Double-click the page record containing Gift and Loyalty buttons to open it.

17. Delete all Gift and Loyalty buttons.

Depending on the property’s Gift and Loyalty configuration, additional menu items,
discounts, service charges, or tenders may have been used. If these items are in
use, leave these additional items and do not delete them.

18. If the property was using the Check Reprocessor service, remove the installed
check reprocessor files from the Enterprise Service Host as the Gift and Loyalty
interface has its own plug-ins.
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19. Browse to the Handlers directory where the Check Reprocessor ran and open the
ChkReprocSvcHost.DLL.config file.

20. Delete the following tag:

<pluginAssembly displayname=”XProcessor Reprocessor”
fullname=”Micros.XProcessor.SVC.dll, Version=0.0.0.0, Culture=neutral,
PublicKeyToken=null” />
Leave the tags <pluginAssemblies> and </pluginAssemblies>.

21. Delete the following files from the Handlers directory:

• Micros.XProcessor.Payment.dll

• Micros.Ops.Extensibility.dll

• Micros.XProcessor.dll

• Micros.XProcessor.SVC.dll

• Micros.XProcessor.SVC.iCare.dll

Related Topics

• Loyalty Configuration Tasks

Related Topics

• Stored Value Configuration Tasks
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48
XProcessor Gift Cards and Plug-ins

The XProcessor is an Extension Application which provides a framework for implementing
processors in EMC. These processors are used to interact with external gift card/stored value
card provider systems.

The following XProcessor plug-ins are available:

• Generic SVC - Givex Processor

• Stored Value Solutions (SVS) Processor

• ValueLink Processor

The subsequent topics in this chapter explain the XProcessor framework, and how to
configure and use each processor plug-in.

Setting Up the XProcessor Framework
To use XProcessor, you need to set up the main XProcessor framework and one or more
processor plug-ins.

The XProcessor plug-ins are:

1. Generic SVC - Givex Processor

2. SVS Processor

3. ValueLink Processor

The following files must be imported into the Simphony EMC to set up the XProcessor
framework:

• Micros.XProcessor.Payment.dll: To be imported into the Payments module

• XProcessorConfiguration_initial.xml: To be imported into the Content module

Subsequent topics provide instructions about importing these two files (and each available
plug-in) into the Simphony system.

Setting up Multiple Processors

Setting up multiple processors in the same system can be done, but has its limitations. More
specifically, the order in which you define the individual processors in the main XProcessor
configuration file matters. If you define all three processors, the first processor defined in the
configuration file, which handles a specific operation, is the one that is used for the operation.

With the configuration shown here, the Generic SVC Processor is defined/listed first.
Attempting to perform a Redeem function, which is common to all three processors, will be
handled by the Generic SVC Processor, even if your intention is to use the SVS Processor.
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Figure 48-1    XProcessor Plug-ins

Note:

This limitation does not apply to the ValueLink processor plug-in as the
ValueLink buttons are configured to use a different entry point.

See Add XProcessor Payment DLL to the Payments Module and Add XProcessor
Configuration File to the Content Module for information about configuring the
XProcessor framework.

Add XProcessor Payment DLL to the Payments Module
The setup steps provided here also apply to remote EMC users. All required
installation files are available in the [Drive
Letter]:\MICROS\Simphony2\EMCClient folder on the Simphony application
server.

These steps are the same for each available XProcessor plug-in. To set up the EMC
Payments module for the XProcessor framework:

1. Select the Enterprise level, click Setup, and then click Payments.

2. Insert a new record, and then double-click the new record to open it in form view.

3. In the Name field, enter Micros.XProcessor.Payment.

When configuring all XProcessor files in the EMC, the naming conventions for the
*.DLL and *.XML files must match the actual file name that is imported into the
module, but is not to include the file’s extension, for example *.dll or *.xml.

4. In the Content Type field, select 3 - DLL from the drop-down list.

5. Click the Import from a file link.

6. From the EMCClient folder, select the Micros.XProcessor.Payment.dll file.
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Figure 48-2    EMC Payments Module

7. Click Save.

8. Continue to Add XProcessor Configuration File to the Content Module.

Add XProcessor Configuration File to the Content Module
The setup steps provided here also apply to remote EMC users. All required installation files
are available in the EMCClient folder on the Simphony application server.

The setup steps outlined here are the same for each available XProcessor plug-in. To setup
the Content module for the XProcessor framework:

1. Access the EMC and select the Enterprise, click Setup, and then select Content.

2. Insert a new record and double-click the new record to toggle to Form view.

3. From the Name field, enter XProcessorConfiguration.

Note:

When configuring all XProcessor files in the EMC, the naming conventions for
the *.DLL and *.XML files must match the actual file name which is imported
into the module, but is not to include the file’s extension, for example *.dll or
*.xml.

4. From the Content Type field, select 1 – Loose Xaml from the drop-down list.

5. Click the Import from a file link.

6. From the EMCClient folder, select the XProcessorConfiguration_initial.xml file.
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7. Depending on how many XProcessor plug-ins you plan to use, you can either
leave unused plug-in(s) as they are (commented out), or remove the unused plug-
in rows altogether.

In this example, only the SVS XProcessor plug-in has been un-commented and is
accessible for use by the system.

Figure 48-3    Example: EMC Content Module - Un-Commented Out
XProcessor Plug-In Row

In this example, the MSVC-Givex – SVC Generic and ValueLink XProcessor plug-
in rows have been removed altogether.

Figure 48-4    Example: EMC Content Module - Removed Unused XProcessor
Plug-Ins Rows

8. Click Save.

Givex Processor
The Generic Stored Value Card (SVC) Processor is an extension to the XProcessor
Extension Application. It provides access to any gift card vendor that supports the
Oracle MICROS SVC Host Message Specification. The processor communicates with
a vendor host adapter, which then communicates with the vendor's host system using
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a vendor-specific protocol. Givex is currently the only vendor that uses this specification.

Figure 48-5    Generic SVC/Givex Processor Data Flow

Setting up the Givex Processor consists of downloading and installing a vendor host adapter/
driver to a workstation, and adding or modifying records in the following EMC modules:

• Content

• Discounts

• Page Design

• Service Charges

• Tender/Media

If you are an existing Givex customer, you can continue using your Givex Processor
configuration, but you must be using the latest release package, which is Version 2.2.5.122.

Configuring the Givex Tender/Media Record
You must configure six tenders for use with the Givex Processor. The tenders are:

• Gift Card Redeem

• Cash Back

• Points Issue

• Pre Auth

• Promotion Card Redeem

• Ticket Redeem

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a record, name it Givex Gift Card Redeem, and then click OK.
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3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click Save.

6. Repeat steps 2 through 5 for the remaining tenders, following a similar naming
convention (for example, Givex [TENDER/MEDIA NAME]).

Configuring the Givex Service Charge Record
You must configure four service charges for use with the Givex Processor. The service
charges are:

• Register

• Increment

• Activate

• Points Redeem

1. Select the Enterprise, property, or zone, click Configuration, and then click
Service Charges.

2. Insert a record, name it Givex Register Charge, and then click OK.

3. Double-click the record to open it.

4. Select option 14 - Service Charge Used For Stored Value Transactions.

5. Set other Service Charge fields and options as needed. Configuring Service
Charges contains more information about the fields and options.

6. Click Save.

7. Repeat steps 2 through 6 for the remaining service charges, following a similar
naming convention (for example, Givex [SERVICE CHARGE NAME] Charge).

Configuring the Givex Processor and Content Files
Before configuring the Givex Processor, you must ensure that the XProcessor
Extension Application is installed and configured. Setting Up the XProcessor
Framework contains more information.

The instructions in this topic explain how to add the GenericSvcProcessor.msvc-
givex.xml file to the Content module in the EMC. This file contains Generic SVC
processor configuration for Givex.

1. Select the Enterprise level, click Setup, and then click Content.

2. Double-click the XProcessorConfiguration row in the Name column.

3. Locate the processor id=”msvc-givex” entry. This file includes an entry for the
Givex Generic SVC Processor as shown in the following figure:
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Figure 48-6    XProcessor Configuration Entry for Givex

If you are using only the Givex Processor for gift card service, delete the other entries or
use comment marks around them.

4. Click the insert icon

on the toolbar.

5. In the Record Name field, enter GenericSvcProcessor.msvc-givex, and then click OK.

Ensure that you enter the filename exactly as shown; otherwise problems may occur in
the system. Do not include the file extension (in this case, *.xml) in the Record Name
field.

6. Double-click the GenericSvcProcessor.msvc-givex row.

7. Set the Content Type to 1 - Loose Xaml so you can see the tags in various colors,
making it easier to read.

8. Click the Import from a file link.

9. Browse to [Drive Letter]:\MICROS\Simphony2\EMCClient, select
GenericSvcProcessor.msvc-givex.xml, and then click Open.

10. Change the GenericSvcProcessor.msvc-givex.xml file to include the appropriate
entries, replacing the tags in braces with the correct information.

The comments in the file explain in further detail. For more information, see Configuring
the Givex Processor Address and Port.

11. Click Save.

12. Update or reload your database on the workstation to ensure that the changes apply to
the workstation.

Updating Workstations After Configuration Changes in the Oracle MICROS
Simphony POS User Guide contains information about this process.

Configuring the Givex Processor Address and Port
One of the settings for the Givex Processor configuration file is the address and port used for
the TCP socket connection to the vendor’s host adaptor. The values can vary by installation
or, in some cases, by location. As such, these values require updating when importing the
Givex processor configuration file in the Content module of EMC. The following figure
indicates where to configure these settings.
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Figure 48-7    Givex Processor XML File – Updating Address and Port

In the address section, set the IP address of the workstation that is running the Givex
host adaptor, and in the port section enter the port number for the Givex host adaptor.
By default the port number for the Givex adaptor is 50000, however this may vary and
is configurable.

Creating Givex Processor Operations Buttons
You need to add a button to POS operations for each supported Givex Processor
operation to function on the workstation. Each button needs to be set to the Function
Run Extensibility App.

The following tables list the operations supported by the Givex Processor and the
arguments that are used in the Page Design module. The first table lists button
arguments that support account numbers less than 9,223,372,036,854,775,807.
Customer sites with account numbers greater than this number must use the button
arguments listed in the second table. You will use the information from these tables in
the subsequent steps.

Table 48-1    Givex Operation Buttons — Original

Operation
Name

Description Argument String

Authorize Authorize the use of a gift card for
payment. This function is used in
conjunction with Finalize.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Authorize;Arg=<XProcessorArg
s transactionstate="inside" />

Balance
Transfer

Transfer the balance of one card to
another. The source card
effectively becomes inactive.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=BalanceTransfer;Arg=&lt;XPro
cessorArgs
transactionstate="outside">&lt;Acc
ountEntryRules title="Givex
Balance Transfer" prompt="Enter
Account Number to Transfer
Balance To" entrytype="Numeric"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" />&lt;/
XProcessorArgs>
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Table 48-1    (Cont.) Givex Operation Buttons — Original

Operation
Name

Description Argument String

Cash Out Remove the remaining balance of
the gift card.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Cashout;Arg=<XProcessorArgs
transactionstate="outside" />

Finalize Finalize the gift card payment.
This function is used in
conjunction with Authorize.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Finalize;Arg=<XProcessorArgs
suppressaccountprompt="true"
selectpendingoperation="true"
transactionstate="inside"/> 

Inquire Retrieve the current balance of a
gift card.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Inquire

Issue Generate a new card number with
the requested balance.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Issue;Arg=<XProcessorArgs pr
ocessorid="msvc-givex"
suppressaccountprompt="true" /> 

Redeem Use the gift card as payment. Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Redeem;Arg=<XProcessorArgs
transactionstate="inside" />

Reload Add value to an active gift card via
a payment.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=Reload

Void Cash Out Reverse a previously performed
cash out operation.

Type=DLL;AppName=XProcessor;F
ileName=Micros.XProcessor.dll;Scr
ipt=void_cashout;Arg=<XProcessor
Args transactionstate="outside" />

Table 48-2    Givex Operation Buttons — Supports 19+ Digit Account Numbers

Operation Name Description Argument String

Authorize Authorize the use of a gift card for
payment. This function is used in
conjunction with Finalize.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=A
uthorize;Arg=<XProcessorArgs
transactionstate="inside"><AccountE
ntryRules title="Authorize"
prompt="Enter Account Number"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>
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Table 48-2    (Cont.) Givex Operation Buttons — Supports 19+ Digit Account Numbers

Operation Name Description Argument String

Balance Transfer Transfer the balance of one card to
another. The source card effectively
becomes inactive.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=B
alanceTransfer;Arg=<XProcessorArgs
transactionstate="outside"><Account
EntryRules title="Givex Balance
Transfer" prompt="Enter Account
Number to Transfer Balance To"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>

Cash Out Remove the remaining balance of the
gift card.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=C
ashout;Arg=<XProcessorArgs
transactionstate="outside"><Account
EntryRules title="Cashout"
prompt="Enter Account Number"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>

Finalize Finalize the gift card payment. This
function is used in conjunction with
Authorize.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=F
inalize;Arg=<XProcessorArgs
suppressaccountprompt="true"
selectpendingoperation="true"
transactionstate="inside"/>

Inquire Retrieve the current balance of a gift
card.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=I
nquire;Arg=<XProcessorArgs><Accou
ntEntryRules title="Inquire"
prompt="Enter Account Number"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>

Issue Generate a new card number with
the requested balance.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=I
ssue;Arg=<XProcessorArgs processori
d="msvc-givex"
suppressaccountprompt="true" />
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Table 48-2    (Cont.) Givex Operation Buttons — Supports 19+ Digit Account Numbers

Operation Name Description Argument String

Redeem Use the gift card as payment. Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=R
edeem;Arg=<XProcessorArgs
transactionstate="inside"><AccountE
ntryRules title="Redeem"
prompt="Enter Account Number"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>

Reload Add value to an active gift card via a
payment.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=R
eload;Arg=<XProcessorArgs><Accoun
tEntryRules title="Reload"
prompt="Enter Account Number"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>

Void Cash Out Reverse a previously performed cash
out operation.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=v
oid_cashout;Arg=<XProcessorArgs
transactionstate="outside"><Account
EntryRules title="Void Cashout"
prompt="Enter Account Number"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false" /></
XProcessorArgs>

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Open the page on which to place the Givex Processor buttons.

3. On the Edit tab, select the page area in which to define the Generic SVC Processor
functions.

4. Click Button.

5. On the General subtab, in the Legend field, enter the operation name (button).

6. Select Function from the Type drop-down list.
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7. Click the black arrow beneath the Type drop-down list.

8. Select Extensibility from the Type pane, select Run Extensibility App in the
Results pane, and then click OK.

9. Click inside the Arguments field (left of the black arrow). The easiest way to
complete this field for each operation name is to copy and paste the information
from the table in the Arguments String field.

Ensure that there are no spaces within the string.

10. Repeat steps 4 through 9 to create buttons for each of the operations listed in the
table.

11. Click Save.

Givex Host Adaptor
Due to the Givex Processor requiring communication with a vendor host adaptor
(which in turn communicates with the vendor's host system using a vendor-specific
protocol), you need to download and install the host adaptor to a workstation.

Givex is Windows-based, and as such, runs as a Windows service on workstations.

For more information on how to download and install Givex to a workstation, contact
your Givex representative for assistance.

The Givex Host Adaptor has its own configuration file called GIVEX.INI, which requires
modification in the following areas:

• Connection information for the Givex host.

• Record numbers to map to Givex Transactions, specifically:

– INVENTORY_BASE relates 4 transactions to Service Charge entries.

– TENDER_BASE relates 6 transactions to Tender/Media.

After modifying the configuration file, restart the Givex Host Adaptor service. The
name of the service is Givex SVC Adaptor.

For more detailed information on how to configure the Givex Host Adaptor, see 
Configuring the Givex Host Adaptor.

Configuring the Givex Host Adaptor
The following steps describe how to configure the Givex Host Adaptor after
downloading and installing it to a workstation. For more information on how to
download and install the adaptor file, contact your Givex representative for assistance.

1. Download and install the provided Givex Host Adaptor file to your workstation.
Make sure to run the file as an administrator to avoid any issues.

2. After installation, browse to [Drive Letter]:\Program
Files\MicrosGivex, and then open the GIVEX.INI file in Notepad or Notepad+
+.

3. Edit the following areas in the file:

a. (Optional) LISTEN_PORT: By default, the value is set to 50000. You may edit
this port number if you wish to use a different port, due to possible restrictions.
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b. INVENTORY_BASE: This setting controls the mapping of Givex transactions to
Oracle MICROS Service Charges. Each of the four Givex transactions that require
configuration correspond to a Service Charge:

• Register (Givex service 904)

• Increment (Givex service 905)

• Activate (Givex service 906)

• Points Redeem (Givex service 912)

Set the INVENTORY_BASE to equal the corresponding Service Charge record
numbers in the EMC, For example, if the Givex Service Charge record numbers set
in the EMC are listed as 2, 3, 4, 5, then set it as INVENTORY_BASE = 2, 3, 4, 5. The
configuration file provides comments that explain the process in further detail for
other examples.

c. TENDER_BASE: This setting controls the mapping of Givex transactions to Oracle
MICROS Tenders. Each of the six Givex transactions that require configuration
correspond to a Tender:

• Gift Card Redeem (Givex service 901, 902, 921)

• Cash Back (Givex service 919)

• Points Issue (Givex service 911)

• Pre Auth (Givex service 920)

• Promotion Card Redeem (Givex service 901, 902, 921)

• Ticket Redeem (Givex service 901, 902, 921)

Set the TENDER_BASE to equal the corresponding Tender Media record numbers in
the EMC, For example, if the Givex Tender Media record numbers set in EMC are
listed as 2, 3, 4, 5, then set it as TENDER_BASE = 2, 3, 4, 5. The configuration file
provides comments that explain the process in further detail for other examples.

d. TERMINALS: Set the TID=USER, PASSWORD to the following:

• TERMINAL ID (TID) = Workstation Object number (record number as shown in
the EMC)

• USER = Givex Terminal user ID

• PASSWORD = Givex Terminal user password

The Givex terminal user ID and password are provided to you by Givex. Each
workstation/terminal in the system requires one entry. The configuration file provides
comments that explain the process in further detail.

4. After completing the necessary changes to the file, click File, and then click Save.

5. To ensure that the configuration changes take place on the workstation, navigate to
Windows Services, locate the Givex adaptor named Givex SVC Adaptor, click the
service, and then click Restart.

Stored Value Solutions (SVS) Processor
The SVS Processor is an extension to the XProcessor Extension Application. It provides
access to the SVS gift card service. This section describes how to configure the SVS
XProcessor plug-in.

Here is a listing of the supported operations for the SVS Processor:
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• Authorize

• Cash Out

• Finalize

• Inquire

• Issue

• Redeem

• Reload

• Void Reload

Figure 48-8    SVS Processor Data Flow

Setting up the SVS Processor consists of adding or modifying records in the following
EMC modules:

• Content

• Interfaces / Payments module

• Page Design

• Service Charges

• Tender/Media

If you are an existing SVS customer, you can continue using your SVS Processor
configuration, but you must be using the latest release package, which is Version
1.2.2.22.

Configuring the SVS Tender/Media Record
You must configure Tender/Media records for use with the SVS Processor for the gift
card service.

1. Select the Enterprise or property, click Configuration, and then click Tender/
Media.
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2. Insert a record, name it SVS Redeem, and then click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Repeat steps 2 through 4 to create the remaining two Tender/Media records as follows:

• SVS Cashout record with a Key Type value of 3 - Pickup.

• SVS Void Cashout record with a Key Type value of 4 - Loan.

6. Click Save.

Configuring the SVS Service Charge Records
You can configure up to four service charge records for use with the SVS Processor plug-in
for gift card service. The services charges are:

• SVS Issue SVC Charge

• SVS Activate SVC Charge

• SVS Reload SVC Charge

1. Select the Enterprise, property, or zone, click Configuration, and then click Service
Charges.

2. Insert a record, name it SVS Issue SVC Charge, and then click OK.

3. Double-click the record to open it.

4. Select option 14 - Service Charge Used For Stored Value Transactions.

5. Set other Service Charge fields and options as needed. Configuring Service Charges
contains more information about the fields and options.

6. Click Save.

7. Repeat steps 2 through 6 to create the remaining service charge records, following a
similar naming convention (for example, SVS [Service Charge name] SVC Charge).

Configuring the SVS Processor and Content Files
The SVS processor is an extension to the XProcessor Extension Application. It provides
access to the Stored Value Solutions (SVS) gift card solution.

Before configuring the SVS Processor, you must ensure that the XProcessor Extension
Application Framework is installed and configured.

Follow the steps outlined in Setting Up the XProcessor Framework before continuing with the
SVS processor configuration. After performing an upgrade, existing SVS Processor users can
continue using their current SVS processor configuration as long as the latest SVS release
package is being utilized. The latest SVS version is 1.2.2.22.

The instructions in this topic explain how to add the following SVS Processor files to the
Content module in the EMC.

Table 48-3    SVS Processor Content Filename and Description

Filename Description

SVSProcessor.svs SVS Processor configuration.
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Table 48-3    (Cont.) SVS Processor Content Filename and Description

Filename Description

SVSHostSettings.svs Sets various connection settings to the SVS host
vendor and enables or disables the optional
bonus card feature.

SVSBonusCard.svs Enables the issuance of a bonus gift card with
a pre-configured limited amount value.

Ensure that you enter the filename exactly as shown; otherwise problems may occur in
the system. Do not include the file extension, for example *.xml or *.dll, in the records
Name field.

1. Select the Enterprise level, click Setup, and then click Content.

2. Double-click the XProcessorConfiguration row in the Name column.

3. Locate the processor id=”svs” entry. This file includes an entry for the SVS
Processor as shown in the following figure:

Figure 48-9    XProcessor Configuration Entry for SVS

If you are using only the SVS Processor for the gift card service, un-comment the
SVS Processor and delete or keep the existing comment marks around the other
processors.

4. Click the insert icon

on the toolbar.

5. In the record’s Name field, enter SVSProcessor.svs, and then click OK.

6. Double-click the SVSProcessor.svs row and set the Content Type to 1 - Loose
Xaml, so you can see the tags in various colors, making it easier to read.

7. Click the Import from a file link.

8. Browse to [Drive Letter]:\MICROS\Simphony2\EMCClient, select
SVSProcessor.svs.xml, and then click Open.

9. You must modify the imported SVSProcessor.svs file so each applicable <macro>
entry in the SVSProcessor.svs file has the actual EMC record number for the
respective Tender/Media or Service Charges. Another option is to remove
individual macros you do not intend to use. Edit the file as needed to use the
correct:
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• Currency Code: For the currencycode setting near the beginning of the imported
SVSProcessor.svs file. This setting defaults to USD (which stands for US Dollars).

• Reload Service Charge: For the macro id-”post_reload” operation, enter the
[service-charge-number] record number (as shown in the EMC) between the
braces.

• Redeem Tender Media: For the macro id=”post_redeem” operation, enter the
[payment-tender-number] Tender/Media record number (twice as shown in the
EMC) between the braces.

• Cash Out Tender Media: For the macro id=”post_cashout” operation, enter the
[payment-tender-number] record number (as shown in the EMC) between the
braces.

Note:

When entering EMC record numbers for macros, such as a [payment-
tender-number] or a [service-charge-number], remove the placeholder
braces, leaving only the record number between the Number tags. Brace
removal applies when editing all of the imported *.xml files.

Figure 48-10    EMC Content Module - SVSProcessor.svs Configuration

a. Repeat step 9 for each remaining macro operation you want to enable for the this
processor.

b. Click Save.

10. Add the SVSHostSettings.svs configuration file to the Content module.

This file needs to be modified to set various connection settings to the SVS host and to
enable the optional Bonus Gift Card feature. Entries here also set the bonus gift card’s
amount values.

a. Import the SVSHostSettings.svs.xml file available in the [Drive
Letter]:\MICROS\Simphony2\EMCClient folder.
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b. Modify this configuration file for rows 3 through 11 to match the information
provided by your SVS service provider.

Figure 48-11    EMC Content Module - Imported SVSHostSettings.svs File

c. To enable the Bonus Gift Card feature, configure rows 12 through 17:

Note:

Bonus Card configuration is required even if users have no intention
of using the Bonus Card feature. As described in step 11 (below), the
SVSBonusCard.svs XML file must be added to the Content module
and the file needs to have its placeholder values replaced with valid
record numbers (even if they are not referring to actual service
charge or discount entries). Add valid service charge and discount
record numbers to the placeholder fields as shown in this figure: 
EMC Content Module - Imported SVSBonusCard.svs File.

• ElligibleParentBonusGC: This field is user defined, but must match the
name field of the parent processor as configured in the SVSProcessor.svs
file (shown below).

Figure 48-12    EMC Content Module - Imported SVSProcessor.svs
File
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• ElligibleBonusGC: This field is user defined, but must match the name field
located in the SVSBonusCard.svs (shown below).

Figure 48-13    EMC Content Module - Imported SVSProcessor.svs File

• BonusGCFeature: This field enables the Bonus Gift Card feature by setting it to
true. The default setting for this field is false (disabled).

• ElligibleBonusAmount: This field is for used to establish the amount that
customers are eligible for an additional bonus gift card after the
ElligibleBonusAmount field’s threshold is reached. In the Figure EMC Content
Module - Imported SVSHostSettings.svs File (above), because the eligible bonus
amount is set to 50.00, when a customer purchases a 50.00 gift card, they are
eligible to receive an additional bonus gift card amount as configured in the
subsequent IssueBonusAmount field (this amount is 10.00 as shown in the same
figure).

• IssueBonusAmount: This field establishes the amount of the bonus gift card
that is issued when customers meet the configured bonus gift card threshold
amount. This amount must match what SVS has configured.

• MaxLimitToIssueBonusGC: This field establishes the maximum amount
customers are eligible for earning additional bonus gift cards. In other words, if
this value is set to 200.00, customers are limited to earning four 50.00 gift cards
(for a total of 200.00), thus earning four bonus gift cards (worth 10.00 each for a
total value of 40.00).

11. Add the SVSBonusCard.svs configuration file.

a. Import the SVSBonusCard.svs.xml file available in the [Drive
Letter]:\MICROS\Simphony2\EMCClient folder.

b. To assist the system with identifying gift cards (for both magnetically swiped and
manually entered cards), enter your issued gift cards preamble numbers in the value
field. Scroll down to the preamble section (near row 190) and edit the rows beginning
with preamble. You must determine how many preamble digits you want to enter.
Oracle Food and Beverage recommends entering a range from 10 to 17 digits.

c. Enter the number of digits you entered in the value field in the count field. The
number of digits entered in the value field must match the number entered in the
count field.
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Figure 48-14    EMC Content Module - Imported SVSBonusCard.svs File
Preamble Settings

d. Bonus card transactions are primarily handled based on the assigned
discount. Modify the configuration file with the appropriate service charge and
discount record numbers between the braces, leaving only the record number
between the Number tags.

Figure 48-15    EMC Content Module - Imported SVSBonusCard.svs File

12. Click Save.
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13. Update or reload the database on the workstation to ensure that the changes apply to the
workstation.

Updating Workstations After Configuration Changes in the Oracle MICROS
Simphony POS User Guide contains information about this process.

Creating SVS Operations Buttons
You need to add a button to POS operations for each supported SVS Processor operation to
function on the workstation. Each button needs to be set to the Function Run Extensibility
App.

The following table lists the SVS operations (button names), descriptions, and argument
strings that are used in the Page Design module. You will use this information in the
subsequent steps.

Table 48-4    SVS Operation Buttons

Operation Name Description Argument String

Authorize Authorize the use of a card for
payment. This function is used in
conjunction with Finalize.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=A
uthorize;Arg=<XProcessorArgs
transactionstate="inside" />

Cash Out Remove the remaining balance of the
gift card as a cash payment.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=C
ashout;Arg=<XProcessorArgs
transactionstate="outside" />

Finalize Use the gift card as payment. This
function is used in conjunction with
Authorize.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=F
inalize;Arg=<XProcessorArgs
suppressaccountprompt="true"
selectpendingoperation="true"
transactionstate="inside"/>

Inquire Retrieve the current balance of a gift
card.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=I
nquire

Issue Activate a non-denominated gift card. Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=I
ssue

Redeem Use the gift card as payment. Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=R
edeem;Arg=<XProcessorArgs
transactionstate="inside" /> 

Reload Add value to an active gift card via a
payment.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=R
eload

Void Cash Out Reverse a previously performed cash
out operation.

Type=DLL;AppName=XProcessor;File
Name=Micros.XProcessor.dll;Script=v
oid_cashout;Arg=<XProcessorArgs
transactionstate="outside" /> 

Chapter 48
Stored Value Solutions (SVS) Processor

48-21



Table 48-4    (Cont.) SVS Operation Buttons

Operation Name Description Argument String

Void Reload Reverse a previously reloaded service
charge.

Reloaded service charge representing
the amount for reload is voided using
the void button on the screen. This
does not have String Arguments like
the above operations.

1. Select the Enterprise, property, or revenue center, click Configuration, and then
click Page Design.

2. Open the page on which to place SVS Processor buttons.

3. On the Edit tab, select the page area in which to define the SVS Processor
functions.

4. Click Button.

5. On the General subtab, in the Legend field, enter the operation name (button).

6. Select Function from the Type drop-down list.

7. Click the black arrow beneath the Type drop-down list.

8. Select Extensibility from the Type pane, select Run Extensibility App in the
Results pane, and then click OK.

9. Click inside the Arguments field (left of the black arrow). The easiest way to
complete this field for each operation name is to copy and paste the information
from the table in the Arguments String field.

Ensure that there are no spaces within the string.

10. Repeat steps 4 through 9 to create buttons for each of the SVS operations listed in
the table.

11. Click Save.

ValueLink Processor
The ValueLink Processor is an extension to the XProcessor Extension Application. It
provides access to Fiserv’s ValueLink gift card service. The processor communicates
with Fiserv’s (formerly FirstData) ValueLink Host either by Fiserv’s Secure Transport or
Frame Relay via TCP/IP.
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Figure 48-16    ValueLink Processor Data Flow

Setting up the ValueLink Processor consists of adding or modifying records in the following
EMC modules:

• Content

• Page Design

• Payments

• Service Charges

• Tender/Media

If you are an existing ValueLink customer, you can continue using your ValueLink Processor
configuration, but you must be using the latest release package, which is Version
2.10.0.9997.

Configuring the ValueLink Tender/Media Record
You must configure four tenders for use with the ValueLink Processor for gift card service.
The following table lists each Tender/Media record, and the corresponding value to select in
the Key Type field.

Table 48-5    ValueLink Processor Tender/Media Records and Key Types

Tender/Media Record Key Type

ValueLink Redeem 1 - Payment

ValueLink Cashout 3 - Pickup

ValueLink Void Cashout 4 - Loan

ValueLink Refund 1 - Payment

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a record, name it ValueLink Redeem, and then click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Repeat steps 2 through 4 to create the remaining three Tender/Media records.
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6. Click Save.

Configuring the ValueLink Service Charge Record
You must configure four service charge records for use with the ValueLink Processor
for gift card service. The services charges are:.

• ValueLink Activate

• ValueLink Batch Activate

• ValueLink Activation Return

• ValueLink Reload

1. Select the Enterprise, property, or zone, click Configuration, and then click
Service Charges.

2. Insert a record, name it ValueLink Activate, and then click OK.

3. Double-click the record to open it.

4. Select option 14 - Service Charge Used For Stored Value Transactions.

5. Set other Service Charge fields and options as needed. Configuring Service
Charges contains more information about the fields and options.

6. Click Save.

7. Repeat steps 2 through 6 to create the remaining three service charge records.

Configuring the ValueLink Processor Content Files
Before configuring the ValueLink Processor plug-in, you must ensure that the
XProcessor Extension Application is installed and configured. Setting Up the
XProcessor Framework contains more information.

The instructions in this topic explain how to add the following files to the Content
module in the EMC:

Table 48-6    ValueLink Processor Content Filenames and Descriptions

Filename Description

ValueLinkProcessor.valuelink ValueLink Processor configuration.

ValueLinkHostDefault.valuelink ValueLink Processor connection
configuration defined at the Enterprise
level, and applies to any property in the
Enterprise. This file does not require
modifications for each property.
This file and the ValueLinkHost.valuelink
file both control the connection settings
between the workstations and the
ValueLink host.

ValueLinkHost.valuelink ValueLink Processor connection
configuration defined at the Enterprise
level. Can be overridden at the property or
revenue center level with property-specific
values.
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Table 48-6    (Cont.) ValueLink Processor Content Filenames and Descriptions

Filename Description

ValueLink2Settings ValueLink2 DLL configuration.

1. Select the Enterprise level, click Setup, and then click Content.

2. Double-click the XProcessorConfiguration row in the Name column.

3. Locate the processor id=”valuelink” entry. The file includes an entry for the ValueLink
Processor as shown in the following figure:

Figure 48-17    XProcessorConfiguration Entry for ValueLink

If you are using only the ValueLink Processor for gift card service, delete the other entries
or use comment marks around them.

4. Click the insert icon

on the toolbar.

5. In the Record Name field, enter ValueLinkProcessor.valuelink, and then click OK.

Ensure that you enter the filename exactly as shown; otherwise problems may occur in
the system. Do not include the file extension (for example *.xml or *.dll) in the Record
Name field.

6. Double-click the ValueLinkProcessor.valuelink row.

7. Set the Content Type to 1 - Loose Xaml so you can see the tags in various colors,
making it easier to read.

8. Click the Import from a file link.

9. Browse to [Drive Letter]:\MICROS\Simphony2\EMCClient, select
ValueLinkProcessor.valuelink, and then click Open.

10. Edit the ValueLinkProcessor.valuelink file to include the actual Tender/Media and/or
Service Charge tags:

You must modify the imported ValueLinkProcessor.valuelink file so each applicable
<macro> entry in the file has the actual EMC record number for the respective Tender/
Media or Service Charges. Another option is to remove individual macros you do not
intend to use.

a. Scroll approximately halfway down the file to the tag macro id=”post_redeem”.
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b. Replace [payment-tender-number] and [tender-number] in two places with
the actual Tender/Media object record number for the ValueLink Processor.

c. Replace [service-charge-number] with the actual Service Charge object
record number for the ValueLink Processor.

Note:

When entering EMC record numbers for macros such as a
[payment-tender-number] or a [service-charge-number], remove
the placeholder braces, thus leaving only the record number
between the Number tags. Brace removal applies when editing all of
the imported *.xml files.

11. Click Save.

12. Click the insert icon

on the toolbar.

13. In the Record Name field, enter ValueLinkHostDefault.valuelink, and then click
OK.

14. Double-click the ValueLinkHostDefault.valuelink row.

15. Click the Import from a file link.

16. Browse to [Drive Letter]:\MICROS\Simphony2\EMCClient, select
ValueLinkHostDefault.valuelink, and then click Open.

17. Change the ValueLinkHostDefault.valuelink file to include the appropriate entries,
replacing the tags in braces with the correct information for the site.

The comments in the file explain the acceptable values.

18. Click Save.

19. Click the insert icon

on the toolbar.

20. In the Record Name field, enter ValueLinkHost.valuelink, and then click OK.

21. Double-click the ValueLinkHost.valuelink row.

22. Click the Import from a file link.

23. Browse to [Drive Letter]:\MICROS\Simphony2\EMCClient, select
ValueLinkHost.valuelink, and then click Open.

24. Scroll to the Datawire tag. If the <DID> tag is blank (all zeros), the system will
trigger the merchant registration process. After completing this registration
process, replace the <DID> tag with the new MerchantID number.

The values for <MerchantID>, <AltMerchantID>, and <TerminalID> are provided
by Datawire. The default values provided are not the actual values for these tags.

25. Click Save.
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26. Click the insert icon

on the toolbar.

27. In the Record Name field, enter ValueLink2Settings, and then click OK.

28. Double-click the ValueLink2Settings row.

29. Click the Import from a file link.

30. Browse to [Drive Letter]:\MICROS\Simphony2\EMCClient, select ValueLink2Settings,
and then click Open.

31. Change the ValueLink2Settings file if needed.

32. Click Save.

33. Update or reload your database on the workstation to ensure that the changes apply to
the workstation.

Updating Workstations After Configuration Changes in the Oracle MICROS
Simphony POS User Guide contains information about this process.

Creating ValueLink Operations Buttons
You need to add a button to POS operations for each supported ValueLink Processor
operation to function on the workstation. Each button needs to be set to the Function Run
Extensibility App.

The following table lists the ValueLink operations (button names), descriptions, and argument
strings that are used in the Page Design module. You will use this information in the
subsequent steps.

Table 48-7    ValueLink Operation Buttons

Operation Name Description Argument String

Activate Activate a gift card. type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=Activate;ar
g=<XProcessorArgs><AccountEntryRu
les title="Activate" prompt="Enter
name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>
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Table 48-7    (Cont.) ValueLink Operation Buttons

Operation Name Description Argument String

Activation on
Hold

Activate a gift card and change its
status to “On Hold” until payment is
made.

<type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=ActivateOn
Hold;arg=<XProcessorArgs><Account
EntryRules title="Activation on Hold"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Activation
Return

Reverse a gift card activation. This
function does not require access to
the original check, unlike a touch
void.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=Activation_
Return;arg=<XProcessorArgs><Accou
ntEntryRules title="Activation Return"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Authorize Authorize the use of a card for
payment. This function is used in
conjunction with Finalize

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=authorize;a
rg=<XProcessorArgs
transactionstate="inside"><AccountE
ntryRules title="Authorize"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Batch Activate Activate multiple gift cards. type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=BatchActiv
ate;arg=<XProcessorArgs><AccountE
ntryRules title="Batch Activate"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>
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Table 48-7    (Cont.) ValueLink Operation Buttons

Operation Name Description Argument String

Cash Out Remove the remaining balance of the
gift card as a cash payment.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=cashout;arg
=<XProcessorArgs
transactionstate="outside"><Account
EntryRules title="Cash Out"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Finalize Use the gift card as payment. This
function is used in conjunction with
Authorize.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=finalize;arg
=<XProcessorArgs
suppressaccountprompt="true"
selectpendingoperation="true"
transactionstate="inside"><AccountE
ntryRules title="Finalize"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Inquire Retrieve the current balance of a gift
card.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=Inquire;arg
=<XProcessorArgs><AccountEntryRul
es title="Inquire" prompt="Enter
name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>
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Table 48-7    (Cont.) ValueLink Operation Buttons

Operation Name Description Argument String

Redeem Use the gift card as payment. type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=Redeem;ar
g=<XProcessorArgs
transactionstate="inside"><AccountE
ntryRules title="Redeem"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Refund Add value to an active gift card via a
return.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=Refund;arg
=<XProcessorArgs transactionstate="i
nside"<AccountEntryRules
title="Refund" prompt="Enter name
or swipe card" entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Reload Add value to an active gift card via a
payment.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=Reload;arg
=<XProcessorArgs><AccountEntryRul
es title="Reload" prompt="Enter
name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Reload on Hold Add value to an active gift card and
change its status to “On Hold” until
payment is made.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=ReloadOnH
old;arg=<XProcessorArgs><AccountE
ntryRules title="Reload on Hold"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Chapter 48
ValueLink Processor

48-30



Table 48-7    (Cont.) ValueLink Operation Buttons

Operation Name Description Argument String

Remove on Hold
Status

Manually remove a card’s “On Hold”
status.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=RemoveOn
HoldStatus;arg=<XProcessorArgs><Ac
countEntryRules title="Remove on
Hold Status" prompt="Enter name or
swipe card" entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Void Cash Out Reverse a previously performed cash
out operation.

type=dll;appname=XProcessor;filena
me=ValueLink2.dll;script=void_casho
ut;arg=<XProcessorArgs
transactionstate="outside"><Account
EntryRules title="Void Cash Out"
prompt="Enter name or swipe card"
entrytype="String"
allowmanual="true"
allowbarcode="true"
allowmagcard="true"
allowmicrosemployeecard="false"
allowfingerprint="false"
maskentry="false"/></
XProcessorArgs>

Transaction
Cancel

Prompt a workstation operator to
void any existing gift card operations
when attempting to cancel a
transaction.

type=DLL;Appname=XProcessor;File
Name=TransCancelExt.dll;

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Open the page on which to place ValueLink Processor buttons.

3. On the Edit tab, select the page area in which to define the ValueLink Processor
functions.

4. Click Button.

5. On the General subtab, in the Legend field, enter the operation name (button).

6. Select Function from the Type drop-down list.

7. Click the black arrow beneath the Type drop-down list.

8. Select Extensibility from the Type pane, select Run Extensibility App in the Results
pane, and then click OK.

9. Click inside the Arguments field (left of the black arrow). The easiest way to complete
this field for each operation name is to copy and paste the information from the table in
the Arguments String field.

Ensure that there are no spaces within the string.
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10. Repeat steps 4 through 9 to create buttons for each of the ValueLink operations
listed in the table.

11. Click Save.

Perform DataWire Merchant Registration
If you are using the ValueLink processor plug-in, you need to perform these steps once
in POS Operations on the workstation. It is ideal if the workstation is connected to a
printer.

1. Sign in to the workstation.

2. Click the XProcessor tab, and then click the ValueLink button.

3. Click the function key for Balance Inquiry.

4. Enter any number, and then click OK. The ValueLink processor begins the
initialization, attempting to communicate with the ValueLink Host. After successful
registration, a message appears stating that ValueLink Datawire registration has
been performed. The Datawire MID, TID, and newly generated DID number
appear.

5. Print or write down the Datawire DID value as you need to update the Content
configuration file with this number.

6. In the EMC, select the Enterprise level, click Setup, and then click Content.

7. Double-click the ValueLinkHost.valuelink row.

8. Scroll to the Datawire tag, and enter the new DID number between the <DID> and
</DID> tags.

9. Click Save.

10. Update or reload your database on the workstation to ensure that the changes
apply to the workstation.

Updating Workstations After Configuration Changes in the Oracle MICROS
Simphony POS User Guide contains information about this process.
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49
Events

An event is a group of transactions that occur within a specific date and time range in one or
more revenue centers at a property. Examples of events include sporting events and games,
banquets, weddings, and receptions. Setting an event allows you to accurately track sales
and inventory, particularly when multiple events occur in a single business day (for example,
a baseball double header).

You can configure events from the EMC, update event status and associate checks with a
specific event at the POS client, view various event reports in Reporting and Analytics, import
and export event totals. You initiate events in the following ways:

• Automatically

• On a predefined schedule

• Through a call to an event service

• Using a function key on the workstation

Simphony retains all event information (including changes to events) for use in reporting and
auditing.

Configuring Event Privileges and Permissions
You can assign event privileges to employees.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, and click the EMC Modules tab.

3. For each of the following event-related items listed in the File column, select the
appropriate employee privileges (View, Edit, Add, and Delete):

• Event Types: This file controls the ability to view, change, create, and delete event
types and sub types.

• Event Areas: This file controls the ability to view, change, create, and delete event
areas.

• Event Definitions: This file controls the ability to view, change, create, and delete
events.

Setting Employee Roles contains more information about setting employee privileges.

4. To set field level permissions, click the Fields tab.

5. Select Event Definitions from the EMC Modules list.

6. For Areas and Cancel Event, select the appropriate permissions from the Access drop-
down list.

7. To set event check privileges, click the Operations tab, and then click the Transactions
subtab.
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8. Select the appropriate options for the privileges. The following table summarizes
the check privileges associated with event functionality and the recommended
roles to have the privilege set.

Table 49-1    Event Check Privileges

Option Number Privilege Name Allow the Employee
to Authorize or
Perform ...

Recommended
Roles

270 Authorize/Perform
association of a
new check to an
ended event

Creating a new
check and linking it
to a closed or ended
event

Manager

271 Authorize/Perform
override of the
"Event association
to a Check is
mandatory" option
(Control
Parameters)

Beginning a check
without linking it to
an event

Manager

9. Click the Miscellaneous subtab.

10. Select the appropriate options for the privileges. The following table summarizes
the workstation privileges associated with event functionality and the
recommended roles to have the privilege set.

Table 49-2    Event Privileges

Option Number Privilege Name Allow the Employee
to Authorize or
Perform ...

Recommended
Roles

272 Authorize/Perform
Start an Event

Starting an event Manager

273 Authorize/Perform
End an Event

Ending an event Manager

276 Authorize/Perform
Select an Event

Selecting an active
event as the
workstation
operator’s default
event

Manager

277 Allow selection of
‘No Default Area
Selected’ when
assigning default
event

Selecting a default
event without
selecting a default
area.

Manager

11. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports
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Specifying Ad Hoc Reports
You must assign privileges to the employee to run event-related reports from a workstation at
the property.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click Operations, and then click Ad Hoc Reports.

3. Select the appropriate event report privileges.

Table 49-3    Event Report Privileges

Report Privilege Description

31068 - Run Property Financial Event Report Provides information about events for each
property, total event and non-event sales for
selected dates, and outstanding (open)
checks associated with events.

31069 - Run Employee Financial Event
Report

Provides information about individual
employee performance for specific events.

31070 - Run Menu Item Sales Event Report Provides a summary of the menu item sales
by revenue center and by employee for each
event.

31071 - Run Event Financial Report Provides a summary of the daily financials
by event broken down by area.

4. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Enabling Events
You need to enable events to associate transactions with events and to use event reporting.

1. Select the property, click Setup, and then click Property Parameters.

2. Click the Options tab, and then select 51 - Enable Events Reporting.

3. Click Save.

Note:

When option 51 - Enable Events Reporting is enabled , users should expect
to be prompted for each newly opened check at point-of-sales (POS)
workstations. If Control Parameters option 67 - Association of an Event to
every Guest Check is mandatory where Event is enabled is disabled, from
the Select Check Event window, click None and then Ok to proceed with the
order. If option 67 is enabled, users are required to choose an Event, or if no
Event currently exists, users receive a No events to select message prompt.
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Related Topics

• Event Information in Reporting and Analytics Reports

Configuring Event Types and Sub Types
An employee with the event types privileges can configure event types and sub types.

1. Select the Enterprise level, click Setup, and then click Event Types.

2. Insert a record for the event (for example, Baseball Double Header or Social), and
then click OK.

3. Double-click the event record to open it in form view.

4. To create event sub types related to the event type, in the Event Sub-Types
section click Add, and then enter an event sub type name (for example, Baseball
Game 1, Baseball Game 2, or Wedding).

5. To delete an event sub-type, highlight the Event Sub-Type, and then click Delete
in the Event Sub-Types section.

6. (Optional) Select the Menu Level Link and the Sub Level Link to associate with
the event type. You must select a main menu level before you can set a sub menu
level.

When you assign main or sub levels to an event type, the event transactions at the
POS client use these menu levels rather than the default levels. This configuration
is useful when a venue and customer agree to a specific pricing level for the event
type. For example, a Happy Hour menu level can be set for an event type of
Social. This configuration allows a wedding event to apply Happy Hour prices at
the workstation, overriding default menu levels set at the revenue center level.

7. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Creating an Event
1. Select the property, click Configuration, and then click Event Definitions.

2. Insert a new record, enter a name for the event definition, and then double-click
the new record.

3. From the Event Data section, enter information in the fields as described in the
following table:

Table 49-4    Event Data Fields

Field Description

Short Code Enter an alphanumeric event code. The
application appends this code with an
automatically generated code to make
the value unique.

Type Select an event type for the event.

Sub Type Select an event sub type for the event.
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Table 49-4    (Cont.) Event Data Fields

Field Description

Event Start and Event End Select the event start and end dates.
Select Auto Start and Auto End to have
the event automatically start or end
when the Event Start or End date and
time are reached. Dates and times are
required when selecting the Auto Start
and Auto End options.
When a workstation is offline and has no
connection to the Check and Posting
Service (CAPS), events cannot start or
end (automatically and manually).

(Optional) Attendance Enter the number of people attending the
event. You can enter this number during
or after the event.

4. Click the Revenue Centers tab.

5. Select one or more revenue centers where the event occurs.

To select multiple revenue centers at once, select the revenue center group from the
RVC Groups drop-down list, and then click the Add button. All revenue centers included
in the revenue center group are automatically selected.

If the RVC Groups field is dimmed, you need to add at least one revenue center group. 
Configuring a Revenue Center Group contains more information about setting up
revenue center groups.

6. Click Save.

7. Events are set as optional by default. To set the event as mandatory:

a. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Control Parameters.

b. Select 67 - Association of an Event to every Guest Check is mandatory where
Event feature is enabled.

Setting option 67 requires workstation operators to select an event when beginning a
check.

You can override this setting for an employee from the Roles module by selecting
Transaction Control option 271 - Authorize/Perform override of the "Event
association to a Check is mandatory" option (Control Parameters). Overriding
option 67 allows the workstation operator to post transactions to no event.

c. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Configuring an Event Area
An employee with event areas privileges can set the areas within a property where events
take place. An area can be part of one or more revenue centers, or independent of revenue
centers. For example, a banking conference might be held in the banquets revenue center, in
several rooms (such as banquet bar, banquet restaurant, banquet cocktail, and ballroom).
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You can associate these room areas with the event. When the workstation operator
signs in to an event that has multiple areas, the operator must select the area in which
to work. Each transaction is associated with either one area or no area. The event
organizer can view information for each area on workstation reports and Reporting and
Analytics reports.

1. Select the property, click Configuration, and then click Event Areas.

2. Insert a new record, and then enter a name for the event area (for example,
Ballroom).

3. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Linking Events
After creating an event, you can link two or more events so that when one finishes, the
other starts (for example, a baseball double header). The linked child event (Game 2)
inherits the attributes of the parent event (Game 1), including revenue centers, event
areas, and menu levels.

1. Select the property, click Configuration, and then click Event Definitions.

2. Double-click the event record to open it in form view.

3. Click the Links tab.

4. To create a subsequent (child) event for the selected event, select Add Linked
Event, and then click Yes at the confirmation.

5. Double-click the linked event record.

6. From the Linked Event Details dialog, enter information as described in the
following table:

Table 49-5    Linked Event Details Fields

Field Description

Event Code You cannot enter a value. The application
appends the short code with an
automatically generated code to make
the event code value unique.

Short Code Enter the alphanumeric event code for
the event.

Event Name Enter a descriptive name for the event.

(Optional) Attendance Enter the number of people attending the
event. You can enter this number during
or after the event.

Event End Enter the end date and time for the
event.

7. Click the Save Changes button.

Linked events are not available in the event search list and do not appear in full in
the Event Definitions module table view.
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Related Topics

• Event Information in Reporting and Analytics Reports

Breaking Linked Events
There are two methods you can use to break the link of events, each producing a different
outcome for the events:

• Break the link between the last linked event and its parent, making the last event the
parent event

• Change a linked event to become the parent event, with subsequent events as the new
parent’s linked events

1. Select the property, click Configuration, and then click Event Definitions.

2. Double-click the event record to open it in form view.

3. Click the Links tab.

4. To break the link between the last event and its parent:

a. Click the Break Link link.

b. Click Yes at the confirmation. The last linked event in the list is removed, and it now
appears in the Event Definitions module search/table view as a parent event.

5. To change a linked event into a parent event:

a. On the Links tab, double-click the linked event record (for example, select linked
event 3 of 5) to open the Linked Event Details dialog.

b. Click the Break Link button.

c. Click Yes at the confirmation. Linked event 3 becomes a parent event, and linked
events 4 and 5 become its child linked events 1 and 2.

A linked event that has the chain broken from its parent event in the Linked Event
Details dialog is available in the Event Definitions module search/table view, and
contains any subsequent linked events as its linked events.

Related Topics

• Event Information in Reporting and Analytics Reports

Cancelling an Event
When cancelling an event, consider the following rules:

• You can only cancel an event that has the Uninitialized status.

• You can cancel a linked event if the parent event has a Started status.

• When you cancel a parent event, all linked child events are also cancelled.

• After cancelling linked events, you cannot add new linked events if you used the Break
Link function on all cancelled linked events.

1. Select the property, click Configuration, and then click Event Definitions.

2. Double-click the event record to open it in form view.

3. To cancel an event with or without linked events, click Cancel Event, and then click Yes
at the confirmation.
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4. To cancel one linked event:

a. Click the Links tab.

b. Double-click the linked event record to open the Linked Event Details.

c. Click Cancel Event, and then click Yes at the confirmation.

5. To cancel multiple linked events:

a. Click the Links tab.

b. Double-click the first linked event record to open the Linked Event Details.

c. Click Cancel Event, and then click Yes at the confirmation. The linked event
Status shows Cancelled and Add Linked Event is dimmed. The parent event is
not cancelled.

Related Topics

• Event Information in Reporting and Analytics Reports

Configuring Event Information to Print on Checks and
Receipts

You can configure the printing of an event name and code on guest check headers
and trailers, customer receipts, and credit card vouchers.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Format Parameters.

2. Click the Options tab.

3. Select the appropriate printing options:

• 59 - Print Event Name After Header on Guest Checks and Receipts:
Select this option to print the event short code and name after the header on
guest checks and customer receipts.

• 60 - Print Event Name After Trailer on Guest Checks and Receipts: Select
this option to print the event short code and name after the trailer on guest
checks and customer receipts.

4. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Creating Task Schedules
A Task Schedule is a timed task that occurs on a Check and Posting Service Host or
on a workstation. These tasks perform database-related functions that increase
performance of the device.

1. Select the Enterprise or property, click Configuration, and then click Task
Schedules.

2. Insert a new record or double-click an existing task schedule record to open it in
form view.

The database includes the following default task schedule records:
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• Purge C&P DB data older than 7 days: Cleans the Check and Posting database for
records older than seven days.

• Purge WS DB data older than 7 days: Cleans the workstation database for records
older than seven days.

• Update C&P DB Statistics: Runs an Update Statistics command on the Check and
Posting database.

• Update WS DB Statistics: Runs an Update Statistics command on the workstation
database.

The purge jobs clear check and totals information, along with message requests that are
stored in the local database.

3. From the General Settings section, enter information in the fields as described in the
following table:

Table 49-6    General Settings

Field Description

Service Type Select the type of service to receive the task,
either 7 - Workstation or 8 - Check and
Posting.

Service ID Select the service identification for which
the task runs. You can only change this value
at the property level.

Task Type Select the type of task.
When the task schedule is:
• Database purge, the database for the

selected service purges old data. The
Task Data field should indicate the
number of days to keep data in the local
database.

• Update statistics, the local database
performs an update statistics job at the
scheduled time. The Task Data field
should contain a semicolon-separated
list of database tables on which the
Update Statistics command runs.

• Run script, the Task Data field should
contain the full path to a script to
execute.

Task Data This value shows the relevant data for the
Task Type.

Duration (seconds) Enter the duration of the task.
The duration time prevents the task from
running too long. The duration time does not
cause tasks to terminate immediately. For
example, the Update Statistics job finishes
each database table listed, and then checks
the duration of the overall task.
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Table 49-6    (Cont.) General Settings

Field Description

Time Zone Select the time zone for the task, which
determines the time of day when the task
runs.
A common setting for this field is 0 - Local
Time Zone, causing the task to run in each
property based on the local time at the
property.

Schedule Type Select the recurrence frequency for the task
schedule (for example, one time, daily,
weekly, or monthly).

4. From the Duration section, select Enabled to run the task schedule at the set time.
Deselect this option if you do not want the task schedule to run.

a. In the Start date field, select the first date for the task schedule to run.

b. To end the task schedule on a specific date, select End date, and then select
the date for the task schedule to end. If the task schedule has no end date,
select No end date.

5. If you selected a recurring frequency in the Schedule Type field, click the
Recurrence tab. The available fields are based on the recurring frequency you
selected (daily, weekly, or monthly).

6. Select the appropriate day and time options for the frequency.

7. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Configuring the Event Status Bar
To allow workstation operators to see the event and check details to which sales are
posting, you need to add the event status bar to the transaction page, and configure
the event information that appears in the status bar.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the event status bar (typically the transaction
page).

3. Click the Configuration tab.

4. Select one or both of the following placement options:

• Top Status Bar

• Bottom Status Bar

5. Click the Add button in the lower area.

6. From the Add Status Bar Element dialog, select Operator Current Event Name
for each of the following POS state drop-down lists, and then click OK.

• Signed Out
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• Signed In

• In Transaction

7. Repeat Steps 5 and 6, selecting the following elements for each POS client drop-down
list:

• Operator Current Event Shortcode

• Operator Current Event Actual Start Date Time

• Operator Current Event End Date Time

• Check Current Event Name

• Check Current Event Shortcode

• Check Current Event Actual Start Date Time

• Check Current Event End Date Time

8. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Configuring the Event Buttons
To allow workstation operators to manually start and end an event, you need to add buttons
assigned to the touchscreen page.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

2. Open the page on which to place the Start Event and End Event buttons.

3. On the Edit tab, select the page area in which to define the Start Event button.

4. Click Button.

5. On the General subtab, enter the button name (for example, Start Event) in the Legend
field.

6. Select Function from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, select the type Event
Management, select the results Start Event, and then click OK.

8. Position and size the button on the page. Use the Style arrow to change the color.

9. Repeat Steps 3 through 9 to create the End Event button, selecting End Event for the
result.

10. Click Save.

Related Topics

• Event Information in Reporting and Analytics Reports

Event Information in Reporting and Analytics Reports
You can view Simphony event-related reporting information in Reporting and Analytics
version 8.5.1 and later. The event information includes event code, name, type, sub type, and
area.
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Table 49-7    Reporting and Analytics Event Reporting

Report Description

Events Summary Reports These reports provide summary
information for properties with events
enabled, and help you identify top level
areas that need improvement for
subsequent events.
The following summary reports include
event information:
• Events Today’s Operations Report
• Events Revenue Center Report
Only the Events Today’s Operations Report
enables you to drill down to more
information or investigate further by
running Detail Reports.

Detail Reports These reports help you analyze the
transaction details for specific events.
Parent and child events are shown
separately.
The following detail reports include event
information:
• Events Adjustments Detail Report
• Events Control Report
• Events Cost of Goods Sold Summary

Report
• Events Daily Discounts Report
• Events Sales Mix Summary Report
• Events Service Charges Report
• Events Taxes Report
• Events Tender Media Report
Most detail reports enable you to drill
down to more information.

Comparison Reports These reports provide information for
comparing key performance indicators
used in specific events. Comparison reports
help you analyze productivity in different
revenue centers and plan future events.
Parent and child events are shown
separately.
The following comparison reports include
event information:
• Events Daily Operations Comparison

by Revenue Center (also includes tax
information)

• Events Store and Date Comparison
Report

These reports do not enable you to drill
down to more information.
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Table 49-7    (Cont.) Reporting and Analytics Event Reporting

Report Description

Menu Engineering Reports These reports provide information to help
you analyze the menu mix, prices, and cost
of goods for specific events. Menu
engineering reports enable you to increase
event revenue by planning menus for
subsequent events using menu information
from past events. Parent and child events
are shown separately.
The following menu engineering reports
include event information:
• Events Menu Engineering Items

Summary Report
• Menu Engineering by Major and

Family Group Reports
• Events Item Groups Average Pricing

Report
• Sales Mix Summary Report
• Top Items Summary Report
Only the Menu Engineering by Major and
Family Group and Events Item Groups
Average Pricing reports enable you to drill
down to more information.

Employee Reports These reports provide information about
employee performance for specific events.
Employee reports help you to select the
most productive staff for events and
highlight training issues. Parent and child
events are shown separately.
The following employee reports include
event information:
• Employee Productivity Report
• Events Employee Financial List Report

(also includes tax information)
• Events Employee Sales Performance

Report
• Events Tip Track Summary Report
• Events Manager Control Report
• Events Employee Control Report
These reports enable you to drill down to
more information.

Events Daily Operations Summary Report This report provides a summary of the
daily operations, including tax
information, for one or more events.
This report enables you to drill down to
more information.
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Table 49-7    (Cont.) Reporting and Analytics Event Reporting

Report Description

Events Financial Report This report provides a summary of the
daily financials by event. The Events
Financial Report shows all tenders, service
charges, discounts, taxes, and void activity
per revenue center during the event.
This report enables you to drill down to
more information.

Events Consolidated Employee Financial
Report by RVC

This report shows a combined view of the
employee financials by revenue center for
each event. It also shows all tenders,
service charges, discounts, taxes, and void
activity per revenue center during the
event.
This report enables you to drill down to
more information.

Events Menu Item Report by RVC by
Employee

This report provides a summary of the
menu item sales by revenue center and by
employee for each event. The report shows
the revenue center number and name, the
employee, menu item, quantity sold, price,
sales less item discounts, taxes, and net
sales.
This report enables you to drill down to
more information.

Consolidated Events Employee Meal This report shows a combined view of the
employee meals for an event. The report
shows the revenue center, the employee
consuming the meal, the check number,
the time of the transaction, the menu items,
the price when the menu item was
ordered, taxes associated with the
transaction, net sales of the transaction,
and the employee adding the sales.
This report enables you to drill down to
more information.

Event Consolidated RVC Financial This report shows a combined view of the
revenue center financials by event. The
report shows all tenders, service charges,
discounts, taxes, net sales, voids,
transaction count, and percent of sales per
revenue center during the event.
This report enables you to drill down to
more information.

Chapter 49
Event Information in Reporting and Analytics Reports

49-14



Table 49-7    (Cont.) Reporting and Analytics Event Reporting

Report Description

KDS Reports These reports provide information to help
you analyze the sales mix and labor for
specific events. Parent and child events are
shown separately. KDS reports help to
identify problems with preparation and
service times, and improve these times for
subsequent events.
The following KDS reports include event
information:
• Events KDS Summary Report
• Events Today’s KDS Summary Report
• Speed of Service Report
These reports enable you to drill down to
more information.

Related Topics

• Configuring Event Privileges and Permissions

• Specifying Ad Hoc Reports

• Enabling Events

• Configuring Event Types and Sub Types

• Creating an Event

• Configuring an Event Area

• Linking Events

• Breaking Linked Events

• Cancelling an Event

• Configuring Event Information to Print on Checks and Receipts

• Creating Task Schedules

• Configuring the Event Status Bar

• Configuring the Event Buttons

Related Topics

• Enabling Reports in Enterprise Back Office
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50
Dining Room Tables and Seating

You can manage the dining room using Simphony with a standard table management
interface, or using the enhanced Table Management System.

Standard and Enhanced Table Management
Dining staff can manage tables in Simphony using one of the following methods:

• Standard table management interface

• Enhanced or integrated tables (available with the Table Management System)

The following table outlines the differences between the two table management methods:

Table 50-1    Differences Between Standard and Enhanced Table Management

Function Standard Tables Enhanced Tables

Accept reservations No Yes

Manage a Reservation List No Yes

Manage a Wait List No Yes

Provide wait quotes No Yes

Show table status Yes Yes

Estimate table turn times No Yes

Assign tables to sections and employees No Yes

Join and split tables No Yes

Suggest tables No Yes

Use function keys on the workstation for
bussing and transferring tables

Yes No

Interface with Oracle Hospitality Gift and
Loyalty Advanced Cloud Service

No Yes

Related Topics

• Configuring the Standard Table Management Interface

• Creating Standard Dining Tables

• Configuring the Standard Dining Table Status Set

Configuring the Standard Table Management Interface
1. Select the Enterprise level, click Setup, and then click Interfaces.

2. Insert a record for Standard Table Management, and then open it in form view.

3. From the Interface Type drop-down list, select 3 - Table Management.
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4. From the Communications Type drop-down list, select 1 - TCP.

5. In the Timeout field, enter the amount of time (in seconds) that Simphony waits for
a response from the standard table management interface before showing a
communications failure message.

6. In the Ping Frequency field, enter the amount of time (in seconds) that Simphony
pings the standard table management server (for example, every 5 seconds).

7. Click the Options tab, and then select the appropriate options as described in the
following table.

Table 50-2    Standard Table Management Interface Options

Option Description

2 - Enable Interface Log Select this option to post debug
information to the Interface log file.

5 - ON = Use 9 digits for Terminal IDs;
OFF = Use 2 digits for Terminal IDs

Select this option to transmit the entire
nine-digit workstation ID to the standard
table management system.

8 - Enable Offline Posting Select this option to allow offline posting
to the Simphony POS client.

9 - Determine Link Status Using Ping Select this option to allow the Simphony
POS client to ping the standard table
management system.

10 - ON = Use 5-digit RVC #; OFF = Use 3-
digit RVC #

Select this option to allow the standard
table management system posting
message to support a five-digit revenue
center number. (Otherwise, the posting is
limited to a three-digit revenue center
number.)

11 - ON = Use 8-digit Check #; OFF = Use
4-digit Check #

Select this option to allow the standard
table management system posting
message to support an eight-digit check
number. (Otherwise, the posting is
limited to a four-digit check number.)

8. In the TCP Host Name field, enter the name or IP address of the standard table
management server for the interface.

9. In the Port Number field, enter 0 (zero).

10. Click the Properties tab, and select each property that uses the standard table
management system interface.

11. Click the Service Host tab, and then select the service host that can run the
standard table management system interface.

12. Click Save.

13. Select the revenue center, click Setup, and then click RVC Parameters.

14. Click the Interfaces tab.

15. Select the TMS Operator to whom a check that is opened by the standard table
management system is assigned, before being picked up by a server.

16. Select the TMS User Workstation to which a check that is opened by the
standard table management system is assigned.
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17. From the TMS Link drop-down list, select the standard table management interface.

18. Click Save.

Related Topics

• Standard and Enhanced Table Management

Creating Standard Dining Tables
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Page Design.

2. Double-click the Front of House page on which to define standard dining tables.

3. On the Edit tab, select the page area on which to place the standard dining tables.

4. Select Other..., and then select Dining Table.

5. Move and adjust the table size on the page. Leave space between tables on the page
layout to ensure visibility of indicators and table state. You can increase the grid
configuration on the page from 24 (default) to 48 using the Change Grid Size link.

6. Repeat Steps 4 and 5 to create additional standard dining tables.

7. Click Save.

Related Topics

• Standard and Enhanced Table Management

Configuring the Standard Dining Table Status Set
You can configure a dining table status set to allow workstation operators to manually assign
a specific table status value from the set. For example, dining tables could be used to begin
new takeout orders. Workstation operators can update the status of the table based upon the
readiness of the order (such as Preparing, Ready, or Called Running Late).

This feature is only available with standard dining tables (not enhanced or integrated tables).

1. Select the Enterprise, property, or revenue center, click Setup, and then click Dining
Table Status Set.

2. Insert a record for the Dining Table Status Set, and then open it in form view.

3. Click Add, and then enter or select information for the fields as described in the following
table.

Table 50-3    Standard Dining Table Status Set Fields and Options

Field or Option Description

Name Enter the name of the dining table status set
(for example, waiting or eating).

Override Background Color Click the ellipsis point (...) button, select the
background color, and then click OK.

Override Text Color Click the ellipsis point (...) button, select the
text color, and then click OK.

Override Image Click the ellipsis point (...) button, select the
image, and then click OK.
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Table 50-3    (Cont.) Standard Dining Table Status Set Fields and Options

Field or Option Description

Option Bits Click the ellipsis point (...) button, select the
appropriate options, and then click OK.
• 1 - Stretch image to fill area: If you

selected an image, this option
determines the image appearance and
sizing.

• 2 - Show table #/cover count
horizontally: Select this option if you
want the table number and cover count
to appear horizontally on the table.

Default Index Enter the default status between 1 and 99.
Enter 0 (zero) if you do not want a default
table status.

Disabled Index Do not use this field.

Styling Key Enter the object key for the dining table
status.

4. Repeat Step 3 for each dining table status you want to add.

5. Click Save.

Related Topics

• Standard and Enhanced Table Management

Table Management
You can integrate dining room management, reservation list, wait list, customer
preferences and seating, and staff availability with the Simphony Table Management
System, Reservation List, and Wait List.

The Simphony Table Management System (TMS) allows you to perform the following
actions:

• Make reservations

• Maintain a Wait List

• Seat guests immediately at available tables

• Control the number of reservations allowed during specific time periods

• See an overview of enhanced dining tables and status

• Update the table status based on coursing

• Manage the seating layout with table, section, and server assignments

• Change table seating capacities

• Estimate wait quote times

Related Topics

• Table Management Configuration Levels
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Reservation List
The Reservation List contains all reservation requests for the revenue center. Hosting staff
with access to the Reservation List can create, edit, and cancel reservation requests from the
list.

Related Topics

• Configuring Reservation Privileges

• Creating the Touchscreen Reservation List

• Setting Reservation Timing Parameters

• Reservation Configuration Levels

Wait List
Often a guest arrives and asks for a table. When tables are not immediately available for
seating, the guest may request a wait time and add their name to a Wait List. The Wait List
contains all wait requests for the revenue center. The Wait List also shows reservations prior
to the scheduled arrival. Reservations appear on the Wait List a configured number of
minutes prior to the schedule seating time. Hosting staff with access to the Wait List can add,
change, and abandon wait requests from this list. Hosting staff can manage the Wait List on
its own page or as a popup in the host view.

Related Topics

• Configuring Wait List Privileges

• Creating the Touchscreen Wait List

• Setting Wait List Timing Parameters

• Wait List Configuration Levels

Table Management, Reservation, and Wait List Configuration
Prerequisites

Before configuring reservations, you must complete the following tasks:

• Configure the Simphony Table Management System (TMS)

• Configure the Simphony Wait List to accept and seat guests with reservations

If the property is using a Wait List, but does not take reservations, you only need to configure
the TMS before setting up the Wait List. (A Reservation List is not required with the Wait List.)

The Simphony TMS, Reservations, and Wait List integrate with loyalty applications such as
Oracle Hospitality Gift and Loyalty, and third party loyalty applications based on the loadable
loyalty modules. When you use Simphony TMS, Reservations, or Wait List with loyalty
applications, workstation operators can associate the loyalty account with the reservation
request or walk-in guest. After associating guest loyalty information with the table request, the
information follows the guest through the life of the guest check. To use the Simphony TMS,
Reservations, or Wait List with a loyalty application, you must configure the loadable loyalty
module. Loyalty Configuration Tasks contains more information about configuring the loyalty
module.
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Related Topics

• Table Management Configuration Levels

Related Topics

• Configuring Reservation Privileges

• Creating the Touchscreen Reservation List

• Setting Reservation Timing Parameters

• Reservation Configuration Levels

Related Topics

• Configuring Wait List Privileges

• Creating the Touchscreen Wait List

• Setting Wait List Timing Parameters

• Wait List Configuration Levels

Configuring Table Management Privileges
1. Select the Enterprise, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Guest
Management subtab.

3. Select the appropriate options for the privileges. The following table summarizes
the privileges associated with table management functionality and the
recommended roles to have the privilege set.

Table 50-4    Table Management Privileges

Tab Location Option Number Privilege Name Allows the
Employee to ...

Recommended
Roles

Guest
Management

32020 Edit Section
Layout

Edit a section
layout

Host, Manager

Guest
Management

32021 Activate
Section Layout

Activate a
defined section
layout as the
Active Layout

Host, Manager

Guest
Management

32022 Delete Section
Layout

Delete an
existing section
layout

Host, Manager

Guest
Management

32031 Assign
Employee to
Table

Assign an
employee to a
table or section
in TMS

Host, Manager

Guest
Management

32032 Mark Table
Clean or Dirty

Mark a table as
clean or dirty

Host, Manager
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Table 50-4    (Cont.) Table Management Privileges

Tab Location Option Number Privilege Name Allows the
Employee to ...

Recommended
Roles

Guest
Management

32033 Change Table
State

Mark tables as
being
Available,
Closed,
Reserved, or
Merged

Host, Manager

Guest
Management

32034 Seat
Unsuggested
Table

Seat a table
request at a
table that is
different than
the table that
was suggested
by the TMS
Table
Suggestion
System

Host, Manager

Guest
Management

32037 View Legend View the TMS
Legend and use
the available
functions
contained
within the form

Host, Manager

Guest
Management

32038 Allow Seating
Guest Above or
Below Table
Capacity

Seat a table
request at a
table that does
not support a
different
seating
capacity (other
than the cover
count on the
table seating
request)

Host, Manager

Guest
Management

32039 Allow Seating
Guest at Table
that does not
Meet all
Required Table
Preferences

Seat a table
request at a
table that does
not meet all of
the seating
preferences
defined on the
table seating
request

Host, Manager

Guest
Management

32040 Edit Server
Availability

Edit the server
availability

Host, Manager

Ad Hoc Reports 31044 Run Employee
Section
Assignment
Report

Run the
Employee
Section
Assignment
Report

Host, Manager
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Table 50-4    (Cont.) Table Management Privileges

Tab Location Option Number Privilege Name Allows the
Employee to ...

Recommended
Roles

Transactions 22 Post Payment
to Checks
Belonging to
Another
Operator

Unseat a table
request

Host, Manager

Transactions 37 Authorize/
Perform
Posting of
Payment

Unseat a table
request

Host, Manager

Transactions 38 Authorize/
Perform
Closing of
Checks with a
Zero Balance

Unseat a table
request

Host, Manager

Guest Checks 18 Authorize/
Perform Pickup
of a Check
Belonging to
Another
Operator

Unseat a table
request

Host, Manager

4. Click Save.

Configuring Reservation Privileges
1. Select the Enterprise, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Guest
Management subtab.

3. Select the appropriate options for the privileges. The following table summarizes
the privileges associated with reservation functionality and the recommended roles
to have the privilege set:

Table 50-5    Reservation Privileges

Option Number Privilege Name Allow the Employee
to ...

Recommended
Roles

32006 Greet Wait List Entry Greet a reservation
request if the party
arrives earlier than
the time at which the
reservation
automatically moves
to the Wait List

Host, Manager

32007 Mark as No Show Mark a reservation
request as a no-show
if the guest does not
arrive

Host, Manager

32010 Add Reservation
Entry

Create a reservation
request

Host, Manager
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Table 50-5    (Cont.) Reservation Privileges

Option Number Privilege Name Allow the Employee
to ...

Recommended
Roles

32011 Edit Reservation
Entry

Edit an existing
reservation request

Host, Manager

32012 Cancel Reservation
Entry

Cancel a reservation
request

Host, Manager

32013 Approve Reservation
Entry

Approve a
reservation that is
requesting a date or
time outside the
acceptable or
allowable timeframe

Host, Manager

4. Click Save.

Related Topics

• Reservation List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Reservation Configuration Levels

Configuring Wait List Privileges
1. Select the Enterprise, click Configuration, and then click Roles.

2. Select the role type, click the Operations tab, and then click the Guest Management
subtab.

3. Select the appropriate options for the privileges.

The following table summarizes the privileges associated with wait list functionality and
the recommended roles to have the privilege set:

Table 50-6    Wait List Privileges

Option Number Privilege Name Allow the Employee
to ...

Recommended Roles

32001 Add Wait List Entry Create a new Wait List
request

Host, Manager

32002 Edit Wait List Entry Edit an existing Wait
List request

Host, Manager

32003 Abandon Wait List
Entry

Abandon a Wait List
request

Host, Manager

32004 Seat Wait List Entry Seat a Wait List
request

Host, Manager

32005 Unseat Wait List Entry Unseat a Wait List
request

Host, Manager

32006 Greet Wait List Entry Greet a Wait List
request

Host, Manager
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Table 50-6    (Cont.) Wait List Privileges

Option Number Privilege Name Allow the Employee
to ...

Recommended Roles

32007 Mark as No Show Mark a reservation
request as a no-show if
the guest does not
arrive

Host, Manager

4. Click Save.

Related Topics

• Wait List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Wait List Configuration Levels

Configuring Servers for Table Management
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Employee Maintenance.

2. Search for and select the employee record.

3. In the Check Name field, enter the server’s name as you want it to appear on the
workstation. If you do not enter a Check Name, the workstation shows a blank
name.

4. Click the Operator Records subtab near the lower area of the screen.

5. In the TMS Color field, select the color to distinguish the server from other servers
on the host page, and then click OK.

Although you can set a different color for each revenue center within a property,
Oracle recommends that you use a single color for the server across the property.
If you do not set a TMS Color, the workstation shows white.

6. In the Server Efficiency field, enter 0 (zero) if you want the Simphony TMS to
ignore the server in the table suggestions.

The Table Suggestion System (within TMS) sets the Server Efficiency rating to
determine the next table recommended for seating. This rating is a value between
0 (zero) and 100, and represents the number of covers that the server can
efficiently service at one time.

7. Click Save.

Configuring Properties for Table Management
1. Select the property, click Setup, and then click Properties.

2. Highlight the property record.

3. In the Simphony Platform field, select 2 - Extensible Clients and Architecture.

4. Click Save.
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Configuring Custom Images for Table Management
You can load custom images into the Simphony application to represent table seating
configuration and statuses. The TMS uses both custom images and images packaged with
Simphony. All images are transparent Portable Network Graphics (PNG) files.

Table images show a graphical representation of the table and chairs. These images can be
a square or round table surrounded by any number of chairs.

Table decorators show a graphical representation of the table status (for example, dirty,
closed, or reserved).

1. Select the Enterprise, property, or revenue center, click Setup, and then click Content.

2. Double-click the content name row to view the image set for that name.

3. Click the Import from a file link to import custom images.

4. Browse to the file location, select the image file, and then click Open.

5. Repeat Steps 2 through 4 to import each table image and table decorator.

6. Click Save.

Configuring KDS or Dining Course Colors and Images for Table
Management

You can set a color or image to indicate the KDS or dining course that the table is being
serviced under.

1. Select the Enterprise or property, click Descriptors, and then click KDS/Dining Course.

2. Insert dining course records if they do not exist.

3. In the Course Color field, select a color for each dining course name.

This color appears as the dining course indicator on the table image in the workstation.
For example, appetizers can be green, entrées can be yellow, and desserts can be red.

4. (Optional) From the Course Image Name field, select a the course decorator image to
represent the dining course (in place of a course color). The image you select replaces
the default Occupied image on the table. To remove a Course Image that was previously
set, select 0 - None, and then click OK.

5. Click Save.

Configuring Dining Course Pacing
You can set the pace at which Simphony sends dining courses to the kitchen. This feature
only works for menu items that have KDS prep times configured.

1. In the EMC, select the Enterprise, or property, click Descriptors, and then click KDS/
Dining Course.

2. Insert a dining course record if it does not exist, and then enter the following information:

• Initial Course Min Prep Time: Enter the target done time for the course.
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For example, if you enter 10 minutes and an item with a prep time of 6 minutes
is sent to the kitchen, it will not fire to Prep Stations until 4 minutes have
elapsed. If an item with a prep time of more than 10 minutes or without any
prep time is sent to the kitchen, it will fire immediately. The timer for the next
course does not start until this time is exceeded.

• Min Prep Time: Enter the minimum amount of time that the KDS Controller
should wait before sending the next course to the kitchen after the current
course is bumped from all Prep Stations. This option is not applicable to the
first dining course.

• Max Prep Time: Enter the maximum amount of time that the KDS Controller
should wait before sending the next course to the kitchen after the current
course is bumped from all Prep Stations.

3. Click Save.

Configuring the Service Total Tender for Table Management
You can configure a unique service total tender media record to process seating and
unseating of guests.

1. Select the Enterprise, click Configuration, and then click Tender/Media.

2. Create a tender media record, and then name it TMS.

3. Double-click the record to open it.

4. From the Key Type drop-down list, select 2 - Service Total.

5. Click Save.

Enhanced Dining Tables
Complete the following tasks to set up enhanced dining tables:

• Set Dining Table Classes

• Set Enhanced Dining Table Attributes

• Configure Enhanced Tables

Related Topics

• Setting Dining Table Classes

• Setting Enhanced Dining Table Attributes

• Configuring Enhanced Dining Tables

Setting Dining Table Classes
You can group and configure similar tables into a dining table class.

1. Select the Enterprise, property, or revenue center, click Setup, and then click
Dining Table Class.

2. Insert a dining table class.

3. Select or enter information for the following fields.
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Table 50-7    Dining Table Class Fields

Field Description

Name Enter the name of the dining table class. The name
identifies the class (for example, 2 Tops, 4 Tops, and so on).

(Optional) Default Background
Color

Select a background color to represent the table. Select a
different color than the page background so as not to blend
similar colors.
If you associate a transparent table image with the dining
table class, the background color appears with the image.
If you select 0 - None, the application shows the table
image and background color of the page.

(Optional) Default Text Color Select the text color to represent the table number or
name. Select a different color than the page background so
as not to blend similar colors.
If you select 0 - None, the application shows the default
text color of black.

(Optional) Default Image Select the image to represent the table.

Minimum Covers Enter the lowest number of covers that the dining table
class can accommodate (for example, a 2-Top can
accommodate a minimum of 1 person).

Maximum Covers Enter the largest number of covers that the dining table
class can accommodate (for example, a 2-Top can
accommodate a maximum of 2 people).
You can overlap covers to seat a specific cover count
within one or more dining table classes (for example, 4
covers on a 4-Top or 6-Top).

Options If you are using enhanced dining tables within the dining
table class, select 1 - Enhanced Dining Table. If you are
using legacy standard tables, deselect Enhancement Dining
Table.

4. Click Save.

Related Topics

• Enhanced Dining Tables

Setting Enhanced Dining Table Attributes
You can set characteristics of the table for use in the table suggestion process.

1. Select the property, click Setup, and then click TMS Table Attributes.

2. Select or enter information for the following fields.

Table 50-8    TMS Table Attributes Fields

Field Description

Name Enter the name of the attribute,
characteristic, or guest preference
associated with a table (for example,
Accessible, Window Seats, City View, Ocean
View, or Booth).
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Table 50-8    (Cont.) TMS Table Attributes Fields

Field Description

Code Enter the attribute code associated with a
guest preference in the request (for
example, ADA, WIND, CITY, OCN, or BTH).

(Optional) Is Exclusive Select this option if the table attributes must
be met before being included in table
seating suggestions. For example, the
Accessible attribute is exclusive.

3. Click Save.

Related Topics

• Enhanced Dining Tables

Configuring Enhanced Dining Tables
Dining tables represent the physical location where a party can be seated with a Quick
Seating operation or from the Wait List.

1. Select the property, click Setup, and then click Tables.

2. Select or enter information for the following fields.

Table 50-9    Tables Fields

Field Description

Table Number (# symbol) Enter a unique table number for all
revenue centers within the property. The
Table Number appears on the
workstation and represents the internal
number used to distinguish one table
from another within the property.

Name Enter a unique table name for all
revenue centers within the property. The
table name appears on the workstation
and represents the local facing name or
number used to differentiate the table
from others. Values in the Name field can
be:
• All numeric
• All alpha
• Alpha and then numeric
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Table 50-9    (Cont.) Tables Fields

Field Description

Class Select the dining table class. The dining
table class defines the type of table. All
instances of this table number use the
color, image, and cover configurations
defined for the selected dining table
class.
Create only tables that are to be used for
seating within a revenue center. Creating
non-seatable tables (such as bar tabs)
prevents the table suggestion system
from properly distributing tables.
Do not delete tables unless you no longer
need them for reports. Oracle Hospitality
recommends that you assign tables that
are not used to a dining table class
named to indicate this status. For
example, create a dining table class
named NOT IN USE and assign unused
tables to this class. Tables assigned to the
NOT IN USE class cannot be used for
seating, but remain in the Simphony TMS
for reporting purposes.

Table Attributes Click the Add link to associate one or
more attributes with a table. When you
set attributes, the application matches
guest preferences with tables. For
example, when a guest prefers window
seats, tables associated with a window
seating attribute move up in the table
suggestion process.

Mergeable Tables Click the Add link to add the tables that
workstation operators can select for
merging with the selected table.
Click the Delete link to remove tables
from the mergeable table assignment.
Select None in the record or leave the
Mergeable Tables section empty to
indicate that the selected table has no
merge restrictions and it can be merged
with any table.

3. Click Save.

Related Topics

• Enhanced Dining Tables

Setting Table Decorator Images
1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS

Parameters.

2. (Optional) Click the link next to each Dining Table Decoration Image Name to view a list
of images (set as custom images).
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Dining table images are optional but useful as part of daily table management
operations. Configuring Custom Images for Table Management contains more
information about setting custom images.

3. Select an image to represent each of the following statuses:

Table 50-10    Dining Table Decoration Images

Table Status Description

Select The application uses this decorator when
a workstation operator selects one or
more tables. Table selection is only
available on a page with the Host
Command Area. Table selection allows
the workstation operator to apply a
specific action to the selected tables.

Dirty The application uses this decorator when
a table is in a status of Dirty. Workstation
operators can still seat guests at dirty
tables.

Seated The application uses this decorator when
a guest is newly seated at a table. This
status remains until the guest places an
order. After placing an order, the table
status changes to Occupied.

Occupied The application uses this decorator after
a guest places an order at the table. This
status remains until the guest tenders the
check.
The image associated with the Occupied
status is overridden when you set images
for dining courses.
Configuring KDS or Dining Course Colors
and Images for Table Management contains
more information about setting dining
course images.

Printed The application uses this decorator when
the workstation operator prints the guest
check. The table is considered occupied,
and the Printed status appears in
addition to the Occupied status.

Paid The application uses this decorator after
a guest completes the dining experience
and tenders the check. This status
remains for the duration of time set in
the Auto Reset Paid Status (Minutes)
field. Host staff can seat new guests at
tables marked as Paid. After a host seats
a guest at a Paid table, the table status
resets.

Parent The application uses this decorator to
identify the table as the parent table in a
merged table grouping. This status
appears in addition to the other status
indicators.
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Table 50-10    (Cont.) Dining Table Decoration Images

Table Status Description

Child The application uses this decorator to
identify the table as the child table in a
merged table grouping. This decorator
includes a text overlay that identifies the
child’s parent table number and name.
The application clears both Parent and
Child decorators when the workstation
operator removes the merged table
grouping.

Closed The application uses this decorator to
indicate a status of Closed. Host staff
cannot seat guests at closed tables.

Reserved The application uses this decorator to
indicate a status of Reserved. The Table
Suggestion process does not consider
reserved tables for seating.

User Suggested The application uses this decorator to
identify the table as the host staff
recommended seating placement for the
highlighted table request on the Wait
List.

System Suggested The application uses this decorator to
identify the table as the system
recommended seating placement for the
highlighted table request on the Wait
List.

Highlighted Do not use this decorator.

Host Area This image is not a table decorator, but
an optional image placement for the Host
Command Area. You can use this image
to place the restaurant logo on the host
page.

4. Click Save.

Configuring Server and Table Availability
1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS

Parameters.

2. Click the Configuration tab, and then click the Table Suggestion subtab.

3. In the Default Server Available Time (Minutes) field, enter the default number of
minutes to use when making a server unavailable in the TMS. You can set this to a
duration between 1 and 480 minutes.

4. In the Auto Reset Paid Status (Minutes) field, enter the number of minutes that the
table decorator shows as paid on the host page before returning to an available status.
You can define a buffer of time between when the table service moves from tendered,
cleaned, and available for a new seating. Setting a value of 0 (zero) or blank defaults the
time to 1 minute.

5. Click Save.
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Setting Table Management Options
1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS

Parameters.

2. On the Configuration tab, select Enable Table Management to turn on TMS
functions in Simphony.

Select this option only for properties and revenue centers that use the TMS
features. This option increases workstation resources and communications
bandwidth for the Enterprise.

3. If you are using a loyalty program to look up and process transactions, select the
Loyalty Module ID from the drop-down list. If you are not using a loyalty program,
select None.

4. Select the appropriate TMS Options in the lower area of the screen. The following
table describes the options.

Table 50-11    TMS Options

Option Description

Close Unassigned Tables on Section
Layout Activation

Select this option to automatically close
tables that are not assigned to a section
when a workstation operator activates a
section layout.

Allow Multiple Loyalty Accounts per
Guest Check

Select this option to allow the
workstation operator to associate
additional loyalty accounts with the
guest check by selecting seats. Deselect
this option to limit one loyalty account
per guest check.
This option determines whether the
workstation operator can associate
multiple loyalty accounts with a guest
check.

Enable Guest Information Chit Printing Select this option to print a chit when the
host staff seats the table request.

Update Table On KDS Bump Event Select this option to update the KDS or
dining course on the table image after
the workstation operator bumps the
menu from the KDS. Deselect this option
to update the KDS or dining course on
the table image after the workstation
operator performs a service total.
Select this option only when the property
or revenue center uses a Kitchen Display
System (KDS). This option determines
when the dining course updates on the
host page table image.

Prompt for Employee on Unassigned
Table

Select this option to have the workstation
operator assign a server during seating.
This option determines whether the host
staff can seat a table without a server
assignment.
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Table 50-11    (Cont.) TMS Options

Option Description

Enable Seating Of Unavailable Tables Select this option to allow the host staff
to seat guests at a table defined as
unavailable (including Closed, Dirty, and
Reserved).

Ignore Cover Count Select this option to maintain a valid
cover count for the seating record while
incrementing the guest count from 0
(zero) to a number based on the menu
items ordered (entrée count).
This option determines the initial guest
count set on the guest check when the
host staff seats the table request. Select
this option if you do not want the cover
count shown on the guest check; instead
the application relies on guest check
configuration to determine the guest
count value. Deselect this option to have
the cover count set on the table request
and provided to the guest check as the
initial guest count.
When you select Ignore Cover Count,
you must also deselect the option Use
Number of Seats for Guest Count from
the RVC Parameters module.

Enable Edit Seating Capacity Select this option to allow the
workstation operator to change the
seating capacity of a table from its
configured number of seats.

Set Seating Capacity on Table Merge Select this option to have the workstation
operator enter the new number of seats
for a table when merging tables.

Enable Create and Edit buttons on Wait
List and Reservation List Screens

Select this option to show the Create and
Edit buttons on the POS client Wait List
and Reservation List screens. The
workstation operator can click the
buttons in the POS client (rather than
double-tap the Reservation List or Wait
List).
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Table 50-11    (Cont.) TMS Options

Option Description

Enable Offline Reservations Select this option to allow workstation
operators to create reservations when
connectivity to the Table Management
Service is not available. This is primarily
used at properties when the host
workstations are unable to access the
service but want to create reservations.
Setting this option does not restrict the
workstation operator’s ability to add
records to the Wait List.
When you enable offline reservations,
the potential to overbook seating
increases as the reservations are not
recorded to a single destination. After the
application re-establishes connectivity to
the service, the application reports
offline reservations to the service. If the
remaining inventory becomes zero, the
offline reservations being reported to the
service are removed without notification.
In cases where more than one source of
reservations are defined (for example,
multiple hosting workstations or online
reservations), Oracle Hospitality
discourages use of this option. Oracle
Hospitality recommends that you disable
offline reservations.

5. Click Save.

Configuring Table Suggestion Factors
The Table Suggestion process uses several optional factors to determine the next
parties to seat, and the tables that the TMS suggests for seating. Although the table
suggestion factors all work together, Oracle Hospitality recommends that you use only
a few factors initially to become accustomed to how the listing and suggestion process
works for the property.

1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS
Parameters.

2. Click the Table Suggestion tab.

3. Use the arrow buttons to move and rank the suggestion factors. The factor order
alters the table suggestion calculations.

Table 50-12    Table Suggestion Factors

Table Suggestion Factor Places a Greater Value On ...

Reservation Waiting Reservations that have been waiting
longer than other requests in the seating
order
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Table 50-12    (Cont.) Table Suggestion Factors

Table Suggestion Factor Places a Greater Value On ...

Waiting Past Quote Reservation or walk-in requests where
the request has been waiting longer than
their scheduled seating time or quoted
wait time

Reservation Waiting Past Quote Reservation requests where the request
has been waiting longer than the
scheduled seating time

Reservation Greeted Reservation requests where the party
has arrived and hosting staff greeted
them

Reservation Reservation requests versus non-
reservation requests (walk-ins) in the
seating order

VIP Waiting Reservation requests where the party is
designated as a VIP and have been
waiting versus non-VIP reservation and
walk-in requests that have been waiting
in the seating order

VIP Reservation and walk-in requests where
the party is designated as a VIP in the
seating order

Table Dirty Any table marked as Dirty

Table Paid Any table marked as Paid

Server Check Count Any server based on their current
service check count (open and closed)

Server Cover Count Any server based on their current
service cover count

Server Efficiency Any server based on their Server
Efficiency Rating

Server Last Assigned Any table based on the table’s current
server assignment and the time since the
server received a new table seating

4. Click Save.

Table Management Alerts
You can set two optional types of table management alerts: Service Alerts and Check Alerts.

Service Alerts show the duration since the last service interaction (for example, guest ordered
a menu item). If you do not set Service Alerts, the table management system does not track
service intervals on the guest check.

Check Alerts show how long the guest has been seated at the table. This alert changes as
the service interaction passes defined thresholds. If you do not set Check Alerts, the table
management system only tracks the duration of time the guest check is open and does not
change the Check Alert color.

Related Topics

• Configuring Alerts
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Configuring Alerts
1. Select the revenue center, click Setup, and then click Service Alert.

2. Enter the name of the service alert as you want it to appear to the workstation
operator (for example, Recent Service, No Touch Warning, or Service Warning).

3. Set the Service Alert Time to the number of minutes since the last service total
elapses before triggering the service alert.

To start the alert immediately upon seating of the guest, set the time to 0 (zero).
The application resets the timer to 0 when the workstation operator performs a
service total with a new menu item on the guest check.

4. Select the Service Alert Color to distinguish one alert from another in the service
alert table area on the host page. Only seated tables show a service alert color.

5. Click Save.

6. Select the revenue center, click Setup, and then click Check Alert.

7. Enter the name of the check alert as you want it to appear to the workstation
operator (for example, In Service, Turn Waiting, or Turn Alert).

8. Set the Check Alert Time to the number of minutes since the check was opened
before triggering the next check alert.

To start the alert immediately upon seating of the guest, set the time to 0 (zero).
The application resets the timer to 0 when the workstation operator performs a
service total with a new menu item on the guest check. The check alert remains as
the last alert until the workstation operator closes the guest check.

9. Select the Check Alert Color to distinguish one alert from another in the check
alert table area on the host page. Only seated tables show a check alert color.

10. Click Save.

Related Topics

• Table Management Alerts

Table Management Sections
You can group tables within an area or station to indicate assignment to a specific
server. Optional seating section templates allow you to set predefined table layouts
where the application automatically assigns tables to a specific section. You can create
seating section layouts at the property level.

Related Topics

• Configuring Sections

Configuring Sections
1. Select the property, click Setup, and then click Section.

2. Enter the name of the section as you want it to appear to the workstation operator
and in reports.
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3. Select the color used to distinguish one section from another when viewing tables on the
host page.

Only tables that are assigned to a section inherit the section color.

4. Click Save.

5. Select the property, click Setup, and then click Seating Section Templates.

6. Enter the name of the section template as you want it to appear to the workstation
operator.

7. Select Add to define a table as part of the template.

a. From the new record, click the build box to view a list of tables defined for the
revenue center. Alternatively, you can enter the Table ID, and then press the Tab key.

b. Select the section from the available list or enter the Section ID.

8. Click Save.

Related Topics

• Table Management Sections

Creating the Touchscreen Reservation List
The Reservation List allows hosting staff to manage all reservation requests. Oracle
recommends that you create a Reservations List on a page for the reservation functions. You
can use the template provided in Simphony. If a property uses future reservations or multiple
dining room layouts, a Tabbed Template provides workstation operators with a smoother
means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside
within the same content area on a page in order to interact.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Double-click the page on which to place the Reservation List.

3. On the Edit tab, select the page area in which to define the reservations.

4. Click Other..., select Table Management, and then select Reservation Area.

The Reservation List contains buttons for creating future reservations. You can place the
Reservation List alone or within the Host Command Area, where hosting staff can hide
and recall it. Oracle Hospitality recommends placing the Reservation List on its own
page. After placing the reservation area, the Reservation List settings appear in two
sections:

• Reservation List Columns: The columns section allows you to set Reservation List
columns and formats that appear on the POS client. You can configure the content,
width, and order in which the columns appear on the Reservation List.

• Summary Area: The summary section allows you to set the reservation details that
appear on the POS client when a workstation operator highlights a reservation in the
Reservation List.

5. Highlight the reservation area, and then select Reservation List Columns.

6. In the Header and Detail Font Size fields, select the size of the font used to show the
reservation heading and detail.
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7. For each Reservation List column, select the Enable option if you want the column
name to appear in the POS client Reservation List, and then enter the column
width for each column.

Table 50-13    Reservation List Columns

Column Name Description

Cancel Date If a reservation is cancelled or the guest
does not arrive, this column shows the
date and time of cancellation.

Alert Icon The alert icon is always enabled and is
the first column shown in the
Reservation List. This column contains
icons to indicate status or properties of
the reservation record. Alert icons
represent the request method, VIP status,
and seating preferences.

Confirmation Number Simphony issues a confirmation number
after a workstation operator or guest
creates a reservation.

Covers This column shows the number of covers
for the reservation.

Created This column shows the date and time the
reservation was created.

Greeted This column shows the time when the
host staff greeted the guest.

Time The time is always enabled and is the
second column shown in the Reservation
List. This column shows the time when
the reservation is scheduled to be seated.

Guest Name This column shows the name in which
the reservation was created.

Pager Number Do not use this column.

Phone Number This column shows the guest’s phone
number.

Request Method This column shows an icon representing
the source of the reservation (phone or
Internet).

VIP This column shows an icon representing
the VIP flag if the guest has a VIP status.

Wait Quote Do not use this column.

8. Click the black up and down arrows in the top portion of the Reservation List
Columns section to sort and move each enabled column to the order of
appearance in the POS client Reservation List.

9. Select Summary Area.

10. Select Show Summary to show reservation details in the Reservation List when a
workstation operator highlights a reservation.

11. In the Summary Height field, enter a static height for the summary information.
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When you enter 0 (zero), the height of the summary area appears dynamically,
depending on the amount of content and details associated with the highlighted
reservation.

12. In the Label and Detail Font Size fields, select the size of the font used to show the
summary label and details.

13. For each Reservation summary field:

• Select the Enable option to show summary content in the POS client Reservation
List.

• Select the New Line option to show summary information on a new line in the POS
client Reservation List.

The information in the Summary Area is the same as the Reservation List Columns, with
the addition of the content listed in the following table.

Table 50-14    Reservation List Summary

Summary Content Description

Notes This summary option contains text included
in the Notes field of the reservation record.
This field holds up to 255 characters of text
and automatically wraps in the summary
area.

Referral Notes This summary option contains text included
in the Referral Notes field of the reservation
record. This field holds up to 255 characters
of text and automatically wraps in the
summary area.

14. Click Save.

Related Topics

• Reservation List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Reservation Configuration Levels

Creating the Touchscreen Wait List
The Wait List allows hosting staff to manage all table requests (including walk-ins and
pending reservations). Oracle Hospitality recommends that you create a Wait List on a page
for the table request functions. You can use the templates provided in Simphony. If the
property uses future reservations or multiple dining room layouts, a Tabbed Template
provides workstation operators with a smoother means to navigate between wait lists,
reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside
within the same content area on a page in order to interact.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Double-click the page on which to place the Wait List.

3. On the Edit tab, select the page area in which to define the Wait List.
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4. Click Other..., select Table Management, and then select Wait List.

The Wait List contains buttons for creating walk-in table requests. You can place
the Wait List alone or within the Host Command Area, where hosting staff can hide
and recall it. Oracle recommends creating a Wait List on the same page as the
tables to simplify the seating process. After placing the wait list, the Wait List
settings appear in two sections:

• Wait List Columns: The columns section allows you to set Wait List columns
and formats that appear on the POS client. You can configure the content,
width, and order in which the columns appear on the Wait List.

• Summary Area: The summary section allows you to set the wait list details
that appear on the POS client when a workstation operator highlights a table
request in the Wait List.

5. Highlight the Wait List, and then select Wait List Columns.

6. From the Header and the Detail fields, select the size of the font used to show the
Wait List heading and detail.

7. For each Wait List column, select the Enable option to have the column name
appear in the workstation Wait List, and then enter the column width for each
column.

Table 50-15    Wait List Columns

Column Name Description

Abandon Time Do not configure the Wait List to contain
this column.

Alert Icon The alert icon is always enabled and is
the first column shown in the Wait List.
This column contains icons to indicate
status or properties of the table request
record. Alert icons represent the quote
status, request method, VIP status, and
seating preferences.

Confirmation Number The confirmation number appears only
for table requests that originate from the
Reservation List.

Covers This column shows the number of covers
for the table request.

Created This column shows the date and time the
table request was created.

Greeted This column shows the time when the
host staff greeted the guest.

Guest Name This column shows the name for the
table request.

Pager Number This column shows the pager number for
the table request.

Phone Number This column shows the guest’s phone
number.

Request Method This column shows an icon representing
the source of the table request (walk-in,
phone-in, or Internet).
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Table 50-15    (Cont.) Wait List Columns

Column Name Description

VIP This column shows an icon representing
the VIP flag if the guest has a VIP status.

Wait Quote This column shows the estimated wait
quote time given for the table request.

8. Click the black up and down arrows in the top portion of the Wait List Columns section to
sort and move each enabled column to the order of appearance in the POS client Wait
List.

9. Select Summary Area.

10. Select Show Summary to show table request details in the Wait List when a workstation
operator highlights a table request.

11. In the Summary Height field, enter a static height for the summary information.

When you enter 0 (zero), the height of the summary area appears dynamically,
depending on the amount of content and details associated with the highlighted table
request.

12. From the Label and Detail fields, select the size of the font used to show the summary
label and details.

13. For each Wait List summary field:

• Select the Enable option to have the summary content appear in the POS client Wait
List.

• Select the New Line option to have the summary information appear on a new line in
the POS client Wait List.

The information in the Summary Area is the same as the Wait List Columns, with the
addition of the content listed in the following table.

Table 50-16    Wait List Summary

Summary Content Description

Estimated Wait Time This summary option contains the
approximate time remaining until a table
will be ready for the guest. This value differs
from the wait quote, which is a static
amount of time that the guest was quoted.
The Estimated Wait Time changes as tables
are freed up and new table seating requests
are made.

Notes This summary option contains text included
in the Notes field of the table request record.
This field holds up to 255 characters of text
and automatically wraps in the summary
area.

Referral Notes This summary option contains text included
in the Referral Notes field of the table
request record. This field holds up to 255
characters of text and automatically wraps
in the summary area.
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14. Click Save.

Related Topics

• Wait List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Wait List Configuration Levels

Touchscreen Page Table Management Tasks
Oracle Hospitality recommends that you create table management forms on a page for
the enhanced dining table functions. You can use the templates provided in Simphony.
If the property uses future reservations or multiple dining room layouts, a Tabbed
Template provides workstation operators with a smoother means to navigate between
wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must
reside within the same content area on a page in order to interact.

Creating table management operations for the touchscreen page consists of
completing the following tasks:

• Setting the Host Command Area

• Setting the Dining Table Status

• Setting Employee Lines

• Creating a Section Layout

• Creating Enhanced Dining Tables

• Setting Table Management Functions in the Guest Check Detail Area

• Creating a button for the Employee Section Assignment Report

Host Command Area
You need to place a Host Command Area on a page for hosting staff to use the
Simphony TMS operations. The Host Command Area is the primary mechanism used
to manage all hosting related functions in the TMS. This area determines the way
hosting staff:

• Enables and disables TMS functions

• Accesses TMS features

• Administers the hosting page

Related Topics

• Configuring the Host Command Area

Configuring the Host Command Area
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Page Design.

2. Double-click the page on which to define the Host Command Area.
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3. On the Edit tab, select the page area on which to place the Host Command Area. You
must place the Host Command Area in the same content area on the page as the tables
in order for the host features to function.

4. Click Other..., select Table Management, and then select Host Command Area.

Hosting staff performs a long button press on the Host Command Area to access the
TMS functions. As such, carefully consider the Host Command Area sizing and
placement to ensure that hosting staff can easily see and press this area on the POS
client.

The Host Command Area can optionally show an image in place of the silver portion of
the area. You can set the image from the TMS Parameters module as the Dining Table
Decoration Image Name. The image you select scales to the size of the Host Command
Area.

5. Click Save.

Related Topics

• Host Command Area

Dining Table Status
Dining Table Status contains information about the highlighted table and associated open
checks. Hosting staff can hide and recall the optional Dining Table Status from the Host
Command Area, as well as move the Dining Table Status on the workstation with a click,
hold, and drag motion. The sizing and placement of the Dining Table Status should not
prevent hosting staff from accessing the table images. In addition, the Dining Table Status
should be large enough so that text is legible to all hosting staff as the text size scales based
on the screen sizing.

Note:

Tax amount values are not shown on the Dining Table Status summary detail
section if the revenue center utilizing the Table Management interface is configured
to use Value Added Tax (VAT) settings.

The following figure shows an example of the Dining Table Status.
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Figure 50-1    Dining Table Status

Related Topics

• Configuring the Dining Table Status

Configuring the Dining Table Status
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Page Design.

2. Double-click the Front of House page on which to define the Dining Table Status.

3. On the Edit tab, select the page area on which to place the Dining Table Status.

Place the Dining Table Status in the same content area on the page as the Host
Command Area and tables so that hosting staff can access the functions and view
information.

4. Click Other..., select Table Management, and then select Dining Table Status.

5. Click Save.

Related Topics

• Dining Table Status

Chapter 50
Configuring the Dining Table Status

50-30



Employee Lines
Hosting staff can hide and recall the optional Employee Lines Area from the Host Command
Area. This area shows lines from the assigned tables to a text box containing the assigned
server’s name. The following figure shows an example of the Employee Lines Area.

Figure 50-2    Employee Lines Area

Related Topics

• Configuring Employee Lines

Configuring Employee Lines
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Page Design.

2. Double-click the page on which to define the Employee Lines Area. (This is the page with
enhanced table images.)

3. On the Edit tab, select the page area on which to place the Employee Lines Area.
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Place the Employee Lines Area in the same content area on the page as the Host
Command Area and tables in order for the hosting staff to access the functions
and view information.

4. Click Other..., select Table Management, and then select Employee Lines Area.

5. Adjust the size and placement of the Employee Lines Area to ensure that it covers
all enhanced tables on the page. Tables that are not covered by the Employee
Lines Area do not show server assignment lines.

6. Click Save.

Related Topics

• Employee Lines

Section Layout
The Section Layout contains controls to create and administer Seating Section
Layouts for table, section, and server assignments. Hosting staff can hide and recall
the optional Section Layout from the Host Command Area or from a separate page.
Oracle Hospitality recommends creating a Section Layout on a separate page. Hosting
staff can easily assign tables to a section when:

• Tables are present on the same page as the Section Layout.

• Tables are accessible while editing a Section Layout.

The following figure shows an example of the Section Layout.

Figure 50-3    Section Layout
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Related Topics

• Creating a Section Layout

Creating a Section Layout
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Page Design.

2. Create the page on which to define the Section Layout.

3. Click Other..., select Table Management, and then select Section Layout.

4. Adjust the Section Layout size to ensure that the text is visible to hosting staff. The text
size scales with the Section Layout size.

5. Click Save.

Related Topics

• Section Layout

Creating Enhanced Dining Tables
You can use all functions of the Simphony TMS using enhanced dining tables. You cannot
use legacy standard tables with TMS. Enhanced dining tables show overlays on the outer
edges of the table that indicate status, coursing, and alerts.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Double-click the page on which to define enhanced dining tables.

3. On the Edit tab, select the page area on which to place the enhanced dining tables.

4. Click Other..., select Table Management, and then select Dining Table (Enhanced).

5. Move and adjust the table size on the page. Leave space between tables on the page
layout to ensure visibility of indicators and table state. You can increase the grid
configuration on the page from 24 (default) to 48 using the Change Grid Size link.

6. Set the unique properties of the enhanced dining table:

a. Enter the table number in the Table # field.

This number must match the Table Number set in the Tables module. See 
Configuring Enhanced Dining Tables for more information.

b. From the Next Page/Panel section, click the black Panel arrow, and then select the
host page from the list.

c. (Optional) Enter a table number in the Legend field.

If the Legend is blank, the table number or name shown on the host page uses the
table number or name defined for the Table # field. To use a different name or
number for the table, enter an override value in the Legend field.

7. Repeat Steps 4 through 6 to create additional enhanced dining tables.

8. Click Save.

Chapter 50
Creating a Section Layout

50-33



Setting Table Management Functions in Check Detail
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Page Design.

2. Double-click the page that contains the Check Detail area.

3. Select the Check Detail area on the page.

4. Select Show Seat Number to provide the workstation operator with a visual
representation of the seat number associated with a menu item or guest on the
check detail area.

5. Select Enable Gestures to allow the workstation operator to access a menu of
options when long-pressing on the guest check.

The long-press options include:

• Change Item Seat

• Change Item Course

• View By Item Entry

• View By Seat

• View By Course

6. Select the view mode from the Initial View Mode drop-down list.

This is the view shown when the workstation operator initially sees the guest
check. Oracle recommends selecting the View By Seat mode for restaurants that
allow multiple loyalty accounts on a single guest check.

7. Click Save.

Creating the Employee Section Assignment Report Button
1. Select the Enterprise, property, or revenue center, click Configuration, and then

click Page Design.

2. Open the page on which to place the Employee Section Assignment Report
button.

3. On the Edit tab, select the page area in which to define the button.

4. Click Button.

5. Position and size the button on the page. Use the Style arrow to change the color.

6. In the Legend field, enter the button name.

7. Select Ad Hoc Report from the Type drop-down list.

8. Click the black arrow beneath the Type drop-down list, select 44 - Employee
Section Assignment Report from the report list, and then click OK.

9. Click Save.
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Configuring Table Cancellation Reasons
You can optionally create Reservation and Wait List Reasons to indicate why a guest cancels
or abandons a table request.

1. Select the Enterprise, property, or revenue center, click Descriptors, and then click TMS
Reasons.

2. Enter a reason in the Text field. You can create a maximum of 32 reasons.

3. Click Save.

Setting Reservation Timing Parameters
1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS

Parameters.

2. On the Configuration tab, enter information in the following fields:

Table 50-17    Reservation Timing Fields

Field Description

Reservation to Waitlist Delay Enter the number of minutes that a
reservation appears on the Wait List before
the scheduled seating time. Reservation
records that are visible on the Wait List
impact the quote times and table
suggestions.

Maximum Reservation Notice (Days) Enter how far in advance a reservation can
be made. This value includes the current
business day. For example, a value of 90
indicates that guests can make reservations
no more than 90 days in advance.

Minimum Reservation Notice (Minutes) Enter the amount of advanced time when
reservations can no longer be made for the
same business day. For example, a value of
30 indicates that guests cannot make
reservations less than 30 minutes in
advance.

3. Select the appropriate options for reservation functions.

Table 50-18    Reservation Options

Option Description

Require Reason Code on Abandon/Cancel Select this option to have the POS client
prompt the workstation operator to enter a
cancellation reason for the reservation
request.

Enable Reservation Approval Select this option to have the workstation
operator obtain approval when creating a
reservation outside of a date or time
available in the TMS inventory.
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Table 50-18    (Cont.) Reservation Options

Option Description

Enable Create and Edit Buttons Select this option to show Create and Edit
buttons following the Reservation List in the
POS client. When you enable the buttons, the
workstation operator can also double-tap the
screen to create or edit reservations.

4. Click Save.

Related Topics

• Reservation List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Reservation Configuration Levels

Setting Wait List Timing Parameters
1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS

Parameters.

2. On the Configuration tab, enter information in the following fields:

Table 50-19    Wait List Timing Fields

Field Description

Reservation To Waitlist Delay Enter the number of minutes that a
reservation appears on the Wait List
before the scheduled seating time.
Reservation records that are visible on
the Wait List impact the quote times and
table suggestions.

Wait Quote Interval (Minutes) Enter the wait quote time increments
(for example, every 2 minutes or 5
minutes).

Auto Abandon Wait List Delay (Minutes) Enter the number of minutes that a table
request record remains on the Wait List
before the application automatically
updates it as Abandoned (for walk-ins) or
No-Show (for reservations). The
application removes the record from the
Wait List after reaching this time
threshold.

Wait Quote Alert Threshold (Minutes) Enter the number of minutes to elapse
before flagging the table request on the
Wait List as Overdue for seating. Enter 0
(zero) to flag the table request as soon as
the time quote elapses.

3. Select the appropriate options to enable or disable wait list functions. The following
table describes the options.
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Table 50-20    Wait List Options

Option Description

Require Reason Code on Abandon/Cancel Select this option to have the POS client
prompt the workstation operator to enter a
reason for abandoning or cancelling a table
request.

Enable Wait List Chit Printing Select this option to print a chit when the
host staff creates or updates a table request.
The chit contains table request information
and the estimated wait time.

Enable Create and Edit Buttons Select this option to show Create and Edit
buttons following the Wait List in the POS
client. When you enable the buttons, the
workstation operator can also double-tap the
screen to create or edit table requests.

4. Click Save.

Related Topics

• Wait List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Wait List Configuration Levels

Reservation Periods
Optional Reservation Period settings control reservation inventory and allow walk-in table
requests. They also define projected turn times for tables based on time and cover count. If
the property does not take reservations, Oracle Hospitality recommends configuring
Reservation Periods so that hosting staff can use the Estimate Wait Quote feature on the
Wait List.

Setting Reservation Periods consists of completing the following tasks:

• Setting the reservation period timeframe

• Setting reservations intervals and covers

• Setting occupancy

• Setting seating capacity and quantity

• Setting anticipated turn times for tables

Related Topics

• Configuring Effectivity

• Configuring Acceptance Limits

• Configuring Occupancy Limits

• Configuring Seating Limits

• Configuring Target Turn Times
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Configuring Effectivity
1. Select the revenue center, click Setup, and then click Reservation Periods.

2. Insert a record with a name that describes the reservation period (for example,
Weekday or Weekend).

3. Double-click the record to open it.

4. On the Effectivity tab, select the appropriate options as described in the following
table:

Table 50-21    Effectivity

Option Description

Effectivity Start Date Select the first calendar day that the
reservation period is effective.
Deselecting the start date causes the
reservation period for the reservation
and wait lists to remain in effect
indefinitely.

Effectivity End Date Select the last calendar day that the
reservation period is effective.
Deselecting the end date causes the
reservation period for the reservation
and wait lists to remain in effect
indefinitely.

Recurrence Day Of Week Select the effective days of the week
within the reservation period. You must
select at least one day in order to save
the reservation period.

Recurrence Time Of Day Select the time of day that is effective in
the reservation period.
Deselecting the Active Start Time causes
the reservation period for the
reservation and wait lists to remain in
effect starting at 00:00:00 on the
applicable calendar days.
Deselecting the Active End Time causes
the reservation period for the
reservation and wait lists to remain in
effect until 23:59:59 on the applicable
calendar days.

5. Click Save.

Related Topics

• Reservation Periods

Configuring Acceptance Limits
Acceptance Limits define the following reservation period items:

• The interval (in minutes) in which reservations can be made
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• The maximum new covers allowed within the interval

1. Select the revenue center, click Setup, and then click Reservation Periods.

2. Open the reservation period record.

3. Click the General tab, and then click the Acceptance Limits subtab.

4. Click the Add link, and then enter information in the Acceptance Limits fields:

Table 50-22    Acceptance Limits

Field Description

Begin Time Enter the time when the defined Acceptance Cycle and Limit
begins (for example, 17:00).

End Time Enter the time when the defined Acceptance Cycle and Limit
ends (for example, 22:00).

Cycle Enter the interval in minutes when reservations can be
accepted.
The Cycle defines the frequency with which you offer new
reservations (for example, every 15 minutes or every 30
minutes) beginning with the start time.

Acceptance Limits Enter a value to limit the potential kitchen workload. Entering
60 prevents new reservations for the defined cycle after the
number of covers for all reservations in that cycle reaches or
exceeds the limit.

5. Click Save.

Related Topics

• Reservation Periods

Configuring Occupancy Limits
Occupancy Limits define the maximum number of covers allowed at any time. Occupancy
Limits are typically set by building codes based on available exits.

1. Select the revenue center, click Setup, and then click Reservation Periods.

2. Open the reservation period record.

3. Click the General tab, and then click the Occupancy Limits subtab.

4. Click the Add link.

5. Enter information in the Occupancy Limits fields:

Table 50-23    Occupancy Limits

Field Description

Begin Time Enter the time when the defined Occupancy
Limit begins.

End Time Enter the time when the defined Occupancy
Limit ends.
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Table 50-23    (Cont.) Occupancy Limits

Field Description

Occupancy Limit Enter the revenue center occupancy.
Entering 250 prevents new reservations for
the defined Acceptance Limits cycle after the
number of covers for all reservations within
that timeframe reaches or exceeds the limit.
If you do not create an Occupancy Limit, the
application uses the default value of 9999
covers.

6. Click Save.

Related Topics

• Reservation Periods

Configuring Seating Limits
Seating Limits define the number of available reservations allocated based on the
cycle defined in the Acceptance Limits and Party Size.

1. Select the revenue center, click Setup, and then click Reservation Periods.

2. Open the reservation period record.

3. Click the General tab, and then click the Seating Limits subtab.

4. Click the Add link.

5. Enter information in the Seating Limits fields:

Table 50-24    Seating Limits

Field Description

Begin Time Enter the time when the defined Seating Limit begins.

End Time Enter the time when the defined Seating Limit ends.

Capacity Enter the number of covers in the party.
The Capacity value cascades to lower values if you do not
set a lower value. For example, if you set a capacity of 4, the
cover includes requests for a party of 1 through 4. However,
setting a lower capacity of 2 applies to parties of 1 or 2, and
the capacity of 4 applies to parties of 3 or 4.

Quantity Enter the number of reservations available for the Cycles
within the timeframe.
The Quantity determines how many reservations to
allocate to accommodate the capacity between the Begin
Time and End Time for each Cycle that you set on the
Acceptance Limits tab. For example, you can allocate a
quantity of 2 reservations every 15 minutes between 5:00
p.m. and 10:00 p.m. that accommodate a cover count of 2 or
fewer.
This value only defines the number allotted and does not
represent the current inventory.

6. Click Save.
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Related Topics

• Reservation Periods

Configuring Target Turn Times
Target Turn Times define the target time from seating to request completion for a seated
party. Target Turn Times also affect the following seating-related operations:

• Prevent reservation overbooking

• Estimate wait times for walk-in table requests

• Anticipate the tables that will be available in order to distribute the table seating
appropriately

1. Select the revenue center, click Setup, and then click Reservation Periods.

2. Open the reservation period record.

3. Click the General tab, and then click the Target Turn Times subtab.

4. Click the Add link.

5. Enter information in the Target Turn Times fields:

Table 50-25    Target Turn Times

Field Description

Begin Time Enter the time when the defined Cover
Count and Target Turn Time begins.

End Time Enter the time when the defined Cover
Count and Target Turn Time ends.

Cover Count Enter the number of covers seated at the
table.
The Cover Count value cascades to lower
values if you do not set a lower value. For
example, if you set a cover count of 4, the
cover includes requests for a party of 1
through 4. However, setting a lower capacity
of 2 applies to parties of 1 or 2, and the
capacity of 4 applies to parties of 3 or 4.

Minutes Enter the anticipated turn time (in minutes)
for a table seating of the defined Cover
Count during the specified timeframe. If you
do not create a Target Turn Time, the
application uses the default value of 60.
For example, if you enter 45, table seatings
that encompass the defined cover count
during the timeframe assume the seating
request is 45 minutes in duration.

6. Click Save.

Related Topics

• Reservation Periods
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Table Management Configuration Levels
The following table shows the hierarchy levels within the EMC that allow you to
configure table management operations.

Table 50-26    Table Management Configuration Levels

Configuration
Module

Enterprise Property Revenue Center Zone

Content X X X X

Dining Table
Classes

X X X

Employee
Maintenance

X X X

TMS Parameters X X X X

TMS Privileges X

Reservation
Periods

X

TMS Table
Attributes

X X X

KDS/Dining
Course Colors

X X X

Loyalty Module X X X X

Page Design X X X X

Properties X

Seating Section
Templates

X

Sections X

Tables X

Related Topics

• Table Management

• Table Management, Reservation, and Wait List Configuration Prerequisites

Reservation Configuration Levels
The following table shows the hierarchy levels within the EMC that allow you to
configure reservation operations.

Table 50-27    Reservation Configuration Levels

Configuration
Module

Enterprise Property Revenue Center Zone

TMS Parameters X X X X
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Table 50-27    (Cont.) Reservation Configuration Levels

Configuration
Module

Enterprise Property Revenue Center Zone

TMS Reasons X X X X

Reservation
Periods

X

TMS Table
Attributes

X X X

Loyalty Module X X X X

Page Design X X X X

Related Topics

• Reservation List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Configuring Reservation Privileges

• Creating the Touchscreen Reservation List

• Setting Reservation Timing Parameters

Wait List Configuration Levels
The following table shows the hierarchy levels within the EMC that allow you to configure wait
list operations.

Table 50-28    Wait List Configuration Levels

Configuration
Module

Enterprise Property Revenue Center Zone

TMS Parameters X X X X

TMS Reasons X X X X

Reservation
Periods

X

Wait Quote
Configuration

X

TMS Table
Attributes

X X X

Loyalty Module X X X X

Page Design X X X X

Related Topics

• Wait List

• Table Management, Reservation, and Wait List Configuration Prerequisites

• Configuring Wait List Privileges
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• Creating the Touchscreen Wait List

• Setting Wait List Timing Parameters
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51
Enterprise Cash Management

You can use the Enterprise Cash Management (ECM) module to track the amount of cash
located within a property. You can track the physical currency that is collected and the exact
location of funds (for example, in a till, safe, bank deposit, or server bank). ECM follows
currency as it progresses through the following phases:

• Enters the building (for example, cash tender, paid-in, or change order received from the
bank)

• Moves through the building (for example, from tills to a safe or bank deposit)

• Leaves the building (for example, paid out to a vendor, change given to a guest, or taken
to a bank for deposit)

As money flows through the operation, ECM logs all currency actions for reporting and
auditing purposes.

Configuring Data Retention Limits
Database administrators can set the length of time data (for example, ECM and Reporting
and Analytics aggregation) remains present in the database at the Enterprise and property
levels.

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the Miscellaneous tab.

3. To set data retention limits, in the Purging section, enter the Days To Keep for the Purge
Type.

This is the number of days from the time a transaction is reported to the enterprise that
the application retains it for use in reporting and auditing (for example, from 1 day to 999
days). After the number of days to keep expires, a scheduled event purges the data. By
default, the purging jobs purge 1000 records per batch.

• To set ECM data retention, enter the number of days for ECM Transaction Detail.

• To change the PC Autosequences data retention, enter the number of days for the
Pcasequence Log.

Oracle recommends that you leave the default value set at 90 days, and that a
subject matter expert change this setting if necessary. The Pcasequence Log Purge
Type is available in Simphony version 2.10 and later and is compatible with
Reporting and Analytics version 9.0 Patch 8 and later.

4. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels
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Specifying Ad Hoc Reports
You must assign privileges to the employee to run specific property reports related to
active receptacle sessions at the property.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type, click Operations, click Ad Hoc Reports, and then click
Report Options.

3. Select the appropriate ECM reports.

Table 51-1    ECM Reports

Report Description

Run Till Report Provides information about the active till
session on the workstation to which the
workstation operator running the report
is assigned. The printed report shows
only values related to the workstation
operator’s activity.

Run Cash Pull Report Provides a list of cash pull transactions
that have been performed for the
business day.

Run Till Banking Report Provides information about all active till
sessions for the location.

Run Safes Report Provides information about all active
safe sessions for the location.

Run Paid-In/Paid-Out Report Provides information about all paid-in
and paid-out transactions that were
recorded for the business day.

Run Over/Short Detail Report Provides information about over and
short conditions that were recorded for
the business day.

Run Bank Deposits Report Provides information about all active
bank deposit sessions for the location.

Run Server Bank Report Provides information about the active
server bank session for the user running
the report.

Run Petty Cash Report Provides information about all active
petty cash sessions for the location.

Run Server Banking Report Provides information about all active
server banking sessions for the location.

Run Change Order Report Provides information about open Change
Order sessions for the property.

4. Click Save.

Related Topics

• ECM Reporting

• ECM Enterprise Information in Reporting and Analytics Reports
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• ECM Property Reports

Configuring ECM Privileges and Permissions
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type (for example, administrator, manager or server), and then click the
EMC Modules tab.

3. In the Cash Management section, select the appropriate Cash Management operation
permissions for the user role. You can grant permissions for the following actions:

• View: Open and view a Cash Management module. If you allow a user to Edit, Add,
or Delete, you must also grant View access (otherwise the user cannot open the
module).

• Edit: Update fields or records within a module.

• Add: Add records to a module. You cannot add records to the Cash Management
Class Behavior module.

• Delete: Delete records from a module. You cannot delete records from the Cash
Management Class Behavior module.

• Add Override: Override records in a module. You cannot override records in the
Cash Management Classes module.

4. Click the Operations tab, and then click the Cash Management subtab.

5. Select the appropriate options for the privileges. The following table summarizes the
privileges associated with ECM functionality and the recommended roles to have the
privilege set.

Table 51-2    ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

General
Operations

249 Change Count
Sheet

Changing the
count sheet that
the receptacle
session uses

Manager

General
Operations

250 Pull Cash A cash pull Cashier,
Manager

General
Operations

258 Threshold Level
Exception

A Cash Pull
Threshold
Exception
(bypass the
threshold
notification)
when prompted
and permitted

Manager
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Table 51-2    (Cont.) ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

General
Operations

260 View Receptacle
Session Status

Viewing of
summary
information for
all active
receptacle
sessions

Manager

General
Operations

267 Update Balance
on Count

Updating the
balance on a
count when the
amount is
outside the
count threshold
values

Manager

General
Operations

301 View Cash
Management
Dashboard

Viewing the
Cash
Management
Dashboard page

Manager

General
Operations

302 View Cash
Management
Dashboard
Detail

Viewing the till
and server bank
detail from the
Cash
Management
Dashboard page

Manager

Till Operations 201 Assign Till to
Cash Drawer

Assignment of a
till to a cash
drawer on a
workstation

Manager

Till Operations 202 Unassign Till
from Cash
Drawer

Unassignment of
a till to a cash
drawer on a
workstation

Manager

Till Operations 203 Assign User to
Till

Perform or
authorize the
assignment of an
employee to an
active till session

Manager

Till Operations 204 Unassign User
from Till

Unassignment of
an employee to
an active till
session

Manager

Till Operations 205 Count Till Counting of a till
session

Cash Handler

Till Operations 206 Adjust Till Count Adjustment of
the last count for
a till session

Manager
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Table 51-2    (Cont.) ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

Till Operations 207 Paid-In/Paid-Out Posting of an
ECM paid-in or
paid-out on a till
session
Workstation
operators can
perform
standard paid-in
and paid-out
transactions
based on
Tender/Media
configuration.

Manager

Till Operations 209 Transfer Funds Transfer of
items from a till
session to
another cash
receptacle
session

Cashier,
Manager

Till Operations 210 Deposit Funds Deposit of cash
from a till
session to a bank
deposit session

Cash Handler

Till Operations 212 Close Till Closing of a till
session

Cash Handler

Till Operations 213 Reopen Till Reopening of a
till session

Manager

Till Operations 251 Quick Start Till Opening of a till
session and
assignment of
the current
operator to a
workstation cash
drawer

Cash Handler

Till Operations 259 Adjust Till
Starting Amount

Adjustment of
the till starting
amount

Manager

Server Bank
Operations

241 Start Server
Bank

Opening of a
new server bank
session

Manager

Server Bank
Operations

242 Count Server
Bank

Counting of a
server bank
session

Manager

Server Bank
Operations

243 Adjust Server
Bank Count

Adjustment of
the last count for
a server bank
session

Manager
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Table 51-2    (Cont.) ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

Server Bank
Operations

244 Paid-In/Paid-Out Posting of an
ECM paid-in or
paid-out on a
server bank
session
Workstation
operators can
perform
standard paid-in
and paid-out
transactions
based on
Tender/Media
configuration.

Manager

Server Bank
Operations

245 Transfer Funds Transferring of
funds from a
server bank
session to
another cash
receptacle
session

Manager

Server Bank
Operations

246 Deposit Funds Deposit of cash
from a server
bank session to a
bank deposit
session

Manager

Server Bank
Operations

247 Close Server
Bank

Closing of a
server bank
session

Manager

Server Bank
Operations

248 Reopen Server
Bank

Reopening a
closed server
bank

Manager

Server Bank
Operations

265 Adjust Server
Bank Starting
Amount

Adjustment of
the server bank
session starting
amount

Manager

Server Bank
Operations

269 Consolidate
Server Banks

Consolidating
two server bank
sessions

Manager

Safe Operations 214 Open Safe Opening of a
new safe session

Manager

Safe Operations 215 Count Safe Counting of a
safe session

Manager

Safe Operations 216 Adjust Safe
Count

Adjustment of
the last count for
a safe session

Manager
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Table 51-2    (Cont.) ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

Safe Operations 217 Paid-In/Paid-Out Posting of an
ECM paid-in or
paid-out on a
safe session
Workstation
operators can
perform
standard paid-in
and paid-out
transactions
based on
Tender/Media
configuration.

Manager

Safe Operations 218 Transfer Funds Transferring of
funds from a
safe session to
another cash
receptacle
session

Manager

Safe Operations 219 Deposit Funds Deposit of cash
from a safe
session to a bank
deposit session

Manager

Safe Operations 220 Close Safe Closing of a safe
session

Manager

Safe Operations 261 Add Funds to
Safe

Adding new
funds into ECM
through a safe
receptacle

Manager

Safe Operations 262 Remove Funds
from Safe

Removing funds
from ECM
through a safe
receptacle

Manager

Petty Cash
Operations

222 Open Petty Cash Opening of a
new petty cash
session

Manager

Petty Cash
Operations

223 Count Petty Cash Counting of a
petty cash
session

Manager

Petty Cash
Operations

224 Adjust Petty Cash
Count

Adjustment of
the last petty
cash session
count

Manager
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Table 51-2    (Cont.) ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

Petty Cash
Operations

225 Paid-In/Paid-Out Posting of an
ECM paid-in or
paid-out on a
petty cash
session
Workstation
operators can
perform
standard paid-in
and paid-out
transactions
based on
Tender/Media
configuration.

Manager

Petty Cash
Operations

226 Transfer Funds Transferring of
funds from a
petty cash
session to
another cash
receptacle
session

Manager

Petty Cash
Operations

227 Deposit Funds Deposit of cash
from a petty
cash session to a
bank deposit
session

Manager

Petty Cash
Operations

228 Close Petty Cash Closing of a
petty cash
session

Manager

Bank Deposit
Operations

233 Create a Bank
Deposit

Opening of a
new bank
deposit session

Manager

Bank Deposit
Operations

234 Transfer Funds Transferring of
funds from a
bank deposit to
another cash
receptacle
session

Manager

Bank Deposit
Operations

237 Adjust Cash
Deposit

Adjustment of a
cash deposit
amount in a
bank deposit
session

Manager

Bank Deposit
Operations

239 Reconcile Bank
Deposit

Reconciliation of
a bank deposit
session

Manager

Bank Deposit
Operations

264 Adjust Bank
Deposit
Reference

Adjustment of a
reference on a
bank deposit
session

Manager
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Table 51-2    (Cont.) ECM Privileges

Section Option Number Privilege Name Allow the
Employee to
Perform or
Authorize...

Recommended
Role(s)

Change Order
Operations

230 Create Change
Order

Creation of a
new Change
Order request
from a safe
session

Manager

Change Order
Operations

232 Reconcile
Change Order

Reconciliation of
a Change Order

Manager

Change Order
Operations

252 Submit Change
Order

Submission of a
new Change
Order request
from a safe
session

Manager

Change Order
Operations

268 Save / Recall
Change Order

Saving or
recalling a
Change Order

Manager

6. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels

Allowing Users to View Blind Totals
In some cases, you can require that workstation operators view the difference between the
amount entered during a count and the amount expected by application transaction activity.
Selecting View Blind Totals allows workstation operators within the Employee Class to view
application expected values and the difference on the count sheet. When an over or short
condition exists, the workstation operator can select the reason for the variance.

1. Select the property, click Configuration, and then click Employee Classes.

2. Select the role type, and then click Operator Options.

3. Select 25 - View Blind Totals.

4. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels

Allowing Assigned Receptacle Access and Counts
ECM requires that you assign a workstation operator to a till or server bank receptacle
session to perform transactions against the session. Managers need access to work within
these receptacle sessions without being assigned to the sessions. You can create an
Employee Class for management workstation operators with a configuration set that allows

Chapter 51
Allowing Users to View Blind Totals

51-9



them to perform transactions against the till or server banking session without prior
assignment.

1. Select the property, click Configuration, and then click Employee Classes.

2. Select the role type, and then click Operator Options.

3. Select 26 - Allow Assigned Receptacle Access to:

• Allow workstation operators to view and perform transactions for till
receptacles when the operator is not the owner or an assigned user.

• Show a list of employees with closed server bank sessions that can be
reopened.

4. To prevent the workstation operator from counting a till or server bank receptacle
session more than once, select 27 - Prevent Multiple Receptacle Counts.

If the receptacle session was already counted, the workstation operator cannot
count it again immediately afterwards. However, if you select option 27, the
workstation operator can perform transactions after counting a receptacle session.

5. To prevent the workstation operator from performing more transactions after
counting a receptacle session, select option 28 - Prevent Transactions once a
Count has been Performed.

Starting with release 19.2.1, option 28 is available. Selecting 28 does not prevent
the workstation operator from adjusting a count or from transferring funds out of
the counted receptacle.

If option 27 is disabled and option 28 is enabled, the workstation operator can
perform more than one count and can perform more transactions following a
count.

6. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels

Configuring Accounting Methods for Users
You can specify the type of accounting method a workstation operator uses to track
cash management activities. The method you select determines the type of Front of
House receptacles the workstation operator can access.

1. Select the property, click Configuration, and then click Employee Classes.

2. Select the role type.

3. On the General tab, select the appropriate Cash Management Accounting
Method:

• None: Select this option to prevent the workstation operator from executing till
or server banking transactions.

• Till Banking: Select this option for workstation operators that maintain and
work from a till that is assigned to a workstation (for example, bartenders and
cashiers).

• Server Banking: Select this option for workstation operators who maintain
and work from an individual server bank on their person (for example, servers
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who are responsible for accepting payment on guest checks). This accounting
method does not allow workstation operators to perform transaction activity on a till
session when the operator is an assigned user.

4. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels

Allowing Users to Override Employee Class Options
You can optionally override Employee Class configuration options for individual workstation
operators.

1. Select the Enterprise, zone, property, or revenue center, click Configuration, and then
click Employee Maintenance.

2. Select a property and revenue center, and then click Search.

3. Select Operator Records.

4. Select Override Class Options for an employee.

5. Select the override options.

Table 51-3    Override Employee Class Options

Option Description

Options When you select Override Class Options,
the application automatically selects the
Operator Options for the employee’s revenue
center. You can override option 25 - View
Blind Totals here.

Cash Management Accounting Method When you select a Cash Management
accounting method here for an employee,
you override the accounting method set in
the Employee Class module.

Cash Drawer This option indicates the cash drawer that is
defined for the workstation operator within
the revenue center: 0 (no cash drawer
assignment, user prompted), 1, or 2. The
Quick Start till operation uses the defined
cash drawer.

6. Click Save.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels

Tracking Tender Transaction Items
You can identify tender media transaction items (for example, cash, check, and other
currency based tenders) that you want ECM to track.
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1. Select the Enterprise, zone, or property, click Configuration, and then click
Tender/Media.

2. Double-click the tender media record.

3. Click the Options tab, and then click the Ops Behavior subtab.

4. Select the appropriate Tender Media options, and then click OK.

• 4 - Use with Currency Conversion: Select this option for the foreign currency
class payment tender.

• 91 - Cash Management Transaction Item: Select this option to include the
tender record in ECM tracking and reporting.

• (Optional) 92 - Affects Cash Pull Threshold: Select this option to have
transactions performed for this tender record affect the Cash Pull Threshold
Set balance. Select this option for tender records that represent a loss if they
are lost or stolen (for example, cash and checks). You must select option 91 to
use option 92.

5. Click Save.

Tracking Service Charge Transactions
You can identify service charge transactions (for example, gift card sales) that you
want ECM to track.

1. Select the Enterprise, zone, or property, click Configuration, and then click
Service Charges.

2. Double-click the service charge.

3. Select 28 - Cash Management Transaction Item to include the service charge
record in ECM tracking and reporting.

4. Click Save.

Tracking Discount Transactions
You can identify discount transactions (for example, coupons and promotional
vouchers) that you want ECM to track.

1. Select the Enterprise, zone, or property, click Configuration, and then click
Discounts.

2. Double-click the discount.

3. Select the appropriate discount options on the General tab:

• 33 - Cash Management Transaction Item: Select this option to include the
discount record in ECM tracking and reporting.

• (Optional) 34 - Affects Cash Pull Threshold: Select this option to have
transactions performed for this discount record increase the value in a
receptacle. You must select option 33 to use option 34.

4. Click Save.
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Creating, Editing, and Deleting Cash Management Reasons
Certain ECM operations allow (and sometimes require) the workstation operator to enter a
reason for performing the operation. For example, workstation operators must provide a
reason for adjusting transactions.

1. Select the Enterprise, zone, property, or revenue center, click Descriptors, and then click
Cash Management Reasons.

2. Highlight the Cash Management transaction, and then select Add Reason.

3. Enter the reason name, based on the following guidelines:

• You can define multiple reasons for each transaction.

• You can use each reason name only once per transaction type.

When you enter a No Sale Reason, the cash drawer opens only after the workstation
operator enters a reason when performing a No Sale transaction. You can set and use
No Sale reason codes without activating ECM. You can also access No Sale reason
codes through extensibility or a System Interface Module (SIM)-based event.

4. Click Save.

5. To edit a reason, highlight the reason record, change the reason name, and then click
Save.

After you change a reason, the new reason appears when viewing historical reporting
activity.

6. To delete a reason, highlight the reason record, and then select Delete Reason.

The application allows you to delete only reasons that are not referenced in historical
reporting activity.

Related Topics

• ECM Workstation Hardware

• ECM Configuration Levels

Cash Management Classes
Beginning with Simphony version 18.1, the ECM supports multiple classes (currency and
non-currency based). Non-currency items include credit card vouchers, gift cards, and
coupons. Classes can be based on primary or alternate currencies. The Engagement console
shows multiple classes in widgets.

Reporting and Analytics version 18.1 Enterprise reports and workstation property reports
support the tracking of multiple classes. If you upgrade to Simphony version 18.1, but do not
upgrade to Reporting and Analytics version 9.0 (for example, Reporting and Analytics
remains at version 8.5.0), Enterprise reports do not show information for multiple classes, nor
do they show the correct base class.

Adding Transaction Items
You must map transaction items (for example, tenders) to the Cash Management currency
class to measure their impact (increase or decrease) on the balance of all transactions. ECM
tracks only transaction items that are mapped to the class.
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1. Select the Enterprise, zone, or property, click Setup, and then click Cash
Management Classes.

2. Insert a Cash Management class record, and then double-click it.

3. Click the Transaction Items tab.

4. Enter the name of the class to track in ECM (for example, Cash US Dollars, Cash
Canadian Dollars, Vouchers, and so on).

5. Select an available Currency from the list to associate with the Cash Management
class.

You can only associate the currency with a single class. Select 0 - None for non-
currency tracking (for example, vouchers and stored value cards) as these items
are always based on the property’s local currency.

6. Click Save.

7. Select the Enterprise, zone, property, or revenue center, click Setup, and then
click Cash Management Class Behavior.

Records are automatically created and removed in the Cash Management Class
Behavior module based on the creation and deletion of records in the Cash
Management Classes module. If you have the appropriate permission, you can
use the Cash Management Class Behavior module to customize and override the
class configuration. Configuring ECM Privileges and Permissions contains more
information about the Add Override permission.

8. Right-click a record, select Override Record, and then select one of the following:

• Use Existing Record

• Create Blank Record

9. Select Display on Status to show the currency class on the POS client
workstation when viewing the receptacle status.

The Oracle Hospitality Simphony Manager User Guide contains information on
Viewing Receptacle Status.

10. Select Add Transaction Item.

11. Select the Transaction Item Type (for example, Tender).

12. Select the Transaction Item (for example, Euro Cash).

The Cash Management Transaction Item options in the tender, service charge,
or discount determine the items that appear in the Transaction Item list. You can
use each transaction item only once per currency class.

13. Click Save.

Adding Counting Units
After you add a denomination unit to a Cash Management class, ECM includes the
unit when building Count Sheets and PAR Level Sets. The following figure shows an
example of the units mapping setup.
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Figure 51-1    Counting Units

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Cash
Management Classes.

2. Double-click a Cash Management class record.

3. Click the Counting Units tab.

4. Select Add Unit.

5. Enter the name of the unit (for example, Pennies, Fives, Twenties, Travelers Checks, and
so on).

6. If the unit has a consistent cash value (for example, notes and coins), select
Denominated. Do not select this option for transaction items that have inconsistent cash
values (for example, personal checks, credit cards, and gift cards).

7. If the unit is denominated, enter the units value relative to the base currency unit in the
Numerator field. For example, when the base currency is US dollars, the base currency
unit is 1 ($1.00).

8. If the unit is denominated, enter the number of units relative to the base currency unit in
the Denominator field. For example, when the base currency is US dollars, the base
currency unit is 1 ($1.00).

9. After you enter the numerator and denominator, the Value field shows the calculated
value per unit.

10. Click Save.

Cash Pull Threshold Set
The optional Cash Pull Threshold Set provides a group of balance-based levels to compare
against a till or server banking session during a transaction. The Cash Pull Threshold Set
indicates when notifications occur for cash pulls. These notifications minimize risk by limiting
the amount of cash circulating in the Front of House. You can add one or more threshold
levels to a Cash Pull Threshold Set. If you create a threshold based on one or more currency
classes, a cash pull notification occurs when a till or server banking session meets or
exceeds the amount of a specific currency class.
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Related Topics

• Creating, Editing, and Deleting a Cash Pull Threshold Set

Creating, Editing, and Deleting a Cash Pull Threshold Set
1. Select the Enterprise, zone, property, or revenue center, click Setup, and then

click Cash Pull Threshold Sets.

2. Insert a record, enter the name of the Cash Pull Threshold Set, and then click OK.

3. Double-click the record to open it.

4. Enter the Chit Quantity.

This is the number of chits that print when a workstation operator performs a cash
pull. A cash pull chit represents the funds that are removed from the till or server
bank.

5. Select Add, and then enter the name of the threshold set.

The name is part of the notification that appears in the application.

6. Enter the Amount.

This is the amount-based threshold (for example, 100 dollars) that elevates the
cash pull notification to the threshold level. If you configure more than one
threshold level, subsequent amounts cannot be equal to or lower than the previous
cash pull amount in the same set.

7. Select Approval to allow a workstation operator with the Threshold Level
Exception privilege to authorize the operator to ignore the exception and to
process transactions against the receptacle without performing a cash pull.

8. Click Save.

9. To edit a cash pull threshold set, highlight the record, change the values, and then
click Save.

The last (final) threshold level does not allow a threshold exception (bypass). This
requires the workstation operator to perform a cash pull first to execute additional
activities against the till or server bank later.

10. To delete a cash pull threshold set, highlight the record, and then select Delete.

You cannot delete a Cash Pull Threshold Set associated with one or more
templates.

Related Topics

• Cash Pull Threshold Set

Cash Count Threshold Set
The optional Cash Count Threshold Set provides an allowable variance threshold for
countable receptacles. This threshold is the difference between counted totals and
expected totals. The threshold indicates the overage and shortage amounts allowed to
complete a receptacle count. You can add one or more cash count threshold sets to a
count sheet. You can also configure multiple currency classes for a cash count
threshold set, and allow workstation operators to set varying thresholds against the
classes.
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Related Topics

• Creating, Editing, and Deleting a Cash Count Threshold Set

Creating, Editing, and Deleting a Cash Count Threshold Set
1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Cash

Count Threshold Sets.

2. Add a Cash Count Threshold Set, enter the name, and then click OK.

3. Enter the Short amount.

This value is the minimum variance amount allowed to complete the receptacle count.

4. Enter the Over amount.

This value is the maximum variance amount allowed to complete the receptacle count.

5. Enter the number of Max Count Attempts.

This value limits the number of times a workstation operator can attempt to submit a
count when the count is over or short beyond the defined threshold.

6. To define additional over or short amounts for each currency class, click the Add Class
link.

You cannot define multiple over or short amounts for the same primary class within a
Cash Count Threshold Set.

a. Select the Class from the drop-down list.

b. (Optional) In the Over field, enter the approved over variance amount for workstation
operators to enter for the count.

c. (Optional) In the Short field, enter the approved short variance amount for
workstation operators to enter for the count.

7. Click Save.

8. To edit a cash count threshold set, highlight the record, change the values, and then click
Save.

9. To delete a cash count threshold set, highlight the record, and then select Delete.

You cannot delete a Cash Count Threshold Set associated with one or more templates.

Related Topics

• Cash Count Threshold Set

PAR Level Set
Periodic Automatic Replenishment (PAR) Level Sets specify the suggested quantity to
maintain of each currency denomination kept in a safe (for example, rolls of coins or quantity
of a denominated note). PAR Level Sets are comprised of count units drawn from the list of
denominated items in a Cash Management class. The PAR determines the values required
when issuing a Change Order request to return the receptacle back to the PAR based on the
last known count of the receptacle. The use of a PAR Level Set is optional.

Related Topics

• Creating, Editing, and Deleting a PAR Level Set
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Creating, Editing, and Deleting a PAR Level Set
1. Select the Enterprise, zone, property, or revenue center, click Setup, and then

click PAR Level Sets.

2. Insert a record, and enter the PAR Level Set name.

3. Double-click the record to open it.

4. Select the CM Class.

The CM Class list includes all Cash Management classes that you created. These
Cash Management classes contain the units that are allowed within the PAR Level
Set.

5. Add a Counting Unit using one of the following methods:

• Select Add All Units to have ECM add all defined units for the Cash
Management class to the PAR Level.

• Select Add Unit to manually add specific units.

6. For each of the defined units, enter the quantity of units to maintain as part of the
PAR Level Set for each day of the week.

The Totals row beneath the Units table shows the cash value required for each
unit quantity and day of the week.

7. Click Save.

8. To edit a PAR Level Set, highlight the record, change the values, and then click
Save.

9. To delete a PAR Level Set, highlight the record, and then select Delete.

You cannot delete a PAR Level Set that is associated with one or more templates.

Related Topics

• PAR Level Set

Count Sheet
A Count Sheet is a custom form used to audit the contents of a safe, till, server bank,
or petty cash receptacle. A workstation operator uses a Count Sheet during the
physical counting of a receptacle session. You can configure the count to include one
of the following:

• Expected funds where variances are recorded

• A simple counting of funds where no variance is tracked (blind count)

You can create unique Count Sheets for each receptacle session to determine the
items and order in which a count is performed, as well as the format for the printed
Count Sheet results. Creating a Count Sheet is similar to building a report. You can
associate multiple classes with a Count Sheet. When you create a Count Sheet, you
define Pages, Groups, and Units.
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Pages

A Count Sheet Page is similar to a chapter in a report. Pages allow you to see totals for all
values counted within the page. For example, you can create a page for each currency class
(US Dollars, Euros, and Pounds Sterling).

Groups

Transaction Items are reported in Count Sheet groups. Groups allow you to see totals for all
values counted within the group. For example, you can create separate groups for Notes
(paper money) and Coins. Within the Notes group, you can assign the currency class (such
as Euros).

Units

A unit is optional but recommended for groups that report based on counting units. If you do
not add a unit, a Total entry appears for the group. Units define the denominations associated
with a currency. Notes, coins, traveler's checks, and gift certificates are examples of
denominated items. Personal checks and credit cards are not denominated items, because
the amount of money associated with them varies with the transaction.

The currency is used as a tender in most cases, but not always. Some tenders indicate
whether the unit has a consistent cash value. A twenty dollar bill is always worth $20.00 US.
If the unit is denominated, you must define a value relative to the base currency. For
example, if the base currency is US Dollars (US$), the following ratios can be defined:

• Twenties = 20:1 (twenty US$ per unit)

• Tens = 10:1 (ten US$ per unit)

• Quarters = 1:4 (1/4 of a US$ per unit)

• Dime Roll = 5:1 (five US$ per unit)

Related Topics

• Creating, Editing, and Deleting a Count Sheet

Creating, Editing, and Deleting a Count Sheet
1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click

Count Sheets.

2. Insert a record, enter a unique name for the Count Sheet, and then click OK.

3. To add or delete a Count Sheet Page:
a. In the Pages section, click the Add link.

b. Enter a name for each page in the Name column (for example, Cash and Vouchers).

c. To delete a page, highlight the page name record, and then click the Delete link. The
application deletes all units associated with a group for the selected page, along with
the page.

4. To add or delete a Count Sheet Group:
a. In the Pages section, highlight a page.

b. In the Groups section, click the Add link.

c. Enter a name for each group in the Name column. For example, you can have a
Cash page with the groups Notes (paper currency) and Coins.
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d. Select the Cash Management currency class for each group from the Class
drop-down list.

When you select a Class, the Name column shows the name of the class if it
was not previously entered. Change the Name value to show its
representation on the Count Sheet POS client view and chit printout.

e. Select the appropriate Options for each group:

• 1 - Allow Multiple Entries: Select this option to allow unique entry of
certain items (for example, gift cards and checks). The Group provides a
multiple entry list when performing a count. This type of count is used to
include non-denominated transaction items, such as personal checks or
gift cards as part of a count, where the amount of each individual item
must be tracked (for example, check and gift card amounts).

• 2 - Reference Required: Select this option to have the POS client prompt
the workstation operator to enter a reference on the Count Sheet (for
example, gift card number, personal check number, credit card, or voucher
number) for each amount entered. Deselect this option to skip the
reference prompt when entering non-denominated values on the count
sheet.

f. Repeat Steps 4a through 4e to add other groups to track.

g. To delete a group, highlight the group record, and then click the Delete link.
The application deletes the group and all units associated with the group.

5. Too add or delete Count Sheet Units:

a. In the Groups section, highlight a group.

b. In the Units section, click the Add link to add all units to count as part of the
group.

c. Select the Units for each group from the Units drop-down list.

Only the Unit Types associated with the Cash Management Class for the
group are available in the Units drop-down list. When you select a Units
value, the Name column shows the name of the unit selected. Change the
Name value to show its representation on the Count Sheet POS client view
and chit printout. You can use each Unit Type only once on a page.

d. To delete a unit, highlight a unit record, and then click the Delete link.

6. Click Save.

7. To sort and alter the order in which pages, groups on a page, and units within a
group appear on the Count Sheet at the POS client, use the up and down arrows.

All units that are part of the selected group remain with the group as it moves.
Units that are part of groups for the selected page remain with the page as it
moves. Groups that are part of the selected page remain with the page as it
moves.

8. To edit a Count Sheet, highlight the count sheet record, change the values, and
then click Save.

When you change a Count Sheet, the application removes all units associated
with the group.

9. To delete a Count Sheet, highlight the record, and then select Delete.

You cannot delete a Count Sheet associated with one or more templates.
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Related Topics

• Count Sheet

Creating, Editing, and Deleting an Account
You can use accounts to report general ledger accounting information for ECM paid-in and
paid-out transactions (for example, produce, meat, bakery, or flower shop).

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click
Accounts.

2. Insert a record, enter a unique name for the account, and then click OK.

3. Click the ellipsis point (...) button in the Options column.

a. Select 1 - Deactivate Account to deactivate or suspend an account that is no longer
being used. A newly created account is active by default.

b. Select 2 - Exclude on Paid In to exclude the account and associated vendors from
being used when a workstation operator performs a paid-in transaction.

c. Select 3 - Exclude on Paid Out to exclude the account and associated vendors from
being used when a workstation operator performs a paid-out transaction.

4. To edit an account, highlight the record, change the values, and then click Save.

5. To delete an account, highlight the record, and then click Delete on the toolbar.

The application only allows you to delete accounts that are not referenced in historical
reporting activity. When an account is assigned to a vendor, you cannot delete it. You can
unassign the account from the vendor.

6. Click Save.

Creating, Editing, and Deleting a Vendor
You can use a vendor to associate companies with ECM paid-in and paid-out transactions for
reporting purposes.

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click
Vendors.

2. Insert a record, enter a unique name for the vendor, and then click OK.

3. (Optional) Select an account from the Account drop-down list to associate with the
vendor.

The vendor always uses the selected account for ECM paid-in and paid-out transactions.

4. Click the ellipsis point (...) button from the Options column and select the appropriate
vendor options:

• 1 - Deactivate Vendor: Select this option to prevent further selection of the vendor
when performing transactions. For example, you can place a credit hold. A newly
created vendor is active by default.

• (Optional) 2 - Invoice Data Required: Select this option to require the workstation
operator to enter invoice information (for example, Date, Invoice Number, and
Description) when performing a transaction for the vendor that can collect invoice
data (for example, paid-out).
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• 3 - Require Reference on Use: Select this option to require the workstation
operator to enter a reference when performing a transaction that requires a
vendor.

5. To edit a vendor, highlight the record, change the values, and then click Save.

6. To delete a vendor, highlight the record, and then click Delete on the toolbar.

The application only allows you to delete vendors that are not referenced in
historical reporting activity.

7. Click Save.

Creating and Editing a Template
You need to use a template to set the initial configuration and operating values for all
new receptacle tracking sessions. This includes setting the amount, assigning a count
sheet, and specifying how the application handles the opening balance after the
workstation operator closes the receptacle. A template allows additional configuration
for specified classes or class exclusions (till and server bank receptacles only) based
on the receptacle type.

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then
click Templates.

2. Insert a template record with a unique name, and then click OK.

3. Double-click the template record to open it.

4. On the General tab, enter or select information in the following fields:

• (Optional) Description: A description provides further understanding of the
template that might not be distinguishable by looking at the template name.
The Description is not shown as part of the receptacle when the workstation
operator opens the receptacle from a template

• Receptacle Type: Depending on the type of receptacle you select, additional
fields become active. The following table describes the fields and receptacle
types.

Table 51-4    Template Receptacle Types and Fields

Field or
Option

Template Receptacle Type

Safe Till Server
Bank

Bank
Deposit

Petty Cash

Starting
Amount

Optional Optional

Starting
Amount
Source

Required Optional

Prompt for
Starting
Amount

Optional Optional

Cash Pull
Threshold

Optional Optional

Cash Pull
Destination

Optional Optional
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Table 51-4    (Cont.) Template Receptacle Types and Fields

Field or
Option

Template Receptacle Type

Safe Till Server
Bank

Bank
Deposit

Petty Cash

Count Sheet Required Required Required Required

Cash Count
Threshold

Optional Optional Optional Optional

Close on
Count
Completion

Optional Optional

PAR Level Optional

Maximum Required Required

Minimum Required

Cash
Deposit
Routing

Optional Optional

• Start Amount: The starting amount determines the initial currency value of the
session upon opening.

• Starting Amount Source: The starting amount source determines where the starting
amount for the session originates. You can specify different starting amount source
configurations for the General and Class Detail tabs (for example, if the source is a
different safe that holds only foreign currencies).

The source for a server bank session must be either an internal (House supplied) or
external (server supplied) starting amount for all defined ECM classes (not internal
and external). If you select None for a server bank, the starting amount is considered
to be part of the receptacle and funds are not transferred from a source receptacle
session. For example, a server who self funds a bank does not receive a funds
transfer from the safe when opening the bank. Selecting a defined safe transfers the
starting amount from the safe session to the receptacle session upon opening.

• Prompt for Starting Amount: Select this option to prompt the workstation operator
to enter the starting amount for the receptacle session upon opening. When you
select this option, the application ignores the value in the starting amount field. This
option is typically used for server banks where the server self-funds the bank.

• Cash Pull Threshold: This field defines the Cash Pull Threshold Set that a
receptacle session uses. If you set cash pull values, select a threshold set from the
drop-down list to be used for the template.

• Cash Pull Destination: Select a destination receptacle into which funds from cash
pull operations will transfer; if you select None, funds do not transfer and ownership
remains with the receptacle session.

• Count Sheet: The Count Sheet value in a template determines the Count Sheet that
is used to count the receptacle.

• Cash Count Threshold: This field defines the Cash Count Threshold Set that a
receptacle session uses. If you set cash count values, select a Threshold Set from
the drop-down list to be used for the template.

• Close on Count Completion: Select this option to have the application attempt to
automatically reconcile the receptacle session upon completion of the count. This
process transfers funds from the receptacle session to the sessions designated
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under Starting Amount Source and Cash Deposit Routing to bring the
session to zero. Deselect this option to leave the session open after the count
completes. The workstation operator must then manually reconcile all funds
and close the receptacle.

• PAR Level: The PAR Level defines the PAR Level Set (quantity to maintain of
each currency denomination) to use for the safe session.

• Minimum: The minimum balance determines the lowest amount of funds
permitted as part of a receptacle session. The application prevents workstation
operators from processing most activity that takes the session balance below
this amount. If you do not set a minimum balance, the application defaults to 0
(no minimum).

• Maximum: The maximum balance determines the largest amount of funds
permitted as part of a receptacle session. The application prevents workstation
operators from processing most activity that takes the session balance beyond
this amount. If you do not set a maximum balance, it defaults to 0 (no
maximum).

• Cash Deposit Routing: Select the destination receptacle (safe or bank
deposit) session to receive funds that transfer from a receptacle session as
part of a cash deposit operation. When you select None, the application
prompts the workstation operator to select a location to deposit cash.

5. Click the Class Details tab.

a. To create additional currency classes (alternate currency such as Dollar, Peso,
Euro, or Pounds, or non-currency such as gift cards) for a receptacle session
or operation, click the Add Class link.

When you configure the base currency in the Class Details tab, these settings
override the configuration set in the General tab. Use the Add Class link for
receptacle sessions and operations that have multiple cash management
classes. You can add alternate classes for bank deposit, till, server bank, and
petty cash receptacle templates only. You cannot add a duplicate class entry.

b. To remove a class, click the Delete Class link, select the class, and then click
OK.

c. To add additional PAR Levels, click the Add PAR Level link.

You can add a PAR Level for safe receptacle templates only.

d. To remove a PAR Level, click the Delete PAR Level link, select the PAR
Level, and then click OK.

6. Click the Class Exclusions tab.

a. To specify currency classes that cannot be used in till and server bank
receptacles created with the receptacle template, click the Add Class link, and
then select the class.

For example, if a till uses the template which excludes the Euros currency
class, the Count Sheet does not show the Euro page. You can exclude
classes for the till and server bank receptacle templates only. A till and server
bank receptacle accepts any currency class unless you exclude it here.

b. To remove classes from the class exclusion list, click the Delete Class link,
select the class, and then click OK.

7. To edit a template, highlight the template record, change the values, and then click
Save.
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Creating, Editing, and Deactivating Receptacles
A receptacle represents a physical or virtual location used to store funds and draw
transactions.

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click
Receptacles.

2. Insert a record, enter a unique name for the receptacle, and then click OK.

3. Double-click the receptacle record to open it.

4. Enter or select information in the receptacle fields.

• Receptacle Type: Select the type of receptacle.

• Template Name: Select the template to use for this receptacle.

• Location: Select the location where the receptacle is defined.

You can define a receptacle type that is commonly used across an Enterprise or
region without uniquely defining it at each property or revenue center. The location
allows you to specify a receptacle name and configuration to be used in multiple
locations. When you select 2 - Property, a receptacle is defined for each property
based on the values entered. When you select 3 - Revenue Center, a receptacle is
defined within each revenue center.

For example, each property might have one safe to maintain all cash transactions for
the entire property. Create a safe receptacle from the Enterprise level or zone, and
then specify the property in the Location field. The safe receptacle is defined at all
properties under the selected level.

• Options: Select Deactivate Receptacle to prevent workstation operators from
performing further activity against the receptacle.

5. To edit a receptacle, highlight the record, change the values, and then click Save.

6. To deactivate a receptacle, highlight the record, and then select Deactivate Receptacle.

Deleting a receptacle is not permitted.

7. Click Save.

Setting Cash Management Parameters
1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Cash

Management Parameters.

2. Click the Configuration tab.

3. Enter or select the appropriate information.
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Table 51-5    Cash Management Parameters Configuration Fields

Field Description

Cash Pull Notification Frequency Specify when the application notifies
workstation operators of the cash pull
threshold levels being reached or
exceeded.
• 0 - None: Select this option to disable

cash pull notifications (default).
Workstation operators can use the
manual process for cash pulls.

• 1 - On Threshold Level Only: Select
this option to notify the workstation
operator once upon reaching or
exceeding a defined threshold level
in the Threshold Level Set.

• 2 - On Each Transaction: Select this
option to notify the workstation
operator with each new check access
attempt upon reaching or exceeding
a defined threshold level in the
Threshold Level Set.

Receptacle Balancing Class Select the class that is based on the
currency in which the property operates.
All transaction items included in the
Cash Management Class selection
determine the appearance of the
receptacle balance on views and reports.

Change Order Report Count Enter the number of reports to print
when a workstation operator creates a
new Change Order request.

Counting Method Select the method in which the
workstation operator must enter
counting units when performing a count
or change order.
• 1 - Quantity: Select this option to

require the workstation operator to
enter the quantity of the counting
units. The application calculates the
value based on the quantity entered
for the associated counting unit.

• 2 - Value: Select this option to
require the workstation operator to
enter the value of the counting units.
The application calculates the
quantity based on the value entered
for the associated counting unit.

Paid-In/Paid-Out Chit Count Enter the number of chits to print when
the workstation operator performs an
ECM paid-in or paid-out transaction.

Server Banking Template Select the default template to use when a
workstation operator opens a new server
banking session. You can override this
setting from the Employee Classes
module.

4. Click the Options tab.
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5. Select the appropriate Cash Management Parameter options.

Table 51-6    Cash Management Parameter Options

Option Description

1 - Enable Cash Management Select this option to activate all ECM features
and functions in the application. Selecting
Enable Cash Management increases both
required workstation resources and
bandwidth for communications with the
Enterprise.
You can define all ECM configurations
without selecting this option. This allows you
to configure ECM beforehand and activate
ECM with a single option.

11 - Require Reason on Adjust Starting
Amount

Select this option to require the workstation
operator to select a reason code when
adjusting a starting amount.

12 - Require Reason on Adjust Count Select this option to require the workstation
operator to select a reason code when
adjusting a previously entered count.

13 - Require Reason on Adjust Cash Deposit Select this option to require the workstation
operator to select a reason code when
adjusting a cash deposit transaction.

14 - Require Reason on Paid-In Select this option to require the workstation
operator to select a reason code when
performing a paid-in transaction.

15 - Require Reason on Paid-Out Select this option to require the workstation
operator to select a reason code when
performing a paid-out transaction.

16 - Require Reason on Transfer Select this option to require the workstation
operator to select a reason code when
transferring funds from one receptacle to
another.

17 - Require Reason on Adjust Bank Deposit
Reference

Select this option to require the workstation
operator to select a reason code when
adjusting a bank deposit reference.

20 - Require Deposit Reference Select this option to prompt the workstation
operator to enter a reference when creating
a new bank deposit.
The workstation operator is not obligated to
enter a reference at the prompt.

21 - Require Reference for Receptacle Counts Select this option to prompt the workstation
operator to enter a reference when counting
a receptacle.
The workstation operator is not obligated to
enter a reference at the prompt.

24 - Require Reference for Cash Pull Select this option to prompt the workstation
operator to enter a reference when
performing a cash pull.
The workstation operator is not obligated to
enter a reference at the prompt.
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Table 51-6    (Cont.) Cash Management Parameter Options

Option Description

25 - Require Reason on Over/Short Select this option to require the workstation
operator to enter a reason code when
posting an operation that finds a variance in
values.

26 - Allow Count of Assigned Till Select this option to allow the workstation
operator to count a till that is assigned to a
workstation. When you deselect it, you
unassign the till from the workstations to
count.
After upgrading to Simphony version 2.7
MR2, existing customers who want to
continue to count assigned tills need to set
this option.

27 - Require Check Closed Before Receptacle
Close

Select this option to allow the workstation
operator to close a till or server banking
session only after all checks with assigned
users as the check owner are closed. The
workstation operator must close all open
checks before closing the till or server
banking session.
Setting this option ensures that a receptacle
is available to settle cash tenders to open
checks for workstation operators assigned to
the receptacle.

28 - Restrict a Single User per Till Select this option to restrict a till session to
only allow one user. When the workstation
operator has option 26 - Allow Assigned
Receptacle Access set from the Employee
Class, the Allow All button is available on
the POS client during the assignment
operation.

29 - Save Count Progress Select this option to allow the workstation
operator to save an incomplete count sheet
when counting a receptacle session.

30 - Enable Change Order Tracking Select this option to track change order
transactions, save, and recall change order
requests.

31 - Require Reference for Change Order Select this option to prompt the workstation
operator to enter a reference when
submitting a change order request.
The workstation operator is not obligated to
enter a reference at the prompt.

32 - Cash Pull Threshold Notification on
Transaction Close

Select this option to prompt the workstation
operator after completing an active
transaction that exceeds the cash pull
threshold level.

33 - Prompt for Business Date on Open Bank
Deposit

Select this option to prompt the workstation
operator to select a business date when
opening a bank deposit receptacle. The
operator can select the current business date
or up to seven dates in the past.
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Table 51-6    (Cont.) Cash Management Parameter Options

Option Description

34 - Hide Bank Deposits on Dashboard Select this option to hide the Bank Deposits
tab on the Cash Management Dashboard.

35 - Hide Petty Cash on Dashboard Select this option to hide the Petty Cash tab
on the Cash Management Dashboard.

36 - Hide Safes on Dashboard Select this option to hide the Safes tab on the
Cash Management Dashboard.

37 - Hide Server Banks on Dashboard Select this option to hide the Server Banks
tab on the Cash Management Dashboard.

38 - Hide Tills on Dashboard Select this option to hide the Tills tab on the
Cash Management Dashboard.

39 - Display Employee First for Tills on
Dashboard

Select this option to show the Employee
column first in the Tills tab on the Cash
Management Dashboard.
Additionally, when this option is enabled,
the Tills Counted column appears in the
Bank Deposit tab on the Cash Management
Dashboard. When disabled, the Expected
column appears in the Bank Deposit tab on
the Cash Management Dashboard.

41 - Require Reference for Paid-In when
vendor not defined

Select this option to prompt the workstation
operator to enter a reference when
performing a paid-in transaction without a
vendor defined.
The workstation operator is not obligated to
enter a reference at the prompt.
If a vendor is defined, the paid-in
transaction follows the configuration of 3 -
Require Reference on Use in the Vendors
module. When option 3 is enabled, the
workstation operator is required to enter a
reference when performing a transaction
(such as paid-in to till, safe, or server bank)
that requires a vendor.

42 - Require Reference for Paid-Out when
vendor not defined

Select this option to prompt the workstation
operator to enter a reference when
performing a paid-out transaction without a
vendor defined.
The workstation operator is not obligated to
enter a reference at the prompt.
If a vendor is defined, the paid-out
transaction follows the configuration of 3 -
Require Reference on Use in the Vendors
module. When option 3 is enabled, the
workstation operator is required to enter a
reference when performing a transaction
(such as paid-out to till, safe, or server bank)
that requires a vendor.

43 - Prompt to Confirm Transfer During
Close on Count

Select this option to prompt the workstation
operator with a confirmation when closing a
count and transferring the cash from a till or
server bank receptacle to a deposit.
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Table 51-6    (Cont.) Cash Management Parameter Options

Option Description

44 - Enforce Close Till and Deposit Till Roles Select this option to override Role privilege
options 210 - Deposit Funds and 212 - Close
Till. If this option is enabled, Role option 205
- Count Till is enabled, and 210 and 212 are
disabled, the till receptacle does not close
after the user performs a count.
Configuring ECM Privileges and Permissions
contains information on options 210 and
212.

45 - Prompt for Drawer on Quick Start Till Select this option to prompt the workstation
operator to select the cash drawer on
workstations with more than one drawer
when performing the Quick Start Till
function.
When 45 is enabled, the Quick Start Till
function ignores the cash drawer
configuration of the workstation operator.
On a workstation with a single drawer, the
selected till session is automatically assigned
to that drawer (if it does not have one
already assigned). On a workstation with
two drawers, the operator is prompted for a
cash drawer when both are available, or
auto assigned to the available drawer when
one is in use.

46 - Prevent Assignment of Tills with Active
Sessions to Cash Drawers

Select this option to show only till
receptacles that do not have an active
session and are not assigned to a cash
drawer when the workstation operator
performs either the Assign Till To Cash
Drawer or the Quick Start Till function.
When 46 is enabled, a workstation operator
cannot assign a till session that has been
counted to a cash drawer. The till session
needs to be closed and a new one started.
You must also select option 28 - Restrict a
Single User per Till.

6. Click Save.

7. Select the Enterprise, zone, property, or revenue center, click Setup, and then
click Control Parameters.

8. Click the Options tab.

9. Select 68 - Require Reason on No Sale to require the workstation operator to
select a reason code when performing a No Sale operation.

10. Click Save.

Creating Cash Management Touchscreens and Dashboard
Oracle Hospitality recommends that you create a page with tabs on which to place the
cash management functions. Create and configure tabs to show operations by
receptacle type. Create buttons on the page for the required cash management
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functions listed. The following figure shows an example of a page with cash management
functions created in the Page Design module.

Figure 51-2    Cash Management Touchscreen in Page Design

You can also add the Cash Management Dashboard to page layouts using the Page Design
module. The Dashboard lets managers view:

• The number of each type of open receptacle

• A summary level and detail view of each type of open receptacle

The Dashboard also includes one-button navigation to open, count, adjust, transfer, and
finalize receptacles.

Option 1 - Enable Cash Management must be set in the Cash management Parameters
module to use the Cash Management Dashboard.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Page Design.

2. Open the page on which to place cash management buttons.

3. On the Edit tab, select the page area in which to define the cash management functions.

4. Create tabs for Safe, Bank Deposit, Till, Server Bank, Petty Cash, General, and
Payments.

5. On each tab, create buttons for each of the functions listed in the following table.

Table 51-7    Cash Management Tabs and Buttons

Tab Button Name Function

Safe Add Funds Add money to the safe.

Adjust Count Correct values from the
previous count.
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Table 51-7    (Cont.) Cash Management Tabs and Buttons

Tab Button Name Function

Change Count Sheet Adjust the count sheet that
workstations operators use
to perform a count.

Close Receptacle Close the safe’s tracking
session.

Count Receptacle Count the money in the safe.

Deposit Cash Deposit cash from the safe to
a bank deposit.

Open New Change Order
Request

Open a Change Order when a
safe is low on a particular
denomination or to stock up
for an event.

Open New Receptacle Open a new safe tracking
session.

Paid-In Accept funds for the safe
outside of a guest check.

Paid-Out Distribute funds from the
safe outside of a guest check.

Remove Funds Remove money from a safe
session and from tracking.

Transfer Funds Transfer money from the
safe to another receptacle.

Bank Deposit Adjust Bank Deposit
Reference

Change the reference of a
bank deposit session.

Adjust Cash Deposit Change the amount of a cash
deposit that was placed into
the bank deposit session.

Open New Receptacle Open a new bank deposit
tracking session.

Reconcile Bank Deposit Close the bank deposit.

Transfer Funds Transfer money from the
bank deposit to another
receptacle.

Till Adjust Count Correct values from the
previous count.

Adjust Till Starting Amount Change the starting amount
of a till session after opening
it.

Assign Till to Cash Drawer Assign a till to a cash drawer.

Assign User(s) to Till Assign one or more operators
to the till session on the
workstation.

Audit Receptacle (Till) Perform a count without
closing the till session
irrespective of the Close on
Count Completion option.
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Table 51-7    (Cont.) Cash Management Tabs and Buttons

Tab Button Name Function

Change Count Sheet Adjust the count sheet that
workstations operators use
to perform a count.

Close Receptacle Close the till’s tracking
session.

Count Receptacle Count the money in the till.

Deposit Cash Deposit cash from the till to a
bank deposit.

Paid-In Accept funds for the till
outside of a guest check.

Paid-Out Distribute funds from the till
outside of a guest check.

Pull Cash Remove cash from the till
session.

Quick Start Till Quickly assign a workstation
operator and till to a cash
drawer on the workstation.

Transfer Funds Transfer money from the till
to another receptacle.

Unassign Till from Cash
Drawer

Restrict the till to a limited
number of operations. This
function does not close the
till.

Unassign User(s) from Till Prevent the workstation
operator from performing
transactions on the till. This
function does not close the
till.

Server Bank Adjust Count Correct values from the
previous count.

Adjust Server Bank Starting
Amount

Change the starting amount
of a till session after opening
it.

Close Receptacle Close the server bank’s
tracking session.

Count Receptacle Count the money in the
server bank.

Deposit Cash Deposit cash from the server
bank to a bank deposit.

Paid-In Accept funds for the server
bank outside of a guest
check.

Paid-Out Distribute funds from the
server bank outside of a
guest check.

Pull Cash Remove cash from the server
bank session.
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Table 51-7    (Cont.) Cash Management Tabs and Buttons

Tab Button Name Function

Transfer Funds Transfer money from the
server bank to another
receptacle.

Petty Cash Adjust Count Correct values from the
previous count.

Close Receptacle Close the petty cash tracking
session.

Count Receptacle Count the money in petty
cash.

Deposit Cash Deposit cash from the petty
cash to a bank deposit.

Open New Receptacle Open a new petty cash
tracking session.

Paid-In Accept funds for petty cash
outside of a guest check.

Paid-Out Distribute funds from petty
cash outside of a guest check.

Transfer Funds Transfer money from petty
cash to another receptacle.

General Cash Management
Dashboard

View the number of each
type of open receptacle
session, see summary level
and detail of each type of
open receptacle session, and
open, count, adjust, transfer,
and finalize receptacle
sessions using a button.

View Receptacle Status Look at summary
information for all receptacle
sessions.

Till Assignment Status (Smart
Key)

Determine whether a till is
assigned to a cash drawer on
the workstation.

Payments Payment Types (for example,
separate buttons for USD,
Euro, and Peso)

Receive payment by type of
currency.

Currency Conversion Convert one currency to
another.

6. To add the Cash Management Dashboard:

a. Click Button.

b. On the General subtab, select Function from the Type drop-down list.

c. Click the black arrow beneath the Type drop-down list.

d. Select Cash Management Dashboard, and then click the OK button.

e. Enter a Legend for the button.

f. Position and size the button on the page. Use the Style arrow to change the
color.
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g. Click Save.

Configuring a Smart Key on a Workstation
A smart key prevents the use of a workstation until you assign a till session to a cash drawer
on the workstation. After assignment, the key permits the workstation operator to sign on to
the workstation. Follow these steps to implement the optional smart key.

1. Select the Enterprise, zone, property, or revenue center, click Configuration, and then
click Page Design.

2. Select the Sign In page.

3. On the Edit tab, click Button.

4. Enter information in the Page Design fields.

Table 51-8    Page Design Edit Fields

Field Entry

Legend Enter the name of the button (for example,
Till Status).

Type Select Function from the drop-down list.

Sub Type Click the black arrow, and then select Smart
Key.

Auto Active Select this option to make the button
automatically active.

5. Click the Edit Smart Keys button.

6. Click Add.

7. Enter information in the fields as described in the following table for Smart Key entry
number 1.

Table 51-9    Smart Key 1 Fields

Field Entry

Condition Select Till Assigned from the drop-down list.

Value Enter 1.

Legend Enter the name of the button (for example,
Sign In).

Type Select Function from the drop-down list.

Sub Type Click the black arrow, and then select Sign-
In.

8. Click Add.

9. Enter information in the fields as described in the following table for Smart Key entry
number 2.
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Table 51-10    Smart Key 2 Fields

Field Entry

Condition Select Default from the drop-down list.

Value Enter 2.

Legend Enter the name of the button (for
example, Assign Till).

Type Select Function from the drop-down list.

Sub Type Click the black arrow, and then select
Assign Till To Cash Drawer.

10. Click Close.

11. Click Save.

Configuring a Till Through Extensibility
ECM provides the Designate till number during assignment capability through
extensibility. When you set the InitiatingCommand.Arguments to a valid receptacle
object number, the application attempts to use that till when assigning a till to a
workstation. If the till is not found or is assigned to another workstation, the application
prompts the workstation operator for the till to assign.

Configuring a Bank Deposit Reference Through Extensibility
ECM allows you to define a bank deposit reference through extensibility using the
GetReference entry. Transaction and location information is exposed to extensibility to
set values that you can use (if required) in the bank deposit reference. The bank
deposit reference entry is based on the following transaction and location information:

• Property Number and Name

• Revenue Center (RVC) Number and Name

• Business Date

• Workstation Number

The extensibility application automatically generates the bank deposit reference. When
you set the bank deposit reference value through extensibility, the workstation operator
cannot enter or edit the reference value.

ECM Reporting
ECM reporting for receptacles and activity is available at the Enterprise and property
hierarchy levels.

Related Topics

• Enabling Reports in Enterprise Back Office

• Specifying Ad Hoc Reports

• ECM Enterprise Information in Reporting and Analytics Reports

• ECM Property Reports
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Enabling Reports in Enterprise Back Office
Enterprise reports must be assigned to an employee role in Oracle Hospitality Reporting and
Analytics before authorized employees can run them. An administrator typically assigns the
reports to a role.

1. In Reporting and Analytics, click Admin, click Warehouse, click Reports, and then click
Report Roles.

2. Highlight a role, and then click Select.

3. On the Role Reports screen, click Add.

4. Select the report names from the list, and then click Save.

5. Create a report category:

a. Click Admin, click Warehouse, click Reports, and then click Report Categories.

b. Click Add.

c. On the Report Categories screen, enter the Name of the new report category, a
Description, and specify a Sort Order.

d. Click Save.

Related Topics

• ECM Reporting

• ECM Enterprise Information in Reporting and Analytics Reports

• ECM Property Reports

Related Topics

• Event Information in Reporting and Analytics Reports

ECM Enterprise Information in Reporting and Analytics Reports
Enterprise reports provide information about active and completed receptacle sessions for
the Enterprise in Oracle Hospitality Reporting and Analytics, including the reports listed in the
following table. These reports contain drill-down options to allow simple auditing for all
receptacle tracking sessions related to the report. You can filter the results by date,
organization, property, revenue center, receptacle type, receptacle, receptacle session,
status, and class. (Class information is available only if using Reporting and Analytics version
18.1.)

The Oracle Hospitality Reporting and Analytics User Guide contains detailed information
about each report.

Table 51-11    Reporting and Analytics ECM Enterprise Reports

Report Description

Safe Report This report contains information about all safe sessions
(regardless of their state) for the selected location and
business date.
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Table 51-11    (Cont.) Reporting and Analytics ECM Enterprise Reports

Report Description

Petty Cash Report This report contains information about all petty cash
sessions (regardless of their state) for the selected location
and business date.

Till Report This report contains information about all till sessions
(regardless of their state) for the selected location and
business date.

Bank Deposit Report This report contains information about all bank deposit
sessions (regardless of their state) for the selected location
and business date.

Bank Deposit Adjustment Report This report contains information about bank deposit
adjustments (amount and references) that were performed
for bank deposit receptacles for the selected location and
business date.

Server Bank Report This report contains information about all server bank
sessions (regardless of their state) for the selected location
and business date.

Count Adjustment Report This report contains information about count adjustments
that were performed for all receptacle tracking sessions for
the selected properties.

Starting Amount Adjustment
Report

This report contains information about adjustments to
starting amounts that were defined for all receptacle
sessions for the selected location and business date.

Over/Short Detail Report This report contains information about over and short
conditions that were reported for all receptacle sessions for
the selected location and business date.

Paid-In/Paid-Out Report This report contains information about paid-in and paid-out
transactions that were reported for all receptacle tracking
sessions for the selected properties.

Activity Report This report contains information about all transactions and
operations that were performed for receptacle sessions for
the selected business date. Transactions and operations are
listed chronologically, allowing an auditor to view an exact
account of all activities performed from open to close for
the receptacle session. The Activity Report includes Cash
Count Threshold Level and Cash Pull Bypass/Threshold
Level notifications for Till, Safe, Server Bank, and Petty
Cash receptacles.
This report is available through a drill-down from another
report and shows only the filter selected from the parent
report. For example, the Activity Report shows only the date
and time range selected in the parent report. The Class filter
is also available and functions when selected within the
Activity Report.

Change Order Report This report contains information about all Change Orders
submitted (open) and reconciled (closed) for the selected
business date. Saved Change Orders are not shown.
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Table 51-11    (Cont.) Reporting and Analytics ECM Enterprise Reports

Report Description

Count Entry Details Report This report contains information about details entered by
the workstation operator during a receptacle count,
including all denominated, non-denominated, and
reference entries
This report is available through a drill-down from the
Activity Report for a receptacle count. This report shows
only the filter selected from the parent report. For example,
the Count Entry Details Report shows only the date and
time range selected in the parent report.

Related Topics

• ECM Reporting

• Enabling Reports in Enterprise Back Office

• Specifying Ad Hoc Reports

ECM Property Reports
Property level reporting at the workstation provides information on active receptacle sessions
and transactions to assist in daily operations management. The reports include multiple
classes showing additional currency and class details. The summary section for each report
shows the currency name, abbreviation, and values (using symbol and separator). You can
print these reports to a local printer for the workstation.

Filtering a property report by revenue center is based on the employee operator assignment
record, reporting privileges (for each report), and the receptacle location.

You can create front of house buttons for each property report listed in the following table. 
Workstation Touchscreen Pages contains more information on configuring front of house
buttons.

Table 51-12    ECM Property Reports

Report Description

Bank Deposit Report This report contains information about active
bank deposit sessions for the location.

Cash Pull Report This report contains information about cash
pull transactions posted for the current
business date.

Change Order Report This report contains information about open
Change Order sessions and transactions for the
location.

Count Sheet This report is not selectable, and it prints
automatically after completion of a receptacle
count. The details shown are for counts
entered during a receptacle count, including
class totals and over/short values (if
applicable).
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Table 51-12    (Cont.) ECM Property Reports

Report Description

Over/Short Detail Report This report contains information about over
and short conditions recorded for the current
business date.

Paid-In/Paid-Out Report This report contains information about paid-in
and paid-out transactions recorded for the
current business date. It is based on the
revenue center in which the paid-in/paid-out
activity occurred.

Petty Cash Report This report contains information about active
petty cash sessions for the location.

Safes Report This report contains information about active
safe sessions for the location.

Server Bank Report This report contains information about the
active server bank session for the operator
signed on to the workstation.

Server Banking Report This report contains information about active
server banking sessions for the location.

Till Banking Report This report contains information about active
till sessions for the location.

Till Report This report contains information about active
till sessions assigned on the workstation.

Related Topics

• ECM Reporting

• Enabling Reports in Enterprise Back Office

• Specifying Ad Hoc Reports

ECM Workstation Hardware
The following table lists the workstation hardware models and operating systems
supported for ECM receptacle operations and functions. Some functionality related to
the operation of tills is limited with tablets, handhelds, and other mobile devices. These
devices are indicated in the table with an asterisk (*).

The receptacle’s tracking session includes ECM tracked transactions that are
processed as part of normal guest check operations, regardless of the hardware
model or supported operating system from which they originated.

Table 51-13    Workstation Hardware

Model Operating System ECM Features Supported?

Oracle MICROS Workstation
6 Series

Microsoft Windows 8.1 Yes

Oracle MICROS Tablet E-
Series (8-inch and 11-inch)

Microsoft Windows 8.1 Yes*
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Table 51-13    (Cont.) Workstation Hardware

Model Operating System ECM Features Supported?

Oracle MICROS Workstation
5a

Microsoft Win32 Yes

Oracle MICROS PC
Workstation 2015

Microsoft Win32 Yes

Oracle MICROS PC
Workstation 2010

Microsoft Win32 Yes

DT Research 362 Microsoft POSReady 7 Yes*

DT Research 365 Microsoft Windows 7 Yes*

Zebra MC40 (formerly the
Motorola MC40)

Android 4.1 Yes*

Apple iPad (all models) Apple iOS 8 No

Certified Consumer Devices
(Android)

Android 4.4 Yes*

Related Topics

• Configuring Data Retention Limits

• Configuring ECM Privileges and Permissions

• Allowing Users to View Blind Totals

• Allowing Assigned Receptacle Access and Counts

• Configuring Accounting Methods for Users

• Allowing Users to Override Employee Class Options

• Creating, Editing, and Deleting Cash Management Reasons

ECM Configuration Levels
The following table lists the hierarchy levels within the EMC that allow configuration of ECM
operations.

Table 51-14    EMC Configuration Levels

EMC
Configuration
Name

Enterprise Property RVC Zone

Accounts X X X X

Cash Count
Threshold Sets

X X X X

Cash Management
Classes

X X X X

Cash Management
Parameters

X X X X

Cash Management
Reasons

X X X X
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Table 51-14    (Cont.) EMC Configuration Levels

EMC
Configuration
Name

Enterprise Property RVC Zone

Cash Pull
Threshold Sets

X X X X

Count Sheets X X X X

Employee Classes X

Employee
Maintenance

X X X

Page Design X X X X

PAR Level Sets X X X X

Vendors X X X X

Templates X X X X

Receptacles X X X X

Roles X

Related Topics

• Configuring Data Retention Limits

• Configuring ECM Privileges and Permissions

• Allowing Users to View Blind Totals

• Allowing Assigned Receptacle Access and Counts

• Configuring Accounting Methods for Users

• Allowing Users to Override Employee Class Options

• Creating, Editing, and Deleting Cash Management Reasons
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52
Engagement Cloud Service

The Engagement Cloud Service is Simphony’s web-based user interface for the Oracle
MICROS Tablet E-Series and Workstation 6 Series. The Engagement Cloud Service is
deployed and automatically enabled with Simphony installation.

There are two types of pages in the Engagement UI:

• Welcome Page: Initial page that appears on tablet devices. You can assign different
Welcome pages to workstations.

• Hub Pages: Pages that appear on the tablet after workstation operators sign on and
press the Hub button. You can assign different Hub pages to each employee.

Pages can contain widgets that allow you to enhance workstation functionality. For example,
you can have daily specials, image slideshows, a Twitter feed, and Oracle Hospitality
Reporting and Analytics reports appear on the tablet’s touchscreen.

The Engagement UI runs on POS operations and allows you to:

• Configure Welcome and Hub pages

• Assign pages to properties, employees or workstations, or both

• Perform Manager Procedures

System Requirements and Supported Devices
The Engagement module included in Oracle Hospitality Simphony version 19.1 works with
Oracle Hospitality Enterprise Back Office version 9.0 (or later).

The Engagement service is supported on workstations running the Microsoft Windows 8.1
and 10 operating systems.

You can use Engagement on the following devices:

• Oracle MICROS Tablet E-Series 8-inch and 11-inch models

• Oracle MICROS Tablet 700 series

• Oracle MICROS Workstation 6 Series

• Oracle MICROS Compact Workstation 310

Related Topics

• Assigning Privileges for Engagement Administrative Users

Security Precautions
The Engagement feature allows you to configure live tiles and content that appear on a POS
client device. Ensure that any external data sources or URLs provided through Engagement
are secure and derive from a trusted source.
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The URL widget, which shows web content from the configured location, contains
built-in security precautions. By default, the URL widget locks the workstation operator
into the domain of the link provided. That is, all links on a page that are outside of the
domain are disabled to prevent workstation operators from navigating to these links.
For example, if you configure a URL widget for http://www.oracle.com, all links outside
of *.oracle.com are automatically disabled for the workstation operator.

Consider the following best practices when configuring the URL widget and POS client
device on which it runs.

Internet Security Settings

The browser security settings within the Engagement feature are defined by the
settings of Microsoft Internet Explorer. When you change Microsoft Internet Explorer
options, (for example, Do not allow cookies) you also change the settings for the
Engagement browser.

Do not move security levels below Medium-high with Enable Protected Mode on for
Internet and Medium-low with Enable Protected Mode off for Local intranet. These
are the minimum Engagement security settings. You may increase the security levels if
desired.

Trusted Source

Only enter URLs for the widget from a secure and trusted source. Creating links to
unverified sources and untrusted websites increases the security risk for your POS
client device.

Related Topics

• Assigning Privileges for Engagement Administrative Users

Assigning Privileges for Engagement Administrative Users
You need to assign privileges for Engagement administrative users to access, add,
and change new pages or page assignments in the EMC.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Insert a record for the role (for example, host, bartender, server, manager, or
administrator), and then click OK.

3. Double-click the role type.

4. Click the EMC Modules tab.

5. For the Engagement Page Design and Engagement Page Assignment
modules listed in the File column, select one or more of the following privileges:

• View: Grants access to view a module. You must select View so that
employees in the role can open the module.

• Edit: Allows employees in the role to edit Welcome and Hub pages.

• Add: Allows employees in the role to add Welcome and Hub pages.

• Delete: Allows employees in the role to delete Welcome and Hub pages.

6. Click Save.
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Related Topics

• System Requirements and Supported Devices

• Security Precautions

Language Translation Tasks
Configuring language translation for Engagement consists of completing the following tasks:

• Adding a language to Hub and Welcome pages

• Adding a language to the EMCWeb file

• Adding a language file to the Engagement Configuration application server

• Enabling multi-languages

Related Topics

• Adding a New Language to Hub and Welcome Pages

• Adding a Language to the EMCWeb File

• Adding a Language File to the Engagement Configuration Application Server

• Setting Multiple Languages

Adding a New Language to Hub and Welcome Pages
1. Browse to the Engagement Language File directory on the workstation.

The default installation path is [Drive
Letter]:\Micros\Simphony\WebServer\Engagement\LanguageFile\Resources.xml.

2. Copy the Resources.xml file.

3. Rename the file to Resource.CULTURE-CODE.xml, where CULTURE-CODE is the code
of the new language you are adding (for example, Resources.fr-FR.xml for French or
Resources.es-ES.xml for Spanish).

4. Change the values of the <string> elements of each language entry to the target
language.

Do not change the values of other elements or attributes.

You can move the number parameters ({0} or {1}) in the language string (left or right of
the string text), but do not delete them.

5. Save the changes.

Related Topics

• Language Translation Tasks

• Setting Multiple Languages

Adding a Language to the EMCWeb File
1. Browse to the Engagement Language File directory on the Simphony application server.

The default installation path is [Drive Letter]:\MICROS\Install\InstallTools\Text.

2. Copy the EMCWebLanguageStringsEN-US.xml file.
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3. Rename the file to EMCWebLanguageStrings.CULTURE-CODE.xml, where
CULTURE-CODE is the code of the new language you are adding.

The file name must include the correct CULTURE-CODE naming convention (for
example, EMCWebLanguageStrings.fr-FR.xml for French or
EMCWebLanguageStrings.es-ES.xml for Spanish).

4. Change the values of the Text language attribute for each language entry to the
target language.

Do not change the values of the key or screen attributes.

You can move the number parameters ({0} or {1}) in the language string (left or
right of the string text), but do not delete them.

5. Save the changes.

6. To upload translation files to the database, browse to [Drive
Letter]:MICROS\Simphony2\Tools\UploadEMCWebLanguageStrings, and run
UploadEMCWebLanguageStrings.exe.

You can also run the executable file from a cmd prompt by entering
UploadEMCWebLanguageStrings.exe  -f:UploadedFilesPath  -
db:DbSettingsFile  [-alias:DbAlias].

Related Topics

• Language Translation Tasks

Adding a Language File to the Engagement Configuration
Application Server

1. Browse to the Engagement Language File folder on the Simphony application
server.

The default installation path is [Drive
Letter]:Micros\Simphony2\Engagement\EngagementConfig\Languages.

2. Copy the en-US.xml file.

3. Rename the file to CULTURE-CODE.xml, where CULTURE-CODE is the code of
the new language you are adding (for example, fr-FR.xml for French or es-ES.xml
for Spanish).

4. Change the values of the Text language attribute for each language entry to the
target language.

Do not change the value of the record key attribute.

You can move the number parameters ({0} or {1}) in the language string (left or
right of the string text), but do not delete them.

5. Change the values of the name and code attributes on the second line to the
Culture code of the target language (<Language version="32" name="English
(US)" code="en-US">).

6. Save the changes.

Related Topics

• Language Translation Tasks
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Setting Multiple Languages
1. Select the Enterprise level, click Setup, and then click Languages.

2. Double-click a language record.

3. In the Language Culture field, enter the abbreviated language code. For example, the
code for English - United States is en-US.

See http://msdn.microsoft.com/en-us/library/ee825488(v=cs.20) for a list of language
codes.

4. Repeat Steps 2 and 3 for each language record.

5. Click Save.

Related Topics

• Language Translation Tasks

Engagement Manager Procedures
The Web EMC or Web Configuration Console (WCC) widget enables you to assign one of the
following manager procedures to a tile:

Table 52-1    WCC Widget Manager Procedures

Manager Procedure Allows You To...

Edit Header/Trailer Edit check headers and trailers for a property
or revenue center. If a logo image is available
at the Enterprise level from the EMC, you can
also add that image to the check header.

Bulk Edit MI Prices Filter and edit menu item prices by revenue
center, major group, family group, screen look
up (SLU), menu item class, and a keyword
entry.

Copy Menu Item Add images to menu items.
Add new menu items using existing menu item
records as a template.

Copy Employee Add new employees using existing employee
records as a template.
Add or change an image in an existing
employee’s profile.

Related Topics

• Adding Engagement Manager Procedure Tiles to the Hub Page

• Editing the Check Header and Trailer

• Editing Bulk Menu Item Prices

• Adding an Employee From a Template

• Deactivating an Employee

• Adding a New Menu Item Using an Existing Menu Item as a Template
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• Adding Images to Menu Items

• Adding or Changing an Employee’s Profile Image

Adding Engagement Manager Procedure Tiles to the Hub
Page

1. Log in to the Engagement dashboard, go to the Hub Pages section, and then add
a new WCC widget.

2. From the EMC - Properties dialog, select Copy Employee as the Command
Type.

3. (Optional) Enter the Primary Text and Secondary Text to appear on the widget.

4. (Optional) Select the widget Size, and then add a Tile Image for the widget.

5. Click Save.

6. Repeat Steps 1 through 5 to add tiles to the Hub page for the Edit Header/Trailer,
Bulk Edit MI Prices, and Copy Menu Item manager procedures.

Related Topics

• Engagement Manager Procedures

Editing the Check Header and Trailer
1. Sign on to the POS client device, and then tap the Hub function.

2. Tap the tile configured for the Edit Header/Trailer manager procedure.

3. Select a property or revenue center.

4. To edit the header and trailer for guest checks, tap Guest Check.

5. To edit the header for a customer receipt, tap Customer Receipt.

6. Enter the details to print on the header in the Header text fields, and then enter the
details to print on the trailer in the Trailer text fields.

7. To insert a logo for the header:

a. Select a Header text field, and then tap Insert Image.

b. Select a logo from the preview.

8. Click Save.

Related Topics

• Engagement Manager Procedures

Editing Bulk Menu Item Prices
1. Sign on to the POS client device, and then tap the Hub function.

2. Tap the tile configured for the Bulk Edit MI Prices manager procedure.

3. To edit the price of one menu item:

a. Enter the menu item’s name in the search field, and then tap Search.
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b. Tap the Price field of the menu item, enter the new menu item price, and then tap
Enter.

4. To edit the prices of several menu items:

a. Tap Filter Menu Item, and then select one or more of the following filter criteria:

• Major Group

• RVC

• Family Group

• SLU

• Menu Item Class

b. Tap the Price field of the first menu item on the search results, enter the new menu
item price, and then tap Enter. The focus moves to the price of the next menu item.

5. Tap Save, and then tap OK to confirm the changes.

Related Topics

• Engagement Manager Procedures

Adding an Employee From a Template
1. Sign on to the POS client device, and then tap the Hub function.

2. Tap the tile configured for the Copy Employee manager procedure.

3. Tap Filter Employees, select the revenue center, the employee role, and the employee
class to assign to the new employee.

4. Select an employee from the search results, and then tap Copy Employee.

5. Configure the following information for the new employee:

Table 52-2    Configuration Fields for Adding New Employees From a Template

Field or Option Name Description

First Name Enter the employee’s first name.

Last Name Enter the employee’s last name.

DOB Select the employee’s date of birth.

Hire Date Enter the date the employee was hired.

(Optional) MagCard ID Enter the magnetic card number assigned to
the employee or swipe the card to enter the
card number into the application.

(Optional) Finger Print If a fingerprint scanner is connected, you
can scan the employee’s fingerprints into the
application.

RVCs Select the employee’s revenue center.
You cannot change the primary revenue
center of the employee.

Enable Reporting Select this option to grant the employee
access to Oracle Hospitality Reporting and
Analytics.
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Table 52-2    (Cont.) Configuration Fields for Adding New Employees From a
Template

Field or Option Name Description

Is Salaried Select this option if the employee is paid a
flat amount.

Pay Rate Enter the employee’s pay rate.

Logon Name Enter the username to use to sign on to the
workstation.
If you selected Enable Reporting, the
employee can use the same username to sign
on to Reporting and Analytics.

Password Enter the password to use to sign on to the
workstation.
If you selected Enable Reporting, the
employee can use the same username to sign
on to Reporting and Analytics.

Confirm Password Re-enter the password.

6. To add an image to the employee’s profile:

a. Tap Change Picture, and then tap Browse Image.

b. Select the employee’s image, and then tap Open.

7. Tap Add Employee, and then tap Yes to confirm the insertion.

Related Topics

• Engagement Manager Procedures

Deactivating an Employee
Deactivating an employee removes the employee’s access to Simphony and the
Enterprise Back Office Suite. When an employee is deactivated:

• The employee is clocked out immediately when outside of a transaction.

• The employee can no longer sign on to the Simphony POS client, EMC, Reporting
and Analytics, or the Engagement configuration website.

Labor Management shows the deactivated employee’s status as Terminated. Use the
Labor Management portal to re-hire a deactivated employee.

1. Sign on to the POS client device, and then tap the Hub function.

2. Tap the tile configured for the Copy Employee manager procedure.

3. Search for and select the employee you want to deactivate.

4. Tap Deactivate Employee, and then tap OK to confirm.

The Simphony EMC shows the deactivated employee’s status as Is Deleted. The
Is Deleted option from the Employee Maintenance module is automatically set for
the deactivated employee.

Related Topics

• Engagement Manager Procedures
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Adding a New Menu Item Using an Existing Menu Item as a
Template

1. Sign on to the POS client device, and then tap the Hub function.

2. Tap the tile configured for the Copy Menu Item manager function.

3. Select a menu item that belongs to the same menu item class and print class that you
want to assign to the new menu item, and then tap Copy Menu.

4. Configure the following details for the new menu item:

Table 52-3    Configuration Fields for Adding New Menu Items From a Template

Field or Option Name Description

Menu Item Master Name Enter the new menu item name.

Definition Select the appropriate menu item definition.
If the menu item that you are using as the
template has several definitions, all
definitions appear in the list.

Menu Item Definition Name Enter the name for the new menu item
definition.

Price Enter the menu item price.

5. To change the image for the menu item:

a. Tap Change Picture, and then tap Browse Image.

b. Select the new image, and then tap Open.

6. Click Add Menu, and then tap OK to confirm the insertion.

Related Topics

• Engagement Manager Procedures

Adding Images to Menu Items
1. Sign on to the POS client device, and then tap the Hub function.

2. Tap the tile configured for the Copy Menu Item manager function.

3. Select the menu item, and then tap Update Image.

4. Tap Browse Image, select the menu item image, and then tap Open.

Related Topics

• Engagement Manager Procedures

Adding or Changing an Employee’s Profile Image
1. Copy images to the POS client device using a flash drive or download the images

through the Internet.

2. Sign on to the POS client device, and then tap the Hub function.
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3. Tap the tile configured for the Copy Employee manager procedure.

4. Select an employee, and then tap Preview.

5. Tap Change Picture, and then tap Browse Image.

6. Browse to and select the employee’s image, and then tap Open.

Image files cannot exceed 50 KB in size. The following image file type formats are
supported:

• .bmp

• .jpeg

• .png

• .gif

7. Close the Employee Summary dialog.

Related Topics

• Engagement Manager Procedures

Creating Pages for Engagement Users
You can create Engagement pages at the Enterprise level. These pages cannot be
overridden at lower levels in the hierarchy.

1. From the dashboard, go to the Pages section, and then tap View All.

2. To add a new page from either the Welcome Pages or Hub Pages section, tap +
Create New Page in the appropriate section.

You can define Welcome Pages for the following EMC modules:

• Workstation

• Workstation Class

You can override the Welcome Page assignment at any level in the hierarchy
below the Enterprise.

The Manager Hub Page is based on the Employee Class of the users.

3. Type the name of the page in the text box, and then tap OK.

Modifying Pages for Engagement Users
You can modify pages using the controls that appear when you select a page.

1. To make changes to a page, select the page, and then tap Edit.

2. To duplicate a page, select the page, and then tap Clone.

3. To remove a page, select the page, tap Delete, and then tap OK to confirm.

Assigning Logos and Colors to Pages
You can define a logo and color palette on Welcome pages. You can add only a logo to
Hub pages because the color palette can be inherited from the Enterprise, property, or
revenue center level based on the Theme Assignment module configuration.
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Image files cannot exceed 1 MB in size. The following image file type formats are supported:

• .bmp

• .jpeg

• .png

• .gif

Copy logo images to the POS client device using a flash drive or download the images
through the Internet.

1. Open the page, and then tap anywhere within the grid.

2. Select the color from the Palette drop-down list.

3. To add a company logo to the page:

a. Tap Open.

b. Browse to the logo image file and select it. The directory path appears in the Logo
field.

4. Tap Save.

Assigning Default Welcome and Hub Pages
You can specify the default Welcome and Hub pages in the EMC.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Assignment.

2. Click the Configuration tab, and then select the following pages from the drop-down
lists:

• Default Welcome Page

• Default Hub Page

3. (Optional) To configure the Welcome Page conditions, click the Welcome tab.

a. Select a Condition from the drop-down list.

b. Select a Page to appear for the condition selected.

The Page options appear in sequence, regardless of your selection in the Condition
drop-down list.

4. (Optional) To configure the Hub Page conditions, click the Hub tab.

a. Select a Condition from the drop-down list.

b. Select a Page to appear for the condition selected.

The Page options appear in sequence, regardless of your selection in the Condition
drop-down list.

5. Click Save.

Widgets
Widgets are tiles that you create to show on Simphony Engagement Cloud Service POS
client screens. Widgets allow workstation operators to perform optional tasks and procedures
based on the assigned privilege level.
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You can assign timing values to three widgets. Timing values affect the duration of
time that widgets appear on an idle Engagement POS client device screen. You can
assign custom timing values to the following widgets:

• URL Launcher

• Image Slideshow

• Today’s Special

Engagement widget timing settings are overridden by Log Off User When Idle
settings that are configured in the Simphony application, with the exception of the Web
Configuration Console (WCC) widget. The WCC widget ignores the Simphony idle
client timeout settings; the allowed idle time can be configured in MM:SS. The default
timing value setting for the Engagement widgets is twenty seconds.

Related Topics

• Adding and Moving Widgets

• Creating Tiles (Adding Widgets to a Page)

• Adding Command Buttons

• Configuring Widget Timing Values

• List of Widgets

The IP Camera Widget
The Engagement Internet Protocol (IP) Camera widget is used to display a camera
feed on the user interface (UI) screen as a widget. It allows users to view live video
from an IP camera configured using the Engagement Widget designer. The IP Camera
widget uses the Motion-JPEG (MJPEG) video compression format. MJPEG is a video
format in which each frame of video is sent as a separate and compressed JPEG
image. The viewer displays the JPEG images as quickly as they are received and that
creates the video.

The IP Camera widget is implemented using an image control to render the camera
feeds received as images on the UI screen. A separate media player is not used. The
IP Camera widget uses an open source library named MJPEG Decoder available in
CodePlex.

The widget initializes the MJPEG decoder by passing an IP camera feed URL, which
is configured using the Engagement widget designer. The widget receives the
appropriate events whenever a new image is available and draws it on the container
image control. The widget works with all resolutions supported by the IP Camera. The
image is resized to fit within the widget’s dimensions, while it preserves its native
aspect ratio in the detail view, regardless of the resolution of the images received. The
widget does not save or store images.

The MJPEG Decoder library initiates an asynchronous request to the MJPEG URL
provided by the viewer. It then streams the multi-part response data received into
separate images as they are received. The library passes each JPEG image to the
viewer using an event whenever they are available.

The IP Camera widget supports all network and IP cameras capable of sending a
direct MJPEG stream. This does not include cameras that are embedded within a web
page. The camera must provide a direct stream of only the MJPEG for the IP Camera
widget to successfully display the feed.
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The IP Camera widget does not require additional security measures when displaying the IP
Camera feed. Administrators should implement security restrictions on the network to
explicitly allow workstations to connect to the camera feed. Additionally, the IP camera feed
should be configured in a secure manner to ensure that the username and password are
included in the URL, if possible.

Related Topics

• Adding and Moving Widgets

• Creating Tiles (Adding Widgets to a Page)

• Adding Command Buttons

• Configuring Widget Timing Values

• List of Widgets

Adding and Moving Widgets
1. From the Widget list, tap the widget to add.

2. To move the widget to a new grid location:

a. Tap the widget. A move icon appears.

b. Tap the move icon, and then tap the new grid location.

Widgets move based on tapping the left corner (upper left corner on large widgets)
and automatically resize when moved to a smaller section of the grid.

Related Topics

• Widgets

• The IP Camera Widget

• Viewing the Maximum Data Limit for Hosted Engagement Server

• List of Widgets

Creating Tiles (Adding Widgets to a Page)
1. From the dashboard, tap a page, and then add a widget.

2. (Optional) Enter the Primary Text, Secondary Text, or both to appear on the widget.

The secondary text appears beneath the primary text in a smaller font.

3. Select the size for the tile:

• Small: One tile (small square)

• Wide: Two tiles (rectangle)

• Large: Four tiles (square)

• Extra Large: Nine tiles (large square) (Only Today’s Special widget supports this
size)

4. (Optional) To add a background image to the tile:

a. Tap Open.

b. Tap Upload images(s), browse to the location of the image file or type the image
URL, and then tap OK.
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c. If images were previously uploaded, tap View Album Contents, and then
select the image.

d. Tap Select to save an existing image or Crop to modify the image, and then
tap Done.

5. To add the URL Launcher widget:

a. Enter the URL for the website.

b. To show the keyboard icon on the tile’s top toolbar, tap Show Keyboard. This
allows workstation operators to tap the keyboard icon to see the tablet
keyboard on the tile.

6. To add an Image widget, tap Open.

When adding the Image widget, you configure both the tile image and the image
that appears after the workstation operator selects the tile. If you do not add an
image, the assigned tile image appears by default.

7. To add an IP Camera Feed widget, enter the web address (URL) of the IP
camera’s video stream in the Video URL field.

Include the end query that defines the user and password of the camera (for
example, http://CAMERAIPADDRESS/videostream.cgi?user=USERNAME&pwd
=PASSWORD&resolution=32&rate=0).

8. To add a PDF Viewer widget, enter the directory path to access the PDF document
in the URL field.

You must install a PDF reader application, such as Adobe Acrobat Reader, on the
POS client device to use this widget.

9. To add a Twitter widget, add a hashtag or account in the Query text field (for
example, #oracle or @oracle).

10. To add an InMotion Chart widget, select the Report and the data to appear by
default from the Chart drop-down list.

11. To add a Slideshow Item widget:

a. Tap Slideshow Item, and then tap Open.

b. Enter the primary and secondary text that appears on the image during the
slideshow.

c. To add images to the slideshow, tap Add More.

d. To remove an image from the slideshow, tap Delete Item.

12. To add a Today’s Special widget:

a. Enter the name of the tile in the Header Text field, and then select a
Template.

• Template1 shows each menu item individually during image rotation.

• Template2 shows each menu item and a preview pane of other menu
items during image rotation.

b. Tap Menu Item to add an image, enter the menu item name in the Title field,
and then enter a Description of the menu item.

• The Oracle MICROS Tablet E-Series 8-inch supports up to 823
characters, including spaces.

• The Oracle MICROS Tablet E-Series 11-inch supports up to 627
characters, including spaces.
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c. Enter the Price and additional text or pricing information in the Extra field.

d. To assign a time range to show specials for different meal periods:

i. Tap Add Group, expand the Group panel, and then tap Recurrence.

ii. Enter a time range in 24-hour format during which the group of menu items
appear, and then select either Daily or the days of the week when the group of
menu items appear.

e. Add as many menu items and groups as needed, and then tap OK.

13. To add supported commands, assign one of the available commands to the tile.

The Command widget does not support adding a tile image.

14. To add a Weather widget for weather updates:

a. To use the default service provider, select wunderground from the Provider drop-
down list.

b. To use a different service provider, enter the API URL, and then enter the API Key to
authorize running the weather application programming interface (API).

c. Enter a city name or postal code in the Location/Zip Code field for specific
forecasts, and then select the desired temperature scale from the Scale drop-down
list.

15. To add an EMC widget, select the EMC task from the Command drop-down list.

EMC widgets allow you to assign procedures, functions, and POS client commands to a
tile. The EMC tasks are:

• Clock In

• Clock Out

• Update Database

• Close Application

• Employee Training

• Redirect Order Device

• Edit Menu Item

• Menu Item Availability

• Minimize Application

• Sign In RVC Prompt

16. Tap Save.

Related Topics

• Widgets

• The IP Camera Widget

• Viewing the Maximum Data Limit for Hosted Engagement Server

• List of Widgets
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Adding Command Buttons
You can add command buttons that provide additional ways to perform common POS
functions such as clocking in or out, editing menu items, or updating the workstation
database. These buttons remain hidden and appear only when a workstation operator
swipes the upper or lower area of the tablet touchscreen.

1. From the dashboard, tap either the upper or lower directional arrow, depending on
where you want to add the buttons.

The upper or lower command bars work independently of each other.

2. Tap the plus sign (+) in the upper corner.

3. Enter Primary Text, select the Command to assign the button, and then tap
Save.

Related Topics

• Widgets

• The IP Camera Widget

• Viewing the Maximum Data Limit for Hosted Engagement Server

• List of Widgets

Configuring Widget Timing Values
The following widgets support timing values:

• EMC (WCC)

– Edit Header/Trailer

– Bulk Edit MI Prices

– Copy Menu Item

– Copy Employee

• Image Slideshow

• Today's Special

• URL Launcher

1. Sign on to the POS client device, and then select a page from the dashboard.

2. Select the widget, and then tap Edit.

3. Enter a value in the Allowed Idle Time field.

4. Tap Save.

Related Topics

• Widgets

• The IP Camera Widget

• Viewing the Maximum Data Limit for Hosted Engagement Server

• List of Widgets
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List of Widgets
You can add the following widgets to a Welcome or Home page. Welcome and Home pages
do not support Hub page widgets.

Table 52-4    Welcome and Home Page Widgets

Widgets for Welcome and Home Pages Description

URL Launcher
 

 

The URL Launcher enables you assign an
image and a web address or URL to a tile.
Tapping this tile takes you to the website.

Image
 

 

The Image widget enables you to assign an
image or picture to a tile. Tapping this tile
increases the image size and shows more
detail.

IP Camera Feed
 

 

The IP Camera Feed enables you to directly
assign an IP camera feed to a tile. Tapping this
tile increases the camera feed screen size. You
do not need to assign an image to the tile. You
can connect a maximum of three cameras.
Creating Tiles (Adding Widgets to a Page)
contains more information about the IP
Camera Feed widget.

PDF Viewer
 

 

The PDF Viewer widget enables you to assign a
PDF to a tile. Tapping this tile opens the PDF
document. Install a PDF reader application on
the POS client device to use this widget.

Twitter
 

 

The Twitter widget enables you to assign a
Twitter feed to a tile. Tapping this tile
increases the size of the Twitter feed view.

Image Slideshow
 

 

The Image Slideshow widget enables you to
assign multiple images that rotate for viewing
at five-second intervals.
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Table 52-4    (Cont.) Welcome and Home Page Widgets

Widgets for Welcome and Home Pages Description

Today’s Special
 

 

The Today’s Special widget enables you to
assign one or more menu items, graphics,
descriptions, and prices to a tile. When more
than one menu item is configured, the items
rotate for viewing at five-second intervals. You
can assign a time range to this widget so that
different specials cycle based on the times they
are being served.

Command Widget
 

 

The Command widget enables you to assign
procedures, functions, and POS client
commands to a tile. The available commands
are:
• Clock In
• Clock Out
• Update Database
• Close Application
• Employee Training
• Redirect Order Device
• Edit Menu Item
• Menu Item Availability
• Minimize Application
• Sign In RVC Prompt

Weather
 

 

The Weather widget enables you to assign a
weather forecast provider and location to a
tile. Purchase an application program
interface (API) key to use this widget.

You can add the following widgets to a Hub page.

Table 52-5    Hub Page Widgets

Widgets for Hub Pages Description

ECM Alert
 

 

The ECM alert widget enables you to view
ECM alerts based on cash pull thresholds
for till and server bank receptacles. This
widget is supported for multiple cash
management classes. The ECM alert widget
shows:
• Receptacle name
• Alert type
• Alert level (if applicable)
• Variance (threshold value – actual

receptacle session amount)
The ECM alert widget also indicates when
there are no active alerts.
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Table 52-5    (Cont.) Hub Page Widgets

Widgets for Hub Pages Description

ECM Summary
 

 

The ECM summary widget enables you to
view summary information for active ECM
receptacles. This widget is supported for
multiple cash management classes. The
ECM summary widget shows:
• Receptacle name
• Number of open receptacle sessions

for each receptacle type
• Current total in base class amount
The ECM summary widget also indicates:
• Active alerts for a session
• Offline open receptacle sessions
• Multiple classes

inMotion Charts
 

 

The inMotion Charts widget enables you to
assign Oracle Hospitality Enterprise Back
Office reports to a tile. When you select this
tile, the assigned report generates first, but
all other reports are also accessible. Select
each report to view more information.
The following reports are available:
• Sales
• Labor Cost
• Discount
• Sales Per Labor Hour
• Check Count
• Guest Count
• Average Ticket Time

inMotion Stores
 

 

The inMotion Stores widget enables you to
view cumulative sales report information
from all available outlets, or you can select
an individual store from a list that appears
when selecting this tile.

Labor Cost
 

 

The Labor Cost widget enables you to view
potential employee overtime labor costs.
When you select this tile, alerts inform the
supervisor about employees approaching
overtime for a particular pay cycle.

WCC (Web Configuration Console)
 

 

The WCC widget enables you to assign one
of the following available manager
procedures to a tile:
• Edit Header/Trailer
• Bulk Edit MI Prices
• Copy Menu Item
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Related Topics

• Widgets

• The IP Camera Widget

• Viewing the Maximum Data Limit for Hosted Engagement Server

• Adding and Moving Widgets

• Creating Tiles (Adding Widgets to a Page)

• Adding Command Buttons

• Configuring Widget Timing Values

Viewing the Maximum Data Limit for Hosted Engagement
Server

You can view the maximum allowable amount and remaining space for uploading
widget images to your hosted Engagement server. When adding images for widgets,
the data limit (2 GB total) appears on the image upload screen, along with the
remaining amount of available space for adding more image content.

Related Topics

• Adding and Moving Widgets

• Creating Tiles (Adding Widgets to a Page)

• Adding Command Buttons

• Configuring Widget Timing Values

• List of Widgets
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53
Extension Applications

A POS Client .NET Extension Application is a .NET class library that adds new operations or
event handlers to the Simphony POS client.

An Extension Application adds new operations by defining extension methods that are
invoked using buttons created in the Page Designer module. Existing operations are
extended by implementing event handlers for POS client events. Extension methods and
event handlers are able to interact with the POS client using the Extension Application API.

The POS Client Extension Application API is the set of data types used by the Extension
Application to interact with the POS client; this interaction includes the ability to add items to
a guest check, prompt the user for information, invoke existing operations, evaluate
configuration elements (such as employee options), and more.

Configuring Extension Application Privileges
1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type (for example, administrator), and then click the EMC Modules tab.

3. In the Touchscreens section, select the appropriate Extension Application Posting
permissions for the user role. You can grant permissions for the following actions:

• View: Open and view the Extension Application module. If you allow a user to Edit,
you must also grant View access (otherwise the user cannot open the module).

• Edit: Update fields or records within the module.

4. Click Save.

Enabling Extension Applications
1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click

Extension Application.

2. Highlight the record for the extension application.

3. Click the ellipsis point (...) button in the Options column.

4. To enable the extension application, ensure that 1 - Disable Application is deselected.
To disable the extension application, select 1 - Disable Application.

5. To configure the extension application to post check data to the Reporting and Analytics
database without manual intervention, select 5 - Post extension application data to
Reporting and Analytics.

6. Click OK to close the Extension Application Options dialog.

7. Enter information in the following columns:

• Type: The value in this field indicates how extensibility information appears in
Reporting and Analytics.
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– Enter 0 if extensibility information is needed only at the POS. Extensibility
information does not appear in Reporting and Analytics reports.

– Enter 1 to have extensibility information appear in the standard Check
Detail Report in Reporting and Analytics.

– Enter 2 to hide the extensibility information in the standard Check Detail
Report, but show it in the Check Detail with Extension Data report in
Reporting and Analytics.

If you selected option 5 in Step 5, you must enter 2 as the Type. Checks for
extension applications with Type 2 will appear in Reporting and Analytics
reports.

Note:

DPS posts the following extensibility data:

– Extensibility Type = 1

– Extensibility Type = 2 (DataLevel != 0 and MaxChars > 1 and
MaxItems > 1)

– Extensibility Type = 2 (DataLevel ==1 but there is no parent link)

• Data Level: The default value is 2.

– Enter 0 to post nothing (no check header nor detail information) to the
Reporting and Analytics database.

– Enter 1 to post only the check header information to the Reporting and
Analytics database.

– Enter 2 to post both the check header and detail information to the
Reporting and Analytics database.

• Max Chars: Enter the maximum characters to appear (from 1 to 2000) for
each extension item. The default value is 200.

If the data entered through the POS client exceeds the maximum character
limit, the data will be truncated and posted to the Reporting and Analytics
database; the Direct Posting Service (DPS) log will indicate the exceeded
character limit for each entry with a line item message stating Truncating
extensibility detail - no data.

• Max Items: Enter the maximum extension items to appear (from 1 to 100).
The default value is 1.

If the data entered through the POS client exceeds the maximum item limit,
the data will be skipped and a message posted to the Reporting and Analytics
database; the Direct Posting Service (DPS) log will indicate the exceeded item
limit for each entry with a line item message stating Skipping extensibility
detail - max detail reached.

• Version: Based on the version of the client that the extensibility application
runs on, set the appropriate value in the Edit Application Content Version
popup window:

– If your extensibility application runs on a version of the client earlier than
19.2, then set the Maximum field to 19.1.
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Note:

The value 19.1 also encompasses versions between 19.1 and 19.2.

– If your extensibility application runs on a version of the client that is 19.2 or later,
then set the Minimum field to 19.2.

8. Click Save.
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54
Transaction Services

Transaction Services is a web service that allows Simphony to interface with third-party
applications (for example, hotel self-service kiosks or room service devices, menu boards,
and Enterprise online ordering). Transaction Services is commonly installed in stadiums that
use self-ordering devices. Guests can place orders using a third-party application that
interfaces with a Transaction Services client. The client then sends the guest checks to
Simphony. To configure Transaction Services, EMC user access privileges are required.

Beginning with Oracle MICROS Simphony version 19.2, there are two types of Transaction
Services available for use.

1. Transaction Services Gen 1

Transaction Services Gen 1 is the legacy version of the product that is typically deployed
at a local Property and supports a single revenue center (RVC) or group of RVCs.

2. Simphony Transaction Services (STS) Gen 2

The use of STS Gen 2 is currently supported for Oracle Hosting Center customers with
Super Org (organization) logon credentials. Oracle Hosting must complete configuration
tasks to enable this functionality. This access is required to support uploading images to
a storage service named Oracle Cloud Object Storage. Once your OCI and cloud object
storage access has been configured by Oracle Hosting, you can upload images from the
Simphony EMC for display on POS workstations or other integrated solutions. STS Gen 2
is optimized for the Simphony product and lets users better handle digital transactions. It
does so by being deployable on either an Enterprise (supports multiple tenants) or a
property location (supports a single revenue center or group of revenue centers), similar
to the way Transaction Services Gen 1 operates.

If you are using the STS Gen 2 API cloud offering and have more than one POS API
Client workstation type available in a revenue center, Oracle Food and Beverage
recommends enabling at least two workstation devices that can receive checks and
orders as this will provide resiliency should one of the workstations become unavailable.

Tip:

Your STS Gen 2 services URL and the OpenId Connect server endpoint values
are located on the Applications subtab on the Enterprise Parameters tab in
the EMC. The STS Gen 2 URL represents the base URL for the services
exposed in your environment. The remainder of the URL for each of the service
endpoints in a given version is consistent regardless of the environment they
are deployed in. The OpenID Connect URL represents the base URL for the
OpenID Connect endpoints that are used to acquire tokens for use with STS
Gen 2. See the Oracle MICROS Simphony Transaction Services Generation 2
API Reference Guide for more information on service endpoints and
authentication and authorization for STS Gen 2.

The following EMC modules have consumer-facing content fields:

• Menu Item Definitions
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• Family Groups

• Condiment Group Names

• Discounts

• Service Charges

• Tender/Media

See Configuring Menu Item Definitions, Family Groups, and Condiment Group
Names Consumer-Facing Settings for more information about configuring
these specific modules.

See Configuring Discounts, Tender/Media, and Service Charges Consumer-
Facing Settings for more information about configuring these specific modules.

Examples of consumer-facing content includes such information as:

• Consumer Facing Name

• Consumer Item Name

• Consumer Item Description

• Consumer Image URL / Consumer Image Description

• Consumer Family Group Name / Consumer Family Group Description

This content can then be exposed to users during point-of-sale transactions
through STS Gen 2.

Additional consumer-facing content can be found and configured in the modules
listed below. Each of these modules contain specific Property and Revenue Center
location and contact information:

• Enterprise level Properties

• Property level RVC Configuration

See Adding a Property and Adding a Revenue Center for information about
configuring these modules.

For Oracle-hosted customers (only), image URLs stored on Cloud Storage should
not be distributed and utilized directly by downstream applications. Image URLs
are provided to give external systems access to pull images associated with
Oracle configuration and then cache those images in a performance appropriate
environment for their consumption.

Note:

The Simphony Web Portal’s (SWP) Import/Export utility supports
accessing all EMC consumer-facing field data.

See the Simphony Transaction Services API Reference Document for more
information about Transaction Services.
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Enabling Simphony Transaction Services Gen 2 for Revenue
Centers

To enable Simphony Transaction Services Gen 2 for revenue centers in the EMC:

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. In the Parameters window, click Options.

3. In the Options section, select 74 - Enable Simphony Transaction Services Gen 2.

4. Click Save.

Enabling Simphony Transaction Services for Workstations
The following steps apply to workstations that are set as POSAPI Clients, and POSAPI
Clients upgrading to Simphony release 19.2.

To enable Simphony Transaction Services for workstations:

1. Select the property, click Setup, and then click Workstations.

2. Click the General tab.

3. In the General Settings section, enable the following options based on which
Transaction Services capabilities you would like to run on your workstations:

• Enable Simphony Transaction Services (Gen1) Location API

• Enable Simphony Transaction Services (Gen2) Location API

• Enable Simphony Transaction Services (Gen2) Cloud API

4. Click Save.

Location-Based API Requirements for Simphony Transaction
Services Gen 2

This topic covers several key location-based API requirements for properties using Simphony
Transaction Services Generation 2 (STS Gen 2). They are as follows:

• The on-premises implementation of STS Gen 2 requires tokens acquired from Enterprise
Back Office’s (EBO) Open ID Connect (IDM). When creating API accounts for STS Gen 2
in EBO API Account Management, set the Client Scope to either Both or Local. This
allows for tokens acquired for that client to be authorized to use the on-premises API.
Additionally, on-premises components require initial access to the EBO IDM endpoints in
order to acquire authentication related details for workstations running the on-premises
API. See the Reporting and Analytics User Guide, specifically the Simphony
Transaction Services API topic in Chapter 5 for more information.

• Since HTTPS is a prerequisite for using the on-premises API, ensure that a valid root
certification authority backed TLS certificate is loaded onto all workstations using the on-
premises API.

• The default port for the on-premises API is 5443. API paths after the base URL are the
same as the cloud endpoints, so cloud documentation can be used if necessary. The API

Chapter 54
Enabling Simphony Transaction Services Gen 2 for Revenue Centers

54-3



path looks similar to the example located athttps://
onprem.example.net:5443/api/v1/sample/ABC/locations/biz1.

Configuring Menu Item Definitions, Family Groups, and
Condiment Group Names Consumer-Facing Settings

As stated in the beginning of this chapter, the use of Simphony Transaction Services
(STS) Gen 2 in conjunction with configuring consumer-facing content, is currently
supported only for Oracle Hosting Center customers with Super Org (organization)
logon credentials.

See Transaction Services for more details about STS Gen 2 support and setup
requirements.

Enabling Consumer-Facing Content

To enable consumer-facing content in the Menu Item Definition, Family Groups, and
Condiment Group Names modules, you must first enable STS Gen 2 on a revenue
center.

1. Access the EMC, select a revenue center, click the Setup tab, and then select
RVC Parameters.

2. Click the Options tab and enable option 74 - Enable Simphony Transaction
Services Gen 2, and then Save.

Note:

After enabling option 74 - Enable Simphony Transaction Services
Gen 2 in a single revenue center, an Images tab shows in the Menu
Item (MI) Definitions module for all of the RVCs assigned to the same
Property. However, you can only add images to the MI Definitions
module where the menu items used by the RVC are located. In other
words, if a RVC uses menu items records originating from the enterprise
or property levels, this is the MI Definition module location where the
Images tab is configurable.

3. Access the enterprise, property, or revenue center level, click the Configuration
tab, and then click Menu Item Maintenance.

4. From the Record Type drop-down list, select Menu Item Definition, and then
click the Search button.

5. Select the menu item record you want to assign images to, toggle to Form view,
and then click the Images tab.

Chapter 54
Configuring Menu Item Definitions, Family Groups, and Condiment Group Names Consumer-Facing Settings

54-4



Figure 54-1    Menu Item Definition - Images Tab

6. From the Consumer Item Name field, enter the menu item name you want guests to
view on the point-of-sale (POS) API device.

7. From the Consumer Item Description field, enter a menu item description you want
guests to view on the POS API device, and then Save.

Adding Images to the MI Definitions and Family Groups Modules

Access to the Image tab differs between the MI Definitions and Family Groups modules. As
noted before, the MI Definition module’s Image tab only shows upon enabling option 74 in the
RVC Parameters module. Access to Family Groups is not determined in the same fashion.
The Family Groups module is accessible to anyone who has access privileges to the module,
but like the MI Definitions module, no images can be added to Family Groups unless the
Oracle Hosting Center establishes an Oracle Cloud Infrastructure (OCI) account with Oracle
Cloud Object Storage access.

Note:

If you want to add images to the Family Groups module, access the enterprise,
property, or revenue center level, click the Configuration tab, select Family
Groups, select the family group of your choice, and then toggle to Form view. The
Images tab is available from there.

There are several restrictions placed on images and the amount of content you can upload to
the Oracle Cloud Object Storage website for this feature. They are:

• Each menu item definition can have up to ten images associated with it.

• Each individual image is restricted to no more than 1 MB in size.

• Only *.JPG, *.PNG, and *.JPEG formatted image files are supported.

• Each organization’s total Oracle Cloud Object Storage compartments are restricted to
hold no more than 2 GB of image files.
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The steps to add images to both the MI Definitions and Family Groups modules are
exactly the same. The following steps and examples are shown from the MI Definitions
module’s perspective.

1. Perform steps 3–7 from the previous section.
The Upload link does not become active and ready for use until Oracle Hosting
successfully creates your Oracle Cloud Object Storage account.

2. Click the Upload link.

Figure 54-2    Menu Item Definition - Images Tab Upload Link

3. You are prompted to select the image for the menu item you want to upload. When
you first click the Upload link and select an image, if the image isn't already stored
on the Oracle Cloud Object Storage site, it adds the image to a new bucket in your
designated object storage compartment. If you want to replace an existing image,
the same method applies by clicking the Upload link and configuring the section in
the same manner as described below.

Figure 54-3    Images Tab - Image Handling Section

When an image is successfully uploaded to the cloud object storage site, the
image is shown in the applicable image handling section. At the same time,
several links become active and additional information auto-populates the form.
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To configure an image section, see the instructions in this table:

Table 54-1    Image Handling Section

Fields and Links Description

Paste (link) Used in tandem with the Copy link. First
click Copy, and then click Paste on any
available image configuration section to
duplicate an existing image section.

Title (field) Enter an image name, usually the menu item
name.

Comments (field) Enter a description of the item you are
showing.

Copy (link) Used in tandem with the Paste link. First
click Copy, and then click Paste on any
available image configuration section to
duplicate an existing image section.

Clear All (link) Clears all fields for the image, but does not
delete the image from the cloud object
storage website.

Delete (link) If you click the Delete link, it deletes the
contents of an entire image section and also
removes the image from the cloud object
storage website.

Note:

If you delete a Menu Item
Definition, Family Group Names
record, or an entire RVC or
Property with any associated
images, all images are also deleted
from the cloud object storage
website. Deletion of unused
images is one way to ensure your 2
GB total cloud object storage limit
is not exceeded.

Upload (link) Used to send new images to the cloud object
storage website. If you want to replace an
existing image, click the Upload link, select
another image, and the previously used
image file is overwritten.

Download (link) Used to download an existing image from
the cloud object storage website and save it
to a local disk.

URL (hyperlink to the cloud object storage
website where each image is stored)

This field auto-populates upon successfully
uploading an image to the cloud object
storage website.

Size (field) Shows the size and dimensions of the
uploaded image file. Image files cannot be
larger than 1 MB in size.
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Configuring a Condiment Group Names Consumer Description

To add consumer-facing text to Condiment Groups:

1. Access the enterprise, property, revenue center, or zone, click Descriptors, and
then click Condiment Group Names.

2. The Condiment Group Names module only opens in Table view. Select a
condiment group name, enter your consumer-facing text in the Consumer
Description field, and then click Save.

Figure 54-4    Descriptors - Condiment Group Names Module

Note:

If you want to add consumer facing text to your required or allowed
condiments, you can do so. For example, a common condiment menu item
class (usually required for preparing steaks) is frequently called meat temps.
These condiments provide the kitchen with a guest’s preferred steak
“doneness”, such as rare, medium, medium well, and well done. You could
add descriptive text to the meat temps condiment class like, “How would you
like your steak cooked?”, and then guests can select from the available meat
temps.

Configuring Discounts, Tender/Media, and Service Charges
Consumer-Facing Settings

To configure consumer-facing content in Discounts, Tender/Media, and Services
Charges records:

1. Access the Enterprise, property, or revenue center, click Configuration, and then
click Discounts.

2. From the General tab, enter the consumer-facing name of the discount in the
Consumer Display Name field, and then click Save.

Note:

Each of the these module’s consumer-facing content can be edited from
either Form View or Table View.
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Figure 54-5    Discounts - Consumer-Facing Content

3. Access the Enterprise, property, or revenue center, click Configuration, and then click
Tender/Media.

4. From the General tab, enter the consumer-facing name of the tender in the Consumer
Display Name field, and then click Save.

Figure 54-6    Tender/Media - Consumer-Facing Content

5. Access the Enterprise, property, or revenue center, click Configuration, and then click
Service Charges.

6. From the General tab, enter the consumer-facing name of the tender in the Consumer
Display Name field, and then click Save.

Figure 54-7    Service Charges - Consumer-Facing Content
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Configuring the Transaction Services Workstation Client
You can configure Transaction Services to run on the same hardware device as a
Simphony client. Kiosks are usually configured as Transaction Services clients. Obtain
the following information before you begin the configuration:

• Transaction Services workstation name

• Number of revenue centers using Transaction Services

POS API client workstations do not run as a Windows Service, and administrators
cannot configure Transaction Services as a Windows Service. This is by design. When
option 3 - POSAPI Client is selected as the Type in the Workstations module, the Is
Windows Service field is disabled and greyed out.

1. Select the property, click Setup, and then click Workstations.

2. Insert a record, enter the workstation name, and then click OK.

3. Double-click the workstation record.

4. From the Type drop-down list, select 3 - POSAPI Client.

POS API client workstations do not run as a Windows Service, and you cannot
configure Transaction Services as a Windows Service. This is by design. When
option 3 - POSAPI Client is selected, the Is Windows Service field is disabled
and greyed out.

5. Select the Service Host ID where the workstation runs.

To host Transaction Services on a separate workstation, select the default Service
Host ID.

6. In the Address / Host Name field, enter the machine where Transaction Services
is installed.

7. Enter the Subnet Mask and the Default Gateway of the workstation to configure.

8. Click the Service Host tab.

9. To host Transaction Services and the POS client on a single workstation, select
the corresponding Service Host name from the Service Host drop-down list.

10. Click the Transactions tab.

11. Enter the Minimum Check Number and the Maximum Check Number to use.

12. From the Default Order Type drop-down list, select the order type that the
Transaction Services client uses.

13. Ensure that the Cash Drawer Settings show 0 (zero).

14. Click the Order Devices tab.

15. Select all order devices that use the Transaction Services client for the revenue
center shown in the list. If multiple revenue centers use Transaction Services,
select the appropriate order devices for each revenue center.

16. Click the Printers tab.

17. For each printer, click the Select link, and then select the printer to use for each
print job.

18. Click the Revenue Centers tab.
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19. Select the revenue centers in which this instance of Transaction Services operates.

20. Click the Devices tab, and then ensure that no peripheral devices appear.

21. Click Save.

22. Repeat Steps 1 through 21 for each Transaction Services workstation client.

If you are using the STS Gen 2 API cloud offering and have more than one POS API
Client workstation type available in a revenue center, Oracle Food and Beverage
recommends enabling at least two workstation devices that can receive checks and
orders as this will provide resiliency should one of the workstations become unavailable.

Configuring the Transaction Services Default Employee
Transactions that are created and altered by the Transaction Services client must be
associated with a default transaction employee in Simphony. You need to create an employee
record that is not associated with a member of the staff, and is solely used for the Transaction
Services client to post records to Simphony.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Employee Maintenance.

2. Click the Insert Record button to add an employee.

3. From the Add Employee dialog box, select Add Employee From Template.

4. If you created employees previously, click Employee to Copy, and then select an
existing employee to copy.

5. Enter the first name and the last name of the employee.

6. Assign the employee with an operator record in the revenue center in which Transaction
Services operates. Take note of the employee record number.

7. Select the Property and the Revenue Center, and then click OK.

8. Click Save.

9. Go to the POS client workstation, and run the CAL, selecting the workstation you
configured through Configuring the Transaction Services Workstation Client.

10. After the CAL installation is complete, navigate to the EGatewayService directory from
the workstation, open the web.config file, and then verify that the file contains the correct
Api_WorkstationID value.

Order Information Service
The Order Information Service allows third-party solutions to offer mobile ordering for delivery
and pickup (for example, in seat ordering at a stadium) with status updates to the guest. The
Order Information Service includes the latest view of the order content, such as order ID,
items purchased, payment, employee delivering the order, and so on.

Third-party integrators can obtain order detail and status from Simphony in environments
where orders enter the Simphony system through the Transaction Services application
program interface (API). Third-party applications can query check status (for example, open,
assigned, or closed), and the Order Information Service returns all checks that meet the
request criteria. The Oracle Hospitality Simphony Transaction Services API Document
contains information for software engineers developing applications that interface with
Simphony using Transaction Services.
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Related Topics

• Activating the Extension Application for Order Information Service

• Configuring Touchscreen Order Information Service Buttons

• Order Information Service Functions and Extensibility Arguments

Activating the Extension Application for Order Information
Service

You need to enable the Order Information Service as an extensibility application. No
interface is needed.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Extension Application.

2. Highlight the record for the Order Information Service Client, click the ellipsis
point (...) button in the Options column, and then verify that 1 - Disable
Application is deselected.

3. Ensure that the Interface column value shows 0 - None.

4. Click Save.

Related Topics

• Order Information Service

• Order Information Service Functions and Extensibility Arguments

Configuring Touchscreen Order Information Service Buttons
You can create buttons on a page for the Order Information Service functions. You can
create multiple buttons with slightly different functions (for example, Delivered All,
Delivered Nothing, Delivered Without Alcohol, Delivered Without Food, Delivered
Without Retail, and so on).

1. Select the Enterprise, property, or revenue center, click Configuration and Page
Design.

2. Open the page on which to place Order Information Service buttons.

3. From the Edit tab, select the page area in which to define the Order Information
Service functions.

4. Click Button.

5. From the General subtab, in the Legend field, enter the button name (for example,
Assign Multiple Checks).

6. Select Function from the Type drop-down list.

7. Click the arrow beneath the Type drop-down list.

8. Select Run Extensibility App, and then click OK.

9. Click the arrow next to the Arguments field. The Edit Extensibility Arguments
dialog appears.

10. Enter the appropriate extensibility arguments:
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a. Select dll from the Type drop-down.

b. In the appname field, enter the name of the extension application you created for the
Order Information Service (for example, OISClient).

c. In the filename field, enter OISClient.dll.

d. In the function field, enter one of the following:

• Assign

• Close

• CloseAllChecks

e. Enter the argument value in the arg field, and then click OK.

Order Information Service Functions and Extensibility Arguments contains detailed
information about the Assign, Close, and CloseAllChecks functions and the
arguments required for each function.

11. Position and size the button on the page. Use the Style arrow to change the color.

12. Click Save.

13. Repeat Steps 4 through 12 to create each button. The following table lists the
recommended Order Information Service buttons.

Table 54-2    Order Information Service Buttons and Functions

Button Name Function Description

Assign Check Assign Assign a single check to a delivery agent.

Assign Multiple
Checks

Assign Assign more than one check to a delivery agent.

Delivered Close Close a check after all items are delivered successfully.

Delivery Failed Close Close a check, voiding all items and returning them to
inventory.
Use this button when the delivery agent cannot find the
guest to deliver the prepared items.

Delivered
Without Alcohol

Close Close a check, voiding the alcohol items and returning
them to inventory.

Cancelled Close Void all items and close the check to a zero dollar
amount.
Use this button when the order is canceled prior to
being prepared and delivered.

Close All Open
Checks

CloseAllChecks Void all items on every open check and close the checks
to a zero dollar amount.

Close All Open
Checks by Order
Type

CloseAllChecks Void all items on every open check created for a specific
Order Type and close the checks to a zero dollar
amount.

Close All Open
Checks by
Employee

CloseAllChecks Void all items on every open check created by a specific
employee and close the checks to a zero dollar amount.

Related Topics

• Order Information Service

• Order Information Service Functions and Extensibility Arguments
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Order Information Service Functions and Extensibility
Arguments

The Order Information Service supports three functions:

• Assign

• Close

• CloseAllChecks

Each function must contain a set of arguments. The following tables describe the
extensibility arguments that you must include for each function. Each argument is
required unless otherwise indicated.

Table 54-3    Assign Function Arguments

Argument Description Example

ID= Enter anything here (for
example, Assigned,
AssignedToRunner,
TransferredToRunner). This
text is visible when
Transaction Services
queries the check.

ID=Assigned

(Optional) MultipleChecks= To include this argument,
set the value to true, and
the function refers to Assign
Multiple Checks.
To exclude this argument,
set the value to false, and
the function refers to Assign
Single Check.

MultipleChecks=true

ServiceTotalNumber= Enter the object number of
the Tender/Media record
used when performing the
operation (such as the
tender used for Service
Total).

ServiceTotalNumber=51

An example of the arg value for the Assign function is
ID=Assigned,MultipleChecks=true,ServiceTotalNumber=51

Table 54-4    Close Function Arguments

Argument Description Example

Reason= Enter anything here. This
text is visible when
Transaction Services
queries the check.

Reason=Delivered
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Table 54-4    (Cont.) Close Function Arguments

Argument Description Example

PaymentNumber= Enter the object number of
the Tender/Media record
used when performing the
operation.

PaymentNumber=3

(Optional) VoidParams= Use this argument to
indicate which items to
remove from the check
before closing it. For
example, to delete all items
in family groups 1, 2 and 5,
set the value to FG:1:2:5.
FG indicates Family Group.
(This is the only recognized
value type.) Use FG=* to void
all items.
If you exclude this
argument, the function does
not allow voids.

VoidParams=FG:10:11:15:
16:30:31:32

(Optional) OrderTypeFilter= Use this filter to close checks
for the tender set in the
payment argument and by a
specific order type.
If you exclude this
argument, the function
includes all order types that
can use the payment tender.

OrderTypeFilter=2

An example of the arg value for the Close function is
Reason=Delivered,PaymentNumber=3,VoidParams=FG:10:11:15:16:30:31:32,OrderTypeFil
ter=2

Table 54-5    CloseAllChecks Function Arguments

Argument Description Example

Reason= Enter anything here. This text
is visible when Transaction
Services queries the check.

Reason=Delivered

PaymentNumber= Enter the object number of the
Tender/Media record used
when performing the
operation.

PaymentNumber=3

(Optional) OrderTypeFilter= Use this filter to close checks
for the tender set in the
payment argument and by a
specific order type.
If you exclude this argument,
the function includes all order
types that can use the payment
tender.

OrderTypeFilter=2
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Table 54-5    (Cont.) CloseAllChecks Function Arguments

Argument Description Example

(Optional) EmployeeFilter= Use this filter to close checks
for the tender set in the
payment argument and by a
specific employee. For
example, a Transaction
Services user creates the
checks, so including this
employee in the argument
closes only the Transaction
Services checks.
If you exclude this argument,
the function closes all
employees’ checks.

EmployeeFilter=2

An example of the arg value for the CloseAllChecks function is
Reason=Delivered,PaymentNumber=3,EmployeeFilter=2
Related Topics

• Order Information Service

• Activating the Extension Application for Order Information Service

• Configuring Touchscreen Order Information Service Buttons
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55
Cruise Ship Time Zone and Business Day
Settings

A cruise ship is a constantly moving property. As a ship moves around the world, the time
zone settings for the shipboard systems need to change daily to align with the time zone in
which the ship is sailing.

There are two methods of changing the time zone:

• A ship’s master clock communicates the current time zone settings. When someone
changes the master clock’s time zone, all shipboard systems (for example, property
management system (PMS) and Simphony) automatically update their settings to ensure
consistent date and time stamp posting across all applications.

• A system administrator manually sets the ship’s time zone within the PMS and Simphony.

Oracle recommends that you perform the following tasks:

• Close all checks before changing the time zone.

• Change the time zone once per day during a slow period of operations (for example,
between 2:00 a.m. and 5:00 a.m.).

Changing the Time Zone
1. Close all checks in the workstations.

2. From the EMC, select the Enterprise level, click Setup, and then click Properties.

3. Select the new time zone for the ship from the Time Zone drop-down list.

4. Click Save. The CAL client deploys the new time zone to the property and automatically
updates the time zones of the workstations connected to the property.

Time zones do not update on workstation tablet devices running generic Android
operating systems when the property time zone changes. You must manually update the
time zone on these devices.

Start of Business Day
In food service and hotel environments, a business day refers to the beginning and end times
of a day of business. A business day can have any begin time, but typically a business day
starts in the early morning hours during a slow or closed period of operations (for example,
3:00 a.m. or 4:00 a.m.). In contrast, a calendar day always begins at 12:00 a.m.

In a cruise ship environment the PMS controls the business date. Simphony posts cabin
charges in the PMS. Simphony and the PMS must be in sync to communicate and balance
these transactions. When initializing the Start of Day (SOD) on a ship, change the PMS date
before changing the Simphony date.

On cruise ships, Simphony allows a manual SOD to run twice in one calendar day. For
example, the cabins empty at approximately the same time on a cruise ship, and the financial
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information resets. The ship’s PMS and Simphony are closed out after the last guest
leaves the ship, which is typically between 12:00 p.m. and 1:00 p.m. The SOD
changes in the PMS and in Simphony at that time, and the next cruise begins. Both
the PMS and Simphony change the SOD again at about 3:00 a.m. the following day
when the cruise is under way.

Related Topics

• Configuring Start of Day

Configuring Start of Day
A system administrator on a ship must take the workstations offline and then manually
set the daily start and end times.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the appropriate role type (such as manager), click the Operations tab, and
then click the PMC Procedures subtab.

3. Select the appropriate privileges as described in the following table:

Table 55-1    Start of Day Role Privileges

Privilege Option Description

30058 - Run Start of Day from OPS Select this option to allow all employees
with the role to increment the business
date from the property’s Check and
Posting Service (CAPS) workstation.

30059 - Prevent Running SOD from OPS
with Open Checks

Select this option so that Start of Day
cannot run when open checks exist.

4. Click Save.

5. Select the Enterprise, property, or revenue center, click Configuration, and then
click Page Design.

6. Select the page on which to place the Start of Day button.

7. Add a Start of Day button:

a. In the Legend field, enter Run Start of Day.

b. From the Type drop-down list, select Function.

c. Click the arrow beneath the Type drop-down list, and then select Start of Day.

d. Position and size the new button on the page.

8. Click Save.

9. Select the property, click Setup, and then click Property Parameters.

10. Click the Options tab, and the select 48 - Run Start of Day from OPS.

11. Click the Calendar tab, and then select Run Manually for each day of the week.

12. In the Manual SOD Safety catch time field, set the time when the application
automatically increments the business date if someone forgets to manually run
SOD.
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The application checks to see whether SOD occurred within a 24-hour period for the
selected property. This time is based on the time zone of the property.

13. Click Save.

14. Select the Enterprise level, click Configuration, and then click PC Autosequences.

15. Insert a PC Autosequence record, name it Increment Business Day, and then click OK.

16. Open the record and select the Allowed Properties to view the autosequence.

17. (Optional) From the Parameters section, click the Add link to add parameters. For
example, you can enter a property number and exclude a revenue center number.

a. From the Select Autosequence Parameter dialog, select the Parameter from the
drop-down list.

b. Enter a Value, and then click OK.

18. Click the Steps tab.

19. Click the Add link to add a step.

20. From the Step Type drop-down list, select 3 - Increment Business Date.

21. Click Save.

Related Topics

• Start of Business Day

Workstation Control Privileges
You can configure the control of workstation operations during critical events, such as:

• Running Start of Day

• Locking and unlocking workstations

• Locking and unlocking revenue centers

• Updating workstations

• Reloading workstations

You can set the workstation control privileges for each employee role type (for example,
manager, server, and host).

Related Topics

• Configuring Workstation Control Privileges

Configuring Workstation Control Privileges
To set the control of workstation operations during critical events:

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role type (such as manager), click the Operations tab, and then click the
Miscellaneous subtab.

3. Select the appropriate privileges:

• 10019 - Unlock UWS or Revenue Center: Select this option to allow employees in
the role to unlock a workstation or revenue center from the locked dialog.
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• 10020 - Use Workstation Control: Select this option to allow employees in
the role to use the Workstation Control key to access various workstation
functions (for example, locking and unlocking workstations and revenue
centers, and updating the database). Selecting this option also allows
employees to unlock a workstation or revenue center from the locked dialog.

4. Click Save.

5. Select the Enterprise, property, or revenue center, click Configuration, and then
click Page Design.

6. Select the page on which to place the Workstation Control button.

7. Add a Workstation Control button:

a. In the Legend field, enter Workstation Control.

b. From the Type drop-down list, select Function.

c. Click the arrow beneath the Type drop-down list, and then select Workstation
Control.

d. Position and size the new button on the page.

8. Click Save.

Related Topics

• Workstation Control Privileges
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56
Interfaces with Simphony

Simphony includes the ability to interface with third-party software, such as Property
Management Systems (PMS).

Configuring a Rear Marketing Display (RMD)
The Remote Marketing Display (RMD) feature allows you to connect a secondary display to
an Oracle MICROS workstation. This application is configured via the Simphony EMC Data
Extensions module, and then can be assigned to workstations with a 10-inch display
attached. This extension application only works if there is a secondary display connected to a
workstation. If the secondary display is a touchscreen, you have the option to show
customers current transaction detail, and then prompt them to confirm their order. If there is
change due, a dialog box is shown to customers. The system can also show customized
images during a transaction, or videos while the workstation is idle. If video files are placed
on workstations (via CAL), the application plays designated videos every 5 minutes (by
default).

Prerequisites

• Supported Hardware

– 10-inch display device

– Oracle MICROS Workstation 6 Series - 610, 620, 625, 650, and 655

Note:

Workstations running Oracle Linux for MICROS are not supported for this
feature.

Each workstation with a secondary display attached needs to be calibrated by following
the steps outlined in the Oracle MICROS Workstation 6 Series Setup Guide for 610, 620,
and 650, specifically the Calibrating the Workstation and 10–Inch Customer Display topic.

• Supported Software

– Simphony Workstation Client version: 19.2.x and later

– Images and (optional) videos are used with the Rear Marketing Display (RMD), and
are required in order to fully configure and utilize the application.

Patch DLL File

Download OCS2020.dll from My Oracle Support (MOS). This file is needed to configure the
RMD. Go to Rear Marketing Display Patch on MOS to download the DLL file.
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RMD Configuration

To configure this feature, you must have EMC access privileges assigned to your role
for the Data Extension, Extension Application, Workstation, and Content modules. To
configure the RMD, complete the following steps using the EMC:

Configuring the Extension Application

1. Select the Enterprise or property, click Setup, and then click Extension
Application.

2. Insert a new record and name it OCS2020. Toggle to Form view.

3. From the General tab, click the Insert Application Content button.

Figure 56-1    Extension Application Module

4. Enter the text in the following fields:

• Zoneable Key: Application

• Description: Main OCS Application

5. Click the Designer tab.

6. From the Content Type drop-down list, select 3 - DLL.

7. Click the Import from a file link, and then select OCS2020.dll.

Note:

The File Name Origin field auto-fills to reflect the full name of the
OCS2020.dll.

8. Click the General tab, and then enter OCS2020.dll in the Disk File Name column
of the record. Note the Disk File Name entry is case-sensitive and must be the
same as the actual file name, including its file extension.

9. From the Target field, click the ellipsis (…), enable the Win32 operating system
check box, and then click OK.

10. Enter the appropriate Simphony Minimum / Maximum version information in the
Version field. Click the ellipsis (…), and (in this case), enter 19.2 in the Minimum
field, select the check box adjacent to the minimum version number, and then click
OK.
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Figure 56-2    Edit Application Content Version Window

11. Click Save.

Configuring the Data Extension

Configure the data extension record using the EMC. This configuration allows you to enable
or disable the RMD application on each workstation. Enable this extension for workstations
connected to 10-inch displays.

1. Select the Enterprise, click Configuration, and then click Data Extensions.

2. Insert a new record.

3. Click the ellipsis (…), and then select 41 - Workstations from the drop-down list in the
Table column.

4. Enter RMDEnabled in the Extra Column Name field.

5. From the Type column, select 4 - Boolean from the drop-down list.

6. Enable the following column check-boxes:

• Is Editable

• Is Viewable

• Is Downloadable

7. Click Save.

Enabling Data Extensions for Workstations

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation record, and then toggle to Form view.

3. Click the Data Extensions tab.

4. Enable the check box under the Value column for the RMDEnabled Data Extension.

5. Click Save.

6. Repeat steps 2 through 5 for each workstation that is connected to a secondary display.

Enabling the Rear Display on a Workstation

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation record, and then toggle to Form view.

3. Click the Options tab, select the Display/Security subtab under the Display Options
section, and then select the 6 - Enable Rear Display option.

4. Click Save.
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Adding Images in the Content Module

In order to achieve the best look and feel of your images and videos on the RMD,
Oracle MICROS Food and Beverage recommends adhering to the following image
dimensions. All dimensions are provided in the form of Width x Height (pixel count).

• OCSDefaultImage dimensions should be set to 1914 x 1074 pixels.

• OCSRightPanelImage dimensions should be set to 957 x 1074 pixels.

• OCSBannerImage dimensions should be set to 957 x 120 pixels.

• Video dimensions should be set to 1914 x 1074 pixels.

1. Select the Enterprise, click Setup and then click Content.

2. Insert a new record and name it OCSDefaultImage. Toggle to Form view.

3. From the General tab, click the Content Type drop-down list, and then select 9 -
Image (JPG).

4. Click the Import from a file link, and then select the image to show when the
workstation operator is signed out or the workstation is idle.

5. Insert a new record and name it OCSRightPanelImage. Toggle to Form view.

6. From the General tab, click the Content Type drop-down list, and then select 9 -
Image (JPG).

7. Click the Import from a file link, and then select the image to show on the right
panel of the display when a transaction is in progress.

8. Insert a new record and name it OCSBannerImage. Toggle to Form view.

9. From the General tab, click the Content Type drop-down list, and then select 9 -
Image (JPG).

10. Click the Import from a file link, and then select the image or logo to show on the
bottom left panel of the display, directly under the check detail window.

11. Click Save.

Configuring Touchscreen Buttons in Page Design

This extension application supports two button configurations for the workstation or
RMD touchscreen displays.

• Manage OCS: This button is used to manage the OCS/RMD application.

1. Select the Enterprise, click Configuration, and then click Page Design.

2. Select the touchscreen on which you want to add the button. Toggle to Form
view.

3. Add a new button and configure it using the following settings:

a. Legend: Manage OCS

b. Type: Function - Run Extensibility App

c. Arguments:
appname=OCS2020;type=dll;filename=OCS2020.dll;function=manageOC
S;arg=

4. Click Save.
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• Confirm Order: This button is used to prompt customers to confirm their order and
should only be used if the secondary display is a touchscreen.

1. Select the Enterprise, click Configuration, and then click Page Design.

2. Select the touchscreen on which you want to add the button. Toggle to Form view.

3. Add a new button and configure it using the following settings:

a. Legend: Confirm Order

b. Type: Function - Run Extensibility App

c. Arguments:
appname=OCS2020;type=dll;filename=OCS2020.dll;function=confirmOrder;arg=

4. Click Save.

(Optional) Create a CAL Package to Distribute Video Files to Workstations

Create a CAL Package to transfer marketing video files to workstations. This is optional and
is not required if the secondary display is not being utilized as a RMD.

• Only videos in MP4 format are supported.

• Video dimensions should be set to 1914 x 1074 pixels.

• A maximum of five videos are supported.

• Video file names must be named like this: movieX.mp4, where X = 1 through 5.

• Video files must be placed in the C:\Micros folder on workstations.

• By default, videos play every 5 minutes starting with movie1.mp4, and then in numerical
sequence thereafter.

OPERA PMS Enhanced Interface Features and Requirements
Supported Software and Hardware

• Simphony release 2.8 or later

• OPERA Interface release 8.7.3.7 or later

• Supported POS client devices as of Simphony release 2.8 running the Service Host
application.

– Oracle MICROS PC Workstation 2015

– Oracle MICROS Tablet E-Series 8 inch (OS 1.5) and 11 inch (OS 1.4)

– Oracle MICROS Workstation 6 Series

– Oracle MICROS Workstation 5A (POSReady 2009/7)

– Android 4.4 tablets

– Samsung Galaxy 7, 8, 11 inch

– Google Nexus

– Zebra MC40 – Android 4.4

– DT Research DT365

– Microsoft Windows 7 and 8.1 devices

Posting Capabilities
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• Up to 16 Sales Itemizers

• Up to 64 Tax Itemizers

• 16 Discount Itemizers if the Full Discount and Service Charge Breakdown is
configured accordingly; otherwise 1 Discount Itemizer

• Up to 14 Service Charge Itemizers if the Full Discount and Service Charge
Breakdown is configured accordingly; otherwise 2 Service Charge Itemizers

• Check Details in the final tender event

Inquiries

• Enhanced inquiry by name or room number returns the following information
(varies and depends on the setup on the PMS):

– Guest last name, first name, and title

– Arrival and departure dates

– Room number and room type

• Display of guest reservation detail

• Display of guest history

• Display and printing of guest messages

• Entry of guest messages

• Display of guest locator

• Entry of guest locator

Inserting the Extension Application Files for OPERA
This procedure explains how to install and configure the SIM OPERA Property
Maintenance System (PMS) interface. The configuration requires:

• Simphony release 2.8 or later

• OPERA Interface release 8.7.3.7 or later

1. Run the SIMPH2_ENH_IFC[version number].exe setup application on the
Simphony application server.

This application verifies the Simphony installation and copies the following files to
the [Drive letter]:\MICROS\Custom\EnhancedInterface folder:

• CONTENT_EnhIFC_Config.txt

• McrsExtDialogsML.dll

• MF_ENH.isl

• MF_ENH_Android.isl

• android.htm

2. If you cannot start the setup application on the Simphony application server
because of access or user right limitations, but have access to EMC from your
local PC, use the /LOCAL parameter to star the application.

This method only works for version 270. That is, SIMPH2_ENH_IFC270.exe.
Running the application through this methods does not verify the Simphony
installation, and it is your responsibility to ensure that the Simphony requirements
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are met. This method copies the required files into the sub-folder
Custom\EnhancedInterface beneath the folder you selected in the setup application.

3. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Extension Application.

4. Click the Insert icon to add a record.

5. Enter the record name in the Name field (for example, OPERA), and then click OK.

6. Double-click the record to open it in form view.

7. On the General tab, click the Insert Application Content button.

Figure 56-3    Extension Application Insert Application Content Button

8. Enter MF_ENH for both the ZonenableKey and Description fields, and then click OK.

Figure 56-4    Inserting Application Content Records

a. On the Designer tab, select 19 - Sim Script as the Content Type.

b. Click the Import from a file link.
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Figure 56-5    Importing Content From File

c. Browse to and select the MF_ENH.isl file, and then click Open.

d. On the General tab, enter MF_ENH.isl in the Disk File Name column.

Disk File Name entries must exactly match the name of their associated SIM
scripts and DLL file names. These entries are case-sensitive.

e. In the Option Bits column, click the ellipsis point (...) button, and then select 2
- Main SIM Content.

f. In the Target column, click the ellipsis point (...) button, and then select 1 -
Win32.

9. Repeat Steps 7 through 9 to insert a new application content and import the
MF_ENH_Android.isl file with the following settings:

• ZonenableKey: Enter MF_ENH_ANDROID.

• Description: Enter MF_ENH_ANDROID.

• Content Type: Select 19 - Sim Script.

• Option Bits: Select 2 - Main SIM Content

• Disk File Name: Enter MF_ENH_ANDROID.isl.

• Target: Select 10 - Android.

10. Repeat Steps 7 through 9 to insert a new application content and import the
McrsExtDialogsML.dll file with the following settings:

• ZonenableKey: Enter McrsExtDialogsML.

• Description: Enter McrsExtDialogsML.

• Content Type: Select 3 - DLL.

• Disk File Name: Enter McrsExtDialogsML.dll
• Target: Select 1 - Win32.

11. Repeat Steps 7 through 9 to insert a new application content and import the
android.htm file with the following settings:

• ZonenableKey: Enter html. The ZoneableKey entry for the android.htm file
must match html, and it is case-sensitive.

• Description: Enter html.
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• Content Type: Select 23 - Text.

• Target: Select 10 - Android.

12. Click Save.

13. For multi-tenant environments, you must configure the content information as Extension
Application content. In these environments the content feature cannot be used.

a. Insert a new application content for the enhanced interface by clicking the Insert
Application Content button.

b. Configure the following fields:

• ZonenableKey: Enter EnhIFC_Config (case sensitive).

• Description: Enter EnhIFC_Config (case sensitive).

• Content Type: Select 23 - Text.

• Target: Select 10 - Android.

c. Click Save.

d. Insert the content information as outlined in Configuring OPERA Content Information.

Configuring OPERA Content Information
For multi-tenant environments using releases earlier than Simphony release 2.9, you are
required to configure the content information as Extension Application content. The content
feature cannot be used in these environments.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Content.

2. Insert a record for the PMS content, named PMS.

3. Double-click the new record to open it.

4. Select 4 - String as the Content Type.

5. Enter the following string in the Content tab and make the necessary modifications, as
shown in the following figure (the content text file is delivered with the other files).

See Content Text Settings for the OPERA PMS for more information on the configuration
strings.
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Figure 56-6    Content Text File

6. (Optional) For debugging purposes, add the line "DEBUG_ON=10".

This increases the verbosity, adding additional messages in the Egateway.log file.

7. To override the Content, select the Use Existing Record option.

The Content can be overridden by property, zone, or revenue center.

Figure 56-7    Override Record Controls

8. Click Save.

9. Restart the Service Hosts.

Content Text Settings for the OPERA PMS
The following tables list the string names and values to be used in the Content module
for the OPERA content text file.
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Posting Related Settings

Table 56-1    Posting Related Settings

Configuration String Configuration Value

MAGCARDONLY Set to 0 to allow both magnetic cards and
keyboard inputs.
Set to 1 to limit the entries in the Room Charge
event to magnetic cards.

MAGCARDOVRWRT When MAGCARDONLY is enabled, you can
overwrite the setting for certain revenue
centers by entering a list of revenue center
numbers (separated by comma).

SUPPRESSGSTMSG Set to 1 to suppress the message indicator
during posting. Enable this setting for high-
volume sites.

SUPPRESSNFOREF Non-Room Charge tenders show the
Department Code for which they were posted.
Set to 1 to suppress this reference.

REVERSEGST Set to 1 to make the guest count negative when
the payment is negative (that is, the payment is
voided). This feature requires specific
configuration on the Front-Office interface to
work correctly.

FULL_DSVC Set to 1 to send the full breakdown of the
discounts. This requires a specific version of
the Front-Office interface.
Set to 2 for an additional full breakdown of the
service charges. This includes the full
breakdown of discounts.

NO_CONFIRM_GST Set to 0 if magnetic cards are used to identify
guests.
Set to 1 to prevent confirmation of the guest
name when posting.

POST_64TAXES Set to 1 to send up to 63 Tax Itemizers to the
Front-Office interface. This feature requires
IFC8 V.8.7.1.2 or later as well as a certain
version of the Front-Office itself.
Set to 0 to send only 8 Tax Itemizers to the
Front-Office interface.

SendAllDtls Set to 0 to send only the check details of Room
Charges the Front-Office interface.
Set to 1 to send also the check details of non-
Room Charges.
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Table 56-1    (Cont.) Posting Related Settings

Configuration String Configuration Value

RESTRICTED_POSTING Select to restrict the response returned from
the Front-Office Interface in the Room Charge
event. Note that this only works in
combination with the option
RESTR_POSTING_EMPL is configured correctly.
There are two values supported:
• Set to 1 to require both the room number

and at least three characters of the
surname (last name) to post the room
charge. If less than three characters are
provided an error appears. If the response
from the PMS contains more than one
record, an error appears and the
workstation operator must enter
additional characters to provide a unique
identifier.

• Set to 3 to assume that an external device
will provide the input as keyboard data.
There is no touchscreen keyboard shown
when this option is used. The workstation
operator (or guest) has only the option to
abort the input. If the response from the
PMS contains more than one record an
error appears and the posting is aborted.
There is no confirmation of the guest-
name shown, irrelevant of the setting in
NO_CONFIRM_GST.

Note that this feature does not work if the
input is restricted to magnetic cards.
Therefore, you must either disable the
restriction or add the relevant revenue center
to the excluded list of revenue centers.

RESTR_POSTING_EMPL Specify the ISL Option to use with the above
option (see ISL Options in the Employee
Maintenance module). The valid value for this
configuration is between 1 and 8.

Locator and Message Settings

Table 56-2    Guest-Locator and Guest-Message Settings

Configuration String Configuration Value

RVCNAMELOC Set to 1 to have the first line of the locator
contain the revenue center name,
otherwise the locator name is blank.
Workstations operator can overwrite this
value when entering the locator
information.
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Table 56-2    (Cont.) Guest-Locator and Guest-Message Settings

Configuration String Configuration Value

LOCVALIDMIN Each new locator is only valid for a certain
time. Enter the default time in minutes for
which the locator is valid. Workstation
operators can overwrite this value when
entering the locator information.

Configuring the OPERA PMS Interface
1. Select the Enterprise level, click Setup, and then click Interfaces

2. Insert a record for the OPERA PMS interface. Enter a System Name that reflects the
property using the interface.

3. Double-click the new interface record to open it.

4. On the General tab, configure the settings as follows:

• Communication Name: Enter the name to use when communicating with the
interface.

• Interface Type: Select 0 - PMS/SIM.

• Communication Type: Select the communication type that the interface uses.

• Timeout: Enter 30.

• Ping Frequency: Set to 0 (zero) to avoid double posting.
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Figure 56-8    Interface Module

5. Click the Options tab, and then select the options 1 - Use 19 Digit Reference
Entry for PMS Inquiries, 2 - Enable Interface Log, 3 - Allow Inquiry without
Sign-In, and 5 - ON = Use 9 digits for Terminal IDs; OFF= Use 2 digits for
Terminal IDs.

Do not enable option 8, as it causes double posting.
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Figure 56-9    Interface Module’s Options Tab

6. In the TCP Communications section, enter the following details:

• TCP Host Name: Enter the OPERA PMS application server’s IP address or server
name (if DNS is enabled).

• Port Number: Enter the port number for the OPERA PMS server.

7. Click the Properties tab, and then select the properties that can use this interface.

Figure 56-10    Interface Module’s Properties Tab

8. Click the Service Host tab, click Select adjacent to the Service Host field, select the
service host to run the OPERA PMS interface, and then click OK.
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You can assign any workstation that has enough power to handle the incoming
queries as the service host.

9. Click Save.

10. Select the Enterprise, property, revenue center, or zone, click Setup, and then
click Extension Application.

This configuration typically occurs at the property level when the PMS interface is
on-premises.

11. In the Interface column corresponding to the OPERA extension application record,
click the ellipsis point (...) button, and then select the PMS interface to associate it
with the OPERA Extension Application record.

Figure 56-11    Extension Application PMS Interface Assignment

12. Click Save.

Enabling the OPERA PMS Interface for a Revenue Center
You must enable the OPERA PMS interface for each revenue center that uses
OPERA.

1. Select the revenue center, click Setup, and then click RVC Parameters

2. Click the Interfaces tab.

3. Select the PMS interface to enable the OPERA PMS interface for the revenue
center.
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Figure 56-12    Revenue Center Parameters Interfaces Tab

4. Click Save.

5. Repeat Steps 1 through 4 for each revenue center that uses the OPERA PMS interface.

Adding the Tender/Media Data Extension for OPERA
1. Select the Enterprise level, click Configuration, and then click Data Extensions.

2. Click the Insert icon on the toolbar to add a record, and then click OK.

3. Enter information in the following fields:

Table 56-3    Data Extension Fields

Field Description

Table Select 71 - Tender Media.

Extra Column Name Enter Room Charge.

Type Select 4 - Boolean.

Data Constraints Not applicable

Sort Priority Not applicable

Display Width Enter 150.

Translatable Name Enter Enh.IFC – Room Charge (translatable).
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Table 56-3    (Cont.) Data Extension Fields

Field Description

Translatable Help Enter Enable this for Room-Charge Payments
(translatable).

Figure 56-13    Data Extensions Module

4. Select the following options:

• Is Editable

• Is Viewable

• Is Downloadable

5. Click Save.

Configuring the Tender Media for OPERA
1. Select the Enterprise or property, click Configuration, and then click Tender/

Media.

2. Click the Insert icon on the toolbar to add a record, enter Room Charge as the
name, and then click OK.

3. Double-click the Room Charge record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

Figure 56-14    Tender/Media Room Charge Configuration
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5. Click the Options tab, and then click the Interface Options subtab.

6. In the View Interface Names for RVC drop-down list, select the revenue center for which
the OPERA PMS interface was assigned, and then select PMS from the Interface Link
drop-down list.

The Interface Link and the View Interface Names for RVC fields are only active if the
Tender/Media configuration is being performed at the property level.

Assign the PMS Interface Link to all payments that must be auto balanced (for example,
Cash, Credit Cards, and so on).

7. Select the following options:

• 29 - ON=Post 0.00 Transactions to PMS; OFF=Do Not Post

• 31 - ON=PMS and Credit Cards Use 19 Digit Acct Number; OFF=16 Digits

• 38 - Use ISL TMED Procedure Instead of PMS Interface

Figure 56-15    Tender/Media Room Charge Options

8. Click the Ops Behavior subtab and in the General Options section, ensure that 5 -
Reference Entry Required is not enabled.

9. Click the Data Extensions tab, and then select the check box in the Value column for the
Enh.IFC – Room Charge.

The Value check-box must be selected for the room charge tender media(s). Deselect
the check-box for all other tender medias.

Figure 56-16    Tender/Media Room Charge Data Extensions Tab
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10. Click Save.

Configuring the Room Charge Buttons for the OPERA PMS
Oracle recommends that you create payment card buttons on a page for the PMS
room charge function.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and
then click Page Design.

2. Open the page on which to place the room charge button.

3. On the Edit tab, select the page area in which to define the room charge function
(typically the payment area).

4. Click Button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Payment Tenders from the Type drop-down list.

7. In the Select Tender/Media Payment dialog, select the OPERA PMS room charge
payment tender, and then click OK.

8. In the Select Payment Type area, select Other1:LoadablePms from the Payment
Type drop-down list.

9. Click the Edit... link in the Command column.

10. In the Payment Configuration dialog, select the Opera payment method from the
Functions drop-down list.

11. Position and size the button on the page. Use the Style arrow to change the color.

Figure 56-17    Room Charge Payment Button

12. Click Save.

13. Add the room inquiry buttons on any required page. Typically, the room inquiry
buttons are created on the payment or function page.

a. Open the page on which to place the Room Charge Inquirye buttons, and then
on the Edit tab, select the page area in which to define the buttons.
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b. Click Button, and then on the General subtab, select Function from the Type drop-
down list.

c. Click the black arrow directly beneath the Type drop-down list, and then select
Extensibility from the Type pane.

d. Select SIM Inquire, and then click OK.

e. In the Argument field, enter <EXTENSION APPLICATION NAME>:<INQUIRY
NUMBER>.

Enter the inquiry number corresponding to the PMS SIM inquiry. For example, enter
OPERA:1 to configure a Room Inquire button.

Table 56-4    Inquire Names and Numbers for Room Inquiry Buttons

Inquire Inquire Number

Room Inquire 1

Info Room Inquire 2

Short Inquire 5

Info Line Inquire 6

View Reservation Inquire 7

Extended Inquire 8

PMS Interface Information Inquire 911

Figure 56-18    Room Charge Inquiry Button

f. Enter a Legend.

g. Repeat Steps 13b through 13f to configure buttons for the remaining PMS SIM
inquire buttons listed in Step 13e.

• Click Save.

14. After the room charge button configurations are complete, perform a full reload of all
workstations and restart the service hosts.
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Updating the SIM OPERA Interface to a Newer Version
To update an available installation:

1. Run the SIMPH2_ENH_IFC[version number].exe setup application on the
Simphony application server to update the [Drive letter]:\MICROS\Custom
folder.

2. Re-import the ISL and DLL files into the Extension Application.

See Inserting the Extension Application Content for OPERA for more information.

3. Create any additional Data Extensions, if required.

4. Perform a database reload on the workstations and restart the service hosts.
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57
Accessibility

This chapter describes the accessibility feature in the EMC and its configuration. Accessibility
features aim to make using the product easier for persons with disabilities. Simphony
currently supports the high-contrast settings that are provided by the Microsoft Windows
operating systems.

Enabling High Contrast Visibility Settings
Enable High Contrast visibility settings based on the operating system that you are running
on your computer.

1. To enable high contrast visibility settings with Microsoft Windows 8.x or Microsoft
Windows 10:

a. Click the Start button from your computer’s Desktop.

b. Type high contrast settings in the Search box, and then select High Contrast from
the list.

c. Select a high contrast theme from the Choose a Theme drop-down list.

d. Click Apply.

2. To enable high contrast visibility settings with Microsoft Windows 7:

a. Click the Start button from your computer’s Desktop, and then select the Control
Panel.

b. Click Appearance and Personalization, and then click Personalization.

c. Click the high-contrast theme that you want to use under Basic and High Contrast
Themes.

Navigating the Home Page Using Keystrokes
1. To place focus on the Location panel on the left, press Ctrl+H.

2. To expand a level (Enterprise or property) to show the locations beneath, press the right
arrow key.

3. To move between the locations in the hierarchy, press the up arrow key and the down
arrow key.

4. To open a module:

a. Press Ctrl+T to move focus to the tabs on the right, and then press the up arrow key
and the down arrow key to move between the tabs.

b. Press Tab to navigate to the first focusable element in the tab.

c. Continue to press Tab to navigate through the modules in the tab.

d. Press Enter to open the module.
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Keyboard Shortcuts
EMC supports standard keyboard shortcuts that are used in Microsoft Windows
operating systems. Additionally, EMC offers shortcuts to perform tasks that are specific
to the application. The following table describes keyboard shortcuts for use with EMC.

Table 57-1    General Keystrokes

Keyboard Shortcut Result

Tab Navigates to the next focusable field or element
from top to bottom and left to right.

Down Arrow Varies based on context:
• When moving through the location hierarchy in

the Home Page, moves one item downward
through the list.

• In a table, moves to the next row.
• When the focus is on a drop-down list, moves to

the next item in the list.

Up Arrow Varies based on context:
• When moving through the location hierarchy in

the Home Page, moves one item upwards
through the list.

• In a table, moves to the previous row.
• When the focus is on a drop-down list, moves to

the previous item in the list.

Right Arrow Varies based on context:
• In a table, navigates to the next column on the

right.
• When moving through the location hierarchy in

the Home Page, expands the location to show
the properties or revenue centers beneath.

Left Arrow Varies based on context:
• In a table, navigates to the next column on the

left.
• When moving through the location hierarchy in

the Home Page, collapses the list and sets the
focus on the parent location.

Delete Deletes the record selected.

Enter Triggers the activity, when the focus is on a link or a
button.

Insert Adds a new record.

Alt+E Accesses the Edit menu on the toolbar.

Alt+F Accesses the File menu on the toolbar.

Alt+H Access the Help menu on the toolbar.

Alt+V Accesses the (Table or Form) view menu (where
applicable) on the toolbar.

Ctrl+C In Table view, copies the record or records that are
selected.

Ctrl+F Opens the Find dialog which allows you to search
for records by entering a search criteria.
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Table 57-1    (Cont.) General Keystrokes

Keyboard Shortcut Result

Crtl+G Opens the Go to Record dialog which allows you to
go to a record by entering the record's object
number.

Ctrl+H In the Home page, moves focus to the location
hierarchy.

Ctrl+K Closes all open modules, including the Home Page,
and disconnects the user from the EMC.

Ctrl+O Opens the EMC Login page when disconnected from
the EMC.

Ctrl+P Print records while in Table view.

Ctrl+Q Closes the module that is active.

Ctrl+S Saves the changes.

Crtl+T Varies based on context:
• In the Home page, moves focus to the main tabs.
• In Table view, shows or hides the record filters.

Ctrl+V In Table view, pastes the copied records.

Shift+F10 In Table view, opens the right-click menu when the
focus is on a record.

F3/F4 In Table view, allows copy and paste of fields.
F3 copies the content in the cell and moves to the
cell in the next row. F4 pastes the contents and
moves to cell in the next row. This allows you to
continually press F4 (or hold it down) and paste the
same information to multiple cells in the same
column.

F8 Opens the EMC Record Translation dialog.

Chapter 57
Keyboard Shortcuts

57-3



58
Remote Support

Oracle Customer Support agents can use the Remote Support Tool (RST) to securely access
Simphony Cloud users’ Linux-based workstations and perform support tasks. This includes
access to the Linux terminal shell, the Simphony client user interface, and transferring files.

To use the RST, your workstations must be on the Linux platform and your organization must
be provisioned for the RST.

The Simphony Cloud upgrade process automatically adds the technical requirements.
Simphony Cloud users automatically benefit from the RST as soon as they are provisioned
and the Simphony CAL and Simphony POS client are updated.

The option 30070 - Launch/Close Support Session in the Roles module allows privileged
users to launch or close a support session from either POS operations or the Property
Management Console (PMC). You can use the Page Design module to add function buttons
which launch or close the support session.

On the Linux workstation, Simphony Cloud users can launch the support session and provide
the Support Session ID to the Oracle Customer Support agent. The status of the Support
Session appears on the workstation (active or connected). Upon completion, the user or the
agent can close the support session.

Allowing Employees to Launch and Close a Support Session
You can grant the privilege for Simphony Cloud users to launch or close a support session on
Oracle Linux workstations. This privilege must be enabled for the Launch Support Session
and the Close Support Session buttons to be active on the Linux-based workstation.

1. Select the Enterprise, click Configuration, and then click Roles.

2. Double-click an employee role.

3. Click the Operations tab, click the PMC Procedures subtab, and then select 30070 -
Launch/Close Support Session.

Selecting 30070 allows employees associated with the role to start and close a support
session from POS operations or from the Property Management Console (PMC).

4. Click Save.

Creating Support Session Buttons
You can use the Page Design module to create two function keys that launch or close a
remote support session from a workstation page other than the Property Management
Console (PMC) Support page. (The Launch Support Session and Close Support Session
buttons automatically appear on the workstation PMC Support page without requiring
configuration.)

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

58-1



2. Open the page on which to place the support session function keys.

3. On the Edit tab, select the page area in which to define the function keys.

4. Click Button.

5. On the General subtab, enter the key name in the Legend field (for example,
Launch Support Session or Close Support Session).

6. In the Type drop-down list, select Function.

7. Click the black arrow beneath the Type drop-down list.

8. In the Edit Command dialog, enter or select the following and then click OK.

• Name: Enter Support.

• Results: Select Launch Support Session or Close Support Session.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Repeat Steps 4 through 9 to create the other support session button.

11. Click Save.
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